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However, the NTP application is known to have some difficulty in the year 2036.

SOFTWARE LICENSE

The terms and conditions for using this software are described in the software license contained in the acknowledgment to your purchase order or, to the
extent applicable, to any reseller agreement or end-user purchase agreement executed between you and Juniper Networks. By using this software, you
indicate that you understand and agree to be bound by those terms and conditions. Generally speaking, the software license restricts the manner in which
you are permitted to use the software and may contain prohibitions against certain uses. The software license may state conditions under which the license
is automatically terminated. You should consult the license for further details. For complete product documentation, please see the Juniper Networks Web
site at www.juniper.net/techpubs.
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END USER LICENSE AGREEMENT

READ THIS END USER LICENSE AGREEMENT (“AGREEMENT”) BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE. BY DOWNLOADING,
INSTALLING, OR USING THE SOFTWARE OR OTHERWISE EXPRESSING YOUR AGREEMENT TO THE TERMS CONTAINED HEREIN, YOU (AS CUSTOMER
OR IF YOU ARE NOT THE CUSTOMER, AS A REPRESENTATIVE/AGENT AUTHORIZED TO BIND THE CUSTOMER) CONSENT TO BE BOUND BY THIS
AGREEMENT. IF YOU DO NOT OR CANNOT AGREE TO THE TERMS CONTAINED HEREIN, THEN (A) DO NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE,
AND (B) YOU MAY CONTACT JUNIPER NETWORKS REGARDING LICENSE TERMS.

1. The Parties. The parties to this Agreement are (i) Juniper Networks, Inc. (if the Customer’s principal office is located in the Americas) or Juniper Networks
(Cayman) Limited (if the Customer’s principal office is located outside the Americas) (such applicable entity being referred to herein as “Juniper”), and (ii)
the person or organization that originally purchased from Juniper or an authorized Juniper reseller the applicable license(s) for use of the Software (“Customer”)
(collectively, the “Parties”).

2. The Software. In this Agreement, “Software” means the program modules and features of the Juniper or Juniper-supplied software, for which Customer
has paid the applicable license or support fees to Juniper or an authorized Juniper reseller, or which was embedded by Juniper in equipment which Customer
purchased from Juniper or an authorized Juniper reseller. “Software” also includes updates, upgrades and new releases of such software. “Embedded
Software” means Software which Juniper has embedded in or loaded onto the Juniper equipment and any updates, upgrades, additions or replacements
which are subsequently embedded in or loaded onto the equipment.

3. License Grant. Subject to payment of the applicable fees and the limitations and restrictions set forth herein, Juniper grants to Customer a non-exclusive
and non-transferable license, without right to sublicense, to use the Software, in executable form only, subject to the following use restrictions:

a. Customer shall use Embedded Software solely as embedded in, and for execution on, Juniper equipment originally purchased by Customer from Juniper
or an authorized Juniper reseller.

b. Customer shall use the Software on a single hardware chassis having a single processing unit, or as many chassis or processing units for which Customer
has paid the applicable license fees; provided, however, with respect to the Steel-Belted Radius or Odyssey Access Client software only, Customer shall use
such Software on a single computer containing a single physical random access memory space and containing any number of processors. Use of the
Steel-Belted Radius or IMS AAA software on multiple computers or virtual machines (e.g., Solaris zones) requires multiple licenses, regardless of whether
such computers or virtualizations are physically contained on a single chassis.

c. Product purchase documents, paper or electronic user documentation, and/or the particular licenses purchased by Customer may specify limits to
Customer’s use of the Software. Such limits may restrict use to a maximum number of seats, registered endpoints, concurrent users, sessions, calls,
connections, subscribers, clusters, nodes, realms, devices, links, ports or transactions, or require the purchase of separate licenses to use particular features,
functionalities, services, applications, operations, or capabilities, or provide throughput, performance, configuration, bandwidth, interface, processing,
temporal, or geographical limits. In addition, such limits may restrict the use of the Software to managing certain kinds of networks or require the Software
to be used only in conjunction with other specific Software. Customer’s use of the Software shall be subject to all such limitations and purchase of all applicable
licenses.

d. For any trial copy of the Software, Customer’s right to use the Software expires 30 days after download, installation or use of the Software. Customer
may operate the Software after the 30-day trial period only if Customer pays for a license to do so. Customer may not extend or create an additional trial
period by re-installing the Software after the 30-day trial period.

e. The Global Enterprise Edition of the Steel-Belted Radius software may be used by Customer only to manage access to Customer’s enterprise network.
Specifically, service provider customers are expressly prohibited from using the Global Enterprise Edition of the Steel-Belted Radius software to support any
commercial network access services.

The foregoing license is not transferable or assignable by Customer. No license is granted herein to any user who did not originally purchase the applicable
license(s) for the Software from Juniper or an authorized Juniper reseller.

4. Use Prohibitions. Notwithstanding the foregoing, the license provided herein does not permit the Customer to, and Customer agrees not to and shall
not: (a) modify, unbundle, reverse engineer, or create derivative works based on the Software; (b) make unauthorized copies of the Software (except as
necessary for backup purposes); (c) rent, sell, transfer, or grant any rights in and to any copy of the Software, in any form, to any third party; (d) remove
any proprietary notices, labels, or marks on or in any copy of the Software or any product in which the Software is embedded; (e) distribute any copy of
the Software to any third party, including as may be embedded in Juniper equipment sold in the secondhand market; (f) use any ‘locked’ or key-restricted
feature, function, service, application, operation, or capability without first purchasing the applicable license(s) and obtaining a valid key from Juniper, even
if such feature, function, service, application, operation, or capability is enabled without a key; (g) distribute any key for the Software provided by Juniper
to any third party; (h) use the Software in any manner that extends or is broader than the uses purchased by Customer from Juniper or an authorized Juniper
reseller; (i) use Embedded Software on non-Juniper equipment; (j) use Embedded Software (or make it available for use) on Juniper equipment that the
Customer did not originally purchase from Juniper or an authorized Juniper reseller; (k) disclose the results of testing or benchmarking of the Software to
any third party without the prior written consent of Juniper; or (l) use the Software in any manner other than as expressly provided herein.

5. Audit. Customer shall maintain accurate records as necessary to verify compliance with this Agreement. Upon request by Juniper, Customer shall furnish
such records to Juniper and certify its compliance with this Agreement.
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6. Confidentiality. The Parties agree that aspects of the Software and associated documentation are the confidential property of Juniper. As such, Customer
shall exercise all reasonable commercial efforts to maintain the Software and associated documentation in confidence, which at a minimum includes
restricting access to the Software to Customer employees and contractors having a need to use the Software for Customer’s internal business purposes.

7. Ownership. Juniper and Juniper’s licensors, respectively, retain ownership of all right, title, and interest (including copyright) in and to the Software,
associated documentation, and all copies of the Software. Nothing in this Agreement constitutes a transfer or conveyance of any right, title, or interest in
the Software or associated documentation, or a sale of the Software, associated documentation, or copies of the Software.

8. Warranty, Limitation of Liability, Disclaimer of Warranty. The warranty applicable to the Software shall be as set forth in the warranty statement that
accompanies the Software (the “Warranty Statement”). Nothing in this Agreement shall give rise to any obligation to support the Software. Support services
may be purchased separately. Any such support shall be governed by a separate, written support services agreement. TO THE MAXIMUM EXTENT PERMITTED
BY LAW, JUNIPER SHALL NOT BE LIABLE FOR ANY LOST PROFITS, LOSS OF DATA, OR COSTS OR PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES,
OR FOR ANY SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THIS AGREEMENT, THE SOFTWARE, OR ANY JUNIPER OR
JUNIPER-SUPPLIED SOFTWARE. IN NO EVENT SHALL JUNIPER BE LIABLE FOR DAMAGES ARISING FROM UNAUTHORIZED OR IMPROPER USE OF ANY
JUNIPER OR JUNIPER-SUPPLIED SOFTWARE. EXCEPT AS EXPRESSLY PROVIDED IN THE WARRANTY STATEMENT TO THE EXTENT PERMITTED BY LAW,
JUNIPER DISCLAIMS ANY AND ALL WARRANTIES IN AND TO THE SOFTWARE (WHETHER EXPRESS, IMPLIED, STATUTORY, OR OTHERWISE), INCLUDING
ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT DOES JUNIPER
WARRANT THAT THE SOFTWARE, OR ANY EQUIPMENT OR NETWORK RUNNING THE SOFTWARE, WILL OPERATE WITHOUT ERROR OR INTERRUPTION,
OR WILL BE FREE OF VULNERABILITY TO INTRUSION OR ATTACK. In no event shall Juniper’s or its suppliers’ or licensors’ liability to Customer, whether
in contract, tort (including negligence), breach of warranty, or otherwise, exceed the price paid by Customer for the Software that gave rise to the claim, or
if the Software is embedded in another Juniper product, the price paid by Customer for such other product. Customer acknowledges and agrees that Juniper
has set its prices and entered into this Agreement in reliance upon the disclaimers of warranty and the limitations of liability set forth herein, that the same
reflect an allocation of risk between the Parties (including the risk that a contract remedy may fail of its essential purpose and cause consequential loss),
and that the same form an essential basis of the bargain between the Parties.

9. Termination. Any breach of this Agreement or failure by Customer to pay any applicable fees due shall result in automatic termination of the license
granted herein. Upon such termination, Customer shall destroy or return to Juniper all copies of the Software and related documentation in Customer’s
possession or control.

10. Taxes. All license fees payable under this agreement are exclusive of tax. Customer shall be responsible for paying Taxes arising from the purchase of
the license, or importation or use of the Software. If applicable, valid exemption documentation for each taxing jurisdiction shall be provided to Juniper prior
to invoicing, and Customer shall promptly notify Juniper if their exemption is revoked or modified. All payments made by Customer shall be net of any
applicable withholding tax. Customer will provide reasonable assistance to Juniper in connection with such withholding taxes by promptly: providing Juniper
with valid tax receipts and other required documentation showing Customer’s payment of any withholding taxes; completing appropriate applications that
would reduce the amount of withholding tax to be paid; and notifying and assisting Juniper in any audit or tax proceeding related to transactions hereunder.
Customer shall comply with all applicable tax laws and regulations, and Customer will promptly pay or reimburse Juniper for all costs and damages related
to any liability incurred by Juniper as a result of Customer’s non-compliance or delay with its responsibilities herein. Customer’s obligations under this
Section shall survive termination or expiration of this Agreement.

11. Export. Customer agrees to comply with all applicable export laws and restrictions and regulations of any United States and any applicable foreign
agency or authority, and not to export or re-export the Software or any direct product thereof in violation of any such restrictions, laws or regulations, or
without all necessary approvals. Customer shall be liable for any such violations. The version of the Software supplied to Customer may contain encryption
or other capabilities restricting Customer’s ability to export the Software without an export license.

12. Commercial Computer Software. The Software is “commercial computer software” and is provided with restricted rights. Use, duplication, or disclosure
by the United States government is subject to restrictions set forth in this Agreement and as provided in DFARS 227.7201 through 227.7202-4, FAR 12.212,
FAR 27.405(b)(2), FAR 52.227-19, or FAR 52.227-14(ALT III) as applicable.

13. Interface Information. To the extent required by applicable law, and at Customer's written request, Juniper shall provide Customer with the interface
information needed to achieve interoperability between the Software and another independently created program, on payment of applicable fee, if any.
Customer shall observe strict obligations of confidentiality with respect to such information and shall use such information in compliance with any applicable
terms and conditions upon which Juniper makes such information available.

14. Third Party Software. Any licensor of Juniper whose software is embedded in the Software and any supplier of Juniper whose products or technology
are embedded in (or services are accessed by) the Software shall be a third party beneficiary with respect to this Agreement, and such licensor or vendor
shall have the right to enforce this Agreement in its own name as if it were Juniper. In addition, certain third party software may be provided with the
Software and is subject to the accompanying license(s), if any, of its respective owner(s). To the extent portions of the Software are distributed under and
subject to open source licenses obligating Juniper to make the source code for such portions publicly available (such as the GNU General Public License
(“GPL”) or the GNU Library General Public License (“LGPL”)), Juniper will make such source code portions (including Juniper modifications, as appropriate)
available upon request for a period of up to three years from the date of distribution. Such request can be made in writing to Juniper Networks, Inc., 1194
N. Mathilda Ave., Sunnyvale, CA 94089, ATTN: General Counsel. You may obtain a copy of the GPL at http://www.gnu.org/licenses/gpl.html, and
a copy of the LGPL at http://www.gnu.org/licenses/lgpl.html .

15. Miscellaneous. This Agreement shall be governed by the laws of the State of California without reference to its conflicts of laws principles. The provisions
of the U.N. Convention for the International Sale of Goods shall not apply to this Agreement. For any disputes arising under this Agreement, the Parties
hereby consent to the personal and exclusive jurisdiction of, and venue in, the state and federal courts within Santa Clara County, California. This Agreement
constitutes the entire and sole agreement between Juniper and the Customer with respect to the Software, and supersedes all prior and contemporaneous
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agreements relating to the Software, whether oral or written (including any inconsistent terms contained in a purchase order), except that the terms of a
separate written agreement executed by an authorized Juniper representative and Customer shall govern to the extent such terms are inconsistent or conflict
with terms contained herein. No modification to this Agreement nor any waiver of any rights hereunder shall be effective unless expressly assented to in
writing by the party to be charged. If any portion of this Agreement is held invalid, the Parties agree that such invalidity shall not affect the validity of the
remainder of this Agreement. This Agreement and associated documentation has been written in the English language, and the Parties agree that the English
version will govern. (For Canada: Les parties aux présentés confirment leur volonté que cette convention de même que tous les documents y compris tout
avis qui s'y rattaché, soient redigés en langue anglaise. (Translation: The parties confirm that this Agreement and all related documentation is and will be
in the English language)).
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About This Guide

This preface provides the following guidelines for using the JUNOS Software Interfaces
and Routing Configuration Guide:

■ J Series and SRX Series Documentation and Release Notes on page xxxvii

■ Objectives on page xxxviii

■ Audience on page xxxviii

■ Supported Routing Platforms on page xxxviii

■ Document Conventions on page xxxviii

■ Documentation Feedback on page xl

■ Requesting Technical Support on page xl

J Series and SRX Series Documentation and Release Notes

For a list of related J Series documentation, see
http://www.juniper.net/techpubs/software/junos-jseries/index-main.html .

For a list of related SRX Series documentation, see
http://www.juniper.net/techpubs/hardware/srx-series-main.html .

If the information in the latest release notes differs from the information in the
documentation, follow the JUNOS Software Release Notes.

To obtain the most current version of all Juniper Networks® technical documentation,
see the product documentation page on the Juniper Networks website at
http://www.juniper.net/techpubs/.

Juniper Networks supports a technical book program to publish books by Juniper
Networks engineers and subject matter experts with book publishers around the
world. These books go beyond the technical documentation to explore the nuances
of network architecture, deployment, and administration using JUNOS Software and
Juniper Networks devices. In addition, the Juniper Networks Technical Library,
published in conjunction with O'Reilly Media, explores improving network security,
reliability, and availability using JUNOS configuration techniques. All the books are
for sale at technical bookstores and book outlets around the world. The current list
can be viewed at http://www.juniper.net/books .
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Objectives

This guide contains instructions for configuring the J Series and SRX Series interfaces
for basic IP routing with standard routing protocols. It also shows how to create
backup ISDN interfaces, configure digital subscriber line (DSL) connections and link
services, create stateless firewall filters—also known as access control lists
(ACLs)—and configure class-of-service (CoS) traffic classification.

Audience

This manual is designed for anyone who installs, sets up, configures, monitors, or
administers a J Series Services Router or an SRX Series Services Gateway running
Junos OS. The manual is intended for the following audiences:

■ Customers with technical knowledge of and experience with networks and
network security, the Internet, and Internet routing protocols

■ Network administrators who install, configure, and manage Internet routers

Supported Routing Platforms

This manual describes features supported on J Series Services Routers and SRX Series
Services Gateways running Junos OS.

Document Conventions

Table 1 on page xxxviii defines the notice icons used in this guide.

Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware damage.Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning
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Table 2 on page xxxix defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type the
configure command:

user@host> configure

Represents text that you type.Bold text like this

user@host> show chassis alarms
No alarms currently active

Represents output that appears on the
terminal screen.

Fixed-width text like this

■ A policy term is a named structure
that defines match conditions and
actions.

■ Junos System Basics Configuration
Guide

■ RFC 1997, BGP Communities
Attribute

■ Introduces important new terms.

■ Identifies book names.

■ Identifies RFC and Internet draft
titles.

Italic text like this

Configure the machine’s domain name:

[edit]
root@# set system domain-name

domain-name

Represents variables (options for which
you substitute a value) in commands or
configuration statements.

Italic text like this

■ To configure a stub area, include
the stub statement at the [edit
protocols ospf area area-id]
hierarchy level.

■ The console port is labeled
CONSOLE.

Represents names of configuration
statements, commands, files, and
directories; IP addresses; configuration
hierarchy levels; or labels on routing
platform components.

Plain text like this

stub <default-metric metric>;Enclose optional keywords or variables.< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between the mutually
exclusive keywords or variables on either
side of the symbol. The set of choices is
often enclosed in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamic MPLS onlyIndicates a comment specified on the
same line as the configuration statement
to which it applies.

# (pound sign)

community name members [
community-ids ]

Enclose a variable for which you can
substitute one or more values.

[ ] (square brackets)
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

[edit]
routing-options {

static {
route default {

nexthop address;
retain;

}
}

}

Identify a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

J-Web GUI Conventions

■ In the Logical Interfaces box, select
All Interfaces.

■ To cancel the configuration, click
Cancel.

Represents J-Web graphical user
interface (GUI) items you click or select.

Bold text like this

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of J-Web
selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback, comments, and suggestions so that we can
improve the documentation. You can send your comments to
techpubs-comments@juniper.net, or fill out the documentation feedback form at
https://www.juniper.net/cgi-bin/docbugreport/. If you are using e-mail, be sure to include
the following information with your comments:

■ Document or topic name

■ URL or page number

■ Software release version (if applicable)

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical
Assistance Center (JTAC). If you are a customer with an active J-Care or JNASC support
contract, or are covered under warranty, and need postsales technical support, you
can access our tools and resources online or open a case with JTAC.

■ JTAC policies—For a complete understanding of our JTAC procedures and policies,
review the JTAC User Guide located at
http://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf  .

■ Product warranties—For product warranty information, visit
http://www.juniper.net/support/warranty/ .

■ JTAC Hours of Operation —The JTAC centers have resources available 24 hours
a day, 7 days a week, 365 days a year.
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Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online
self-service portal called the Customer Support Center (CSC) that provides you with
the following features:

■ Find CSC offerings: http://www.juniper.net/customers/support/

■ Search for known bugs: http://www2.juniper.net/kb/

■ Find product documentation: http://www.juniper.net/techpubs/

■ Find solutions and answer questions using our Knowledge Base:
http://kb.juniper.net/

■ Download the latest versions of software and review release notes:
http://www.juniper.net/customers/csc/software/

■ Search technical bulletins for relevant hardware and software notifications:
https://www.juniper.net/alerts/

■ Join and participate in the Juniper Networks Community Forum:
http://www.juniper.net/company/communities/

■ Open a case online in the CSC Case Management tool: http://www.juniper.net/cm/

To verify service entitlement by product serial number, use our Serial Number
Entitlement (SNE) Tool: https://tools.juniper.net/SerialNumberEntitlementSearch/

Opening a Case with JTAC

You can open a case with JTAC on the Web or by telephone.

■ Use the Case Management tool in the CSC at http://www.juniper.net/cm/ .

■ Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, visit
us at  http://www.juniper.net/support/requesting-support.html
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Part 1

Configuring Router Interfaces

■ Interfaces Overview on page 3

■ Configuring Ethernet, DS1, DS3, and Serial Interfaces on page 81

■ Configuring Channelized T1/E1/ISDN PRI Interfaces on page 117

■ Configuring Digital Subscriber Line Interfaces on page 133

■ Configuring G.SHDSL Interfaces on page 165

■ Configuring DOCSIS Mini-PIM Interfaces on page 181

■ Configuring VDSL2 Interface on page 189

■ Configuring 2-Port 10 Gigabit Ethernet XPIM on page 227

■ Voice over Internet Protocol with Avaya on page 237

■ Configuring Point-to-Point Protocol over Ethernet on page 289

■ Configuring ISDN on page 309

■ Configuring 3G Wireless Modems for WAN Connections on page 355

■ Configuring USB Modems for Dial Backup on page 383

■ Configuring Link Services Interfaces on page 399

■ Aggregated Ethernet on page 449
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Chapter 1

Interfaces Overview

J Series Services Routers and SRX Series Service Gateways support a variety of
interface types.

To configure and monitor J Series or SRX Series device interfaces, you need to
understand their media characteristics, as well as physical and logical properties such
as IP addressing, link-layer protocols, and link encapsulation.

For more information about interfaces, see the Junos Network Interfaces Configuration
Guide, the Junos Services Interfaces Configuration Guide, and the Junos Interfaces
Command Reference.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Interfaces Terms on page 4

■ Network Interfaces on page 8

■ Data Link Layer Overview on page 14

■ Ethernet Interface Overview on page 15

■ T1 and E1 Interfaces Overview on page 19

■ Channelized T1/E1/ISDN PRI Interfaces Overview on page 23

■ T3 and E3 Interfaces Overview on page 23

■ Serial Interface Overview on page 28

■ ADSL Interface Overview on page 34

■ SHDSL Interface Overview on page 38

■ G.SHDSL Mini-PIM on page 39

■ VDSL2 Interface Overview on page 41

■ DOCSIS Mini-PIM Interface Overview on page 45

■ 2-Port 10 Gigabit Ethernet XPIM Overview on page 47

■ ISDN Interface Overview on page 49

■ Interface Physical Properties on page 52

■ Physical Encapsulation on an Interface on page 57
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■ Interface Logical Properties on page 64

■ Special Interfaces on page 74

Interfaces Terms

To understand interfaces, become familiar with the terms defined in Table 3 on
page 4.

Table 3: Network Interfaces Terms

DefinitionTerm

Standard Ethernet specification that provides 10 Gbps connections over unshielded or
shielded twisted pair cables.

10GBASE-T or IEEE 802.3an

Standard Ethernet specification that provides 1 Gbps connections over twisted pair.1000BASE-T IEEE 802.3ab

Standard Ethernet specification that provides 100 Mbps connections over twisted pair.100BASE-T IEEE 802.3u

Original method of formatting T1 and E1 data streams.alternate mark inversion (AMI)

Physical WAN interface for connecting a J Series device to a digital subscriber line access
multiplexer (DSLAM). An ADSL interface allocates line bandwidth asymmetrically with
downstream (provider-to-customer) data rates of up to 8 Mbps for ADSL, 12 Mbps for
ADSL2, and 25 Mbps for ADSL2+, and upstream (customer-to-provider) rates of up to
800 Kbps for ADSL and 1 Mbps for ADSL2 and ADSL2+, depending on the
implementation.

asymmetric digital subscriber line
(ADSL) interface

An ADSL interface that supports ITU-T Standards G.992.3 and G.992.4 and allocates
downstream (provider-to-customer) data rates of up to 12 Mbps and upstream
(customer-to-provider) rates of up to 1 Mbps.

ADSL2 interface

An ADSL interface that supports ITU-T Standard G.992.5 and allocates downstream
(provider-to-customer) data rates of up to 25 Mbps and upstream (customer-to-provider)
rates of up to 1 Mbps.

ADSL2+ interface

ITU-T Standard G.992.1 that defines how ADSL works over plain old telephone service
(POTS) lines.

Annex A

ITU-T Standard G.992.1 that defines how ADSL works over Integrated Services Digital
Network (ISDN) lines.

Annex B

Improved method of formatting T1 and E1 data streams, in which a special code is
substituted whenever 8 consecutive zeros are sent over the link.

binary 8-zero substitution (B8ZS)

Protocol that authenticates remote users. CHAP is a server-driven, three-step
authentication method that depends on a shared secret password residing on both the
server and the client.

Challenge Handshake
Authentication Protocol (CHAP)

See frame checksum sequence.checksum

Combination of DS0 interfaces partitioned from a channelized interface into a single
logical bundle.

channel group

Unit that connects a digital telephone line to a multiplexer or other signal service.channel service unit (CSU)
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Table 3: Network Interfaces Terms (continued)

DefinitionTerm

2.048-Mbps interface that can be configured as a single clear-channel E1 interface or
channelized into as many as 31 discrete DS0 interfaces, or up to 30 ISDN PRI B-channels
and 1 D-channel. On J Series channelized T1/E1/ISDN PRI interfaces, time slots are
numbered from 1 through 31, and time slot 1 is reserved for framing. When the interface
is configured for ISDN PRI service, time slot 16 is reserved for the D-channel.

channelized E1

Interface that is a subdivision of a larger interface, minimizing the number of Physical
Interface Modules (PIMs) that an installation requires. On a channelized PIM, each port
can be configured as a single clear channel or partitioned into multiple discrete T1, E1,
and DS0 interfaces.

channelized interface

1.544-Mbps interface that can be configured as a single clear-channel T1 interface or
channelized into as many as 24 discrete DS0 interfaces, or up to 23 ISDN PRI B-channels
and 1 D-channel. When the interface is configured for ISDN PRI service, time slot 24 is
reserved for the D-channel.

channelized T1

Cisco High-level Data Link Control protocol. Proprietary Cisco encapsulation for
transmitting LAN protocols over a WAN. HDLC specifies a data encapsulation method
on synchronous serial links by means of frame characters and checksums. Cisco HDLC
enables the transmission of multiple protocols.

Cisco HDLC

Source of the consistent, periodic signal used by a device to synchronize data
communication and processing tasks.

clock source

Subrate on an E3 or T3 interface that allows a J Series device to connect to a channel
service unit (CSU) with proprietary multiplexing at the remote end of the line. Subrating
an E3 or T3 interface reduces the maximum allowable peak rate by limiting the payload
encapsulated by the High-level Data Link Control protocol (HDLC).

CSU compatibility mode

Identifier for a Frame Relay virtual connection, also called a logical interface.data-link connection identifier
(DLCI)

Unit that connects a data terminal equipment (DTE) device—in this case, a J Series
Services Router or an SRX Series Services Gateway— to a digital telephone line.

data service unit (DSU)

RS-232 interface that a Juniper Networks device uses to exchange information with a
serial device.

data terminal equipment (DTE)

Digital signal 1, another name for a T1 interface.DS1

Digital signal 3, another name for a T3 interface.DS3 interface

Transmission of all data bits in the data stream so that zeros are transmitted as ones and
ones are transmitted as zeros. Data inversion is normally used only in alternate mark
inversion (AMI) mode to guarantee ones density in the transmitted stream.

data inversion

Physical WAN interface for transmitting signals in European digital transmission (E1)
format. The E1 signal format carries information at a rate of 2.048 Mbps and can carry
32 channels of 64 Kbps each.

E1 interface

Physical WAN interface for transmitting 16 E1 circuits over copper wires using
time-division multiplexing. E3 is widely used outside of North America and transfers
traffic at the rate of 34.368 Mbps.

E3 interface

Type of protocol header in which data is wrapped for transmission.encapsulation type
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Table 3: Network Interfaces Terms (continued)

DefinitionTerm

Physical LAN interface for transmitting data at 100 Mbps. Fast Ethernet, also called
100Base-T, additionally supports standard 10Base-T Ethernet transmission. Fast Ethernet
is available on both dual-port and 4-port PIMs for the J4350 and J6350 devices.

Fast Ethernet interface

Logical identifier for a Physical Interface Module (PIM) installed on a J Series device. The
FPC number used in the JUNOS command-line interface (CLI) and displayed in command
output represents the chassis slot in which a PIM is installed.

FPC

Interface that contains one or more of the 32 DS0 time slots that can be reserved from
an E1 interface. (Time slot 0 is reserved.)

fractional E1

Interface that contains one or more of the 24 DS0 time slots that can be reserved from
a T1 interface. (Time slot 0 is reserved.)

fractional T1

Calculation that is added to a frame to control errors in High-level Data Link Control
(HDLC), Frame Relay, and other data link layer protocols.

frame check sequence (FCS)

An efficient WAN protocol that does not require explicit acknowledgement of each frame
of data. Frame Relay allows private networks to reduce costs by sharing facilities between
the endpoint switches of a network managed by a Frame Relay service provider. Individual
data link connection identifiers (DLCIs) are assigned to ensure that customers receive
only their own traffic.

Frame Relay

Physical LAN or WAN interface for transmitting data at 1000 Mbps. The four built-in
ports on J4350 and J6350 devices are Gigabit Ethernet interfaces. Gigabit Ethernet is also
available in a single-port copper or optical PIM for these devices. Gigabit Ethernet is also
supported in SRX Series devices.

Gigabit Ethernet interface

International Telecommunication Union (ITU) standard for a bit-oriented data link layer
protocol on which most other bit-oriented protocols are based.

High-Level Data Link Control
(HDLC)

Name assigned to the device during initial configuration.hostname

International Telecommunication Union standard describing a data transmission method
for symmetric high-speed digital subscriber line (SHDSL) as a means for data transport
in telecommunications access networks. The standard also describes the functionality
required for interoperability of equipment from various manufacturers.

ITU-T G.991.2

International Telecommunication Union standard that requires the downstream
(provider-to-customer) data transmission to consist of full-duplex low-speed bearer
channels and simplex high-speed bearer channels. In the upstream (customer-to-provider)
transmissions, only low-speed bearer channels are provided.

ITU-T G.992.1

International Telecommunication Union standard describing a data transmission method
for VDSL2 transceivers.

ITU-T G.993.2

International Telecommunication Union standard describing the types of signals,
messages, and procedures exchanged between digital subscriber line (DSL) equipment
when the operational modes of equipment need to be automatically established and
selected.

ITU-T G.994.1
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Table 3: Network Interfaces Terms (continued)

DefinitionTerm

International Telecommunication Union standard describing the physical layer
management for asymmetric digital subscriber line (ADSL) transmission systems. The
standard specifies the means of communication on a transport transmission channel
defined in the physical layer recommendations. In addition, the standard describes the
content and syntax of network elements for configuration, fault management, and
performance management.

ITU-T G.997.1

Virtual interface that you create on a physical interface to identify its connection. Creating
multiple logical interfaces allows you to associate multiple virtual circuits, data line
connections, or virtual LANs (VLANs) with a single interface device.

logical interface

Maximum or largest segment size that a network can transmit.maximum transmission unit
(MTU)

Protocol that allows multiple Frame Relay links to be aggregated by inverse multiplexing.Multilink Frame Relay (MLFR)

Protocol that allows you to bundle multiple Point-to-Point Protocol (PPP) links into a
single logical unit. MLPPP improves bandwidth efficiency and fault tolerance and reduces
latency.

Multilink Point-to-Point Protocol
(MLPPP)

Authentication protocol that uses a simple 2-way handshake to establish identity.Password Authentication Protocol
(PAP)

Network interface card that is fixed or can be interchangeably installed on a J Series
device to provide the physical connections to a LAN or WAN, receiving incoming packets
and transmitting outgoing packets. A PIM contains one of the following interfaces or sets
of interfaces:

■ Single Gigabit Ethernet LAN or WAN interface

■ Two or four Fast Ethernet LAN interfaces

■ Two T1 or two E1 WAN interfaces

■ Single E3 or T3 (DS3) WAN interface (J4350 and J6350 models only)

■ Single asynchronous digital subscriber line (ADSL) WAN interface—Annex A to
support ADSL over plain old telephone service (POTS) lines or Annex B to support
ADSL over ISDN

■ Four ISDN BRI S/T or U interfaces

■ Two channelized T1/E1/ISDN PRI interfaces

■ Two serial interfaces

■ Symmetric high-speed digital subscriber line (SHDSL) WAN interface—Annex A or
Annex B to support ATM-over-SHDSL connections

Physical Interface Module (PIM)

Link-layer protocol that provides multiprotocol encapsulation. PPP is used for link-layer
and network-layer configuration.

Point-to-Point Protocol (PPP)

Transport of packet-based services method based on the EFM IEEE802.3AH standard.Packet Transfer Mode (PTM)
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Table 3: Network Interfaces Terms (continued)

DefinitionTerm

Physical LAN interface for transmitting data between computing devices. A J Series device
has two types of serial interfaces:

■ Asynchronous serial interface—Console port, with speeds up to 110.5 Kbps. The
console port supports an RS-232 (EIA-232) standard serial cable with a 25-pin (DB-25)
connector.

■ Synchronous serial interface—Port that transmits packets to and from, for example,
a T1 device or microwave link, at speeds up to 8 Mbps. You cannot use this serial
interface to connect a console. J Series device synchronous serial interfaces support
RS-232 (EIA-232), RS-422/449 (EIA-449), RS-530 (EIA-530), V.35, and X.21 cable
types. For details, see “Serial Line Protocols” on page 31.

For cable details, see the J Series Services Routers Hardware Guide.

serial interface

Fiber optic transceiver module designed for 10-Gigabit Ethernet and 8.5 Gbps fiber
channel systems.

SFP+

Physical WAN symmetric DSL interface capable of sending and receiving high-speed
symmetrical data streams over a single pair of copper wires at rates between 192 Kbps
and 2.31 Mbps. G.SHDSL incorporates features of other DSL technologies such as
asymmetric DSL and transports T1, E1, ISDN, Asynchronous Transfer Mode (ATM), and
IP signals.

symmetric high-speed digital
subscriber line (G.SHDSL)

Equipment that provides symmetric high-speed digital subscriber line (SHDSL) connections
to remote user terminals such as data terminals or telecommunications equipment.

symmetric high-speed digital
subscriber line (SHDSL)
transceiver unit–remote (STU–R)

Physical WAN interface for transmitting digital signals in the T-carrier system used in
the United States, Japan, and Canada. The T1 signal format carries 24 pulse code
modulation (PCM) signals using time-division multiplexing (TDM) at an overall rate of
1.544 Mbps.

T1 interface

Physical WAN interface for transmitting digital signals in the T-carrier system used in
the United States, Japan, and Canada. T3 signals are formatted like T1 signals, but carry
information at the higher rate of 44.736 Mbps. T3 is also called DS3.

T3 interface

VDSL2 is an enhancement to G.993.1 (VDSL) that permits the transmission of asymmetric
and symmetric (full duplex) aggregate data at faster rate. VDSL2 is based on ITU-T G.993.2
(VDSL2) standard.

VDSL2

Physical Interface Modules (PIMs) that provides 10-Gigabit Ethernet front end interface
connection.

XPIM

Network Interfaces

All Juniper Networks devices use network interfaces to make physical connections
to other devices. A connection takes place along media-specific physical wires through
a port on a Physical Interface Module (PIM) installed in the J Series Services Router
or an Input/Output Card (IOC) in the SRX Series Services Gateway. Each device
interface has a unique name that follows a naming convention.
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This section contains the following topics:

■ Media Types on page 9

■ Network Interface Naming on page 9

Media Types

Each type of interface on a J Series or SRX Series device uses a particular medium
to transmit data. The physical wires and data link layer protocols used by a medium
determine how traffic is sent. See the Junos OS Feature Support Reference for SRX
Series and J Series Devices for a list of media supported on each type of device.

You must configure each network interface before it can operate on the device.
Configuring an interface can define both the physical properties of the link and the
logical properties of a logical interface on the link.

Network Interface Naming

The interfaces on the J Series and SRX Series devices are used for networking and
services. Most interfaces are configurable, but some internally generated interfaces
are not configurable. If you are familiar with Juniper Networks M Series and T Series
routing platforms, be aware that device interface names are similar to but not identical
with the interface names on those routing platforms.

This section contains the following topics:

■ Interface Naming Conventions on page 9

■ Understanding CLI Output for Interfaces on page 12

Interface Naming Conventions

The unique name of each network interface identifies its type and location and
indicates whether it is a physical interface or an optional logical unit created on a
physical interface:

■ The name of each network interface has the following format to identify the
physical device that corresponds to a single physical network connector:

type-slot/pim-or-ioc/port

■ Network interfaces that are fractionalized into time slots include a channel
number in the name, preceded by a colon (:):

type-slot/pim-or-ioc/port:channel

■ Each logical interface has an additional logical unit identifier, preceded by a
period (.):

type-slot/pim-or-ioc/port:<channel>.unit

The parts of an interface name are summarized in Table 4 on page 10.

Network Interfaces ■ 9
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Table 4: Network Interface Names

Possible ValuesMeaningName Part

ae—Aggregated Ethernet interface

at—ATM-over-ADSL or ATM-over-SHDSL WAN interface

bc—Bearer channel on an ISDN interface

br—Basic Rate Interface for establishing ISDN connections

ce1—Channelized E1 interface

ct1—Channelized T1 interface

dc—Delta channel on an ISDN interface

dl—Dialer interface for initiating ISDN and USB modem connections

e1—E1 WAN interface

e3—E3 WAN interface

fe—Fast Ethernet interface

ge—Gigabit Ethernet interface

pt—VDSL2 interface

reth—For chassis cluster configurations only, redundant Ethernet interface

se—Serial interface (either RS-232, RS-422/499, RS-530, V.35, or X.21)

t1—T1 (also called DS1) WAN interface

t3—T3 (also called DS3) WAN interface

wx—WXC Integrated Services Module (ISM 200) interface for WAN
acceleration

xe—10-Gigabit Ethernet interface

In addition to these network interfaces, devices can have the following
special interfaces: dsc, gr and gre, ip and ipip, lo, ls and lsi, lt, pd and pimd,
pc, pe and pime, pp0, st, tap, and umd0. For more information, see “Special
Interfaces” on page 74.

Type of network medium
that can connect to this
interface.

type
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Table 4: Network Interface Names (continued)

Possible ValuesMeaningName Part

J Series Services Router: The slot number begins at 1 and increases as
follows from top to bottom, left to right:

■ J2320 router—Slots 1 to 3

■ J2350 router—Slots 1 to 5

■ J4350 or J6350 router—PIM slots 1 to 6

The slot number 0 is reserved for the out-of-band management ports. (See
“Management Interface” on page 77.)

SRX5600 and SRX5800 devices: The slot number begins at 0 and increases
as follows from left to right, bottom to top:

■ SRX5600 device—Slots 0 to 5

■ SRX5800 device—Slots 0 to 5, 7 to 11

SRX3400 and SRX3600 devices: The Switch Fabric Board (SFB) is always
0. Slot numbers increase as follows from top to bottom, left to right:

■ SRX3400 devce—Slots 0 to 4

■ SRX3600 device—Slots 0 to 6

Number of the chassis slot in
which a PIM or IOC is
installed.

slot

J Series devices: This number is always 0. Only one PIM can be installed
in a slot.

SRX5600 and SRX5800 devices: For 40-port Gigabit Ethernet IOCs or
4-port 10-Gigabit Ethernet IOCs, this number can be 0, 1, 2, or 3.

SRX3400 and SRX3600 devices: This number is always 0. Only one IOC
can be installed in a slot.

Number of the PIM or IOC on
which the physical interface
is located.

pim-or-ioc

J Series Services Routers:

■ On a single-port PIM, always 0.

■ On a multiple-port PIM, this number begins at 0 and increases from
left to right, bottom to top, to a maximum of 3.

On SRX5600 and SRX5800 devices:

■ For 40-port Gigabit Ethernet IOCs, this number begins at 0 and
increases from left to right to a maximum of 9.

■ For 4-port 10-Gigabit Ethernet IOCs, this number is always 0.

On SRX3400 and SRX3600 devices:

■ For the SFB built-in copper Gigabit Ethernet ports, this number begins
at 0 and increases from top to bottom, left to right, to a maximum
of 7. For the SFB built-in fiber Gigabit Ethernet ports, this number
begins at 8 and increases from left to right to a maximum of 11.

■ For 16-port Gigabit Ethernet IOCs, this number begins at 0 to a
maximum of 15.

■ For 2-port 10-Gigabit Ethernet IOCs, this number is 0 or 1.

Port numbers appear on the PIM or IOC faceplate.

Number of the port on a PIM
or IOC on which the physical
interface is located.

port

Network Interfaces ■ 11

Chapter 1: Interfaces Overview



Table 4: Network Interface Names (continued)

Possible ValuesMeaningName Part

■ On an E1 interface, a value from 1 through 31. The 1 time slot is
reserved.

■ On a T1 interface, a value from 1 through 24.

Number of the channel (time
slot) on a fractional or
channelized T1 or E1
interface.

channel

A value from 0 through 16384.

If no logical interface number is specified, unit 0 is the default, but must
be explicitly configured. For more information about logical interfaces,
see “Interface Logical Properties” on page 64.

Number of the logical
interface created on a
physical interface.

unit

For example, the interface name e1-5/0/0:15.0 on a J Series Services Router
represents the following information:

■ E1 WAN interface

■ PIM slot 5

■ PIM number 0 (always 0)

■ Port 0

■ Channel 15

■ Logical interface, or unit, 0

Understanding CLI Output for Interfaces

The JUNOS Software that operates on J Series Services Routers and SRX Series Services
Gateways was originally developed for Juniper Networks routing platforms that
support many ports, on interface cards called Physical Interface Cards (PICs). On
these larger platforms, PICs are installed into slots on Flexible PIC Concentrators
(FPCs), and FPCs are installed into slots in the router chassis.

For J Series and SRX Series devices, PIM and IOC slots are detected internally by the
JUNOS Software as FPC slots, and the PIM or IOC in each slot is identified as a “PIC.”
For example, in the following output, the three PIMs located in slots 0, 2, and 5 are
reported as FPC 0, FPC 2, and FPC 5, and PIM 0 is reported as PIC 0:

user@host> show chassis hardware
Hardware inventory:
Item             Version  Part number  Serial number     Description
Chassis                                JN000192AB        J4350
Midplane         REV 02.04 710-010001  CORE99563        
System IO        REV 02.03 710-010003  CORE100885        System IO board
Routing Engine   RevX2.6  750-010005   IWGS40735451      RE-J.2
FPC 0                                                    FPC
  PIC 0                                                  2x FE
FPC 2            RevX2.1  750-010355   CORE100458        FPC
  PIC 0                                                  2x T1
FPC 5            REV 04   750-010353   AF04451744        FPC
  PIC 0                                                  2x FE
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To understand the abbreviations for PICs that appear in JUNOS CLI output, see Table
5 on page 13. For details, see the J Series Services Routers Hardware Guide.

Table 5: PIC Abbreviations and Full Names

PIC or IOC Name
PIC Abbreviation in JUNOS
CLI

Dual-Port Fast Ethernet PIM2x FE

4-Port Fast Ethernet ePIM4x FE

Copper Gigabit Ethernet ePIM (1 10-Mbps, 100-Mbps, or 1000-Mbps port)1x GE Copper

SFP Gigabit Ethernet ePIM (1 fiber port)1x GE SFP

1-Port Gigabit Ethernet uPIM1x SFP uPIM

6-Port SFP Gigabit Ethernet uPIM6x GE SFP uPIM

8-Port Gigabit Ethernet uPIM8x GE uPIM

16-Port Gigabit Ethernet uPIM16x GE uPIM

4 built-in Gigabit Ethernet ports on a chassis (fixed PIM)4x GE Base PIC

1-Port 10-Gigabit Ethernet IOC1x 10GE

10-Port Gigabit Ethernet IOC10x 1GE

Dual-Port Serial PIM2x Serial

Dual-Port T1 PIM2x T1

Dual-Port E1 PIM2x E1

T3 PIM (1 port)1x T3

E3 PIM (1 port)1x E3

4-Port ISDN BRI S/T PIM4x BRI S/T

4-Port ISDN BRI U PIM4x BRI U

ADSL 2/2+ Annex A PIM (1 port, for POTS)1x ADSL Annex A

ADSL 2/2+ Annex B PIM (1 port, for ISDN)1x ADSL Annex B

G.SHDSL PIM (2-port two-wire mode or 1-port four-wire mode)2x SHDSL (ATM)

VDSL2 Annex A Mini-PIM1x VDSL2 Annex A

WXC Integrated Services Module (ISM 200)Integrated Services Module

2-Port 10-Gigabit Ethernet XPIM2x 10G gPIM
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Data Link Layer Overview

The data link layer is Layer 2 in the Open Systems Interconnection (OSI) model. The
data link layer is responsible for transmitting data across a physical network link.
Each physical medium has link-layer specifications for network and link-layer protocol
characteristics such as physical addressing, network topology, error notification,
frame sequencing, and flow control.

Physical Addressing

Physical addressing is different from network addressing. Network addresses
differentiate between nodes or devices in a network, allowing traffic to be routed or
switched through the network. In contrast, physical addressing identifies devices at
the link-layer level, differentiating between individual devices on the same physical
medium. The primary form of physical addressing is the media access control (MAC)
address.

Network Topology

Network topology specifications identify how devices are linked in a network. Some
media allow devices to be connected by a bus topology, while others require a ring
topology. The bus topology is used by Ethernet technologies, which are supported
on Juniper Networks devices.

Error Notification

The data link layer provides error notifications that alert higher-layer protocols that
an error has occurred on the physical link. Examples of link-level errors include the
loss of a signal, the loss of a clocking signal across serial connections, or the loss of
the remote endpoint on a T1 or T3 link.

Frame Sequencing

The frame sequencing capabilities of the data link layer allow frames that are
transmitted out of sequence to be reordered on the receiving end of a transmission.
The integrity of the packet can then be verified by means of the bits in the Layer 2
header, which is transmitted along with the data payload.

Flow Control

Flow control within the data link layer allows receiving devices on a link to detect
congestion and notify their upstream and downstream neighbors. The neighbor
devices relay the congestion information to their higher-layer protocols so that the
flow of traffic can be altered or rerouted.

Data Link Sublayers

The data link layer is divided into two sublayers: Logical Link Control (LLC) and Media
Access Control (MAC). The LLC sublayer manages communications between devices
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over a single link of a network. This sublayer supports fields in link-layer frames that
enable multiple higher-layer protocols to share a single physical link.

The MAC sublayer governs protocol access to the physical network medium. Through
the MAC addresses that are typically assigned to all ports on a device, multiple devices
on the same physical link can uniquely identify one another at the data link layer.
MAC addresses are used in addition to the network addresses that are typically
configured manually on ports within a network.

MAC Addressing

A MAC address is the serial number permanently stored in a device adapter to
uniquely identify the device. MAC addresses operate at the data link layer, while IP
addresses operate at the network layer. The IP address of a device can change as
the device is moved around a network to different IP subnets, but the MAC address
remains the same, because it is physically tied to the device.

Within an IP network, devices match each MAC address to its corresponding
configured IP address by means of the Address Resolution Protocol (ARP). ARP
maintains a table with a mapping for each MAC address in the network.

Most Layer 2 networks use one of three primary numbering spaces—MAC-48, EUI-48
(Extended Unique Identifier), and EUI-64—which are all globally unique. MAC-48
and EUI-48 spaces each use 48-bit addresses, and EUI-64 spaces use a 64-bit
addresses, but all three use the same numbering format. MAC-48 addresses identify
network hardware, and EUI-48 addresses identify other devices and software.

The Ethernet and ATM technologies supported on devices use the MAC-48 address
space. IPv6 uses the EUI-64 address space.

MAC-48 addresses are the most commonly used MAC addresses in most networks.
These addresses are 12-digit hexadecimal numbers (48 bits in length) that typically
appear in one of the following formats:

■ MM:MM:MM:SS:SS:SS

■ MM-MM-MM-SS-SS-SS

The first three octets (MM:MM:MM or MM-MM-MM) are the ID number of the hardware
manufacturer. Manufacturer ID numbers are assigned by the Institute of Electrical
and Electronics Engineers (IEEE). The last three octets (SS:SS:SS or SS-SS-SS) make
up the serial number for the device, which is assigned by the manufacturer. For
example, an Ethernet interface card might have a MAC address of 00:05:85:c1:a6:a0.

Ethernet Interface Overview

Ethernet is a Layer 2 technology that operates in a shared bus topology. Ethernet
supports broadcast transmission, uses best-effort delivery, and has distributed access
control. Ethernet is a point-to-multipoint technology.

In a shared bus topology, all devices connect to a single, shared physical link through
which all data transmissions are sent. All traffic is broadcast, so that all devices within
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the topology receive every transmission. The devices within a single Ethernet topology
make up a broadcast domain.

Ethernet uses best-effort delivery to broadcast traffic. The physical hardware provides
no information to the sender about whether the traffic was received. If the receiving
host is offline, traffic to the host is lost. Although the Ethernet data link protocol does
not inform the sender about lost packets, higher-layer protocols like TCP/IP might
provide this type of notification.

This section contains the following topics:

■ Ethernet Access Control and Transmission on page 16

■ Collisions and Detection on page 16

■ Collision Domains and LAN Segments on page 17

■ Broadcast Domains on page 18

■ Ethernet Frames on page 18

Ethernet Access Control and Transmission

Ethernet's access control is distributed, because Ethernet has no central mechanism
that grants access to the physical medium within the network. Instead, Ethernet uses
carrier sense multiple access with collision detection (CSMA/CD). Because multiple
devices on an Ethernet network can access the physical medium, or wire,
simultaneously, each device must determine whether the physical medium is in use.
Each host listens on the wire to determine if a message is being transmitted. If it
detects no transmission, the host begins transmitting its own data.

The length of each transmission is determined by fixed Ethernet packet sizes. By
fixing the length of each transmission and enforcing a minimum idle time between
transmissions, Ethernet ensures that no pair of communicating devices on the network
can monopolize the wire and block others from sending and receiving traffic.

Collisions and Detection

When a device on an Ethernet network begins transmitting data, the data takes a
finite amount of time to reach all hosts on the network. Because of this delay, or
latency, in transmitting traffic, a device might detect an idle state on the wire just as
another device initially begins its transmission. As a result, two devices might send
traffic across a single wire at the same time. When the two electrical signals collide,
they become scrambled so that both transmissions are effectively lost.

Collision Detection

To handle collisions, Ethernet devices monitor the link while they are transmitting
data. The monitoring process is known as collision detection. If a device detects a
foreign signal while it is transmitting, it terminates the transmission and attempts
to transmit again only after detecting an idle state on the wire. Collisions continue
to occur if two colliding devices both wait the same amount of time before
retransmitting. To avoid this condition, Ethernet devices use a binary exponential
backoff algorithm.
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Backoff Algorithm

To use the binary exponential backoff algorithm, each device that sent a colliding
transmission randomly selects a value within a range. The value represents the
number of transmission times that the device must wait before retransmitting its
data. If another collision occurs, the range of values is doubled and retransmission
takes place again. Each time a collision occurs, the range of values doubles, to reduce
the likelihood that two hosts on the same network can select the same retransmission
time. Table 6 on page 17 shows collision rounds up to round 10.

Table 6: Collision Backoff Algorithm Rounds

Elements in the SetSize of SetRound

{0,1}21

{0,1,2,3}42

{0,1,2,3,...,7}83

{0,1,2,3,4,...,15}164

{0,1,2,3,4,5,...,31}325

{0,1,2,3,4,5,6,...,63}646

{0,1,2,3,4,5,6,7,...,127}1287

{0,1,2,3,4,5,6,7,8,...,255}2568

{0,1,2,3,4,5,6,7,8,9,...,511}5129

{0,1,2,3,4,5,6,7,8,9,10,...,1023}102410

Collision Domains and LAN Segments

Collisions are confined to a physical wire over which data is broadcast. Because the
physical wires are subject to signal collisions, individual LAN segments are known
as collision domains. Although the physical limitations on the length of an Ethernet
cable restrict the length of a LAN segment, multiple collision domains can be
interconnected by repeaters, bridges, and switches.

Repeaters

Repeaters are electronic devices that act on analog signals. Repeaters relay all
electronic signals from one wire to another. A single repeater can double the distance
between two devices on an Ethernet network. However, the Ethernet specification
restricts the number of repeaters between any two devices on an Ethernet network
to two, because collision detection with latencies increases in complexity as the wire
length and number of repeaters increase.
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Bridges and Switches

Bridges and switches combine LAN segments into a single Ethernet network by using
multiple ports to connect the physical wires in each segment. Although bridges and
switches are fundamentally the same, bridges generally provide more management
and more interface ports. As Ethernet packets flow through a bridge, the bridge
tracks the source MAC address of the packets and stores the addresses and their
associated input ports in an interface table. As it receives subsequent packets, the
bridge examines its interface table and takes one of the following actions:

■ If the destination address does not match an address in the interface table, the
bridge transmits the packet to all hosts on the network using the Ethernet
broadcast address.

■ If the destination address maps to the port through which the packet was
received, the bridge or switch discards the packet. Because the other devices on
the LAN segment also received the packet, the bridge does not need to retransmit
it.

■ If the destination address maps to a port other than the one through which the
packet was received, the bridge transmits the packet through the appropriate
port to the corresponding LAN segment.

Broadcast Domains

The combination of all the LAN segments within an Ethernet network is called a
broadcast domain. In the absence of any signaling devices such as a repeater, bridge,
or switch, the broadcast domain is simply the physical wire that makes up the
connections in the network. If a bridge or switch is used, the broadcast domain
consists of the entire LAN.

Ethernet Frames

Data is transmitted through an Ethernet network in frames. The frames are of variable
length, ranging from 64 octets to 1518 octets, including the header, payload, and
cyclic redundancy check (CRC) value. Figure 1 on page 18 shows the Ethernet frame
format.

Figure 1: Ethernet Frame Format

Ethernet frames have the following fields:
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■ The preamble (PRE) in the frame is 7 octets of alternating 0s and 1s. The
predictable format in the preamble allows receiving interfaces to synchronize
themselves to the data being sent. The preamble is followed by a 1-octet
start-of-frame delimiter (SFD).

■ The destination address (DA) and source address (SA) fields contain the 6-octet
(48-bit) MAC addresses for the destination and source ports on the network.
These Layer 2 addresses uniquely identify the devices on the LAN.

■ The length/type field is a 2-octet field that either indicates the length of the
frame's data field or identifies the protocol stack associated with the frame.
Following are some common frame types:

■ AppleTalk—0x809B

■ AppleTalk ARP—0x80F3

■ DECnet—0x6003

■ IP—0x0800

■ IPX—0x8137

■ Loopback—0x9000

■ XNS—0x0600

■ The frame data is the packet payload.

■ The frame check sequence (FCS) field is a 4-octet field that contains the calculated
CRC value. This value is calculated by the originating host and appended to the
frame. When it receives the frames, the receiving host calculates the CRC and
checks it against this appended value to verify the integrity of the received frame.

T1 and E1 Interfaces Overview

T1 and E1 are equivalent digital data transmission formats that carry DS1 signals.
T1 and E1 lines can be interconnected for international use. This section contains
the following topics:

■ T1 Overview on page 19

■ E1 Overview on page 20

■ T1 and E1 Signals on page 20

■ Encoding on page 20

■ T1 and E1 Framing on page 21

■ T1 and E1 Loopback Signals on page 22

T1 Overview

T1 is a digital data transmission medium capable of handling 24 simultaneous
connections running at a combined 1.544 Mbps. T1 combines these 24 separate
connections, called channels or time slots, onto a single link. T1 is also called DS1.
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The T1 data stream is broken into frames. Each frame consists of a single framing
bit and 24 8-bit channels, totalling 193 bits per T1 frame. Frames are transmitted
8,000 times per second, at a data transmission rate of 1.544 Mbps (8,000 x 193 =
1.544 Mbps).

As each frame is received and processed, the data in each 8-bit channel is maintained
with the channel data from previous frames, enabling T1 traffic to be separated into
24 separate flows across a single medium. For example, in the following set of
4-channel frames (without a framing bit), the data in channel 1 consists of the first
octet of each frame, the data in channel 2 consists of the second octet of each frame,
and so on:

           Chan. 1   Chan. 2   Chan. 3   Chan. 4
Frame 1  [10001100][00110001][11111000][10101010]
Frame 2  [11100101][01110110][10001000][11001010]
Frame 3  [00010100][00101111][11000001][00000001]

E1 Overview

E1 is the European format for DS1 digital transmission. E1 links are similar to T1
links except that they carry signals at 2.048 Mbps. Each signal has 32 channels, and
each channel transmits at 64 Kbps. E1 links have higher bandwidth than T1 links
because they use all 8 bits of a channel. T1 links use 1 bit in each channel for
overhead.

T1 and E1 Signals

T1 and E1 interfaces consist of two pairs of wires—a transmit data pair and a receive
data pair. Clock signals, which determine when the transmitted data is sampled, are
embedded in T1 and E1 transmissions.

Typical digital signals operate by sending either zeros (0s) or ones (1s), which are
usually represented by the absence or presence of a voltage on the line. The receiving
device need only detect the presence of the voltage on the line at the particular
sampling edge to determine if the signal is 0 or 1. T1 and E1, however, use bipolar
electrical pulses. Signals are represented by no voltage (0), positive voltage (1), or
negative voltage (1). The bipolar signal allows T1 and E1 receivers to detect error
conditions in the line, depending on the type of encoding that is being used. For
more information, see “Encoding” on page 20.

Encoding

Following are common T1 and E1 encoding techniques:

■ Alternate mark inversion (AMI)—T1 and E1

■ Bipolar with 8-zero substitution (B8ZS)—T1 only

■ High-density bipolar 3 code (HDB3)—E1 only
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AMI Encoding

AMI encoding forces the 1s signals on a T1 or E1 line to alternate between positive
and negative voltages for each successive 1 transmission, as in this sample data
transmission:

1 1 0 1 0 1 0 1
+ - 0 + 0 - 0 +

When AMI encoding is used, a data transmission with a long sequence of 0s has no
voltage transitions on the line. In this situation, devices have difficulty maintaining
clock synchronization, because they rely on the voltage fluctuations to constantly
synchronize with the transmitting clock. To counter this effect, the number of
consecutive 0s in a data stream is restricted to 15. This restriction is called the 1s
density requirement, because it requires a certain number of 1s for every 15 0s that
are transmitted.

On an AMI-encoded line, two consecutive pulses of the same polarity—either positive
or negative—are called a bipolar violation (BPV), which is generally flagged as an
error.

B8ZS and HDB3 Encoding

Both B8ZS and HDB3 encoding do not restrict the number of 0s that can be
transmitted on a line. Instead, these encoding methods detect sequences of 0s and
substitute bit patterns in their place to provide the signal oscillations required to
maintain timing on the link.

The B8ZS encoding method for T1 lines detects sequences of eight consecutive 0
transmissions and substitutes a pattern of two consecutive BPVs (11110000). Because
the receiving end uses the same encoding, it detects the BPVs as 0s substitutions,
and no BPV error is flagged. A single BPV, which does not match the 11110000
substitution bit sequence, is likely to generate an error, depending on the configuration
of the device.

The HDB3 encoding method for E1 lines detects sequences of four consecutive 0
transmissions and substitutes a single BPV (1100). Similar to B8ZS encoding, the
receiving device detects the 0s substitutions and does not generate a BPV error.

T1 and E1 Framing

J Series Services Router T1 interfaces use two types of framing: superframe (D4) and
extended superframe (ESF). E1 interfaces use G.704 framing or G.704 with no CRC4
framing, or can be in unframed mode.

Superframe (D4) Framing for T1

A D4 frame consists of 192 data bits: 24 8-bit channels and a single framing bit. The
single framing bit is part of a 12-bit framing sequence. The 193rd bit in each T1
frame is set to a value, and every 12 consecutive frames are examined to determine
the framing bit pattern for the 12-bit superframe.
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The following sample 12-frame sequence shows the framing pattern for D4 framing:

[data bits][framing bit]
[xxxxxxxxx][1]
[xxxxxxxxx][0]
[xxxxxxxxx][0]
[xxxxxxxxx][0]
[xxxxxxxxx][1]
[xxxxxxxxx][1]
[xxxxxxxxx][0]
[xxxxxxxxx][1]
[xxxxxxxxx][1]
[xxxxxxxxx][1]
[xxxxxxxxx][0]
[xxxxxxxxx][0]

The 100011011100 12-bit pattern is repeated in each successive superframe. The
receiving device detects these bits to synchronize with the incoming data stream
and determine when the framing pattern begins and ends.

D4 framing requires the 8th bit of every byte (of every channel) within the frame to
be set to 1, a process known as bit robbing. The bit-robbing requirement ensures
that the 1s density requirements are met, regardless of the data contents of the
frames, but it reduces the bandwidth on the T1 link by an eighth.

Extended Superframe (ESF) Framing for T1

ESF extends the D4 superframe from 12 frames to 24 frames. By expanding the size
of the superframe, ESF increases the number of bits in the superframe framing
pattern from 12 to 24. The extra bits are used for frame synchronization, error
detection, and maintenance communications through the facilities data link (FDL).

The ESF pattern for synchronization bits is 001011. Only the framing bits from
frames 4, 8, 12, 16, 20, and 24 in the superframe sequence are used to create the
synchronization pattern.

The framing bits from frames 2, 6, 10, 14, 18, and 22 are used to pass a CRC code
for each superframe block. The CRC code verifies the integrity of the received
superframe and detects bit errors with a CRC6 algorithm.

The framing bits for frames 1, 3, 5, 7, 9, 11, 13, 15, 17, 19, 21, and 23 are used for
the data link channel. These 12 bits enable the operators at the network control
center to query the remote equipment for information about the performance of the
link.

T1 and E1 Loopback Signals

The control signal on a T1 or E1 link is the loopback signal. Using the loopback signal,
the operators at the network control center can force the device at the remote end
of a link to retransmit its received signals back onto the transmit path. The
transmitting device can then verify that the received signals match the transmitted
signals, to perform end-to-end checking on the link.

Two loopback signals are used to perform the end-to-end testing:
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■ The loop-up command signal sets the link into loopback mode, with the following
command pattern:

...100001000010000100...

■ The loop-down signal returns the link to its normal mode, with the following
command pattern:

...100100100100100100...

While the link is in loopback mode, the operator can insert test equipment onto the
line to test its operation.

Channelized T1/E1/ISDN PRI Interfaces Overview

Channelization enables devices to provide IP services to users with different access
speeds and bandwidth requirements. Users share an interface that has been divided
into discrete time slots, by transmitting in only their own time slot. On J Series
devices, a single channelized T1/E1/ISDN PRI interface can be partitioned into the
following numbers of DS0 or ISDN PRI time slots, by means of software configuration:

■ T1 interface—Up to 24 DS0 time slots (channels 1 through 24).

■ E1 interface—Up to 31 DS0 time slots (channels 1 through 31).

■ ISDN PRI—Up to 23 ISDN PRI B-channels and 1 D-channel when the parent
interface is channelized T1, and up to 30 ISDN PRI B-channels and 1 D channel
when the parent interface is channelized E1. Time slots on the interface unused
by ISDN PRI can operate normally as DS0 interfaces.

For more information about ISDN, see “ISDN Interface Overview” on page 49.

NOTE: You cannot configure the channelized T1/E1/ISDN PRI PIM through a J-Web
Quick Configuration page.

You can aggregate the channels on a channelized interface into bundles called channel
groups to aggregate customer traffic.

A single channelized T1/E1/ISDN PRI interface also supports drop-and-insert
multiplexing, to integrate voice and data channels on a single T1 or E1 link. The
drop-and-insert feature allows you to remove the DS0 time slots of one T1 or E1 port
and replace them by inserting the time slots of another T1 or E1 interface.

T3 and E3 Interfaces Overview

T3 is a high-speed data-transmission medium formed by multiplexing 28 DS1 signals
into seven separate DS2 signals, and combining the DS2 signals into a single DS3
signal. T3 links operate at 43.736 Mbps. T3 is also called DS3.

E3 is the equivalent European transmission format. E3 links are similar to T3 (DS3)
links, but carry signals at 34.368 Mbps. Each signal has 16 E1 channels, and each
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channel transmits at 2.048 Mbps. E3 links use all 8 bits of a channel, whereas T3
links use 1 bit in each channel for overhead.

Multiplexing DS1 Signals

Four DS1 signals combine to form a single DS2 signal. The four DS1 signals form a
single DS2 M-frame, which includes subframes M1 through M4. Each subframe has
six 49-bit blocks, for a total of 294 bits per subframe. The first bit in each block is a
DS2 overhead (OH) bit. The remaining 48 bits are DS1 information bits.

Figure 2 on page 24 shows the DS2 M-frame format.

Figure 2: DS2 M-Frame Format

The four DS2 subframes are not four DS1 channels. Instead, the DS1 data bits within
the subframes are formed by data interleaved from the DS1 channels. The 0n values
designate time slots devoted to DS1 inputs as part of the bit-by-bit interleaving
process. After every 48 DS1 information bits (12 bits from each signal), a DS2 OH
bit is inserted to indicate the start of a subframe.

DS2 Bit Stuffing

Because the four DS1 signals are asynchronous signals, they might operate at different
line rates. To synchronize the asynchronous streams, the multiplexers on the line
use bit stuffing.

A DS2 connection requires a nominal transmit rate of 6.304 Mbps. However, because
multiplexers increase the overall output rate to the intermediate rate of 6.312 Mbps,
the output rate is higher than individual input rates on DS1 signals. The extra
bandwidth is used to stuff the incoming DS1 signals with extra bits until the output
rate of each signal equals the increased intermediate rate. These stuffed bits are
inserted at fixed locations in the DS2 M-frame. When DS2 frames are received and
the signal is demultiplexed, the stuffing bits are identified and removed.
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DS3 Framing

A set of four DS1 signals is multiplexed into seven DS2 signals, which are multiplexed
into a single DS3 signal. The multiplexing occurs just as with DS1-to-DS2 multiplexing.
The resulting DS3 signal uses either the standard M13 asynchronous framing format
or the C-bit parity framing format. Although the two framing formats differ in their
use of control and message bits, the basic frame structures are identical. The DS3
frame structures are shown in Figure 3 on page 25 and Figure 4 on page 27.

M13 Asynchronous Framing

A DS3 M-frame includes seven subframes, formed by DS2 data bits interleaved from
the seven multiplexed DS2 signals. Each subframe has eight 85-bit blocks—a DS3
OH bit plus 84 data bits. The meaning of an OH bit depends on the block it precedes.
Standard DS3 M13 asynchronous framing format is shown in Figure 3 on page 25.

Figure 3: DS3 M13 Frame Format

A DS3 M13 M-frame contains the following types of OH bits:

■ Framing bits (F-bits)—Make up a frame alignment signal that synchronizes DS3
subframes. Each DS3 frame contains 28 F-bits (4 bits per subframe). F-bits are
located at the beginning of blocks 2, 4, 6, and 8 of each subframe. When
combined, the frame alignment pattern for each subframe is 1001. The pattern
can be examined to detect bit errors in the transmission.

■ Multiframing bits (M-bits)—Make up a multiframe alignment signal that
synchronizes the M-frames in a DS3 signal. Each DS3 frame contains 3 M-bits,
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which are located at the beginning of subframes 5, 6, and 7. When combined,
the multiframe alignment patter for each M-frame is 010.

■ Bit stuffing control bits (C-bits)—Serve as bit stuffing indicators for each DS2
input. For example, C11, C12, and C13 are indicators for DS2 input 1. Their values
indicate whether DS3 bit stuffing has occurred at the multiplexer. If the three
C-bits in a subframe are all 0s, no stuffing was performed for the DS2 input. If
the three C-bits are all 1s, stuffing was performed.

■ Message bits (X-bits)—Used by DS3 transmitters to embed asynchronous
in-service messages in the data transmission. Each DS3 frame contains 2 X-bits,
which are located at the beginning of subframes 1 and 2. Within an DS3 M-frame,
both X-bits must be identical.

■ Parity bits (P-bits)—Compute parity over all but 1 bit of the M-frame. (The first
X-bit is not included.) Each DS3 frame contains 2 P-bits, which are located at
the beginning of subframes 3 and 4. Both  P-bits must be identical.

If the previous DS3 frame contained an odd number of 1s, both P-bits are set to
1. If the previous DS3 contained an even number of 1s, both P-bits are set to 0.
If, on the receiving side, the number of 1s for a given frame does not match the
P-bits in the following frame, it indicates one or more bit errors in the
transmission.

C-Bit Parity Framing

In M13 framing, every C-bit in a DS3 frame is used for bit stuffing. However, because
multiplexers first use bit stuffing when multiplexing  DS1 signals into DS2 signals,
the incoming DS2 signals are already synchronized. Therefore, the bit stuffing that
occurs when DS2 signals are multiplexed is redundant.

C-bit parity framing format redefines the function of C-bits and X-bits, using them
to monitor end-to-end path performance and provide in-band data links. The C-bit
parity framing structure is shown in Figure 4 on page 27.
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Figure 4: DS3 C-Bit Parity Framing

In C-bit parity framing, the X-bits transmit error conditions from the far end of the
link to the near end. If no error conditions exist, both X-bits are set to 1. If an
out-of-frame (OOF) or alarm indication signal (AIS) error is detected, both X-bits are
set to 0 in the upstream direction for 1 second to notify the other end of the link
about the condition.

The C-bits that control bit stuffing in M13 frames are typically used in the following
ways by C-bit parity framing:

■ Application identification channel (AIC)—The first C-bit in the first subframe
identifies the type of DS3 framing used. A value of 1 indicates that C-bit parity
framing is in use.

■ Na—A reserved network application bit.

■ Far-end alarm and control (FEAC) channel—The third C-bit in the first subframe
is used for the FEAC channel. In normal transmissions, the FEAC C-bit transmits
all 1s. When an alarm condition is present, the FEAC C-bit transmits a code word
in the format 0xxxxxxx 11111111, in which x can be either 1 or 0. Bits are
transmitted from right to left.

Table 7 on page 27 lists some C-bit code words and the alarm or status condition
indicated.

Table 7: FEAC C-Bit Condition Indicators

C-Bit Code WordAlarm or Status Condition

00110010 11111111DS3 equipment failure requires immediate attention.
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Table 7: FEAC C-Bit Condition Indicators (continued)

C-Bit Code WordAlarm or Status Condition

00011110 11111111DS3 equipment failure occurred—such as suspended, not activated, or
unavailable service—that is non-service-affecting.

00011100 11111111DS3 loss of signal.

00000000 11111111DS3 out of frame.

00101100 11111111DS3 alarm indication signal (AIS) received.

00110100 11111111DS3 idle received.

00011101 11111111Common equipment failure occurred that is non-service-affecting.

00101010 11111111Multiple DS1 loss of signal.

00001010 11111111DS1 equipment failure occurred that requires immediate attention.

00000110 11111111DS1 equipment failure occurred that is non-service-affecting.

00111100 11111111Single DS1 loss of signal.

■ Data links—The 12 C-bits in subframes 2, 5, 6, and 7 are data link (DL) bits for
applications and terminal-to-terminal path maintenance.

■ DS3 parity—The 3 C-bits in the third subframe are DS3 parity C-bits (also called
CP-bits). When a DS3 frame is transmitted, the sending device sets the CP-bits
to the same value as the P-bits. When the receiving device processes the frame,
it calculates the parity of the M-frame and compares this value to the parity in
the CP-bits of the following M-frame. If no bit errors have occurred, the two
values are typically the same.

■ Far–end block errors (FEBEs)—The 3 C-bits in the fourth subframe make up the
far-end block error (FEBE) bits. If a framing or parity error is detected in an
incoming M-frame (via the CP-bits), the receiving device generates a C-bit parity
error and sends an error notification to the transmitting (far-end) device. If an
error is generated, the FEBE bits are set to 000. If no error occurred, the bits are
set to 111.

Serial Interface Overview

Serial links are simple, bidirectional links that require very few control signals. In a
basic serial setup, data communications equipment (DCE) installed in a user's
premises is responsible for establishing, maintaining, and terminating a connection.
A modem is a typical DCE device.

A serial cable connects the DCE to a telephony network where, ultimately, a link is
established with data terminal equipment (DTE). DTE is typically where a serial link
terminates.
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The distinction between DCE and DTE is important because it affects the cable pinouts
on a serial cable. A DTE cable uses a male 9-pin or 25-pin connector, and a DCE
cable uses a female 9-pin or 25-pin connector.

To form a serial link, the cables are connected to each other. However, if the pins
are identical, each side's transmit and receive lines are connected, which makes data
transport impossible. To address this problem, each cable is connected to a null
modem cable, which crosses the transmit and receive lines in the cable.

Serial Transmissions

In basic serial communications, nine signals are critical to the transmission. Each
signal is associated with a pin in either the 9-pin or 25-pin connector. Table 8 on
page 29 lists and defines serial signals and their sources.

Table 8: Serial Transmission Signals

Signal SourceDefinitionSignal Name

DTETransmitted dataTD

DCEReceived dataRD

DTERequest to sendRTS

DCEClear to sendCTS

DCEData set readyDSR

–Grounding signalSignal Ground

–Carrier detectCD

DTEData terminal readyDTR

–Ring indicatorRI

When a serial connection is made, a serial line protocol—such as EIA-530, X.21,
RS-422/449, RS-232, or V.35—begins controlling the transmission of signals across
the line as follows:

1. The DCE transmits a DSR signal to the DTE, which responds with a DTR signal.
After this handshake, the link is established and traffic can pass.

2. When the DTE device is ready to receive data, it sets its RTS signal to a marked
state (all 1s) to indicate to the DCE that it can transmit data. (If the DTE is not
able to receive data—because of buffer conditions, for example—it sets the RTS
signal to all 0s.)
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3. When the DCE device is ready to receive data, it sets its CTS signal to a marked
state to indicate to the DTE that it can transmit data. (If the DCE is not able to
receive data, it sets the CTS signal to all 0s.)

4. When the negotiation to send information has taken place, data is transmitted
across the transmitted data (TD) and received data (RD) lines:

■ TD line—Line through which data from a DTE device is transmitted to a DCE
device

■ RD line—Line through which data from a DCE device is transmitted to a
DTE device

The name of the wire does not indicate the direction of data flow.

The DTR and DSR signals were originally designed to operate as a handshake
mechanism. When a serial port is opened, the DTE device sets its DTR signal to a
marked state. Similarly, the DCE sets its DSR signal to a marked state. However,
because of the negotiation that takes place with the RTS and CTS signals, the DTR
and DSR signals are not commonly used.

The carrier detect and ring indicator signals are used to detect connections with
remote modems. These signals are not commonly used.

Signal Polarity

Serial interfaces use a balanced (also called differential) protocol signaling technique.
Two serial signals are associated with a circuit: the A signal and the B signal. The
A signal is denoted with a plus sign (for example, DTR+), and the B signal is denoted
with a minus sign (for example, DTR–). If DTR is low, then DTR+ is negative with
respect to DTR–. If DTR is high, then DTR+ is positive with respect to DTR–.

By default, all signal polarities are positive, but sometimes they might be reversed.
For example, signals might be miswired as a result of reversed polarities.

Serial Clocking Modes

By default, a serial interface uses loop clocking to determine its timing source. For
EIA-530 and V.35 interfaces, you can set each port independently to use one of the
following clocking modes. X.21 interfaces can use only loop clocking mode.

■ Loop clocking mode—Uses the DCE's receive (RX) clock to clock data from the
DCE to the DTE.

■ DCE clocking mode—Uses the transmit (TXC) clock, generated by the DCE
specifically to be used by the DTE as the DTE's transmit clock.

■ Internal clocking mode—Uses an internally generated clock. The speed of this
clock is configured locally. Internal clocking mode is also known as line timing.

Both loop clocking mode and DCE clocking mode use external clocks generated by
the DCE.
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Figure 5 on page 31 shows the clock sources for loop, DCE, and internal clocking
modes.

Figure 5: Serial Interface Clocking Modes

Serial Interface Transmit Clock Inversion

When an externally timed clocking mode (DCE or loop) is used, long cables might
introduce a phase shift of the DTE-transmitted clock and data. At high speeds, this
phase shift might cause errors. Inverting the transmit clock corrects the phase shift,
thereby reducing error rates.

DTE Clock Rate Reduction

Although the serial interface is intended for use at the default clock rate of
16.384 MHz, you might need to use a slower rate under any of the following
conditions:

■ The interconnecting cable is too long for effective operation.

■ The interconnecting cable is exposed to an extraneous noise source that might
cause an unwanted voltage in excess of +1 volt.

The voltage must be measured differentially between the signal conductor and
the point in the circuit from which all voltages are measured (“circuit common”)
at the load end of the cable, with a 50-ohm resistor substituted for the generator.

■ Interference with other signals must be minimized.

■ Signals must be inverted.

Serial Line Protocols

Serial interfaces support the following line protocols:

■ EIA-530 on page 32

■ RS-232 on page 32

■ RS-422/449 on page 33
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■ V.35 on page 33

■ X.21 on page 34

EIA-530

EIA-530 is an Electronic Industries Association (EIA) standard for the interconnection
of DTE and DCE using serial binary data interchange with control information
exchanged on separate control circuits. EIA-530 is also known as RS-530.

The EIA-530 line protocol is a specification for a serial interface that uses a DB-25
connector and balanced equivalents of the RS-232 signals—also called V.24. The
EIA-530 line protocol is equivalent to the RS-422 and RS-423 interfaces implemented
on a 25-pin connector.

The EIA-530 line protocol supports both balanced and unbalanced modes. In
unbalanced transmissions, voltages are transmitted over a single wire. Because only
a single signal is transmitted, differences in ground potential can cause fluctuations
in the measured voltage across the link. For example, if a 3V signal is sent from one
endpoint to another, and the receiving endpoint has a ground potential 1V higher
than the transmitter, the signal on the receiving end is measured as a 2V signal.

Balanced transmissions use two wires instead of one. Rather than sending a single
signal across the wire and having the receiving end measure the voltage, the
transmitting device sends two separate signals across two separate wires. The
receiving device measures the difference in voltage of the two signals (balanced
sampling) and uses that calculation to evaluate the signal. Any differences in ground
potential affect both wires equally, and the difference in the signals is still the same.

The EIA-530 interface supports asynchronous and synchronous transmissions at
rates ranging from 20 Kbps to 2 Mbps.

RS-232

RS-232 is a Recommended Standard (RS) describing the most widely used type of
serial communication. The RS-232 protocol is used for asynchronous data transfer
as well as synchronous transfers using HDLC, Frame Relay, and X.25. RS-232 is also
known as EIA-232.

The RS-232 line protocol is very popular for low-speed data signals. RS-232 signals
are carried as single voltages referred to a common ground signal. The voltage output
level of these signals varies between –12V and +12V. Within this range, voltages
between –3V and +3V are considered inoperative and are used to absorb line noise.
Control signals are considered operative when the voltage ranges from +3 to +25V.

The RS-232 line protocol is an unbalanced protocol, because it uses only one wire,
and is susceptible to signal degradation. Degradation can be extremely disruptive,
particularly when a difference in ground potential exists between the transmitting
and receiving ends of a link.

The RS-232 interface is implemented in a 25-pin D-shell connector and supports line
rates up to 200 Kbps over lines shorter than 98 feet (30 meters).
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NOTE: RS-232 serial interfaces cannot function error-free with a clock rate greater
than 200 KHz.

RS-422/449

RS-422 is a Recommended Standard (RS) describing the electrical characteristics of
balanced voltage digital interface circuits that support higher bandwidths than
traditional serial protocols like RS-232. RS-422 is also known as EIA-422.

The RS-449 standard (also known as EIA-449) is compatible with RS-422 signal levels.
The EIA created RS-449 to detail the DB-37 connector pinout and define a set of
modem control signals for regulating flow control and line status.

The RS-422/499 line protocol runs in balanced mode, allowing serial communications
to extend over distances of up to 4,000 feet (1.2 km) and at very fast speeds of up
to 10 Mbps.

In an RS-422/499-based system, a single master device can communicate with up
to 10 slave devices in the system. To accommodate this configuration, RS-422/499
supports the following kinds of transmission:

■ Half-duplex transmission—In half-duplex transmission mode, transmissions
occur in only one direction at a time. Each transmission requires a proper
handshake before it is sent. This operation is typical of a balanced system in
which two devices are connected by a single connection.

■ Full-duplex transmission—In full duplex transmission mode, multiple
transmissions can occur simultaneously so that devices can transmit and receive
at the same time. This operation is essential when a single master in a
point-to-multipoint system must communicate with multiple receivers.

■ Multipoint transmission—RS-422/449 allows only a single master in a multipoint
system. The master can communicate to all points in a multipoint system, and
the other points must communicate with each other through the master.

V.35

V.35 is an ITU-T standard describing a synchronous, physical-layer protocol used for
communications between a network access device and a packet network. V.35 is
most commonly used in the United States and Europe.

The V.35 line protocol is a mixture of balanced (RS-422) and common ground (RS-232)
signal interfaces. The V.35 control signals DTR, DSR, DCD, RTS, and CTS are
single-wire common ground signals that are essentially identical to their RS-232
equivalents. Unbalanced signaling for these control signals is sufficient, because the
control signals are mostly constant, varying at very low frequency, which makes
single-wire transmission suitable. Higher-frequency data and clock signals are sent
over balanced wires.

V.35 interfaces operate at line rates of 20 Kbps and above.
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X.21

X.21 is an ITU-T standard for serial communications over synchronous digital lines.
The X.21 protocol is used primarily in Europe and Japan.

The X.21 line protocol is a state-driven protocol that sets up a circuit-switched network
using call setup. X.21 interfaces use a 15-pin connector with the following eight
signals:

■ Signal ground (G)—Reference signal used to evaluate the logic states of the other
signals. This signal can be connected to the protective earth (ground).

■ DTE common return (Ga)—Reference ground signal for the DCE interface. This
signal is used only in unbalanced mode.

■ Transmit (T)—Binary signal that carries the data from the DTE to the DCE. This
signal can be used for data transfer or in call-control phases such as Call Connect
or Call Disconnect.

■ Receive (R)—Binary signal that carries the data from the DCE to the DTE. This
signal can be used for data transfer or in call-control phases such as Call Connect
or Call Disconnect.

■ Control (C)—DTE-controlled signal that controls the transmission on an X.21
link. This signal must be on during data transfer, and can be on or off during
call-control phases.

■ Indication (I)—DCE-controlled signal that controls the transmission on an X.21
link. This signal must be on during data transfer, and can be on or off during
call-control phases.

■ Signal Element Timing (S)—Clocking signal that is generated by the DCE. This
signal specifies when sampling on the line must occur.

■ Byte Timing (B)—Binary signal that is on when data or call-control information
is being sampled. When an 8-byte transmission is over, this signal switches to
off.

Transmissions across an X.21 link require both the DCE and DTE devices to be in a
ready state, indicated by an all 1s transmission on the T and R signals.

ADSL Interface Overview

Asymmetric digital subscriber line (ADSL) technology is part of the xDSL family of
modem technologies that use existing twisted-pair telephone lines to transport
high-bandwidth data. ADSL lines connect service provider networks and customer
sites over the "last mile" of the network—the loop between the service provider and
the customer site.

ADSL transmission is asymmetric because the downstream bandwidth is typically
greater than the upstream bandwidth. The typical bandwidths of ADSL, ADSL2, and
ADSL2+ circuits are defined in Table 9 on page 35.
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Table 9: Standard Bandwidths of DSL Operating Modes

DownstreamUpstreamOperating Modes

8 Mbps800 Kbps — 1 MbpsADSL

12 —14 Mbps1 — 1.5 MbpsADSL2

24 —25 Mbps1 — 1.15 MbpsADSL2+

25 Mbps4 MbpsADSL2+ Annex M

SRX210 devices support ADSL, ADSL2, and ADSL2+, which comply with the following
standards:

■ For Annex A:

■ ITU G.992.1 (ADSL)

■ For Annex A only:

■ ANSI T1.413 Issue II

■ ITU G.992.3 (ADSL2)

■ ITU G.992.5 (ADSL2+)

■ For Annex M:

■ ITU G.992.3 (ADSL2)

■ ITU G.992.5 (ADSL2+)

■ For Annex B:

■ ITU G.992.1 (ADSL)

■ ITU G.992.3 (ADSL2)

■ ITU G.992.5 (ADSL2+)

■ For Annex B only

■ ETSI TS 101 388 V1.3

The ADSL Mini-PIM is supported on SRX210 devices. The ADSL Mini-PIM facilitates
a maximum of ten virtual circuits on SRX210 devices.

SRX210 devices with Mini-PIMs can use PPP over Ethernet over ATM (PPPoEoA) and
PPP over ATM (PPPoA) to connect through ADSL lines only.

ADSL Systems

ADSL links run across twisted-pair telephone wires. When ADSL modems are
connected to each end of a telephone wire, a dual-purpose ADSL circuit can be
created. Once established, the circuit can transmit lower-frequency voice traffic and
higher-frequency data traffic.
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To accommodate both types of traffic, ADSL modems are connected to plain old
telephone service (POTS) splitters that filter out the lower-bandwidth voice traffic
and the higher-bandwidth data traffic. The voice traffic can be directed as normal
telephone voice traffic. The data traffic is directed to the ADSL modem, which is
typically connected to the data network.

Because twisted-pair wiring has a length limit, ADSL modems are typically connected
to multiplexing devices. DSL access multiplexers (DSLAMs) can process and route
traffic from multiple splitters. This typical ADSL configuration is shown in Figure 6
on page 36 and Figure 7 on page 37.

Figure 6: Typical ADSL IP DSLAM Topology
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Figure 7: Typical ADSL ATM DSLAM Topology

ADSL2 and ADSL2+

The ADSL2 and ADSL2+ standards were adopted by the ITU in July 2002. ADSL2
improves the data rate and reach performance, diagnostics, standby mode, and
interoperability of ADSL modems.

ADSL2+ doubles the possible downstream data bandwidth, enabling rates of 20
Mbps on telephone lines shorter than 5,000 feet (1.5 km).

ADSL2 uses seamless rate adaptation (SRA) to change the data rate of a connection
during operation with no interruptions or bit errors. The ADSL2 transceiver detects
changes in channel conditions—for example, the failure of another transceiver in a
multicarrier link—and sends a message to the transmitter to initiate a data rate
change. The message includes data transmission parameters such as the number of
bits modulated and the power on each channel. When the transmitter receives the
information, it transitions to the new transmission rate.

ATM CoS Support

Certain class-of-service (CoS) components for Asynchronous Transmission Mode
(ATM) are provided to control data transfer, especially for time-sensitive voice packets.
The ADSL Mini-PIM on the SRX210 device provides extended ATM CoS functionality
to provide cells across the network. You can define bandwidth utilization, which
consists of either a constant rate or a peak cell rate, with sustained cell rate and burst
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tolerance. By default, unspecified bit rate (UBR) is used because the bandwidth
utilization is unlimited.

The following ATM traffic shaping is supported for the SRX210 device:

CBR is the service category for traffic with rigorous timing requirements like voice, and certain
types of video. CBR traffic needs a constant cell transmission rate throughout the duration of
the connection.

Constant bit rate, (CBR)

VBR-NRT is intended for sources such as data transfer, which do not have strict time or delay
requirements. VBR-NRT is suitable for packet data transfers.

Variable bit rate non-real
- time (VBR-NRT)

UBR is ATM’s best-effort service, which does not provide any CoS guarantees. This is suitable
for noncritical applications that can tolerate or quickly adjust to loss of cells.

Unspecified bit rate (UBR)

The ability of a network to guarantee class of service is related in the way in which
the source generates cells and also on the availability of network resources. The
connection contract between the user and the network will thus contain information
about the way in which traffic will be generated by the source.

A set of traffic descriptors is specified for this purpose. The network provides the
class of service for the cells that do not violate these specifications. The following
are the traffic descriptors specified for an ATM network:

■ Peak cell rate (PCR) - Top rate at which traffic can burst.

■ Sustained cell rate (SCR) - Normal traffic rate averaged over time.

■ Maximum burst size (MBS) - The maximum burst size that can be sent at the
peak rate.

■ Cell delay variation tolerance (CDVT) – Allows the user to delay the traffic for a
particular time duration in microseconds to follow a rhythmic pattern.

NOTE: CDVT is not supported on J Series devices.

For traffic that does not require the ability to periodically burst to a higher rate, you
can specify a CBR. You can configure VBR-NRT for ATM interfaces, which supports
VBR data traffic with average and peak traffic parameters. VBR-NRT is scheduled
with a lower priority and with a larger sustained cell rate (SCR) limit, allowing it to
recover bandwidth if it falls behind.

SHDSL Interface Overview

SHDSL interfaces on J Series device support a symmetric, high-speed digital subscriber
line (SHDSL) multirate technology for data transfer between a single customer
premises equipment (CPE) subscriber and a central office (CO). ITU-T G.991.2 is the
officially designated standard describing SHDSL, also known as G.SHDSL.
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Unlike ADSL, which delivers more bandwidth downstream than available upstream,
SHDSL is symmetrical and delivers a bandwidth of up to 2.3  Mbps in both directions.
Because business applications require higher-speed digital transportation methods,
SHDSL is becoming very popular and gaining wide acceptance in the industry.
Additionally, SHDSL is compatible with ADSL and therefore causes very little, if any,
interference between cables.

SHDSL is deployed on a network in much the same manner as ADSL.

G.SHDSL Mini-PIM

This topic includes the following sections:

■ G.SHDSL 8–Wire Mini-PIM Overview on page 39

■ Operating Modes and Line Rates of the G.SHDSL Mini-PIM on page 40

■ ATM CoS Support on page 40

G.SHDSL 8–Wire Mini-PIM Overview

The G.SHDSL Mini-Physical Interface Module (Mini-PIM) is supported on SRX210 and
SRX240 devices. The G.SHDSL supported on the SRX Series Services Gateways
provides the physical connection to DSL network media types.

The G.SHDSL Mini-Physical Interface Module (Mini-PIM) provides the following key
features:

■ 2-wire (4 port 2-wire) mode, 4-wire (2 port 4–wire) mode, and 8-wire (1 port
8–wire) mode support

■ Virtual circuits per Mini-PIM (8 maximum)

■ ATM-over-G.SHDSL framing

■ ATM OAM support

■ Maximum MTU size of 9180 bytes

■ Noise margin support

■ Point-to-Point Protocol over ATM and PPPoE over ATM encapsulation support

■ Local loop back mode support

The following four annexes are supported on the G.SHDSL Mini-PIM:

■ Annex A

■ Annex B

■ Annex F

■ Annex G

G.SHDSL Mini-PIM ■ 39

Chapter 1: Interfaces Overview



Operating Modes and Line Rates of the G.SHDSL Mini-PIM

The G.SHDSL Mini-PIM supports 2-wire, 4-wire and 8-wire modes; the Mini-PIM can
be used in 1x 8-wire, 2x 4- wire and 4x 2-wire modes. The default operating mode
is 2x 4-wire for this G.SHDSL Mini-PIM. G.SHDSL is supported on all SRX210 and
SRX240 devices using the following Symmetrical WAN speeds as shown in Table 10
on page 40.

Table 10: Symmetrical WAN speeds

Symmetrical WAN Speed Using Annex F and G
Symmetrical WAN Speed
Using Annex A and BModes

From 768 Kbps to 5.696 Mbps2.3 Mbps2-wire

From 1.536 Mbps to 11.392 Mbps4.6 Mbps4-wire

From 3.072 Mbps to 22.784 Mbps9.2 Mbps8-wire

NOTE: A maximum of 16 Mbps is supported on SRX210 and SRX240 devices.

ATM CoS Support

The G.SHDSL Mini-PIM on the SRX210 and SRX240 devices provide extended ATM
CoS functionality to provides cells across the network. You can define bandwidth
utilization, which consists of either a constant rate or a peak cell rate, with sustained
cell rate and burst tolerance. By default, unspecified bit rate (UBR) is used because
the bandwidth utilization is unlimited.

The following ATM traffic shaping is supported for the SRX210 and SRX240 devices:

■ Constant bit rate (CBR)—CBR is the service category for traffic with rigorous
timing requirements like voice and certain types of video. CBR traffic needs a
constant cell transmission rate throughout the duration of the connection.

■ Variable bit rate, non-real - time (VBR-NRT)—VBR-NRT is intended for sources such
as data transfer, which do not have strict time or delay requirements. VBR-NRT
is suitable for packet data transfers.

■ Variable bit rate, real- time (VBR-RT)—VBR-RT is intended for sources such as data
transfer, which takes place in real time. VBR-RT requires access to time slots at
a rate that can vary significantly from time to time.

Table 11 on page 40 displays the traffic descriptors specified for an ATM network.

Table 11: Traffic Descriptors

TasksTraffic Descriptors

Maximum rate at which traffic can burst.Peak cell rate (PCR)
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Table 11: Traffic Descriptors (continued)

TasksTraffic Descriptors

Normal traffic rate averaged over time.Sustained cell rate (SCR)

Maximum burst size that can be sent at the peak rate.Maximum burst size (MBS)

VDSL2 Interface Overview

This section includes the following topics:

■ VDSL2 Systems on page 41

■ VDSL2 Terms on page 42

■ Implementation of a VDSL2 Network Using SRX Series Services
Gateways on page 42

■ VDSL2 Mini-PIM Support on SRX210 and SRX240 Services Gateways on page 44

■ Supported Profiles on page 44

■ Supported Features on page 44

VDSL2 Systems

Very-high-bit-rate digital subscriber line (VDSL) technology is part of the xDSL family
of modem technologies that provide faster data transmission over a single flat
untwisted or twisted pair of copper wires. The VDSL lines connect service provider
networks and customer sites to provide high bandwidth applications (Triple Play
services) such as high-speed Internet access, telephone services like voice over IP
(VoIP), high-definition TV (HDTV), and interactive gaming services over a single
connection. VDSL2 is an enhancement to VDSL and permits the transmission of
asymmetric and symmetric (full-duplex) aggregate data rates up to 100 Mbps on
short copper loops using a bandwidth up to 30 MHz.

The VDSL2 technology is based on the ITU-T G.993.2 standard. The VDSL2 uses
Discrete Multitone (DMT) modulation . VDSL2 provides backward compatibility with
ADSL, ADSL2, and ADSL2+ because this technology is based on both the VDSL1-DMT
and ADSL2/ADSL2+ recommendations.

Packet Transfer Mode

VDSL2 interface supports Packet Transfer Mode (PTM). The PTM mode transports
packets (IP, PPP, Ethernet, MPLS, and so on) over DSL links as an alternative to using
Asynchronous Transfer Mode (ATM). PTM is based on the Ethernet in the First Mile
(EFM) IEEE802.3ah standard.

Discrete Multitone Modulation

VDSL2 interface uses DMT modulation. Discrete multitone (DMT) is a method of
separating a digital subscriber line signal so that the usable frequency range is
separated into 256 frequency bands (or channels) of 4.3125 KHz each. The DMT
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uses the Fast Fourier Transform (FFT) algorithm for demodulation or modulation for
increased speed.

VDSL2 Terms

Table 12 on page 42 lists the terms related to VDSL2 technology.

Table 12: VDSL Terminology

DefinitionTerm

International Telecommunication Union standard describing a data transmission method for
VDSL2 transceivers.

ITU-T G.993.2

Transport of packet-based services method based on the EFM IEEE802.3ah standard.Packet Transfer Mode
(PTM)

VDSL is a DSL technology that provides data transmission over a single, flat, untwisted or twisted
pair of copper wires at faster rate.

VDSL

VDSL2 is an enhancement to G.993.1 (VDSL) that permits the transmission of asymmetric and
symmetric (full duplex) aggregate data at faster rate. VDSL2 is based on ITU-T G.993.2 (VDSL2)
standard.

VDSL2

Discrete multitone (DMT) modulation is used by VDSL2. The DMT modulation is a method of
separating a digital subscriber line signal so that the usable frequency range is separated into 256
frequency bands (or channels) of 4.3125 KHz each.

DMT

Implementation of a VDSL2 Network Using SRX Series Services Gateways

In standard telephone cables of copper wires, voice signals use only a fraction of the
available bandwidth. Like any other DSL technology, the VDSL2 technology utilizes
the remaining capacity to carry the data and multimedia on the wire without
interrupting the line's ability to carry voice signals.

The following example depicts the typical VDSL2 network topology deployed using
SRX Series Services Gateways.

A VDSL2 link between network devices is set up as follows:

1. Connect an end-user device such as a LAN, hub, or PC through an Ethernet
interface to the customer premises equipment (CPE) (for example, an SRX Series
device).

2. Use an RJ-11 cable to connect the CPE to a DSLAM.

3. The VDSL2 interface uses either Gigabit Ethernet or fiber as second mile to
connect to the Broadband Remote Access Server (B-RAS) as shown in Figure
8 on page 43.

■

■ The ADSL interface uses either Gigabit Ethernet (in case of IP DSLAM] as the
“second mile” to connect to the B-RAS or OC3/DS3 ATM as the second mile
to connect the B-RAS as shown in Figure 9 on page 43.
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NOTE: The VDSL2 technology is backward compatible with ADSL. VDSL2 provides
an ADSL interface in an ATM DSLAM topology and provides a VDSL2 interface in an
IP or VDSL DSLAM topology.

The DSLAM accepts connections from many customers and aggregates them to
a single, high-capacity connection to the Internet.

Figure 8 on page 43 shows a typical VDSL2 network topology.

Figure 8: Typical VDSL2 End-to-End Connectivity and Topology Diagram

Figure 9 on page 43 shows a backward-compatible ADSL topology using ATM DSLAM.

Figure 9: Backward-Compatible ADSL Topology (ATM DSLAM)
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VDSL2 Mini-PIM Support on SRX210 and SRX240 Services Gateways

The SRX210 and SRX240 Services Gateways support the VDSL2 Mini-PIM (Annex
A). The VDSL2 Mini-Physical Interface Module (Mini-PIM) carries the Ethernet
backplane. When the Mini-PIM is plugged into the chassis, the Mini-PIM connects to
one of the ports of the baseboard switch. The VDSL2 Mini-PIM on the SRX Series
devices provides ADSL backward compatibility.

The VDSL2 Mini-PIM (Annex A) is compatible with ITU-T G.993.2 (VDSL2) standard.

Supported Profiles

A profile is a table that contains a list of preconfigured VDSL2 settings. Table 13 on
page 44 lists the different profiles supported on the VDSL2 Mini-PIM and their
properties.

Table 13: Supported Profiles on the VDSL2 Mini-PIM

Data RateProfiles

508a

508b

508c

508d

6812a

6812b

10017a

Auto mode (default)Auto

Supported Features

The following features are supported on the VDSL2 Mini-PIM:

■ ADSL/ADSL2/ADSL2+ backward compatibility with Annex-A, Annex-M support

■ PTM or EFM (802.3ah) support

■ Operation, Administration, and Maintenance (OAM) support for
ADSL/ADSL/ADSL2+ mode

■ ATM quality of service (QoS) (supported only when the VDSL2 Mini-PIM is
operating in ADSL2 mode)

■ Multilink Point-to-Point Protocol (MLPPP) (supported only when the VDSL2
Mini-PIM is operating in ADSL2 mode)
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■ MTU size of 1500 bytes (maximum)

■ Support for maximum of 10 permanent virtual connections (PVCs) (only in
ADSL/ADSL2/ADSL2+ mode)

■ Dying gasp support (ADSL and VDSL2 mode)

Related Topics ADSL Interface Overview on page 34■

■ Configuring the VDSL2 Interface with the CLI Configuration Editor on page 189

DOCSIS Mini-PIM Interface Overview

This section includes the following topics:

■ Introduction on page 45

■ Configuring DOCSIS Mini-PIM on page 46

Introduction

Data over Cable Service Interface Specifications (DOCSIS) define the communications
and operation support interface requirements for a data-over-cable system. DOCSIS
is used by cable operators to provide Internet access over their existing cable
infrastructure for both residential and business customers. DOCSIS 3.0 is the latest
interface standard allowing channel bonding to deliver speeds higher than 100 Mbps
throughput in either direction, far surpassing other WAN technologies such as T1/E1,
ADSL2+, ISDN, and DS3.

DOCSIS network architecture includes a cable modem on SRX Series Services
Gateways with a DOCSIS Mini-Physical Interface Module (Mini-PIM) located at
customer premises and a cable modem termination system (CMTS) located at the
head-end or data center locations. Standards-based DOCSIS 3.0 Mini-PIM is
interoperable with CMTS equipments. The DOCSIS Mini-PIM provides backward
compatibility with CMTS equipment based on the following standards:

■ DOCSIS 2.0

■ DOCSIS 1.1

■ DOCSIS 1.0

DOCSIS Mini-PIM is supported on SRX210 and SRX240 Services Gateways.

Software Features Supported on DOCSIS Mini-PIMs

Table 14 on page 46 lists the software features related to DOCSIS Mini-PIMs.
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Table 14: Software Features Supported on DOCSIS Mini-PIMs

DefinitionTerm

DHCP and DHCPv6 clients are used to get the IP address from the CMTS by using DHCP
protocol. DHCP is supported on IPv4 and IPv6. One of the main components of the
configuration file is the static public IP address, which CMTS assigns to the cable modem.
The management IP address is configured on the Mini-PIM’s hybrid fiber coaxial (HFC)
interface, which performs the following tasks:

■ CMTS executes remote monitoring and management of the Mini-PIM’s cable interface.

■ Downloads the configuration file from CMTS and uses it for configuring the cable
interface.

DHCP and DHCPv6 Clients

The SRX Series device Routing Engine is configured through the existing QoS CLI. Because
the configuration on the SRX Series device Routing Engine and Mini-PIM is done together,
the QoS configuration has to be consistent between the SRX Series Routing Engine and the
cable modem interface. The QoS mechanisms on the SRX Series Routing Engine are decoupled
from the QoS mechanisms on the Mini-PIM.

The configuration file downloaded from CMTS contains parameters for primary and secondary
flows. These parameters are programmed in the DOCSIS Mini-PIM. The Mini-PIM sends these
parameters to the SRX Series Routing Engine through the PIM infrastructure. The secondary
flows are prioritized over primary flows in the DOCSIS Mini-PIM.

QoS Support

The SNMP requests are issued by CMTS and go to the cable modem. The DOCSIS MIB on
the SRX Series device Routing Engine displays the Ethernet interface of the cable modem.
The following features are supported on the DOCSIS Mini-PIM:

■ NAT support

■ Dying gasp support

■ Back pressure information

SNMP Support

The MAC address of the DOCSIS Mini-PIM is statically set at the factory and cannot be
changed. The MAC address is retrieved from the Mini-PIM and assigned to the cable modem
interface in the JUNOS Software.

MAC Address

The DOCSIS Mini-PIM performs transparent bridging by sending the packets received on the
Ethernet interface with the SRX Series device to the HFC interface and vice versa, without
any modifications to the packet. All the other services such as webserver, DHCP server, and
DNS server are disabled on the DOCSIS Mini-PIM during transparent bridging.

Transparent Bridging

Configuring DOCSIS Mini-PIM

The cable modem interface of Mini-PIM is managed and monitored by CMTS through
SNMP. This DOCSIS 3.0 Mini-PIM can be deployed in any multiple service operator
(MSO) networks. The primary application is for distributed enterprise offices to
connect to a CMTS network through the DOCSIS 3.0 (backward compatible to 2.0,
1.1, and 1.0) interface. The DOCSIS Mini-PIM uses PIM infrastructure developed for
third-party PIMs.

The Mini-PIM can also be used with encapsulations other than GRE, PPPoE, and
IP-in-IP.

Figure 10 on page 47 illustrates a typical use of this Mini-PIM in a multiple service
operator (MSO) network.
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Figure 10: Typical DOCSIS End-to-End Connectivity and Topology Diagram

2-Port 10 Gigabit Ethernet XPIM Overview

■ 10 Gigabit Ethernet Interface Overview on page 47

■ 2-Port Gigabit Ethernet XPIM Overview on page 47

■ 2-Port 10 Gigabit Ethernet XPIM Terminology on page 48

■ Supported Features on page 49

10 Gigabit Ethernet Interface Overview

The 10 Gigabit Ethernet (10GBASE-T), based on the IEEE 802.3a standard, is a
telecommunication technology that offers data speeds up to 10 billion bits per second.

The 10 Gigabit Ethernet is used to interconnect LANs, WANs, and metropolitan area
networks (MANs). The 2-Port 10 Gigabit Ethernet XPIM can provide multiple service
levels (1Gigabit Ethernet to 10 Gigabit Ethernet in increments) and a single connection
option for a wide range of customer needs and applications.

2-Port Gigabit Ethernet XPIM Overview

The 2-Port 10 Gigabit Ethernet XPIM is supported on the SRX650 Services Gateway.

The 2-Port 10 Gigabit Ethernet XPIM is a 2 x 10GBASE-T / SFP+ XPIM line card that
includes the following ports:
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■ 2 X copper ports. The copper ports support 10GBASE-T running with CAT6A or
CAT7 Ethernet cable for up to 100 meters.

■ 2 X fiber (SFP+) ports. The fiber ports support SFP+ multiple 10G modules.

NOTE:

■ On the 2-Port 10 Gigabit Ethernet XPIM, one copper port and one fiber port is
grouped together as port 0, and another copper port and fiber port are grouped
as port 1.

■ Only two ports can be active at same time (one port from port 0 and another
port from port 1)

■ The 2-Port 10 Gigabit Ethernet XPIM can be configured to operate in two copper
mode, two fiber mode, or mixed mode (one copper and one fiber). In mixed
mode, two port should be from different port group (one port from port 0 and
one port from port 1).

■ The ports support the following link speeds for copper and fiber:

■ Copper – 10/100/1000Mbps/10G (full-duplex). Half duplex is only for 10/100
Mbps.

■ Fiber – 1000Mbps/10G (full-duplex)

2-Port 10 Gigabit Ethernet XPIM Terminology

Table 15 on page 48 lists the terms related to 2-Port 10 Gigabit Ethernet XPIM
technology.

Table 15: 2-Port 10 Gigabit Ethernet XPIM Terminology

DefinitionTerm

Standard Ethernet specification that provides 10 Gbps
connections over unshielded or shielded twisted pair cables.

10GBASE-T or IEEE 802.3an

Standard Ethernet specification that provides 1 Gbps
connections over twisted pair.

1000BASE-T IEEE 802.3ab

Standard Ethernet specification that provides 100 Mbps
connections over twisted pair.

100BASE-T IEEE 802.3u

Fiber optic transceiver module designed for 10 Gigabit
Ethernet and 8.5 Gbps fiber channel systems.

SFP+

Physical Interface Modules (PIMs) that provides 10 Gigabit
Ethernet front end interface connection.

XPIM

48 ■ 2-Port 10 Gigabit Ethernet XPIM Overview

JUNOS Software Interfaces and Routing Configuration Guide



Supported Features

The following features are supported on the 2-Port 10 Gigabit Ethernet XPIM:

■ Multiple SFP+ 10G modules support. The following SFP modules are supported:

■ SFPP-10GE-SR

■ SFPP-10GE-LR

■ SFPP-10GE-ER

■ SFPP-10GE-LRM

■ Support for Copper TWIN-AX 1M and Copper TWIN-AX 3M

■ Online Insertion and Removal (OIR ) functionality

■ Link speeds of up to 10 gigabits/second

■ Full-duplex and half-duplex modes

■ Flow control

■ Autonegotiation and autosensing

■ Support quality of service (QoS)

NOTE: By default, flow control is enabled on all ports, and link speed of 10 Gbps in
full duplex is supported. By default autonegotation disabled on the fiber ports where
as it is enabled on copper ports.

NOTE: Autonegotiation is not supported when the 2-Port 10 Gigabit Ethernet XPIM
is operating in fiber mode at link speed of 10 Gbps.

ISDN Interface Overview

The Integrated Services Digital Network (ISDN) technology is a design for a completely
digital telecommunications network. ISDN can carry voice, data, images, and video
across a telephony network, using a single interface for all transmissions.

ISDN Channels

ISDN uses separate channels to transmit voice and data over the network. Channels
operate at bandwidths of either 64 Kbps or 16 Kbps, depending on the type of
channel.

Bearer channels (B-channels) use 64 Kbps to transmit voice, data, video, or multimedia
information. This bandwidth is derived from the fact that analog voice lines are
sampled at a rate of 64 Kbps (8,000 samples per second using 8 bits per sample).
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Delta channels (D-channels) are control channels that operate at either 16 Kbps or
64 Kbps. D-channels are used primarily for ISDN signaling between switching
equipment in an ISDN network.

ISDN Interfaces

ISDN provides two basic types of service, Basic Rate Interface (BRI) and Primary
Rate Interface (PRI). J Series devices support both ISDN BRI and ISDN PRI.

ISDN BRI is designed for high-bandwidth data transmissions through existing
telephone lines. The copper wires that make up much of the existing telephony
infrastructure can support approximately 160 Kbps, which provides enough bandwidth
for two B-channels and a D-channel, leaving 16 Kbps for any data framing,
maintenance, and link control overhead.

ISDN PRI is designed for users with greater capacity requirements than can be met
with ISDN BRI. In the United States, the most common PRI supports 23 B-channels
and 1 D-channel, totalling 1,536 Kbps, which is roughly equivalent to a T1 link. In
Europe, the most common PRI supports 30 B-channels and 1 D-channel, totalling
1,984 Kbps, which is roughly equivalent to an E1 link.

Typical ISDN Network

Figure 11 on page 50 shows a typical ISDN network.

Figure 11: ISDN Network

In Figure 11 on page 50, two types of end-user devices are connected to the ISDN
network:

■ Terminal equipment type 1 (TE1) device—Designed to connect directly through
an ISDN telephone line.

■ Terminal equipment type 2 (TE2) device—Not designed for ISDN. TE2
devices—for example, analog telephones or modems—must connect to the ISDN
network through a terminal adapter (TA).
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A terminal adapter allows non-ISDN devices on the ISDN network.

NT Devices and S and T Interfaces

The interface between the ISDN network and a TE1 device or terminal adapter is
called an S interface. The S interface connects to a network termination type 2 (NT2)
device such as a PBX, or directly to the TE1 device or terminal adapter, as shown in
Figure 11 on page 50. The NT2 device is then connected to a network termination
type 1 (NT1) device through a T interface. The S and T interfaces are electrically
equivalent.

An NT1 device is a physical layer device that connects a home telephone network
to a service provider carrier network. ISDN devices that connect to an NT1 device
from the home network side use a 4-wire S/T interface. The NT1 device converts the
4-wire S/T interface into the 2-wire U interface that telephone carriers use as their
plain old telephone service (POTS) lines.

In the United States, NT1 devices are user owned. In many other countries, NT1
devices are owned by the telephone service providers.

U Interface

The U interface connects the ISDN network into the telephone switch through line
termination (LT) equipment. The connection from LT equipment to other switches
within the telephone network is called the exchange termination (ET).

ISDN Call Setup

Before traffic can pass through an ISDN network, an ISDN call must be set up. ISDN
call setup requires a Layer 2 connection to be initialized and then a Layer 3 session
to be established over the connection.

To specify the services and features to be provided by the service provider switch,
you must set service profile identifiers (SPIDs) on TE1 devices before call setup and
initialization. If you define SPIDs for features that are not available on the ISDN link,
Layer 2 initialization takes place, but a Layer 3 connection is not established.

Layer 2 ISDN Connection Initialization

The TE device and the telephone network initialize a Layer 2 connection for ISDN
as follows:

1. The TE device and the telephone network exchange Receive Ready (RR) frames,
to indicate that they are available for data transmission. A call cannot be set up
if either the TE device or telephone network does not transmit RR frames.

2. If both ends of the ISDN connection are available to receive data, the TE device
sends an Unnumbered Information (UI) frame to all devices on the ISDN link.

3. When it receives the UI frame, the network responds with a message containing
a unique terminal endpoint identifier (TEI) that identifies the endpoint on the
ISDN link for all subsequent data transmissions.

4. When the TE device receives the TEI message, it sends out a call setup message.
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5. The network sends an acknowledgement of the call setup message.

6. When the TE device receives the acknowledgement, a Layer 2 connection is
initialized on the ISDN link.

Layer 3 ISDN Session Establishment

The caller, switch, and receiver establish a Layer 3 ISDN connection as follows:

1. When a Layer 2 connection is initialized, the caller sends a SETUP message to
the switch in the telephone network.

2. If the setup is message is valid, the switch responds with a call proceeding (CALL
PROC) message to the caller and a SETUP message to the receiver.

3. When the receiver receives the SETUP message, it responds with an ALERTING
message to the telephone switch.

4. This ALERTING message is then forwarded to the caller.

5. The receiver then accepts the connection by sending a CONNECT message to
the switch.

6. The switch forwards the CONNECT message to the caller.

7. The caller responds with an acknowledgement message (CONNECT ACK).

8. When the CONNECT ACK message is received by the receiver, the ISDN call is
set up and traffic can pass.

Interface Physical Properties

The physical properties of a network interface are the characteristics associated with
the physical link that affect the transmission of either link-layer signals or the data
across the links. Physical properties include clocking properties, transmission
properties, such as the maximum transmission unit (MTU), and encapsulation
methods, such as point-to-point and Frame Relay encapsulation.

The default property values for an interface are usually sufficient to successfully
enable a bidirectional link. However, if you configure a set of physical properties on
an interface, those same properties must be set on all adjacent interfaces to which
a direct connection is made.

Table 16 on page 52 summarizes some key physical properties of device interfaces.

Table 16: Interface Physical Properties

DescriptionPhysical Property

Bit error rate (BER). The error rate specifies the number of bit errors in a particular bit error rate
test (BERT) period required to generate a BERT error condition. See “Bit Error Rate Testing” on
page 53.

bert-error-rate

Bit error rate test (BERT) time period over which bit errors are sampled. See “Bit Error Rate Testing”
on page 53.

bert-period
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Table 16: Interface Physical Properties (continued)

DescriptionPhysical Property

Challenge Handshake Authentication Protocol (CHAP). Specifying chap enables CHAP authentication
on the interface. See “PPP Authentication” on page 60.

chap

Clock source for the link. Clocking can be provided by the local system (internal) or a remote
endpoint on the link (external). By default, all interfaces use the internal clocking mode. If an
interface is configured to accept an external clock source, one adjacent interface must be configured
to act as a clock source. Under this configuration, the interface operates in a loop timing mode, in
which the clocking signal is unique for that individual network segment or loop. See “Interface
Clocking” on page 54.

clocking

A user-defined text description of the interface, often used to describe the interface's purpose.description

Administratively disables the interface.disable

Type of encapsulation on the interface. Common encapsulation types include PPP, Frame Relay,
Cisco HDLC, and PPP over Ethernet (PPPoE). See “Physical Encapsulation on an Interface” on
page 57.

encapsulation

Frame check sequence (FCS). FCS is an error-detection scheme that appends parity bits to a digital
signal and uses decoding algorithms that detect errors in the received digital signal. See “Frame
Check Sequences” on page 55.

fcs

Maximum transmission unit (MTU) size. The MTU is the largest size packet or frame, specified in
bytes or octets, that can be sent in a packet-based or frame-based network. The Transmission
Control Protocol (TCP) uses the MTU to determine the maximum size of each packet in any
transmission. For MTU values on J Series interfaces, see “MTU Default and Maximum Values” on
page 56.

mtu

Disabling of keepalive messages across a physical link. A keepalive message is sent between
network devices to indicate that they are still active. Keepalives help determine whether the interface
is operating correctly. Except for ATM-over-ADSL interfaces, all interfaces use keepalives by default.

no-keepalives

Password Authentication Protocol (PAP). Specifying pap enables PAP authentication on the interface.
To configure PAP, use the CLI or J-Web configuration editor. PAP is not available in the J-Web Quick
Configuration pages.

pap

Scrambling of traffic transmitted out the interface. Payload scrambling randomizes the data payload
of transmitted packets. Scrambling eliminates nonvariable bit patterns (strings of all 1s or all 0s)
that generate link-layer errors across some physical links.

payload-scrambler

Bit Error Rate Testing

In telecommunication transmission, the bit error rate (BER) is the percentage of bits
that have errors compared to the total number of bits received in a transmission,
usually expressed as 10 to a negative power. For example, a transmission with a
BER of 10–6 received 1 errored bit in 1,000,000 bits transmitted. The BER indicates
how often a packet or other data unit must be retransmitted because of an error. If
the BER is too high, a slower data rate might improve the overall transmission time
for a given amount of data if it reduces the BER and thereby lowers the number of
resent packets.
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A bit error rate test (BERT) is a procedure or device that measures the BER for a given
transmission. You can configure a device to act as a BERT device by configuring the
interface with a bit error rate and a testing period. When the interface receives a
BERT request from a BER tester, it generates a response in a well-known BERT
pattern. The initiating device checks the BERT-patterned response to determine the
number of bit errors.

Interface Clocking

Clocking determines how individual routing nodes or entire networks sample
transmitted data. As streams of information are received by a device in a network,
a clock source specifies when to sample the data. In asynchronous networks, the
clock source is derived locally, and synchronous networks use a central, external
clock source. Interface clocking indicates whether the device uses asynchronous or
synchronous clocking.

NOTE: Because truly synchronous networks are difficult to design and maintain,
most synchronous networks are really plesiochronous networks. In a plesiochronous
network, different timing regions are controlled by local clocks that are synchronized
(with very narrow constraints). Such networks approach synchronicity and are
generally known as synchronous networks.

Most networks are designed to operate as asynchronous networks. Each device
generates its own clock signal, or devices use clocks from more than one clock source.
The clocks within the network are not synchronized to a single clock source. By
default, devices generate their own clock signals to send and receive traffic.

The system clock allows the device to sample (or detect) and transmit data being
received and transmitted through its interfaces. Clocking enables the device to detect
and transmit the 0s and 1s that make up digital traffic through the interface. Failure
to detect the bits within a data flow results in dropped traffic.

Short-term fluctuations in the clock signal are known as clock jitter. Long-term
variations in the signal are known as clock wander.

Asynchronous clocking can either derive the clock signal from the data stream or
transmit the clocking signal explicitly.

Data Stream Clocking

Common in T1 links, data stream clocking occurs when separate clock signals are
not transmitted within the network. Instead, devices must extract the clock signal
from the data stream. As bits are transmitted across the network, each bit has a time
slot of 648 nanoseconds. Within a time slot, pulses are transmitted with alternating
voltage peaks and drops. The receiving device uses the period of alternating voltages
to determine the clock rate for the data stream.
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Explicit Clocking Signal Transmission

Clock signals that are shared by hosts across a data link must be transmitted by one
or both endpoints on the link. In a serial connection, for example, one host operates
as a clock master and the other operates as a clock slave. The clock master internally
generates a clock signal that is transmitted across the data link. The clock slave
receives the clock signal and uses its period to determine when to sample data and
how to transmit data across the link.

This type of clock signal controls only the connection on which it is active and is not
visible to the rest of the network. An explicit clock signal does not control how other
devices or even other interfaces on the same device sample or transmit data.

Frame Check Sequences

All packets or frames within a network can be damaged by crosstalk or interference
in the network's physical wires. The frame check sequence (FCS) is an extra field in
each transmitted frame that can be analyzed to determine if errors have occurred.
The FCS uses cyclic redundancy checks (CRCs), checksums, and two-dimensional
parity bits to detect errors in the transmitted frames.

Cyclic Redundancy Checks and Checksums

On a link that uses CRCs for frame checking, the data source uses a predefined
polynomial algorithm to calculate a CRC number from the data it is transmitting.
The result is included in the FCS field of the frame and transmitted with the data.
On the receiving end, the destination host performs the same calculation on the data
it receives.

If the result of the second calculation matches the contents of the FCS field, the
packet was sent and received without bit errors. If the values do not match, an FCS
error is generated, the frame is discarded and the originating host is notified of the
error.

Checksums function similarly to CRCs, but use a different algorithm.

Two-Dimensional Parity

On a link that uses two-dimensional parity bits for frame checking, the sending and
receiving hosts examine each frame in the total packet transmission and create a
parity byte that is evaluated to detect transmission errors.

For example, a host can create the parity byte for the following frame sequence by
summing up each column (each bit position in the frame) and keeping only the
least-significant bit:

 Frame 1       0 1 0 1 0 0 1
 Frame 2       1 1 0 1 0 0 1
 Frame 3       1 0 1 1 1 1 0
 Frame 4       0 0 0 1 1 1 0
 Frame 5       0 1 1 0 1 0 0
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 Frame 6       1 0 1 1 1 1 1

 Parity Byte   1 1 1 1 0 1 1

If the sum of the bit values in a bit position is even, the parity bit for the position is
0. If the sum is odd, the parity bit is 1. This method is called even parity. Matching
parity bytes on the originating and receiving hosts indicate that the packet was
received without error.

MTU Default and Maximum Values

Table 17 on page 56 lists MTU values for J Series devices.

Table 17: MTU Values for J2320, J2350, J4350, and J6350 Interfaces

Default IP MTU
(bytes)

Maximum MTU
(bytes)

Default Media MTU
(bytes)J4350 and J6350 Interfaces

150090181514Gigabit Ethernet (10/100/1000) built-in interface

1500901415146-Port, 8-Port, and 16-Port Gigabit Ethernet uPIMs

150090181514Gigabit Ethernet (10/100/1000) ePIM

150090181514Gigabit Ethernet (10/100/1000) SFP ePIM

1500151415144-Port Fast Ethernet (10/100) ePIM

150091921514Dual-Port Fast Ethernet (10/100) PIM

150091501504Dual-Port Serial PIM

150091921504Dual-Port T1 or E1 PIM

150045001504Dual-Port Channelized T1/E1/ISDN PRI PIM (channelized
to DS0s)

150091501504Dual-Port Channelized T1/E1/ISDN PRI PIM
(clear-channel T1 or E1)

150040981504Dual-Port Channelized T1/E1/ISDN PRI PIM (ISDN PRI
dialer interface)

447091924474T3 (DS3) or E3 PIM

1500409215044-Port ISDN BRI PIM

447091504482ADSL+2 PIM

447091504482G.SHDSL PIM
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Physical Encapsulation on an Interface

Encapsulation is the process by which a lower-level protocol accepts a message from
a higher-level protocol and places it in the data portion of the lower-level frame. As
a result, datagrams transmitted through a physical network have a sequence of
headers: the first header for the physical network (or data link layer) protocol, the
second header for the network layer protocol (IP, for example), the third header for
the transport protocol, and so on.

The following encapsulation protocols are supported on device physical interfaces:

■ Frame Relay on page 57

■ Point-to-Point Protocol on page 59

■ Point-to-Point Protocol over Ethernet on page 61

■ High-Level Data Link Control on page 63

Frame Relay

The Frame Relay packet-switching protocol operates at the physical and data link
layers in a network to optimize packet transmissions by creating virtual circuits
between hosts. Figure 12 on page 57 shows a typical Frame Relay network.

Figure 12: Frame Relay Network

Figure 12 on page 57 shows multiple paths from Host A to Host B. In a typical routed
network, traffic is sent from device to device with each device making routing
decisions based on its own routing table. In a packet-switched network, the paths
are predefined. Devices switch a packet through the network according to
predetermined next-hops established when the virtual circuit is set up.
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Virtual Circuits

A virtual circuit is a bidirectional path between two hosts in a network. Frame Relay
virtual circuits are logical connections between two hosts that are established either
by a call setup mechanism or by explicit configuration.

A virtual circuit created through a call setup mechanism is known as a switched
virtual circuit (SVC). A virtual circuit created through explicit configuration is called
a permanent virtual circuit (PVC).

Switched and Permanent Virtual Circuits

Before data can be transmitted across an SVC, a signaling protocol like ISDN must
set up a call by the exchange of setup messages across the network. When a
connection is established, data is transmitted across the SVC. After data transmission,
the circuit is torn down and the connection is lost. For additional traffic to pass
between the same two hosts, a subsequent SVC must be established, maintained,
and terminated.

Because PVCs are explicitly configured, they do not require the setup and teardown
of SVCs. Data can be switched across the PVC whenever a host is ready to transmit.
SVCs are useful in networks where data transmission is sporadic and a permanent
circuit is not needed.

Data-Link Connection Identifiers

An established virtual circuit is identified by a data-link connection identifier (DLCI).
The DLCI is a value from 16 through 1022. (Values 1 through 15 are reserved.) The
DLCI uniquely identifies a virtual circuit locally so that devices can switch packets to
the appropriate next-hop address in the circuit. Multiple paths that pass through the
same transit devices have different DLCIs and associated next-hop addresses.

Congestion Control and Discard Eligibility

Frame Relay uses the following types of congestion notification to control traffic
within a Frame Relay network. Both are controlled by a single bit in the Frame Relay
header.

■ Forward-explicit congestion notification (FECN)

■ Backward-explicit congestion notification (BECN)

Traffic congestion is typically defined in the buffer queues on a device. When the
queues reach a predefined level of saturation, traffic is determined to be congested.
When traffic congestion occurs in a virtual circuit, the device experiencing congestion
sets the congestion bits in the Frame Relay header to 1. As a result, transmitted
traffic has the FECN bit set to 1, and return traffic on the same virtual circuit has the
BECN bit set to 1.

When the FECN and BECN bits are set to 1, they provide a congestion notification
to the source and destination devices. The devices can respond in either of two ways:
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to control traffic on the circuit by sending it through other routes, or to reduce the
load on the circuit by discarding packets.

If devices discard packets as a means of congestion (flow) control, Frame Relay uses
the discard eligibility (DE) bit to give preference to some packets in discard decisions.
A DE value of 1 indicates that the frame is of lower importance than other frames
and more likely to be dropped during congestion. Critical data (such as signaling
protocol messages) without the DE bit set is less likely to be dropped.

Point-to-Point Protocol

The Point-to-Point Protocol (PPP) is an encapsulation protocol for transporting IP
traffic across point-to-point links. PPP is made up of three primary components:

■ Link control protocol (LCP)—Establishes working connections between two
points.

■ Authentication protocols—Enable secure connections between two points.

■ Network control protocols (NCPs)—Initialize the PPP protocol stack to handle
multiple network layer protocols, such as IPv4, IPv6, and Connectionless Network
Protocol (CLNP).

Link Control Protocol

LCP is responsible for establishing, maintaining, and tearing down a connection
between two endpoints. LCP also tests the link and determines whether it is active.
LCP establishes a point-to-point connection as follows:

1. LCP must first detect a clocking signal on each endpoint. However, because the
clocking signal can be generated by a network clock and shared with devices on
the network, the presence of a clocking signal is only a preliminary indication
that the link might be functioning.

2. When a clocking signal is detected, a PPP host begins transmitting PPP
Configure-Request packets.

3. If the remote endpoint on the point-to-point link receives the Configure-Request
packet, it transmits a Configure-Acknowledgement packet to the source of the
request.

4. After receiving the acknowledgement, the initiating endpoint identifies the link
as established. At the same time, the remote endpoint sends its own request
packets and processes the acknowledgement packets. In a functioning network,
both endpoints treat the connection as established.

During connection establishment, LCP also negotiates connection parameters such
as FCS and HDLC framing. By default, PPP uses a 16-bit FCS, but you can configure
PPP to use either a 32-bit FCS or a 0-bit FCS (no FCS). Alternatively, you can enable
HDLC encapsulation across the PPP connection.

After a connection is established, PPP hosts generate Echo-Request and
Echo-Response packets to maintain a PPP link.
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PPP Authentication

PPP's authentication layer uses a protocol to help ensure that the endpoint of a PPP
link is a valid device. Authentication protocols include the Password Authentication
Protocol (PAP), the Extensible Authentication Protocol (EAP), and the Challenge
Handshake Authentication Protocol (CHAP). CHAP is the most commonly used.

NOTE: EAP is not currently supported on J Series devices. PAP is supported, but must
be configured from the CLI or J-Web configuration editor. PAP is not configurable
from the J-Web Quick Configuration pages.

CHAP ensures secure connections across PPP links. After a PPP link is established
by LCP, the PPP hosts at either end of the link initiate a three-way CHAP handshake.
Two separate CHAP handshakes are required before both sides identify the PPP link
as established.

CHAP configuration requires each endpoint on a PPP link to use a shared secret
(password) to authenticate challenges. The shared secret is never transmitted over
the wire. Instead, the hosts on the PPP connection exchange information that enables
both to determine that they share the same secret. Challenges consist of a hash
function calculated from the secret, a numeric identifier, and a randomly chosen
challenge value that changes with each challenge. If the response value matches the
challenge value, authentication is successful. Because the secret is never transmitted
and is required to calculate the challenge response, CHAP is considered very secure.

PAP authentication protocol uses a simple 2-way handshake to establish identity.
PAP is used after the link establishment phase (LCP up), during the authentication
phase. JUNOS Software can support PAP in one direction (egress or ingress), and
CHAP in the other.

Network Control Protocols

After authentication is completed, the PPP connection is fully established. At this
point, any higher-level protocols (for example, IP protocols) can initialize and perform
their own negotiations and authentication.

PPP NCPs include support for the following protocols. IPCP and IPV6CP are the most
widely used on J Series devices.

■ ATCP—AppleTalk Control Protocol

■ BCP—Bridging Control Protocol

■ BVCP—Banyan Vines Control Protocol

■ DNCP—DECnet Phase IV Control Protocol

■ IPCP—IP Control Protocol

■ IPV6CP—IPv6 Control Protocol

■ IPXCP—Novell IPX Control Protocol

■ LECP—LAN Extension Control Protocol
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■ NBFCP—NetBIOS Frames Control Protocol

■ OSINLCP—OSI Network Layer Control Protocol (includes IS-IS, ES-IS, CLNP, and
IDRP)

■ SDTP—Serial Data Transport Protocol

■ SNACP—Systems Network Architecture (SNA) Control Protocol

■ XNSCP—Xerox Network Systems (XNS) Internet Datagram Protocol (IDP) Control
Protocol

Magic Numbers

Hosts running PPP can create “magic” numbers for diagnosing the health of a
connection. A PPP host generates a random 32-bit number and sends it to the remote
endpoint during LCP negotiation and echo exchanges.

In a typical network, each host's magic number is different. A magic number
mismatch in an LCP message informs a host that the connection is not in loopback
mode and traffic is being exchanged bidirectionally. If the magic number in the LCP
message is the same as the configured magic number, the host determines that the
connection is in loopback mode, with traffic looped back to the transmitting host.

Looping traffic back to the originating host is a valuable way to diagnose network
health between the host and the loopback location. To enable loopback testing,
telecommunications equipment typically supports channel service unit/data service
unit (CSU/DSU) devices.

CSU/DSU Devices

A channel service unit (CSU) connects a terminal to a digital line. A data service unit
(DSU) performs protective and diagnostic functions for a telecommunications line.
Typically, the two devices are packaged as a single unit. A CSU/DSU device is required
for both ends of a T1 or T3 connection, and the units at both ends must be set to
the same communications standard.

A CSU/DSU device enables frames sent along a link to be looped back to the
originating host. Receipt of the transmitted frames indicates that the link is functioning
correctly up to the point of loopback. By configuring CSU/DSU devices to loop back
at different points in a connection, network operators can diagnose and troubleshoot
individual segments in a circuit.

Point-to-Point Protocol over Ethernet

Point-to-Point Protocol over Ethernet (PPPoE) combines PPP, which is typically run
over broadband connections, with the Ethernet link-layer protocol that allows users
to connect to a network of hosts over a bridge or access concentrator. PPPoE enables
service providers to maintain access control through PPP connections and also
manage multiple hosts at a remote site.

To provide a PPPoE connection, each PPP session must learn the Ethernet address
of the remote peer and establish a unique session identifier during the PPPoE
discovery and session stages.
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PPPoE Discovery

To initiate a PPPoE session, a host must first identify the Ethernet MAC address of
the remote peer and establish a unique PPPoE session ID for the session. Learning
the remote Ethernet MAC address is called PPPoE discovery.

During the PPPoE discovery process, the host does not discover a remote endpoint
on the Ethernet network. Instead, the host discovers the access concentrator through
which all PPPoE sessions are established. Discovery is a client/server relationship,
with the host (a J Series device) acting as the client and the access concentrator acting
as the server.

The PPPoE discovery stage consists of the following steps:

1. PPPoE Active Discovery Initiation (PADI)—The client initiates a session by
broadcasting a PADI packet to the LAN, to request a service.

2. PPPoE Active Discovery Offer (PADO)—Any access concentrator that can provide
the service requested by the client in the PADI packet replies with a PADO packet
that contains it own name, the unicast address of the client, and the service
requested. An access concentrator can also use the PADO packet to offer other
services to the client.

3. PPPoE Active Discovery Request (PADR)—From the PADOs it receives, the client
selects one access concentrator based on its name or the services offered and
sends it a PADR packet to indicate the service or services needed.

4. PPPoE Active Discovery Session-Confirmation (PADS)—When the selected access
concentrator receives the PADR packet, it accepts or rejects the PPPoE session:

■ To accept the session, the access concentrator sends the client a PADS packet
with a unique session ID for a PPPoE session and a service name that
identifies the service under which it accepts the session.

■ To reject the session, the access concentrator sends the client a PADS packet
with a service name error and resets the session ID to zero.

PPPoE Sessions

The PPPoE session stage starts after the PPPoE discovery stage is over. Each PPPoE
session is uniquely identified by the Ethernet address of the peer and the session ID.
After the PPPoE session is established, data is sent as in any other PPP encapsulation.
The PPPoE information is encapsulated within an Ethernet frame and is sent to a
unicast address. Magic numbers, echo requests, and all other PPP traffic behave
exactly as in normal PPP sessions. In this stage, both the client and the server must
allocate resources for the PPPoE logical interface.

After a session is established, the client or the access concentrator can send a PPPoE
Active Discovery Termination (PADT) packet anytime to terminate the session. The
PADT packet contains the destination address of the peer and the session ID of the
session to be terminated. After this packet is sent, the session is closed to PPPoE
traffic.
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High-Level Data Link Control

High-Level Data Link Control (HDLC) is a bit-oriented, switched and nonswitched
link-layer protocol. HDLC is widely used because it supports half-duplex and full-duplex
connections, point-to-point and point-to-multipoint networks, and switched and
nonswitched channels.

HDLC Stations

Nodes within a network running HDLC are called stations. HDLC supports three types
of stations for data link control:

■ Primary stations—Responsible for controlling the secondary and combined other
stations on the link. Depending on the HDLC mode, the primary station is
responsible for issuing acknowledgement packets to allow data transmission
from secondary stations.

■ Secondary stations—Controlled by the primary station. Under normal
circumstances, secondary stations cannot control data transmission across the
link with the primary station, are active only when requested by the primary
station, and can respond to the primary station only (not to other secondary
stations). All secondary station frames are response frames.

■ Combined stations—A combination of primary and secondary stations. On an
HDLC link, all combined stations can send and receive commands and responses
without any permission from any other stations on the link and cannot be
controlled by any other station.

HDLC Operational Modes

HDLC runs in three separate modes:

■ Normal Response Mode (NRM)—The primary station on the HDLC link initiates
all information transfers with secondary stations. A secondary station on the
link can transmit a response of one or more information frames only when it
receives explicit permission from the primary station. When the last frame is
transmitted, the secondary station must wait for explicit permission before it
can transmit more frames.

NRM is used most widely for point-to-multipoint links, in which a single primary
station controls many secondary stations.

■ Asynchronous Response Mode (ARM)—The secondary station can transmit either
data or control traffic at any time, without explicit permission from the primary
station. The primary station is responsible for error recovery and link setup, but
the secondary station can transmit information at any time.

ARM is used most commonly with point-to-point links, because it reduces the
overhead on the link by eliminating the need for control packets.

■ Asynchronous Balance Mode (ABM)—All stations are combined stations. Because
no other station can control a combined station, all stations can transmit
information without explicit permission from any other station. ABM is not a
widely used HDLC mode.
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Interface Logical Properties

The logical properties of an interface are the characteristics that do not apply to the
physical interface or the wires connected to it. Logical properties include the protocol
families running on the interface (including any protocol-specific MTUs), the IP address
or addresses associated with the interface, virtual LAN (VLAN) tagging, and any
firewall filters or routing policies that are operating on the interface.

The IP specification requires a unique address on every interface of each system
attached to an IP network, so that traffic can be correctly routed. Individual hosts
such as home computers must have a single IP address assigned. Devices must have
a unique IP address for every interface.

This section contains the following topics:

■ Protocol Families on page 64

■ IPv4 Addressing on page 65

■ IPv6 Addressing on page 68

■ Virtual LANs on page 72

Protocol Families

A protocol family is a group of logical properties within an interface configuration.
Protocol families include all the protocols that make up a protocol suite. To use a
protocol within a particular suite, you must configure the entire protocol family as a
logical property for an interface. The protocol families include common and
not-so-common protocol suites.

Common Protocol Suites

JUNOS protocol families include the following common protocol suites:

■ Inet—Supports IP protocol traffic, including Open Shortest Path First (OSPF),
Border Gateway Protocol (BGP), and Internet Control Message Protocol (ICMP).

■ Inet6—Supports IPv6 protocol traffic, including Routing Information Protocol
for IPv6 (RIPng), Intermediate System-to-Intermediate System (IS-IS), and BGP.

■ ISO—Supports IS-IS traffic.

■ MPLS—Supports Multiprotocol Label Switching (MPLS).

NOTE: JUNOS Software security features are flow-based—meaning the device sets
up a flow in order to examine the traffic. Flow-based processing is not supported for
ISO or MPLS protocol families.
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Other Protocol Suites

In addition to the common protocol suites, JUNOS protocol families sometimes use
the following protocol suites:

■ ccc—Circuit cross-connect (CCC).

■ mlfr-uni-nni—Multilink Frame Relay (MLFR) FRF.16 user-to-network
network-to-network (UNI NNI).

■ mlfr-end-to-end—Multilink Frame Relay end-to-end.

■ mlppp—Multilink Point-to-Point Protocol.

■ tcc—Translational cross-connect (TCC).

■ tnp—Trivial Network Protocol. This Juniper Networks proprietary protocol provides
communication between the Routing Engine and the device's packet forwarding
components. JUNOS Software automatically configures this protocol family on
the device's internal interfaces only.

IPv4 Addressing

IPv4 addresses are 32-bit numbers that are typically displayed in dotted decimal
notation. A 32-bit address contains two primary parts: the network prefix and the
host number.

All hosts within a single network share the same network address. Each host also
has an address that uniquely identifies it. Depending on the scope of the network
and the type of device, the address is either globally or locally unique. Devices that
are visible to users outside the network (webservers, for example) must have a
globally unique IP address. Devices that are visible only within the network (J Series
devices, for example) must have locally unique IP addresses.

IP addresses are assigned by a central numbering authority called the Internet
Assigned Numbers Authority (IANA). IANA ensures that addresses are globally unique
where needed and has a large address space reserved for use by devices not visible
outside their own networks.

IPv4 Classful Addressing

To provide flexibility in the number of addresses distributed to networks of different
sizes, 4-octet (32-bit) IP addresses were originally divided into three different
categories or classes: class A, class B, and class C. Each address class specifies a
different number of bits for its network prefix and host number:

■ Class A addresses use only the first byte (octet) to specify the network prefix,
leaving 3 bytes to define individual host numbers.

■ Class B addresses use the first 2 bytes to specify the network prefix, leaving
2 bytes to define host addresses.

■ Class C addresses use the first 3 bytes to specify the network prefix, leaving only
the last byte to identify hosts.
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In binary format, with an x representing each bit in the host number, the three
address classes can be represented as follows:

00000000 xxxxxxxx xxxxxxxx xxxxxxxx (Class A)
00000000 00000000 xxxxxxxx xxxxxxxx (Class B)
00000000 00000000 00000000 xxxxxxxx (Class C)

Because each bit (x) in a host number can have a 0 or 1 value, each represents a
power of 2. For example, if only 3 bits are available for specifying the host number,
only the following host numbers are possible:

111 110 101 100 011 010 001 000

In each IP address class, the number of host-number bits raised to the power of 2
indicates how many host numbers can be created for a particular network prefix.
Class A addresses have 224 (or 16,777,216) possible host numbers, class B addresses
have 216 (or 65,536) host numbers, and class C addresses have 28 (or 256) possible
host numbers.

IPv4 Dotted Decimal Notation

The 32-bit IPv4 addresses are most often expressed in dotted decimal notation, in
which each octet (or byte) is treated as a separate number. Within an octet, the
rightmost bit represents 20 (or 1), increasing to the left until the first bit in the octet
is 27 (or 128). Following are IP addresses in binary format and their dotted decimal
equivalents:

11010000 01100010 11000000 10101010 = 208.98.192.170
01110110 00001111 11110000 01010101 = 118.15.240.85
00110011 11001100 00111100 00111011 = 51.204.60.59

IPv4 Subnetting

Because of the physical and architectural limitations on the size of networks, you
often must break large networks into smaller subnetworks. Within a network, each
wire or ring requires its own network number and identifying subnet address.

Figure 13 on page 67 shows two subnets in a network.
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Figure 13: Subnets in a Network

Figure 13 on page 67 shows three devices connected to one subnet and three more
devices connected to a second subnet. Collectively, the six devices and two subnets
make up the larger network. In this example, the network is assigned the network
prefix 192.14.0.0, a class B address. Each device has an IP address that falls within
this network prefix.

In addition to sharing a network prefix (the first two octets), the devices on each
subnet share a third octet. The third octet identifies the subnet. All devices on a
subnet must have the same subnet address. In this case, the alpha subnet has the
IP address 192.14.126.0 and the beta subnet has the IP address 192.14.17.0.

The subnet address 192.14.17.0 can be represented as follows in binary notation:

11000000 . 00001110 . 00010001 . xxxxxxxx

Because the first 24 bits in the 32-bit address identify the subnet, the last 8 bits are
not significant. To indicate the subnet, the address is written as 192.14.17.0/24 (or
just 192.14.17/24). The /24 is the subnet mask (sometimes shown as
255.255.255.0).

IPv4 Variable-Length Subnet Masks

Traditionally, subnets were divided by address class. Subnets had either 8, 16, or
24 significant bits, corresponding to 224, 216, or 28 possible hosts. As a result, an
entire /16 subnet had to be allocated for a network that required only 400 addresses,
wasting 65,136 (216 – 400 = 65,136) addresses.

To help allocate address spaces more efficiently, variable-length subnet masks (VLSMs)
were introduced. Using VLSM, network architects can allocate more precisely the
number of addresses required for a particular subnet.

For example, suppose a network with the prefix 192.14.17/24 is divided into two
smaller subnets, one consisting of 18 devices and the other of 46 devices.
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To accommodate 18 devices, the first subnet must have 25 (32) host numbers. Having
5 bits assigned to the host number leaves 27 bits of the 32-bit address for the subnet.
The IP address of the first subnet is therefore 192.14.17.128/27, or the following
in binary notation:

 11000000 . 00001110 . 00010001 . 100xxxxx

The subnet mask includes 27 significant digits.

To create the second subnet of 46 devices, the network must accommodate 26 (64)
host numbers. The IP address of the second subnet is 192.14.17.64/26, or

 11000000 . 00001110 . 00010001 . 01xxxxxx

By assigning address bits within the larger /24 subnet mask, you create two smaller
subnets that use the allocated address space more efficiently.

IPv6 Addressing

To create a much larger address space and relieve a projected future shortage of IP
addresses, IPv6 was created. IPv6 addresses consist of 128 bits, instead of 32 bits,
and include a scope field that identifies the type of application suitable for the address.
IPv6 does not support broadcast addresses, but instead uses multicast addresses for
broadcast. In addition, IPv6 defines a new type of address called anycast.

■ IPv6 Address Representation on page 68

■ IPv6 Address Types on page 69

■ IPv6 Address Scope on page 69

■ IPv6 Address Structure on page 69

■ IPv6 Protocol Family: inet6 on page 70

■ Enabling Flow-Based Processing for IPv6 Traffic on page 71

IPv6 Address Representation

IPv6 addresses consist of 8 groups of 16-bit hexadecimal values separated by colons
(:). IPv6 addresses have the following format:

 aaaa:aaaa:aaaa:aaaa:aaaa:aaaa:aaaa:aaaa

Each aaaa is a 16-bit hexadecimal value, and each a is a 4-bit hexadecimal value.
Following is a sample IPv6 address:

 3FFE:0000:0000:0001:0200:F8FF:FE75:50DF

You can omit the leading zeros of each 16-bit group, as follows:

 3FFE:0:0:1:200:F8FF:FE75:50DF

You can compress 16-bit groups of zeros to double colons (::) as shown in the
following example, but only once per address:

3FFE::1:200:F8FF:FE75:50DF
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An IPv6 address prefix is a combination of an IPv6 prefix (address) and a prefix
length. The prefix takes the form ipv6-prefix/prefix-length and represents a block of
address space (or a network). The ipv6-prefix variable follows general IPv6 addressing
rules. The /prefix-length variable is a decimal value that indicates the number of
contiguous, higher-order bits of the address that make up the network portion of the
address. For example, 10FA:6604:8136:6502::/64 is a possible IPv6 prefix.

For more information on the text representation of IPv6 addresses and address
prefixes, see RFC 4291, IP Version 6 Addressing Architecture.

IPv6 Address Types

IPv6 has three types of addresses:

■ Unicast—For a single interface.

■ Multicast—For a set of interfaces on the same physical medium. A packet is sent
to all interfaces associated with the address.

■ Anycast—For a set of interfaces on different physical media. A packet is sent to
only one of the interfaces associated with this address, not to all the interfaces.

IPv6 Address Scope

Unicast and multicast IPv6 addresses support address scoping, which identifies the
application suitable for the address.

Unicast addresses support global address scope and two types of local address scope:

■ Link-local unicast addresses—Used only on a single network link. The first 10 bits
of the prefix identify the address as a link-local address. Link-local addresses
cannot be used outside the link.

■ Site-local unicast addresses—Used only within a site or intranet. A site consists
of multiple network links. Site-local addresses identify nodes inside the intranet
and cannot be used outside the site.

Multicast addresses support 16 different types of address scope, including node, link,
site, organization, and global scope. A 4-bit field in the prefix identifies the address
scope.

IPv6 Address Structure

Unicast addresses identify a single interface. Each unicast address consists of n bits
for the prefix, and 128 – n bits for the interface ID.

Multicast addresses identify a set of interfaces. Each multicast address consists of
the first 8 bits of all 1s, a 4-bit flags field, a 4-bit scope field, and a 112-bit group ID:

11111111 | flgs | scop | group ID

The first octet of 1s identifies the address as a multicast address. The flags field
identifies whether the multicast address is a well-known address or a transient
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multicast address. The scope field identifies the scope of the multicast address. The
112-bit group ID identifies the multicast group.

Similar to multicast addresses, anycast addresses identify a set of interfaces. However,
packets are sent to only one of the interfaces, not to all interfaces. Anycast addresses
are allocated from the normal unicast address space and cannot be distinguished
from a unicast address in format. Therefore, each member of an anycast group must
be configured to recognize certain addresses as anycast addresses.

IPv6 Protocol Family: inet6

A logical interface can be configured with an IPv6 address, IPv4 address, or both.

In configuration commands, the protocol family for IPv6 is named inet6. In the
configuration hierarchy, instances of inet6 are parallel to instances of inet, the protocol
family for IPv4. In general, you configure inet6 settings and specify IPv6 addresses
in parallel to inet settings and IPv4 addresses.

The following example shows the CLI commands you use to configure an IPv6 address
for an interface:

[edit]
user@host# show interfaces
ge-0/0/0 {
    unit 0 {
        family inet {
            address 10.100.37.178/24;
        }
    }
}
[edit]
user@host# set interfaces ge-0/0/0 unit 0 family ?
Possible completions:
+ apply-groups         Groups from which to inherit configuration data
+ apply-groups-except  Don't inherit configuration data from these groups
> ccc                  Circuit cross-connect parameters
> ethernet-switching   Ethernet switching parameters
> inet                 IPv4 parameters
> inet6                IPv6 protocol parameters
> iso                  OSI ISO protocol parameters
> mpls                 MPLS protocol parameters
> tcc                  Translational cross-connect parameters
> vpls                 Virtual private LAN service parameters
[edit]
user@host# set interfaces ge-0/0/0 unit 0 family inet6 address 8d8d:8d01::1/64
user@host# show interfaces
ge-0/0/0 {
    unit 0 {
        family inet {
            address 10.100.37.178/24;
        }
        family inet6 {
            address 8d8d:8d01::1/64;
        }
    }
}
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For complete information about configuring interfaces, see the Junos Network Interfaces
Configuration Guide.

Enabling Flow-Based Processing for IPv6 Traffic

You have the following options for handling IPv6 traffic:

■ Drop—Do not forward IPv6 packets. This is the default behavior.

■ Packet-based forwarding—Do not create a session and process according to
packet-based features only (includes firewall filters and class of service).

■ Flow-based forwarding—Create a session and process according to packet-based
features (including firewall filters and class of service) but also flow-based security
features, such as screens and firewall security policy.

NOTE: Packet-based forwarding is not supported for SRX3400, SRX3600, SRX5600,
or SRX5800 devices; and the option is unavailable in the CLI.

To enable flow-based processing for IPv6 traffic, modify the mode statement at the
[edit security forwarding-options family inet6] hierarchy level:

security {
forwarding-options {

family {
inet6 {

mode flow-based;
}

}
}

}

The following example shows the CLI commands you use to configure forwarding
for IPv6 traffic:

[edit]
user@host# set security forwarding-options family inet6 mode ?
Possible completions:
  drop                 Disable forwarding
  flow-based           Enable flow-based forwarding
  packet-based         Enable packet-based forwarding
[edit]
user@host# set security forwarding-options family inet6 mode flow-based
user@host# show security forwarding-options
family {
    inet6 {
        mode flow-based;
    }
}

If you change the forwarding option mode for IPv6, you might need to perform a
reboot to initialize the configuration change. Table 18 on page 72 summarizes device
status upon configuration change.
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Table 18: Device Status Upon Configuration Change

Impact on New Traffic
Before Reboot

Impact on Existing Traffic
Before Reboot

Reboot
Required

Commit
WarningConfiguration Change

DroppedDroppedYesYesDrop to flow-based

Packet-basedPacket-basedNoNoDrop to packet-based

Flow sessions createdNoneYesYesFlow-based to packet-based

Flow sessions createdNoneYesYesFlow-based to drop

Packet-basedPacket-basedYesYesPacket-based to flow-based

DroppedDroppedNoNoPacket-based to drop

For details on packet-based and flow-based processing, see the Junos OS Security
Configuration Guide.

Virtual LANs

A local area network (LAN) is a single broadcast domain. When traffic is broadcast,
all hosts within the LAN receive the broadcast traffic. A LAN is determined by the
physical connectivity of devices within the domain.

Within a traditional LAN, hosts are connected by a hub or repeater that propagates
any incoming traffic throughout the network. Each host and its connecting hubs or
repeaters make up a LAN segment. LAN segments are connected through switches
and bridges to form the broadcast domain of the LAN. Figure 14 on page 73 shows
a typical LAN topology.
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Figure 14: Typical LAN

Virtual LANs (VLANs) allow network architects to segment LANs into different
broadcast domains based on logical groupings. Because the groupings are logical,
the broadcast domains are not determined by the physical connectivity of the devices
in the network. Hosts can be grouped according to a logical function, to limit the
traffic broadcast within the VLAN to only the devices for which the traffic is intended.

Suppose a corporate network has three major organizations: engineering, sales, and
support. Using VLAN tagging, hosts within each organization can be tagged with a
different VLAN identifier. Traffic sent to the broadcast domain is then checked against
the VLAN identifier and broadcast to only the devices in the appropriate VLAN. Figure
15 on page 73 shows a typical VLAN topology.

Figure 15: Typical VLAN
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Special Interfaces

In addition to the configured network interfaces associated with the physical ports
and wires that make up much of the network, devices have special interfaces. Table
19 on page 74 lists each special interface and briefly describes its use.

For information about interface names, See “Network Interface Naming” on page 9.

Table 19: Special Interfaces

DescriptionInterface Name

Discard interface. See “Discard Interface” on page 76.dsc

In a J Series chassis cluster configuration, configurable management interfaces are created from
built-in interfaces on the connected J Series chassis. The fxp0 interface is the management port,
and fxp1 is used as the control link interface in a chassis cluster.

In an SRX Series device, the fxp0 management interface is a dedicated port located on the Routing
Engine. In an SRX Series chassis cluster configuration, the control link interface must be port 0 on
an SPC. For each node in the chassis cluster, you must configure the SPC that is used for the control
link interface.

For more information about chassis clusters, see the Junos OS Security Configuration Guide.

For more information about the device management port interfaces, see “Management Interface”
on page 77.

fxp0

Configurable generic routing encapsulation (GRE) interface. GRE allows the encapsulation of one
routing protocol over another routing protocol.

Within a J Series device, packets are routed to this internal interface, where they are first
encapsulated with a GRE packet and then re-encapsulated with another protocol packet to complete
the GRE. The GRE interface is an internal interface only and is not associated with a physical
medium or PIM. You must configure the interface for it to perform GRE.

gr-0/0/0

Internally generated GRE interface. This interface is generated by JUNOS Software to handle GRE.
It is not a configurable interface.

gre

Configurable IP-over-IP encapsulation (also called IP tunneling) interface. IP tunneling allows the
encapsulation of one IP packet over another IP packet.

Generally, IP routing allows packets to be routed directly to a particular address. However, in some
instances you might need to route an IP packet to one address and then encapsulate it for forwarding
to a different address. In a mobile environment in which the location of the end device changes,
a different IP address might be used as the end device migrates between networks.

Within a J Series device, packets are routed to this internal interface where they are encapsulated
with an IP packet and then forwarded to the encapsulating packet's destination address. The IP-IP
interface is an internal interface only and is not associated with a physical medium or PIM. You
must configure the interface for it to perform IP tunneling.

ip-0/0/0

Internally generated IP-over-IP interface. This interface is generated by JUNOS Software to handle
IP-over-IP encapsulation. It is not a configurable interface.

ipip
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Table 19: Special Interfaces (continued)

DescriptionInterface Name

Loopback address. The loopback address has several uses, depending on the particular JUNOS
feature being configured. See “Loopback Interface” on page 76.

lo0

Internal loopback address. The internal loopback address is a particular instance of the loopback
address with the logical unit number 16384. It is created by JUNOS Software as the loopback
interface for the internal routing instance. This interface prevents any filter on lo0.0 from disrupting
internal traffic.

lo0.16384

Configurable link services queuing interface. Link services include the multilink services MLPPP,
MLFR, and Compressed Real-Time Transport Protocol (CRTP).

Within a J Series device, packets are routed to this internal interface for link bundling or
compression. The link services interface is an internal interface only and is not associated with a
physical medium or PIM. You must configure the interface for it to perform multilink services.

NOTE: The ls-0/0/0 interface has been deprecated. All multiclass multilink features supported by
ls-0/0/0 are now supported by lsq-0/0/0.

For more information about multilink services, see “Services Interfaces” on page 78.

lsq-0/0/0

Internally generated link services interface. This interface is generated by JUNOS Software to handle
multilink services like MLPPP, MLFR, and CRTP. It is not a configurable interface.

lsi

Interface used to provide class-of-service (CoS) support for real-time performance monitoring (RPM)
probe packets.

Within a J Series device, packets are routed to this internal interface for services. The lt interface
is an internal interface only and is not associated with a physical medium or PIM. You must configure
the interface for it to perform CoS for RPM services.

NOTE: The lt interface on the M Series and T Series routing platforms supports configuration of
logical devices—the capability to partition a single physical device into multiple logical devices that
perform independent routing tasks. However, the lt interface on the J Series device does not support
logical devices.

lt-0/0/0

Internally configured interface used by the system as a control path between the WXC Integrated
Services Module and the Routing Engine.

pc-pim/0/0

Protocol Independent Multicast (PIM) de-encapsulation interface. In PIM sparse mode, the first-hop
routing platform encapsulates packets destined for the rendezvous point device. The packets are
encapsulated with a unicast header and are forwarded through a unicast tunnel to the rendezvous
point. The rendezvous point then de-encapsulates the packets and transmits them through its
multicast tree.

Within a device, packets are routed to this internal interface for de-encapsulation. The PIM
de-encapsulation interface is an internal interface only and is not associated with a physical interface.
You must configure PIM with the [edit protocol pim] hierarchy to perform PIM de-encapsulation.

pd-0/0/0
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Table 19: Special Interfaces (continued)

DescriptionInterface Name

Protocol Independent Multicast (PIM) encapsulation interface. In PIM sparse mode, the first-hop
routing platform encapsulates packets destined for the rendezvous point device. The packets are
encapsulated with a unicast header and are forwarded through a unicast tunnel to the rendezvous
point. The rendezvous point then de-encapsulates the packets and transmits them through its
multicast tree.

Within a device, packets are routed to this internal interface for encapsulation. The PIM
encapsulation interface is an internal interface only and is not associated with a physical interface.
You must configure PIM with the [edit protocol pim] hierarchy to perform PIM encapsulation.

pe-0/0/0

Internally generated Protocol Independent Multicast (PIM) de-encapsulation interface. This interface
is generated by JUNOS Software to handle PIM de-encapsulation. It is not a configurable interface.

pimd

Internally generated Protocol Independent Multicast (PIM) encapsulation interface. This interface
is generated by JUNOS Software to handle PIM encapsulation. It is not a configurable interface.

pime

Configurable PPPoE encapsulation interface. PPP packets being routed in an Ethernet network use
PPPoE encapsulation.

Within a J Series device, packets are routed to this internal interface for PPPoE encapsulation. The
PPPoE encapsulation interface is an internal interface only and is not associated with a physical
medium or PIM. You must configure the interface for it to forward PPPoE traffic. For more
information about PPPoE interfaces, see “Configuring Point-to-Point Protocol over Ethernet” on
page 289.

pp0

Secure tunnel interface used for IPSec VPNs.st0

Internally generated interface. This interface is generated by JUNOS Software to monitor and record
traffic during passive monitoring. When packets are discarded by the Packet Forwarding Engine,
they are placed on this interface. It is not a configurable interface.

tap

Configurable USB modem physical interface. This interface is detected when an USB modem is
connected to the USB port on the device.

NOTE: The J4350 and J6350 devices have two USB ports. However, you can connect only one USB
modem to the USB ports on these devices. If you connect USB modems to both the USB ports,
only the first USB modem connected to the device is recognized.

umd0

Discard Interface

The discard (dsc) interface is not a physical interface, but a virtual interface that
discards packets. You can configure one discard interface. This interface allows you
to identify the ingress (inbound) point of a denial-of-service (DoS) attack. When your
network is under attack, the target host IP address is identified, and the local policy
forwards attacking packets to the discard interface. Traffic routed out the discard
interface is silently discarded.

Loopback Interface

The Internet Protocol (IP) specifies a loopback network with the (IPv4) address
127.0.0.0/8. Most IP implementations support a loopback interface (lo0) to represent
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the loopback facility. Any traffic that a computer program sends on the loopback
network is addressed to the same computer. The most commonly used IP address
on the loopback network is 127.0.0.1 for IPv4 and ::1 for IPv6. The standard domain
name for the address is localhost.

The loopback interface can perform the following functions:

■ Device identification—The loopback interface is used to identify the device.
While any interface address can be used to determine if the device is online, the
loopback address is the preferred method. Whereas interfaces might be removed
or addresses changed based on network topology changes, the loopback address
never changes.

When you ping an individual interface address, the results do not always indicate
the health of the device. For example, a subnet mismatch in the configuration
of two endpoints on a point-to-point link makes the link appear to be inoperable.
Pinging the interface to determine whether the devicer is online provides a
misleading result. An interface might be unavailable because of a problem
unrelated to the device's configuration or operation.

■ Routing information—The loopback address is used by protocols such as OSPF
to determine protocol-specific properties for the device or network. Further,
some commands such as ping mpls require a loopback address to function
correctly.

■ Packet filtering—Stateless firewall filters can be applied to the loopback address
to filter packets originating from, or destined for, the Routing Engine.

Management Interface

Management interfaces are the primary interfaces for accessing the device remotely.
Typically, a management interface is not connected to the in-band network, but is
connected instead to the device's internal network. Through a management interface
you can access the device over the network using utilities such as ssh and telnet and
configure it from anywhere, regardless of its physical location. Simple Network
Management Protocol (SNMP) can use the management interface to gather statistics
from the device.

Management interfaces vary based on device type:

■ The J Series devices include four built-in Gigabit Ethernet interfaces located on
the front panel of the router chassis named ge-0/0/0, ge-0/0/1, ge-0/0/2, and
ge-0/0/3 from left to right. These are not physically dedicated management
interfaces, although the factory configuration for these routers automatically
enables the J-Web user interface on these interfaces. You can use them to pass
traffic or you can segregate one off and place it in the management zone to be
used as a management interface. To use a built-in interface as a management
Ethernet interface, configure it with a valid IP address.

■ The SRX5600 and SRX5800 devices include a 10/100-Mbps Ethernet port on the
Routing Engine (RE). This port, which is labeled ETHERNET, is a dedicated
out-of-band management interface for the device. JUNOS Software automatically
creates the device’s management interface fxp0. To use fxp0 as a management
port, you must configure its logical port fxp0.0 with a valid IP address. While you
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can use fxp0 to connect to a management network, you cannot place it into the
management zone.

NOTE: On the SRX5600 and SRX5800 devices, you must first connect to the device
through the serial console port before assigning a unique IP address to the
management interface.

As a security feature, users cannot log in as root through a management interface.
To access the device as root, you must use the console port.

Services Interfaces

On Juniper Networks M Series and T Series routing platforms, individual services
such as IP-over-IP encapsulation, link services such as multilink protocols, adaptive
services such as stateful firewall filters and NAT, and sampling and logging capabilities
are implemented by services Physical Interface Cards (PICs). On a J Series device,
these same features are implemented by the general-purpose CPU on the main circuit
board.

Although the same JUNOS Software image supports the services features across all
routing platforms, on a J Series device no Physical Interface Module (PIM) is associated
with services features.

To configure services on a J Series device, you must configure one or more internal
interfaces by specifying PIM slot 0 and port 0—for example, gr-0/0/0 for GRE.

J Series devices support multilink protocol services on the lsq-0/0/0 interface. At the
logical level, the lsq-0/0/0 interface supports the Multilink Point-to-Point Protocol
(MLPPP) and Multilink Frame Relay (MLFR) FRF.15 encapsulation types, and at the
physical level, the interface supports the MLRF FRF.16 encapsulation type and
Compressed Real-Time Transport Protocol (CRTP). lsq-0/0/0 supports multilink
classes similar to the link services intelligent queuing interface (LSQ) PIC on M Series
routing platforms. Configuring multilink classes is same as that off LSQ PIC.

MLPPP and MLFR

Multilink Point-to-Point Protocol (MLPPP) is a protocol for aggregating multiple
constituent links into one larger PPP bundle. Multilink Frame Relay (MLFR) allows
you to aggregate multiple Frame Relay links by inverse multiplexing. MLPPP and
MLFR provide service options between low-speed T1 and E1 services. In addition to
providing additional bandwidth, bundling multiple links can add a level of fault
tolerance to your dedicated access service. Because you can implement bundling
across multiple interfaces, you can protect users against loss of access when a single
interface fails.

MLFR Frame Relay Forum

JUNOS supports FRF.12 fragmentation header formats for both FRF.15 (MLFR) and
FRF.16 (MFR).
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MLFR Frame Relay Forum 15 (FRF.15) combines multiple permanent virtual circuits
(PVCs) into one aggregated virtual circuit (AVC). This process provides fragmentation
over multiple PVCs on one end and reassembly of the AVC on the other end. MLFR
FRF.15 is supported on the lsq-0/0/0 interface.

MLFR FRF.16 is supported on the lsq-0/0/0:channel, which carries a single MLFR
FRF.16 bundle. MLFR FRF.16 combines multiple links to form one logical link. Packet
fragmentation and reassembly occur on each virtual circuit. Each bundle can support
multiple virtual circuits.

NOTE: If you configure a permanent virtual circuit (PVC) between T1, E1, T3, or E3
interfaces in J Series device and another vendor, and the other vendor does not have
the same FRF.12 support or supports FRF.12 in a different way, the devices interface
might discard a fragmented packet containing FRF.12 headers and count it as a
"Policed Discard." Therefore, when you configure a PVC between T1, E1, T3, or E3
interfaces in the devices and another vendor, you should configure multilink bundles
on both peers and configure fragmentation thresholds on the multilink bundle.

CRTP

Real-Time Transport Protocol (RTP) can help achieve interoperability among different
implementations of network audio and video applications. However, the header can
be too large a payload for networks using low-speed lines such as dial-up modems.
Compressed Real-Time Transport Protocol (CRTP) can reduce network overhead on
a low-speed link. On a J Series device, CRTP can operate on a T1 or E1 interface with
PPP encapsulation.
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Chapter 2

Configuring Ethernet, DS1, DS3, and
Serial Interfaces

Juniper Networks devices can use network interfaces such as DS1, DS3, Fast Ethernet,
Gigabit Ethernet, and serial interfaces to transmit and receive network traffic. For
network interfaces to operate, you must configure properties such as logical interfaces,
the encapsulation type, and certain settings specific to the interface type.

In most cases, you can use either J-Web Quick Configuration or a configuration editor
to configure network interfaces.

NOTE: You cannot configure channelized T1 or E1 interfaces through a J-Web Quick
Configuration page. You must use the J-Web or CLI configuration editor. Even after
configuration, channelized interfaces do not appear on the Quick Configuration
Interfaces page.

For more information about interfaces, see “Interfaces Overview” on page 3 and
the Junos Network Interfaces Configuration Guide. To configure channelized interfaces,
see “Configuring Channelized T1/E1/ISDN PRI Interfaces” on page 117. To configure
DSL interfaces, see “Configuring Digital Subscriber Line Interfaces” on page 133. To
configure PPPoE interfaces, see “Configuring Point-to-Point Protocol over Ethernet”
on page 289. To configure ISDN interfaces, see “Configuring ISDN” on page 309.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Before You Begin on page 81

■ Configuring Interfaces—Quick Configuration on page 82

■ Enabling and Disabling Promiscuous Mode on Ethernet Interfaces on page 108

■ Configuring Network Interfaces with a Configuration Editor on page 109

■ Verifying Interface Configuration on page 113

Before You Begin

Before you configure network interfaces, you need to perform the following tasks:
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■ Install your Juniper Networks device. For more information, see the Hardware
Guide for your device.

■ Establish basic connectivity. For more information, see the Getting Started Guide
for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

Although it is not a requirement, you might also want to plan how you are going to
use the various network interfaces before you start configuring them. You can see a
list of the physical interfaces installed on the device by displaying the Quick
Configuration page, as shown in Figure 16 on page 82.

Configuring Interfaces—Quick Configuration

You can use J-Web Quick Configuration to quickly configure most network interfaces,
as shown in Figure 16 on page 82.

Figure 16: Quick Configuration Interfaces Page

To configure a network interface with Quick Configuration:

1. Select Configure>Interfaces. For information about interface names, see
“Network Interface Naming” on page 9.

A list of the network interfaces available on the routing platform appears, as
shown in Figure 16 on page 82. The third column indicates whether the interface
has been configured.
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NOTE: Channelized T1 and E1 interfaces are not displayed in the list of interfaces
on the J-Web Quick Configuration Interfaces page. However, you can configure and
view channelized T1/E1/ISDN PRI interfaces with the J-Web configuration editor. For
details, see “Configuring Channelized T1/E1/ISDN PRI Interfaces” on page 117.

2. Configure properties for a network interface by selecting the interface name and
following the instructions in one of the following topics.

■ Configuring an E1 Interface with Quick Configuration on page 84

■ Configuring an E3 Interface with Quick Configuration on page 87

■ Configuring a Fast Ethernet Interface with Quick Configuration on page 90

■ Configuring Gigabit Ethernet Interfaces—Quick Configuration on page 94

■ Configuring T1 Interfaces with Quick Configuration on page 97

■ Configuring T3 Interfaces with Quick Configuration on page 101

■ Configuring Serial Interfaces with Quick Configuration on page 104
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Configuring an E1 Interface with Quick Configuration

To configure properties on an E1 interface:

1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the E1 interface you want to configure.

The properties you can configure on an E1 interface are displayed, as shown in
Figure 17 on page 84. (See “Network Interface Naming” on page 9.)

Figure 17: E1 Interfaces Quick Configuration Page

2. Enter information into the Quick Configuration page, as described in Table 20
on page 85.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.
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■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the E1 interface is configured correctly, see “Verifying Interface
Configuration” on page 113.

Table 20: E1 Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that
you connect to this physical E1 interface.
You must define at least one logical unit
for an E1 interface. You can define
multiple units if the encapsulation type
is Frame Relay.

Add logical interfaces

Type a text description of the logical
interface to more clearly identify it in
monitoring displays.

(Optional) Describes the logical interface.Logical Interface Description

1. Type one or more IPv4 addresses
and prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses for
the interface.

IPv4 Addresses and Prefixes

Type a text description of the E1
interface to more clearly identify it in
monitoring displays.

(Optional) Adds supplementary
information about the physical E1
interface.

Physical Interface Description

Type a value between 256 and 9192
bytes. The default MTU for E1 interfaces
is 1504.

Specifies the maximum transmission unit
size for the E1 interface.

MTU (bytes)

From the list, select one of the following:

■ internal—device's own system
clock (the default)

■ external—Clock received from the
E1 interface

Specifies the transmit clock source for
the E1 line.

Clocking

■ To enable scheduling, select the
check box.

■ To disable scheduling, clear the
check box.

Enables scheduling on logical interfaces.

Allows you to configure multiple output
queues on a logical interface and
associate an output scheduler and
shaping rate with the queues.

Per unit scheduler

Encapsulation
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Table 20: E1 Quick Configuration Summary (continued)

Your ActionFunctionField

From the list, select the encapsulation
for this E1 interface:

■ PPP

■ Frame Relay

■ Cisco HDLC

Specifies the encapsulation type for
traffic on the interface.

Encapsulation

■ To enable CHAP, select the check
box.

■ To disable CHAP, clear the check
box.

Enables or disables CHAP authentication
on an E1 interface with PPP
encapsulation only.

Enable CHAP

CHAP Local Identity (available if CHAP is enabled)

■ To enable, select the check box (the
default).

■ To disable, clear the check box.

Specifies that the E1 interface uses the
device's system hostname in CHAP
challenge and response packets.

Use System Host Name

Type a local name for this E1 interface.If Use System Host Name is disabled,
specifies the local name for CHAP to use.

Local Name

Type the CHAP client name.Identifies the client or peer with which
the device communicates on this E1
interface.

CHAP Peer Identity

Type a password that is known to the
other side of the connection. Use a
combination of letters and numbers that
is difficult for others to guess.

Specifies the secret password for CHAP
authentication, known to both sides of
the connection.

CHAP Secret

E1 Options

From the list, select one of the following:

■ g704—The default

■ g704–no-crc4—G704 without cyclic
redundancy check 4 (CRC4)

■ unframed—Unframed transmission
format

Specifies the framing mode for the E1
line.

Framing Mode

■ To enable, select the check box.

■ To disable, clear the check box.

Enables or disables data inversion. Data
inversion is normally used only in
alternate mark inversion (AMI) mode.

Invert Data

Type numeric values from 2 through 32.
Separate discontinuous entries with
commas, and use hyphens to indicate
ranges. For example:

2,4,7–9

Specifies the number of time slots
allocated to a fractional E1 interface. By
default, an E1 interface uses all the time
slots.

Timeslots

Select 16 or 32. The default checksum
is 16.

Specifies the number of bits in the frame
checksum. A 32–bit checksum provides
more reliable packet verification, but is
not supported by some older equipment.

Frame Checksum
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Configuring an E3 Interface with Quick Configuration

To configure properties on an E3 interface:

1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the E3 interface you want to configure.

The properties you can configure on an E3 interface are displayed, as shown in
Figure 18 on page 87. (See “Network Interface Naming” on page 9.)

Figure 18: E3 Interfaces Quick Configuration Page

2. Enter information into the Quick Configuration page, as described in Table 21
on page 88.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the E3 interface is configured correctly, see “Verifying Interface
Configuration” on page 113.
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Table 21: E3 Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that you connect
to this physical E3 interface. You must define at
least one logical unit for an E3 interface. You can
define multiple units if the encapsulation type is
Frame Relay.

Add logical
interfaces

Type a text description of the logical interface to
more clearly identify it in monitoring displays.

(Optional) Describes the logical interface.Logical Interface
Description

1. Type one or more IPv4 addresses and prefixes.
For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses for the
interface.

IPv4 Addresses
and Prefixes

Type a text description of the E3 interface to more
clearly identify it in monitoring displays.

(Optional) Adds supplementary information about
the physical E3 interface.

Physical Interface
Description

Type a value between 256 and 9192 bytes. The
default MTU for E3 interfaces is 4474.

Specifies the maximum transmission unit size for
the E3 interface.

MTU (bytes)

From the list, select one of the following:

■ internal—device's own system clock (the
default)

■ external—Clock received from the E3 interface

Specifies the transmit clock source for the E3 line.Clocking

Encapsulation

From the list, select the encapsulation for this E3
interface:

■ PPP

■ Frame Relay

■ Cisco HDLC

Specifies the encapsulation type for traffic on the
interface.

Encapsulation

■ To enable CHAP, select the check box.

■ To disable CHAP, clear the check box.

Enables or disables CHAP authentication on an E3
interface with PPP encapsulation only.

Enable CHAP

CHAP Local Identity (available if CHAP is enabled)

■ To enable, select the check box (the default).

■ To disable, clear the check box.

Specifies that the E3 interface uses the device's
system hostname in CHAP challenge and response
packets.

Use System Host
Name

Type a local name for this E3 interface.If Use System Host Name is disabled, specifies the
local name for CHAP to use.

Local Name

Type the CHAP client name.Identifies the client or peer with which the device
communicates on this E3 interface.

CHAP Peer
Identity
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Table 21: E3 Quick Configuration Summary (continued)

Your ActionFunctionField

Type a password that is known to the other side of
the connection. Use a combination of letters and
numbers that is difficult for others to guess.

Specifies the secret password for CHAP
authentication, known to both sides of the
connection.

CHAP Secret

E3 Options

From the Bert Algorithm list, select the algorithm
to use:

■ all-ones-repeating

■ alternating-ones-zeros

■ all-zeros-repeating

■ pseudo-2e11–o152

■ pseudo-2e15–o151

■ pseudo-2e20–o151

■ pseudo-2e20–o153

■ pseudo-2e23–o151

■ pseudo-2e29

■ pseudo-2e31

■ pseudo-2e9–o153

The default is pseudo-2e15-o151.

Specifies the bit error rate test (BERT) algorithm to
use during a BERT.

BERT is supported only when transmission is
unframed. (See the Unframed option.)

Bert Algorithm

Type a value between 3 and 7, or 0. For example,
a value of 6 specifies that 1 bit out of 1,000,000 is
transmitted in error. The default is 0 (no bits are
transmitted in error).

Specifies the exponent n in the bit error rate 10–n.Bert Error Rate

Type a value between 1 and 240. The default is 10.Specifies the length of time—in seconds—of the
BERT.

Bert Period

Select one of the following check boxes:

■ Off—CSU compatibility is disabled.

■ Digital-Link—Compatible with a Digital Link
CSU.

■ Kentrox—Compatible with a Kentrox CSU.

If you select Digital-Link, you can optionally specify
a subrate by selecting a value from the Subrate list.

If you select Kentrox, you can optionally specify a
subrate by typing a value from 1 through 48 in the
Subrate box.

If you do not specify a subrate, the full E3 rate is
used.

Defines the transmission mode and subrating to
use on the E3 interface. The mode must be set to
the type of channel service unit (CSU) connected to
the interface. The subrating specified must be the
same subrating configured on the CSU.

CSU compatibility mode and subrating are
supported only when transmission is unframed.
(See the Unframed option.)

Compatibility
Mode

From the Frame Checksum list, select 16 or 32. The
default value is 16.

Specifies the number of bits in the frame checksum.
A 32-bit checksum provides more reliable packet
verification, but is not supported by some older
equipment.

Frame Checksum
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Table 21: E3 Quick Configuration Summary (continued)

Your ActionFunctionField

From the Idle Cycle Flag list, select one of the
following:

■ flags—Transmits the value 0x7E during idle
cycles. This is the default.

■ ones—Transmits the value 0xFF during idle
cycles.

Specifies the value to transmit during idle cycles.Idle Cycle Flag

From the Loopback list, select one of the following:

■ local—Traffic loops from the transmitter to the
receiver at the E3 interface during tests.

■ remote—Traffic loops from the receiver to the
transmitter at the E3 interface during tests.

Configures the E3 interface as a loopback interface
for testing purposes.

When E3 is configured as a local loopback interface,
the device transmits test traffic simultaneously to
the CSU and to the receiver at the E3 interface.

When E3 is configured as a remote loopback
interface, test traffic transmitted by the CSU is
simultaneously received at the E3 interface and
transmitted back to the CSU.

Loopback

Select one of the following check boxes:

■ Yes—Transmission is scrambled.

■ No—Transmission is not scrambled.

Specifies whether the payload of the packet is to
be scrambled, or randomized, when transmitted.
Scrambling eliminates nonvariable bit patterns in
the transmission, which can generate link-layer
errors across an E3 link.

The payload scrambler is supported only when CSU
compatibility is enabled and transmission is framed.
(See the Compatibility Mode and Unframed options).

Payload
Scrambler

From the Start End Flag list, select one of the
following:

■ filler—Flags are separated by idle cycles.

■ shared—Flags overlap (no separation).

Specifies whether the end and start flags are
separated.

Start End Flag

Select one of the following check boxes:

■ Yes—Unframed transmission.

■ No—Framed transmission.

Specifies whether the transmission is framed (G.751
framing) or unframed.

Unframed

Configuring a Fast Ethernet Interface with Quick Configuration

To configure properties on a Fast Ethernet interface:
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1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the Fast Ethernet interface you want to configure.

The properties you can configure on a Fast Ethernet interface are displayed, as
shown in Figure 19 on page 91. (See “Network Interface Naming” on page 9.)

Figure 19: Fast Ethernet Interfaces Quick Configuration Page

2. Enter information into the Quick Configuration page, as described in Table 22
on page 91.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the Fast Ethernet interface is configured correctly, see “Verifying
Interface Configuration” on page 113.

Table 22: Fast Ethernet Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that
you connect to this physical Fast
Ethernet interface. You must define at
least one logical unit for a Fast Ethernet
interface. You can define multiple units
if the encapsulation type is Frame Relay.

Add logical interfaces

Type a text description of the logical
interface to more clearly identify it in
monitoring displays.

(Optional) Describes the logical interface.Logical Interface Description
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Table 22: Fast Ethernet Quick Configuration Summary (continued)

Your ActionFunctionField

1. Type one or more IPv4 addresses
and prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses
for the interface.

IPv4 Addresses and Prefixes

Type an IPv4 address that you want to
associate with the MAC address—for
example, 10.10.10.1.

Enables the device to create a static
Address Resolution Protocol (ARP) entry
for this interface by specifying the IP
address of a node to associate with its
media access control (MAC) address. The
IP address must be in the same subnet
as the IPv4 address or prefix of the
interface you are configuring.

Static ARP entries associate the IP
addresses and MAC addresses of nodes
on the same subnet, enabling a device
to respond to ARP requests having
destination addresses that are not local
to the incoming interface.

ARP Address

Type the MAC address to be mapped to
the ARP entry—for example,
00:12:1E:A9:8A:80.

Specifies the hardware media access
control (MAC) address associated with
the ARP address.

The MAC address uniquely identifies the
system and is expressed in the following
format: mm:mm:mm:ss:ss:ss. The first
three octets denote the hardware
manufacturer ID, and the last three are
serial numbers identifying the device.

MAC Address

■ To enable publishing, select the
check box.

■ To disable publishing, clear the
check box.

Enables the device to reply to ARP
requests for the specified address.

For more information, see “Configuring
Static ARP Entries on Ethernet
Interfaces” on page 111.

Publish

Type a text description of the Fast
Ethernet interface to more clearly
identify it in monitoring displays.

(Optional) Adds supplementary
information about the physical Fast
Ethernet interface.

Physical Interface Description
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Table 22: Fast Ethernet Quick Configuration Summary (continued)

Your ActionFunctionField

Type a value between 256 bytes and one
of the following values:

■ For built-in Fast Ethernet interfaces
and Dual-Port Fast Ethernet PIM
interfaces, 9192 bytes

■ For 4-Port Fast Ethernet ePIM
interfaces, 1514 bytes

The default MTU for Fast Ethernet
interfaces is 1514.

Specifies the maximum transmission
unit size for the Fast Ethernet interface.

MTU (bytes)

■ To enable scheduling, select the
check box.

■ To disable scheduling, clear the
check box.

Enables scheduling on logical interfaces.

Allows you to configure multiple output
queues on a logical interface and
associate an output scheduler and
shaping rate with the queues.

Per unit scheduler

NOTE: You can also manually set the speed and link mode for a Fast Ethernet
interface using the CLI commands set interfaces fe-pim/0/port speed 10m | 100m
and set interfaces fe-pim/0/port link-mode half-duplex | full-duplex.
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Configuring Gigabit Ethernet Interfaces—Quick Configuration

You can use J-Web Quick Configuration to quickly configure a Gigabit Ethernet
interface.

1. Select Configure>Interfaces. The properties you can configure on a Gigabit
Ethernet interface appear as shown in Figure 20 on page 94.

Figure 20: Gigabit Ethernet Interface Quick Configuration

2. Fill in the information as described in Table 23 on page 95.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main Configuration page, click
OK.
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■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the Gigabit Ethernet interface is configured correctly, see “Verifying
Interface Configuration” on page 113.

Table 23: Gigabit Ethernet Quick Configuration Page Summary

ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that you connect to this physical
Gigabit Ethernet interface. You must define at least one logical unit for
a Gigabit Ethernet interface.

Add logical interfaces

Type a text description of the
logical interface to more
clearly identify it in
monitoring displays.

(Optional) Describes the logical interface.Logical Interface
Description

1. Type one or more IPv4
addresses and prefixes.
For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

To delete an IP address and
prefix, select them in the
Source Addresses and
Prefixes box, then click
Delete.

Specifies one or more IPv4 addresses for the interface.IPv4 Addresses and
Prefixes

Type an IPv4 address that
you want to associate with
the MAC address—for
example, 10.10.10.1.

Enables the device to create a static Address Resolution Protocol (ARP)
entry for this interface by specifying the IP address of a node to
associate with its media access control (MAC) address. The IP address
must be in the same subnet as the IPv4 address or prefix of the
interface you are configuring.

Static ARP entries associate the IP addresses and MAC addresses of
nodes on the same subnet, enabling a device to respond to ARP
requests having destination addresses that are not local to the incoming
interface.

ARP Address

Type the MAC address to be
mapped to the ARP
entry—for example,
00:12:1E:A9:8A:80.

Specifies the hardware media access control (MAC) address associated
with the ARP address.

The MAC address uniquely identifies the system and is expressed in
the following format: mm:mm:mm:ss:ss:ss. The first three octets denote
the hardware manufacturer ID, and the last three are serial numbers
identifying the device.

MAC Address

■ To enable publishing,
select the check box.

■ To disable publishing,
clear the check box.

Enables the device to reply to ARP requests for the specified address.

For more information, see “Configuring Static ARP Entries on Ethernet
Interfaces” on page 111.

Publish
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Table 23: Gigabit Ethernet Quick Configuration Page Summary (continued)

ActionFunctionField

Type a text description of the
Gigabit Ethernet interface to
more clearly identify it in
monitoring displays.

(Optional) Adds supplementary information about the physical Gigabit
Ethernet interface.

Physical Interface
Description

Type a value between 256
and 9014 bytes. The default
MTU for Gigabit Ethernet
interfaces is 1514.

The default MTU for Fast
Ethernet interfaces is 1518.

Specifies the maximum transmission unit size for the Gigabit Ethernet
interface.

MTU (bytes)

■ To enable scheduling,
select the check box.

■ To disable scheduling,
clear the check box.

Enables scheduling on logical interfaces.

Allows you to configure multiple output queues on a logical interface
and associate an output scheduler and shaping rate with the queues.

Per unit scheduler

Gigabit Ethernet Options/ Fast Ethernet Options

Select Yes to enable the
loopback diagnostic option,
or select No to disable the
loopback option. By default,
loopback is disabled.

Enables or disables the loopback option.Loopback

Select Yes to enable
autonegotiation, or select No
to disable it. By default,
autonegotiation is enabled.

Enables or disables autonegotiation.

By default, Gigabit Ethernet interfaces autonegotiate the link mode
and speed settings. If you disable autonegotiation and do not manually
configure link mode and speed, the link is negotiated at 1000 Mbps,
full duplex.

When you configure both the link mode and the speed, the link
negotiates with the manually configured settings whether
autonegotiation is enabled or disabled.

Auto Negotiation

Select the autonegotation
remote fault value from the
list of options given. This field
is enabled only if
autonegotiation is enabled.

Indicates the autonegotiation remote fault value.Auto Negotiation
Remote Fault

To add MAC addresses, type
them in the boxes above the
Add button, then click Add.

To delete a MAC address,
select it in the Source
Addresses box, then click
Delete.

Displays the list of media access control (MAC) addresses from which
you want to receive packets on this interface.

Source MAC Address
Filters
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NOTE: You can also manually set the speed and link mode for built-in and copper
PIM Gigabit Ethernet interfaces on J4350 and J6350 devices using the CLI commands
set interfaces ge-pim/0/port speed 10m | 100m | 1000m and set interfaces
ge-pim/0/port link-mode half-duplex | full-duplex. (You cannot manually configure speed
and link mode on SFP Gigabit Ethernet PIMs.) You must configure both link mode
and speed—if you configure only one or the other, the system ignores the
configuration and generates a system log message.

Configuring T1 Interfaces with Quick Configuration

To configure properties on a T1 interface:
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1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the T1 interface you want to configure.

The properties you can configure on a T1 interface are displayed, as shown in
Figure 21 on page 98. (See “Network Interface Naming” on page 9.)

Figure 21: T1 Interfaces Quick Configuration Page

2. Enter information into the Quick Configuration page, as described in Table 24
on page 99.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.
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■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the T1 interface is configured correctly, see “Verifying Interface
Configuration” on page 113.

Table 24: T1 Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that you connect
to this physical T1 interface. You must define at
least one logical unit for a T1 interface. You can
define multiple units if the encapsulation type is
Frame Relay.

Add logical
interfaces

Type a text description of the logical interface to
more clearly identify it in monitoring displays.

(Optional) Describes the logical interface.Logical Interface
Description

1. Type one or more IPv4 addresses and
prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses for the
interface.

IPv4 Addresses and
Prefixes

Type a text description of the T1 interface to more
clearly identify it in monitoring displays.

(Optional) Adds supplementary information about
the physical T1 interface.

Physical Interface
Description

Type a value between 256 and 9192 bytes. The
default MTU for T1 interfaces is 1504.

Specifies the maximum transmission unit size for
the T1 interface.

MTU (bytes)

From the list, select one of the following:

■ internal—device's own system clock (the
default)

■ external—Clock received from the T1
interface

Specifies the transmit clock source for the T1 line.Clocking

■ To enable scheduling, select the check box.

■ To disable scheduling, clear the check box.

Enables scheduling on logical interfaces.

Allows you to configure multiple output queues on
a logical interface and associate an output
scheduler and shaping rate with the queues.

Per unit scheduler

Encapsulation

From the list, select the encapsulation for this T1
interface:

■ PPP

■ Frame Relay

■ Cisco HDLC

Specifies the encapsulation type for traffic on the
interface.

Encapsulation

■ To enable CHAP, select the check box.

■ To disable CHAP, clear the check box.

Enables or disables CHAP authentication on a T1
interface with PPP encapsulation only.

Enable CHAP
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Table 24: T1 Quick Configuration Summary (continued)

Your ActionFunctionField

CHAP Local Identity (available if CHAP is enabled)

■ To enable, select the check box (the default).

■ To disable, clear the check box.

Specifies that the T1 interface uses the device's
system hostname in CHAP challenge and response
packets.

Use System Host
Name

Type a local name for this T1 interface.If Use System Host Name is disabled, specifies the
local name for CHAP to use.

Local Name

Type the CHAP client name.Identifies the client or peer with which the device
communicates on this T1 interface.

CHAP Peer Identity

Type a password that is known to the other side
of the connection. Use a combination of letters
and numbers that is difficult for others to guess.

Specifies the secret password for CHAP
authentication, known to both sides of the
connection.

CHAP Secret

T1 Options

From the list, select one of the following:

■ esf—Extended superframe (the default)

■ sf—Superframe

Specifies the framing mode for the T1 line.Framing Mode

From the list, select one of the following:

■ ami—Alternate mark inversion

■ b8zs—Binary 8 zero substitution (the default)

Specifies the line encoding method.Line Encoding

From the list, select one of the following:

■ nx56—7 bits per byte

■ nx64—8 bits per byte (the default)

Specifies the byte encoding method.Byte Encoding

■ To enable, select the check box.

■ To disable, clear the check box.

Enables or disables data inversion. Data inversion
is normally used only in alternate mark inversion
(AMI) mode.

Invert Data

Type numeric values from 1 through 24. You can
use any combination of time slots. To configure
ranges, use hyphens. To configure discontinuous
slots, use commas. For example:

1–5,10,24

Specifies the number of time slots allocated to a
fractional T1 interface. By default, a T1 interface
uses all the time slots.

Timeslots

Select 16 or 32. The default value is 16.Specifies the number of bits in the frame
checksum. A 32–bit checksum provides more
reliable packet verification, but is not supported
by some older equipment.

Frame Checksum
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Table 24: T1 Quick Configuration Summary (continued)

Your ActionFunctionField

From the list, select one of the following line
buildouts:

■ 0–132 (0 m–40 m) (the default)

■ 133–265 (40 m–81 m)

■ 266–398 (81 m–121 m)

■ 399–531 (121 m–162 m)

■ 532–655 (162 m–200 m)

■ long-0db

■ long-7.5db

■ long-15db

■ long-22.5db

Specifies the T1 line buildout in feet for cables
655 feet (200 m) or shorter, or in decibels for
longer cables.

Line buildout compensates for the loss in decibels
based on the distance from the device to the first
repeater in the circuit.

Line Buildout

Configuring T3 Interfaces with Quick Configuration

To configure properties on a T3 (DS3) interface:
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1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the T3 interface you want to configure.

The properties you can configure on a T3 interface are displayed, as shown in
Figure 22 on page 102. (See “Network Interface Naming” on page 9.)

Figure 22: T3 Interfaces Quick Configuration Page

2. Enter information into the Quick Configuration page, as described in Table 25
on page 103.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the T3 interface is configured correctly, see “Verifying Interface
Configuration” on page 113.
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Table 25: T3 Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that you connect
to this physical T3 interface. You must define at least
one logical unit for a T3 interface. You can define
multiple units if the encapsulation type is Frame
Relay.

Add logical interfaces

Type a text description of the logical interface
to more clearly identify it in monitoring
displays.

(Optional) Describes the logical interface.Logical Interface
Description

1. Type one or more IPv4 addresses and
prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses for the
interface.

IPv4 Addresses and
Prefixes

Type a text description of the T3 interface to
more clearly identify it in monitoring displays.

(Optional) Adds supplementary information about
the physical T3 interface.

Physical Interface
Description

Type a value between 256 and 9192 bytes.
The default MTU for T3 interfaces is 4474.

Specifies the maximum transmission unit size for
the T3 interface.

MTU (bytes)

From the list, select one of the following:

■ internal—device's own system clock (the
default)

■ external—Clock received from the T3
interface

Specifies the transmit clock source for the T3 line.Clocking

■ To enable scheduling, select the check
box.

■ To disable scheduling, clear the check
box.

Enables scheduling on logical interfaces.

Allows you to configure multiple output queues on
a logical interface and associate an output scheduler
and shaping rate with the queues.

Per unit scheduler

Encapsulation

From the list, select the encapsulation for this
T3 interface:

■ PPP

■ Frame Relay

■ Cisco HDLC

Specifies the encapsulation type for traffic on the
interface.

Encapsulation

■ To enable CHAP, select the check box.

■ To disable CHAP, clear the check box.

Enables or disables CHAP authentication on a T3
interface with PPP encapsulation only.

Enable CHAP

CHAP Local Identity (available if CHAP is enabled)
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Table 25: T3 Quick Configuration Summary (continued)

Your ActionFunctionField

■ To enable, select the check box (the
default).

■ To disable, clear the check box.

Specifies that the T3 interface uses the device's
system hostname in CHAP challenge and response
packets.

Use System Host
Name

Type a local name for this T3 interface.If Use System Host Name is disabled, specifies the
local name for CHAP to use.

Local Name

Type the CHAP client name.Identifies the client or peer with which the device
communicates on this T3 interface.

CHAP Peer Identity

Type a password that is known to the other
side of the connection. Use a combination of
letters and numbers that is difficult for others
to guess.

Specifies the secret password for CHAP
authentication, known to both sides of the
connection.

CHAP Secret

T3 Options

Select 16 or 32. The default value is 16.Specifies the number of bits in the frame checksum.
A 32-bit checksum provides more reliable packet
verification, but is not supported by some older
equipment.

Frame Checksum

■ To enable long buildout, select the check
box.

■ To disable long buildout, clear the check
box.

Specifies a short or long cable length for
copper-cable-based T3 interfaces. A long cable is
longer than 225 feet (68.6m).

Enable Long Buildout

■ To disable, select the check box.

■ To enable, clear the check box.

Enables or disables C-bit parity mode, which controls
the type of framing that is present on the transmitted
T3 signal.

Disable C-Bit Parity
Mode

Configuring Serial Interfaces with Quick Configuration

A serial interface uses a serial line protocol—such as EIA-530, X.21, RS-449/422,
RS-232, or V.35—to control the transmission of signals across the interface. You do
not need to explicitly configure the serial line protocol, because it is automatically
detected by the Juniper Networks device based on the cable plugged into the serial
interface.

To configure properties on a serial interface:
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1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the serial interface you want to configure.

The properties you can configure on a serial interface are displayed, as shown
in Figure 23 on page 105. (See “Network Interface Naming” on page 9.)

Figure 23: Serial Interfaces Quick Configuration Page

2. Enter information into the Quick Configuration page, as described in Table 26
on page 106.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the serial interface is configured correctly, see “Verifying Interface
Configuration” on page 113.
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Table 26: Serial Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that you
connect to this physical serial interface. You
must define at least one logical unit for a serial
interface. You can define multiple units if the
encapsulation type is Frame Relay.

Add logical interfaces

Type a text description of the logical interface
to more clearly identify it in monitoring
displays.

(Optional) Describes the logical interface.Logical Interface
Description

1. Type one or more IPv4 addresses and
prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses for the
interface.

IPv4 Addresses and
Prefixes

Type a text description of the serial interface
to more clearly identify it in monitoring
displays.

(Optional) Adds supplementary information
about the physical serial interface.

Physical Interface
Description

Type a value between 256 and 9192 bytes.
The default MTU for serial interfaces is 1504.

Specifies the maximum transmission unit size
for a serial interface.

MTU (bytes)

■ To enable scheduling, select the check
box.

■ To disable scheduling, clear the check
box.

Enables scheduling on logical interfaces.

Allows you to configure multiple output queues
on a logical interface and associate an output
scheduler and shaping rate with the queues.

Per unit scheduler

Encapsulation

From the list, select the encapsulation for this
serial interface:

■ PPP

■ Frame Relay

■ Cisco HDLC

Specifies the encapsulation type for traffic on
the interface.

Encapsulation

■ To enable CHAP, select the check box.

■ To disable CHAP, clear the check box.

Enables or disables CHAP authentication on a
serial interface with PPP encapsulation only.

Enable CHAP

CHAP Local Identity (available if CHAP is enabled)

■ To enable, select the check box (the
default).

■ To disable, clear the check box.

Specifies that the serial interface use the
device's system hostname in CHAP challenge
and response packets.

Use System Host Name

Type a local name for this serial interface.If Use System Host Name is disabled, specifies
the local name for CHAP to use.

Local Name
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Table 26: Serial Quick Configuration Summary (continued)

Your ActionFunctionField

Type the CHAP client name.Identifies the client or peer with which the
device communicates on this serial interface.

CHAP Peer Identity

Type a password that is known to the other
side of the connection. Use a combination of
letters and numbers that is difficult for others
to guess.

Specifies the secret password for CHAP
authentication, known to both sides of the
connection.

CHAP Secret

Serial Options

From the list, select one of the following timing
sources:

■ dce—Uses a transmit clock generated by
the data circuit-terminating equipment
(DCE) for the device's DTE.

■ internal—Uses the device's internal clock.

■ loop—Uses the DCE's or DTE's receive
clock (the default).

For X.21 serial interfaces, you must use the
loop clocking mode.

When the device is functioning as DTE, you
must use the dce clocking mode for all
interfaces except X.21 serial interfaces.

When the device is functioning as DCE, we
recommend using the internal clocking mode
for all interfaces.

Specifies the clock source to determine the
timing on serial interfaces.

If you use an externally timed clocking
mode—dce or loop—long cables might
introduce a phase shift of DTE-transmitted
clock and data. At high speeds, this phase shift
might cause errors.

Inverting the transmit clock corrects the phase
shift, thereby reducing error rates. By default,
the transmit clock is not inverted. To invert the
transmit clock, do either of the following:

■ In the J-Web configuration editor, set the
Transmit clock value to invert on the
Interfaces>interface-name> Serial
options page.

■ In the CLI configuration editor, include
the transmit-clock invert statement at the
[edit interfaces se-pim/0/port serial-options]
hierarchy level.

Clocking Mode
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Table 26: Serial Quick Configuration Summary (continued)

Your ActionFunctionField

From the list, select one of the following clock
rates:

■ 1.2 KHz

■ 2.4 KHz

■ 9.6 KHz

■ 19.2 KHz

■ 38.4 KHz

■ 56.0 KHz

■ 64.0 KHz

■ 72.0 KHz

■ 125.0 KHz

■ 148.0 KHz

■ 250.0 KHz

■ 500.0 KHz

■ 800.0 KHz

■ 1.0 MHz

■ 1.3 MHz

■ 2.0 MHz

■ 4.0 MHz

■ 8.0 MHz

Specifies the line speed in kilohertz or
megahertz for serial interfaces that use the DTE
clocking mode.

Clock Rate

NOTE: RS-232 serial
interfaces cannot function
error-free with a clock rate
greater than 200 KHz.

Enabling and Disabling Promiscuous Mode on Ethernet Interfaces

This section contains the following topics:

■ Understanding Promiscuous Mode on page 108

■ Enabling and Disabling Promiscuous Mode on page 109

Understanding Promiscuous Mode

When promiscuous mode is enabled on a Layer 3 Ethernet interface, all packets
received on the interface are sent to the central point or Services Processing Unit
regardless of the destination MAC address of the packet. You can also enable
promiscuous mode on chassis cluster redundant Ethernet interfaces and aggregated
Ethernet interfaces. If you enable promiscuous mode on a redundant Ethernet
interface, promiscuous mode is then enabled on any child physical interfaces. If you
enable promiscuous mode on an aggregated Ethernet interface, promiscuous mode
is then enabled on all member interfaces.
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Enabling and Disabling Promiscuous Mode

You can use either J-Web or the CLI configuration editor to enable or disable
promiscuous mode on an interface.

■ J-Web Point and Click CLI Configuration on page 109

■ CLI Configuration on page 109

J-Web Point and Click CLI Configuration

To enable promiscuous mode on an interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Under Interface, click the Interface name ge-0/0/0.

4. Select the Promiscuous Mode check box.

5. Click OK.

To disable promiscuous mode on an interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Under Interface, click the Interface name ge-0/0/0.

4. Clear the Promiscuous Mode check box.

5. Click OK.

CLI Configuration

To enable promiscuous mode on an interface:

user@host# set interfaces ge-0/0/0 promiscuous-mode

To disable promiscuous mode on an interface:

user@host# delete interfaces ge-0/0/0 promiscuous-mode

Configuring Network Interfaces with a Configuration Editor

To enable the interfaces installed on your device to work properly, you must configure
their properties. You can perform basic interface configuration using the J-Web Quick
Configuration pages, as described in “Configuring Interfaces—Quick Configuration”
on page 82. You can perform the same configuration tasks using the J-Web or CLI
configuration editor. In addition, you can configure a wider variety of options that
are encountered less frequently.

Configuring Network Interfaces with a Configuration Editor ■ 109

Chapter 2: Configuring Ethernet, DS1, DS3, and Serial Interfaces



You can perform the following tasks to configure interfaces:

■ Adding a Network Interface with a Configuration Editor on page 110

■ Configuring Static ARP Entries on Ethernet Interfaces on page 111

■ Deleting a Network Interface with a Configuration Editor on page 112

For information about using the J-Web and CLI configuration editors, see the J-Web
Interface User Guide and the Junos CLI User Guide.

Adding a Network Interface with a Configuration Editor

After you install a PIM, connect the interface cables to the ports, and power on the
device, you must complete initial configuration of each network interface, as described
in the following procedure:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 27 on page 110.

3. When you are finished configuring the device, commit the configuration.

4. To verify that the network interface is configured correctly, see “Verifying
Interface Configuration” on page 113.

Table 27: Adding an Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces interface-name

For information about interface names,
see “Network Interface Naming” on
page 9.

1. In the J-Web interface, select
Configure>Configure>CLI Tools>Point and Click
CLI.

2. Next to Interfaces, click Configure or Edit.

Navigate to the
Interfaces level in the
configuration hierarchy.

1. Next to Interface, click Add new entry.

2. Enter the name of the new interface in the Interface
name box.

Make sure the name conforms to the interface
naming rules. For more information, see “Network
Interface Naming” on page 9.

3. Click OK.

Create the new
interface.

Enter values for physical interface
properties as needed. Examples include
changes to the default values for
physical encapsulation or MTU. For
example:

set interface-name encapsulation ppp

1. Under Interface Name in the table, click the name of
the new interface.

2. Enter values in the other fields on this page if
warranted.

All these entries are optional, but you need to set
values for Clocking and Encapsulation in particular
if the default values are not suitable.

Create the basic
configuration for the
new interface.
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Table 27: Adding an Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. From the [edit interfaces
interface-name] hierarchy level,
type

edit interface-options

2. Enter the statement for each
interface-specific property for
which you need to change the
default value.

1. Under Nested configuration, click Configure for the
appropriate interface type.

2. In the interface-specific page that appears, enter the
values you need to supply or change the default
values.

3. When you are finished, click OK to confirm your
changes or Cancel to cancel them and return to the
previous page.

Add values for
interface-specific
options.

Most interface types
have optional
parameters that are
specific to the interface
type.

1. From the [edit interfaces
interface-name] hierarchy level,
type

set unitlogical-unit-number

Replace logical-unit-number with a
value from 0 through 16384.

2. Enter additional values for
properties you need to configure
on the logical interface, such as
logical encapsulation or protocol
family.

1. In the main Interface page for this interface, next to
Unit, click Add new entry.

2. On the Unit page for logical interfaces that appears,
type a number from 0 through 16384 in the Interface
unit number box.

3. Enter values in other fields as required for your
network.

4. To configure protocol family values if needed, under
Family, click Configure next to the appropriate
protocol.

5. To access additional subordinate hierarchies under
Nested configuration, click Configure next to any
parameter you want to configure.

6. When you are finished, click OK.

Add logical interfaces.

Configuring Static ARP Entries on Ethernet Interfaces

By default, the device responds to an Address Resolution Protocol (ARP) request only
if the destination address of the ARP request is on the local network of the incoming
interface. For Fast Ethernet or Gigabit Ethernet interfaces, you can configure static
ARP entries that associate the IP addresses of nodes on the same Ethernet subnet
with their media access control (MAC) addresses. These static ARP entries enable
the device to respond to ARP requests even if the destination address of the ARP
request is not local to the incoming Ethernet interface.

In this example, you configure a static ARP entry on Gigabit Ethernet interface
ge-0/0/3 of the device consisting of the IP address and corresponding MAC address
of a node on the same Ethernet subnet. The ge-0/0/3 interface has the IP address
10.1.1.1/24. The node has the IP address 10.1.1.3 and the MAC address
00:ff:85:7f:78:03. If the node on your network is another device running JUNOS
Software, you can enter the show interfaces interface-name command to learn the IP
and MAC (hardware) address of the node.

For more information about configuring static ARP entries, see the Junos Network
Interfaces Configuration Guide.

To configure a static ARP entry on the ge-0/0/3 interface:
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1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 28 on page 112.

3. If you are finished configuring the device, commit the configuration.

4. To verify the configuration, see “Verifying Interface Configuration” on page 113.

Table 28: Configuring Static ARP Entries

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces ge-0/0/3

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

In the Interface name column, click
ge-0/0/3.

Select the Gigabit Ethernet interface
ge-0/0/3.

1. Enter

edit unit 0

2. Enter

edit family inet address 10.1.1.1/24

3. Enter

set arp 10.1.1.3 mac
00:ff:85:7f:78:03 publish

1. Under Unit, next to 0, click Edit.

2. Under Family, next to Inet, click
Edit.

3. Under Address, next to
10.1.1.1/24, click Edit.

4. Next to Arp, click Add new entry.

5. In the Address box, type the IP
address of the node—10.1.1.3.

6. Select the Publish check box.

7. From the Mac address type list,
select Mac.

8. In the Mac box, type the MAC
address 00:ff:85:7f:78:03 of node.

9. Click OK until you return to the
Interfaces page.

Configure a static ARP entry on logical
unit 0 with the source address
10.1.1.1/24 on the ge-0/0/3 interface.

Set the IP address of the subnet node to
10.1.1.3 and the corresponding MAC
address to 00:ff:85:7f:78:03.

To have the device reply to ARP requests
from the node, use the publish option.

Deleting a Network Interface with a Configuration Editor

To delete an interface:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 29 on page 113.
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NOTE: Performing this action removes the interface from the software configuration
and disables it. Network interfaces remain physically present, and their identifiers
continue to appear on the J-Web Monitor and Quick Configuration pages.

Table 29: Deleting an Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

edit interfaces

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the  Interfaces
level in the configuration
hierarchy.

Enter

delete interface-name

In the Interface table, under Interface name, select the name
of the interface you want to delete.

For information about interface names, see “Network Interface
Naming” on page 9.

Select the interface you want
to delete.

Commit the configuration
change:

commit

1. Click Discard.

2. In the page that appears, select the appropriate option
button.

If you have not made any previous changes, the only
selection available is Delete Configuration Below This
Point.

Execute the selection.

Verifying Interface Configuration

To verify an interface configuration, perform these tasks:

■ Verifying the Link State of All Interfaces on page 113

■ Verifying Interface Properties on page 114

Verifying the Link State of All Interfaces

Purpose By using the ping tool on each peer address in the network, verify that all interfaces
on the device are operational.

Action For each interface on the device:

1. In the J-Web interface, select Troubleshoot>Ping Host.

2. In the Remote Host box, type the address of the interface for which you want
to verify the link state.

3. Click Start. Output appears on a separate page.

Sample Output
PING 10.10.10.10 : 56 data bytes
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64 bytes from 10.10.10.10: icmp_seq=0 ttl=255 time=0.382 ms
64 bytes from 10.10.10.10: icmp_seq=1 ttl=255 time=0.266 ms

Meaning If the interface is operational, it generates an ICMP response. If this response is
received, the round-trip time in milliseconds is listed in the time field. For more
information about the output, see the Junos OS Administration Guide for Security
Devices.

Related Topics For more information about using the J-Web interface to ping a host, see the Junos
OS Administration Guide for Security Devices.

For information about the ping command, see the Junos OS Administration Guide for
Security Devices or the Junos System Basics and Services Command Reference.

Verifying Interface Properties

Purpose Verify that the interface properties are correct.

Action From the CLI, enter the show interfaces detail command.

Sample Output user@host> show interfaces detail
Physical interface: ge-1/0/0, Enabled, Physical link is Up
  Interface index: 134, SNMP ifIndex: 27, Generation: 17
  Link-level type: Ethernet, MTU: 1514, Speed: 100mbps, Loopback: Disabled,
  Source filtering: Disabled, Flow control: Enabled
  Device flags   : Present Running
  Interface flags: SNMP-Traps 16384
  Link flags     : None
  CoS queues     : 4 supported
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: 00:90:69:87:44:9d, Hardware address: 00:90:69:87:44:9d
  Last flapped   : 2004-08-25 15:42:30 PDT (4w5d 22:49 ago)
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :                    0                    0 bps
   Output bytes  :                    0                    0 bps
   Input  packets:                    0                    0 pps
   Output packets:                    0                    0 pps
  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 best-effort                    0                    0                    0

    1 expedited-fo                   0                    0                    0

    2 assured-forw                   0                    0                    0

    3 network-cont                   0                    0                    0

  Active alarms  : None
  Active defects : None
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Meaning The output shows a summary of interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do one
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).

■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates likely link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

Related Topics For a complete description of show interfaces detail output, see the Junos Interfaces
Command Reference.
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Chapter 3

Configuring Channelized T1/E1/ISDN PRI
Interfaces

The J Series device supports the software-configurable interfaces on the Dual-Port
Channelized T1/E1/ISDN PRI PIM. Each interface can be partitioned into T1 or E1
DS0 channels, or into a combination of T1 or E1 and ISDN Primary Rate Interface
(PRI) B-channels and a D-channel.

NOTE: You cannot configure channelized T1/E1/ISDN/PRI interfaces through a J-Web
Quick Configuration page. You must use the J-Web or CLI configuration editor. Even
after configuration, channelized interfaces do not appear on the Quick Configuration
Interfaces page.

For more information about interfaces, see “Interfaces Overview” on page 3 and
the Junos Network Interfaces Configuration Guide. For ISDN information, see
“Configuring ISDN” on page 309.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Channelized T1/E1/ISDN PRI Terms on page 117

■ Channelized T1/E1/ISDN PRI Overview on page 118

■ Before You Begin on page 120

■ Configuring Channelized T1/E1/ISDN PRI interfaces with a Configuration
Editor on page 120

■ Verifying Channelized T1/E1/ISDN PRI Interfaces on page 128

■ Frequently Asked Questions About Channelized T1/E1/ISDN PRI
Interfaces on page 130

Channelized T1/E1/ISDN PRI Terms

Before configuring channelized T1/E1/ISDN PRI interfaces on a J Series device, become
familiar with the terms defined in Table 30 on page 118.
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Table 30: Channelized T1/E1/ISDN PRI Terms

DefinitionTerm

Combination of DS0 or ISDN PRI B-channels interfaces partitioned from a channelized interface
into a single logical bundle.

channel group

2.048-Mbps interface that can be configured as a single clear-channel E1 interface or channelized
into as many as 31 discrete DS0 interfaces, or up to 30 ISDN PRI B-channels and 1 D-channel.
On J Series channelized T1/E1/ISDN PRI interfaces, time slots are numbered from 1 through 31,
and time slot 1 is reserved for framing. When the interface is configured for ISDN PRI service,
time slot 16 is reserved for the D-channel.

channelized E1

Interface that is a subdivision of a larger interface, minimizing the number of Physical Interface
Modules (PIMs) that an installation requires. On a channelized PIM, each port can be configured
as a single T1 or E1 clear channel or partitioned into multiple discrete DS0 interfaces or ISDN
PRI channels.

channelized interface

1.544-Mbps interface that can be configured as a single clear-channel T1 interface or channelized
into as many as 24 discrete DS0 interfaces, or up to 23 ISDN PRI B-channels and 1 D-channel.
When the interface is configured for ISDN PRI service, time slot 24 is reserved for the D-channel.

channelized T1

Physical WAN interface for transmitting signals in European digital transmission (E1) format.
The E1 signal format transmits information at a rate of 2.048 Mbps and can carry 32 channels
of 64 Kbps each.

E1 interface

ISDN service intended for higher-bandwidth applications than ISDN BRI. ISDN PRI consists of a
single D-channel for control and signaling, plus a number of 64-Kbps B-channels—either 23
B-channels on a T1 line or 30 B-channels on an E1 line—to carry network traffic.

Primary Rate Interface
(PRI)

Physical WAN interface for transmitting digital signals in the T-carrier system used in the United
States, Japan, and Canada. The T1 signal format carries 24 pulse code modulation (PCM) signals
using time-division multiplexing (TDM) at an overall rate of 1.544 Mbps.

T1 interface

Channelized T1/E1/ISDN PRI Overview

You can configure a channelized T1/E1/ISDN PRI interface for T1 or E1 or ISDN PRI
service.

On a channelized T1/E1/ISDN PRI PIM configured for channelized operation, you
can use the "drop-and-insert" feature to integrate voice and data on a single T1 or
E1 link, and save the cost of two lines.

This overview contains the following topics:

■ Channelized T1/E1/ISDN PRI Interfaces on page 118

■ Drop and Insert on page 119

■ ISDN PRI Transmission on Channelized Interfaces on page 119

Channelized T1/E1/ISDN PRI Interfaces

Each port on a channelized T1/E1/ISDN PRI PIM is software configurable for T1, E1,
or ISDN PRI service. Each channelized T1 or E1 interface can be configured as a

118 ■ Channelized T1/E1/ISDN PRI Overview

JUNOS Software Interfaces and Routing Configuration Guide



single clear channel, or for fractional (NxDS0) or channelized operation, where N is
channels 1 to 31 for an E1 interface and channels 1 to 24 for a T1 interface.

Each channelized interface can be configured as ISDN PRI B-channels and one
D-channel or as a combination of T1 or E1 DS0 channels and ISDN PRI channels.

J Series ISDN PRI interfaces support the following switch types:

■ ATT5E—AT&T 5ESS

■ ETSI—NET3 for the United Kingdom and Europe

■ NI2—National ISDN-2

■ NTDMS100—Northern Telecom DMS-100

■ NTT—NTT Group switch for Japan

For more information, see “ISDN PRI Transmission on Channelized Interfaces” on
page 119.

Channelized T1/E1/ISDN PRI interfaces are configured through a configuration editor
only.

A channelized T1/E1/ISDN PRI interface supports CoS configuration. For information
about CoS features, see Junos OS Class of Service Configuration Guide for Security
Devices.

Drop and Insert

On channelized T1/E1 interfaces configured for channelized operation, you can insert
channels (time slots) from one port (for example, channels carrying voice) directly
into the other port on the PIM, to replace channels coming through the Routing
Engine. This feature, known as drop and insert, allows you to integrate voice and
data on a single T1 or E1 link by removing the DS0 time slots of one T1 or E1 port
and replacing them by inserting the time slots of another T1 or E1 port. You need
not use the same time slots on both interfaces, but the time slots count must be the
same.

The channels that are not configured for the drop-and-insert feature are used for
normal traffic.

ISDN PRI Transmission on Channelized Interfaces

The Dual-Port Channelized T1/E1/ISDN PRI PIM provides support for ISDN PRI services
such as dial-in at the central office, callback from the central office, and primary or
backup network connections from branch offices. For more information about the
services, see “Configuring ISDN” on page 309.

You can configure up to 23 time slots in a channelized T1 PRI interface and up to
30 time slots in a channelized E1 PRI interface as B-channels. The 24th time slot in
a T1 interface and the 16th time slot in an E1 interface are configured as the
D-channel interface for signaling purposes. Each B-channel supports 64 Kbps of
traffic. The unconfigured time slots can be used as regular DS0 interfaces on top of
the T1 or E1 physical layer.
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You can install channelized T1/EI/ISDN PRI PIMs and ISDN BRI PIMs and configure
both ISDN PRI and ISDN BRI service on the same J Series device.

Before You Begin

Before you configure network interfaces, you need to perform the following tasks:

■ Install J Series device hardware. For more information, see the J Series Services
Routers Hardware Guide.

■ Establish basic connectivity. For more information, see the Getting Started Guide
for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

Although it is not a requirement, you might also want to plan how you are going to
use the various network interfaces before you start configuring them.

Configuring Channelized T1/E1/ISDN PRI interfaces with a Configuration Editor

Each port on a channelized T1/E1/ISDN PRI PIM is software configurable as a T1 or
E1 clear channel. You can partition each port into up to 24 DS0 channels on a T1
interface or up to 31 DS0 channels on an E1 interface, and can insert channels from
one port into another with the drop-and-insert feature.

Channelized T1/E1/ISDN PRI ports can also be partitioned into channels for ISDN
PRI service.

Channelized T1/E1/ISDN PRI interfaces are configured through a configuration editor
only.

This section includes the following topics:

■ Configuring Channelized T1/E1/ISDN PRI Interface as a Clear Channel on page 120

■ Configuring Channelized T1/E1/ISDN PRI Interface to Drop and Insert Time
Slots on page 123

■ Configuring Channelized T1/E1/ISDN PRI Interfaces for ISDN PRI
Operation on page 125

Configuring Channelized T1/E1/ISDN PRI Interface as a Clear Channel

To configure or edit a channelized T1/E1/ISDN PRI interface as a clear channel:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 31 on page 121.

3. If you are finished configuring the J Series device, commit the configuration.

4. To verify the configuration, see “Verifying Interface Configuration” on page 113.
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NOTE: When you configure a T1 or an E1 interface on the SRX-GP-QUAD-T1-E1 or
SRX-GP-DUAL-T1-E1, the line encoding and the framing must be specified under the
ct1-n/n/n interface, whereas the remaining T1 or E1 specific configuration items
must be configured under the t1-n/n/n or e1-n/n/n interface, respectively.

Table 31: Configuring a Channelized T1/E1/ISDN PRI interface as a Clear Channel

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter
one of the following:

edit interfaces ct1-3/0/0

edit interfaces ce1-3/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the  Interfaces level in the
configuration hierarchy.

For information about interface names,
see “Network Interface Naming” on
page 9.

1. Next to Interfaces, click Add new
entry.

2. In the Interface name box, type one
of the following interface names:

■ ct1-3/0/0

■ ce1-3/0/0

3. Click OK.

Create the new interface—for example,
ct1-3/0/0 or ce1-3/0/0.

1. Enter

set clocking internal

2. Add a description:

■ For T1 interfaces, enter set
description clear t1 interface.

■ For E1 interfaces, enter set
description clear e1 interface.

3. Enter

set hold-time down 500 up 500

4. Specify a clear channel:

■ For T1 interfaces, enter set
no--partition interface-type t1.

■ For E1 interfaces, enter set
no--partition interface-type e1.

5. Enter

set per-unit-scheduler

1. In the Interface table, under
Interface name, click the interface
you are configuring:.

■ ct1-3/0/0

■ ce1-3/0/0

2. From the Clocking list, select
internal.

3. In the Description box, type one of
the following descriptions:

■ clear t1 interface

■ clear e1 interface

4. Under Hold time:

Next to Down, type 500.

Next to Up, type 500.

5. Under No partition, from the
Interface type list, select the type of
interface:

■ t1

■ e1

6. From the Scheduler type list, select
Per unit scheduler.

Configure interface options:

■ Specify a transmit clock source—for
example, internal. Internal clocking
uses the device’s own system clock
(the default).

External clocking uses a signal
received from the T1 or E1
interface.

■ Describe the physical interface.

■ To delay the advertisement of
interface transitions from up to
down or down to up, set the link
hold down time or link hold up
time, or both. Set a value in
milliseconds from 0 (the default)
through 65534—for example, 500.

■ To use the channelizable interface
as a single clear channel, specify
no partition.

■ To use subunit queuing on Frame
Relay or virtual LAN (VLAN) IQ
interfaces, enable the per-unit
scheduler.
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Table 31: Configuring a Channelized T1/E1/ISDN PRI interface as a Clear Channel (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. Enter

set bert-algorithm all-ones-repeating

2. Enter

set bert-error-rate 5

3. Enter

set bert-period 5

4. For T1 interfaces only, enter

set buildout 0-132

5. Set the framing mode:

■ For T1 interfaces, enter set
framing esf.

■ For E1 interfaces, enter set
framing g704.

6. For T1 interfaces only, enter

set line encoding ami

7. Enter

set loopback local

1. Next to T1 options or E1 options,
click Configure.

2. From the Bert algorithm list, select
all-ones-repeating.

3. In the Bert error rate box, type 5.

4. In the Bert period box, type 5.

5. For T1 interfaces only, from the
Buildout list, select 0-132.

6. From the Framing list:

■ For T1 interfaces, select esf.

■ For E1 interfaces, select g704.

7. For T1 interfaces only, from the
Line encoding list, select ami

8. From the Loopback list, select local.

9. Click OK

Configure T1 or E1 options:

■ Bit error rate test (BERT)
algorithm—for example, all ones
repeating.

■ BERT error rate, a value from 0
through 7—for example, 5.

■ BERT period, in seconds, a value
from 1 through 240—for example,
5.

■ (T1 interfaces only) Line buildout,
in feet for cables 655 ft (200 m) or
shorter—for example, 0-132—or in
decibels for longer cables.

■ Framing mode:

■ For T1 interfaces, either
superframe or extended
superframe (ESF)—for
example, ESF

■ For E1 interfaces, G704, G704
without cyclic redundancy
check 4 (CRC4), or G703
unframed—for example,
G704.

■ (T1 interfaces only) Line encoding
method—for example, alternate
mark inversion (AMI).

■ Loopback mode—for example,
local.

Enter

set traceoptions flag all

1. Next to Traceoptions, select the
check box and click Configure.

2. Next to Flag, click Add new entry.

3. From the Flag name list, select all.

4. Click OK until you return to the
Interface page.

Configure trace options.

Enter

set interfaces apply-groups test

1. Next to Advanced, click the expand
(+) icon.

2. Next to Apply groups except, click
Add new entry.

3. In the Value box, type test.

4. Click OK.

Configure advanced options.

For example, apply configuration
settings from one or more groups except
the test group.
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Configuring Channelized T1/E1/ISDN PRI Interface to Drop and Insert Time Slots

On channelized T1/E1/ISDN PRI interfaces configured for channelized operation, you
can insert channels (time slots) from one port (for example, channels carrying voice)
directly into the other port on the PIM, to replace channels coming through the
Routing Engine. Although you need not use the same time slots on both interfaces,
the time slots count must be the same. The channels that are not configured for the
drop-and-insert feature are used for normal traffic.

You must ensure that the signaling channels (port 16 for an E1 interface and port 24
for a T1 interface) are also part of the channels that are being switched through the
drop-and-insert functionality. JUNOS Software does not support switching of voice
and data between ports by default.

Both ports involved in the drop-and-insert configuration must use the same clock
source—either the device's internal clock or an external clock. The following clock
source settings are valid:

■ When port 0 is set to use the internal clock, port 1 must also be set to use it, and
vice versa.

■ When port 0 is set to use its external clock, port 1 must be set to run on the
same clock—the external clock for port 0.

■ When port 1 is set to use its external clock, port 0 must be set to run on the
same clock—the external clock for port 1.

For more details about valid clock combinations, see “Frequently Asked Questions
About Channelized T1/E1/ISDN PRI Interfaces” on page 130.

To configure or edit the drop-and-insert feature on a channelized T1/E1/ISDN PRI
interface:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 32 on page 124.

3. If you are finished configuring the device, commit the configuration.

4. To verify the configuration, see “Verifying Interface Configuration” on page 113.
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Table 32: Configuring a Channelized T1/E1/ISDN PRI Interface to Drop and Insert Time Slots

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces ct1-3/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the  Interfaces level in the
configuration hierarchy.

For information about interface names,
see “Network Interface Naming” on
page 9.

1. Next to Interfaces, click Add new
entry.

2. In the Interface name box, type
ct1–3/0/0.

3. Click OK.

Create a new interface—for example,
ct1-3/0/0.

From the [edit] hierarchy level, enter

set interfaces ct1-3/0/0 clocking external

set interfaces ct1-3/0/0 partition 1
timeslots 1-10

set interfaces ct1-3/0/0 partition 1
interface-type ds

1. In the Interface name column, click
ct1–3/0/0.

2. On the Interfaces page, next to
Clocking, select the check box and
click Configure.

3. From the Clocking choices list,
select external.

4. Click OK.

5. On the Interfaces page, next to
Partition, click Add new entry.

6. On the Interface Partition page, type
1 in the Partition number box.

7. From the Interface type list, Select
ds.

8. In the Timeslots box, type 1-10.

9. Click OK twice.

Configure the clock source and partition
on ct1-3/0/0.

NOTE: While configuring the
drop-and-insert feature, you must ensure
that both ports on the channelized T1/E1
PIM run on the same clock.

For more details about valid clock
combinations, see “Frequently Asked
Questions About Channelized
T1/E1/ISDN PRI Interfaces” on page 130.

From the [edit] hierarchy level, enter

edit interfaces ct1-3/0/1

1. On the Interfaces Configuration
page, next to Interface, click Add
new entry.

2. In the Interface name box, type
ct1-3/0/1.

3. Click OK.

Create a new interface—for example,
ct1-3/0/1.
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Table 32: Configuring a Channelized T1/E1/ISDN PRI Interface to Drop and Insert Time Slots (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

set interfaces ct1-3/0/1 clocking external
interface ct1-3/0/0

set interfaces ct1-3/0/1 partition 1
timeslots 1-10

set interfaces ct1-3/0/1 partition 1
interface-type ds

1. On the Interfaces Configuration
page, click ct1-3/0/1 in the Interface
name column.

2. Next to Clocking, select the Yes
check box, and click Configure.

3. From the Clocking choices list,
select external.

4. Next to External, click Configure.

5. In the Interface box, type ct1-3/0/0.

6. Click OK twice.

7. On the Interfaces page, next to
Partition, click Add new entry.

8. On the Interface Partition page, type
1 in the Partition number box.

9. From the Interface type list, Select
ds.

10. In the Timeslots box, type 1-10.

11. Click OK twice

Configure the clock source and partition
on ct1-3/0/1.

NOTE: While configuring the
drop-and-insert feature, you must ensure
that both ports on the channelized T1/E1
PIM run on the same clock.

For more details about valid clock
combinations, see “Frequently Asked
Questions About Channelized
T1/E1/ISDN PRI Interfaces” on page 130.

From the [edit] hierarchy level, enter

edit interfaces ds-3/0/0:1

Enter

set interfaces ds-3/0/0:1 data-input
interface ds-3/0/1:1

1. On the Interfaces Configuration
page, next to Interface, click Add
new entry.

2. In the Interface name box, type
ds–3/0/0:1.

3. Click OK.

4. On the Interfaces Configuration
page, click ds–3/0/0:1 in the
Interface name column.

5. Next to Data input, click Configure.

6. From the Input choice list, select
interface.

7. In the Interface box, type
ds-3/0/1:1.

8. Click OK.

Create new interfaces—for example,
ds-3/0/0:1, ds-3/0/1:1 and configure
drop-and-insert feature.

NOTE: Both interfaces configured for
the drop-and-insert feature must exist
on the same PIM. For example, you can
configure ds-3/0/0:1 as the data input
interface for ds-3/0/1:1, but not for
ds-4/0/0:1.

Configuring Channelized T1/E1/ISDN PRI Interfaces for ISDN PRI Operation

On a J Series device with Dual-Port Channelized T1/E1/ISDN PRI PIMs, you can
configure each port for either T1, E1, or ISDN PRI service, or for a combination of
ISDN PRI and either channelized T1 or E1 service. For a channelized T1 interface
with ISDN PRI service, you can configure 23 B-channels and for a channelized E1
interface with ISDN PRI service, you can configure 30 B-channels.
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You must also explicitly configure a D-channel: time slot 24 on a channelized T1
interface and time slot 16 on a channelized E1 interface. In addition, you select a
switch type and trace options.

Setting up the J Series device for ISDN PRI operation is a multipart process. First,
you add ISDN PRI service on a channelized interface as shown here. Second, you
follow the instructions in “Configuring Dialer Interfaces (Required)” on page 324 to
configure a dialer interface. You can then configure ISDN services such as dial-in,
callback, and backup. For details, see “Configuring ISDN” on page 309.

To configure an ISDN PRI network service on a channelized T1 or E1 interface for
the J Series device:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 33 on page 126.

3. Go on to “Configuring Dialer Interfaces (Required)” on page 324.

Table 33: Adding an ISDN PRI Service to a Channelized T1/E1/ISDN PRI Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces ct1-2/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the  Interfaces level in the
configuration hierarchy.

1. Next to Interfaces, click Add new
entry.

2. In the Interface name box, type
ct1–2/0/0.

3. Click OK.

Create a new interface—for example,
ct1-2/0/0.

For information about interface names,
see “Network Interface Naming” on
page 9.
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Table 33: Adding an ISDN PRI Service to a Channelized T1/E1/ISDN PRI Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

set interfaces ct1-2/0/0 partition 1-23
timeslots 1-23

set interfaces ct1-2/0/0 partition 1-23
interface-type bc

set interfaces ct1-2/0/0 partition 24
timeslots 24

set interfaces ct1-2/0/0 partition 24
interface-type dc

1. In the Interface name column, click
ct1–2/0/0.

2. On the Interfaces page, next to
Partition, click Add new entry.

3. In the Partition number box, type
1–23.

4. In the Timeslots box, type 1-23.

5. From the Interface type list, Select
bc.

6. Click OK.

7. On the Interfaces page, next to
Partition, click Add new entry.

8. In the Partition number box, type
24.

9. In the Timeslots box, type 24.

10. From the Interface type list, Select
dc.

11. Click OK.

Configure the partition and interface
type. For example, partition the interface
into time slots 1 through 23 for
B-channels and time slot 24 for the
D-channel.

For a channelized T1 interface, you can
configure 1 through 23 as B-channels
and the 24th channel as the signaling
channel (D-channel).

For a channelized E1 interface, you can
configure 1 through 15 and 17 through
31 as B-channels and the 16th channel
as the signaling channel (D-channel).

From the [edit] hierarchy level, enter

set interfaces ct1-2/0/0 traceoptions flag
q921

1. Next to Traceoptions, select the
check box and click Configure.

2. Next to Flag, click Add new entry.

3. From the Flag name list, select
q921.

4. Click OK until you return to the
Interface page.

Configure a trace options flag.

To set the ISDN options, from the [edit]
hierarchy level, enter

set interfaces ct1-2/0/0 isdn-options
bchannel-allocation ascending

1. On the Interfaces page, next to Isdn
options, click Configure.

2. From the Bchannel allocation list,
select ascending.

3. Click OK.

Configure B-channel allocation order for
allocating a free B-channel for dial-out
calls. You can allocate from the
lowest-numbered or highest-numbered
time slot. The default value is
descending.

From the [edit] hierarchy level, enter

set interfaces ct1-2/0/0 isdn-options
switch-type ni2

From the Switch type list, select ni2.Select the type of ISDN switch—for
example, NI2. The following switches
are compatible with J Series devices:

■ ATT5E—AT&T 5ESS

■ ETSI—NET3 for the UK and Europe

■ NI2—National ISDN-2

■ NTDMS-100—Northern Telecom
DMS-100

■ NTT—NTT Group switch for Japan
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Table 33: Adding an ISDN PRI Service to a Channelized T1/E1/ISDN PRI Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

set isdn-options t310 15

1. In the T310 box, type 15.

2. Click OK.

Configure Q.931 timers. Q.931 is a
Layer 3 protocol for the setup and
termination of connections. The default
value for each timer is 10 seconds, but
can be configured between 1 and 65536
seconds—for example, 15.

From the [edit interfaces ct1-2/0/0]
hierarchy level, enter

set dialer-options pool isdn-dialer-group
priority 1

1. On the Interfaces page, next to
Dialer options, select Yes and then
click configure.

2. Next to Pool, click Add new entry.

3. In the Pool identifier box, type
isdn-dialer-group.

4. In the Priority box, type 1.

5. Click OK.

Configure dialer options.

■ Name the dialer pool—for example,
ISDN-dialer-group.

■ Set the dialer pool priority—for
example, 1.

Dialer pool priority has a range from 1
to 255, with 1 designating lowest-priority
interfaces and 255 designating the
highest-priority interfaces.

To configure a dialer interface, see “Configuring Dialer Interfaces (Required)” on
page 324.

Verifying Channelized T1/E1/ISDN PRI Interfaces

To verify an interface configuration, perform these tasks:

■ Verifying Channelized Interfaces on page 128

■ Verifying Clear-Channel Interfaces on page 129

■ Verifying ISDN PRI Configuration on Channelized T1/E1/ISDN PRI
Interfaces on page 130

Verifying Channelized Interfaces

Purpose Verify that your configurations for the channelized interfaces are correct.

Action From the CLI, enter the show interfaces ct1-3/0/1 command.

Sample Output user@host> show interfaces ct1-3/0/1

Physical interface: ct1-3/0/1, Enabled, Physical link is Up
  Interface index: 151, SNMP ifIndex: 28
  Link-level type: Controller, Clocking: Internal, Speed: E1, Loopback: None,
  Framing: G704, Parent: None
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps Internal: 0x4000
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Last flapped   : 2006-10-05 21:11:48 PDT (06:45:04 ago)
  DS1   alarms   : None
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  DS1   defects  : None
    Line encoding: HDB3

Meaning The output shows a summary of information about the physical parent interface—a
channelized T1 interface in this example.

Related Topics For a complete description of show interfaces output, see the Junos Interfaces Command
Reference.

Verifying Clear-Channel Interfaces

Purpose Verify that your configurations for the clear-channel interfaces are correct.

Action From the CLI, enter the show interfaces e1-3/0/1 command.

Sample Output user@host> show interfaces e1-3/0/1

Physical interface: e1-3/0/1, Enabled, Physical link is Up
  Interface index: 212, SNMP ifIndex: 237
  Link-level type: PPP, MTU: 1504, Speed: E1, Loopback: None, FCS: 16,
  Parent: ce1-3/0/1 Interface index 151
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps Internal: 0x4000
  Link flags     : Keepalives
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 1066 (00:00:02 ago), Output: 1066 (00:00:02 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Opened, iso: Not-configured, mpls:
  Not-configured
  CHAP state: Closed
  CoS queues     : 8 supported, 8 maximum usable queues
  Last flapped   : 2006-10-06 01:01:36 PDT (02:57:27 ago)
  Input rate     : 88 bps (0 pps)
  Output rate    : 58144 bps (157 pps)
  DS1   alarms   : None
  DS1   defects  : None

  Logical interface e1-3/0/1.0 (Index 66) (SNMP ifIndex 238)
    Flags: Point-To-Point SNMP-Traps 0x4000 Encapsulation: PPP
    Bandwidth: 1984kbps
    Protocol inet, MTU: 1500
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 47.47.47.0/30, Local: 47.47.47.2, Broadcast: 47.47.47.3
    Protocol inet6, MTU: 1500
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 8b8b:8b01::/64, Local: 8b8b:8b01::2
      Addresses, Flags: Is-Preferred
        Destination: fe80::/64, Local: fe80::205:85ff:fec5:d3d0
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Meaning The output shows a summary of interface information. Although the parent interface
is ce1-3/0/1, the physical and logical clear-channel interfaces are named e1-3/0/1
and e1-3/0/1.0.

Related Topics For a complete description of show interfaces output, see the Junos Interfaces Command
Reference.

Verifying ISDN PRI Configuration on Channelized T1/E1/ISDN PRI Interfaces

Purpose Verify that your configuration of ISDN PRI service on a channelized interface is
correct.

Action From the J-Web interface, select Configure>CLI Tools>CLI Viewer. Alternatively,
from configuration mode in the CLI, enter the show interfaces ct1-2/0/0 command.

Sample Output user@host# show interfaces ct1-2/0/0

traceoptions {
    flag q921;
    file {
        isdnback;
    }
}
clocking external;
isdn-options {
    switch-type ni2;
}
dialer-options {
    isdn-dialer-group priority 1;
    }
partition 24 timeslots 24 interface-type dc;
partition 1-23 timeslots 1-23 interface-type bc;

[edit]

Meaning Verify that the output shows your intended ISDN PRI interface configuration.

Related Topics For more information about the format of a configuration file, see the J-Web Interface
User Guide or the Junos CLI User Guide.

To additionally verify ISDN PRI configuration, see Verifying the ISDN Configuration
on page 343.

Frequently Asked Questions About Channelized T1/E1/ISDN PRI Interfaces

Use answers to the following question to solve configuration problems on a
channelized T1/E1/ISDN PRI interface:

■ What Clock Combinations Are Possible for Channelized T1/E1/ISDN PRI Drop
and Insert? on page 131
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What Clock Combinations Are Possible for Channelized T1/E1/ISDN PRI Drop and Insert?

When you configure the drop-and-insert feature on a channelized T1/E1/ISDN PRI
PIM, you must ensure that both ports run on the same clock. The following clock
combinations are valid:

■ When port 0 is configured to use the internal clock, port 1 must also be configured
to use the internal clock.

■ When port 0 is configured to use the external clock, port 1 must be configured
to run on the same clock, the external clock for port 0.

■ When port 1 is configured to use the external clock, port 0 must be configured
to run on the same clock, the external clock for port 1.

J Series devices connected to one another must have complementary clock sources
configured. Consider a scenario where Device R1 is connected to Devices R2 and
R3. Port 0 on the channelized T1/E1/ISDN PRI PIM of R1 is connected to R2, and
port 1 is connected to R3. The drop-and-insert feature is configured on R1 to insert
input coming from R2 on port 0 into port 1 for transmission to R3.

Devices R1, R2, and R3 can be configured in three ways, according to whether the
drop-and-insert clock source on R1 is the external clock for port 0, the external clock
for port 1, or the device's internal clock.

To configure the drop-and-insert interfaces on Device R1 to use the external clock
for port 0:

1. On Device R2, configure:

user@hostR2# set interfaces ct1-6/0/0 partition 1 timeslots 1-10
user@hostR2# set interfaces ct1-6/0/0 partition 1 interface-type ds
user@hostR2# set interfaces ds-6/0/0:1 unit 0 family inet address 10.46.46.1/30

2. On Device R3, configure:

user@hostR3# set interfaces ct1-3/0/0 clocking external
user@hostR3# set interfaces ct1-3/0/0 partition 1 timeslots 1-10
user@hostR3# set interfaces ct1-3/0/0 partition 1 interface-type ds
user@hostR3# set interfaces ds-3/0/0:1 unit 0 family inet address 10.46.46.2/30

3. On Device R1, configure:

user@hostR1# set interfaces ct1-3/0/0 clocking external
user@hostR1# set interfaces ct1-3/0/0 partition 1 timeslots 1-10
user@hostR1# set interfaces ct1-3/0/0 partition 1 interface-type ds
user@hostR1# set interfaces ds-3/0/0:1 data-input interface ds-3/0/1:1
user@hostR1# set interfaces ct1-3/0/1 clocking external interface ct1-3/0/0
user@hostR1# set interfaces ct1-3/0/1 partition 1 timeslots 1-10
user@hostR1# set interfaces ct1-3/0/1 partition 1 interface-type ds

To configure the drop-and-insert interfaces on Device R1 to use the external clock
for port 1:

1. On Device R2, configure:

user@hostR2# set interfaces ct1-6/0/0 clocking external
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user@hostR2# set interfaces ct1-6/0/0 partition 1 timeslots 1-10
user@hostR2# set interfaces ct1-6/0/0 partition 1 interface-type ds
user@hostR2# set interfaces ds-6/0/0:1 unit 0 family inet address 10.46.46.1/30

2. On Device R3, configure:

user@hostR3# set interfaces ct1-3/0/0 partition 1 timeslots 1-10
user@hostR3# set interfaces ct1-3/0/0 partition 1 interface-type ds
user@hostR3# set interfaces ds-3/0/0:1 unit 0 family inet address 10.46.46.2/30

3. On Device R1, configure:

user@hostR1# set interfaces ct1-3/0/0 clocking external interface ct1-3/0/1
user@hostR1# set interfaces ct1-3/0/0 partition 1 timeslots 1-10
user@hostR1# set interfaces ct1-3/0/0 partition 1 interface-type ds
user@hostR1# set interfaces ds-3/0/0:1 data-input interface ds-3/0/1:1
user@hostR1# set interfaces ct1-3/0/1 clocking external
user@hostR1# set interfaces ct1-3/0/1 partition 1 timeslots 1-10
user@hostR1# set interfaces ct1-3/0/1 partition 1 interface-type ds

To configure the drop-and-insert interfaces on Device R1 to use the device's internal
clock:

1. On Device R2, configure:

user@hostR2# set interfaces ct1-6/0/0 clocking external
user@hostR2# set interfaces ct1-6/0/0 partition 1 timeslots 1-10
user@hostR2# set interfaces ct1-6/0/0 partition 1 interface-type ds
user@hostR2# set interfaces ds-6/0/0:1 unit 0 family inet address 10.46.46.1/30

2. On Device R3, configure:

user@hostR3# set interfaces ct1-3/0/0 clocking external
user@hostR3# set interfaces ct1-3/0/0 partition 1 timeslots 1-10
user@hostR3# set interfaces ct1-3/0/0 partition 1 interface-type ds
user@hostR3# set interfaces ds-3/0/0:1 unit 0 family inet address 10.46.46.2/30

3. On Device R1, configure:

user@hostR1# set interfaces ct1-3/0/0 clocking internal
user@hostR1# set interfaces ct1-3/0/0 partition 1 timeslots 1-10
user@hostR1# set interfaces ct1-3/0/0 partition 1 interface-type ds
user@hostR1# set interfaces ds-3/0/0:1 data-input interface ds-3/0/1:1
user@hostR1# set interfaces ct1-3/0/1 clocking internal
user@hostR1# set interfaces ct1-3/0/1 partition 1 timeslots 1-10
user@hostR1# set interfaces ct1-3/0/1 partition 1 interface-type ds
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Chapter 4

Configuring Digital Subscriber Line
Interfaces

The J Series and SRX210 devices support DSL features including ATM-over-ADSL and
ATM-over-SHDSL interfaces.

You can use either J-Web Quick Configuration or a configuration editor to configure
ATM-over-ADSL or ATM-over-SHDSL interfaces.

NOTE: Payload loopback functionality is not supported on ATM-over-SHDSL interfaces.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ DSL Terms on page 133

■ Before You Begin on page 135

■ Configuring ATM-over-ADSL Interfaces on page 135

■ Configuring ATM-over-SHDSL Interfaces on page 145

■ Configuring CHAP on DSL Interfaces (Optional) on page 155

■ Verifying DSL Interface Configuration on page 156

■ Configuring MLPPP over ADSL Interfaces on page 164

DSL Terms

Before configuring DSL on J Series or SRX210 devices, become familiar with the
terms defined in Table 34 on page 134.
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Table 34: DSL Terms

DefinitionTerm

Physical WAN interface for connecting a J Series device to a digital subscriber line access
multiplexer (DSLAM). An ADSL interface allocates line bandwidth asymmetrically with downstream
(provider-to-customer) data rates of up to 8 Mbps for ADSL, 12 Mbps for ADSL2, and 25 Mbps
for ADSL2+, and upstream (customer-to-provider) rates of up to 800 Kbps for ADSL and 1 Mbps
for ADSL2 and ADSL2+, depending on the implementation.

asymmetric digital
subscriber line (ADSL)
interface

An ADSL interface that supports ITU-T Standards G.992.3 and G.992.4 and allocates downstream
(provider-to-customer) data rates of up to 12 Mbps and upstream (customer-to-provider) rates
of up to 1 Mbps.

ADSL2 interface

An ADSL interface that supports ITU-T Standard G.992.5 and allocates downstream
(provider-to-customer) data rates of up to 25 Mbps and upstream (customer-to-provider) rates
of up to 1 Mbps.

ADSL2+ interface

ITU-T Standard G.992.1 that defines how ADSL works over plain old telephone service (POTS)
lines.

Annex A

ITU-T Standard G.992.1 that defines how ADSL works over Integrated Services Digital Network
(ISDN) lines.

Annex B

ITU-DMT-BIS Standard G.992.3 and ADSL2PLUS Standard G.992.5 that extends the capability
of basic ADSL2 by doubling the number of upstream bits.

Annex M

International Telecommunication Union standard describing a data transmission method for
symmetric high-speed digital subscriber line (SHDSL) as a means for data transport in
telecommunications access networks. The standard also describes the functionality required for
interoperability of equipment from various manufacturers.

ITU-T G.991.2

International Telecommunication Union standard that requires the downstream
(provider-to-customer) data transmission to consist of full-duplex low-speed bearer channels and
simplex high-speed bearer channels. In the upstream (customer-to-provider) transmissions, only
low-speed bearer channels are provided.

ITU-T G.992.1

International Telecommunication Union standard describing the types of signals, messages, and
procedures exchanged between digital subscriber line (DSL) equipment when the operational
modes of equipment need to be automatically established and selected.

ITU-T G.994.1

International Telecommunication Union standard describing the physical layer management for
asymmetric digital subscriber line (ADSL) transmission systems. The standard specifies the
means of communication on a transport transmission channel defined in the physical layer
recommendations. In addition, the standard describes the content and syntax of network elements
for configuration, fault management, and performance management.

ITU-T G.997.1

Physical WAN symmetric DSL interface capable of sending and receiving high-speed symmetrical
data streams over a single pair of copper wires at rates between 192 Kbps and 2.31 Mbps.
G.SHDSL incorporates features of other DSL technologies such as asymmetric DSL and transports
T1, E1, ISDN, Asynchronous Transfer Mode (ATM), and IP signals.

symmetric high-speed
digital subscriber line
(G.SHDSL)

Equipment that provides symmetric high-speed digital subscriber line (SHDSL) connections to
remote user terminals such as data terminals or telecommunications equipment.

symmetric high-speed
digital subscriber line
(SHDSL) transceiver
unit–remote (STU–R)
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Before You Begin

Before you begin configuring DSL interfaces, complete the following tasks:

■ Establish basic connectivity. See the Getting Started Guide for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

■ Configure network interfaces as necessary. See “Configuring Ethernet, DS1, DS3,
and Serial Interfaces” on page 81.

Configuring ATM-over-ADSL Interfaces

J Series devices with ADSL Annex A or Annex B PIMs can use an Asynchronous
Transfer Mode (ATM) interface to send network traffic through a point-to-point
connection to a DSL access multiplexer (DSLAM).

NOTE: You can configure J Series devices with ADSL PIMs for connections through
ADSL only, not for direct ATM connections.

To configure Point-to-Point Protocol (PPP), see the Junos Network Interfaces
Configuration Guide.

You configure the underlying ADSL interface as an ATM interface, with an interface
name of at-pim/0/port. (For information about interface names, see “Network Interface
Naming” on page 9.) Multiple encapsulation types are supported on both the physical
and logical ATM-over-ADSL interface.

This section contains the following topics:

■ Configuring an ATM-over-ADSL Interface with Quick Configuration on page 135

■ Adding an ATM-over-ADSL Network Interface with a Configuration
Editor on page 140

Configuring an ATM-over-ADSL Interface with Quick Configuration

The Quick Configuration pages allow you to configure ATM-over-ADSL interfaces on
J Series devices.

To configure an ATM-over-ADSL interface with Quick Configuration:

1. In the J-Web user interface, select Configure>Interfaces.

A list of the network interfaces present on the device is displayed. (See “Network
Interface Naming” on page 9.)

2. Select the at-pim/0/port interface name for the ADSL port you want to configure.
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The ATM-over-ADSL Quick Configuration page is displayed, as shown in Figure
24 on page 136.

Figure 24: ATM-over-ADSL Interfaces Quick Configuration Page

3. Enter information into the ATM-over-ADSL Quick Configuration pages, as
described in Table 35 on page 136.

4. From the ATM-over-ADSL Quick Configuration main page, click one of the
following buttons:

■ To apply the configuration and stay on the ATM-over-ADSL Quick
Configuration main page, click Apply.

■ To apply the configuration and return to the Interfaces Quick Configuration
page, click OK.

■ To cancel your entries and return to the Interfaces Quick Configuration page,
click Cancel.

5. To verify that the ATM-over-ADSL interface is configured properly, see “Verifying
DSL Interface Configuration” on page 156.

Table 35: ATM-over-ADSL Interface Quick Configuration Pages Summary

Your ActionFunctionField

Configuring Logical Interfaces

■ To add a logical interface, click Add.

■ To edit a logical interface, select the
interface from the list.

■ To delete a logical interface, select the
check box next to the name and click
Delete.

Lists the logical interfaces for this
ATM-over-ADSL physical interface.

Logical Interfaces

Adding or Editing a Logical Interface

Click Add.Defines one or more logical units that you
connect to this physical ADSL interface.

Add logical interfaces
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Table 35: ATM-over-ADSL Interface Quick Configuration Pages Summary (continued)

Your ActionFunctionField

Type a text description of the logical interface
to more clearly identify it in monitoring
displays.

(Optional) Describes the logical interface.Logical Interface
Description

From the list, select one of the following types
of encapsulations.

For ATM-over-ADSL interfaces that use inet
(IPv4) protocols only, select one of the
following:

■ ATM VC multiplexing—Use ATM virtual
circuit multiplex encapsulation.

■ ATM NLPID—Use ATM network layer
protocol identifier (NLPID) encapsulation.

■ Cisco-compatible ATM NLPID—Use Cisco
NLPID encapsulation.

■ Ethernet over ATM (LLC/SNAP)—For
interfaces that carry IPv4 traffic, use
Ethernet over logical link control (LLC)
encapsulation. You cannot configure
multipoint interfaces if you use this type
of encapsulation.

For ATM-over-ADSL for PPP-over-ATM (PPPoA)
interfaces only, select one of the following:

■ ATM PPP over AAL5/LLC—Use AAL5
logical link control (LLC) encapsulation.

■ ATM PPP over Raw AAL5—Use AAL5
multiplex encapsulation.

For other encapsulation types on the
ATM-over-ADSL interfaces, select one of the
following:

■ PPPoE over ATM (LLC/SNAP)—Use PPP
over Ethernet over ATM LLC
encapsulation. When you use this
encapsulation type, you cannot configure
the interface address. Instead you
configure the interface address on the PPP
interface.

■ Ethernet over ATM (LLC/SNAP)—Use
ATM subnetwork attachment point (SNAP)
encapsulation.

Specifies the type of encapsulation on the DSL
logical interface.

Encapsulation

In the VCI box, type the number for the VCI.Configures the ATM virtual circuit identifier
(VCI) for the interface.

VCI

Click Add.Specifies one or more IPv4 addresses and
destination addresses.

Add IPv4 address prefixes
and destinations
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Table 35: ATM-over-ADSL Interface Quick Configuration Pages Summary (continued)

Your ActionFunctionField

Type an IPv4 address and prefix. For example:

10.10.10.10/24

Specifies an IPv4 address for the interface.IPv4 Address Prefix

1. Type an IPv4 address for the destination.

2. Click OK.

Specifies the destination address.Destination Address

Configuring Physical Interface Properties

Type a text description of the physical
ATM-over-ADSL interface to more clearly
identify it in monitoring displays. Specify that
it is an ADSL interface.

(Optional) Adds supplementary information
about the physical ATM-over-ADSL interface.

Physical Interface
Description

Type a value from 256 to 9192.Specifies the maximum transmit size of a
packet for the ATM-over-ADSL interface.

MTU (bytes)

From the list, select the type of encapsulation
for this ATM-over-ADSL interface:

■ ATM permanent virtual circuits—Use
this type of encapsulation for PPP over
ATM (PPPoA) over ADSL interfaces. This
is the default encapsulation for
ATM-over-ADSL interfaces.

■ Ethernet over ATM encapsulation—Use
this type of encapsulation for PPP over
Ethernet (PPPoE) over ATM-over-ADSL
interfaces that carry IPv4 traffic.

Selects the type of encapsulation for traffic on
this physical interface.

Encapsulation

Type a VPI value between 0 and 255.Configures the ATM virtual path identifier for
the interface.

VPI

Configuring ADSL Options
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Table 35: ATM-over-ADSL Interface Quick Configuration Pages Summary (continued)

Your ActionFunctionField

From the list, select one of the following types
of DSL operating modes—for example auto.

For Annex A or Annex B, or Annex M
(applicable to SRX210 devices), select one of
the following:

■ auto—Configure the ADSL interface to
auto negotiate settings with the DSLAM
located at the central office.

For Annex A, the ADSL interface trains in
either ANSI T1.413 Issue II mode or ITU
G.992.1 mode.

For Annex B, the ADSL interface trains in
ITU G.992.1 mode.

For Annex M, the ADSL interface trains in
ITU G.992.3 mode (applicable to SRX210
devices).

■ itu-dmt-bis—Configure the ADSL interface
to train in ITU G.992.3 mode. The ADSL
interface trains in ITU G.992.5 mode.

■ adsl2plus—Configure the ADSL interface
to train in ITU G.992.5 mode. You can
configure this mode only when it is
supported on the DSLAM.

For Annex A and Annex B, select the following:

■ itu-dmt—Configure the ADSL interface to
train in ITU G.992.1 mode.

■ adsl2plus—Configure the ADSL interface
to train in ITU G.992.5 mode. You can
configure this mode only when it is
supported on the DSLAM.

■ itu-dmt-bis—Configure the ADSL interface
to train in ITU G.992.3 mode. The ADSL
interface trains in ITU G.992.5 mode.

For Annex A only, select the following:

■ ansi-dmt—Configure the ADSL interface
to train in the ANSI T1.413 Issue II mode.

For Annex B only, select the following:

■ itu-annexb-ur2—Configure the ADSL line
to train in the G.992.1 Deutsche Telekom
UR-2 mode.

Specifies the type of DSL operating mode for
the ATM-over-ADSL interface.

Operating Mode
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Adding an ATM-over-ADSL Network Interface with a Configuration Editor

To configure ATM-over-ADSL network interfaces for the J Series device with a
configuration editor:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 36 on page 140.

3. If you are finished configuring the J Series device, commit the configuration.

4. Go on to one of the following procedures:

■ To enable authentication on the interface, see “Configuring CHAP on DSL
Interfaces (Optional)” on page 155.

■ To configure PPP over Ethernet (PPPoE) encapsulation on an Ethernet
interface or on an ATM-over-ADSL interface, see “Configuring Point-to-Point
Protocol over Ethernet” on page 289.

5. To check the configuration, see “Verifying DSL Interface Configuration” on
page 156.

Table 36: Adding an ATM-over-ADSL Network Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

edit interfaces at-2/0/0

1. In the J-Web interface,
select Configure>CLI
Tools>Point and Click
CLI.

2. Next to Interfaces, click
Edit.

Navigate to the  Interfaces level in the configuration
hierarchy.

1. Next to Interface, click
Add new entry.

2. In the Interface name
box, type at-2/0/0.

3. Click OK.

Create the new interface—for example, at-2/0/0.

Configuring Physical Properties
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Table 36: Adding an ATM-over-ADSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. To configure the VPI value,
enter

set atm-options vpi 25

2. To configure OAM liveness
values on a VPI, enter

set atm-options vpi 25
oam-liveness up-count 200
down-count 200

3. To configure the OAM
period, enter

set atm-options vpi 25
oam-period 100

4. To configure the CBR
value, enter

set interfaces at-1/0/0 unit
0 shaping cbr

5. To configure the VBR
value, enter

set interfaces at-1/0/0 unit
0 shaping vbr

Configure ATM virtual path identifier (VPI) options for the
interface—for example, at-2/0/0.

■ ATM VPI—A number between 0 and 255—for
example, 25.

■ Operation, Maintenance, and Administration (OAM)
F5 loopback cell thresholds (“liveness”) on ATM virtual
circuits. The range is between 1 and 255, and the
default is 5 cells.

■ Down count—Number of consecutive OAM
loopback cells an ATM virtual circuit must lose
to be identified as unavailable—for example,
200.

■ Up count—Number of consecutive OAM loopback
cells an ATM virtual interface must receive to be
identified as operational—for example, 200.

■ OAM period—Interval, in seconds, at which OAM cells
are transmitted on ATM virtual circuits—for example,
100. The range is between 1 and 900 seconds.

■ Configure CBR for the Interface—for example,
at-1/0/0.

■ CBR – Range from 33000 through 1199920

■ CDVT – Range from 1 through 9999

NOTE: CDVT is not supported on J Series devices.

■ Configure Vbr for the Interface—for example, at-1/0/0.

■ MBS – Range from 33000 through 1199920

■ CDVT – Range from 1 through 9999

■ PCR – Range from 33000 through 1199920

■ SCR – Range from 33000 through 1199920
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Table 36: Adding an ATM-over-ADSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. In the Interface name
box, select at-2/0/0.

2. Next to Atm options, click
Configure.

3. Next to Vpi, click Add
new entry.

4. In the Vpi number box,
type 25.

5. Click OK.

6. In the Actions box, click
Edit.

7. Next to Oam liveness,
click  Configure.

8. In the Down count box,
type 200.

9. In the Up count box, type
200.

10. Click OK.

11. Next to Oam period, click
Configure.

12. From the Oam period
choices list, select Oam
period.

13. In the Oam period box,
type 100.

14. Click OK until you return
to the Interface page.

15. Next to Shaping, click
Configure.

16. In the Queue length box,
type 200.

17. From the Useless Shaping
Choice list, select Cbr.

18. In the Cbr value box, type
33000.

19. In the Cdvt box, type 200,
Click OK.

20. From the Useless Shaping
Choice list, select Vbr.

21. In the Burst box, type
33000.

22. In the Cdvt box, type 200.

23. In the Peak box, type
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Table 36: Adding an ATM-over-ADSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

33000.

24. In the Sustained box, type
33000.

25. Click OK.

Enter

set dsl-options operating-mode
auto

1. Next to Dsl options, click
Configure.

2. From the Operating Mode
list, select auto.

3. Click OK.

Configure the type of DSL operating mode for the
ATM-over-ADSL interface—for example auto.

Annex A and Annex B support the following operating
modes:

■ auto—Configures the ADSL interface to autonegotiate
settings with the DSLAM located at the central office.
For Annex A, the ADSL interface trains in either
ANSI T1.413 Issue II mode or ITU G.992.1 mode. For
Annex B, the ADSL interface trains in ITU G.992.1
mode.

■ itu-dmt—Configures the ADSL interface to train in ITU
G.992.1 mode.

Annex A supports the following operating modes:

■ adsl2plus—Configures the ADSL interface to train in
ITU G.992.5 mode. You can configure this mode only
when it is supported on the DSLAM.

■ itu-dmt-bis—Configures the ADSL interface to train in
ITU G.992.3 mode. You can configure this mode only
when it is supported on the DSLAM.

■ ansi-dmt—Configures the ADSL interface to train in
the ANSI T1.413 Issue II mode.

Annex B supports the following operating modes:

■ etsi—Configures the ADSL line to train in the ETSI TS
101 388 V1.3.1 mode.

■ itu-annexb-ur2—Configures the ADSL line to train in
the G.992.1 Deutsche Telekom UR-2 mode.

■ itu-annexb-non-ur2—Configures the ADSL line to train
in the G.992.1 Non-UR-2 mode.

Enter

set encapsulation
ethernet-over-atm

From the Encapsulation list,
select ethernet-over-atm.

Configure the encapsulation type—for example,
ethernet-over-atm.

■ atm-pvc—ATM permanent virtual circuits is the default
encapsulation for ATM-over-ADSL interfaces.

For PPP over ATM (PPPoA) over ADSL interfaces, use
this type of encapsulation.

■ ethernet-over-atm—Ethernet over ATM encapsulation.

For PPP over Ethernet (PPPoE) over ATM-over-ADSL
interfaces that carry IPv4 traffic, use this type of
encapsulation.
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Table 36: Adding an ATM-over-ADSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Configuring Logical Properties

Enter

set unit 3

1. Scroll down the page to
Unit, and click Add new
entry.

2. In the Interface unit
number box, type 3.

3. Enter other values in the
fields required by your
network.

Add the logical interface.

Set a value from 0 and 16385—for example, 3.

Add other values if required by your network.

Enter

set unit 3 encapsulation
atm-nlpid

From the Encapsulation list,
select atm-nlpid.

Configure encapsulation for the ATM-for-ADSL logical
unit—for example, atm-nlpid.

The following encapsulations are supported on the
ATM-over-ADSL interfaces that use inet (IP) protocols only:

■ atm-vc-mux–Use ATM virtual circuit multiplex
encapsulation.

■ atm-nlpid–Use ATM network layer protocol identifier
(NLPID) encapsulation.

■ atm-cisco-nlpid–Use Cisco NLPID encapsulation.

■ ether-over-atm-llc–For interfaces that carry IPv4 traffic,
use Ethernet over LLC encapsulation. You cannot
configure multipoint interfaces if you use this type of
encapsulation.

The following encapsulations are supported on the
ATM-over-ADSL for PPP-over-ATM (PPPoA) interfaces only.
(For a sample PPPoA configuration, see “Verifying Interface
Configuration” on page 113.)

■ atm-ppp-llc— AAL5 logical link control (LLC)
encapsulation.

■ atm-ppp-vc-mux—Use AAL5 multiplex encapsulation.

Other encapsulation types supported on the
ATM-over-ADSL interfaces:

■ ppp-over-ether-over-atm-llc—Use PPP over Ethernet over
ATM LLC encapsulation. When you use this
encapsulation type, you cannot configure the interface
address. Instead you configure the interface address
on the PPP interface.

■ atm-snap—Use ATM subnetwork attachment point
(SNAP) encapsulation.

144 ■ Configuring ATM-over-ADSL Interfaces

JUNOS Software Interfaces and Routing Configuration Guide



Table 36: Adding an ATM-over-ADSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. To configure OAM liveness
values for an ATM virtual
circuit, enter

set unit 3 oam-liveness
up-count 200 down-count
200

2. To configure the OAM
period, enter

set unit 3 oam-period 100

1. Next to Oam liveness,
click  Configure.

2. In the Down count box,
type 200.

3. In the Up count box, type
200.

4. Click OK.

5. Next to Oam period, click
Configure.

6. From the Oam period
choices list, select Oam
period.

7. In the Oam period box,
type 100.

8. Click OK.

Configure Operation, Maintenance, and Administration
(OAM) options for ATM virtual circuits:

■ OAM F5 loopback cell thresholds (“liveness”) on ATM
virtual circuits. The range is between 1 and 255, and
the default is 5 cells.

■ Down count—Number of consecutive OAM
loopback cells an ATM virtual circuit must lose
to be identified as unavailable—for example,
200.

■ Up count—Number of consecutive OAM loopback
cells an ATM virtual interface must receive to be
identified as operational—for example, 200.

■ OAM period—Interval, in seconds, at which OAM cells
are transmitted on ATM virtual circuits—for example,
100. The range is between 1 and 900 seconds.

Enter

set unit 3 family inet

Commands vary depending on
the protocol type.

1. In the Inet box, select Yes
and click Configure.

2. Enter the values in the
fields required by your
network.

3. Click OK.

Add the Family protocol type—for example, inet.

1. To configure the VCI value,
enter

set unit 3 vci 35

1. From the Vci Type list,
select vci.

2. In the Vci box, type 35.

3. Click OK until you return
to the Interfaces page.

Configure ATM virtual channel identifier (VCI) options for
the interface.

■ ATM VCI type—vci.

■ ATM VCI value—A number between 0 and 4089—for
example, 35— with VCIs 0 through 31 reserved.

Configuring ATM-over-SHDSL Interfaces

J Series devices with G.SHDSL interfaces can use an Asynchronous Transfer Mode
(ATM) interface to send network traffic through a point-to-point connection to a DSL
access multiplexer (DSLAM).

NOTE: You can configure J Series devices with a G.SHDSL interface for connections
through SHDSL only, not for direct ATM connections.
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J Series devices with a 2-port G.SHDSL interface installed support the following modes.
You can configure only one mode on each interface.

■ 2-port two-wire mode (Annex A or Annex B)—Supports autodetection of the line
rate or fixed line rates and provides network speeds from 192 Kbps to 2.3 Mbps
in 64-Kbps increments. Two-wire mode provides two separate, slower SHDSL
interfaces.

■ 1-port four-wire mode (Annex A or Annex B)—Supports fixed line rates only and
provides network speeds from 384 Kbps to 4.6 Mbps in 128-Kbps increments,
doubling the bandwidth. Four-wire mode provides a single, faster SHDSL interface.

To configure Point-to-Point Protocol (PPP), see the Junos Network Interfaces
Configuration Guide.

You configure the underlying G.SHDSL interface as an ATM interface, with an interface
name of at-pim/0/port. (See “Network Interface Naming” on page 9.) Multiple
encapsulation types are supported on both the physical and logical ATM-over-SHDSL
interface.

This section contains the following topics:

■ Configuring an ATM-over-SHDSL Interface with Quick Configuration on page 146

■ Adding an ATM-over-SHDSL Interface with a Configuration Editor on page 150

Configuring an ATM-over-SHDSL Interface with Quick Configuration

The ATM-over-SHDSL Quick Configuration pages allow you to configure
ATM-over-SHDSL interfaces and SHDSL options.

To configure an ATM-over-SHDSL interface with Quick Configuration:

1. In the J-Web interface, select Configure>Interfaces.

A list of the network interfaces installed on the device is displayed. (See “Network
Interface Naming” on page 9.)

2. Select an at-pim/0/port interface from the list.

The ATM-over-SHDSL Interface Quick Configuration page is displayed, as shown
in Figure 25 on page 147.
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Figure 25: ATM-over-SHDSL Interfaces Quick Configuration Main Page

3. Enter information into the ATM-over-SHDSL Quick Configuration page, as
described in Table 37 on page 147.

4. From the ATM-over-SHDSL Quick Configuration main page, click one of the
following buttons:

■ To apply the configuration and stay in the ATM-over-SHDSL interface Quick
Configuration main page, click Apply.

■ To apply the configuration and return to the Interfaces Quick Configuration
page, click OK.

■ To cancel your entries and return to the Interfaces Quick Configuration page,
click Cancel.

5. To verify the ATM-over-SHDSL interface properties, see “Verifying DSL Interface
Configuration” on page 156.

Table 37: ATM-over-SHDSL Interface Quick Configuration Pages Summary

Your ActionFunctionField

Configuring Logical Interfaces
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Table 37: ATM-over-SHDSL Interface Quick Configuration Pages Summary (continued)

Your ActionFunctionField

If you have not added an at-pim/0/port interface,
click Add and enter the information required in the
Interfaces Quick Configuration fields.

If you have already configured a logical interface,
select the interface name from the Logical Interface
Name list.

To delete a logical interface, select the interface and
click Delete.

Lists the logical interfaces for the
ATM-over-SHDSL physical interface.

Logical Interface Name

Adding or Editing a Logical Interface

Click Add.Defines one or more logical units that you
connect to this physical ADSL interface.

Add logical interfaces

Type a text description of the logical interface to
clearly identify it in monitoring displays.

(Optional) Describes the logical interface.Logical Interface
Description

From the list, select one of the following types of
encapsulations.

For ATM-over-SHDSL interfaces that use inet (IPv4)
protocols only, select one of the following:

■ Cisco-compatible ATM NLPID—Use Cisco
NLPID encapsulation.

■ ATM NLPID—Use ATM network layer protocol
identifier (NLPID) encapsulation.

■ ATM PPP over AA5/LLC—Use AAL5 logical link
control (LLC) encapsulation.

■ ATM PPP over raw AAL5—Use AAL5 multiplex
encapsulation.

■ ATM LLC/SNAP—For interfaces that carry IPv4
traffic, use ATM over logical link control (LLC)
encapsulation. You cannot configure multipoint
interfaces if you use this type of encapsulation.

■ ATM VC multiplexing—Use ATM virtual circuit
multiplex encapsulation.

For other encapsulation types on the
ATM-over-SHDSL interfaces, select one of the
following:

■ Ethernet over ATM (LLC/SNAP)—Use ATM
subnetwork attachment point (SNAP)
encapsulation.

■ PPPoE over ATM (LLC/SNAP)—Use PPP over
Ethernet over ATM LLC encapsulation. When
you use this encapsulation type, you cannot
configure the interface address. Instead you
configure the interface address on the PPP
interface.

Specifies the type of encapsulation on the
SHDSL logical interface.

Encapsulation
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Table 37: ATM-over-SHDSL Interface Quick Configuration Pages Summary (continued)

Your ActionFunctionField

In the VCI box, type the number for the VCI.Configures the ATM virtual circuit
identifier (VCI) for the interface.

VCI

Click Add.Specifies one or more IPv4 addresses and
destination addresses.

Add IPv4 address prefixes
and destinations

Type an IPv4 address and prefix. For example:

10.10.10.10/24

Specifies an IPv4 address for the interface.IPv4 Address Prefix

1. Type an IPv4 address for the destination.

2. Click OK.

Specifies the destination address.Destination Address

Configuring Physical Properties

Type a description of the interface.Describes the physical interface
description information. (Optional)

Physical Interface
Description

Type a value for the byte size—for example, 1500.Specifies the maximum transmission unit
(MTU) size, in bytes, of a packet on the
ATM-over-SHDSL interface.

MTU (bytes)

Select one of the following types of encapsulation:

■ ATM permanent virtual circuits—Use this type
of encapsulation for PPP over ATM (PPPoA)
over SHDSL interfaces. This is the default
encapsulation for ATM-over-SHDSL interfaces.

■ Ethernet over ATM encapsulation—Use this
type of encapsulation for PPP over Ethernet
(PPPoE) over ATM-over-SHDSL interfaces that
carry IPv4 traffic.

Selects the type of encapsulation for traffic
on the physical interface.

Encapsulation

In the VPI field, type a number between 0 and
255—for example, 25.

Configures the ATM virtual path identifier
(VPI) for the interface.

VPI

Configuring SHDSL Options

Select either of the following:

■ 1-port-atm—1-port four-wire mode

■ 2-port-atm—2-port two-wire mode

Specifies the mode on the
ATM-over-SHDSL interface.

PIC Mode

Select one of the following:

■ Annex A—Used in North American network
implementations.

■ Annex B—Used in European network
implementations.

Specifies the type of annex for the
interface.

Annex defines the System Reference
Model for connecting DSL networks to the
plain old telephone service (POTS).

Annex

Select the appropriate value.

For 2-port-atm mode only, you can select auto,
which automatically selects a line rate.

Specifies the available line rates, in kilobits
per second, to use on an G.SHDSL
interface.

Line Rate
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Table 37: ATM-over-SHDSL Interface Quick Configuration Pages Summary (continued)

Your ActionFunctionField

Select one of the following:

■ local—Used for testing the SHDSL equipment
with local network devices.

■ payload—Used to command the remote
configuration to send back the received
payload.

■ remote—Used to test SHDSL with a remote
network configuration.

Specifies the type of loopback testing for
the interface.

Loopback testing is a diagnostic procedure
in which a signal is transmitted and
returned to the sending device after
passing through all or a portion of a
network or circuit. The returned signal is
compared with the transmitted signal in
order to evaluate the integrity of the
equipment or transmission path. TEST

Loopback

To disable Current SNR Margin, select Disable.

To configure a specific value, type a number from
0 to 10—for example, 5.

The range is 0 dB to 10 dB with a default value of
0.

Specifies the signal-to-noise ratio (SNR)
margin or disables SNR.

Current SNR Margin

Disable

Value

To disable SNEXT SNR Margin, select Disable.

To configure a specific value, type a number from
–10 to 10—for example, 5.

Sets a value, from –10 dB to 10 dB, for
the self-near-crosstalk (SNEXT) SNR
margin, or disables SNEXT.

SNEXT SNR Margin

Disable

Value

Adding an ATM-over-SHDSL Interface with a Configuration Editor

To configure ATM-over-SHDSL network interfaces for the J Series device with a
configuration editor:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 38 on page 151.

3. If you are finished configuring the J Series device, commit the configuration.

4. Go on to one of the following procedures:

■ To enable authentication on the interface, see “Configuring CHAP on DSL
Interfaces (Optional)” on page 155.

■ To configure PPP over Ethernet (PPPoE) encapsulation on an Ethernet
interface or on an ATM-over-SHDSL interface, see “Configuring Point-to-Point
Protocol over Ethernet” on page 289.

5. To check the configuration, see “Verifying DSL Interface Configuration” on
page 156.

150 ■ Configuring ATM-over-SHDSL Interfaces

JUNOS Software Interfaces and Routing Configuration Guide



Table 38: Adding an ATM-over-SHDSL Network Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

set chassis fpc 6 pic 0 shdsl
pic-mode 1-port-atm

1. In the J-Web interface,
select Configure>CLI
Tools>Point and Click
CLI.

2. Next to Chassis, click
Configure.

Navigate to the Chassis level in the configuration hierarchy.

1. Next to Fpc, click Add
new entry.

2. In the Slot box, type 6.

3. Next to Pic, click Add new
entry.

4. In the Slot box, type 0.

5. Next to Shdsl, click
Configure.

6. From the Pic mode menu,
select 1-port-atm.

7. Click OK until you return
to the main Configuration
page.

Set the ATM-over-SHDSL mode on the G.SHDSL interface,
if required. By default, G.SHDSL interfaces are enabled in
two-wire Annex B mode. To configure the four-wire mode
on the G.SHDSL interface, follow the tasks in this table.

From the [edit] hierarchy level,
enter

edit interfaces at-2/0/0

On the main Configuration
page next to Interfaces, click
Edit.

Navigate to the  Interfaces level in the configuration
hierarchy.

1. Next to Interface, click
Add new entry.

2. In the Interface name box,
type at-2/0/0.

3. Click OK.

Create the new interface—for example, at-2/0/0.

Configuring Physical Properties
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Table 38: Adding an ATM-over-SHDSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. To configure the VPI
value, enter

set atm-options vpi 25

2. To configure OAM liveness
values on a VPI, enter

set atm-options vpi 25
oam-liveness up-count 200
down-count 200

3. To configure the OAM
period, enter

set atm-options vpi 25
oam-period 100

1. In the Interface name box,
select at-2/0/0.

2. Next to Atm options, click
Configure.

3. Next to Vpi, click Add
new entry.

4. In the Vpi number box,
type 25.

5. Click OK.

6. In the Actions box, click
Edit.

7. Next to Oam liveness,
click  Configure.

8. In the Down count box,
type 200.

9. In the Up count box, type
200.

10. Click OK.

11. Next to Oam period, click
Configure.

12. From the Oam period
choices list, select Oam
period.

13. In the Oam period box,
type 100.

14. Click OK until you return
to the Interface page.

Configure ATM virtual path identifier (VPI) options for the
interface—for example, at-2/0/0.

■ ATM VPI—A number between 0 and 255—for
example, 25.

■ Operation, Maintenance, and Administration (OAM)
F5 loopback cell thresholds (“liveness”) on ATM virtual
circuits. The range is between 1 and 255, and the
default is 5 cells.

■ Down count—Number of consecutive OAM
loopback cells an ATM virtual circuit must lose
to be identified as unavailable—for example,
200.

■ Up count—Number of consecutive OAM loopback
cells an ATM virtual interface must receive to be
identified as operational—for example, 200.

■ OAM period—Interval, in seconds, at which OAM cells
are transmitted on ATM virtual circuits—for example,
100. The range is between 1 and 900 seconds.

Enter

set encapsulation
ethernet-over-atm

From the Encapsulation list,
select ethernet-over-atm.

Configure the encapsulation type—for example,
ethernet-over-atm.

■ atm-pvc—ATM permanent virtual circuits is the default
encapsulation for ATM-over-SHDSL interfaces.

For PPP over ATM (PPPoA) over SHDSL interfaces,
use this type of encapsulation.

■ ethernet-over-atm—Ethernet over ATM encapsulation.

For PPP over Ethernet (PPPoE) over ATM-over-SHDSL
interfaces that carry IPv4 traffic, use this type of
encapsulation.

Enter

set shdsl-options annex annex-a

1. Next to Shdsl options,
click Configure.

2. From the Annex list,
select Annex-a.

Set the annex type.

■ Annex A—Used in North American network
implementations.

■ Annex B—Used in European network
implementations.
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Table 38: Adding an ATM-over-SHDSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set shdsl-options line-rate auto

From the Line Rate list, select
auto.

Configure the SHDSL line rate for the ATM-over-SHDSL
interface–for example, automatic selection of the line rate.

The following values are available:

■ auto—Automatically selects a line rate. This option is
available only in two-wire mode and is the default
value.

■ 192 Kbps or higher—Speed of transmission of data
on the SHDSL connection.

In the four-wire mode, the default line rate is 4608 Kbps.

Enter

set shdsl-options loopback local

From the Loopback list, select
local.

Configure the loopback option for testing the SHDSL
connection integrity–for example, local loopback.

The following values are available:

■ local—Used for testing the SHDSL equipment with
local network devices.

■ payload—Used to command the remote configuration
to send back the received payload.

■ remote—Used to test SHDSL with a remote network
configuration.

1. Enter

set shdsl-options snr-margin
current 5

2. Enter

set shdsl-options snr-margin
snext 5

1. Next to Snr margin, select
Yes, then click Configure.

2. From the Current list,
select Enter Specific
Value.

3. In the Value box, type 5.

4. From the Snext list, select
Enter Specific Value.

5. In the Value box, type 5.

6. Click OK until you return
to the Interface page.

Configure the signal-to-noise ratio (SNR) margin—for
example, 5 dB for either or both of the following thresholds:

■ current—Line trains at higher than current noise
margin plus SNR threshold. The range is 0 to 10 dB.
The default value is 0.

■ snext—Line trains at higher than self-near-end
crosstalk (SNEXT) threshold. The default value is
disabled.

Setting the SNR creates a more stable SHDSL connection
by making the line train at a SNR margin higher than the
threshold. If any external noise below the threshold is
applied to the line, the line remains stable. You can also
disable the SNR margin thresholds.

Configuring Logical Properties

Enter

set unit 3

1. Scroll down the page to
Unit, and click Add new
entry.

2. In the Interface unit
number box, type 3.

3. Enter other values in the
fields required by your
network.

Add the logical interface.

Set a value from 0 and 16385—for example, 3.

Add other values if required by your network.
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Table 38: Adding an ATM-over-SHDSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set unit 3 encapsulation
atm-nlpid

From the Encapsulation list,
select atm-nlpid.

Configure encapsulation for the ATM-for-SHDSL logical
unit—for example, atm-nlpid.

The following encapsulations are supported on the
ATM-over-SHDSL interfaces that use inet (IP) protocols only:

■ atm-vc-mux—Use ATM virtual circuit multiplex
encapsulation.

■ atm-nlpid—Use ATM network layer protocol identifier
(NLPID) encapsulation.

■ atm-cisco-nlpid—Use Cisco NLPID encapsulation.

■ ether-over-atm-llc—For interfaces that carry IPv4 traffic,
use Ethernet over LLC encapsulation. You cannot
configure multipoint interfaces if you use this type of
encapsulation.

The following encapsulations are supported on the
ATM-over-SHDSL for PPP-over-ATM (PPPoA) interfaces
only. (For a sample PPPoA configuration, see “Verifying
Interface Configuration” on page 113.)

■ atm-ppp-llc—AAL5 logical link control (LLC)
encapsulation.

■ atm-ppp-vc-mux—Use AAL5 multiplex encapsulation.

Other encapsulation types supported on the
ATM-over-SHDSL interfaces:

■ ppp-over-ether-over-atm-llc—Use PPP over Ethernet over
ATM LLC encapsulation. When you use this
encapsulation type, you cannot configure the interface
address. Instead you configure the interface address
on the PPP interface.

■ atm-snap—Use ATM subnetwork attachment point
(SNAP) encapsulation.

1. To configure OAM liveness
values for an ATM virtual
circuit, enter

set unit 3 oam-liveness
up-count 200 down-count
200

2. To configure the OAM
period, enter

set unit 3 oam-period 100

1. Next to Oam liveness,
click  Configure.

2. In the Down count box,
type 200.

3. In the Up count box, type
200.

4. Click OK.

5. Next to Oam period, click
Configure.

6. From the Oam period
choices list, select Oam
period.

7. In the Oam period box,
type 100.

8. Click OK.

Configure Operation, Maintenance, and Administration
(OAM) options for ATM virtual circuits:

■ OAM F5 loopback cell thresholds (“liveness”) on ATM
virtual circuits. The range is between 1 and 255, and
the default is 5 cells.

■ Down count—Number of consecutive OAM
loopback cells an ATM virtual circuit must lose
to be identified as unavailable—for example,
200.

■ Up count—Number of consecutive OAM loopback
cells an ATM virtual interface must receive to be
identified as operational—for example, 200.

■ OAM period—Interval, in seconds, at which OAM cells
are transmitted on ATM virtual circuits—for example,
100. The range is between 1 and 900 seconds.
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Table 38: Adding an ATM-over-SHDSL Network Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set unit 3 family inet

Commands vary depending on
the protocol type.

1. In the Inet box, select Yes
and click Configure.

2. Enter the values in the
fields required by your
network.

3. Click OK.

Add the Family protocol type—for example, inet.

1. To configure the VCI
value, enter

set unit 3 vci 35

1. From the Vci type list,
select vci.

2. In the Vci box, type 35.

3. Click OK until you return
to the Interfaces page.

Configure ATM virtual channel identifier (VCI) options for
the interface.

■ ATM VCI type—vci.

■ ATM VCI value—A number between 0 and 4089—for
example, 35—with VCIs 0 through 31 reserved.

Configuring CHAP on DSL Interfaces (Optional)

For interfaces with PPPoA encapsulation, you can optionally configure interfaces to
support the PPP Challenge Handshake Authentication Protocol (CHAP). When you
enable CHAP on an interface, the interface can authenticate its peer and be
authenticated by its peer.

If you set the passive option to handle incoming CHAP packets only, the interface
does not challenge its peer. However, if the interface is challenged, it responds to
the challenge. If you do not set the passive option, the interface always challenges
its peer.

For more information about CHAP, see the Junos Network Interfaces Configuration
Guide.

To configure CHAP on the ATM-over-ADSL or ATM-over-SHDSL interface:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 39 on page 156.

3. If you are finished configuring the J Series device, commit the configuration.

4. To check the configuration, see “Verifying DSL Interface Configuration” on
page 156.
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Table 39: Configuring CHAP

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit access

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Access, click Configure or Edit.

Navigate to the Access
level in the configuration
hierarchy.

Enter

set profile A-ppp-client client client1
chap-secret my-secret.

1. Next to Profile, click Add new entry.

2. In the Profile name box, type A-ppp-client.

3. Next to Client, click Add new entry.

4. In the Name box, type client1.

5. In the Chap secret box, type my-secret.

6. Click OK until you return to the main
Configuration page.

Define a CHAP access
profile—for example,
A-ppp-client—with a client
named client 1 and the
secret (password)
my-secret.

From the [edit] hierarchy level, enter

edit interfaces at-3/0/0 unit 0

1. On the main Configuration page next to
Interfaces, click Configure or Edit.

2. In the Interface name box, click at-3/0/0.

3. Under Interface unit number box, click 0.

Navigate to the appropriate
ATM interface level in the
configuration
hierarchy—for example,
at-3/0/0 unit 0.

Enter

set ppp-options chap access-profile A-ppp-client

1. Next to Ppp options, click Configure.

2. Next to Chap, click Configure.

3. In the Access profile box, type A-ppp-client.

Configure CHAP on the
ATM-over-ADSL or
ATM-over-SHDSL interface
and specify a unique
profile name containing a
client list and access
parameters—for example,
A-ppp-client.

Enter

set ppp-options chap local-name A-at-3/0/0.0.

In the Local name box, type, A-at-3/0/0.0Specify a unique hostname
to be used in CHAP
challenge and response
packets—for example,
A-at-3/0/0.0.

Enter

set ppp-options chap passive

1. In the Passive box, click Yes.

2. Click OK.

Set the passive option to
handle incoming CHAP
packets only.

Verifying DSL Interface Configuration

To verify ATM-over-ADSL or ATM-over-SHDSL, perform these tasks:

■ Verifying ADSL Interface Properties on page 157

■ Displaying a PPPoA Configuration for an ATM-over-ADSL Interface on page 160

■ Verifying an ATM-over-SHDSL Configuration on page 160
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Verifying ADSL Interface Properties

Purpose Verify that the interface properties are correct.

Action From the CLI, enter the show interfaces interface-name extensive command.

Sample Output user@host> show interfaces at-1/0/0 extensive
 Physical interface: at-1/0/0, Enabled, Physical link is Up
   Interface index: 141, SNMP ifIndex: 49, Generation: 142
   Link-level type: ATM-PVC, MTU: 4482, Clocking: Internal, ADSL mode,
   Speed: ADSL, Loopback: None
   Device flags   : Present Running
   Link flags     : None
   CoS queues     : 8 supported, 8 maximum usable queues
   Hold-times     : Up 0 ms, Down 0 ms
   Current address: 00:05:85:c3:17:f4
   Last flapped   : 2008-06-26 23:11:09 PDT (01:41:30 ago)
   Statistics last cleared: Never
   Traffic statistics:
    Input  bytes  :                    0                    0 bps
    Output bytes  :                    0                    0 bps
    Input  packets:                    0                    0 pps
    Output packets:                    0                    0 pps
   Input errors:
     Errors: 0, Drops: 0, Invalid VCs: 0, Framing errors: 0,Policed discards: 0,
 L3 incompletes: 0, L2 channelerrors: 0, L2 mismatch timeouts: 0,
     Resource errors: 0
   Output errors:
     Carrier transitions: 3, Errors: 0, Drops: 0, Aged packets: 0, MTU errors: 
0, Resource errors: 0
   ADSL  alarms   : None
   ADSL  defects  : None
   ADSL media:            Seconds        Count State
    LOF                       1            1  OK
    LOS                       1            1  OK
    LOM                       0            0  OK
    LOP                       0            0  OK
    LOCDI                     0            0  OK
    LOCDNI                    0            0  OK
   ADSL status:
     Modem status  : Showtime (Adsl2plus)
     DSL mode      :     Auto    Annex A
     Last fail code: None
     Subfunction   : 0x00
     Seconds in showtime : 6093
   ADSL Chipset Information:               ATU-R                ATU-C
     Vendor Country :                       0x0f                 0xb5
     Vendor ID      :                       STMI                IFTN
     Vendor Specific:                       0x0000              0x70de
   ADSL Statistics:                        ATU-R                ATU-C
     Attenuation (dB)         :              0.0                  0.0
     Capacity used(%)         :              100                  92
     Noise margin(dB)         :              7.5                  9.0
     Output power (dBm)       :             10.0                  12.5
                                   Interleave       Fast  Interleave         Fast

     Bit rate (kbps)   :                    0      24465           0         1016
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     CRC               :                    0          0           0         0
     FEC               :                    0          0           0         0  

     HEC               :                    0          0           0         0  

     Received cells    :                    0         49
     Transmitted cells :                    0          0
   ATM status:
     HCS state:     Hunt
     LOC      :       OK
  ATM Statistics:
    Uncorrectable HCS errors: 0, Correctable HCS errors: 0,Tx cell FIFO overruns:
 0,Rx cell FIFO overruns: 0,Rx cell FIFO underruns: 0,
    Input cell count: 49, Output cell count: 0,Output idle cell count: 0,Output 
VC queue drops: 0Input no buffers: 0, Input length errors: 0,
    Input timeouts: 0, Input invalid VCs: 0, Input bad CRCs: 0, Input OAM cell 
no buffers: 0

  Packet Forwarding Engine configuration:
     Destination slot: 1
     Direction : Output
     CoS transmit queue               Bandwidth               Buffer  Priority  
 Limit  
                               %            bps     %           usec
     0 best-effort            95        7600000    95              0       low  
  none          
     3 network-control         5         400000     5              0       low  
  none     

     But for ADSL MiniPim TI chipset does not send  ADSL Chipset
     Information. Also Adsl minipim does not send any alarms. So we can't
     show alarm stats for minipim. So following information will not be
     displayed in Minipim case.

     ADSL  alarms   : None
     ADSL  defects  : None   
     ADSL media:            Seconds        Count State
     LOF                       1            1  OK
     LOS                       1            1  OK
     LOM                       0            0  OK
     LOP                       0            0  OK
     LOCDI                     0            0  OK
     LOCDNI                    0            0  OK

    ADSL Chipset Information:               ATU-R      ATU-C
      Vendor Country :                       0x0f       0xb5
      Vendor ID      :                       STMI       IFTN
      Vendor Specific:                       0x0000     0x70de

Meaning The output shows a summary of interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.
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■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).

■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates likely link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

■ No ADSL alarms and defects appear that can render the interface unable to pass
packets. When a defect persists for a certain amount of time, it is promoted to
an alarm. The following are ADSL-specific alarms:

■ LOCDI–Loss of cell delineation for interleaved channel

■ LOCDNI—Loss of cell delineation for non-interleaved channel

■ LOF—Loss of frame

■ LOM—Loss of multiframe

■ LOP—Loss of power

■ LOS—Loss of signal

■ FAR_LOF—Loss of frame in ADSL transceiver unit-central office (ATU-C)

■ FAR_LOS—Loss of signal in ATU-C

■ FAR_LOCDI—Loss of cell delineation for interleaved channel in ATU-C

■ FAR_LOCDNI—Loss of cell delineation for non-interleaved channel in ATU-C

Examine the operational statistics for an ADSL interface. Statistics in the ATU-R (ADSL
transceiver unit–remote) column are for the near end. Statistics in the ATU-C (ADSL
transceiver unit–central office) column are for the far end.

■ Attenuation (dB)—Reduction in signal strength measured in decibels.

■ Capacity used (%)—Amount of ADSL usage in %.

■ Noise Margin (dB)—Maximum extraneous signal allowed without causing the
output to deviate from an acceptable level.

■ Output Power (dBm)—Amount of power used by the ADSL interface.

■ Bit Rate (kbps)—Data transfer speed on the ADSL interface.

Related Topics For a complete description of show interfaces extensive output, see the Junos Interfaces
Command Reference.
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Displaying a PPPoA Configuration for an ATM-over-ADSL Interface

Purpose Verify the PPPoA configuration for an ATM-over-ADSL interface.

Action From the J-Web interface, select Configure>CLI Tools>CLI Viewer. Alternatively,
from configuration mode in the CLI, enter the show interfaces interface-name and
the show access commands from the top level.

[edit]
user@host# show interfaces at-1/0/0
at-1/0/0 {
encapsulation atm-pvc;

atm-options {
vpi 0;

}
dsl-options {

operating-mode auto;
}
unit 0 {

encapsulation atm-ppp-llc;
vci 0.100;
ppp-options {

chap {
access-profile A-ppp-client;

local-name A-at-1/0/0.0;
passive;

}
}
family inet {

negotiate address;
}

}
}

user@host# show access
profile A-ppp-client {

client A-ppp-server chap-secret "$9$G4ikPu0ISyKP5clKv7Nik.PT3"; ## SECRET-DATA
}

Meaning Verify that the output shows the intended configuration of PPPoA.

Related Topics For more information about the format of a configuration file, see the J-Web Interface
User Guide or the Junos CLI User Guide.

Verifying an ATM-over-SHDSL Configuration

Purpose Verify that the interface properties are correct.

Action From the CLI, enter the show interfaces interface-name extensive command.
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Sample Output user@host> show interfaces at-6/0/0 extensive
Physical interface: at-6/0/0, Enabled, Physical link is Up
  Interface index: 141, SNMP ifIndex: 23, Generation: 48
  Link-level type: ATM-PVC, MTU: 4482, Clocking: Internal, ADSL mode, Speed: ADSL,

  Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: 00:05:85:c7:44:3c
  Last flapped   : 2005-05-16 05:54:41 PDT (00:41:42 ago)
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :                 4520                    0 bps
   Output bytes  :                39250                    0 bps
   Input  packets:                   71                    0 pps
   Output packets:                 1309                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Invalid VCs: 0, Framing errors: 0, Policed discards: 0,

    L3 incompletes: 0, L2 channel errors: 1, L2 mismatch timeouts: 0, Resource 
errors: 0
  Output errors:
    Carrier transitions: 3, Errors: 0, Drops: 0, Aged packets: 0, MTU errors: 0,

    Resource errors: 0
  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 best-effort                    4                    4                    0

    1 expedited-fo                   0                    0                    0

    2 assured-forw                   0                    0                    0

    3 network-cont                2340                 2340                    0

  SHDSL  alarms   : None
  SHDSL  defects  : None 
  SHDSL media:            Seconds        Count  State
    LOSD                  239206            2  OK
    LOSW                  239208            1  OK
    ES                         3            1  OK
    SES                        0            0  OK
    UAS                        3            1  OK

  SHDSL status:
    Line termination  :STU-R
  Annex     :Annex B
  Line Mode    :2–wire
  Modem Status   :Data
  Last fail code  :0
  Framer mode   :ATM
  Dying Gasp    :Enabled
  Chipset version  :1
  Firmware version  :R3.0
  SHDSL Statistics:                        
   Loop Attenuation (dB)   :0.600
 Transmit power (dB)     :8.5
 Receiver gain (dB)    :21.420
 SNR sampling (dB)     :39.3690
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 Bit rate  (kbps)     :2304
 Bit error rate      :0
 CRC errors       :0
 SEGA errors       :1
 LOSW errors       :0
 Received cells      :1155429
 Transmitted cells     :1891375
 HEC errors       :0
 Cell drop       :0    

Meaning The output shows a summary of interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).

■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates likely link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

■ No SHDSL alarms and defects appear that can render the interface unable to
pass packets. When a defect persists for a certain amount of time, it is promoted
to an alarm.

■ LOS—Loss of signal. No signal was detected on the line.

■ LOSW—Loss of sync word. A message ID was sent.

■ Power status—A power failure has occurred.

■ LOSD—Loss of signal was detected at the remote application interface.

■ ES—Errored seconds. One or more cyclic redundancy check (CRC) anomalies
were detected.

■ SES—Severely errored seconds. At least 50 CRC anomalies were detected.

■ UAS—Unavailable seconds. An interval has occurred during which one or
more LOSW defects were detected.
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Examine the SHDSL interface status:

■ Line termination—SHDSL transceiver unit–remote (STU–R). (Only customer
premises equipment is supported.)

■ Annex—Either Annex A or Annex B. Annex A is supported in North America, and
Annex B is supported in Europe.

■ Line Mode—SHDSL mode configured on the G.SHDSL interface pair, either 2-wire
or 4-wire.

■ Modem Status—Data. Sending or receiving data.

■ Last fail code—Code for the last interface failure.

■ Framer mode—Framer mode of the underlying interface: ATM.

■ Dying Gasp—Ability of a J Series device that has lost power to send a message
informing the attached DSL access multiplexer (DSLAM) that it is about to go
offline.

■ Chipset version—Version number of the chipset on the interface

■ Firmware version—Version number of the firmware on the interface.

Examine the operational statistics for a SHDSL interface.

■ Loop Attenuation (dB)—Reduction in signal strength measured in decibels.

■ Transmit power (dB)—Amount of SHDSL usage in %.

■ Receiver gain (dB)—Maximum extraneous signal allowed without causing the
output to deviate from an acceptable level.

■ SNR sampling (dB)—Signal-to-noise ratio at a receiver point, in decibels.

■ Bit Rate (kbps)—Data transfer speed on the SHDSL interface.

■ CRC errors—Number of cyclic redundancy check errors.

■ SEGA errors—Number of segment anomaly errors. A regenerator operating on
a segment received corrupted data.

■ LOSW errors—Number of loss of signal defect errors. Three or more consecutively
received frames contained one or more errors in the framing bits.

■ Received cells—Number of cells received through the interface.

■ Transmitted cells—Number of cells sent through the interface.

■ HEC errors—Number of header error checksum errors.

■ Cell drop—Number of dropped cells on the interface.

Related Topics For a complete description of show interfaces extensive output, see the Junos Interfaces
Command Reference.
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Configuring MLPPP over ADSL Interfaces

J Series and SRX Series devices with an ADSL interface support link fragmentation
and interleaving (LFI) through a Multilink Point-to-Point Protocol (MLPPP).

NOTE: Currently, JUNOS Software supports bundling of only one xDSl link under
bundle interface.

To configure MLPPP, see the Junos Network Interfaces Configuration Guide.

To support MLPPP encapsulation and the family mlppp on the ADSL interface on a
J Series or SRX Series device, an existing JUNOS CLI is enabled. To configure MLPPP
encapsulation and the family mlppp, use the following commands:

set interfaces at-5/0/0 unit 0 encapsulation atm-mlppp-llc

set interfaces at-5/0/0 unit 0 family mlppp bundle lsq-0/0/0.1

Figure 26:  MLPPP over ADSL Interface

To establish an ADSL link between network devices, you must use some intermediate
connections. First, use an RJ-11 cable to connect the customer premises equipment
(CPE) (for example, a J Series or SRX Series device) to a DSLAM patch panel to form
an ADSL link. Then use OC3 or DS3 to connect the DSLAM to M Series or E Series
devices to form an ATM backbone. Figure 26 on page 164 shows a typical example
of MLPPP over ADSL end-to-end connectivity.
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Chapter 5

Configuring G.SHDSL Interfaces

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter includes the following topics:

■ Before You Begin on page 165

■ Configuring the G.SHDSL Interface with the CLI Configuration Editor on page 165

■ Verifying G.SHDSL Interface Properties on page 168

■ Configuring the G.SHDSL Interface on SRX Series Devices on page 176

Before You Begin

Before you begin configuring G.SHDSL interfaces on SRX Series devices, complete
the following tasks:

■ Establish basic connectivity. See the Getting Started Guide for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

■ Configure network interfaces as necessary. See “Configuring Ethernet, DS1, DS3,
and Serial Interfaces” on page 81.

Configuring the G.SHDSL Interface with the CLI Configuration Editor

Use the CLI configuration editor to configure the G.SHDSL interface.

NOTE: J-Web support for configuring the G.SHDSL Interface is not available.

NOTE: The G.SHDSL configuration details mentioned in this topic are applicable to
SRX Series devices. For information about configuring G.SHDSL configuration on J
Series devices, see “Configuring ATM-over-SHDSL Interfaces” on page 145.

To configure the G.SHDSL interfaces for SRX210 and SRX240 devices:
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1. Navigate to the top of the interfaces configuration hierarchy in the CLI
configuration editor.

2. Perform the configuration tasks described in Table 40 on page 166.

3. Commit the configuration after you have completed configuring the device.

4. Check the configuration. See “Verifying G.SHDSL Interface Properties” on page 168
for details.

Table 40: Configuring the G.SHDSL Interface Using the CLI Configuration Editor

Description
CLI Configuration Editor
CommandsTask

Specifies the wire mode on the G.SHDSL
interface.

Select one of the following options:

■ 1-port-atm — Use this option to configure
the 8-wire (1-port, 8-wire) wire mode.

■ 2-port-atm —Use this option to configure
the 4-wire (2-port, 4-wire) wire mode.

■ 4-port-atm — Use this option to configure
the 2-wire (4-port, 2-wire) wire mode).

NOTE: The default wire mode is 4-wire (2-port,
4-wire).

From the [edit] hierarchy
level, enter

set chassis fpc fpc
slot-number pic pic
slot-number shdsl
pic-mode wire mode

Example:

set chassis fpc 1 pic 0
shdsl pic-mode 2-port-atm

Navigate to the Chassis level in the configuration
hierarchy.

Provides a hierarchy level to configure the
interface.

From the [edit] hierarchy
level, enter

edit interfaces interface

Example:

edit interfaces at-1/0/0

Navigate to the Interfaces level in the
configuration hierarchy.

Sets the annex type. The following options are
available:

■ Annex A

■ Annex B

■ Annex F

■ Annex G

NOTE: The default annex type is Annex B.

From the [edit] hierarchy
level, enter

set interfaces interface
shdsl-options annex
annex type

Example:

set interfaces at-1/0/0
shdsl-options annex
annex-a

Set the annex type.
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Table 40: Configuring the G.SHDSL Interface Using the CLI Configuration Editor (continued)

Description
CLI Configuration Editor
CommandsTask

Configures the SHDSL line rate. Line rate is speed
of transmission of data on the SHDSL connection.

The following values are available:

■ auto — Automatically selects a line rate.

■ value — Select the values between 192 kbps
and 22784 kbps.

NOTE: The default line rate is Auto.

From the [edit] hierarchy
level, enter

set interfaces interface
shdsl-options line-rate
line rate value

Example

set interfaces at-1/0/0
shdsl-options line-rate
auto

Configure the line rates.

Sets the encapsulation type.

The following values are available:

■ atm-pvc—ATM permanent virtual circuits is
the default encapsulation for
ATM-over-SHDSL interfaces. For PPP over
ATM (PPPoA) over SHDSL interfaces, use
this type of encapsulation. Use this type of
encapsulation if you are using ATM DSLAM.

■ ethernet-over-atm — Ethernet over ATM
encapsulation. For PPP over Ethernet
(PPPoE) over ATM-over-SHDSL interfaces
that carry IPv4 traffic, use this type of
encapsulation. Use this type of
encapsulation if you are using IP DSLAM.

From the [edit] hierarchy
level, enter

set interfaces interface
encapsulation
encapsulation type

Example

set interfaces at-1/0/0
encapsulation
ethernet-over-atm

Configure the encapsulation type.

Configuring Logical Properties

Defines one or more logical units that you
connect to this physical G.SHDSL interface.

Set a value from 0 through 7.

From the [edit] hierarchy
level, enter

set interfaces interface
unit unit value

Example

set interfaces at-1/0/0
unit 3

Add the logical interface.
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Table 40: Configuring the G.SHDSL Interface Using the CLI Configuration Editor (continued)

Description
CLI Configuration Editor
CommandsTask

Sets the encapsulation type.

The following values are available:

■ atm-cisco-nlpid—Use Cisco NLPID
encapsulation.

■ atm-mlppp-llc —Use ATM MLPPP over
AAL5/LLC encapsulation.

■ atm-nlpid—Use ATM network layer protocol
identifier (NLPID) encapsulation.

■ atm-ppp-llc—AAL5 logical link control (LLC)
encapsulation.

■ atm-ppp-vc-mux—Use AAL5 multiplex
encapsulation.

■ atm-vc-mux—Use ATM virtual circuit
multiplex encapsulation.

■ atm-snap—Use ATM subnetwork attachment
point (SNAP) encapsulation.

■ ether-over-atm-llc—For interfaces that carry
IPv4 traffic, use Ethernet over LLC
encapsulation. You cannot configure
multipoint interfaces if you use this type of
encapsulation.

■ ppp-over-ether-over-atm-llc—Use PPP over
Ethernet over ATM LLC encapsulation. When
you use this encapsulation type, you cannot
configure the interface address. Instead you
configure the interface address on the PPP
interface.

From the [edit] hierarchy
level, enter

set interfaces interface
unit unit
valueencapsulation

Example

set interfaces at-1/0/0
unit 0 encapsulation

Configure encapsulation.

NOTE: For more information on configuring the physical and logical properties for
the G.SHDSL interface, see “Configuring ATM-over-SHDSL Interfaces” on page 145.

Related Topics Configuring ATM-over-SHDSL Interfaces on page 145■

■ Verifying G.SHDSL Interface Properties on page 168

Verifying G.SHDSL Interface Properties

Purpose Verify that the G.SHDSL interface properties are configured properly

Action From the CLI configuration editor, enter the show interfaces interface-name extensive
command.
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Sample Output 4-wire mode (for interface at-1/0/0)

user@host# run show interfaces at-1/0/0 extensive
Physical interface: at-1/0/0, Enabled, Physical link is Up

  Interface index: 146, SNMP ifIndex: 139, Generation: 329
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, Speed: SHDSL(4-wire)

  Speed: SHDSL(4-wire), Loopback: None
  Device flags   : Present Running
  Link flags     : None
 CoS queues     : 8 supported, 8 maximum usable queues
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: 00:24:dc:01:cf:a0
  Last flapped   : 2009-09-24 00:19:03 PDT (00:00:54 ago)
  Statistics last cleared: 2009-09-24 00:18:24 PDT (00:01:33 ago)
  Traffic statistics:
   Input  bytes  :                  125                    0 bps
   Output bytes  :                   96                    0 bps
   Input  packets:                    2                    0 pps
   Output packets:                    1                    0 pps
  Input errors:

    Errors: 0, Drops: 0, Invalid VCs: 0, Framing errors: 0, Policed discards: 0,
 L3 incompletes: 0, L2 channel errors: 0, L2 mismatch timeouts: 0,    Resource 
errors: 0

  Output errors:
    Carrier transitions: 1, Errors: 0, Drops: 0, Aged packets: 0, MTU errors: 0,
 Resource errors: 0
  Egress queues: 8 supported, 4 in use
  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 best-effort                    1                    1                    0

    1 expedited-fo                   0                    0                    0
    2 assured-forw                   0                    0                    0

    3 network-cont                   0                    0                    0

  SHDSL alarms   : None
  SHDSL defects  : None
  SHDSL media:            Seconds        Count  State
    LINE1_LOSD                  32            0  OK
    LINE1_LOSW                  37            0  OK
    LINE2_LOSD                  32            0  OK
    LINE2_LOSW                  37            0  OK
   ES                          37
    SES                         37
    UAS                         48
  SHDSL status:
    Line  termination      : STU-R
    Annex                  : Annex B
    Line mode              : 4-wire
    Modem status           : Data
    Bit rate (kbps)        : 4608
    Last fail mode         : No failure (0x00)
    Framer mode            : ATM
    Dying gasp             : Enabled
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    Framer sync status     : In sync
    Chipset version        : 00
  SHDSL statistics:
    Loop attenuation (dB)  : 0.0
    Transmit power (dBm)   : 0.0
    Receiver gain (dB)     : -inf
    SNR sampling (dB)      : inf
    CRC errors             : 0
    SEGA errors            : 0
    LOSW errors            : 0
    Received cells         : 0
    Transmitted cells      : 0
    HEC errors             : 0
    Cell drop              : 0
  Packet Forwarding Engine configuration:
    Destination slot: 1
  CoS information:
    Direction : Output 
    CoS transmit queue               Bandwidth               Buffer Priority   
Limit
                              %            bps     %           usec
    0 best-effort            95        4377600    95              0      low    
none
    3 network-control         5         230400     5              0      low    
none

  Logical interface at-1/0/0.0 (Index 76) (SNMP ifIndex 133) (Generation 402)
    Flags: Point-To-Multipoint SNMP-Traps 0x0 Encapsulation: Ether-over-ATM-LLC
    Traffic statistics:
     Input  bytes  :                  125
     Output bytes  :                  116
     Input  packets:                    2
     Output packets:                    1
    Local statistics:
     Input  bytes  :                  125
     Output bytes  :                  116
     Input  packets:                    2
     Output packets:                    1
    Transit statistics:
     Input  bytes  :                    0                    0 bps
     Output bytes  :                    0                    0 bps
     Input  packets:                    0                    0 pps
     Output packets:                    0                    0 pps
    Security: Zone: Null
    Flow Statistics :  
    Flow Input statistics :
      Self packets :                     0
      ICMP packets :                     0
      VPN packets :                      0
      Multicast packets :                0
      Bytes permitted by policy :        0
      Connections established :          0 
    Flow Output statistics: 
      Multicast packets :                0
      Bytes permitted by policy :        0 
    Flow error statistics (Packets dropped due to): 
      Address spoofing:                  0
      Authentication failed:             0
      Incoming NAT errors:               0
      Invalid zone received packet:      0
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      Multiple user authentications:     0 
      Multiple incoming NAT:             0
      No parent for a gate:              0
      No one interested in self packets: 0   

      No minor session:                  0 
      No more sessions:                  0
      No NAT gate:                       0 
      No route present:                  0 
      No SA for incoming SPI:            0 
      No tunnel found:                   0
      No session for a gate:             0 
      No zone or NULL zone binding       0
      Policy denied:                     0
      Security association not active:   0 
      TCP sequence number out of window: 0
      Syn-attack protection:             0
      User authentication errors:        0
    Protocol inet, MTU: 1468, Generation: 322, Route table: 0
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 17.1.1/24, Local: 17.1.1.1, Broadcast: 17.1.1.255, Generation:
 496
    VCI 1.70
      Flags: Active, Multicast
      Total down time: 0 sec, Last down: Never
      ATM per-VC transmit statistics:
       Tail queue packet drops: 0
      Traffic statistics:
       Input  bytes  :                    0
       Output bytes  :                    0
       Input  packets:                    0
       Output packets:                    0

  Logical interface at-1/0/0.32767 (Index 77) (SNMP ifIndex 141) (Generation 403)

    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation: ATM-VCMUX

    Traffic statistics:
     Input  bytes  :                    0
     Output bytes  :                    0
     Input  packets:                    0
     Output packets:                    0
    Local statistics:
     Input  bytes  :                    0
     Output bytes  :                    0
     Input  packets:                    0
     Output packets:                    0
    Security: Zone: Null
    Flow Statistics :  
    Flow Input statistics :
      Self packets :                     0
      ICMP packets :                     0
      VPN packets :                      0
      Multicast packets :                0
      Bytes permitted by policy :        0
      Connections established :          0 
    Flow Output statistics: 
      Multicast packets :                0
      Bytes permitted by policy :        0 
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    Flow error statistics (Packets dropped due to): 
      Address spoofing:                  0
      Authentication failed:             0
      Incoming NAT errors:               0
      Invalid zone received packet:      0
      Multiple user authentications:     0 
      Multiple incoming NAT:             0
      No parent for a gate:              0
      No one interested in self packets: 0    

      No minor session:                  0 
      No more sessions:                  0
      No NAT gate:                       0 
      No route present:                  0 
      No SA for incoming SPI:            0 
      No tunnel found:                   0
      No session for a gate:             0 
      No zone or NULL zone binding       0
      Policy denied:                     0
      Security association not active:   0 
      TCP sequence number out of window: 0
      Syn-attack protection:             0
      User authentication errors:        0
    VCI 1.4
      Flags: Active
      Total down time: 0 sec, Last down: Never
      ATM per-VC transmit statistics:
       Tail queue packet drops: 0
      Traffic statistics:
       Input  bytes  :                    0
       Output bytes  :                    0
       Input  packets:                    0
       Output packets:                    0

Sample Output 4-wire mode (for interface at-1/0/1)

Physical interface: at-1/0/1, Enabled, Physical link is Up

 Interface index: 147, SNMP ifIndex: 140, Generation: 330
Link-level type: Ethernet-over-ATM, MTU: 1496, Clocking: Internal, Speed: 
SHDSL(4-wire)
  Speed: SHDSL(4-wire), Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: 00:24:dc:01:cf:a1
  Last flapped   : 2009-09-24 00:19:02 PDT (00:00:58 ago)
  Statistics last cleared: 2009-09-24 00:18:24 PDT (00:01:36 ago)
  Traffic statistics:
   Input  bytes  :                    0                    0 bps
   Output bytes  :                    0                    0 bps
   Input  packets:                    0                    0 pps
   Output packets:                    0                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Invalid VCs: 0, Framing errors: 0, Policed discards: 0,
 L3 incompletes: 0, L2 channel errors: 0, L2 mismatch timeouts: 0,
    Resource errors: 0
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  Output errors:
    Carrier transitions: 0, Errors: 0, Drops: 0, Aged packets: 0, MTU errors: 0,
 Resource errors: 0
  Egress queues: 8 supported, 4 in use
  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 best-effort                    0                    0                    0

    1 expedited-fo                   0                    0                    0

    2 assured-forw                   0                    0                    0

    3 network-cont                   0                    0                    0

  SHDSL alarms   : None
  SHDSL defects  : None
  SHDSL media:            Seconds        Count  State
    LINE1_LOSD                   0            0  OK
    LINE1_LOSW                   0            0  OK
    LINE2_LOSD                   0            0  OK
    LINE2_LOSW                   0            0  OK
    ES                          36
    SES                         36
    UAS                         47
  SHDSL status:
    Line  termination      : STU-R
    Annex                  : Annex B
    Line mode              : 4-wire
    Modem status           : Data
    Bit rate (kbps)        : 4608
    Last fail mode         : No failure (0x00)
    Framer mode            : ATM
    Dying gasp             : Enabled
    Framer sync status     : In sync
    Chipset version        : 00
  SHDSL statistics:
    Loop attenuation (dB)  : 0.0
    Transmit power (dBm)   : 0.0
    Receiver gain (dB)     : -inf
    SNR sampling (dB)      : inf
    CRC errors             : 0
    SEGA errors            : 0
    LOSW errors            : 0
    Received cells         : 0
    Transmitted cells      : 0
    HEC errors             : 0
    Cell drop              : 0
  Packet Forwarding Engine configuration:
    Destination slot: 1
  CoS information:
    Direction : Output 
    CoS transmit queue               Bandwidth               Buffer Priority   
Limit
                              %            bps     %           usec
    0 best-effort            95        4377600    95              0      low    
none
    3 network-control         5         230400     5              0      low    
none
  Logical interface at-1/0/1.0 (Index 78) (SNMP ifIndex 145) (Generation 404)
    Flags: Point-To-Multipoint SNMP-Traps 0x0 Encapsulation: Ether-over-ATM-LLC
    Traffic statistics:
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     Input  bytes  :                    0
     Output bytes  :                    0
     Input  packets:                    0
     Output packets:                    0
    Local statistics:
     Input  bytes  :                    0
     Output bytes  :                    0
     Input  packets:                    0
     Output packets:                    0
    Transit statistics:
     Input  bytes  :                    0                    0 bps
     Output bytes  :                    0                    0 bps
     Input  packets:                    0                    0 pps
     Output packets:                    0                    0 pps
    Security: Zone: Null
    Flow Statistics : 
    Flow Input statistics :
      Self packets :                     0
      ICMP packets :                     0
      VPN packets :                      0
      Multicast packets :                0
      Bytes permitted by policy :        0
      Connections established :          0 
    Flow Output statistics: 
      Multicast packets :                0
      Bytes permitted by policy :        0 
    Flow error statistics (Packets dropped due to):
      Address spoofing:                  0
      Authentication failed:             0
      Incoming NAT errors:               0
      Invalid zone received packet:      0
      Multiple user authentications:     0 
      Multiple incoming NAT:             0
      No parent for a gate:              0
      No one interested in self packets: 0   

      No minor session:                  0 
      No more sessions:                  0
      No NAT gate:                       0 
      No route present:                  0 
      No SA for incoming SPI:            0 
      No tunnel found:                   0
      No session for a gate:             0 
      No zone or NULL zone binding       0
      Policy denied:                     0
      Security association not active:   0 
      TCP sequence number out of window: 0
      Syn-attack protection:             0
      User authentication errors:        0
    Protocol inet, MTU: 1468, Generation: 323, Route table: 0
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
      Destination: 18.1.1/24, Local: 18.1.1.1, Broadcast: 18.1.1.255, Generation:
 498
    VCI 1.71
      Flags: Active, Multicast
      Total down time: 0 sec, Last down: Never
      ATM per-VC transmit statistics:
       Tail queue packet drops: 0
      Traffic statistics:
       Input  bytes  :                    0
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       Output bytes  :                    0
       Input  packets:                    0
       Output packets:                    0

  Logical interface at-1/0/1.32767 (Index 79) (SNMP ifIndex 146) (Generation 405)

    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation: ATM-VCMUX

    Traffic statistics:
     Input  bytes  :                    0
     Output bytes  :                    0
     Input  packets:                    0
     Output packets:                    0
    Local statistics:
     Input  bytes  :                    0
     Output bytes  :                    0
     Input  packets:                    0
     Output packets:                    0
    Security: Zone: Null
    Flow Statistics : 

    Flow Input statistics :
      Self packets :                     0
      ICMP packets :                     0
      VPN packets :                      0
      Multicast packets :                0
      Bytes permitted by policy :        0
      Connections established :          0 
    Flow Output statistics: 
      Multicast packets :                0
      Bytes permitted by policy :        0 
    Flow error statistics (Packets dropped due to): 
      Address spoofing:                  0
      Authentication failed:             0
     Incoming NAT errors:               0
      Invalid zone received packet:      0
      Multiple user authentications:     0 
      Multiple incoming NAT:             0
      No parent for a gate:              0
      No one interested in self packets: 0    

      No minor session:                  0
      No more sessions:                  0
      No NAT gate:                       0 
      No route present:                  0
      No SA for incoming SPI:            0
      No tunnel found:                   0
      No session for a gate:             0 
      No zone or NULL zone binding       0
      Policy denied:                     0
      Security association not active:   0 
      TCP sequence number out of window: 0
      Syn-attack protection:             0
      User authentication errors:        0

    VCI 1.4
      Flags: Active
      Total down time: 0 sec, Last down: Never
      ATM per-VC transmit statistics:
       Tail queue packet drops: 0
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      Traffic statistics:
       Input  bytes  :                    0
       Output bytes  :                    0
       Input  packets:                    0
       Output packets:                    0

Meaning The output shows a summary of information about the G.SHDSL interface in this
example.

Related Topics For a complete description of show interfaces extensive output, see the JUNOS
Interfaces Command Reference Guide.

Configuring the G.SHDSL Interface on SRX Series Devices

This topic provides information on the minimum steps required to configure a
G.SHDSL interface on SRX Series devices. The configuration example uses an SRX210
Services Gateway, the information is also applicable to the SRX240 device.

■ Topology Diagrams of the G.SHDSL Mini-PIM on page 176

■ Example: Configuring the G.SHDSL Interface on the SRX210 Services
Gateway on page 177

Topology Diagrams of the G.SHDSL Mini-PIM

The following topology diagrams show various G.SHDSL Mini-PIM connections:

Figure 27 on page 176 shows the topology for the G.SHDSL Mini-PIM operating in the
2X4-wire mode.

Figure 27: G.SHDSL Mini-PIM Operating in the 2X4-Wire Mode

Figure 28 on page 177 shows the topology for the G.SHDSL Mini-PIM operating in the
4X2-wire mode.
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Figure 28: G.SHDSL Mini-PIM Operating in the 4X2-Wire Mode

Figure 29 on page 177 shows the topology for the G.SHDSL Mini-PIM operating in the
1X8-wire mode.

Figure 29: G.SHDSL Mini-PIM Operating in the 1X8-Wire Mode

Example: Configuring the G.SHDSL Interface on the SRX210 Services Gateway

The following assumptions are made in this example:

■ The G.SHDSL Mini-PIM is installed in the first slot of the SRX210 device chassis;
therefore the FPC used here is fpc 1.

■ The SRX210 device is connected to a DSLAM (IP DSLAM and ATM DSLAM).

The steps to configure the G.SHDSL interface when the device is connected to
an IP DSLAM and ATM DSLAM are given separately (see Table 42 on page 178
and Table 43 on page 179.

Table 41 on page 178 provides the basic configuration steps for the G.SHDSL interface
on an SRX210 device.
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Table 41: Basic Configuration of the G.SHDSL Interface

CommandsTasks

From the [chassis] hierarchy level, enter:

■ set chassis fpc 1 pic 0 shdsl pic-mode 1-port-atm

(1x8-wire configuration)

■ set chassis fpc 1 pic 0 shdsl pic-mode 2-port-atm

(2x4-wire configuration)

NOTE: The 2x4-wire configuration is the default configuration and
behavior.

■ set chassis fpc 1 pic 0 shdsl pic-mode 4-port-atm

(4x2-wire configuration)

Select the operating wire mode (2-wire, 4-wire or 8-
wire).

NOTE: When the wire mode is set to 8-wire, one
physical interface (IFD) is created. Similarly for 2-wire
mode and 4-wire modes, four IFDs and two IFDs are
created respectively.

From the [edit] hierarchy level, enter:

set interfaces at-1/0/0 shdsl-options line-rate 4096

Configure the line rates.

From the [edit] hierarchy level, enter:

set interfaces at-1/0/0 shdsl-options annex annex-a

Set the annex type.

Table 42 on page 178 provides the configuration steps for configuring the G.SHDSL
interface on an SRX210 device when it is connected to an IP DSLAM.

Table 42: G.SHDSL Interface Configuration Steps (IP DSLAM)

CommandsTasks

set interface at-1/0/0 encapsulation ethernet-over-atmSpecify the type of encapsulation on the G.SHDSL
interface.

set interface at-1/0/0 atm-options vpi 0Configure the ATM virtual path identifier (VPI) options
for the interface.

set interface at-1/0/0 unit 0 encapsulation ether-over-atm-llcSpecify the type of encapsulation on the G.SHDSL
logical interface.

set interface at-1/0/0 unit 0 vci 0.60Configure the ATM virtual channel identifier (VCI)
options for the logical interface.

set interface at-1/0/0 unit 0 family inet address 1.1.1.1/24Configure the interface address for logical interface.

Table 43 on page 179 provides the configuration steps for configuring the G.SHDSL
interface on an SRX210 device when the device is connected to an ATM DSLAM.
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Table 43: G.SHDSL Interface Configuration Steps (ATM DSLAM)

CommandsTasks

set interface at-1/0/0 encapsulation atm-pvcSpecify the type of encapsulation on the G.SHDSL
interface.

interface at-1/0/0 atm-options vpi 0Configure the ATM virtual path identifier (VPI) options
for the interface.

interface at-1/0/0 unit 0 encapsulation atm-snapSpecify the type of encapsulation on the G.SHDSL
logical interface.

set interface at-1/0/0 unit 0 vci 0.65Configure the ATM virtual channel identifier (VCI)
options for the logical interface.

set interface at-1/0/0 unit 0 family inet address 2.1.1.1/24Configure the interface address for logical interface.

Table 44 on page 179 provides the configuration steps for configuring PPPoE over
ATM on the G.SHDSL interface on an SRX210 device when it is connected to an IP
DSLAM.

Table 44: Steps for Configuring PPPoE over ATM for the G.SHDSL Interface

CommandsTasks

interface at-1/0/0 atm-options vpi 0Configure the ATM virtual path identifier (VPI) options
for the interface.

set interfaces at-1/0/0 unit 0 encapsulation ppp-over-ether-over-atm-llcSpecify the type of encapsulation on the G.SHDSL logical
interface.

set interfaces at-1/0/0 unit 0 vci 0.35Configure the ATM virtual channel identifier (VCI)
options for the logical interface.

set interfaces pp0 unit 0 ppp-options pap access-profile pap_profConfigure a PPPoE interface with the PAP access profile.

set interfaces pp0 unit 0 ppp-options pap local-name srx-210Configure a local-name for the PAP interface.

set interfaces pp0 unit 0 ppp-options pap local-password
"$9$0tLw1SeN-woJDSr-wY2GU69Cp1RSre"

Configure a local-password for the PAP interface.

set interfaces pp0 unit 0 ppp-options pap passiveSet the passive option to handle incoming PAP packets
only.

set interfaces pp0 unit 0 pppoe-options underlying-interface at-1/0/0.0Specify the logical interface as the underlying interface
for the PPPoE session.

set interfaces pp0 unit 0 pppoe-options auto-reconnect 120Specify the number of seconds (from 1 through
4294967295) to wait before reconnecting after a PPPoE
session is terminated.

set interfaces pp0 unit 0 pppoe-options clientSpecify the logical interface as the client for the PPPoE
interface.
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Table 44: Steps for Configuring PPPoE over ATM for the G.SHDSL Interface (continued)

CommandsTasks

set interfaces pp0 unit 0 family inet negotiate-addressObtain an IP address by negotiation with the remote
end.

Table 45 on page 180 provides the configuration steps for configuring PPP-over-ATM
(PPPoA) on the G.SHDSL interface on an SRX210 device when the device is connected
to an IP DSLAM.

Table 45: Steps for Configuring PPPoA for the G.SHDSL Interface

CommandsTasks

set interfaces at-1/0/0 encapsulation atm-pvcSpecify the type of encapsulation on the G.SHDSL
interface.

set interfaces at-1/0/0 atm-options vpi 1Configure the ATM virtual path identifier (VPI) options
for the interface.

set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc

(For PPP over ATM adaptation layer 5 (AAL5) logical link control
(LLC)

or

set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-vc-mux

(For PPP over ATM AAL5 multiplex)

Specify the type of encapsulation on the G.SHDSL logical
interface.

set interfaces at-1/0/0 unit 0 vci 1.122Configure the ATM virtual channel identifier (VCI)
options for the logical interface.

set interfaces at-1/0/0 unit 0 ppp-options chap access-profile juniperConfigure a PPPoA interface with the CHAP access
profile.

set interfaces at-1/0/0 unit 0 ppp-options chap local-name srx-210Configure a local-name for the CHAP interface.

set interfaces at-1/0/0 unit 0 family inet negotiate-addressObtain an IP address by negotiation with the remote
end.
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Chapter 6

Configuring DOCSIS Mini-PIM Interfaces

This chapter includes following topics:

■ Before You Begin on page 181

■ Configuring the DOCSIS Interfaces (CLI procedure) on page 181

■ Configuring the DOCSIS Logical Interfaces (J-Web procedure) on page 183

■ Configuring the DOCSIS Physical Interfaces (J-Web procedure) on page 184

■ Verifying DOCSIS Interfaces Properties on page 184

Before You Begin

Before you begin configuring Data over Cable Service Interface Specifications (DOCSIS)
interfaces, complete the following tasks:

■ Establish basic connectivity. See the Getting Started Guide for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interfaces conventions, read “Interfaces Overview” on
page 3.

■ Configure network interfaces as necessary. See “Configuring Ethernet, DS1, DS3,
and Serial Interfaces” on page 81.

Configuring the DOCSIS Interfaces (CLI procedure)

To use the CLI configuration editor to configure the DOCSIS network interface for
SRX210 and SRX240 devices:

1. Navigate to the top of the interface configuration hierarchy in the CLI
configuration editor.

2. Perform the configuration tasks described in Table 46 on page 182.

3. When you are done, commit the configuration.

4. To check the configuration, see “Verifying DOCSIS Interfaces Properties” on
page 184.

Before You Begin ■ 181



Table 46: Configuring the DOCSIS Mini-PIM Interfaces Using the CLI

DescriptionCLI Configuration EditorTask

Provides a hierarchy level to configure the
interface.

From the [edit] hierarchy
level, enter

edit interfaces cm-1/0/0

Navigate to the Interfaces level in the
configuration hierarchy.

Configuring Physical Properties

Sets the interface trace options. The following
option is supported:

■ flag—Sets tracing parameters

From the [edit] hierarchy
level, enter

set interfaces interface
name traceoptions

Example:

set interfaces cm-2/0/0
traceoptions

Configure the traceoptions.

The following options are supported:

■ All—Enable all interface trace flags

■ event—Trace interface events

■ ipc—Trace interface IPC messages

■ media—Trace interface media changes

■ critical—Trace critical events

■ major—Trace major events

NOTE: MTU is limited to 1518 bytes on this
interface.

set interface
interface-name
traceoptions flag
flag-options

Example:

set interface cm-2/0/0
traceoptions flag

Select the flag option

Configuring Logical Properties

Defines one or more logical units that you
connect to this physical DOCSIS interface.

From the [edit] hierarchy
level, enter

set interfaces interface
name unit unit value

Example:

set interfaces cm-2/0/0
unit 0

Add the logical interface.

Commands vary depending on the protocol type.set interfaces interface
name unit unit value
family inet

Example:

set interfaces cm-2/0/0
unit 0 family inet

Add the Family protocol type—for example,
inet.
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Table 46: Configuring the DOCSIS Mini-PIM Interfaces Using the CLI (continued)

DescriptionCLI Configuration EditorTask

The following option is supported:

■ client-identifier—The DHCP server
identifies a client by a client-identifier value.

set interfaces cm-2/0/0
unit 0 family inet dhcp

Configure the Dynamic Host Configuration
Protocol (DHCP) client.

Configuring the DOCSIS Logical Interfaces (J-Web procedure)

To configure the logical interface of DOCSIS Mini-PIM using J-Web:

1. Select Interfaces>Configure.

2. Under Interface, select cm-4/0/0 and then click Add>Logical Interface. A pop-up
window appears.

3. From the Zone list, select None.

4. To add a family protocol type to the Mini-PIM interfaces, select the following
check boxes as applicable:

■ INET: Supports IP protocol traffic, including OSPF, BGP, and ICMP.

■ MPLS: Supports MPLS.

5. Click OK.

To edit the logical interfaces of the DOCSIS Mini-PIM using J-Web:

1. Under Interface, select the logical interface added to the DOCSIS Mini-PIM and
then click Edit. A pop-up window appears.

2. From the Zone list, select None.

3. To add a family protocol type to the Mini-PIM interfaces, select the following
check boxes as applicable:

■ INET: Supports IP protocol traffic including, Open Shortest Path First (OSPF),
Border Gateway Protocol (BGP), and Internet Control Message Protocol
(ICMP).

■ MPLS: Supports Multiprotocol Label Switching (MPLS).

4. Click OK.

NOTE: You cannot add or edit Interface Name, Description, and Unit for a logical
interface.

To delete the logical interface of the DOCSIS Mini-PIM using J-Web:

1. Select Interfaces>Configure.

2. Under Interface, select cm-4/0/0.0 and then click Delete. A pop-up window
appears.
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3. Click Yes.

Configuring the DOCSIS Physical Interfaces (J-Web procedure)

To edit the physical interface of the DOCSIS Mini-PIM using J-Web:

1. Select Interfaces>Configure.

2. Under Interface, select cm-4/0/0 and then click Edit. A pop-up window appears.

3. In the Description box, enter a description to be updated for the configured
Mini-PIM interface.

4. In the MTU box, enter an integer value between 256 and 9192 bytes.

5. Click OK.

To disable the physical interface of the DOCSIS Mini-PIM using J-Web:

1. Select Interfaces>Configure.

2. Under Interface, select cm-4/0/0 and then click Disable. A pop-up window
appears.

3. Click Yes.

Verifying DOCSIS Interfaces Properties

Purpose Verify that the DOCSIS interface properties are configured properly.

Action From the CLI configuration editor, enter the show interfaces interface-name extensive
command.

Sample Output show interfaces cm-1/0/0 extensive

Physical interface: cm-1/0/0, Enabled, Physical link is Up

  Interface index: 154, SNMP ifIndex: 522, Generation: 157

  Link-level type: Ethernet, MTU: 1518, Speed: 40mbps

  Link flags     : None

  Hold-times     : Up 0 ms, Down 0 ms

   State   : OPERATIONAL, Mode: 2.0, Upstream speed: 5120000 0 0 0

   Downstream scanning: CM_MEDIA_STATE_DONE, Ranging: CM_MEDIA_STATE_DONE

   Signal to noise ratio: 31.762909 21.390018  7.517472 14.924058

   Power: -15.756125 -31.840363 -31.840363 -31.840363

   Downstream buffers used           : 0

   Downstream buffers free           : 0
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   Upstream buffers free             : 0

   Upstream buffers used             : 0

   Request opportunity burst         : 0 MSlots

   Physical burst                    : 0 MSlots

   Tuner frequency                   : 555 0 0 0 MHz

   Standard short grant              : 0 Slots

   Standard long grant               : 0 Slots

   Baseline privacy state: authorized, Encryption algorithm: ????, Key length: 0

  MAC statistics:                      Receive         Transmit

    Total octets                          1935             2036

    Total packets                            8                8

    CRC/Align errors                         0                0

    Oversized frames                         0

  CoS queues     : 8 supported, 8 maximum usable queues

  Current address: 00:24:dc:0d:76:19, Hardware address: 00:24:dc:0d:76:19

  Last flapped   : 2009-11-10 19:55:40 UTC (00:16:29 ago)

  Statistics last cleared: Never

  Traffic statistics:

   Input  bytes  :                  710                    0 bps

   Output bytes  :                  866                    0 bps

   Input  packets:                    2                    0 pps

   Output packets:                    4                    0 pps

  Packet Forwarding Engine configuration:

    Destination slot: 1

    Direction : Output

    CoS transmit queue               Bandwidth               Buffer Priority   
Limit

                              %            bps     %           usec

    0 best-effort            95       38000000    95              0      low    
none

    3 network-control         5        2000000     5              0      low    
none
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  Logical interface cm-1/0/0.0 (Index 69) (SNMP ifIndex 523) (Generation 134)

    Flags: Point-To-Point SNMP-Traps Encapsulation: ENET2

    Traffic statistics:

     Input  bytes  :                  710

     Output bytes  :                  806

     Input  packets:                    2

     Output packets:                    4

    Local statistics:

     Input  bytes  :                  710

     Output bytes  :                  806

     Input  packets:                    2

     Output packets:                    4

    Transit statistics:

     Input  bytes  :                    0                    0 bps

     Output bytes  :                    0                    0 bps

     Input  packets:                    0                    0 pps

     Output packets:                    0                    0 pps

    Security: Zone: Null

    Flow Statistics :

    Flow Input statistics :

      Self packets :                     0

      ICMP packets :                     0

      VPN packets :                      0

      Multicast packets :                0

      Bytes permitted by policy :        0

      Connections established :          0

    Flow Output statistics:

      Multicast packets :                0

      Bytes permitted by policy :        0
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    Flow error statistics (Packets dropped due to):

      Address spoofing:                  0

      Authentication failed:             0

      Incoming NAT errors:               0

      Invalid zone received packet:      0

      Multiple user authentications:     0

      Multiple incoming NAT:             0

      No parent for a gate:              0

      No one interested in self packets: 0

      No minor session:                  0

      No more sessions:                  0

      No NAT gate:                       0

      No route present:                  0

      No SA for incoming SPI:            0

      No tunnel found:                   0

      No session for a gate:             0

      No zone or NULL zone binding       0

      Policy denied:                     0

      Security association not active:   0

      TCP sequence number out of window: 0

      Syn-attack protection:             0

      User authentication errors:        0

    Protocol inet, MTU: 1504, Generation: 147, Route table: 0

      Flags: None

      Addresses, Flags: Is-Preferred Is-Primary

        Destination: 20.20.20/24, Local: 20.20.20.5, Broadcast: 20.20.20.255, 
Generation: 144

Meaning The output shows a summary of information about the DOCSIS interface in this
example.
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Chapter 7

Configuring VDSL2 Interface

This chapter includes following sections:

■ Before You Begin on page 189

■ Configuring the VDSL2 Interface with the CLI Configuration Editor on page 189

■ Example: Configuring the VDSL2 Interface on SRX Series Services Gateways
(CLI) on page 191

■ Example: Configuring the ADSL Interface on SRX Series Services Gateway
(CLI) on page 208

Before You Begin

Before you begin configuring VDSL2 interfaces, complete the following tasks:

■ Establish basic connectivity. See the Getting Started Guide for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

■ Configure network interfaces as necessary. See “Configuring Ethernet, DS1, DS3,
and Serial Interfaces” on page 81.

Configuring the VDSL2 Interface with the CLI Configuration Editor

NOTE: J-Web support for configuring the VDSL2 Interface is not available in JUNOS
Software Release 10.1.

To use the CLI configuration editor to configure the VDSL2 network interfaces for
SRX210 and SRX240 devices:

1. Navigate to the top of the interfaces configuration hierarchy in the CLI
configuration editor.

2. Perform the configuration tasks described in Table 47 on page 190.

3. Commit the configuration once you have completed configuring the device.
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NOTE: The VDSL2 Mini-PIM has backward compatibility with ADSL/ADSL2/ADSL2+.
The VDSL2 interface is represented by the pt interface when configured to function
as VDSL2, and the ADSL interface is represented by the at interface when configured
to function as ADSL.

Table 47: Configuring the VDSL2 Interface Using the CLI Configuration Editor

DescriptionCLI Configuration EditorTask

Provides a hierarchy level to configure the
interface.

From the [edit] hierarchy
level, enter

edit interfaces pt-1/0/0

Navigate to the  Interfaces level in the
configuration hierarchy.

Configuring Physical Properties

The following profiles are supported:

■ 8a

■ 8b

■ 8c

■ 8d

■ 12a

■ 12b

■ 17a

■ auto (default)

From the [edit] hierarchy
level, enter

set interfaces interface
name vdsl-options
vdsl-profile profile-name

Example

set interfaces pt-1/0/0
vdsl-options vdsl-profile
auto

Configure the type of VDSL2 profiles.

Configuring Logical Properties

Defines one or more logical units that you
connect to this physical VDSL interface.

Set a value from 0 through 16385. Add other
values if required by your network.

From the [edit] hierarchy
level, enter

set interfaces interface
name unit unit value

Example:

set interfaces pt-1/0/0
unit 0

Add the logical interface.

Specifies the type of encapsulation on the VDSL
logical interface.

■ ppp-over-ether—Use this type of
encapsulation for PPPoE over VDSL
interfaces that carry IPv4 traffic.

NOTE: The encapsulation type Point-to-Point
Protocol over Ethernet (PPPoE) is supported for
the VDSL2 interface. You can also set no
encapsulation for the VDSL2 interface.

set interfaces interface
name unit unit value
encapsulation
encapsulation-type

Example:

set interfaces pt-1/0/0
unit 0 encapsulation
ppp-over-ether

Select the encapsulation for the logical interface.

190 ■ Configuring the VDSL2 Interface with the CLI Configuration Editor

JUNOS Software Interfaces and Routing Configuration Guide



Table 47: Configuring the VDSL2 Interface Using the CLI Configuration Editor (continued)

DescriptionCLI Configuration EditorTask

Commands vary depending on the protocol type.set interfaces interface
name unit unit value
family inet

Example:

set interfaces pt-1/0/0
unit 0 family inet

Add the Family protocol type—for example,
inet.

NOTE: See “Configuring ATM-over-ADSL Interfaces” on page 135 for details about
configuring the interface when operating in ADSL mode.

Example: Configuring the VDSL2 Interface on SRX Series Services Gateways (CLI)

This topic provides information on the minimum steps required to configure a VDSL2
interface on SRX Series devices. The configuration example uses an SRX210 device;
the information is also applicable to the SRX240 device.

This topic includes the following sections:

■ Requirements on page 191

■ Overview on page 191

■ Before You Begin on page 192

■ VDSL2 Interface Configuration on page 193

Requirements

Before you configure the VDSL2 interface, be sure you have completed the following
tasks:

■ Install JUNOS Software Release 10.1 or later for the SRX Series devices.

■ Set up and perform initial configuration on the SRX Series device.

■ Install the VDSL2 Mini-PIM on the SRX210 device chassis.

■ Connect the SRX210 device to a DSLAM.

Overview

The SRX210 and SRX240 devices support the VDSL2 Mini-Physical Interface Module
(Mini-PIM) (Annex A). The VDSL2 Mini-PIM carries the Ethernet backplane. When
the Mini-PIM is plugged into the chassis, the Mini-PIM connects to one of the ports
of the baseboard switch. The VDSL2 Mini-PIM on the SRX Series devices provides
ADSL backward compatibility.
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Figure 30 on page 192 shows a typical SRX Series Services Gateway VDSL2 Mini-PIM
network connection.

Figure 30: SRX Series Services Gateway VDSL2 Mini-PIM End-to-End Deployment
Scenario

Before You Begin

Note the following before you start configuration:

■ On the VDSL2 Mini-PIMs, by default the pt-1/0/0 interface is created when there
is no configuration already created for either pt-1/0/0 or at-1/0/0 interface. You
can switch to ADSL mode by just configuring at-1/0/0. If the configurations are
already created for pt-1/0/0 or at-1/0/0, then you need to deactivate pt-1/0/0
before you create at-1/0/0 or deactivate at-1/0/0 to create pt-1/0/0.

Use the following commands to deactivate pt-1/0/0 or at-1/0/0:

■ deactivate interface pt-1/0/0

■ deactivate interface at-1/0/0

■ Before you begin a new configuration, make sure that you have deleted the
previous configurations on pt-1/0/0 and pp0.

Use following command to delete the old configuration:

■ delete interface pt-1/0/0

■ delete interface pp0
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VDSL2 Interface Configuration

This section provides information about the following configurations:

■ VDSL2 Mini-PIM Default Configuration and Verification on page 193

■ Configuring the VDSL2 Interface for End-to-End Data Path on page 196

■ Configuring PPPoE on the pt–x/x/x Interface with a Static IP Address on page 199

■ Configuring PPPoE on the pt-x/x/x Interface with a Static IP Address (CHAP
Authentication) on page 200

■ Configuring PPPoE on the pt-x/x/x Interface with Unnumbered IP (PAP
Authentication) on page 202

■ Configuring PPPoE on the pt-x/x/x Interface with Unnumbered IP (CHAP
Authentication) on page 203

■ Configuring PPPoE on the pt-x/x/x Interface with Negotiated IP (PAP
Authentication) on page 205

■ Configuring PPPoE on the pt-x/x/x Interface with Negotiated IP (CHAP
Authentication) on page 206

VDSL2 Mini-PIM Default Configuration and Verification

2. Verify the FPC status by entering the show chassis fpc command. The output
should display FPC status as online.

user@host# run show chassis fpc
Temp CPU Utilization (%) Memory Utilization
(%)
Slot State (C) Total Interrupt DRAM (MB) Heap Buffer
0 Online -------------------- CPU less FPC --------------------
1 Online -------------------- CPU less FPC --------------------

NOTE: The VDSL2 Mini-PIM is installed in the first slot of the SRX210 device chassis;
therefore the FPC used here is fpc 1. For SRX240 devices, the FPC used will be fpc
1, fpc 2, fpc 3, or fpc 4.

3. Enter run show interface pt-1/0/0 and verify the following information in the
command output:

■ Status of interface pt-1/0/0 is displayed as physical link is up.

■ Modem status is displayed as Showtime (Profile-17a).

■ Time in seconds during which the interface stayed up is displayed as Seconds
in Showtime.

■ VDSL profile is displayed as Auto Annex A.
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Physical interface: pt-1/0/0, Enabled, Physical link is Up
 Interface index: 146, SNMP ifIndex: 524, Generation: 149
 Type: PTM, Link-level type: Ethernet, MTU: 1496, VDSL mode, Speed:    
45440kbps
 Speed: VDSL2
 Device flags : Present Running
 Link flags : None
 CoS queues : 8 supported, 8 maximum usable queues
 Hold-times : Up 0 ms, Down 0 ms
 Current address: 00:b1:7e:85:84:ff
 Last flapped : 2009-10-18 11:56:50 PDT (12:32:49 ago)
 Statistics last cleared: 2009-10-19 00:29:37 PDT (00:00:02 ago)
 Traffic statistics:
  Input bytes : 22438962 97070256 bps
  Output bytes : 10866024 43334088 bps
  Input packets: 15141 8187 pps
  Output packets: 7332 3655 pps
Input errors:
   Errors: 0, Drops: 0, Policed discards: 0, L3 incompletes: 0,
   L2 channel errors: 0, L2 mismatch timeouts: 0, Resource errors: 0
 Output errors:
  Carrier transitions: 0, Errors: 0, Drops: 0, Aged packets: 0, MTU  
errors: 0,
  Resource errors: 0
 Egress queues: 8 supported, 4 in use
 Queue counters: Queued packets Transmitted packets Dropped packets
    0 best-effort 6759 6760 0
    1 expedited-fo 0 0 0
    2 assured-forw 0 0 0
    3 network-cont 0 0 0
VDSL alarms : None
VDSL defects : None
VDSL media: Seconds Count State
   LOF 0 0 OK
   LOS 0 0 OK
   LOM 0 0 OK
   LOP 0 0 OK
   LOCDI 0 0 OK
   LOCDNI 0 0 OK
VDSL status:
  Modem status : Showtime (Profile-17a)
  VDSL profile : Profile-17a Annex A
  Last fail code: None
  Subfunction : 0x00
  Seconds in showtime : 45171
VDSL Chipset Information: VTU-R VTU-C
 Vendor Country : 0xb5 0xb5
  Vendor ID : BDCM BDCM
  Vendor Specific: 0x9385 0x9385
VDSL Statistics: VTU-R VTU-C
  Attenuation (dB) : 0.0 0.0
  Capacity used (%) : 0 0
  Noise margin (dB) : 20.0 20.0
  Output power (dBm) : 6.0 12.0
                      Interleave Fast Interleave Fast
  Bit rate (kbps) :     100004     0    45440       0
  CRC :                 0          0    0           0
 FEC :                  0          0    0            0
 HEC :                  0          0    0            0
Packet Forwarding Engine configuration:
  Destination slot: 0 (0x00)
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CoS information:
   Direction : Output
   CoS transmit queue Bandwidth Buffer Priority
Limit
                        %        bps        %       usec
   0 best-effort        95       43168000   95       0      low
none
   3 network-control    5        2272000    5        0       low
none
Logical interface pt-1/0/0.0 (Index 71) (SNMP ifIndex 525) (Generation 
136)
    Flags: SNMP-Traps Encapsulation: ENET2
    Traffic statistics:
      Input bytes :  23789064
      Output bytes :  10866024
      Input packets:   16052
      Output packets:   7332
    Local statistics:
      Input bytes : 0
      Output bytes : 0
      Input packets: 0
      Output packets: 0
    Transit statistics:
      Input bytes :  23789064  97070256 bps
      Output bytes :  10866024  43334088 bps
      Input packets:  16052  8187 pps
       Output packets:  7332   3655 pps
     Security: Zone: Null
     Flow Statistics :
    Flow Input statistics :
      Self packets :                     0
      ICMP packets :                     0
      VPN packets :                      0
      Multicast packets :                0
      Bytes permitted by policy :        0
      Connections established :          0
    Flow Output statistics:
      Multicast packets :                0
      Bytes permitted by policy :        0
    Flow error statistics (Packets dropped due to):
      Address spoofing:                  0
      Authentication failed:             0
      Incoming NAT errors:               0
      Invalid zone received packet:      0
      Multiple user authentications:     0
      Multiple incoming NAT:             0
      No parent for a gate:              0
      No one interested in self packets: 0
      No minor session:                  0
      No more sessions:                  0
      No NAT gate:                       0
      No route present:                  0
      No SA for incoming SPI:            0
      No tunnel found:                   0
      No session for a gate:             0
      No zone or NULL zone binding       0
      Policy denied:                     0
      Security association not active:   0
      TCP sequence number out of window: 0
      Syn-attack protection:             0
      User authentication errors:        0
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    Protocol inet, MTU: 1482, Generation: 169, Route table: 0
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary

   Destination: 10.10.10/24, Local: 10.10.10.1, Broadcast:  10.10.10.255,
Generation: 158

Configuring the VDSL2 Interface for End-to-End Data Path

The following steps provide the basic configuration details for the VDSL2 interface
on an SRX210 device for end-to-end data path.

1. Configure the VDSL2 interface with the VDSL profile and the Layer-3
configuration.

user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 family inet address 11.11.11.1/24
[edit]
user@host# commit
commit complete

2. Verify interface status by using the show interface terse command and test
end-to-end data path connectivity by sending the ping packets to the remote
end IP address.

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up   inet     11.11.11.1/24

[edit]
user@host# run ping 11.11.11.2 count 1000 rapid
PING 11.11.11.2 (11.11.11.2): 56 data bytes
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
- 11.11.11.2 ping statistics ---
1000 packets transmitted, 1000 packets received, 0% packet loss
round-trip min/avg/max/stddev = 16.109/17.711/28.591/2.026 ms

3. Verify the VDSL2 interface configuration and check the traffic statistics.

user@host# run show interfaces pt-1/0/0 extensive
Physical interface: pt-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 524, Generation: 197
  Type: PTM, Link-level type: Ethernet, MTU: 1496, VDSL mode, Speed: 
45440kbps
  Speed: VDSL2
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 00:36:29 PDT (00:12:03 ago)
  Statistics last cleared: 2009-10-28 00:47:56 PDT (00:00:36 ago)
  Traffic statistics:
   Input  bytes  :                84000                    0 bps
   Output bytes  :               138000                    0 bps
   Input  packets:                 1000                    0 pps
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   Output packets:                 1000                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Policed discards: 0, L3 incompletes: 0, L2 channel
 errors: 0, L2 mismatch timeouts: 0, Resource errors: 0
  Output errors:
    Carrier transitions: 0, Errors: 0, Drops: 0, Aged packets: 0, MTU 
errors: 0, Resource errors: 0
  Egress queues: 8 supported, 4 in use
  Queue counters:       Queued packets  Transmitted packets      Dropped
 packets
    0 best-effort                 1000                 1000             
       0
    1 expedited-fo                   0                    0             
       0
    2 assured-forw                   0                    0             
       0
    3 network-cont                   0                    0             
       0
  VDSL  alarms   : None
  VDSL  defects  : None
  VDSL media:            Seconds        Count  State
    LOF                          0            0  OK
    LOS                          0            0  OK
    LOM                          0            0  OK
    LOP                          0            0  OK
    LOCDI                        0            0  OK
    LOCDNI                       0            0  OK
  VDSL status:
    Modem status  : Showtime (Profile-17a)
    VDSL profile  : Profile-17a Annex A
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 723
  VDSL Chipset Information:               VTU-R                  VTU-C
    Vendor Country :                       0xb5                   0xb5
    Vendor ID      :                       BDCM                   BDCM
    Vendor Specific:                     0x9385                 0x9385
  VDSL Statistics:                        VTU-R                  VTU-C
    Attenuation (dB)         :              0.0                    0.0
    Capacity used (%)        :                0                      0
    Noise margin (dB)        :             16.0                   20.0
    Output power (dBm)       :              5.0                   13.0

                                  Interleave       Fast  Interleave     
  Fast
    Bit rate (kbps)   :                100004         0       45440     
     0
    CRC               :                    0          0           0     
     0
    FEC               :                    0          0           0     
     0
    HEC               :                    0          0           0     
     0
  Packet Forwarding Engine configuration:
    Destination slot: 0 (0x00)
  CoS information:
    Direction : Output
    CoS transmit queue               Bandwidth               Buffer 
Priority   Limit
                              %            bps     %           usec
    0 best-effort            95       43168000    95              0     

Example: Configuring the VDSL2 Interface on SRX Series Services Gateways (CLI) ■ 197

Chapter 7: Configuring VDSL2 Interface



 low    none
    3 network-control         5        2272000     5              0     
 low    none

  Logical interface pt-1/0/0.0 (Index 72) (SNMP ifIndex 521) (Generation
 158)
    Flags: SNMP-Traps Encapsulation: ENET2
    Traffic statistics:
     Input  bytes  :                84000
     Output bytes  :                98000
     Input  packets:                 1000
     Output packets:                 1000
    Local statistics:
     Input  bytes  :                84000
     Output bytes  :                98000
     Input  packets:                 1000
     Output packets:                 1000
    Transit statistics:
     Input  bytes  :                    0                    0 bps
     Output bytes  :                    0                    0 bps
     Input  packets:                    0                    0 pps
     Output packets:                    0                    0 pps
    Security: Zone: Null
    Flow Statistics :
    Flow Input statistics :
      Self packets :                     0
      ICMP packets :                     0
      VPN packets :                      0
      Multicast packets :                0
      Bytes permitted by policy :        0
      Connections established :          0
    Flow Output statistics:
      Multicast packets :                0
      Bytes permitted by policy :        0
    Flow error statistics (Packets dropped due to):
      Address spoofing:                  0
      Authentication failed:             0
      Incoming NAT errors:               0
      Invalid zone received packet:      0
      Multiple user authentications:     0
      Multiple incoming NAT:             0
      No parent for a gate:              0
      No one interested in self packets: 0
      No minor session:                  0
      No more sessions:                  0
      No NAT gate:                       0
      No route present:                  0
      No SA for incoming SPI:            0
      No tunnel found:                   0
      No session for a gate:             0
      No zone or NULL zone binding       0
      Policy denied:                     0
      Security association not active:   0
      TCP sequence number out of window: 0
      Syn-attack protection:             0
      User authentication errors:        0
    Protocol inet, MTU: 1482, Generation: 169, Route table: 0
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 11.11.11/24, Local: 11.11.11.1, Broadcast: 
11.11.11.255, Generation: 189
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Configuring PPPoE on the pt–x/x/x Interface with a Static IP Address

1. Configure the VDSL2 interface on the SRX210 device.

user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 encapsulation ppp-over-ether
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap access-profile
pap_prof
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-name locky
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-password india
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap passive
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface
pt-1/0/0.0
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client
[edit]
user@host# set interfaces pp0 unit 0 family inet address 10.1.1.6/24
[edit]
user@host# set access profile pap_prof authentication-order password
[edit]
user@host# set access profile pap_prof client cuttack pap-password india
[edit]
user@host# commit
commit complete

2. Verify the interface output.

user@host# run show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0
    Output packets: 0

  Logical interface pp0.0 (Index 71) (SNMP ifIndex 522)
    Flags: Hardware-Down Point-To-Point SNMP-Traps 0x0 Encapsulation: 
PPPoE
    PPPoE:
      State: SessionDown, Session ID: None,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: pt-1/0/0.0 (Index 69)
    Input packets : 57
    Output packets: 56
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 22 (00:00:40 ago), Output: 25 (00:00:04 ago)
  LCP state: Down
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  NCP state: inet: Down, inet6: Not-configured, iso: Not-configured, mpls:
 Not-configured
  CHAP state: Closed
  PAP state: Closed
    Security: Zone: Null
    Protocol inet, MTU: 1492
      Flags: Protocol-Down
      Addresses, Flags: Dest-route-down Is-Preferred Is-Primary
        Destination: 10.1.1/24, Local: 10.1.1.6

3. Verify the end-to-end data path on the interface.

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up

[edit]
user@host# run show interfaces pp0 terse
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up
pp0.0                   up    up   inet     10.1.1.6/24

[edit]
user@host# run ping 10.1.1.1 count 100 rapid
PING 10.1.1.1 (10.1.1.1): 56 data bytes
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
- 10.1.1.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 14.669/15.649/21.655/1.740 ms

Configuring PPPoE on the pt-x/x/x Interface with a Static IP Address
(CHAP Authentication)

1. Configure the VDSL interface on the SRX210 device.

user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 encapsulation ppp-over-ether
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap default-chap-secret
india
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap local-name locky
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap passive
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface
pt-1/0/0.0
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client
[edit]
user@host# set interfaces pp0 unit 0 family inet address 10.1.1.6/24
[edit]
user@host# commit
commit complete
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2. Verify the interface status.

user@host# run show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0
    Output packets: 0

  Logical interface pp0.0 (Index 70) (SNMP ifIndex 522)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 31,
      Session AC name: cuttack, Remote MAC address: 00:03:6c:c8:8c:55,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: pt-1/0/0.0 (Index 69)
    Input packets : 12
    Output packets: 10
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 1 (00:00:08 ago), Output: 0 (never)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: Null
    Protocol inet, MTU: 1492
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 10.1.1/24, Local: 10.1.1.6

3. Verify the interface and check end-to-end data path connectivity.

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up

[edit]
user@host# run show interfaces pp0 terse
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up
pp0.0                   up    up   inet     10.1.1.6/24

[edit]
user@host# run ping 10.1.1.1 count 100 rapid
PING 10.1.1.1 (10.1.1.1): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 10.1.1.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 14.608/15.466/25.939/1.779 ms
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Configuring PPPoE on the pt-x/x/x Interface with Unnumbered IP (PAP
Authentication)

1. Configure the VDSL2 interface on the SRX210 device:

 user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 encapsulation ppp-over-ether
[edit]
user@host# set interfaces lo0 unit 0 family inet address 10.1.1.24/32
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap access-profile
pap_prof
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-name locky
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-password india
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap passive
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface
pt-1/0/0.0
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client
[edit]
user@host# set interfaces pp0 unit 0 family inet unnumbered-address lo0.0
[edit]
user@host# set interfaces pp0 unit 0 family inet unnumbered-address
destination 10.1.1.1
[edit]
user@host# set access profile pap_prof authentication-order password
[edit]
user@host# set access profile pap_prof client cuttack pap-password india
[edit]
user@host# commit
commit complete

2. Verify the interface status.

user@host# run show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0
    Output packets: 0

  Logical interface pp0.0 (Index 72) (SNMP ifIndex 522)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 33,
      Session AC name: cuttack, Remote MAC address: 00:03:6c:c8:8c:55,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
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      Underlying interface: pt-1/0/0.0 (Index 69)
    Input packets : 22
    Output packets: 20
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 1 (00:00:08 ago), Output: 0 (never)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Closed
  PAP state: Success
    Security: Zone: Null
    Protocol inet, MTU: 1492
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 10.1.1.1, Local: 10.1.1.24

3. Verify the end-to-end data path testing.

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up

[edit]
user@host# run show interfaces pp0 terse
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up
pp0.0                   up    up   inet     10.1.1.24           --> 
10.1.1.1

[edit]
user@host# run ping 10.1.1.1 count 100 rapid
PING 10.1.1.1 (10.1.1.1): 56 data bytes
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 10.1.1.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 14.584/15.503/21.204/1.528 ms

Configuring PPPoE on the pt-x/x/x Interface with Unnumbered IP (CHAP
Authentication)

1. Configure the VDSL2 interface on the SRX210 device:

 user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 encapsulation ppp-over-ether
[edit]
user@host# set interfaces lo0 unit 0 family inet address 10.1.1.24/32
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap default-chap-secret
india
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap local-name locky
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap passive
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface
pt-1/0/0.0
[edit]
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user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client
[edit]
user@host# set interfaces pp0 unit 0 family inet unnumbered-address lo0.0
[edit]
user@host# set interfaces pp0 unit 0 family inet unnumbered-address
destination 10.1.1.1
[edit]
user@host# commit
commit complete

2. Verify the interface status.

user@host# run show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0
    Output packets: 0

  Logical interface pp0.0 (Index 70) (SNMP ifIndex 522)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 35,
      Session AC name: cuttack, Remote MAC address: 00:03:6c:c8:8c:55,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: pt-1/0/0.0 (Index 69)
    Input packets : 25
    Output packets: 22
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 2 (00:00:10 ago), Output: 2 (00:00:02 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: Null
    Protocol inet, MTU: 1492
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 10.1.1.1, Local: 10.1.1.24

3. Verify the end-to-end data path testing on the PPPOE interface.

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up

[edit]
user@host# run show interfaces pp0 terse
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up
pp0.0                   up    up   inet     10.1.1.24           --> 
10.1.1.1
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[edit]
user@host# run ping 10.1.1.1 count 100 rapid
PING 10.1.1.1 (10.1.1.1): 56 data bytes
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
-- 10.1.1.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 14.585/16.025/22.354/2.019 ms

Configuring PPPoE on the pt-x/x/x Interface with Negotiated IP (PAP
Authentication)

1. Configure the VDSL2 interface on the SRX210 device.

user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 encapsulation ppp-over-ether
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap access-profile my_prf
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-name purple
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-password
Embe1mpls
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap passive

[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface
pt-1/0/0.0
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client
[edit]
user@host# set interfaces pp0 unit 0 family inet negotiate-address
[edit]
user@host# set access profile my_prf authentication-order password
[edit]
user@host# set access-profile my_prf
[edit]
user@host# commit
commit complete

2. Verify the PPPoE interface status.

user@host# run show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0
    Output packets: 0

  Logical interface pp0.0 (Index 72) (SNMP ifIndex 522)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
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    PPPoE:
      State: SessionUp, Session ID: 4,
      Session AC name: belur, Remote MAC address: 00:90:1a:43:18:d1,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: pt-1/0/0.0 (Index 69)
    Input packets : 18
    Output packets: 18
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 0 (never), Output: 11 (00:00:01 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Closed
  PAP state: Success
    Security: Zone: Null
    Protocol inet, MTU: 1474
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 12.12.12.1, Local: 12.12.12.11

3. Verify the end-to-end data path connectivity.

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up

[edit]
user@host# run show interfaces pp0 terse
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up
pp0.0                   up    up   inet     12.12.12.11         --> 
12.12.12.1

[edit]
user@host# run ping 12.12.12.1 count 100 rapid
PING 12.12.12.1 (12.12.12.1): 56 data bytes
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 12.12.12.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 16.223/17.692/24.359/2.292 ms

Configuring PPPoE on the pt-x/x/x Interface with Negotiated IP (CHAP
Authentication)

1. Configure the VDSL2 interface on the SRX210 device.

 user@host# set interfaces pt-1/0/0 vdsl-options vdsl-profile 17a
[edit]
user@host# set interfaces pt-1/0/0 unit 0 encapsulation ppp-over-ether
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap default-chap-secret
Embe1mpls
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap local-name purple
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap passive
[edit]
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user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface
pt-1/0/0.0
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client
[edit]
user@host# set interfaces pp0 unit 0 family inet negotiate-address
user@host# commit

2. Verifying the interface status.

user@host# run show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0
    Output packets: 0

  Logical interface pp0.0 (Index 70) (SNMP ifIndex 522)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 8,
      Session AC name: belur, Remote MAC address: 00:90:1a:43:18:d1,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: pt-1/0/0.0 (Index 69)
    Input packets : 12
    Output packets: 11
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 0 (never), Output: 4 (00:00:03 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: Null
    Protocol inet, MTU: 1474
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 12.12.12.1, Local: 12.12.12.12

3. Verify the end-to-end data path connectivity:

user@host# run show interfaces pt-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
pt-1/0/0                up    up
pt-1/0/0.0              up    up

[edit]
user@host# run show interfaces pp0 terse
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up
pp0.0                   up    up   inet     12.12.12.12         --> 
12.12.12.1

[edit]
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user@host# run ping 12.12.12.1 count 100 rapid
PING 12.12.12.1 (12.12.12.1): 56 data bytes
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 12.12.12.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 16.168/17.452/23.299/2.016 ms

Example: Configuring the ADSL Interface on SRX Series Services Gateway (CLI)

This topic includes the following sections:

■ Requirements on page 208

■ Overview on page 208

■ ADSL Interface Configuration on page 208

Requirements

Before you configure the ADSL2 interface, be sure you have completed the following
tasks:

■ Install JUNOS Software Release 10.1 or later for the SRX Series devices.

■ Set up and perform initial configuration on the SRX Series device.

■ Install the VDSL2 Mini-PIM on the SRX210 device chassis.

■ SRX210 device is connected to a DSLAM that supports VDSL2 to ADSL fallback.

Overview

The SRX210 and SRX240 devices support the VDSL2 Mini-Physical Interface Module
(Mini-PIM) (Annex A). The VDSL2 Mini-PIM carries the Ethernet backplane. When
the Mini-PIM is plugged into the chassis, the Mini-PIM connects to one of the ports
of the baseboard switch. The VDSL2 Mini-PIM on the SRX Series devices provides
ADSL backward compatibility. The VDSL2 uses EFM or PTM mode as first mile and
is represented as pt-x/x/x. In case of ADSL fallback mode, the VDSL2 Mini-PIM
operates on the ATM encapsulation interface as first mile and is represented as
at-x/x/x.

ADSL Interface Configuration

This section provides information about the following configurations:

■ Configuring the ADSL Interface for End-to-End Data Path on page 209

■ Configuring PPPoA on the at-x/x/x Interface with Negotiated IP (CHAP
Authentication) on page 211

■ Configuring PPPoA on the at-x/x/x Interface with Negotiated IP (PAP
Authentication) on page 212

■ Configuring PPPoA on the at-x/x/x Interface with Static IP (CHAP
Authentication) on page 214
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■ Configuring PPPoA on the at-x/x/x Interface with Static IP (PAP
Authentication) on page 216

■ Configuring PPPoA on the at-x/x/x Interface with Unnumbered IP (PAP
Authentication) on page 218

■ Configuring PPPoA on the at-x/x/x Interface with Unnumbered IP (CHAP
Authentication) on page 220

■ Configuring PPPoE over ATM on the at-x/x/x Interface with Negotiated IP (PAP
Authentication) on page 222

■ Configuring PPPoE over ATM on the at-x/x/x Interface with Negotiated IP (CHAP
Authentication) on page 223

Configuring the ADSL Interface for End-to-End Data Path

The following steps provide the basic configuration details for the ADSL interface on
an SRX210 device for end-to-end data path for "second mile" ATM.

1. Configure the ADSL interface:

user@host# delete interfaces at-1/0/0
[edit]
user@host# set interfaces at-1/0/0 encapsulation atm-pvc
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2
[edit]
user@host# set interfaces at-1/0/0 dsl-options operating-mode itu-dmt
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-snap
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet address 10.10.10.1/24
[edit]
user@host# commit
commit complete
[edit]
user@host#

2. Verify interface status by using the show interface terse command and test
end-to-end data path connectivity by sending the ping packets to remote end IP
address.

user@host# run show interfaces at-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up
at-1/0/0.0              up    up   inet     10.10.10.1/24
at-1/0/0.32767          up    up

[edit]
user@host# run ping 10.10.10.2 count 1000 rapid
PING 10.10.10.2 (10.10.10.2): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 10.10.10.2 ping statistics ---
1000 packets transmitted, 1000 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.141/9.356/58.347/3.940 ms
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[edit]
user@host#

3. Verify the ADSL interface and traffic statistics.

user@host# run show interfaces at-1/0/0
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode,
  Speed: ADSL
  Speed: 832kbps, Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 02:14:45 PDT (00:09:54 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 0 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :  Itu-dmt    Annex A
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 596

  Logical interface at-1/0/0.0 (Index 69) (SNMP ifIndex 523)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-SNAP
    Input packets : 1000
    Output packets: 1000
    Security: Zone: Null
    Protocol inet, MTU: 1456
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 10.10.10/24, Local: 10.10.10.1, Broadcast: 
10.10.10.255
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 1000
        Output packets: 1000

  Logical interface at-1/0/0.32767 (Index 70) (SNMP ifIndex 525)
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0
    Encapsulation: ATM-VCMUX
    Input packets : 0
    Output packets: 0
    Security: Zone: Null
    VCI 2.4
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 0
        Output packets: 0
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Configuring PPPoA on the at-x/x/x Interface with Negotiated IP (CHAP
Authentication)

1. Configure the Point-to-Point Protocol over ATM (PPPoA) on ADSL PHY for "second
mile" ATM.

user@host# set interfaces at-1/0/0 encapsulation atm-pvc
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options chap access-profile
 jnpr
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options chap local-name 
locky
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet negotiate-address
[edit]
user@host# set access profile jnpr client sringeri chap-secret india
[edit]
user@host# commit
ommit complete
[edit]
user@host#

2. Verify the interface output:

user@host# run show interfaces at-1/0/0
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode, 
Speed: ADSL
  Speed: 832kbps, Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 02:39:14 PDT (00:01:37 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 80 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :     Auto    Annex A
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 97

  Logical interface at-1/0/0.0 (Index 71) (SNMP ifIndex 523)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-PPP-LLC
    Input packets : 26
    Output packets: 29
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 10 (00:00:02 ago), Output: 8 (00:00:06 ago)
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  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: Null
    Protocol inet, MTU: 1486
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 100.100.100.6, Local: 100.100.100.1
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 26
        Output packets: 29

  Logical interface at-1/0/0.32767 (Index 70) (SNMP ifIndex 525)
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation:
 ATM-VCMUX
    Input packets : 0
    Output packets: 0
    Security: Zone: Null
    VCI 2.4
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 0
        Output packets: 0

3. Verify the end-to-end data path connectivity:

user@host# run show interfaces at-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up
at-1/0/0.0              up    up   inet     100.100.100.1       --> 
100.100.100.6
at-1/0/0.32767          up    up

[edit]
user@host# run ping 100.100.100.6 count 100 rapid
PING 100.100.100.6 (100.100.100.6): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 100.100.100.6 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.231/9.167/58.852/5.716 ms

Configuring PPPoA on the at-x/x/x Interface with Negotiated IP (PAP
Authentication)

1. Configure the PPPoA on ADSL PHY for "second mile" ATM.

user@host# set interfaces at-1/0/0 encapsulation atm-pvc
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2
[edit]
user@host# set interfaces at-1/0/0 dsl-options operating-mode auto
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc
[edit]
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user@host# set interfaces at-1/0/0 unit 0 vci 2.119
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap access-profile
 jnpr
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap local-name locky
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap local-password
 india
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet negotiate-address
[edit]
user@host# set access profile jnpr client sringeri pap-password india
[edit]
user@host# commit
commit complete

2. Verify the Interface status.

user@host# run show interfaces at-1/0/0
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode, 
Speed: ADSL
  Speed: 832kbps, Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 02:39:14 PDT (00:09:29 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 80 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :     Auto    Annex A
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 571

  Logical interface at-1/0/0.0 (Index 69) (SNMP ifIndex 523)
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-PPP-LLC
    Input packets : 2
    Output packets: 2
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 8 (00:00:01 ago), Output: 9 (00:00:03 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Closed
  PAP state: Success
    Security: Zone: Null
    Protocol inet, MTU: 1486
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 100.100.100.6, Local: 100.100.100.1
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 2
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        Output packets: 2

  Logical interface at-1/0/0.32767 (Index 70) (SNMP ifIndex 525)
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation:
 ATM-VCMUX
    Input packets : 0
    Output packets: 0
    Security: Zone: Null
    VCI 2.4
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 0
        Output packets: 0

3. Verify the interface and check end-to-end data path connectivity.

user@host# run show interfaces at-1/0/0 terse
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up
at-1/0/0.0              up    up   inet     100.100.100.1       --> 
100.100.100.6
at-1/0/0.32767          up    up

[edit]
user@host# run ping 100.100.100.6 count 100 rapid
PING 100.100.100.6 (100.100.100.6): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 100.100.100.6 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.056/8.501/14.194/1.787 ms

Configuring PPPoA on the at-x/x/x Interface with Static IP (CHAP
Authentication)

1. Configure the PPPoA on ADSL PHY for "second mile" ATM.

user@host# set interfaces at-1/0/0 encapsulation atm-pvc 
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2 
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119 
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options chap access-profile
 jnpr
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options chap local-name 
locky 
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet address 
100.100.100.1/24
[edit]
user@host# set access profile jnpr client sringeri chap-secret india 
[edit]
user@host# commit 
commit complete
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2. Verify the interface status.

user@host# run show interfaces at-1/0/0   
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode, 
Speed: ADSL
  Speed: 832kbps, Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 22:18:50 PDT (00:05:17 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 0 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :     Auto    Annex A     
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 316

  Logical interface at-1/0/0.0 (Index 71) (SNMP ifIndex 523) 
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-PPP-LLC
    Input packets : 46 
    Output packets: 88
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 18 (00:00:04 ago), Output: 17 (00:00:08 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    Protocol inet, MTU: 1486
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 100.100.100/24, Local: 100.100.100.1, Broadcast: 
100.100.100.255
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 46 
        Output packets: 88

  Logical interface at-1/0/0.32767 (Index 72) (SNMP ifIndex 525) 
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation:
 ATM-VCMUX
    Input packets : 0 
    Output packets: 0
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    VCI 2.4                             
      Flags: Active
      Total down time: 0 sec, Last down: Never
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        Input packets : 0 
        Output packets: 0

3. Verify the end-to-end data path testing.

user@host# run show interfaces at-1/0/0 terse 
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up  
at-1/0/0.0              up    up   inet     100.100.100.1/24
at-1/0/0.32767          up    up  

[edit]
user@host# run ping 100.100.100.6 count 100 rapid 
PING 100.100.100.6 (100.100.100.6): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 100.100.100.6 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.787/9.300/15.081/2.023 ms

Configuring PPPoA on the at-x/x/x Interface with Static IP (PAP
Authentication)

1. Configure the PPPoA on ADSL PHY for "second mile" ATM.

user@host# set interfaces at-1/0/0 encapsulation atm-pvc
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2 
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc 
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119 
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap access-profile
 jnpr
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap local-name locky
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap local-password
 india 
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet address 
100.100.100.10/24
[edit]
user@host# set access profile jnpr client sringeri pap-password india 
[edit]
user@host# commit 
commit complete

2. Verify the interface status.

user@host# run show interfaces at-1/0/0   
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode, 
Speed: ADSL
  Speed: 832kbps, Loopback: None

216 ■ Example: Configuring the ADSL Interface on SRX Series Services Gateway (CLI)

JUNOS Software Interfaces and Routing Configuration Guide



  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 22:18:50 PDT (00:10:26 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 80 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :     Auto    Annex A     
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 624

  Logical interface at-1/0/0.0 (Index 73) (SNMP ifIndex 523) 
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-PPP-LLC
    Input packets : 28 
    Output packets: 29
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 2 (00:00:01 ago), Output: 1 (00:00:09 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Closed
  PAP state: Success
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    Protocol inet, MTU: 1486
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 100.100.100/24, Local: 100.100.100.10, Broadcast: 
100.100.100.255
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 28 
        Output packets: 29

  Logical interface at-1/0/0.32767 (Index 72) (SNMP ifIndex 525) 
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation:
 ATM-VCMUX
    Input packets : 0 
    Output packets: 0
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    VCI 2.4                             
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 0 
        Output packets: 0

3. Verify the end-to-end data path testing.

user@host# run show interfaces at-1/0/0 terse 
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up  
at-1/0/0.0              up    up   inet     100.100.100.10/24
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at-1/0/0.32767          up    up  

[edit]
user@host# run ping 100.100.100.6 count 100 rapid 
PING 100.100.100.6 (100.100.100.6): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 100.100.100.6 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.698/10.296/61.622/5.856 ms

Configuring PPPoA on the at-x/x/x Interface with Unnumbered IP (PAP
Authentication)

1. Configure the PPPoA on ADSL PHY for "second mile" ATM.

user@host# set interfaces at-1/0/0 encapsulation atm-pvc 
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2 
[edit]
user@host# set interfaces at-1/0/0 dsl-options operating-mode auto
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc 
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap access-profile
 jnpr
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap local-name locky

[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options pap local-password
 india
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet unnumbered-address
 lo0.0
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet unnumbered-address
 destination 100.100.100.6
[edit]
user@host# set interfaces lo0 unit 0 family inet address 100.100.100.20/32

[edit]
user@host# set access profile jnpr client sringeri pap-password india 
[edit]
user@host# commit 
commit complete

2. Verify the interface status.

user@host# run show interfaces at-1/0/0          
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode, 
Speed: ADSL
  Speed: 832kbps, Loopback: None
  Device flags   : Present Running
  Link flags     : None
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  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 22:18:50 PDT (00:19:19 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 0 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :     Auto    Annex A     
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 1158

  Logical interface at-1/0/0.0 (Index 73) (SNMP ifIndex 523) 
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-PPP-LLC
    Input packets : 441 
    Output packets: 342
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 53 (00:00:06 ago), Output: 55 (00:00:05 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Closed
  PAP state: Success
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    Protocol inet, MTU: 1486
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 100.100.100/24, Local: 100.100.100.20, Broadcast: 
100.100.100.255
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 441 
        Output packets: 342

  Logical interface at-1/0/0.32767 (Index 72) (SNMP ifIndex 525) 
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation:
 ATM-VCMUX
    Input packets : 0 
    Output packets: 0
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    VCI 2.4                             
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 0 
        Output packets: 0

3. Verify the end-to-end data path connectivity.

user@host# run show interfaces at-1/0/0 terse 
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up  
at-1/0/0.0              up    up   inet     100.100.100.20      --> 
100.100.100.6
at-1/0/0.32767          up    up  
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[edit]
user@host# run ping 100.100.100.6 count 100 rapid 
PING 100.100.100.6 (100.100.100.6): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 100.100.100.6 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.917/10.164/56.428/5.340 ms

Configuring PPPoA on the at-x/x/x Interface with Unnumbered IP (CHAP
Authentication)

1. Configure the PPPoA on ADSL PHY for "second mile" ATM.

user@host# set interfaces at-1/0/0 encapsulation atm-pvc 
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2 
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation atm-ppp-llc 
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119 
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options chap access-profile
 jnpr
[edit]
user@host# set interfaces at-1/0/0 unit 0 ppp-options chap local-name 
locky 
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet unnumbered-address
 lo0.0
[edit]
user@host# set interfaces at-1/0/0 unit 0 family inet unnumbered-address
 destination 100.100.100.6 
[edit]
user@host# set interfaces lo0 unit 0 family inet address 100.100.100.10/32

[edit]
user@host# set access profile jnpr client sringeri chap-secret india
[edit]
user@host# commit 
commit complete

2. Verify the interface status.

user@host# run show interfaces at-1/0/0   
Physical interface: at-1/0/0, Enabled, Physical link is Up
  Interface index: 146, SNMP ifIndex: 504
  Link-level type: ATM-PVC, MTU: 1496, Clocking: Internal, ADSL mode, 
Speed: ADSL
  Speed: 832kbps, Loopback: None
  Device flags   : Present Running
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:b1:7e:85:84:ff
  Last flapped   : 2009-10-28 22:18:50 PDT (00:37:35 ago)
  Input rate     : 0 bps (0 pps)
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  Output rate    : 0 bps (0 pps)
  ADSL  alarms   : None
  ADSL  defects  : None
  ADSL status:
    Modem status  : Showtime (Itu-dmt)
    DSL mode      :     Auto    Annex A     
    Last fail code: None
    Subfunction   : 0x00
    Seconds in showtime : 2253

  Logical interface at-1/0/0.0 (Index 71) (SNMP ifIndex 523) 
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: ATM-PPP-LLC
    Input packets : 36 
    Output packets: 35
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 12 (00:00:07 ago), Output: 13 (00:00:05 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    Protocol inet, MTU: 1486
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 100.100.100.6, Local: 100.100.100.10
    VCI 2.119
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 36 
        Output packets: 35

  Logical interface at-1/0/0.32767 (Index 72) (SNMP ifIndex 525) 
    Flags: Point-To-Multipoint No-Multicast SNMP-Traps 0x0 Encapsulation:
 ATM-VCMUX
    Input packets : 0 
    Output packets: 0
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp ospf pgm pim rip router-discovery rsvp sap vrrp
    VCI 2.4                             
      Flags: Active
      Total down time: 0 sec, Last down: Never
        Input packets : 0 
        Output packets: 0

3. Verify the end-to-end data path connectivity.

user@host# run show interfaces at-1/0/0 terse 
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up  
at-1/0/0.0              up    up   inet     100.100.100.10      --> 
100.100.100.6
at-1/0/0.32767          up    up  

[edit]
user@host# run ping 100.100.100.6 count 100 rapid 
PING 100.100.100.6 (100.100.100.6): 56 data bytes
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!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 100.100.100.6 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 7.881/9.046/15.136/1.697 ms

Configuring PPPoE over ATM on the at-x/x/x Interface with Negotiated
IP (PAP Authentication)

1. Configure the Point-to-Point Protocol over Ethernet over Asynchronous Transfer
Mode (PPPoE over ATM) on ADSL PHY for "second mile" Ethernet.

user@host# set interfaces at-1/0/0 encapsulation ethernet-over-atm 
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2 
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119 
[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation 
ppp-over-ether-over-atm-llc 
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap access-profile my_prf

[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-name purple 
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap local-password 
Embe1mpls 
[edit]
user@host# set interfaces pp0 unit 0 ppp-options pap passive 
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface 
at-1/0/0.0 
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120 
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client 
[edit]
user@host# set interfaces pp0 unit 0 family inet negotiate-address 
[edit]
user@host# set access profile my_prf authentication-order password 
[edit]
user@host# set access-profile my_prf
[edit]
user@host# commit 
commit complete

2. Verify the interface status.

user@host# run show interfaces pp0 
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0 
    Output packets: 0
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  Logical interface pp0.0 (Index 72) (SNMP ifIndex 526) 
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 63,
      Session AC name: belur, Remote MAC address: 00:90:1a:41:03:c5,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: at-1/0/0.0 (Index 71)
    Input packets : 464 
    Output packets: 241
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 1 (00:39:51 ago), Output: 225 (00:00:08 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls:
  Not-configured
  CHAP state: Closed
  PAP state: Success
    Security: Zone: Null
    Protocol inet, MTU: 1456
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 12.12.12.1, Local: 12.12.12.15

3. Verify the end-to-end data path connectivity.

user@host# run show interfaces at-1/0/0 terse    
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up  
at-1/0/0.0              up    up  
at-1/0/0.32767          up    up  

[edit]
user@host# run show interfaces pp0 terse         
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up  
pp0.0                   up    up   inet     12.12.12.15         --> 
12.12.12.1

[edit]
user@host# run ping 12.12.12.1 count 100 rapid 
PING 12.12.12.1 (12.12.12.1): 56 data bytes

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 12.12.12.1 ping statistics ---
100 packets transmitted, 100 packets received, 0% packet loss
round-trip min/avg/max/stddev = 9.369/10.590/16.716/1.660 ms

Configuring PPPoE over ATM on the at-x/x/x Interface with Negotiated
IP (CHAP Authentication)

1. Configure the Point-to-Point Protocol over Ethernet over Asynchronous Transfer
Mode (PPPoE over ATM) on ADSL PHY for "second mile" Ethernet.

user@host# set interfaces at-1/0/0 encapsulation ethernet-over-atm 
[edit]
user@host# set interfaces at-1/0/0 atm-options vpi 2 
[edit]
user@host# set interfaces at-1/0/0 unit 0 vci 2.119 
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[edit]
user@host# set interfaces at-1/0/0 unit 0 encapsulation 
ppp-over-ether-over-atm-llc
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap default-chap-secret
 Embe1mpls 
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap local-name purple 
[edit]
user@host# set interfaces pp0 unit 0 ppp-options chap passive 
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface 
at-1/0/0.0 
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options auto-reconnect 120 
[edit]
user@host# set interfaces pp0 unit 0 pppoe-options client 
[edit]
user@host# set interfaces pp0 unit 0 family inet negotiate-address 
[edit]
user@host# commit 
commit complete

2. Verify the interface status.

user@host# run show interfaces pp0          
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 128, SNMP ifIndex: 510
  Type: PPPoE, Link-level type: PPPoE, MTU: 1532
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
    Input packets : 0 
    Output packets: 0

  Logical interface pp0.0 (Index 70) (SNMP ifIndex 526) 
    Flags: Point-To-Point SNMP-Traps 0x0 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 64,
      Session AC name: belur, Remote MAC address: 00:90:1a:41:03:c5,
      Configured AC name: None, Service name: None,
      Auto-reconnect timeout: 120 seconds, Idle timeout: Never,
      Underlying interface: at-1/0/0.0 (Index 71)
    Input packets : 14 
    Output packets: 13
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 0 (never), Output: 7 (00:00:08 ago)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
mpls: Not-configured
  CHAP state: Success
  PAP state: Closed
    Security: Zone: Null
    Protocol inet, MTU: 1456
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 12.12.12.1, Local: 12.12.12.16

3. Verify the end-to-end data path connectivity.
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user@host# run show interfaces at-1/0/0 terse    
Interface               Admin Link Proto    Local                 Remote
at-1/0/0                up    up  
at-1/0/0.0              up    up  
at-1/0/0.32767          up    up  

[edit]
user@host# run show interfaces pp0 terse         
Interface               Admin Link Proto    Local                 Remote
pp0                     up    up  
pp0.0                   up    up   inet     12.12.12.16         --> 
12.12.12.1

[edit]
user@host# run ping 12.12.12.1 count 1000 rapid 

!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
--- 12.12.12.1 ping statistics ---
1000 packets transmitted, 1000 packets received, 0% packet loss
round-trip min/avg/max/stddev = 8.748/10.461/21.386/1.915 ms

[edit]
user@host# 
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Chapter 8

Configuring 2-Port 10 Gigabit Ethernet
XPIM

■ Before You Begin on page 227

■ Configuring the 2-Port 10 Gigabit Ethernet XPIM Interface (CLI
Procedure) on page 227

■ Configuring the 2-Port 10 Gigabit Ethernet XPIM Interface (J-Web
Procedure) on page 230

■ Verifying the 2-Port 10 Gigabit Ethernet XPIM Configuration on page 233

Before You Begin

Before you begin configuring the 2-Port 10 Gigabit Ethernet XPIM, complete the
following tasks:

■ Establish basic connectivity. See the Getting Started Guide for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “2-Port 10 Gigabit Ethernet
XPIM Overview” on page 47.

■ Configure network interfaces as necessary. See “Configuring Ethernet, DS1, DS3,
and Serial Interfaces” on page x.

Configuring the 2-Port 10 Gigabit Ethernet XPIM Interface (CLI Procedure)

To perform basic configuration for the 2-Port 10 Gigabit Ethernet XPIM and configure
network interfaces for the services gateway with the CLI:

1. Navigate to the top of the interface configuration hierarchy in the CLI
configuration editor.

2. Perform the configuration tasks described in Table 48 on page 228.

3. Once you have completed configuring the device, commit the configuration.

4. To check the configuration, see “Verifying the 2-Port 10 Gigabit Ethernet XPIM
Configuration” on page 233.
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NOTE: The following format is used to represent the 2-Port 10 Gigabit Ethernet XPIM:

type-fpc/pic/port

■ type — Media type (xe)

■ fpc — Number of the Flexible PIC Concentrator (FPC) card on which the physical
interface is located (6 or 2)

■ pic — Number of the PIC on which the physical interface is located (0)

■ port — Specific port on a PIC (0 or 1)

Example: xe-6/0/0 or xe-2/0/0

Table 48: Configuring the 2-Port 10 Gigabit Ethernet XPIM Using the CLI

DescriptionCLI CommandTask

Specifies the operating modes for
the 2-Port 10 Gigabit Ethernet
XPIM.

The following operating modes are
available:

■ Copper

■ Fiber

The 2-Port 10 Gigabit Ethernet
XPIM can be configured to operate
in two-copper mode, two-fiber
mode, or mixed mode (one copper
and one fiber).

From the [edit] hierarchy level,
enter

set interfaces xe-x/x/x media-type

Example:

set interfaces xe-6/0/0 media-type
copper

set interfaces xe-6/0/0 media-type
fiber

Configure the
operating mode.

Specifies the operating speed for
the 2-Port 10 Gigabit Ethernet
XPIM.

The following link speeds are
supported:

■ 100m — Sets the link speed
to 100 Mbps.

■ 10g — Sets the link speed to
10 Gbps.

■ 10m — Sets the link speed to
10 Mbps.

■ 1g — Sets the link speed to 1
Gbps.

From the [edit] hierarchy level,
enter

set interfaces xe-x/x/x speed

Example:

set interfaces xe-6/0/0 speed
100m

set interfaces xe-6/0/0 speed 10g

set interfaces xe-6/0/0 speed 1g

set interfaces xe-6/0/0 speed 10m

Set the operating
speed for XPIM.
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Table 48: Configuring the 2-Port 10 Gigabit Ethernet XPIM Using the CLI (continued)

DescriptionCLI CommandTask

Defines one or more logical units
that you can connect to the 2-Port
10 Gigabit Ethernet XPIM.

From the [edit] hierarchy level,
enter

set interfaces xe-x/x/x unit unit
number family inet

Example:

set interfaces xe-6/0/1 unit 0 family
inet

Add the logical
interface.

Specifies the maximum
transmission unit size for the
2-Port 10 Gigabit Ethernet XPIM.

Enter a value from 256 through
9216 . The default MTU for Gigabit
Ethernet interfaces is 1514.

From the [edit] hierarchy level,
enter

set interfaces xe-x/x/x unit 0 family
inet mtu mtu values

Example:

set interfaces xe-6/0/0 unit 0 family
inet mtu 1514

Assign MTU values.

Sets the link settings for the 2-Port
10 Gigabit Ethernet XPIM with the
following options:

■ 802.3ad — Specifies an
aggregated Ethernet bundle.

■ auto-negotiation — Enables
auto-negotation of flow
control, link mode, and
speed.

■ loopback — Enables
loopback.

■ no auto-negotiation —
Disables auto-negotation of
flow control, link mode, and
speed.

■ no loopback — Disables
loopback.

From the [edit] hierarchy level,
enter

set interfaces xe-x/x/x
gigether-options

Example:

set interfaces xe-6/0/0
gigether-options

Set link options.

Enables or disables the 2-Port 10
Gigabit Ethernet XPIM.

By default, the interfaces on the
ports on the uplink module
installed in services gateways are
enabled. You can disable the
interfaces using a CLI command.

If an interface on the uplink
module is disabled, you can
enable the interface using a CLI
command.

From the [edit] hierarchy level,
enter

set interfaces xe-x/x/x
disable/enable

Example:

■ set interfaces xe-6/0/0
disable

■ set interfaces xe-6/0/0 Enable

Enable and disabling
the interface.
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Configuring the 2-Port 10 Gigabit Ethernet XPIM Interface (J-Web Procedure)

To perform basic configuration for the 2-Port 10 Gigabit Ethernet XPIM and configure
network interfaces for the services gateway with J-Web:

1. In the J-Web interface, select Configure>Interfaces.

A list of the network interfaces present on the device is displayed.

2. Select the interface name (xe-2/0/1 or xe-6/0/0) to edit.

3. Enter information into the configuration pages, as described in Table 49 on
page 230.

4. From the configuration main page, click one of the following buttons:

■ Click OK to save changes.

■ Click Cancel to cancel your entries and return to the previous page.

■ Click Commit  to apply the configuration and other pending changes (if any).

■ Click Discard to discard pending changes.

5. To verify the configuration, see “Verifying the 2-Port 10 Gigabit Ethernet XPIM
Configuration” on page 233.

Table 49: Configuring the 2-Port 10 Gigabit Ethernet XPIM Using J-Web

DescriptionYour ActionField

Logical Interfaces

Defines one or more logical units that you
connect to this physical Gigabit Ethernet
interface. You must define at least one
logical unit for a Gigabit Ethernet
interface.

Click AddAdd logical
interfaces

Describes the logical interface.Enter logical interface description.Logical
Interface
(Optional)

Specifies one or more IPv4 addresses for
the interface.

1. Type one or more IPv4
addresses and prefixes.

For example: 10.10.10.10/24

2. Click Add.

3. Click OK.

To delete an IP address and prefix,
select them in the Source
Addresses and Prefixes box, then
click Delete.

IPv4
Addresses
Prefixes
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Table 49: Configuring the 2-Port 10 Gigabit Ethernet XPIM Using J-Web (continued)

DescriptionYour ActionField

Enables the device to create a static
Address Resolution Protocol (ARP) entry
for this interface by specifying the IP
address of a node to associate with its
MAC address.

The IP address must be in the same
subnet as the IPv4 address or prefix of
the interface you are configuring. Static
ARP entries associate the IP addresses
and MAC addresses of nodes on the same
subnet, enabling a device to respond to
ARP requests having destination
addresses that are not local to the
incoming interface.

Type an IPv4 address that you
want to associate with the media
access control (MAC) address—for
example, 10.10.10.1.

ARP Address

Specifies the hardware MAC address
associated with the ARP address.

The MAC address uniquely identifies the
system and is expressed in the following
format: mm:mm:mm:ss:ss:ss.

The first three octets denote the hardware
manufacturer ID, and the last three are
serial numbers identifying the device.

Type the MAC address to be
mapped to the ARP entry—for
example, 00:12:1E:A9:8A:80.

MAC Address

Enables the device to reply to ARP
requests for the specified address.

■ To enable publishing, select
the check box.

■ To disable publishing, clear
the check box.

Publish

Enables or disables Ethernet switching.■ To enable Ethernet switching,
select the check box.

■ To disable Ethernet switching,
clear the check box.

Enable
Ethernet
Switching

Specifies the mode of operation for the
port.

Select one of the following:

■ Trunk

■ Access

Port Mode

VLAN identifier to associate with untagged
packets received on the interface.

Enter a valid VLAN name or VLAN
tag.

Native VLAN
Id

Adds supplementary information about
the physical Gigabit Ethernet interface.

Type a text description of the
Gigabit Ethernet interface to more
clearly identify it in monitoring
displays.

Physical
Interface
Description
(Optional)

Specifies the maximum transmission unit
(MTU) size for the Gigabit Ethernet
interface.

Type a value between 256 and
9216 bytes.

Default MTU: 1514

MTU (bytes)
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Table 49: Configuring the 2-Port 10 Gigabit Ethernet XPIM Using J-Web (continued)

DescriptionYour ActionField

Enables scheduling on logical interfaces.

This option allows you to configure
multiple output queues on a logical
interface and associate an output
scheduler and shaping rate with the
queues.

■ To enable scheduling, select
the check box.

■ To disable scheduling, clear
the check box.

Per unit
scheduler

Framing Mode

Specifies the framing mode.Select one of the following:

■ LAN-mode

■ WAN-mode

Framing Mode

Specifies the loopback mode.Select one of the following:

■ Local

■ Remote

Loopback
Mode

Identifies the circuit.Enter a text string.Path Trace

Gigabit Ethernet Options

Enables or disables the loopback option.■ Select Yes to enable the
loopback diagnostic option.

■ Select No to disable the
loopback option.

By default, loopback is
disabled.

Loopback

Enables or disables autonegotiation.

By default, Gigabit Ethernet interfaces
autonegotiate the link mode and speed
settings. If you disable autonegotiation
and do not manually configure link mode
and speed, the link is negotiated at 1000
Mbps, full duplex. When you configure
both the link mode and the speed, the
link negotiates with the manually
configured settings whether
autonegotiation is enabled or disabled.

■ Select Yes to enable
autonegotiation.

■ Select No to disable
autonegotiation.

By default, autonegotiation is
enabled.

Auto
Negotiation

Indicates the autonegotiation remote fault
value.

Select the autonegotation remote
fault value from the list of options
given.

■ local-interface-offline

■ local-interface-offline

This field is enabled only if
autonegotiation is enabled.

Auto
Negotiation
Remote Fault
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Table 49: Configuring the 2-Port 10 Gigabit Ethernet XPIM Using J-Web (continued)

DescriptionYour ActionField

Displays the list of MAC addresses from
which you want to receive packets on this
interface.

To add MAC addresses, type them
in the boxes above the Add button,
then click Add.

To delete a MAC address, select it
in the Source Addresses box, then
click Delete.

Source MAC
Address Filters

Specifies the name of the redundant
Ethernet interface that a physical
interface is associated with to form a
redundant Ethernet interface pair.

Enter a redundant Ethernet
interface name.

Redundant
Parent

Enables you to group Ethernet interfaces
at the Physical Layer to form a single link
layer interface.

Enter an aggregated Ethernet
logical interface name.

802.3ad

Identifies the frame as an IEEE
802.1Q-tagged frame.

Enter standard Tag Protocol
Identifier (TPID) values.

Tag Protocol
ID

Enables or disabling dynamic source MAC
addresses.

■ Select Yes to enable MAC
Learning.

■ Select No to disable MAC
Learning.

MAC Learning

NOTE: You can configure the operating mode options (copper and fiber) and speed
options for the 2-Port 10 Gigabit Ethernet XPIM in Point and Click CLI option of J-Web
interface.

To set the operating mode and speed in Point and Click CLI:

1. Navigate to Configure > CLI tools > Point and Click CLI.

2. Click and expand interfaces field under Configuration.

3. Select the interface name (xe-2/0/1 or xe-6/0/0) to edit.

4. Select Media type to set the operating mode and select Speed to set the operating
speed for the 2-Port 10 Gigabit Ethernet XPIM.

Verifying the 2-Port 10 Gigabit Ethernet XPIM Configuration

Purpose Verify the 2-Port 10 Gigabit Ethernet XPIM default configuration and settings:

Action 1. Check if the 2-Port 10 Gigabit Ethernet XPIM is installed on the services gateway
by entering show chassis hardware command.

The output should display the following values:
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■ FPC 2 , PIC 0 – 2x 10G gPIM

■ FPC 6, PIC 0  – 2x 10G gPIM

Sample output

Hardware inventory:
Item             Version  Part number  Serial number     Description
Chassis                                AJ0309AC0047      SRX650
Midplane         REV 04   710-023875   TV3993           
System IO        REV 04   710-023209   TV4035            SRXSME System IO
Routing Engine   REV 01   710-023224   DT5109            RE-SRXSME-SRE6
FPC 0                                                    FPC
  PIC 0                                                  4x GE Base PIC
FPC 2                                                    FPC
  PIC 0                                                  2x 10G gPIM
FPC 6                                                    FPC
  PIC 0                                                  2x 10G gPIM
Power Supply 0   REV 01   740-024283   TA00049WSSSS      PS 645W AC

2. Verify the FPC status by entering the show chassis fpc command. The output
should display FPC status as online.

Sample output

  Temp  CPU Utilization (%)   Memory    Utilization (%)
Slot State            (C)  Total  Interrupt      DRAM (MB) Heap     Buffer

  0  Online          -------------------- CPU less FPC --------------------

  1  Empty           
  2  Online          -------------------- CPU less FPC --------------------

  3  Empty           
  4  Empty           
  5  Empty           
  6  Online          -------------------- CPU less FPC --------------------

  7  Empty           
  8  Empty           

NOTE: The 2-Port 10 Gigabit Ethernet XPIM is installed in the second and sixth slot
of the SRX650 device chassis; therefore the FPC used here is fpc 2 and fpc 6.

3. Enter run show interface xe-6/0/0 command and verify the following information
in the command output:

■ Physical interface — xe-6/0/0, Enabled, Physical link is Up

■ MTU — 1514, Link-mode: Full-duplex,

■ Speed — 10Gbps
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■ Loopback — Disabled

■ Flow control — Enabled

Sample output

Physical interface: xe-6/0/0, Enabled, Physical link is Up
  Interface index: 144, SNMP ifIndex: 501
  Link-level type: Ethernet, MTU: 1514, Link-mode: Full-duplex, Speed: 
10Gbps,
  BPDU Error: None, MAC-REWRITE Error: None, Loopback: Disabled,
  Source filtering: Disabled, Flow control: Enabled
  Device flags   : Present Running
  Interface flags: SNMP-Traps Internal: 0x0
  Link flags     : None
  CoS queues     : 8 supported, 8 maximum usable queues
  Current address: 00:1f:12:e0:80:a8, Hardware address: 00:1f:12:e0:80:a8

  Last flapped   : 1970-01-01 00:34:22 PST (07:26:29 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 0 bps (0 pps)
  Active alarms  : None
  Active defects : None

  Logical interface xe-6/0/0.0 (Index 72) (SNMP ifIndex 503) 
    Flags: SNMP-Traps Encapsulation: ENET2
    Input packets : 25 
    Output packets: 25
    Security: Zone: HOST
    Allowed host-inbound traffic : any-service bfd bgp dvmrp igmp ldp msdp
 nhrp
    ospf pgm pim rip router-discovery rsvp sap vrrp
    Protocol inet, MTU: 1500            
      Flags: Sendbcast-pkt-to-re        
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 10.10.10/24, Local: 10.10.10.10, Broadcast: 
10.10.10.255
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Chapter 9

Voice over Internet Protocol with Avaya

J2320, J2350, J4350, and J6350 Services Routers support voice over IP (VoIP)
connectivity for branch offices with the Avaya IG550 Integrated Gateway. The Avaya
IG550 Integrated Gateway consists of four VoIP modules—a TGM550 Telephony
Gateway Module and three types of Telephony Interface Modules (TIMs).

The VoIP modules installed in a Services Router at a branch office connect the IP
and analog telephones and trunk lines at the branch to headquarters and to the
public-switched telephone network (PSTN).

You can use either J-Web Quick Configuration or a configuration editor to configure
VoIP on the Services Router. Alternatively, you can download a complete router
configuration that includes VoIP from an Electronic Preinstallation Worksheet (EPW)
and a Disk-on-Key USB memory stick.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Console and Connector Port Pinouts on page 238

■ Avaya VoIP Modules on page 244

■ VoIP Terms on page 257

■ VoIP Overview on page 259

■ Before You Begin on page 267

■ Configuring VoIP Interfaces with EPW and Disk-on-Key on page 268

■ Configuring VoIP Interfaces with Quick Configuration on page 269

■ Configuring VoIP with a Configuration Editor on page 272

■ Accessing and Administering the TGM550 CLI on page 278

■ Verifying the VoIP Configuration on page 283

■ Frequently Asked Questions About the VoIP Interface on page 286
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Console and Connector Port Pinouts

The Avaya VoIP modules supported on the Services Router accept different kinds of
network cables.

■ TGM550 Console Port Pinouts on page 238

■ TGM550 RJ-11 Connector Pinout for Analog Ports on page 239

■ TIM508 Connector Pinout on page 239

■ TIM510 RJ-45 Connector Pinout on page 240

■ TIM514 Connector Pinout on page 240

■ TIM516 Connector Pinout on page 241

■ TIM518 Connector Pinout on page 242

TGM550 Console Port Pinouts

The console port on a TGM550 Telephony Gateway Module has an RJ-45 connector.
Table 50 on page 238 provides TGM550 RJ-45 console connector pinout information.
An RJ-45 cable is supplied with the TGM550.

NOTE: Two different RJ-45 cables and RJ-45 to DB-9 adapters are provided. Do not
use the RJ-45 cable and adapter for the Services Router console port to connect to
the TGM550 console port.

To connect the console port to an external management device, you need an RJ-45
to DB-9 serial port adapter, which is also supplied with the TGM550.

Table 50: TGM550 RJ-45 Console Connector Pinouts

Terminal DB-9 PinsSignal
TGM550 RJ-45
Pin

NCFor future use1

3TXD (TGM550 input)2

2RXD (TGM550 output)3

4CD4

5GND5

1DTR6

8RTS7

7CTS8
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TGM550 RJ-11 Connector Pinout for Analog Ports

The two analog telephone ports and two analog trunk ports on the TGM550 use an
RJ-11 cable. Table 51 on page 239 describes the TGM550 RJ-11 connector pinout.

Table 51: TGM550 RJ-11 Connector Pinout

SignalPin

No connection1

No connection2

Ring3

Tip4

No connection5

No connection6

TIM508 Connector Pinout

The TIM508 Analog Telephony Interface Module uses a B25A unshielded 25–pair
Amphenol cable. Table 52 on page 239 describes the TIM508 connector pinout.

Table 52: TIM508 Connector Pinout

SignalPin

Tip1

Tip2

Tip3

Tip4

Tip5

Tip6

Tip7

Tip8

R - Receive26

Ring27

Ring28

Console and Connector Port Pinouts ■ 239

Chapter 9: Voice over Internet Protocol with Avaya



Table 52: TIM508 Connector Pinout (continued)

SignalPin

Ring29

Ring30

Ring31

Ring32

Ring33

TIM510 RJ-45 Connector Pinout

The TIM510 Telephony Interface Module uses an RJ-45 cable. Table 53 on page 240
describes the TIM510 RJ-45 connector pinout.

Table 53: TIM510 RJ-45 Connector Pinout

SignalPin

Ring1

Tip2

No connection3

R1 - Transmit4

T1 - Transmit5

No connection6

No connection7

No connection8

TIM514 Connector Pinout

The TIM514 Telephony Interface Module uses an RJ-11 cable. Table 54 on page 240
describes the TIM514 RJ-11 connector pinout information.

Table 54: TIM514 RJ-11 Connector Pinout

SignalPin

No connection1

No connection2
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Table 54: TIM514 RJ-11 Connector Pinout (continued)

SignalPin

Ring3

Tip4

No connection5

No connection6

TIM516 Connector Pinout

The TIM516 Analog Telephony Interface Module uses a B25A unshielded 25–pair
Amphenol cable. Table 55 on page 241 describes the TIM516 connector pinout.

Table 55: TIM516 Connector Pinout

SignalPin

Tip1

Tip2

Tip3

Tip4

Tip5

Tip6

Tip7

Tip8

Tip17

Tip18

Tip19

Tip20

Tip21

Tip22

Tip23

Tip24

Ring26
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Table 55: TIM516 Connector Pinout (continued)

SignalPin

Ring27

Ring28

Ring29

Ring30

Ring31

Ring32

Ring33

Ring42

Ring43

Ring44

Ring45

Ring46

Ring47

Ring48

Ring49

TIM518 Connector Pinout

The TIM518 Analog Telephony Interface Module uses a B25A unshielded 25–pair
Amphenol cable. Table 56 on page 242 describes the TIM518 connector pinout.

Table 56: TIM518 Connector Pinout

SignalPin

Ring1

Ring2

Ring3

Ring4

Ring5

Ring6
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Table 56: TIM518 Connector Pinout (continued)

SignalPin

Ring7

Ring8

Ring17

Ring18

Ring19

Ring20

Ring21

Ring22

Ring23

Ring24

Tip26

Tip27

Tip28

Tip29

Tip30

Tip31

Tip32

—33

Tip42

Tip43

—44

Tip45

Tip46

Tip47

Tip48

Tip49
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Avaya VoIP Modules

The Avaya VoIP modules are installed in a J Series chassis like Physical Interface
Modules (PIMs), but they are controlled by Avaya Communication Manager software
rather than JUNOS Software.

CAUTION: PIMs and VoIP modules are not hot-swappable. You must power off the
Services Router before removing or inserting a PIM or VoIP module. Ensure that the
PIMs and VoIP modules are installed in the router chassis before booting up the
system.

CAUTION: The grounding cable for J Series devices must be, at minimum, 14 AWG
cable.

Avaya VoIP modules are described in the following sections:

■ Avaya VoIP Module Summary on page 244

■ TGM550 Telephony Gateway Module on page 247

■ TIM508 Analog Telephony Interface Module on page 250

■ TIM510 E1/T1 Telephony Interface Module on page 251

■ TIM514 Analog Telephony Interface Module on page 253

■ TIM516 Analog Telephony Interface Module on page 254

■ TIM518 Analog Telephony Interface Module on page 255

■ TIM521 BRI Telephony Interface Module on page 256

Avaya VoIP Module Summary

Table 57 on page 245 and Table 58 on page 246 provide the module names, software
release information, slot and port numbers, maximum number allowed on a chassis,
and sample interface names (where applicable) for the Avaya VoIP modules.

CAUTION: Do not install a combination of PIMs in a single chassis that exceeds the
maximum power and heat capacity of the chassis. If power management is enabled,
PIMs that exceed the maximum power and heat capacity remain offline for a J Series
device when the chassis is powered on.

On each J Series device with Avaya VoIP, a single TGM550 Telephony Gateway Module
(TGM) and at least one telephony interface module (TIM) is required. No more than
four TIMs of any kind can be installed on a single chassis.
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Table 57: J2320 and J2350 Avaya VoIP Module Summary

Sample Interface
Name

(type-pim/0/port)
Maximum Number on a
Chassis

Slot and Port
NumberingAlso CalledPIM

vp-3/0/0One (required)

If more than one TGM550 is
installed, only the one in the
lowest-numbered slot is
enabled. For example, if
TGM550s are installed in slots
2 and 3, only the one in slot 2
is enabled.

■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TGM550 Gateway
Module

■ TGM550

TGM550
Telephony
Gateway Module

–One on J2320

Three on J2350

■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TIM508 media module

■ TIM508

TIM508 Analog
Telephony
Interface Module

–Two■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TIM510 E1/T1 media
module

■ TIM510

TIM510 E1/T1
Telephony
Interface Module

–Two■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TIM514 analog media
module

■ TIM514

TIM514 Analog
Telephony
Interface Module

–One on J2320

Three on J2350

■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TIM516 analog media
module

■ TIM516

TIM516 Analog
Telephony
Interface Module

–One on J2320

Three on J2350

■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TIM518 analog media
module

■ TIM518

TIM518 Analog
Telephony
Interface Module

–Two■ J2320—Slots 1
through 3

■ J2350—Slots 1
through 5

■ TIM521 BRI media
module

■ TIM521

TIM521 BRI
Telephony
Interface Module
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Table 58: J4350 and J6350 Avaya VoIP Module Summary

Sample Interface
Name

(type-pim/0/port)
Maximum Number on a
Chassis

Slot and Port
NumberingAlso CalledPIM

vp-3/0/0One (required)

If more than one
TGM550 is installed,
only the one in the
lowest-numbered slot is
enabled. For example, if
TGM550s are installed in
slots 2 and 3, only the
one in slot 2 is enabled.

Slots 1 through 6■ TGM550
Gateway
Module

■ TGM550

TGM550
Telephony
Gateway
Module

–ThreeSlots 1 through 6■ TIM508
media
module

■ TIM508

TIM508
Analog
Telephony
Interface
Module

–TwoSlots 1 through 6■ TIM510
E1/T1 media
module

■ TIM510

TIM510 E1/T1
Telephony
Interface
Module

–FourSlots 1 through 6■ TIM514
analog media
module

■ TIM514

TIM514
Analog
Telephony
Interface
Module

–ThreeSlots 1 through 6■ TIM516
analog media
module

■ TIM516

TIM516
Analog
Telephony
Interface
Module

–ThreeSlots 1 through 6■ TIM518
analog media
module

■ TIM518

TIM518
Analog
Telephony
Interface
Module

–TwoSlots 1 through 6■ TIM521 BRI
media
module

■ TIM521

TIM521 BRI
Telephony
Interface
Module
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TGM550 Telephony Gateway Module

The TGM550 Telephony Gateway Module (Figure 31 on page 247), also known as the
TGM550 Gateway Module, has two analog telephone ports, two analog trunk ports,
and a serial console port.

The TGM550 enables routers to provide VoIP services to telephones and trunks that
do not directly support VoIP by translating voice and signaling data between VoIP
and the system used by the telephones and trunks.

Figure 31: TGM550 Telephony Gateway Module

The TGM550 provides the following key features:

■ Voice

■ VoIP Media Gateway services.

■ Two analog telephone (LINE) ports to support two analog telephones or
incoming analog direct inward dialing (DID) trunks with either wink start or
immediate start. An analog relay supports emergency transfer relay (ETR).

■ Two analog trunk (TRUNK) ports to support loop start, ground start, centralized
automatic message accounting (CAMA), and direct inward and outward
dialing (DIOD) trunks (for Japan only).

■ Survivability features for continuous voice services.

■ Call center capabilities.

■ Provisioning

■ Avaya Communication Manager (CM) media server management.

■ Extensive alarm and troubleshooting features.

■ Survivability

■ Media Gateway Controller (MGC) automatic switchover, migration, and
survivability features.

■ Modem backup connection to the MGC.

■ Dynamic call admission control (CAC) for WAN interfaces.

■ Management: One serial port for console access over an RJ-45 connector cable.
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NOTE: The RJ-45 console cable and DB-9 adapter supplied with the TGM550 are
different from those supplied with the Services Router. You cannot use the RJ-45
cable and DB-9 adapter supplied with the Services Router for console connections
to the TGM550.

Table 59 on page 248 lists the maximum number of media servers, telephones, and
so on that are supported by the TGM550 installed on a J4350, J6350, J2320, or J2350
device.

Table 59: TGM550 Maximum Media Gateway Capacities

Additional InformationTGM550 Maximum CapacityHardware or Feature

This number also applies if a combination of
Avaya G700 Media Gateways, G250 Media
Gateways, and G350 Media Gateways are
controlled by the same media server.

250TGM550s that can be controlled by
an Avaya S8500 or S8700 Media
Server

This number also applies if a combination of
Avaya G700 Media Gateways, G250 Media
Gateways, and G350 Media Gateways are
controlled by the same media server.

5TGM550s that can be controlled by
an Avaya S8400 Media Server

This capacity is 50 if a combination of Avaya
G700 Media Gateways, G250 Media Gateways,
and G350 Media Gateways are controlled by the
same media server.

The S8300 must reside in a G700 or G350 media
gateway. Therefore, the maximum of 50 H.248
gateways supported by the S8300 means that
only 49 of the 50 can be TGM550s.

49TGM550s that can be controlled by
an Avaya S8300 Media Server

If an MGC becomes unavailable, the TGM550
uses the next MGC on the list. The built-in SLS
module can be considered a fifth MGC, although
its functionality is limited from that of a full-scale
media server.

4Media servers that can be registered
as Media Gateway Controllers
(MGCs) on a TGM550

—2Fixed analog line ports

—2Fixed analog trunk ports
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Table 59: TGM550 Maximum Media Gateway Capacities (continued)

Additional InformationTGM550 Maximum CapacityHardware or Feature

For calls using voice codec sets with 20ms or
higher packet sizes, the DSP supports:

■ 80 channels

■ 20 channels

■ 10 channels

For calls with 10 ms or-lower packet sizes, the
80–channel DSP supports 40 channels.

For TTY, fax, or modem over IP calls, the
80–channel DSP supports 40 channels.

1 (up to 80 channels)Digital signal processors (DSPs)

—800Busy Hour Call Completion Rate
(BHCC)

Maximum includes a combination of analog and
IP telephones

70 (J4350)

100 (J6350)

Total of IP and analog telephones
that can be connected to a TGM550
and TIMs

Receivers32Touch-tone recognition (TTR)

—As much as necessary for all TDM
calls.

Tone generation

16 playback channels for playing
announcements, one of which can
be used for recording<

20 minutes for G711-quality stored
announcements and music-on-hold.

256 maximum announcements
stored

Announcements (VAL)

CAUTION: Some capacities may change. For the most recent list, see System Capacities
Table for Avaya Communication Manager on Avaya Media Servers at
http://support.avaya.com.

For pinouts of the TGM550 RJ-45 console connector, see “TGM550 Console Port
Pinouts” on page 238. For pinouts of cable connectors for the TGM550 analog ports,
see “TGM550 RJ-11 Connector Pinout for Analog Ports” on page 239.

TGM550 LEDs indicate link status and activity. Table 60 on page 250 describes the
meaning of the LEDs.
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Table 60: LEDs for TGM550 Gateway Module

DescriptionStateColorLabel

Alarm. A failure in the TGM550
requires monitoring or maintenance.

On steadilyRedALM

Active. The TGM550 is online with
network traffic.

On steadilyYellowACT

Alternate software bank. The
software is not running from the
selected boot bank.

On steadilyGreenASB

Emergency transfer relay (ETR)
feature is active.

On steadilyGreenETR

For more information about the TGM550, see Hardware Description and Reference
for Avaya Communication Manager at http://support.avaya.com.

TIM508 Analog Telephony Interface Module

The TIM508 Analog Telephony Interface Module (Figure 32 on page 250), also known
as the TIM508 analog media module, has eight analog telephone lines that can be
used as trunk ports.

Figure 32: TIM508 Analog Telephony Interface Module
g0

03
86

5

ACT

1 — 8

TIM 508

ALM

Analog

LINES

NOTE: All eight analog lines can be configured as analog direct inward dialing(DID)
trunks.

You can configure TIM508 ports as described in Table 61 on page 250.

Table 61: TIM508 Possible Port Configurations

Possible Analog Telephone Line Configurations

Wink-start or immed-start DID trunk
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Table 61: TIM508 Possible Port Configurations (continued)

Possible Analog Telephone Line Configurations

Analog tip/ring devices such as single-line telephones with or without LED message-waiting indication

The TIM508 also provides the following features:

■ Three ringer loads, the ringer equivalency number for up to 2,000 ft (610 m),
for all eight lines

■ Up to eight simultaneously ringing lines

■ Type 1 caller ID and Type 2 caller ID for lines

■ Ring voltage generation for a variety of international frequencies and cadences

For pinouts of cable connectors for the TIM508, see “TIM508 Connector Pinout” on
page 239.

TIM508 LEDs indicate link status and activity. Table 62 on page 251 describes the
meaning of the LEDs.

Table 62: LEDs for TIM508

DescriptionStateColorLabel

Alarm. A TIM508 failure requires
monitoring or maintenance.

On steadilyRedALM

Active. A device connected to the
TIM508 is in use. This situation can
include a telephone that is off the
hook.

BlinkingYellowACT

For more information about the TIM508, see Hardware Description and Reference for
Avaya Communication Manager at http://support.avaya.com.

TIM510 E1/T1 Telephony Interface Module

The TIM510 E1/T1 Telephony Interface Module (Figure 33 on page 252), also known
as the TIM510 E1/T1 media module, terminates an E1 or T1 trunk. The TIM510 T1/E1
media module has a built-in channel service unit (CSU) so an external CSU is not
necessary. The CSU is used for a T1 circuit only. Up to two TIM510s can be installed
in any of the slots on the Services Router.
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Figure 33: TIM510 E1/T1 Telephony Interface Module

The TIM510 provides the following key features:

■ One E1 or T1 trunk port with up to 30 channels on an E1 port and 24 channels
on a T1 port.

■ DS1-level support for a variety of E1 and T1 trunk types.

■ Trunk signaling to support U.S. and international central office (CO) or tie trunks.

■ Echo cancellation in either direction—incoming or outgoing.

For pinouts of cable connectors for the TIM510, see “TIM510 RJ-45 Connector Pinout”
on page 240.

TIM510 LEDs indicate link status and activity. Table 63 on page 252 describes the
meaning of the LEDs.

Table 63: LEDs for TIM510

DescriptionStateColorLabel

Alarm. A TIM510 failure requires
monitoring or maintenance.

On steadilyRedALM

Active. The TIM510 is online with
network traffic.

On steadilyGreenACT

Test. A test is being performed on
the TIM510 through the Media
Gateway Controller (MGC).

On steadilyYellowTST

Signal. The link to the central office
(CO) is active.

On steadilyGreenSIG

For more information about the TIM510, see Hardware Description and Reference for
Avaya Communication Manager at http://support.avaya.com.
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TIM514 Analog Telephony Interface Module

The TIM514 Analog Telephony Interface Module (Figure 34 on page 253), also known
as the TIM514 analog media module, has four analog telephone ports and four analog
trunk ports.

Figure 34: TIM514 Analog Telephony Interface Module

NOTE: For analog direct inward dialing (DID) trunks, you must use the four analog
telephone (LINE) ports. You cannot use the four analog trunk (TRUNK) ports for analog
DID trunks.

You can configure TIM514 ports as described in Table 64 on page 253.

Table 64: TIM514 Possible Port Configurations

Possible Analog Trunk (TRUNK) Port Configurations
Possible Analog Telephone (LINE) Port
Configurations

Loop-start or ground-start central office trunk with a loop current of
18 to 120 mA.

Wink-start or immediate-start DID trunk

Two-wire analog outgoing centralized automatic message accounting
(CAMA) emergency E911 trunk, for connectivity to the PSTN.

Multifrequency (MF) signaling is supported for CAMA ports.

Analog tip/ring devices such as single-line telephones
with or without LED message-waiting indication

The TIM514 also provides the following features:

■ Three ringer loads, the ringer equivalency number for up to 2,000 ft (610 m),
for all eight ports.

■ Up to four simultaneously ringing ports.

■ Type 1 caller ID and Type 2 caller ID.

■ Ring voltage generation for a variety of international frequencies and cadences.

For pinouts of cable connectors for the TIM514, see “TIM514 Connector Pinout” on
page 240.
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TIM514 LEDs indicate link status and activity. Table 65 on page 254 describes the
meaning of the LEDs.

Table 65: LEDs for TIM514

DescriptionStateColorLabel

Alarm. A TIM514 failure requires
monitoring or maintenance.

On steadilyRedALM

Active. A device connected to the
TIM514 is in use. This situation can
include a telephone that is off the
hook.

BlinkingYellowACT

For more information about the TIM514, see Hardware Description and Reference for
Avaya Communication Manager at http://support.avaya.com.

TIM516 Analog Telephony Interface Module

The TIM516 Analog Telephony Interface Module (Figure 35 on page 254), also known
as the TIM516 analog media module, has 16 analog telephone lines.

Figure 35: TIM516 Analog Telephony Interface Module
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You can configure TIM516 lines as described in Table 66 on page 254.

Table 66: TIM516 Possible Port Configurations

Possible Analog Telephone (LINE) Line Configurations

Analog tip/ring devices such as single-line telephones with or without LED message-waiting indication

The TIM516 also provides the following features:

■ Three ringer loads, the ringer equivalency number for up to 2,000 ft (610 m),
for all 16 lines

■ Up to 16 simultaneously ringing lines
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■ Type 1 caller ID and Type 2 caller ID for line lines

■ Ring voltage generation for a variety of international frequencies and cadences

For pinouts of cable connectors for the TIM516, see “TIM516 Connector Pinout” on
page 241.

TIM516 LEDs indicate link status and activity. Table 67 on page 255 describes the
meaning of the LEDs.

Table 67: LEDs for TIM516

DescriptionStateColorLabel

Alarm. A TIM516 failure requires
monitoring or maintenance.

On steadilyRedALM

Active. A device connected to the
TIM516 is in use. This situation can
include a telephone that is off the
hook.

BlinkingYellowACT

For more information about the TIM516, see the Avaya manual Hardware Description
and Reference for Avaya Communication Manager.

TIM518 Analog Telephony Interface Module

The TIM518 Analog Telephony Interface Module (Figure 36 on page 255), also known
as the TIM518 analog media module, has eight analog telephone lines and eight
analog trunk lines.

Figure 36: TIM518 Analog Telephony Interface Module
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NOTE: For analog direct inward dialing (DID) trunks, you can use all eight analog
telephone lines.

You can configure eight TIM518 analog telephone lines as described in Table 68 on
page 256.
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Table 68: TIM518 Possible Port Configurations

Possible Analog Trunk Port ConfigurationsPossible Analog Telephone Port Configurations

Loop-start or ground-start central office trunk with a loop
current of 18 to 120 mA

Wink-start or immed-start DID trunk

Two-wire analog outgoing centralized automatic message
accounting (CAMA) emergency E911 trunk for connectivity
to the PSTN

Analog tip/ring devices such as single-line telephones with or
without LED message-waiting indication

The TIM518 also provides the following features:

■ Three ringer loads, the ringer equivalency number for up to 2,000 ft (610 m),
for all 16 lines

■ Up to 16 simultaneously ringing lines

■ Type 1 caller ID and Type 2 caller ID for line lines

■ Type 1 caller ID for trunk lines

■ Ring voltage generation for a variety of international frequencies and cadences

For pinouts of cable connectors for the TIM518, see “TIM518 Connector Pinout” on
page 242.

TIM518 LEDs indicate link status and activity. Table 69 on page 256 describes the
meaning of the LEDs.

Table 69: LEDs for TIM518

DescriptionStateColorLabel

Alarm. A TIM518 failure requires
monitoring or maintenance.

On steadilyRedALM

Active. A device connected to the
TIM518 is in use. This situation can
include a telephone that is off the
hook.

BlinkingYellowACT

For more information about the TIM518, see Hardware Description and Reference for
Avaya Communication Manager at http://support.avaya.com.

TIM521 BRI Telephony Interface Module

The TIM521 BRI Telephony Interface Module (Figure 37 on page 257), also known as
the TIM521 BRI media module, has four ports with RJ-45 jacks that can be
administered as ISDN Basic Rate Interface (BRI) trunk connections. Each ISDN BRI
port has two B-channels plus a D-channel. Up to two TIM521 modules (with four BRI
trunk ports each) can be installed in any of the slots on the Services Router.
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Figure 37: TIM521 BRI Telephony Interface Module

For ISDN BRI trunking, the TIM521 supports up to four BRI interfaces to the central
office at the ISDN T reference point. Information is communicated on each port in
two ways:

■ Over two 64-Kbps B-channels, called B1 and B2, that can be circuit-switched
simultaneously

NOTE: The TIM521 does not support BRI stations or combining both B-channels
together to form a 128-Kbps channel.

■ Over a 16-Kbps channel, called the D-channel, that is used for signaling. The
TIM521 occupies one time slot for all four D-channels

The circuit-switched connections have an a-law or mu-law option for voice operation.
The circuit-switched connections operate as 64-Kbps clear channels transmitting
data.

TIM521 LEDs indicate link status and activity. Table 70 on page 257 describes the
meaning of the LEDs.

Table 70: LEDs for TIM521

DescriptionStateColorLabel

Alarm. A TIM521 failure requires
monitoring or maintenance.

On steadilyRedALM

Active. A trunk connected to the
TIM521 is in use.

On steadilyYellowACT

For more information about the TIM521, see Hardware Description and Reference for
Avaya Communication Manager at http://support.avaya.com.

VoIP Terms

Before configuring VoIP, become familiar with the terms defined in Table 71 on
page 258.
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Table 71: VoIP Terminology

DefinitionTerm

Maximum bandwidth available for voice traffic on an interface when
dynamic call admission control is configured on the interface. See also
dynamic CAC.

bearer bandwidth limit (BBL)

Method of limiting voice traffic over a particular link in a network. See
also dynamic CAC.

call admission control (CAC)

Recording of toll calls at a central point.centralized automatic message accounting (CAMA)

Feature of a trunk line that allows incoming calls to be routed directly
to selected stations without help from an attendant.

direct inward dialing (DID)

Feature of a trunk line that allows outgoing calls to be routed directly
without help from an attendant.

direct outward dialing (DOD)

Feature of a trunk line that allows both incoming and outgoing calls to
be routed directly without help from an attendant. See also direct inward
dialing (DID) and direct outward dialing (DOD).

direct inward and outward dialing (DIOD)

Memory device (stick) that plugs into a USB port to load a complete
JUNOS configuration with VoIP onto a Services Router. You must first
use an Electronic Preinstallation Worksheet (EPW) to download the
configuration to the Disk-on-Key device. The EPW and Disk-on-Key
device provide an alternative method to configure the router for VoIP.

Disk-on-Key

Application that blocks calls on a WAN interface when the bandwidth
is exhausted. See also call admission control (CAC).

dynamic CAC

Customized Microsoft Excel spreadsheet used with a Disk-on-Key USB
memory stick to configure VoIP on a Services Router. You download
the EPW from an Avaya Web site.

Electronic Preinstallation Worksheet (EPW)

Feature that provides an emergency link between the telephone
connected to the first LINE port on the TGM550 and the trunk connected
to the TRUNK port on the TGM550 if power is disconnected from the
Services Router or if the TGM550 becomes unregistered from its Media
Gateway Controller (MGC).

emergency transfer relay (ETR)

IEEE standard for a Layer 2 frame structure that supports virtual LAN
(VLAN) identification and class-of-service (CoS) traffic classification.

IEEE 802.1p standard

IEEE standard that defines a method for powering network devices
through an Ethernet cable. Also known as Power over Ethernet (PoE),
this standard enables remote devices (such as VoIP telephones) to
operate without a separate, external power source. See also Power over
Ethernet (PoE).

IEEE 802.3af standard

International Telecommunications Union (ITU) standard for
communication between a gateway controller and a media gateway.

ITU H.248 standard

International Telecommunications Union (ITU) standard for packet-based
multimedia communications over networks that do not guarantee class
of service (CoS), such as IP networks. H323, modeled after ISDN PRI,
is the standard for voice over IP (VoIP) and conferencing.

ITU H.323 standard
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Table 71: VoIP Terminology (continued)

DefinitionTerm

Avaya media server that controls the parts of the call state that pertain
to connection control for media channels in a media gateway. The MGC
is the controlling entity in an H.248 relationship.

Media Gateway Controller (MGC)

Electrical current run to networking devices over Ethernet Category 5
or higher data cables. No extra AC power cord or outlets are needed at
the product location.

Power over Ethernet (PoE)

The public worldwide voice telephone network.public switched telephone network (PSTN)

Configurable software feature that enables a TGM550 to provide limited
Media Gateway Controller (MGC) functionality when no link is available
to a registered MGC.

standard local survivability (SLS)

A form of multiplexing that divides a transmission channel into
successive time slots.

time-division multiplexing (TDM)

Avaya Telephony Gateway Module. Avaya VoIP H.248 media gateway
module installed in a Services Router along with one or more Telephony
Interface Modules (TIMs) to connect VoIP and legacy analog telephones
and trunks over IP networks. Only the TGM550 has an interface
configurable through the J-Web interface or JUNOS CLI. The TIMs are
configured and administered from the TGM550 CLI.

TGM550

Avaya E1/T1 Telephony Interface Module. Avaya VoIP module installed
in a Services Router to provide an E1 or T1 trunk connection over the
Internet to a telephone central office (CO). A TIM510 is configured and
administered from a TGM550 installed in the same router.

TIM510

Avaya Analog Telephony Interface Module. Avaya VoIP module installed
in a Services Router to connect individual telephones or trunk lines to
the Internet. A TIM514 is configured and administered from a TGM550
installed in the same router.

TIM514

Avaya BRI Telephony Interface Module. Avaya VoIP module installed
in a Services Router to connect ISDN Basic Rate Interface (BRI) trunk
lines to a telephone central office (CO) over the Internet for data or
voice transmission. A TIM521 is configured and administered from a
TGM550 installed in the same router.

TIM521

VoIP Overview

This section contains the following topics.

■ About the Avaya IG550 Integrated Gateway on page 260

■ VoIP Interfaces on page 261

■ Avaya VoIP Modules Overview on page 262

■ Media Gateway Controller on page 263

■ Avaya Communication Manager on page 264

■ Dynamic Call Admission Control Overview on page 264
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■ TGM550 Firmware Compatibility with JUNOS Internet Software on page 266

■ TGM550 IP Addressing Guidelines on page 266

About the Avaya IG550 Integrated Gateway

The Avaya IG550 Integrated Gateway consists of the TGM550 Telephony Gateway
Module and one or more Telephony Interface Modules (TIMs) that are installed in
the slots on the J4350 and J6350 Services Routers to provide VoIP connectivity. The
TGM550 is an H.248 media gateway that works with the TIMs to connect IP and
legacy analog telephones and trunks over IP networks and enable IP telephones to
communicate through analog telephone lines and trunks.

The TGM550 is also connected over a LAN or WAN to a Media Gateway Controller
(MGC)—an Avaya media server running Avaya Communication Manager (CM) call
processing software. The telephony services on the TGM550 are managed by an
MGC located at headquarters or in a branch office. When the primary MGC is located
at a remote location, the TGM550 uses standard local survivability (SLS) for partial
MGC backup in the event that the connection to the primary MGC is lost. Devices
can thereby provide reliable telephony services to branch offices.

Figure 38 on page 261 shows a typical VoIP topology. The small branch office shown
in the expanded illustration on the right is connected over the corporate WAN to the
head office through a J6300 Services Router with VoIP modules installed. The Avaya
Media Gateway Controller, S8700 Media Server, and integrated Management tools
at the head office manage telephony services for headquarters and the branch offices
on the WAN, connecting the corporation's legacy analog telephones, VoIP telephones,
PCs, and fax machines to the PSTN.
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Figure 38: Typical VoIP Topology

VoIP Interfaces

Four types of interfaces on Avaya VoIP modules provide VoIP connectivity on J4350
and J6350 Services Routers:

■ Analog telephone or trunk port

■ T1 port

■ E1 port

■ ISDN BRI telephone or trunk port

These interfaces are available on the field-replaceable Avaya VoIP modules listed in
Table 72 on page 262. For more information about interface names, see “Network
Interface Naming” on page 9. For more information about the modules, see “Avaya
VoIP Modules Overview” on page 262.
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Table 72: Interfaces on Avaya VoIP Modules

JUNOS Interface

(type-pim/0/port)VoIP InterfacesDescriptionModule Name

vp-pim/0/0

On a VoIP interface, the port is
always 0.

■ Two analog telephone
ports

■ Two analog trunk ports

■ One serial port for
console access

Avaya Telephony Gateway
Module (TGM)

TGM550

–One E1/T1 trunk port
providing up to 30 E1 or 24 T1
channels

Avaya E1/T1 Telephony
Interface Module (TIM)

TIM510

–■ Four analog telephone
ports

■ Four analog trunk ports

Avaya Analog TIMTIM514

–Four ISDN BRI trunk ports
providing up to eight channels

Avaya BRI TIMTIM521

Only the TGM550 has a JUNOS interface. Because the TIMs do not have corresponding
physical interfaces, you cannot configure or administer them with the J-Web interface
or the JUNOS CLI. However, you can display TGM550 and TIM status from J-Web
Monitor>Chassis pages and with the CLI show chassis command.

NOTE: TIMs are configured and administered from the TGM550 CLI. For more
information, see the Administration Guide and CLI Reference for the Avaya IG550
Integrated Gateway at http://support.avaya.com.

CAUTION: The TGM550 and TIMs are not hot-swappable. You must power off the
router before installing or removing the Avaya VoIP modules. Ensure that the Avaya
VoIP modules are installed in the router chassis before booting up the system.

Avaya VoIP Modules Overview

A TGM550 and one or more TIMs installed in a Services Router provide telephony
exchange services to a branch office over IP networks. Different TIMs have access
ports for different types of VoIP and analog telephones and telephone lines. You
connect the telephones and lines to the ports on the TGM550 and the TIMs. VoIP
telephones require connection to a Power over Ethernet (PoE) adapter or switch that
is plugged into an Ethernet port on the Services Router.

VoIP capabilities on the TGM550 enable the Services Router to provide VoIP services
to telephones and trunks that do not directly support VoIP. The TGM550 translates
voice and signaling data between VoIP and the system used by the telephones and
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trunks. TIMs convert the voice path of traditional circuits such as analog trunk and
T1 or E1 to a TDM bus inside the router. The TGM550 then converts the voice path
from the TDM bus to compressed or uncompressed and packetized VoIP on an
Ethernet connection.

Media Gateway Controller

A Media Gateway Controller (MGC) is a media server (call controller) that controls
telephone services on the TGM550. An Avaya media server running Avaya
Communication Manager (CM) software acts as an MGC for the TGM550.

The following media servers running Avaya Communication Manager can be used
as an MGC with the TGM550:

■ Avaya S8300 Media Server—Controls up to 49 TGM550s.

■ Avaya S8400 Media Server—Controls up to 5 TGM550s.

■ Avaya S8500 Media Server—Controls up to 250 TGM550s.

■ Avaya S8700 Media Server—Controls up to 250 TGM550s.

■ Avaya S8710 Media Server—Controls up to 250 TGM550s.

■ Avaya S8720 Media Server—Controls up to 250 TGM550s.

To provide telephony services, the TGM550 must be registered with at least one
Media Gateway Controller (MGC). You can configure the IP addresses of up to four
MGCs that the TGM550 can connect to in the event of a link failure. The MGC list
consists of the IP addresses of the MGCs to connect to and the order in which to
reestablish the H.248 link. The first MGC on the list is the primary MGC. The TGM550
searches for the primary MGC first. If it cannot connect to the primary MGC or loses
its connection to the primary MGC, it attempts to connect to the next MGC in the
list, and so on.

NOTE: The MGC list is stored in the TGM550. It is not written to the JUNOS
configuration file.

You must also administer Avaya Communication Manager on the configured Media
Gateway Controllers to support the TGM550. For more information, see the following
Avaya IG550 Integrated Gateway manuals at http://support.avaya.com:

■ Installing and Configuring the Avaya IG550 Integrated Gateway

■ Administration Guide and CLI Reference for the Avaya IG550 Integrated Gateway

■ Administrator Guide for Avaya Communication Manager

■ Avaya Maintenance Procedures for Communication Manager, Media Servers, and
Media Gateways

■ Avaya Maintenance Commands for Communication Manager, Media Servers, and
Media Gateways

■ Avaya Maintenance Alarms for Communication Manager, Media Servers, and Media
Gateways
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Avaya Communication Manager

Avaya Communication Manager (CM) software manages the Media Gateway Controller
(MGC). Avaya CM allows you to do the following:

■ Assign numbers to local telephones.

■ Determine where to connect your telephone call based on the number you dial.

■ Play dial tones, busy signals, and prerecorded voice announcements.

■ Allow or prohibit access to outside lines for specific telephones.

■ Assign telephone numbers and buttons to special features.

■ Exchange call switching information with older telephone switches that do not
support VoIP.

NOTE:  The TGM550 supports Avaya Communication Manager (CM) release 4.0 and
later releases. The TGM550 does not support Avaya Communication Manager (CM)
releases earlier than release 4.0.

For more information about Avaya CM, see the Administrator Guide for Avaya
Communication Manager at http://support.avaya.com.

Dynamic Call Admission Control Overview

Dynamic call admission control (CAC) enables the Media Gateway Controller (MGC)
to automatically assign the bandwidth available for voice traffic on WAN interfaces
and block new calls when the existing call bandwidth is completely engaged. You
configure dynamic CAC on a high-bandwidth primary interface and on one or more
backup interfaces with less bandwidth.

Without dynamic CAC, the MGC cannot detect the switchover to the backup link or
the resulting changes in network topology and available bandwidth. As a result, the
MGC continues to admit calls at the bandwidth of the primary link, causing network
congestion and possible jitter, delay, and loss of calls.

Supported Interfaces

Dynamic CAC must be configured on each Services Router interface responsible for
providing call bandwidth. You can configure dynamic CAC on the following types of
interfaces on Services Routers:

■ ADSL

■ E1

■ E3

■ Fast Ethernet

■ Gigabit Ethernet
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■ GRE

■ G.SHDSL

■ ISDN BRI

■ Serial interfaces

■ T1

■ T3

Bearer Bandwidth Limit and Activation Priority

The dynamic CAC bearer bandwidth limit (BBL) configured on an interface specifies
the maximum bandwidth available for voice traffic on the interface. The TGM550
reports the BBL to the MGC. When the call bandwidth exceeds the BBL, the MGC
blocks new calls and alerts the user with a busy tone.

You configure the dynamic CAC activation priority value on interfaces to specify the
order in which the interfaces are used for providing call bandwidth.

Rules for Determining Reported BBL

To assess the WAN interfaces that have an activation priority value and determine
a single BBL to report to the MGC, the TGM550 uses the following rules. The reported
BBL (RBBL) allows the MGC to automatically control the call bandwidth when
interfaces responsible for providing call bandwidth become available or unavailable.

■ Report the BBL of the active interface with the highest activation priority. For
example, if one interface has the activation priority of 200 and a BBL of
1500 Kbps and another interface has the activation priority of 100 and a BBL of
1000 Kbps, the RBBL is 1500 Kbps.

■ If more than one active interface has the same activation priority, report a BBL
that is the number of interfaces times their lowest BBL. For example, if two
interfaces with the same activation priority have BBLs of 2000 Kbps and 1500
Kbps, the RBBL is 3000 Kbps (2 x 1500 Kbps).

■ If the interface with the highest activation priority is unavailable, report the BBL
of the active interface with the next highest activation priority.

■ If all the interfaces on which dynamic CAC is configured are inactive, report a
BBL of 0. The MGC does not allow calls to go through when the RBBL is 0.

NOTE: Dynamic CAC works in conjunction with the Avaya Communication Manager
(CM) Call Admission Control: Bandwidth Limitation (CAC-BL) feature. If you configure
dynamic CAC on WAN interfaces, you must also configure CAC-BL on Avaya CM.
For more information about configuring CAC-BL, see the Administrator Guide for
Avaya Communication Manager at http://support.avaya.com.
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TGM550 Firmware Compatibility with JUNOS Internet Software

The TGM550 firmware version must be compatible with the JUNOS Software version
installed on the device. For compatibility information, see the Communication Manager
Software & Firmware Compatibility Matrix at http://support.avaya.com.

CAUTION: If the TGM550 firmware version is not compatible with the JUNOS Internet
software version on the router, the router does not detect the VoIP interface
(vp-pim/0/0) and the interface is unavailable. For more information, see “TGM550
Is Installed But the VoIP Interface Is Unavailable” on page 286.

If you are upgrading both the TGM550 firmware and the JUNOS Software on the
router, first upgrade the TGM550 firmware, and then upgrade the JUNOS Software.

For information about upgrading the TGM550 firmware, see the Administration Guide
and CLI Reference for the Avaya IG550 Integrated Gateway at http://support.avaya.com.

TGM550 IP Addressing Guidelines

For operational purposes, the TGM550 is identified as a host on the device. Hence,
the TGM550 needs to be assigned an IP address that is reachable both externally
and internally from the device. The TGM550 uses this IP address to identify itself
when communicating with other devices, particularly the Media Gateway Controller
(MGC).

To assign the IP address for the TGM550, you configure the destination address on
the vp-pim/0/0 interface. For information about configuring the vp-pim/0/0 interface,
see “Configuring VoIP Interfaces with Quick Configuration” on page 269 or “Configuring
the VoIP Interface (Required)” on page 272.

CAUTION: Applying a new or modified IP address resets the TGM550. Before
modifying the IP address, take the following precautions:

■ Log into the TGM550 and enter copy running-config startup-config to save the
TGM550 configuration. (For login instructions, see “Accessing and Administering
the TGM550 CLI” on page 278.)

■ Ensure that the TGM550 is not currently handling voice traffic.

To enable easier administration of the TGM550, we recommend the following
guidelines for assigning the IP address of the TGM550:

■ Assign an address from one of the subnets that is already configured in the
branch office where the device is installed.

■ Decide on a block of IP addresses for VoIP services, and assign an IP address
from that block to the TGM550.

■ Do not assign the following IP addresses to the TGM550:
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■ A broadcast address (255.255.255.255)

■ A class E address (240.0.0.0 to 255.255.255.254)

■ A loopback address (127.0.0.0 to 127.255.255.255)

■ A multicast address (224.0.0.0 to 239.255.255.255)

■ An address with 0 as the first byte or an address with 0 or 255 as the last
byte

Before You Begin

Before you configure VoIP interfaces, you need to perform the following tasks:

■ Install Services Router hardware, including the TGM550 and the TIMs. Before
power is connected, ensure that the router is grounded with a 10 AWG cable.

For installation and grounding instructions, see the J4350 and J6350 Services
Router Getting Started Guide.

CAUTION: The original grounding cable for SSG Services Routers is 14 AWG only
and must be replaced with a 10 AWG cable.

■ Verify that you have connectivity to at least one Avaya media server running
Avaya Communication Manager (CM) release 4.0 or later. For more information
about Avaya media servers, see “Media Gateway Controller” on page 263.

■ Verify that the Services Router is running JUNOS Release 8.2R1 or later.

■ Download and install the most recent firmware for the TGM550. Verify that the
TGM550 firmware version is compatible with the JUNOS Software version installed
on the Services Router. For more information, see “TGM550 Firmware
Compatibility with JUNOS Internet Software” on page 266.

■ If you are configuring VoIP using the Avaya Electronic Preinstallation Worksheet
(EPW) and a Disk-on-Key USB memory stick, order a Disk-on-Key USB memory
stick. For Disk-on-Key requirements, see “Configuring VoIP Interfaces with EPW
and Disk-on-Key” on page 268.

■ Establish basic connectivity. For more information, see the J4350 and J6350
Services Router Getting Started Guide.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

■ Applying an IP address to the TGM550 resets the module. If you are updating
an existing VoIP configuration by modifying the TGM550 IP address, take the
following precautions:

■ Log into the TGM550 and enter copy running-config startup-config to save the
TGM550 configuration. (For login instructions, see “Accessing and
Administering the TGM550 CLI” on page 278.)
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■ Ensure that the TGM550 is not currently handling voice traffic.

Configuring VoIP Interfaces with EPW and Disk-on-Key

If you have a new J4350 or J6350 Services Router with the TGM550 and TIMs installed
in the router, you can use the Avaya Electronic Preinstallation Worksheet (EPW) and
a Disk-on-Key USB memory stick to configure VoIP on the router.

The EPW is a customized Microsoft Excel spreadsheet that you use to collect a
complete set of VoIP configuration information and create a configuration file named
juniper-config.txt. You can copy the juniper-config.txt file to a Disk-on-Key device and
boot the router from the device to configure VoIP on the router.

This configuration method has the following requirements:

■ A management device (PC or laptop) running Microsoft Excel version 2000 or
later.

■ A Disk-on-Key device with one of the following 16-bit or 32-bit file allocation
table (FAT) file systems:

■ DOS 3.0+ 16-bit FAT (up to 32 MB)

■ DOS 3.31+ 16-bit FAT (over 32 MB)

■ WIN95 OSR2 FAT32

■ WIN95 OSR2 FAT32, LBA-mapped

■ WIN95 DOS 16-bit FAT, LBA-mapped

■ A Services Router with the factory configuration and the TGM550 and TIMs
installed. If other JUNOS configuration files exist on the Services Router, the
router cannot read the juniper-config.txt file from the Disk-on-Key device. To
remove the configuration files from the router, press and hold the RESET CONFIG
button for 15 seconds or more, until the STATUS LED blinks red.

CAUTION: Pressing and holding the RESET CONFIG button for 15 seconds or
more—until the STATUS LED blinks red—deletes all configurations on the router,
including the backup configurations and rescue configuration, and loads and commits
the factory configuration.
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To configure a VoIP interface using EPW and Disk-on-Key:

1. Follow these instructions to download the EPW to a PC or laptop computer.

a. Go to http://support.avaya.com.

b. On the Avaya support page, click Find Documentation and Technical
Information by Product Name.

c. Scroll down and click Integrated Management — Provisioning & Installation
Manager.

d. Select the 4.0 release from the select a release drop-down box and click View
all documents.

e. Scroll down and double— click the Electronic Preinstallation Worksheet
for Provisioning Installation Manager link.

f. Scroll down and double— click the View XLS link.

g. In the File Open window, click the Open button.

h. In the Security Warning window, open the EPW by clicking Enable Macros.
Be sure to open the EPW in Microsoft Excel version 2000 or later versions.

2. Enter information in the individual worksheets. Ensure that all mandatory fields
(highlighted in blue color) are filled in.

3. Select File>Save.

4. Open the InitialConfig worksheet and click Create Configuration File.

The Select Location page is displayed.

5. Choose a location where you want to create the configuration file.

The configuration file with the name juniper-config.txt is created.

6. Copy the juniper-config.txt file to a Disk-on-Key device.

7. Press and release the power button to power off the router. Wait for the POWER
LED to turn off.

8. Plug the Disk-on-Key device into the USB port on the Services Router.

9. Press the POWER button on the front panel of the router. Verify that the POWER
LED on the front panel turns green.

The router reads the juniper-config.txt file from the Disk-on-Key device and
commits the configuration.

10. Remove the Disk-on-Key device.

Configuring VoIP Interfaces with Quick Configuration

You can use the VoIP Interfaces Quick Configuration pages to configure the VoIP
interface on a router.
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To configure a VoIP interface with Quick Configuration:

1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the VoIP interface—for example, vp-5/0/0—you want to configure.

See “Network Interface Naming” on page 9.

2. Enter information into the Quick Configuration page, as described in Table 73
on page 270.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

4. To verify that the VoIP interface is configured correctly, see “Verifying the VoIP
Configuration” on page 283.

Table 73: VoIP Interface Quick Configuration Page Summary

Your ActionFunctionField

VoIP Logical Interfaces

Click Add.Defines logical unit 0  as the physical VoIP
interface to which you connect. You must
define one logical unit for the VoIP interface.

NOTE: You cannot define more than one logical
unit for the VoIP interface. The logical unit
number must be 0.

Add logical interfaces

Type a text description of the logical interface
to more clearly identify it in monitoring
displays.

(Optional) Describes the logical interface.Logical Interface
Description
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Table 73: VoIP Interface Quick Configuration Page Summary (continued)

Your ActionFunctionField

Type the IPv4 address with /32 as the subnet
mask. For example:

10.10.10.1/32

Specifies the IPv4 address for the interface.

The following rules apply:

■ You cannot specify more than one IPv4
address.

■ Do not assign the following IPv4
addresses:

■ A broadcast address
(255.255.255.255)

■ A class E address (240.0.0.0 to
255.255.255.254)

■ A loopback address (127.0.0.0 to
127.255.255.255)

■ A multicast address (224.0.0.0 to
239.255.255.255)

■ An address with 0 as the first byte or
an address with 0 or 255 as the last
byte

■ The VoIP interface needs a point-to-point
connection to the TGM550. To configure
the point-to-point connection, specify /32
as the subnet mask in the IPv4 address.

IPv4 Address and Prefix

Type the IP address of the TGM550—for
example, 10.10.10.2.

Specifies the IP address of the TGM550.

CAUTION: Applying a new or modified IP
address resets the TGM550. For existing
configurations, ensure that the TGM550
configuration is saved (see “Saving the TGM550
Configuration” on page 283) and that the
TGM550 module is carrying no voice traffic.

You cannot specify more than one IP address.
For more information, see “TGM550 IP
Addressing Guidelines” on page 266.

Destination Address

Type a text description of the physical VoIP
interface in the box to clearly identify it in
monitoring displays.

(Optional) Adds supplemental information
about the VoIP physical interface on the router.

Physical Interface
Description

TGM Configuration

1. Type the IP address of the MGC.

2. Click Add.

To delete an IP address, select it in the MGC
List box, then click Delete.

Specifies the IP address of at least one and up
to four Media Gateway Controllers (MGCs) with
which the TGM550 must be registered.

The first MGC in the list is the primary MGC.
The TGM550 searches for the primary MGC
first. If it cannot connect to the primary MGC,
the TGM550 searches for the next MGC on the
list, and so on.

MGC List
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Configuring VoIP with a Configuration Editor

To configure VoIP on a device, perform the following tasks marked (Required). Perform
other tasks if needed on your network.

■ Configuring the VoIP Interface (Required) on page 272

■ Configuring the Media Gateway Controller List (Required) on page 273

■ Configuring Dynamic Call Admission Control on WAN Interfaces
(Optional) on page 275

■ Modifying the IP Address of the TGM550 on page 277

Configuring the VoIP Interface (Required)

You must assign a local IP address to the vp-pim/0/0 interface on the Services Router
and also a destination IP address to the TGM550 so that they can communicate with
each other.

To configure the VoIP interface on the device:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 74 on page 272.

3. If you are finished configuring the router, commit the configuration.

4. Continue with “Configuring the Media Gateway Controller List (Required)” on
page 273.

Table 74: Configuring the VoIP Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces vp-3/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

In the Interface name column, click the
VoIP interface name vp-3/0/0.

Select the VoIP interface—for example,
vp-3/0/0.

Enter

edit unit 0

1. Next to Unit, click Add new entry.

2. In the Interface unit number box,
type 0.

Create the logical unit 0.

NOTE: You cannot configure more than
one logical unit on the VoIP interface.
The logical unit number must be 0.
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Table 74: Configuring the VoIP Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set family inet address 10.10.10.1/32
destination 10.10.10.2

1. Under Family, select the Inet check
box and click Configure.

2. Next to Address, click Add new
entry.

3. In the Source box, type
10.10.10.1/32.

Configure the source IPv4 address—for
example, 10.10.10.1/32—for the VoIP
interface.

The following rules apply:

■ You cannot specify more than one
IPv4 address.

■ Do not assign the following IPv4
addresses:

■ A broadcast address
(255.255.255.255)

■ A class E address (240.0.0.0
to 255.255.255.254)

■ A loopback address (127.0.0.0
to 127.255.255.255)

■ A multicast address (224.0.0.0
to 239.255.255.255)

■ An address with 0 as the first
byte or an address with 0 or
255 as the last byte

■ The VoIP interface needs a
point-to-point connection to the
TGM550. To configure the
point-to-point connection, specify
/32 as the subnet mask in the IPv4
address.

1. In the Destination box, type
10.10.10.2.

2. Click OK until you return to the
Interfaces page.

Configure the destination IP address—for
example 10.10.10.2—for the TGM550.
The TGM550 uses this IP address to
identify itself when communicating with
other devices, particularly the Media
Gateway Controller (MGC).

CAUTION: Applying a new or modified
IP address resets the TGM550. For
existing configurations, ensure that the
TGM550 configuration is saved (see
“Saving the TGM550 Configuration” on
page 283) and that the TGM550 module
is carrying no voice traffic.

You cannot specify more than one IP
address. For more information, see
“TGM550 IP Addressing Guidelines” on
page 266.

Configuring the Media Gateway Controller List (Required)

To provide telephony services, the TGM550 must be registered with at least one
Media Gateway Controller (MGC). You can configure the IP addresses of up to four
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MGCs that the TGM550 can connect to in the event of a link failure. For more
information, see “Media Gateway Controller” on page 263.

In addition to configuring the MGC list from a J-Web Quick Configuration page (see
Table 73 on page 270) and the JUNOS CLI, you can log in to the TGM550 and configure
the list. For more information, see the Administration for the Avaya IG550 Integrated
Gateway  at http://support.avaya.com.

This section contains the following topics:

■ Configuring an MGC List and Adding Addresses on page 274

■ Clearing an MGC List on page 275

Configuring an MGC List and Adding Addresses

In the following example, a TGM550 installed in slot 2 of a Services Router has the
IP address 10.10.10.2. The TGM550 needs to have registered a primary MGC at
address 172.16.0.0, and second and third MGC at addresses 10.10.10.30 and
10.10.10.10.40.

To configure the MGC list with the JUNOS CLI:

1. Enter operational mode on the JUNOS CLI.

2. Configure the IP addresses of the Media Gateway Controllers, by entering the
set tgm fpc slot media-gateway-controller command with the IP addresses of the
primary, second, and third MGC:

user@host> set tgm fpc 2 media-gateway-controller [172.16.0.0 10.10.10.30
10.10.10.40]

NOTE: Running the set tgm fpc slot media-gateway-controller command updates the
startup configuration on the TGM550. You do not need to run the copy running-config
start-config command to save the configuration on the module.

3. Log in to the TGM550 with SSH, and verify that each MGC can be reached over
the network.

user@host> ssh 10.10.10.2

password> root

TGM550-00<root># ping 172.16.0.0

...

TGM550-00<root># ping 10.10.10.30

...

TGM550-00<root># ping 10.10.10.40

...

4. Do one of the following:
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■ To control bandwidth assignments for voice traffic, continue with
“Configuring Dynamic Call Admission Control on WAN Interfaces (Optional)”
on page 275.

■ To verify that VoIP is configured correctly on the router, see “Verifying the
VoIP Configuration” on page 283.

Clearing an MGC List

In the following example, a TGM550 is installed in slot 2 of the router.

To remove all the IP addresses from the MGC list:

1. Enter operational mode on the CLI.

2. Enter the clear tgm fpc slot media-gateway-controller command:

user@host> clear tgm fpc 2 media-gateway-controller

The clear command removes all the MGC IP addresses. You cannot clear the IP
address of a single MGC with this command.

3. Add one or more new MGC IP addresses. (See “Configuring an MGC List and
Adding Addresses” on page 274.)

Configuring Dynamic Call Admission Control on WAN Interfaces (Optional)

To configure dynamic call admission control (CAC), you define the bearer bandwidth
limit (BBL) and activation priority on each WAN interface responsible for providing
call bandwidth.

■ The activation priority has a range from 1 through 255. The default value is 50.

■ The BBL has a range from 0 Kbps through 9999 Kbps. The default BBL value of
–1 Kbps indicates that the complete bandwidth of the interface is available for
voice traffic. Use a BBL of 0, which indicates that no bandwidth is available for
bearer traffic on the MGC, to use the interface for signaling only.

In this example, a Gigabit Ethernet, T1, and ISDN BRI interface are configured with
the BBL and activation priority values shown in Table 75 on page 275.

Table 75:  Dynamic CAC Configuration Example

Activation Priority ValueBearer Bandwidth Limit (BBL) ValueInterface Providing Call Bandwidth

2003000 KbpsGigabit Ethernet

1501000 KbpsT1

100128 KbpsISDN BRI
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The Gigabit Ethernet interface is used as the primary link for providing call bandwidth
because it has the highest activation priority value. When the Gigabit Ethernet interface
is active, the TGM550 reports its BBL value of 3000 Kbps to the MGC. If the Gigabit
Ethernet interface fails, the TGM550 automatically switches over to the T1 interface
because it has the next highest activation priority. The TGM550 now reports the BBL
value of the T1 interface to the MGC. If the T1 interface also fails, the TGM550 switches
over to the ISDN BRI interface and reports the BBL value of the ISDN BRI interface
to the MGC. Configuring dynamic CAC on multiple WAN interfaces allows the MGC
to automatically control the call bandwidth when interfaces responsible for providing
call bandwidth are unavailable.

For more information about dynamic CAC, see “Dynamic Call Admission Control
Overview” on page 264.

To configure dynamic CAC on Services Router WAN interfaces:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 76 on page 276.

3. If you are finished configuring the router, commit the configuration.

4. Configure Call Admission Control: Bandwidth Limitation (CAC-BL) on Avaya
Communication Manager. For more information, see the Administrator Guide for
Avaya Communication Manager at http://support.avaya.com.

5. Verify that dynamic CAC is configured correctly, see “Verifying the VoIP
Configuration” on page 283.

Table 76: Configuring Dynamic CAC

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces ge-0/0/3

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

In the Interface name column, click
ge-0/0/3.

Select the Gigabit Ethernet interface—for
example, ge-0/0/3.

1. Enter

edit unit 0

2. Enter

set dynamic-call-admission-control
activation-priority 200
bearer-bandwidth-limit 3000

1. Under Unit, next to 0, click Edit.

2. Next to Dynamic call admission
control, click Configure or Edit.

3. In the Activation priority box, type
200.

4. In the Bearer bandwidth limit box,
type 3000.

5. Click OK until you return to the
Interfaces page.

Configure dynamic CAC on logical unit
0 of the Gigabit Ethernet interface with
the activation priority and BBL values
given in Table 75 on page 275.
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Table 76: Configuring Dynamic CAC (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces t1-6/0/0

In the Interface name column, click
t1-6/0/0.

Select the T1 interface—for example,
t1-6/0/0.

1. Enter

edit unit 0

2. Enter

set dynamic-call-admission-control
activation-priority 150
bearer-bandwidth-limit 1000

1. Under Unit, next to 0, click Edit.

2. Next to Dynamic call admission
control, click Configure or Edit.

3. In the Activation priority box, type
150.

4. In the Bearer bandwidth limit box,
type 1000.

5. Click OK until you return to the
Interfaces page.

Configure dynamic CAC on logical unit
0 of the T1 interface with the activation
priority and BBL values given in Table
75 on page 275.

From the [edit] hierarchy level, enter

edit interfaces br-1/0/3

In the Interface name column, click
br-1/0/3.

Select the ISDN BRI interface—for
example, br-1/0/3.

1. Enter

edit unit 0

2. Enter

set dynamic-call-admission-control
activation-priority 100
bearer-bandwidth-limit 128

1. Under Unit, next to 0, click Edit.

2. Next to Dynamic call admission
control, click Configure or Edit.

3. In the Activation priority box, type
100.

4. In the Bearer bandwidth limit box,
type 128.

5. Click OK.

Configure dynamic CAC on logical unit
0 of the ISDN BRI interface with the
activation priority and BBL values given
in Table 75 on page 275.

Modifying the IP Address of the TGM550

CAUTION: The TGM550 is reset when you commit the configuration after modifying
the IP address. Before modifying the TGM550 IP address, take the following
precautions:

■ Log into the TGM550 and enter copy running-config startup-config to save the
TGM550 configuration. (For login instructions, see “Accessing and Administering
the TGM550 CLI” on page 278.)

■ Ensure that the TGM550 is not currently handling voice traffic.

To modify the IP address of the TGM550:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.
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2. Perform the configuration tasks described in Table 77 on page 278.

3. If you are finished configuring the router, commit the configuration.

Table 77: Modifying the IP Address of the TGM550

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces vp-3/0/0 unit 0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

1. In the Interface name column, click
the VoIP interface name vp-3/0/0.

2. In the Interface unit number box,
click 0.

Select the logical VoIP interface—for
example, vp-3/0/0.0.

Enter

set family inet address 10.10.10.1/32
destination 10.10.10.80

1. Under Family, next to Inet, click
Edit.

2. Under Address, in the Broadcast
column, click Edit.

3. In the Destination box, type
10.10.10.80.

4. Click OK.

Modify the destination IP address for the
TGM550 to a different address—for
example, 10.10.10.80.

For guidelines, see “TGM550 IP
Addressing Guidelines” on page 266.

NOTE: You cannot specify more than
one IP address.

Accessing and Administering the TGM550 CLI

The CLI on the TGM550 allows you to configure, monitor, and diagnose the TGM550
and TIMs installed in a Services Router. You can access the TGM550 from a
management device attached to the TGM550 console port or by opening a Telnet or
secure shell (SSH) session from the JUNOS CLI on the Services Router.

You can also open a remote Telnet or SSH session directly to the TGM550 from a
network location, or indirectly through the JUNOS CLI from a dial-up connection with
a USB modem attached to the router.

This section contains the following topics. For complete information about the
TGM550 CLI, see the Administration Guide and CLI Reference for the Avaya IG550
Integrated Gateway.

■ TGM550 Access Requirements on page 279

■ Connecting Through the TGM550 Console Port on page 279

■ Connecting to the TGM550 with SSH on page 280

■ Accessing the TGM550 with Telnet on page 280

■ Accessing the Services Router from the TGM550 on page 282
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■ Resetting the TGM550 on page 282

■ Saving the TGM550 Configuration on page 283

TGM550 Access Requirements

Administrators can use the root password to access the TGM550 initially, but all users
need a TGM550 user account (username and password) set up by the network
administrator for regular access to the module. For information about user accounts
on a TGM550, see the Administration Guide and CLI Reference for the Avaya IG550
Integrated Gateway at at http://support.avaya.com.

NOTE: You cannot use a Services Router user account to access the TGM550 CLI.

■ A console connection requires the Ethernet rollover cable and adapter provided
with the TGM550. (See “Connecting Through the TGM550 Console Port” on
page 279.)

■ An SSH connection requires that the TGM550 have an IP address assigned.

■ A Telnet connection to the TGM550 requires that the module have an IP address
and that Telnet service be enabled on the module.

To assign an IP address to the TGM550, see “Configuring VoIP Interfaces with Quick
Configuration” on page 269 or “Configuring the VoIP Interface (Required)” on page 272.

To enable Telnet, see “Accessing the TGM550 with Telnet” on page 280.

Connecting Through the TGM550 Console Port

To connect to the TGM550 through its console port:

1. Turn off the power to the management device, such as a PC or laptop computer,
that you are using to access the TGM550.

2. Plug one end of an Ethernet rollover cable provided with the TGM550 into the
RJ-45 to DB-9 serial port adapter provided with the TGM550.

CAUTION: Two different RJ-45 cables and RJ-45 to DB-9 adapters are provided. Do
not use the RJ-45 cable and adapter for the Services Router console port to connect
to the TGM550 console port.

3. Plug the RJ-45 to DB-9 serial port adapter provided with the TGM550 into the
serial port on the management device.

4. Connect the other end of the Ethernet rollover cable to the console port (CONSOLE)
on the TGM550.

5. Turn on power to the management device.
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6. Start your asynchronous terminal emulation application (such as Microsoft
Windows Hyper Terminal), and select the appropriate COM port to use (for
example, COM1).

7. Configure the port settings as follows:

■ Bits per second: 9600

■ Data bits: 8

■ Parity: None

■ Stop bits: 1

■ Flow control: Hardware

8. At the login prompt, type your username and press Enter.

9. At the password prompt, type your password and press Enter.

Connecting to the TGM550 with SSH

To connect to the TGM550 with SSH:

1. Ensure that the TGM550 has an IP address. (See “Configuring VoIP Interfaces
with Quick Configuration” on page 269 or “Configuring the VoIP Interface
(Required)” on page 272.)

2. From the JUNOS CLI or a remote connection, enter the following command:

ssh ip-address

Accessing the TGM550 with Telnet

By default, Telnet service is not enabled on the TGM550. You must enable Telnet
service on the TGM550 before you can telnet to the TGM550 from other devices or
from the TGM550 to other devices.

CAUTION: Telnet connections are not encrypted and therefore can be intercepted.

This section contains the following topics:

■ Enabling Telnet Service on the TGM550 on page 280

■ Connecting to the TGM550 with Telnet on page 281

■ Disabling Telnet Service on the TGM550 on page 281

Enabling Telnet Service on the TGM550

To enable Telnet service on the TGM550:
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1. Connect to the TGM550 through the console port. (See “Connecting Through the
TGM550 Console Port” on page 279.

2. Enable incoming Telnet connections, by entering the following command,
replacing port with the Telnet port number:

TGM550-004(super)# ip telnet port port

3. Enable outgoing Telnet connections from the TGM550 to other devices, by
entering

TGM550-004(super)# ip telnet-client

4. Save the configuration by entering:

TGM550-004(super)# copy running-config startup-config

Connecting to the TGM550 with Telnet

To connect to the TGM550 with Telnet:

1. Ensure that Telnet is enabled on the TGM550. (See “Enabling Telnet Service on
the TGM550” on page 280.)

2. Ensure that the TGM550 has an IP address. (See “Configuring VoIP Interfaces
with Quick Configuration” on page 269 or “Configuring the VoIP Interface
(Required)” on page 272.)

3. From the JUNOS CLI or a remote connection, enter the following command:

telnet ip-address

Disabling Telnet Service on the TGM550

To disable Telnet service on the TGM550:

1. Connect to the TGM550 through the console port. For more information, see
“Connecting Through the TGM550 Console Port” on page 279.

2. Disable incoming Telnet connections, by entering the following command,
replacing port with the Telnet port number:

TGM550-004(super)# no ip telnet

3. Disable outgoing Telnet connections from the TGM550 to other devices, by
entering

TGM550-004(super)# no ip telnet-client

4. Save the configuration:

TGM550-004(super)# copy running-config startup-config
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Accessing the Services Router from the TGM550

You can access the Services Router from the CLI on its installed TGM550 in the
following ways:

■ Enter the session chassis command.

■ Enter the telnet or ssh command.

NOTE: Before using the TGM550 CLI telnet command, ensure that Telnet service is
enabled on the TGM550. For more information, see “Enabling Telnet Service on the
TGM550” on page 280.

Resetting the TGM550

CAUTION: Before resetting the TGM550, take the following precautions:

Log into the TGM550 and enter copy running-config startup-config to save the
TGM550 configuration. (For login instructions, see “Accessing and Administering
the TGM550 CLI” on page 278.)

■

■ Ensure that the TGM550 is not currently handling voice traffic.

You can reset the TGM550 from the module itself or from the Services Router.

To reset the TGM550 from the module itself, do one of the following:

■ Press the RST button on the TGM550.

■ Log into the TGM550, and enter the reset command. (For login instructions, see
“Accessing and Administering the TGM550 CLI” on page 278.)

To reset the TGM550 from the device:

1. Enter operational mode in the CLI.

2. Enter the request chassis fpc slot slot-number restart command.

For example, to reset a TGM550 installed in slot 2 on the router chassis, enter

user@host> request chassis fpc slot 2 restart

NOTE: You cannot reset the TIMs using the request chassis fpc slot slot-number restart
command. TIMs are administered only from the TGM550.
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Saving the TGM550 Configuration

To save the configuration on the TGM550:

1. Log in to the TGM550. (For login instructions, see “Accessing and Administering
the TGM550 CLI” on page 278.)

2. Save the configuration, by entering

TGM550-004(super)# copy running-config startup-config

For more information about saving a TGM550 configuration, see the Administration
Guide and CLI Reference for the Avaya IG550 Integrated Gateway at
http://support.avaya.com.

Verifying the VoIP Configuration

To verify the VoIP configuration, perform the following tasks:

■ Verifying the VoIP Interface on page 283

■ Verifying the Media Gateway Controller List on page 285

■ Verifying Bandwidth Available for VoIP Traffic on page 285

Verifying the VoIP Interface

Purpose Verify that the VoIP interface is correctly configured.

Action From the CLI, enter the show interfaces extensive command.

Sample Output user@host> show interfaces vp-3/0/0 extensive
Physical interface: vp-3/0/0, Enabled, Physical link is Up
  Interface index: 141, SNMP ifIndex: 21, Generation: 142
  Type: VP-AV, Link-level type: VP-AV, MTU: 1518, Speed: 10mbps
  Device flags   : Present Running
  Link type      : Full-Duplex
  Link flags     : None
  Physical info  : Unspecified
  CoS queues     : 8 supported, 8 maximum usable queues
  Last flapped   : 2006-09-29 09:28:32 UTC (4d 18:35 ago)
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :              8886912                    0 bps
   Output bytes  :              6624354                    0 bps
   Input  packets:                90760                    0 pps
   Output packets:                65099                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Framing errors: 0, Runts: 0, Giants: 0, Policed discards:
 0, 
Resource errors: 0
  Output errors:
    Carrier transitions: 0, Errors: 0, Drops: 0, MTU errors: 0, Resource errors:
 0
  Egress queues: 8 supported, 8 in use

Verifying the VoIP Configuration ■ 283

Chapter 9: Voice over Internet Protocol with Avaya

http://support.avaya.com


  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 best-effort                65099                65099                    0

    1 expedited-fo                   0                    0                    0

    2 assured-forw                   0                    0                    0

    3 network-cont                   0                    0                    0

  Packet Forwarding Engine configuration:
    Destination slot: 2
    CoS transmit queue               Bandwidth               Buffer Priority   
Limit
                              %            bps     %           usec
    0 best-effort            95        9500000    95              0      low    
none
    3 network-control         5         500000     5              0      low    
none

  Logical interface vp-3/0/0.0 (Index 71) (SNMP ifIndex 47) (Generation 137)
    Flags: Point-To-Point SNMP-Traps Encapsulation: VP-AV
    Protocol inet, MTU: 1500, Generation: 142, Route table: 0
      Flags: None   
      Filters: Input: pcap, Output: pcap
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 10.10.10.2, Local: 10.10.10.1, Broadcast: Unspecified, 
Generation: 144

Meaning The output shows a summary of interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates that the interface is disabled.
Do one of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates likely link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.
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Related Topics For a complete description of show interfaces output, see the Junos Interfaces Command
Reference.

Verifying the Media Gateway Controller List

Purpose Verify that the Media Gateway Controller (MGC) list is correctly configured and that
the MGCs are reachable over the network.

Action From the operational mode in the CLI, enter show tgm fpc slot-number
media-gateway-controller.

Sample Output user@host> show tgm fpc 2 media-gateway-controller
Media gateway controller(s): 173.26.232.77
                             10.10.10.30
                             10.10.10.40

Meaning The output shows the configured MGC list. Verify the following:

■ The IP addresses and the order of the IP addresses in the MGC list are correct.
The first MGC on the list is the primary MGC. The TGM550 searches for the
primary MGC first. If it cannot connect to the primary MGC or loses its connection
to the primary MGC, it attempts to connect to the next MGC in the list, and so
on.

■ Use the JUNOS CLI ping command or the J-Web ping host tool
(Troubleshoot>Ping Host) to verify that the configured MGCs can be reached
over the network.

Related Topics For a complete description of show tgm fpc output, see the Junos Interfaces Command
Reference.

Verifying Bandwidth Available for VoIP Traffic

Purpose Verify that the dynamic call admission control (CAC) configuration supports sufficient
bandwidth for VoIP traffic.

Action From the operational mode in the CLI, enter show tgm dynamic-call-admission-control.

Sample Output user@host> show tgm dynamic-call-admission-control
Reported bearer bandwidth limit: 3000  Kbps
Interface       State         Activation    Bearer bandwidth
                              priority      limit (Kbps)
ge-0/0/3.0      up                     200                 3000
t1-6/0/0.0      up                     150                 1000
br-1/0/3.0      up                      50                  128

Meaning The output shows the dynamic CAC configuration. Verify the following information:
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■ The activation priority and bearer bandwidth limit (BBL) configured on individual
interfaces are correct.

■ The Reported bearer bandwidth limit field displays the bandwidth available for
VoIP traffic. Ensure that the bandwidth is sufficient for VoIP traffic.

Related Topics For a complete description of show tgm dynamic-call-admission-control output, see the
Junos Interfaces Command Reference.

Frequently Asked Questions About the VoIP Interface

Use answers to the following question to solve configuration problems on a VoIP
interface:

■ TGM550 Is Installed But the VoIP Interface Is Unavailable on page 286

TGM550 Is Installed But the VoIP Interface Is Unavailable

Problem—I installed the TGM550 Telephony Gateway Module and configured the
VoIP interface—for example, vp-3/0/0—but the interface is not accessible. The show
chassis hardware command displays the TGM550 installed on slot 3. However, the
show interfaces terse command does not display the vp-3/0/0 interface, and the
show interfaces vp-3/0/0 command displays an error:

user@host> show interfaces vp-3/0/0
error: device vp-3/0/0 not found

Solution—The VoIP interface might be unavailable because the TGM550 firmware
version is not compatible with the JUNOS Software version installed on the device.
For more information, see “TGM550 Firmware Compatibility with JUNOS Internet
Software” on page 266.

To correct the TGM550 firmware and JUNOS Software version compatibility error:

1. Check the router's system log messages for a version incompatibility error similar
to the following:

Jan  5 11:07:03  host fwdd[2857]: TGMT: RE (1.0) - TGM (2.0) major protocol
 version mismatch: not marking TGM slot ready

2. If the error exists, connect to the TGM550 through the console port. (See
“Connecting Through the TGM550 Console Port” on page 279.

3. View the TGM550 firmware version, by entering

TGM550-003(super)# show image version

Bank        Version
----------- -------
A (current) 26.23.0
B           26.22.0

In this example, the current TGM550 firmware version is 26.23.0.
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4. Refer to the Communication Manager Software & Firmware Compatibility Matrix
at http://support.avaya.com to identify the JUNOS Software version that is compatible
with the current TGM550 firmware version.

5. Upgrade the router with the compatible JUNOS Software version.
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Chapter 10

Configuring Point-to-Point Protocol over
Ethernet

Point-to-Point Protocol over Ethernet (PPPoE) connects multiple hosts on an Ethernet
LAN to a remote site through a single customer premises equipment (CPE) device—a
Juniper Networks device. Hosts share a common digital subscriber line (DSL), a cable
modem, or a wireless connection to the Internet. To use PPPoE, you must initiate a
PPPoE session, encapsulate Point-to-Point Protocol (PPP) packets over Ethernet, and
configure the device as a PPPoE client.

NOTE: Juniper Networks devices with asymmetric digital subscriber line (ADSL) or
symmetric high-speed DSL (SHDSL) interfaces can use PPPoE over Asynchronous
Transfer Mode (ATM) to connect through DSL lines only, not for direct ATM
connections.

You can use the J-Web Quick Configuration, J-Web configuration editor, or CLI
configuration editor to configure PPPoE.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ PPPoE Terms on page 290

■ PPPoE Overview on page 291

■ Before You Begin on page 293

■ Configuring PPPoE Interfaces with Quick Configuration on page 293

■ Configuring PPPoE Encapsulation on an Ethernet Interface on page 296

■ Configuring PPPoE Encapsulation on an ATM-over-ADSL or ATM-over-SHDSL
Interface on page 297

■ Configuring PPPoE Interfaces on page 298

■ Configuring CHAP on a PPPoE Interface (Optional) on page 300

■ Verifying a PPPoE Configuration on page 303
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PPPoE Terms

Before configuring PPPoE, become familiar with the terms defined in Table 78 on
page 290.

Table 78: PPPoE Terms

DefinitionTerm

Device that acts as a PPPoE client in a PPPoE session—for example, a
Juniper Networks device.

customer premises equipment (CPE)

Encapsulation protocol that allows transport of multiple protocols over
a single ATM virtual connection.

Logical Link Control (LLC)

Encapsulation protocol for transporting IP traffic over point-to-point
links.

Point-to-Point Protocol (PPP)

Network protocol that encapsulates PPP frames in Ethernet frames and
connects multiple hosts over a simple bridging access device to a remote
access concentrator.

PPP over Ethernet (PPPoE)

Initiation packet that is broadcast by the client to start the discovery
process.

PPPoE Active Discovery Initiation (PADI) packet

Offer packets sent to the client by one or more access concentrators
in reply to a PADI packet.

PPPoE Active Discovery Offer (PADO) packet

Packet sent by the client to one selected access concentrator to request
a session.

PPPoE Active Discovery Request (PADR) packet

Packet sent by the selected access concentrator to confirm the session.PPPoE Active Discovery Session-Confirmation
(PADS) packet

Packet sent by either the client or the access concentrator to terminate
a session.

PPPoE Active Discovery Termination (PADT) packet

Network protocol that encapsulates PPPoE frames in Asynchronous
Transfer Mode (ATM) frames for asymmetric digital subscriber line
(ADSL) or symmetric high-speed DSL (SHDSL) transmission, and
connects multiple hosts over a simple bridging access device to a remote
access concentrator.

PPPoE over ATM

An identifier of the virtual path that establishes a route between two
devices in a network.

virtual path identifier (VPI)

An identifier of the virtual channel inside a virtual path. Each virtual
path identifier (VPI) can contain multiple virtual channels, each
represented by a VCI.

virtual channel identifier (VCI)
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PPPoE Overview

On the Juniper Networks device, PPPoE establishes a point-to-point connection
between the client (Juniper Networks device) and the server, also called an access
concentrator. Multiple hosts can be connected to the device, and their data can be
authenticated, encrypted, and compressed before the traffic is sent to the PPPoE
session on the Juniper Networks device's Fast Ethernet, Gigabit Ethernet,
ATM-over-ADSL, or ATM-over-SHDSL interface. PPPoE is easy to configure and allows
services to be managed on a per-user basis rather than on a per-site basis.

This overview contains the following topics:

■ PPPoE Interfaces on page 291

■ PPPoE Stages on page 292

■ Optional CHAP Authentication on page 293

PPPoE Interfaces

The device's PPPoE interface to the access concentrator can be a Fast Ethernet
interface, a Gigabit Ethernet interface, an ATM-over-ADSL interface, or an
ATM-over-SHDSL interface. The PPPoE configuration is the same for all interfaces.
The only difference is the encapsulation for the underlying interface to the access
concentrator:

■ If the interface is Ethernet, use a PPPoE encapsulation.

■ If the interface is ATM-over-ADSL or ATM-over-SHDSL, use a PPPoE over ATM
encapsulation.

Ethernet Interface

The device encapsulates each PPP frame in an Ethernet frame and transports the
frames over an Ethernet loop. Figure 39 on page 291 shows a typical PPPoE session
between a device and an access concentrator on the Ethernet loop.

Figure 39: PPPoE Session on the Ethernet Loop

ATM-over-ADSL or ATM-over-SHDSL Interface

When an ATM network is configured with a point-to-point connection, PPPoE can
use ATM Adaptation Layer 5 (AAL5) for framing PPPoE-encapsulated packets. The
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AAL5 protocol provides a virtual connection between the client and the server within
the same network. The device encapsulates each PPPoE frame in an ATM frame and
transports each frame over an ADSL or SHDSL loop and a digital subscriber line
access multiplexer (DSLAM). For example, Figure 40 on page 292 shows a typical
PPPoE over ATM session between a device and an access concentrator on an ADSL
loop.

Figure 40: PPPoE Session on an ADSL Loop

PPPoE Stages

PPPoE has two stages, the discovery stage and the PPPoE session stage. In the
discovery stage, the client discovers the access concentrator by identifying the
Ethernet media access control (MAC) address of the access concentrator and
establishing a PPPoE session ID. In the PPPoE session stage, the client and the access
concentrator build a point-to-point connection over Ethernet, based on the information
collected in the discovery stage.

PPPoE Discovery Stage

A device initiates the PPPoE discovery stage by broadcasting a PPPoE Active Discovery
Initiation (PADI) packet. To provide a point-to-point connection over Ethernet, each
PPPoE session must learn the Ethernet MAC address of the access concentrator and
establish a session with a unique session ID. Because the network might have more
than one access concentrator, the discovery stage allows the client to communicate
with all of them and select one.

NOTE: A device cannot receive PPPoE packets from two different access concentrators
on the same physical interface.

PPPoE Session Stage

The PPPoE session stage starts after the PPPoE discovery stage is over. The access
concentrator can start the PPPoE session after it sends a PPPoE Active Discovery
Session-Confirmation (PADS) packet to the client, or the client can start the PPPoE
session after it receives a PADS packet from the access concentrator. A device
supports multiple PPPoE sessions on each interface, but no more than 256 PPPoE
sessions per device.
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Each PPPoE session is uniquely identified by the Ethernet address of the peer and
the session ID.

Optional CHAP Authentication

For interfaces with PPPoE encapsulation, you can configure interfaces to support the
PPP Challenge Handshake Authentication Protocol (CHAP). When you enable CHAP
on an interface, the interface can authenticate its peer and be authenticated by its
peer.

If you set the passive option to handle incoming CHAP packets only, the interface
does not challenge its peer. However, if the interface is challenged, it responds to
the challenge. If you do not set the passive option, the interface always challenges
its peer.

You can configure Remote Authentication Dial-In User Service (RADIUS) authentication
of PPP sessions using CHAP. CHAP enables you to send RADIUS messages through
a routing instance to customer RADIUS servers in a private network. For more
information, see the Junos System Basics Configuration Guide.

For more information about CHAP, see the Junos Network Interfaces Configuration
Guide.

Before You Begin

Before you begin configuring PPPoE, complete the following tasks:

■ Establish basic connectivity. See the Getting Started Guide for your device.

■ Configure network interfaces. See ”Configuring a Fast Ethernet Interface with
Quick Configuration,””Configuring Gigabit Ethernet Interfaces—Quick
Configuration,” or ”Configuring Digital Subscriber Line Interfaces.”

Configuring PPPoE Interfaces with Quick Configuration

To configure properties on a PPPoE interface:

1. In the J-Web user interface, select Configure>Interfaces.

A list of the network interfaces present on the device is displayed, as shown in
Figure 12 on page 74 (see “Network Interface Naming” on page 16). The third
column indicates whether the interface has been configured.

2. Select pp0.

The PPPoE Interfaces Quick Configuration main page is displayed, as shown in
Figure 41 on page 294.
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Figure 41: PPPoE Interfaces Quick Configuration Main Page

3. Enter information into the Quick Configuration pages, as described in Table 79
on page 295.

4. From the PPPoE Interfaces Quick Configuration main page, click one of the
following buttons:

■ To apply the configuration and stay on the PPPoE Quick Configuration main
page, click Apply.

■ To apply the configuration and return to the Interfaces Quick Configuration
page, click OK.

■ To cancel your entries and return to the Interfaces Quick Configuration page,
click Cancel.

5. To verify that the PPPoE interface is configured correctly, see “Verifying a PPPoE
Configuration” on page 303.
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Table 79: PPPoE Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

■ To add a logical interface, click
Add.

■ To edit a logical interface, select the
interface from the list.

■ To delete a logical interface, select
the check box next to the name
and click Delete.

Lists the logical interfaces for the PPPoE
physical interface.

Logical Interfaces

Click Add.Defines one or more logical units that
you connect to this physical PPPoE
interface. You must define at least one
logical unit for a PPPoE interface.

Add logical interfaces

Type a text description of the logical
interface to more clearly identify it in
monitoring displays.

(Optional) Describes the logical interface.Logical Interface Description

1. Type one or more IPv4 addresses
and prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses
for the interface.

IPv4 Addresses and Prefixes

Type a text description of the PPPoE
interface to more clearly identify it in
monitoring displays.

(Optional) Adds supplementary
information about the physical PPPoE
interface.

Physical Interface Description

PPP Options

■ To enable CHAP, select the check
box.

■ To disable CHAP, clear the check
box.

Enables or disables CHAP authentication
on a PPPoE interface.

Enable CHAP

CHAP Local Identity (available if CHAP is enabled)

■ To enable, select the check box (the
default).

■ To disable, clear the check box.

Specifies that the PPPoE interface uses
the device's system hostname in CHAP
challenge and response packets.

Use System Host Name

Type a local name for this PPPoE
interface.

If Use System Host Name is disabled,
specifies the local name for CHAP to use.

Local Name

Type the CHAP client name.Identifies the client or peer with which
the device communicates on this PPPoE
interface.

CHAP Peer Identity (required if CHAP is
enabled)

Type a password that is known to the
other side of the connection. Use a
combination of letters and numbers that
is difficult for others to guess.

Specifies the secret password for CHAP
authentication, known to both sides of
the connection.

CHAP Secret (required if CHAP is
enabled)
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Table 79: PPPoE Quick Configuration Summary (continued)

Your ActionFunctionField

PPPoE Options

Type a name for the access
concentrator—for example, ispl.com.

Identifies the access concentrator by a
unique name.

Access Concentrator

Type a value from 1 through
4294947295 for automatic
reconnection—for example, 100
seconds. Type 0 (the default) for
immediate reconnection.

Specifies the number of seconds to wait
before reconnecting after a PPPoE
session is terminated.

Auto Reconnect Time

Type a value for the timeout. Type 0 if
you do not want the session to time out.

Specifies the number of seconds a
session can be idle without
disconnecting.

Idle Timeout

Type the type of service provided by the
access concentrator. For example,
video@ispl.com.

Identifies the type of service provided
by the access concentrator, such as the
name of the Internet service provider
(ISP), class, or quality of service.

Service Name

From the list, select the underlying
interface for the PPPoE session—for
example, ge-0/0/1.0 or at-2/0/0.0.

Specifies the logical Ethernet interface
or the logical ATM interface as the
underlying interface for the PPPoE
session.

Underlying Interface

Configuring PPPoE Encapsulation on an Ethernet Interface

For PPPoE on an Ethernet interface, you configure encapsulation on the logical
interface.

In this example, you configure the interface ge-0/0/1 for PPPoE encapsulation.

You can use either J-Web or the CLI configuration editor to configure PPPoE
encapsulation on an Ethernet interface.

This topic covers:

■ J-Web Configuration on page 296

■ CLI Configuration on page 297

■ Related Topics on page 297

J-Web Configuration

To configure PPPoE encapsulation on an Ethernet interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name box, click ge-0/0/1.

4. In the Interface unit number box, click 0.
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5. From the Encapsulation list, select ppp-over-ether.

6. Click OK.

CLI Configuration

To configure PPPoE encapsulation on an Ethernet interface:

user@host# set interfaces ge-0/0/1 unit 0 encapsulation ppp-over-ether

Related Topics

■ Configuring PPPoE Interfaces on page 298

■ Configuring CHAP on a PPPoE Interface (Optional) on page 300

Configuring PPPoE Encapsulation on an ATM-over-ADSL or ATM-over-SHDSL Interface

For PPPoE on an ATM-over-ADSL or ATM-over-SHDSL interface, you must configure
encapsulation on both the physical and logical interfaces. To configure encapsulation
on an ATM-over-ADSL or ATM-over-SHDSL physical interface, use Ethernet over ATM
encapsulation. To configure encapsulation on an ATM-over-ADSL or ATM-over-SHDSL
logical interface, use PPPoE over AAL5 logical link control (LLC) encapsulation. LLC
encapsulation allows a single ATM virtual connection to transport multiple protocols.

In this example, you configure the physical interface at-2/0/0 for Ethernet over ATM
encapsulation and then create a logical interface for PPPoE over LLC encapsulation.

You can use either J-Web or the CLI configuration editor to configure PPPoE on an
ATM-over-ADSL or ATM-over-SHDSL interface.

This topic covers:

■ J-Web Configuration on page 297

■ CLI Configuration on page 298

■ Related Topics on page 298

J-Web Configuration

To set the virtual path identifier (VPI) on an ATM-over-ADSL physical interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name box, click at-2/0/0.

4. Next to ATM options, click Configure.

5. Next to Vpi, click Add new entry.

6. In the Vpi number box, type 0.

7. Click OK twice.
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To configure the ADSL operating mode on the ATM-over-ADSL physical interface:

1. Next to Dsl options, click Configure.

2. From the Operating mode list, select auto.

3. Click OK twice.

To configure PPPoE encapsulation on the ATM-over-ADSL physical interface:

1. From the Encapsulation list, select ethernet-over-atm.

To create an ATM-over-ADSL logical interface and configure LLC encapsulation:

1. Next to Unit, click Add new entry.

2. In the Interface unit number box, type 0.

3. From the Encapsulation list, select ppp-over-ether-over-atm-llc.

4. In the Multicast vci box, type 0.120.

5. Click OK twice.

CLI Configuration

To set the virtual path identifier (VPI) on an ATM-over-ADSL physical interface:

user@host# set interfaces at-2/0/0 atm-options vpi 0

To configure the ADSL operating mode on the ATM-over-ADSL physical interface:

user@host# set interfaces at-2/0/0 dsl-options operating-mode auto

To configure PPPoE encapsulation on the ATM-over-ADSL physical interface:

user@host# set interfaces at-2/0/0 encapsulation ethernet-over-atm

To create an ATM-over-ADSL logical interface and configure LLC encapsulation:

user@host# set interfaces at-2/0/0 unit 0 encapsulation ppp-over-ether-over-atm-llc
vci 0.120

Related Topics

■ Configuring PPPoE Interfaces on page 298

■ Configuring CHAP on a PPPoE Interface (Optional) on page 300

Configuring PPPoE Interfaces

You create a PPPoE interface with a logical interface unit 0, then specify a logical
Ethernet or ATM interface as the underlying interface for the PPPoE session. You
then specify other PPPoE options, including the access concentrator and PPPoE
session parameters.
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In this example, you create the PPPoE interface pp0.0 and specify the logical Ethernet
interface ge-0/0/1.0 as the underlying interface. You also set the access concentrator
and PPPoE session parameters.

To clear a PPPoE session on the pp0.0 interface, use the clear pppoe sessions pp0.0
command. To clear all sessions on the interface, use the clear pppoe sessions
command.

You can use either J-Web or the CLI configuration editor to create and configure the
PPPoE interface.

This topic covers:

■ J-Web Configuration on page 299

■ CLI Configuration on page 300

■ Related Topics on page 300

J-Web Configuration

To create a PPPoE interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Next to Interface, click Add new entry.

4. In the Interface name box, type pp0.

5. Click OK.

6. Under Interface name, click pp0.

7. Next to Unit, click Add new entry.

8. In the Interface unit number box, type 0.

To configure PPPoE options:

1. In the Underlying interface box, type ge-0/0/1.0.

2. In the Access concentrator box, type ispl.com.

3. In the Auto reconnect box, type 100.

4. In the Idle timeout box, type 100.

5. Next to Chap, click Configure.

6. In the Client box, type Yes.

7. In the Service name box, type video@ispl.com.

To configure the maximum transmission unit (MTU) of the IPv4 family:

1. In the Inet box, select Yes and then click Configure.

2. In the Mtu box, type 1492.

3. Click OK until you return to the Unit page.
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To configure the PPPoE interface address:

1. Next to Inet, click Edit.

2. Next to Negotiate address, select Yes.

3. Click OK until you return to the Unit page.

CLI Configuration

To create a PPPoE interface and configure PPPoE options:

user@host# set interfaces pp0 unit 0 pppoe-options underlying-interface ge-0/0/1.0
access-concentrator ispl.com auto-reconnect 100 idle-timeout 100 client
service-name video@ispl.com

To configure the maximum transmission unit (MTU) of the IPv4 family:

user@host# set interfaces pp0 unit 0 family inet mtu 1492

To configure the PPPoE interface address:

user@host# set interfaces pp0 unit 0 family inet negotiate-address

Related Topics

■ Configuring CHAP on a PPPoE Interface (Optional) on page 300

Configuring CHAP on a PPPoE Interface (Optional)

You can configure interfaces with PPPoE encapsulation to support the PPP Challenge
Handshake Authentication Protocol (CHAP). When you enable CHAP on an interface,
the interface can authenticate its peer and be authenticated by its peer.

In this example, you configure a CHAP access profile, and then apply it to the PPPoE
interface pp0. You also configure the hostname to be used in CHAP challenge and
response packets, and set the passive option for handling incoming CHAP packets.

You can use either J-Web or the CLI configuration editor to configure CHAP on a
PPPoE interface.

This topic covers:

■ J-Web Configuration on page 300

■ CLI Configuration on page 301

■ Configuring the PPPoE-Based Radio-Router Protocol on page 302

J-Web Configuration

To configure a CHAP access profile:
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1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Access, click Configure or Edit.

3. Next to Profile, click Add new entry.

4. In the Profile name box, type A-ppp-client.

5. Next to Client, click Add new entry.

6. In the Name box, type client1.

7. In the Chap secret box, type my-secret.

8. Click OK until you return to the main Configuration page.

To configure a PPPoE interface with the CHAP access profile:

1. On the main Configuration page next to Interfaces, click Configure or Edit.

2. In the Interface name box, click pp0.

3. In the Interface unit number box, click 0.

4. Next to Ppp options, click Configure.

5. Next to Chap, click Configure.

6. In the Access profile box, type A-ppp-client.

To configure a hostname for the CHAP challenge and response packets:

1. In the Local name box, type A-ge-0/0/1.0.

To set the passive option to handle incoming CHAP packets only:

1. In the Passive box, click Yes.

2. Click OK.

CLI Configuration

To configure a CHAP access profile:

user@host# set access profile A-ppp-client client client1 chap-secret my-secret

To configure a PPPoE interface with the CHAP access profile:

user@host# set interfaces pp0 unit 0 ppp-options chap access-profile A-ppp-client

To configure a hostname for the CHAP challenge and response packets:

user@host# set interfaces pp0 unit 0 ppp-options chap local-name A-ge-0/0/1.0

To set the passive option to handle incoming CHAP packets only:

user@host# set interfaces pp0 unit 0 ppp-options chap passive
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Configuring the PPPoE-Based Radio-Router Protocol

Point-to-Point Protocol over Ethernet (PPPoE)-based radio-to-router protocols include
messages that define how an external system will provide the device with timely
information about the quality of a link's connection. They also include a flow control
mechanism to indicate how much data the device can forward. The device can then
use the information provided in the PPPoE messages to dynamically adjust the
interface speed of PPP links.

For example, a High-band Networking Waveform (HNW) radio provides
ground-to-ground or ground-to-air communications with like devices. When the HNW
picks up a signal from another device, it initiates a PPPoE session with a directly
connected device (router). The PPPoE session encapsulates the packets that are
relayed over a PPP link between the local and remote devices. The remote radio then
forwards traffic to a remote device using an independent PPPoE session. The two
devices exchange Link Control Protocol (LCP) and Internet Protocol Control Protocol
(IPCP) messages to configure the link and exchange OSPF messages to establish the
network topology.

Each HNW radio monitors the link every 50 milliseconds for changes in the link
bandwidth, quality, and utilization. If any changes are detected, the radios announce
the new set of metrics to the respective devices through a PPPoE Active Discovery
Quality (PADQ) message, which is a nonstandard extension to the PPPoE Discovery
Protocol [RFC2516]. The device transforms these metrics into a bandwidth value for
the PPP link and compares it to the value currently in use. When the device detects
that the difference exceeds a user-specified threshold, it adjusts the speed of the PPP
link. OSPF is notified of the change and announces any resulting routing topology
changes to its neighbors.

Overview of CLI Statements

The CLI statement, radio-router, indicates that metrics announcements received on
the interface will be processed by the device. When a PPPoE logical interface refers
to this as an underlying interface, the device then processes incoming PADQ messages
and uses information from the host's messages to control the flow of traffic and
manage the speed of the link, resulting in a corresponding adjustment of the OSPF
cost. If this option is not specified, then PADQ messages received over the underlying
interface are ignored.

The radio-router statement includes bandwidth, resource, latency, and quality
statements. These subsequent statements provide control over the weights used
when transforming PADQ link metrics into an interface speed for the virtual link.
The default value for all four weights is 100.

The radio-router statement includes a threshold statement. The threshold value
specifies how much of a difference is required between the calculated and the current
interface speeds. The threshold value, expressed as a percentage, defaults to 10.

To support credit-based flow control extensions described in RFC4938, PPPoE peers
can now grant each other forwarding credits using the radio-router credit statement.
The grantee is then allowed to forward traffic to the peer only when it has a sufficient
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number of credits to do so. The subsequent credit interval statement controls how
frequently the device generates credit announcement messages.

Here is a brief description of the available settings for radio-router:

■ bandwidth-Weight of current (vs. maximum) data rate (value 0–100)

■ credit-Credit-based scheduling parameters

■ interval-Grant rate interval (value 1–60 seconds)

■ latency-Latency weight (value 0–100)

■ quality-Relative Link Quality weight (value 0–100)

■ resource-Resource weight (value 0–100)

■ threshold-Percentage bandwidth change required for routing updates

CLI Configuration

user@host# edit interfaces ge-3/0/3 unit 1 radio-router bandwidth 100 resource 100
latency 100 quality 100 resource 100 threshold 10

user@host# edit interfaces pp0 unit 1 pppoe-options underlying-interface ge-3/0/3
user@host# edit interfaces pp0 unit 1 pppoe-options server test
user@host# edit interfaces pp0 unit 1 family inet unnumbered-address lo0.0 destination

192.168.1.2
user@host# edit interfaces pp0 unit 1 family inet6 unnumbered-address lo0.0

destination fec0:1:1:1::2

CLI Hierarchy

user@host# set interfaces ge-0/0/1.0 radio-router {
bandwidth;

credit {
interval;
}
latency;
quality;
resource;

threshold;
}

Verifying a PPPoE Configuration

To verify PPPoE configuration, perform the following tasks:

■ Displaying a PPPoE Configuration for an Ethernet Interface on page 304

■ Displaying a PPPoE Configuration for an ATM-over-ADSL or ATM-over-SHDSL
Interface on page 304

■ Verifying PPPoE Interfaces on page 305

■ Verifying PPPoE Sessions on page 307
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■ Verifying the PPPoE Version on page 307

■ Verifying PPPoE Statistics on page 308

Displaying a PPPoE Configuration for an Ethernet Interface

Purpose Verify the PPPoE configuration for an Ethernet interface.

Action From the J-Web interface, select Configure>CLI Tools>CLI Viewer. Alternatively,
from configuration mode in the CLI, enter the show interfaces command from the
top level.

[edit]
user@host# show interfaces
ge-3/0/0 {

unit 1 {
}

}
pp0 {

unit 1 {
pppoe-options {

underlying-interface ge-3/0/0.0;
idle-timeout 123;
access-concentrator myac;
service-name myserv;
auto-reconnect 10;
client;

}
family inet {

address 22.2.2.1/32 {
destination 22.2.2.2;

}
}
family inet6 {

address 3004::1/128 {
destination 3004::2;

}
}

}
}

Meaning Verify that the output shows the intended configuration of PPPoE.

Related Topics For more information about the format of a configuration file, see the J-Web Interface
User Guide or the Junos CLI User Guide.

Displaying a PPPoE Configuration for an ATM-over-ADSL or ATM-over-SHDSL Interface

Purpose Verify the PPPoE configuration for an ATM-over-ADSL or ATM-over-SHDSL interface.
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Action From the J-Web interface, select Configure>CLI Tools>CLI Viewer. Alternatively,
from configuration mode in the CLI, enter the show interfaces command from the
top level.

[edit]
user@host#show interfaces
at-6/0/0 {

encapsulation ethernet-over-atm;
atm-options {

vpi 0;
}
dsl-options {

operating-mode itu-dmt;
}
unit 0 {

encapsulation ppp-over-ether-over-atm-llc;
vci 35;

}
}
pp0 {

unit 0 {
pppoe-options {

underlying-interface at-6/0/0.0;
idle-timeout 123;
access-concentrator myac;
service-name myserv;
auto-reconnect 10;
client;

}
family inet {

address 11.1.1.1/32 {
destination 11.1.1.2;

}
}
family inet6 {

address 2004::1/128 {
destination 2004::2;

}
}
family mpls;

}
}

Meaning Verify that the output shows the intended configuration of PPPoE.

Related Topics For more information about the format of a configuration file, see the J-Web Interface
User Guide or the Junos CLI User Guide.

Verifying PPPoE Interfaces

Purpose Verify that the PPPoE device interfaces are configured properly.
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Action From the CLI, enter the show interfaces pp0 command.

Sample Output user@host> show interfaces pp0
Physical interface: pp0, Enabled, Physical link is Up
  Interface index: 67, SNMP ifIndex: 317
  Type: PPPoE, Link-level type: PPPoE, MTU: 9192
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : None
  Last flapped   : Never
  Input rate     : 0 bps (0 pps)
  Output rate    : 0 bps (0 pps)

  Logical interface pp0.0 (Index 1) (SNMP ifIndex 330)
    Flags: Point-To-Point SNMP-Traps 16384 Encapsulation: PPPoE
    PPPoE:
      State: SessionUp, Session ID: 3304,
      Session AC name: isp1.com, AC MAC address: 00:90:1a:40:f6:4c,
      Service name: video@isp1.com, Configured AC name: isp1.com,
      Auto-reconnect timeout: 60 seconds
      Underlying interface: ge-5/0/0.0 (Index 71)
  Input packets : 23
  Output packets: 22
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive: Input: 16 (00:00:26 ago), Output: 0 (never)
  LCP state: Opened
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, mpls:
  Not-configured
  CHAP state: Success
    Protocol inet, MTU: 1492
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 211.211.211.2, Local: 211.211.211.1

Meaning The output shows information about the physical and the logical interface. Verify the
following information:

■ The physical interface is enabled and the link is up.

■ The PPPoE session is running on the correct logical interface.

■ Under State, the state is active (up).

■ Under Underlying interface, the physical interface on which the PPPoE session is
running is correct:

■ For an Ethernet connection, the underlying interface is Fast Ethernet or
Gigabit Ethernet—for example, ge-5/0/0.0.

■ For an ATM-over-ADSL or ATM-over-SHDSL connection, the underlying
interface is ATM—for example, at-2/0/0.0.

Related Topics For a complete description of show interfaces pp0 output, see the Junos Interfaces
Command Reference.
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Verifying PPPoE Sessions

Purpose Verify that a PPPoE session is running properly on the logical interface.

Action From the CLI, enter the show pppoe interfaces command.

Sample Output user@host> show pppoe interfaces
pp0.0 Index 67
  State: Session up, Session ID: 31,
  Service name: video@isp1.com, Configured AC name: isp1.com,
  Session AC name: belur, AC MAC address: 00:90:1a:40:f6:4e,
  Auto-reconnect timeout: 1 seconds,
  Underlying interface: ge-0/0/1.0 Index 69

Meaning The output shows information about the PPPoE sessions. Verify the following
information:

■ The PPPoE session is running on the correct logical interface.

■ Under State, the session is active (up).

■ Under Underlying interface, the physical interface on which the PPPoE session is
running is correct:

■ For an Ethernet connection, the underlying interface is Fast Ethernet or
Gigabit Ethernet—for example, ge-0/0/1.0.

■ For an ATM-over-ADSL or ATM-over-SHDSL connection, the underlying
interface is ATM—for example, at-2/0/0.0.

Related Topics For a complete description of show pppoe interfaces output, see the Junos Interfaces
Command Reference.

Verifying the PPPoE Version

Purpose Verify the version information of the PPPoE protocol configured on the device
interfaces.

Action From the CLI, enter the show pppoe version command.

Sample Output user@host> show pppoe version
Point-to-Point Protocol Over Ethernet, version 1. rfc2516
   PPPoE protocol               = Enabled
   Maximum Sessions             = 256
   PADI resend timeout          = 2 seconds
   PADR resend timeout          = 16 seconds
   Max resend timeout           = 64 seconds
   Max Configured AC timeout    = 4 seconds

Meaning The output shows PPPoE protocol information. Verify the following information:
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■ The correct version of the PPPoE protocol is configured on the interface.

■ Under PPPoE protocol, the PPPoE protocol is enabled.

Related Topics For a complete description of show pppoe version output, see the Junos Interfaces
Command Reference.

Verifying PPPoE Statistics

Purpose Display statistics information about PPPoE interfaces.

Action From the CLI, enter the show pppoe statistics command.

Sample Output user@host> show pppoe statistics
Active PPPoE sessions: 4
  PacketType                       Sent         Received
    PADI                            502                0
    PADO                              0              219
    PADR                            219                0
    PADS                              0              219
    PADT                              0              161
    Service name error                0                0
    AC system error                   0               13
    Generic error                     0                0
    Malformed packets                 0               41
    Unknown packets                   0                0
  Timeout
    PADI                             42
    PADO                              0
    PADR                              0

Meaning The output shows information about active sessions on PPPoE interfaces. Verify the
following information:

■ Total number of active PPPoE sessions running on the interface.

■ Under Packet Type, the number of packets of each type sent and received during
the PPPoE session.

Related Topics For a complete description of show pppoe statistics output, see the Junos Interfaces
Command Reference.
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Chapter 11

Configuring ISDN

ISDN connectivity is supported on J Series devices as a backup for a primary Internet
connection. J Series devices can be configured to “fail over” to an ISDN interface
when the primary connection experiences interruptions in Internet connectivity.

Use ISDN also at the central office to terminate calls that originate at branch office
routers and for central office callback for security, accounting, or cost savings at the
branch office.

You can use either J-Web Quick Configuration or a configuration editor to configure
ISDN BRI interfaces. To configure ISDN PRI, you use either the J-Web configuration
editor or CLI configuration editor.

NOTE: This chapter provides instructions for configuring basic ISDN BRI service and
features such as dial backup, dial-in, or callback for both ISDN BRI and ISDN PRI. To
configure basic ISDN PRI service, see “Configuring Channelized T1/E1/ISDN PRI
Interfaces” on page 117.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ ISDN Terms on page 309

■ ISDN Overview on page 312

■ Before You Begin on page 313

■ Configuring ISDN BRI Interfaces with Quick Configuration on page 314

■ Configuring ISDN Interfaces and Features with a Configuration Editor on page 321

■ Verifying the ISDN Configuration on page 343

ISDN Terms

Before configuring ISDN, become familiar with the terms defined in Table 80 on
page 310.
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Table 80: ISDN Terminology

DefinitionTerm

ISDN cost-control feature defining the bandwidth threshold that must
be reached on all links before a J Series device initiates additional ISDN
data connections to provide more bandwidth.

bandwidth on demand

ISDN service intended for home and small enterprise applications. ISDN
BRI consists of two 64-Kbps B-channels to carry voice or data and one
16-Kbps D-channel for control and signaling.

Basic Rate Interface (BRI)

64-Kbps channel used for voice or data transfer on an ISDN interface.bearer channel (B-channel)

Alternative feature to dial-in that enables a J Series device to call back
the caller from the remote end of a backup ISDN connection. Instead
of accepting a call from the remote end of the connection, the device
rejects the call, waits a configured period of time, and calls a number
configured on the device's dialer interface. See also dial-in.

callback

Telephone number of the caller on the remote end of a backup ISDN
connection, used to dial in and also to identify the caller. Multiple caller
IDs can be configured on an ISDN dialer interface. During dial-in, the
device matches the incoming call's caller ID against the caller IDs
configured on its dialer interfaces. Each dialer interface accepts calls
from only callers whose caller IDs are configured on it.

caller ID

Circuit-switched channel that carries signaling and control for
B-channels. In ISDN Basic Rate Interface (BRI) applications, a D-channel
can also support customer packet data traffic at speeds up to 9.6 Kbps.

delta-channel (D-channel)

Network segment whose cost varies with usage, according to a service
level agreement with a service provider. Demand circuits limit traffic
based on either bandwidth (bites or packets transmitted) or access time.
For example, ISDN interfaces can be configured for dial-on-demand
routing backup. In OSPF, the demand circuit reduces the amount of
OSPF traffic by removing all OSPF protocols when the routing domain
is in a steady state.

demand circuit

Feature that reestablishes network connectivity through one or more
backup ISDN dialer interfaces after a primary interface fails. When the
primary interface is reestablished, the ISDN interface is disconnected.

dial backup

Stateless firewall filter that enables dial-on-demand routing backup
when applied to a physical ISDN interface and its dialer interface
configured as a passive static route. The passive static route has a lower
priority than dynamic routes. If all dynamic routes to an address are
lost from the routing table and the device receives a packet for that
address, the dialer interface initiates an ISDN backup connection and
sends the packet over it. See also dial-on-demand routing backup; floating
static route.

dialer filter

Logical interface for configuring dialing properties and the control
interface for a backup ISDN connection.

dialer interface (dl)
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Table 80: ISDN Terminology (continued)

DefinitionTerm

Feature that enables J Series devices to receive calls from the remote
end of a backup ISDN connection. The remote end of the ISDN call
might be a service provider, a corporate central location, or a customer
premises equipment (CPE) branch office. All incoming calls can be
verified against caller IDs configured on the device's dialer interface.
See also callback.

dial-in

Feature that provides a J Series device with full-time connectivity across
an ISDN line.

When routes on a primary serial T1, E1, T3, E3, Fast Ethernet, Gigabit
Ethernet, or PPPoE interface are lost, an ISDN dialer interface establishes
a backup connection. To save connection time costs, the device drops
the ISDN connection after a configured period of inactivity. Devices
with ISDN interfaces support two types of dial-on-demand routing
backup: on-demand routing with a dialer filter and dialer watch. See
also dialer filter; dialer watch.

dial-on-demand routing (DDR) backup

Set of characteristics configured for the ISDN dialer interface. Dialer
profiles allow the configuration of physical interfaces to be separated
from the logical configuration of dialer interfaces required for ISDN
connectivity. This feature also allows physical and logical interfaces to
be bound together dynamically on a per-connection basis.

dialer profile

Dial-on-demand routing (DDR) backup feature that provides reliable
connectivity without relying on a dialer filter to activate the ISDN
interface. The ISDN dialer interface monitors the existence of each
route on a watch list. If all routes on the watch list are lost from the
routing table, dialer watch initiates the ISDN interface for failover
connectivity. See also dial-on-demand routing backup.

dialer watch

Route with an administrative distance greater than the administrative
distance of the dynamically learned versions of the same route. The
static route is used only when the dynamic routes are no longer
available. When a floating static route is configured on an interface with
a dialer filter, the interface can be used for backup.

floating static route

Digital communication service provided by telecommunication service
providers. It is an all-digital dialup (on-demand) service that carries
voice, data, and video transmissions over telephone lines.

Integrated Services Digital Network (ISDN)

ISDN service intended for higher-bandwidth applications than ISDN
BRI. ISDN PRI consists of a single D-channel for control and signaling,
plus a number of 64-Kbps B-channels—either 23 B-channels on a T1
line or 30 B-channels on an E1 line—to carry network traffic.

Primary Rate Interface (PRI)

Number that specifies the services available to you on the service
provider switch and defines the feature set ordered when the ISDN
service is provisioned.

service profile identifier (SPID)

Number that identifies a terminal endpoint, an ISDN-capable device
attached to an ISDN network through an ISDN interface on the device.
The TEI is a number between 0 and 127. The numbers 0–63 are used
for static TEI assignment, 64–126 are used for dynamic assignment,
and 127 is used for group assignment.

terminal endpoint identifier (TEI)
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ISDN Overview

Integrated Services Digital Network (ISDN) is a set of standards for digital transmission
over different media created by the Consultative Committee for International
Telegraph and Telephone (CCITT) and International Telecommunication Union (ITU).
As a dial-on-demand service, it has fast call setup and low latency as well as the
ability to carry high-quality voice, data, and video transmissions. ISDN is also a
circuit-switched service that can be used on both multipoint and point-to-point
connections.

You configure two types of interfaces for ISDN service: at least one physical interface
and a logical interface called the dialer interface.

ISDN Interfaces

The following interfaces on a device are available for ISDN connectivity:

■ For ISDN BRI, up to six of the following field-replaceable units (FRUs):

■ 4-port S/T PIM supporting ITU-T I.430, ETSI TS 101080, and GR-1089-Core
Type III

■ 4-port U PIM supporting ANSI T.601 and GR-1089-Core

■ For ISDN PRI, up to six Dual-Port Channelized T1/E1/ISDN PRI PIMs, supporting
ITU-T Q.920, Q.921: LAPD, Q.930, and Q.931

ISDN BRI Interface Types

A J Series device with one or more ISDN BRI ports has the following types of ISDN
interfaces:

■ Physical ISDN BRI interface—br-pim/0/port

■ Physical B-channel interface—bc-pim/0/port

■ Physical D-channel interface—dc-pim/0/port

■ Logical dialer interface—dln

For information about interface names, see “Network Interface Naming” on page 9.

To configure ISDN BRI service on a J Series device, you configure the physical ISDN
BRI interface and the logical dialer interface.

Each ISDN BRI port has two B-channels for transport, identified as bc-pim/0/port:1
and bc-pim/0/port:2, and one D-channel for control, identified as dc-pim/0/port. On
ISDN BRI interfaces, the B-channels and D-channel have no configurable settings,
but you can monitor them for interface status and statistics.
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ISDN PRI Interface Types

On a J Series device with one or more Dual-Port Channelized T1/E1/ISDN PRI PIMs,
you can configure each port on the PIM for either T1, E1, or ISDN PRI service, or for
a combination of ISDN PRI and either T1 or E1 service. For ISDN PRI service, you
configure the following types of ISDN interfaces as channels on the channelized T1
or E1 interface:

■ Physical B-channel interface—bc-pim/0/port:channel

■ On a channelized T1 interface, up to 23 time slots can be configured as ISDN
PRI B-channels.

■ On a channelized E1 interface, up to 30 time slots can be configured as ISDN
PRI B-channels.

■ Physical D-channel interface—dc-pim/0/port:channel

■ On a channelized T1 interface, you configure time slot 24 as the D-channel.

■ On a channelized E1 interface, you configure time slot 16 as the D-channel.

■ Logical dialer interface—dln

For information about interface names, see “Network Interface Naming” on page 9.

For more information about channelized T1/E1/ISDN PRI interfaces, see “Configuring
Channelized T1/E1/ISDN PRI Interfaces” on page 117.

Dialer Interface

The dialer (dln) interface is a logical interface on which you configure dialing properties
for ISDN connections. The interface can be configured in two modes:

■ Multilink mode using Multilink PPP encapsulation

■ Normal mode using PPP or Cisco High-Level Data Link Control (HDLC)
encapsulation

The dialer interface can perform backup, dialer filter, and dialer watch functions, but
these operations are mutually exclusive. You can configure a single dialer interface
to operate in only one of the following ways:

■ As a backup interface—for one primary interface

■ As a dialer filter

■ As a dialer watch interface

Before You Begin

Before you configure ISDN interfaces, you need to perform the following tasks:
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■ Install J Series device hardware. For more information, see the J Series Services
Routers Hardware Guide.

■ Establish basic connectivity. For more information, see the Getting Started Guide
for your device.

■ Order an ISDN line from your telecommunications service provider. Contact
your service provider for more information.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

Although it is not a requirement, you might also want to plan how you are going to
use the ISDN interfaces on your network before you begin configuring them. (To
display a list of installed ISDN BRI interfaces, select Configuration>Quick
Configuration>Interfaces.)

Configuring ISDN BRI Interfaces with Quick Configuration

You can use the ISDN Interfaces Quick Configuration pages to configure ISDN BRI
interfaces on a J Series device. The Quick Configuration pages allow you to configure
ISDN BRI connectivity on a device to back up a primary Internet connection.

NOTE: To configure an ISDN PRI interface, you must use the J-Web or CLI
configuration editor.

You configure the physical ISDN BRI interface first and then the backup method on
the logical dialer interface.

This section contains the following topics:

■ Configuring ISDN BRI Physical Interfaces with Quick Configuration on page 314

■ Configuring ISDN BRI Dialer Interfaces with Quick Configuration on page 317

Configuring ISDN BRI Physical Interfaces with Quick Configuration

To configure ISDN BRI physical interfaces with Quick Configuration:

1. In the J-Web interface, select Configure>Interfaces.

A list of network interfaces installed on the device is displayed.

2. Click the br-pim/0/port interface name for the ISDN BRI port you want to
configure.

The ISDN BRI Physical Interface Quick Configuration page is displayed as shown
in Figure 42 on page 315.
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Figure 42: ISDN BRI Physical Interface Quick Configuration Page

3. Enter information into the ISDN Quick Configuration pages, as described in Table
81 on page 315.

4. From the ISDN Physical Interfaces Quick Configuration page:

■ To apply the configuration and stay on the ISDN Physical Interfaces Quick
Configuration page, click Apply.

■ To apply the configuration and return to the Interfaces Quick Configuration
page, click OK.

■ To cancel your entries and return to the Interfaces Quick Configuration page,
click Cancel.

5. Go on to “Configuring ISDN BRI Dialer Interfaces with Quick Configuration” on
page 317.

Table 81: ISDN BRI Quick Configuration Page Summary

Your ActionFunctionField

Configuring ISDN Interfaces

Type a text description of the physical ISDN
BRI interface in the box to clearly identify it in
monitoring displays.

(Optional) Adds supplemental information
about the ISDN physical interface on the device.

Physical Interface
Description
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Table 81: ISDN BRI Quick Configuration Page Summary (continued)

Your ActionFunctionField

Select internal or external from the list.Enables internal or external clocking sources
for the interface on the device.

■ internal—device's own system clock (the
default)

■ external—Clock received from the T1
interface

Clocking

Dialer Pool Options

■ To add a dialer pool to the interface, click
Add.

■ To edit a dialer pool, select the name from
the list. You can change the priority, but
not the name.

■ To delete a dialer pool, select the check
box and click Delete.

Displays the list of configured ISDN dialer pools
on the device.

Dialer Pools

Type the dialer pool name—for example,
isdn-dialer-pool.

Specifies the group of physical interfaces to be
used by the dialer interface.

Dialer Pool Name
(required)

1. Type a priority value from 0 (lowest) to
255 (highest). The default is 0.

2. Click OK to return to the Quick
Configuration page.

Specifies the priority of this interface within
the dialer pool. Interfaces with a higher priority
are the first to interact with the dialer interface.

Priority

ISDN Options

Type the outgoing calling number for the
service provider.

Configures the dialing number used to connect
with the service provider.

Calling Number

Select one of the following switch types:

■ att5e—AT&T 5ESS

■ etsi—NET3 for the UK and Europe

■ ni1—National ISDN-1

■ ntdms-100—Northern Telecom DMS-100

■ ntt—NTT Group switch for Japan

Specifies the type of ISDN switch used by the
service provider.

ISDN Switch Type

Type the SPID in the box. If you have a
NTDMS-100 or NI1 switch, an additional SPID
field is provided.

Configures the service profile identifier (SPID)
provided by your ISDN service.

Service Profile Identifier

Service Profile Identifier 2
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Table 81: ISDN BRI Quick Configuration Page Summary (continued)

Your ActionFunctionField

Type a value between 0 and 63. If this value is
not supplied, the device dynamically acquires
a TEI.

If you configured more than one SPID, the TEI
must be acquired dynamically.

Configures the static terminal endpoint
identifier (TEI) value from your service
provider.

The TEI number identifies a terminal endpoint,
an ISDN-capable device attached to an ISDN
network through an ISDN interface on the
device. The TEI is a number between 0 and
127. The numbers 0–63 are used for static TEI
assignment, 64–126 are used for dynamic
assignment, and 127 is used for group
assignment.

Static TEI Value

■ Select first-call to activate the connection
when the call setup is sent to the ISDN
provider.

■ Select power-up (the default) to activate
the connection when the device is
powered on.

Configures when the TEI negotiates with the
ISDN provider.

TEI Option

Type a value between 1 and 65536. The default
value is 10 seconds.

Sets the Q.931 timer value in seconds.Timer T310 Value

Configuring ISDN BRI Dialer Interfaces with Quick Configuration

When ISDN BRI interfaces are installed on the device, links to ISDN Quick
Configuration pages for dialer options are displayed on the Interfaces Quick
Configuration page as shown in Figure 43 on page 318.

You can use these Quick Configuration pages to configure an ISDN BRI dialer interface
for either dial backup or dialer watch. For dial backup you specify the serial interface
to back up. For dialer watch you specify a watch list of one or more routes to monitor.
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Figure 43: ISDN BRI Dialer Options Quick Configuration Page

To configure ISDN BRI dialer interfaces with Quick Configuration:

1. In the J-Web interface, select Configure>Interfaces.

A list of network interfaces installed on the device is displayed.

2. Click ISDN Dialer Options under the interfaces list.

3. Select a backup method to configure on the dialer interface:

■ Click Dial Backup to allow one or more dialer interfaces to back up the
primary interface. The backup interfaces are activated only when the primary
interface fails.

■ Click Dialer Watch to monitor a specified route and initiate dialing of the
backup link if that route is not present.

4. Do one of the following:

■ To edit an existing dialer interface, click the dialer interface name. For
example, click dl0 to edit the dialer physical interface, and then click dl0.0
to edit the dialer logical interface.

■ To add a dialer interface, click Add. In the Interface Name box, type a name
for the logical interface—for example, dl1—then click Add under Logical
Interfaces.

Figure 44 on page 319 shows the ISDN Quick Configuration page for dialer logical
interfaces.
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Figure 44: ISDN BRI Dialer Interface Quick Configuration Page

5. Enter information into the ISDN Quick Configuration page for dialer logical
interfaces, as described in Table 82 on page 319.

6. Click one of the following buttons on the ISDN Quick Configuration page:

■ To apply the configuration and stay on the current Quick Configuration page,
click Apply.

■ To apply the configuration and return to the previous Quick Configuration
page, click OK.

■ To cancel your entries and return to the previous Quick Configuration page,
click Cancel.

7. To verify that the ISDN interface is configured correctly, see “Verifying the ISDN
Configuration” on page 343.

Table 82: ISDN BRI Dialer Interface Quick Configuration Page Summary

Your ActionFunctionField

Configuring Dialer Interfaces

Type a text description of the interface in the
box.

Describes the logical interface.Logical Interface
Description
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Table 82: ISDN BRI Dialer Interface Quick Configuration Page Summary (continued)

Your ActionFunctionField

Type an IP address and a prefix in the boxes.
Click Add.

To delete an IP address, highlight it in the list,
and click Delete.

Displays the IPv4 addresses for the interfaces
to which the dialer interface is assigned.

NOTE: Ensure that the same IP subnet address
is not configured on different dialer interfaces.
Configuring the same IP subnet address on
different dialer interfaces can result in
inconsistency in the route and packet loss.
Packets can be routed through any of the dialer
interfaces with the IP subnet address, instead
of being routed through the dialer interface to
which the ISDN call is mapped.

IPv4 Addresses and
Prefixes

Dialer Options

Type a value, in seconds—for example, 30.

The default value is 0 seconds with a maximum
value of 60 seconds.

Displays the time to wait before activating the
backup interface once the primary interface is
down.

Activation Delay

Type a value, in seconds—for example, 30.

The default value is 0 seconds with a maximum
value of 60 seconds.

Displays the time to wait before deactivating
the backup interface once the primary interface
is up.

Deactivation Delay

Type the dialing number and click Add.

To delete a dial string, highlight it and click
Delete.

Displays the dialing number from your ISDN
service provider.

Dial String (required)

Select a dialer pool from the list.Displays a list of dialer pools configured on
br-pim/0/port interfaces.

Pool (required)

Multilink Dialer Options

Type a value, in seconds—for example, 30.

The default value is 60 seconds with a range
of 20–80. The value must be a multiple of 10.

Defines the interval used to calculate the
average load on the dialer interface for
bandwidth on demand.

Load Interval

Type a percentage—for example, 80.

The default value is 100 with a range of 0–100.

Defines the threshold at which an additional
ISDN interface is activated for
bandwidth-on-demand. You specify the
threshold as a percentage of the cumulative
load of all UP links.

Load Threshold

Backup Interface (for dial backup only)

Select an interface from the list for ISDN
backup.

Displays a list of interfaces for ISDN backup.Interface to Backup

Dialer Watch List (for dialer watch only)
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Table 82: ISDN BRI Dialer Interface Quick Configuration Page Summary (continued)

Your ActionFunctionField

Type an IP address and a prefix in the boxes.
Click Add.

To delete an IP address, highlight it in the list,
and click Delete.

Displays the IPv4 addresses in the list of routes
to be monitored by the dialer interface.

IPv4 Addresses and
Prefixes

Configuring ISDN Interfaces and Features with a Configuration Editor

To configure ISDN interfaces on a J Series device, you first configure the basic ISDN
interface—either “Adding an ISDN BRI Interface (Required)” on page 321 or
“Configuring Channelized T1/E1/ISDN PRI Interfaces for ISDN PRI Operation” on
page 125. Second, configure the dialer interface by performing “Configuring Dialer
Interfaces (Required)” on page 324.

To configure ISDN interfaces to back up primary device interfaces, you then configure
a backup method—either “Configuring Dial Backup” on page 327, “Configuring Dialer
Filters for Dial-on-Demand Routing Backup” on page 328, or “Configuring Dialer
Watch” on page 330.

To configure ISDN interfaces for dial-in or callback, configure the basic ISDN BRI or
PRI interface and then perform “Configuring Dial-In and Callback (Optional)” on
page 337.

Perform other tasks as needed on your network.

This section contains the following topics:

■ Adding an ISDN BRI Interface (Required) on page 321

■ Configuring Dialer Interfaces (Required) on page 324

■ Configuring Dial Backup on page 327

■ Configuring Dialer Filters for Dial-on-Demand Routing Backup on page 328

■ Configuring Dialer Watch on page 330

■ Configuring Dial-on-Demand Routing Backup with OSPF Support
(Optional) on page 331

■ Configuring Bandwidth on Demand (Optional) on page 332

■ Configuring Dial-In and Callback (Optional) on page 337

■ Disabling Dialing Out Through Dialer Interfaces on page 342

■ Disabling ISDN Signaling on page 343

Adding an ISDN BRI Interface (Required)

To enable ISDN BRI interfaces installed on your J Series device to work properly, you
must configure the interface properties.
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To configure an ISDN BRI network interface for the J Series device:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 83 on page 322.

3. Go on to “Configuring Dialer Interfaces (Required)” on page 324.

Table 83: Adding an ISDN BRI Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces br-1/0/3

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

Navigate to the Interfaces  level in the
configuration hierarchy.

1. Next to Interface, click Add new
entry.

2. In the Interface name box, type the
name of the new interface,
br-1/0/3.

3. Click OK.

Create the new interface—for example,
br-1/0/3.

From the [edit interfaces br-1/0/3]
hierarchy, enter

set dialer-options pool isdn-dialer-group
priority 255

1. In the Encapsulation column, next
to the new interface, click Edit.

2. Next to Dialer options, select Yes,
and then click Configure.

3. Next to Pool, click Add new entry.

4. In the Pool identifier box, type
isdn-dialer-group.

5. In the Priority box, type 255.

6. Click OK twice.

Configure dialer options.

■ Name the dialer pool—for example,
isdn-dialer-group.

■ Set the dialer pool priority—for
example, 255.

Dialer pool priority has a range from 1
to 255, with 1 designating
lowest-priority interfaces and 255
designating the highest-priority
interfaces.
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Table 83: Adding an ISDN BRI Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. To set the ISDN options, enter

set isdn-options calling-number
18005555555

2. Enter

set isdn-options spid1
00108005555555

3. Enter

set isdn-options static-tei-val 23

4. set isdn-options
incoming-called-number
18883333456

1. Next to Isdn options, click
Configure.

2. In the Calling number box, type
18005555555.

3. In the Spid1 box, type
00108005555555.

4. In the Static tei val box, type 23.

5. Next to Incoming called number,
click Add new entry.

6. In the Called number box, type
18883333456.

7. Click OK.

Configure ISDN BRI properties.

■ Calling number sent to the ISDN
switch during the call setup, which
represents the caller's number—for
example, 18005555555.

■ Service provider ID (SPID)—for
example, 00108005555555.

■ Static TEI between 0 and 63 from
your service provider—for
example, 23. If the field is left
blank, the device dynamically
acquires a TEI. Also, if you have
configured a second SPID, you
cannot set a static TEI value.

If you have a NTDMS-100 or NI1
switch, an additional box for a
service provider ID is provided.

If you are using a service provider
that requires SPIDs, you cannot
place calls until the interface sends
a valid, assigned SPID to the service
provider when accessing the ISDN
connection.

■ Incoming called number—for
example, 18883333456.

Configure incoming call properties
if you have remote locations dialing
into the device through the ISDN
interface.

To select the switch type, enter

set isdn-options switch-type att5e

From the Switch type list, select att5e.Select the type of ISDN switch—for
example, ATT5E. The following switches
are compatible with J Series devices:

■ ATT5E—AT&T 5ESS

■ ETSI—NET3 for the UK and Europe

■ NI1—National ISDN-1

■ NTDMS–100—Northern Telecom
DMS-100

■ NTT—NTT Group switch for Japan

set isdn-options t310 15In the T310 box, type 15.Configure the Q.931 timer. Q.931 is a
Layer 3 protocol for the setup and
termination of connections. The default
value for the timer is 10 seconds, but
can be configured between 1 and 65536
seconds—for example, 15.
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Table 83: Adding an ISDN BRI Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

To initiate activation at power-up, enter

set isdn-options tei-option power-up

1. From the Tei option list, select
power-up.

2. Click OK to return to the Interfaces
page.

Configure when the TEI negotiates with
the ISDN provider.

■ first-call—Activation does not
occur until a call is sent.

■ power-up—Activation occurs when
the device is powered on. This is
the default value.

Configuring Dialer Interfaces (Required)

The dialer interface (dl) is a logical interface configured to establish ISDN connectivity.
You can configure multiple dialer interfaces for different functions on the J Series
device.

After configuring the dialer interface, you must configure a backup method—either
dial backup, a dialer filter, or dialer watch.

To configure a logical dialer interface for the J Series device:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 84 on page 324.

3. To configure a backup method, go on to one of the following tasks:

■ “Configuring Dial Backup” on page 327.

■ “Configuring Dialer Filters for Dial-on-Demand Routing Backup” on page 328.

■ “Configuring Dialer Watch” on page 330.

Table 84: Adding a Dialer Interface to a Device

CLI Configuration Editor
J-Web Configuration
EditorTask

From the [edit] hierarchy
level, enter

edit interfaces

1. In the J-Web
interface, select
Configure>CLI
Tools>Point and
Click CLI.

2. Next to Interfaces,
click Configure or
Edit.

Navigate to the Interfaces  level in the configuration hierarchy.
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Table 84: Adding a Dialer Interface to a Device (continued)

CLI Configuration Editor
J-Web Configuration
EditorTask

Create and name the
interface:

1. edit dl0

2. set description
T1-backup

1. Next to Interface,
click Add new
entry.

2. In the Interface
name box, type
dl0.

3. In the Description
box, type
T1–backup.

4. Click OK.

Create the new interface—for example, dl0.

Adding a description can differentiate between different dialer
interfaces—for example, T1–backup.

Enter

set encapsulation
cisco-hdlc

1. In the
Encapsulation
column, next to the
new interface, click
Edit.

2. From the
Encapsulation list,
select cisco-hdlc.

Configure encapsulation options—for example, Cisco HDLC.

■ Cisco HDLC—For normal mode (when the device is using only one
B-channel). Cisco-compatible High-Level Data Link Control is a
group of protocols for transmitting data between network points.

■ PPP—For normal mode (when the device is using only one ISDN
B-channel per call). Point-to-Point Protocol is for communication
between two computers using a serial interface.

■ Multilink PPP—For multilink mode, when the device is using
multiple B-channels per call. Multilink Point-to-Point Protocol
(MLPPP) is a protocol for aggregating multiple constituent links into
one larger PPP bundle. You can bundle up to eight B-channels.

NOTE: MPLS over ISDN is supported only with MLPPP encapsulation.
If you use PPP or Cisco-HDLC, MPLS packets might be dropped.

1. Enter

set hold-time down
60

2. Enter

set hold-time up 60

1. In the Hold time
section, type 60 in
the Down box.

2. In the Up box, type
60.

Enter a hold-time value in milliseconds—for example, 60. The hold-time
value is used to damp interface transitions. When an interface goes
from up to down, it is not advertised as down to the rest of the system
until it remains unavailable for the hold-time period. Similarly, an
interface is not advertised as up until it remains operational for the
hold-time period. The hold time is three times the interval at which
keepalive messages are sent.

Enter

set unit 0

1. Next to Unit, click
Add new entry.

2. In the Interface unit
number box, type
0.

3. Next to Dialer
options, select Yes,
and then click
Configure.

Create the logical unit—for example, 0.

NOTE: You can set the logical unit to 0 only, unless you are configuring
the dialer interface for Multilink PPP encapsulation.
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Table 84: Adding a Dialer Interface to a Device (continued)

CLI Configuration Editor
J-Web Configuration
EditorTask

1. Enter

edit unit 0
dialer-options

2. Enter

set activation-delay
60

3. Enter

set
deactivation-delay
30

4. Enter

set pool
isdn-dialer-group

5. Enter

set redial-delay 5

1. In the Activation
delay box, type 60.

2. In the Deactivation
delay box, type 30.

3. In the Pool box,
type
isdn-dialer-group.

4. In the Redial delay
box, type 5.

Configure dialer options.

■ Activation delay—Time to wait before activating the backup
interface once the primary interface is down—for example, 30.
Default value is 0 seconds with a maximum value of 60 seconds.
Use only for dialer backup and dialer watch.

■ Deactivation delay—Time to wait before deactivating the backup
interface once the primary interface is up—for example, 30. Default
value is 0 seconds with a maximum value of 60 seconds. Use only
for dialer backup and dialer watch.

■ Idle timeout—Time a connection is idle before disconnecting—for
example, 30. Default value is 120 seconds with a range from 0 to
4294967295. This option is used only to configure a dialer filter.

■ Initial route check—Time to wait before checking if the primary
interface is up—for example, 30. Default value is 120 seconds with
a range of 1 to 300 seconds. This option is used only to configure
dialer watch.

■ Pool—Name of a group of ISDN interfaces configured to use the
dialer interface—for example, isdn-dialer-group.

■ Redial delay—Number of seconds to wait before redialing a failed
outgoing ISDN call. Default value is 3 seconds with a range from
2 to 255.

Enter

set dial-string 5551212

1. Next to Dial string,
click Add new
entry.

2. In the Value box,
type 5551212.

3. Click OK until you
return to the Unit
page.

Configure the remote destination to call—for example, 5551212.

1. From the [edit]
hierarchy level,
enter

edit interfaces dl0
unit 0

2. Enter

set family inet
address
172.20.10.2
destination
172.20.10.1

1. Select Inet under
Family, and click
Edit.

2. Next to Address,
click Add new
entry.

3. In the Source box,
type 172.20.10.2.

4. In the Destination
box, type
172.20.10.1.

5. Click OK.

Configure source and destination IP addresses for the dialer
interface—for example, 172.20.10.2 and 172.20.10.1. (The destination
IP address is optional.)

NOTE: If you configure multiple dialer interfaces, ensure that the same
IP subnet address is not configured on different dialer interfaces.
Configuring the same IP subnet address on multiple dialer interfaces
can result in inconsistency in the route and packet loss. The device
might route packets through another dialer interface with the IP subnet
address instead of through the dialer interface to which the ISDN modem
call is mapped.
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Configuring Dial Backup

Dial backup allows one or more dialer interfaces to be configured as the backup link
for a primary interface. The backup dialer interfaces are activated only when the
primary interface fails. ISDN backup connectivity is supported on all interfaces except
lsq-0/0/0.

To configure a primary interface for backup connectivity:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 85 on page 327.

3. If you are finished configuring the device, commit the configuration.

4. Go on to any of the following optional tasks:

■ “Configuring Dial-on-Demand Routing Backup with OSPF Support (Optional)”
on page 331.

■ “Configuring Bandwidth on Demand (Optional)” on page 332.

■ Configuring Dial-In and Callback (Optional) on page 337

5. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.

Table 85: Configuring an Interface for ISDN Backup

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces ge-0/0/0 unit 0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

1. In the Interface name column, click
the physical interface name.

1. Under Unit, in the Nested
Configuration column, click Edit.

Select the physical interface for backup
ISDN connectivity.

Enter

set backup-options interface dl0.0

1. Next to Backup options, click
Configure.

2. In the Interface box, type dl0.0.

3. Click OK until you return to the
Interfaces page.

Configure the backup dialer
interface—for instance, dl0.0.
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Configuring Dialer Filters for Dial-on-Demand Routing Backup

This dial-on-demand routing backup method allows an ISDN line to be activated only
when network traffic configured as an “interesting packet” arrives on the network.
Once the network traffic is sent, an inactivity timer is triggered and the connection
is closed after the timer expires.

You define an interesting packet using the dialer filter feature of the device. There
are two steps to configuring dial-on-demand routing backup using a dialer filter:

■ Configuring the Dialer Filter on page 328

■ Applying the Dial-on-Demand Dialer Filter to the Dialer Interface on page 329

Configuring the Dialer Filter

To configure the dialer filter:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 86 on page 328.

3. Go on to “Applying the Dial-on-Demand Dialer Filter to the Dialer Interface” on
page 329.

Table 86: Configuring a Dialer Filter for Interesting Packets

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit firewall

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Firewall, click Configure or Edit.

Navigate to the Firewall level in the
configuration hierarchy.

1. Enter

edit family inet

2. Then enter

edit dialer-filter
int-packet

1. Next to Inet, click Configure or Edit.

2. Next to Dialer filter, click Add new entry.

3. In the Filter name box, type int-packet.

Configure the dialer filter name—for
example, int-packet.

Enter

set term term1 from
protocol icmp

1. Next to Term, click Add new entry.

2. In the Rule name box, type term1.

3. Next to From, click Configure.

4. From the Protocol choice list, select Protocol.

5. Next to Protocol, click Add new entry.

6. From the Value keyword list, select icmp.

7. Click OK twice to return to the Term page.

Configure the dialer filter rule name—for
example, term1.

Configure term behavior. For example,
you might want to configure your
interesting packet as an ICMP packet.

To configure the term completely, include
both from and then statements.
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Table 86: Configuring a Dialer Filter for Interesting Packets (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set term1 then note

1. Next to Then, click Configure.

2. From the Designation list, select Note.

3. Click OK.

Configure the then part of the dialer filter.

Applying the Dial-on-Demand Dialer Filter to the Dialer Interface

To complete dial-on-demand routing with dialer filter configuration:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 87 on page 329.

3. When you are finished configuring the device, commit the configuration.

4. Go on to any of the following optional tasks:

■ “Configuring Dial-on-Demand Routing Backup with OSPF Support (Optional)”
on page 331.

■ “Configuring Bandwidth on Demand (Optional)” on page 332.

■ Configuring Dial-In and Callback (Optional) on page 337

5. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.

Table 87: Applying the Dialer Filter to the Dialer Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit interfaces dl0 unit 0

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

Navigate to the Interfaces level in
the configuration hierarchy.

1. In the Interface name column, click dl0.

2. Under Unit, in the Mtu column, click Edit.

Select the dialer interface to apply
the filter—for example, dl0.

1. Enter

edit family inet filter

2. Enter

set dialer int-packet

1. In the Family section, next to Inet, click Edit.

2. Next to Filter, click Configure.

3. In the Dialer box, type int-packet, the dialer-filter
configured in “Configuring the Dialer Filter” on
page 328, as the dialer-filter.

4. Click OK.

Select the dialer filter and apply it
to the dialer interface.
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Configuring Dialer Watch

Dialer watch is a backup method that integrates backup dialing with routing
capabilities and provides reliable connectivity without relying on a dialer filter to
trigger outgoing ISDN connections. With dialer watch, the device monitors the
existence of a specified route and if the route disappears, the dialer interface initiates
the ISDN connection as a backup connection.

Adding a Dialer Watch Interface on the Device

To configure dialer watch:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 88 on page 330.

3. Go on to “Configuring the ISDN Interface for Dialer Watch” on page 330.

Table 88: Adding a Dialer Watch Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

1. Enter

edit dl0

2. Enter

set description dialer-watch

1. Under Interface name, select dl0.

2. In the Description box, type
dialer-watch.

Select a dialer interface—for example,
dl0.

Adding a description, such as
dialer-watch, can help you identify one
dialer interface from another.

1. Enter

edit unit 0 dialer-options

2. Enter

set pool dw-group

3. Enter

set watch-list 172.27.27.0/24

1. Under Unit, click the logical unit
number 0.

2. Next to Dialer options, click Edit.

3. In the Pool box, type dw-group.

4. Next to Watch list, click Add new
entry.

5. In the Prefix box, type
172.27.27.0/24.

6. Click OK.

On a logical interface—for example,
0—specify a dial pool—for example,
dw-group—to link the dialer interface to
at least one ISDN physical interface.

Then configure the list of routes for
dialer watch—for example,
172.27.27.0/24.

Configuring the ISDN Interface for Dialer Watch

To configure the ISDN interface to participate as a dialer watch interface:
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1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 89 on page 331.

3. If you are finished configuring the device, commit the configuration.

4. Go on to any of the following optional tasks:

■ “Configuring Dial-on-Demand Routing Backup with OSPF Support (Optional)”
on page 331.

■ “Configuring Bandwidth on Demand (Optional)” on page 332.

■ Configuring Dial-In and Callback (Optional) on page 337

5. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.

Table 89: Configuring an ISDN Interface for Dialer Watch

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level:

■ For ISDN BRI, enter

edit interfaces br-1/0/3
dialer-options pool
isdn-dialer-group

■ For ISDN PRI, enter

edit interfaces ct1-1/0/1
dialer-options
isdn-dialer-group

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

3. Under Interface name:

■ For ISDN BRI, click br-1/0/3.

■ For ISDN PRI, click ct1-1/0/1.

Navigate to the Interfaces level in the configuration
hierarchy, and select an ISDN physical
interface—for example, br-1/0/3 for ISDN BRI.

For ISDN PRI, select a channelized T1/E1/ISDN PRI
interface—for example, ct1-1/0/1.

1. Next to Dialer options, click Edit.

2. Next to Pool, click Add new entry.

3. In the Pool identifier box, type
isdn-dialer-group.

4. Click OK.

Configure dialer watch options for each ISDN
interface participating in the dialer watch feature.

Each ISDN interface must have the same pool
identifier to participate in dialer watch. Therefore,
the dialer pool name isdn-dialer-group, for the dialer
watch interface configured in Table 88 on page 330,
is used when configuring the ISDN interface.

Configuring Dial-on-Demand Routing Backup with OSPF Support (Optional)

Two types of routing protocol traffic are used by OSPF to establish and maintain
network structure. First, periodic hello packets are sent over each link for neighbor
discovery and maintenance. Second, OSPF protocol traffic achieves and maintains
link-state database synchronization between devices. The OSPF demand circuit
feature removes the periodic nature of both traffic types and reduces the amount of
OSPF traffic by removing all OSPF protocol traffic from a demand circuit when the
routing domain is in a steady state. This feature allows the underlying data-link
connections to be closed when no application traffic is on the network.
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You must configure OSPF on the device before configuring on-demand routing backup
with OSPF support. For information on configuring OSPF, see Junos OS Routing
Protocols and Policies Configuration Guide for Security Devices.

To configure OSPF demand circuits:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 90 on page 332.

3. If you are finished configuring the device, commit the configuration.

4. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.

Table 90: Configuring OSPF Demand Circuits

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

edit protocols ospf area 0.0.0.0

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Protocols, click Configure or Edit.

3. Next to Ospf, click Configure.

4. Next to Area, click Add new entry.

5. In the Area id box, type 0.0.0.0.

Navigate to the Protocols level in the
configuration hierarchy.

1. Enter

edit interface dl0

2. Enter

set demand-circuit

1. Next to Interface, click Add new entry.

2. In the Interface name box, type dl0.0.

3. Select Demand circuit.

4. Click OK.

Configure OSPF on-demand circuits
for each ISDN dialer interface
participating as an on-demand routing
interface—for example, dl0.

Configuring Bandwidth on Demand (Optional)

You can define a threshold for network traffic on the device using the dialer interface
and ISDN interfaces. A number of ISDN interfaces are aggregated together into a
bundle and assigned a single dialer profile. Initially, only one ISDN link is active and
all packets are sent through this interface. When a configured threshold is exceeded,
the dialer interface activates another ISDN link and initiates a data connection. The
threshold is specified as a percentage of the cumulative load of all UP links that are
part of the bundle. When the cumulative load of all UP links, not counting the most
recently activated link, is at or below the threshold, the most recently activated link
is deactivated.

Configuring Dialer Interfaces for Bandwidth on Demand

To configure a dialer interface for bandwidth-on-demand:
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1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 91 on page 333.

3. Go on to “Configuring an ISDN Interface for Bandwidth on Demand” on page 336.

Table 91: Configuring a Dialer Interface for Bandwidth on Demand

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces dl0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

3. Next to dl0, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy, and select a
dialer interface—for example, dl0.

Enter

set encapsulation multilink-ppp

1. Select multilink-ppp as the
encapsulation type.

Configure multilink properties on the
dialer interface.

1. Enter

edit unit 0

2. Enter

edit dialer-options

3. Enter

set dial-string 4085550115

4. Enter

set load-interval 90

5. Enter

set load-threshold 95

6. Enter

set pool bw-pool

1. In the Unit section, click Dialer
options under Encapsulation.

2. Next to Dial string, click Add new
entry.

3. In the Value box, type 4085550115
and click OK.

4. In the Load interval box, type 90.

5. In the Load threshold box, type 95.

6. In the Pool box, type bw-pool.

7. Click OK.

Configure the dialer options.

■ Dial string—Telephone number for
the interface to dial that establishes
ISDN connectivity—for example,
4085550115. You can configure a
maximum of 15 dial strings per
dialer interface.

■ Load interval—Interval of time
used to calculate the average load
on the dialer interface—for
example, 90. Default value is 60
seconds with a range of 20-180
seconds. The value must be a
multiple of 10.

■ Load threshold—Threshold above
which an additional ISDN interface
is activated, specified as a
percentage of the cumulative load
of all UP links—for example 95.
Default value is 100 with a range
of 0–100.

■ Pool—Name of a group of ISDN
interfaces configured to use the
dialer interface—for example,
bw-pool.
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Table 91: Configuring a Dialer Interface for Bandwidth on Demand (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. From the [edit] hierarchy level,
enter

edit interfaces dl0 unit 0

2. Enter

set compression rtp f-max-period 500
queues q3

1. Next to Compression, select Yes,
and then click Configure.

2. Select Rtp, and then click
Configure.

3. In the F max period box, type 100.

4. Next to Queues, click Add new
entry.

5. From the Value list, select q3.

6. Click OK until you return to the Unit
page.

Configure unit properties.

To configure multiple dialer interfaces
for bandwidth-on-demand, increment
the unit number—for example, dl0.1,
dl0.2, and so on.

F max period—Maximum number of
compressed packets allowed between
the transmission of full packets—for
example, 100. The value can be between
1 and 65535.

1. Enter

set fragment-threshold 1024

2. Enter

set mrru 1500

1. In the Fragment threshold box, type
1024.

2. In the Mrru box, type 1500.

3. Click OK until you return to the
main Configuration page.

Configure logical properties.

■ Fragment threshold–Maximum
size, in bytes, for multilink packet
fragments. The value can be
between 128 and 16320 bytes, for
example, 1024. The default is 0
bytes (no fragmentation). Any
nonzero value must be a multiple
of 64 bytes.

■ Maximum received reconstructed
unit (MRRU)—This value is
expressed as a number between
1500 and 4500 bytes—for
example, 1500.

From the [edit] hierarchy level, enter

set access profile bw-profile client client1
chap-secret my-secret

1. On the main Configuration page
next to Access, click Configure or
Edit.

2. Next to Profile, click Add new
entry.

3. In the Profile name box, type
bw-profile.

4. Next to Client, click Add new
entry.

5. In the Name box, type client1.

6. In the Chap secret box, type
my-secret.

7. Click OK until you return to the
main Configuration page.

Define a CHAP access profile with a
client and a secret password. For
example, define bw–profile with client 1
and password my-secret.
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Table 91: Configuring a Dialer Interface for Bandwidth on Demand (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces dl0 unit 0

1. On the main Configuration page
next to Interfaces, click Configure
or Edit.

2. In the interface name box, click
dl0.

3. In the Interface unit number box,
click 0.

Navigate to the appropriate dialer
interface level in the configuration
hierarchy—for example, dl0 unit 0.

Enter

set ppp-options chap access-profile
bw-profile

1. Next to Ppp options, click
Configure.

2. Next to Chap, click Configure.

3. Next to Access data, select Access
profile.

4. In the Access profile box, type
bw-profile.

5. Click OK.

Configure CHAP on the dialer interface
and specify a unique profile name
containing a client list and access
parameters—for example, bw-profile.

Enter

set ppp-options compression acfc

1. Under Compression, select Acfc.

2. Click OK until you return to the Unit
page.

Configure packet compression.

You can configure the following
compression types:

■ ACFC (address and control field
compression)—Conserves
bandwidth by compressing the
address and control fields of
PPP-encapsulated packets.

■ PFC (protocol field
compression)—Conserves
bandwidth by compressing the
protocol field of a PPP-encapsulated
packet.
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Table 91: Configuring a Dialer Interface for Bandwidth on Demand (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Do one of the following:

■ To assign source and destination IP
addresses, enter

set family inet address 172.20.10.2
destination 172.20.10.1

■ To obtain an IP address from the
remote end, enter

set family inet negotiate-address

■ To derive the source address and
assign the destination address,
enter

set family inet unnumbered-address
lo0.0 destination 192.168.1.2

Next to Inet, select Yes and click
Configure.

Select one of the following IP address
configurations:

To assign source and destination IP
addresses:

1. Next to Address, click Add new
entry.

2. In the Source box, type
172.20.10.2.

3. In the Destination box, type
172.20.10.1.

4. Click OK.

To obtain an IP address from the remote
end:

1. Next to Negotiate address, select
the Yes check box.

2. Click OK.

To derive the source address and assign
the destination address:

1. Next to Unnumbered address,
select the Yes check box and click
Configure.

2. In the Destination box, type
192.168.1.2.

3. In the Source box, type lo0.0.

4. Click OK.

Configure the dialer interface to be
assigned an IP address in one of the
following ways:

■ Assign source and destination IP
addresses as described in Table 84
on page 324—for example,
172.20.10.2 and 172.20.10.1. (The
destination IP address is optional.)

■ Obtain an IP address by negotiation
with the remote end. This method
might require the access
concentrator to use a RADIUS
authentication server.

■ Derive the source address from a
specified interface—for example,
the loopback interface, lo0.0—and
assign a destination address—for
example, 192.168.1.2. The
specified interface must include a
logical unit number and have a
configured IP address.

Configuring an ISDN Interface for Bandwidth on Demand

To configure bandwidth on demand on the ISDN interface:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 92 on page 337. Repeat these
tasks for each ISDN interface participating in the aggregated link.

3. If you are finished configuring the device, commit the configuration.

4. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.
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Table 92: Configuring an ISDN Interface for Bandwidth on Demand

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level:

■ For ISDN BRI, enter

edit interfaces
br-1/0/3

■ For ISDN PRI, enter

edit interfaces
ct1-1/0/1

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

3. Under Interface name:

■ For ISDN BRI, click br-1/0/3.

■ For ISDN PRI, click ct1-1/0/1.

Navigate to the Interfaces level in the configuration
hierarchy, and select an ISDN BRI physical interface—for
example, br-1/0/3.

For ISDN PRI, select a channelized T1/E1/ISDN PRI
interface—for example, ct1-1/0/1.

Enter

set dialer-options pool
bw-pool

1. Next to Dialer options, click Dialer
options.

2. Next to Pool, click Add new entry.

3. In the Pool identifier box, type the
name of the dialer pool—for
example, bw-pool.

4. Click OK.

Because each ISDN interface must have the same pool
identifier to participate in bandwidth on demand, use
the dialer pool name bw-pool, the dialer interface
configured in Table 91 on page 333, to configure the
ISDN interfaces participating in the pool.

For ISDN BRI, you can group up to four ISDN interfaces
together when configuring bandwidth on demand, for
a total of eight B-channels (two channels per interface)
providing connectivity.

For ISDN PRI, the pool limit is eight B-channels per
channelized T1/E1/ISDN PRI port.

Configuring Dial-In and Callback (Optional)

If you are a service provider or a corporate data center into which a remote location
dials in during an emergency, you can configure your Juniper Networks device to
accept incoming ISDN calls originating from the remote location, or reject the
incoming calls and call back the remote location. The callback feature lets you control
access by allowing only specific remote locations to connect to the device. You can
also configure the device to reject all incoming ISDN calls.

NOTE: Incoming voice calls are currently not supported.

When it receives an incoming ISDN call, the Juniper Networks device matches the
incoming call's caller ID against the caller IDs configured on its dialer interfaces. If
an exact match is not found and the incoming call's caller ID has more digits than
the configured caller IDs, the device performs a right-to-left match of the incoming
call's caller ID with the configured caller IDs and accepts the incoming call if a match
is found. For example, if the incoming call's caller ID is 4085550115 and the caller
ID configured on a dialer interface is 5550115, the incoming call is accepted. Each
dialer interface accepts calls from only callers whose caller IDs are configured on it.

The dialer interface of the device and the dialer interface of the remote device must
have the same encapsulation—PPP, Multilink PPP, or Cisco HDLC. If the encapsulation
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is different, the ISDN call is dropped. Table 93 on page 338 describes how the device
performs encapsulation monitoring.

Table 93: Encapsulation Monitoring by Juniper Networks Devices

Encapsulation Monitoring
and Call Status

Possible Action on Juniper
Networks Device's Dialer
Interface

Encapsulation on Remote
Router's Dialer Interface

Encapsulation on Juniper
Networks Device's Interface

Device performs
encapsulation monitoring.

ISDN call is successful
because encapsulation
matches.

■ Accepts an incoming call

■ Rejects an incoming call
and calls back the
incoming number when
callback is enabled on
the dialer interface

PPPPPP

Multilink PPPMultilink PPP

Device performs
encapsulation monitoring.

ISDN call is dropped because
of encapsulation mismatch.

Multilink PPP or Cisco HDLCPPP

PPP or Cisco HDLCMultilink PPP

Device does not perform
encapsulation monitoring.

Success of the ISDN call
depends on the encapsulation
monitoring capability of the
remote device.

■ Dials out

■ Accepts an incoming call
as a result of having
originally dialed out,
because the dialer
interface of the remote
device has callback
enabled

PPP, Multilink PPP, or Cisco
HDLC

PPP or Multilink PPP

■ Dials out

■ Accepts an incoming call

■ Accepts an incoming call
as a result of having
originally dialed out,
because the dialer
interface of the remote
device has callback
enabled

■ Rejects an incoming call
and calls back the
incoming number when
callback is enabled on
the dialer interface

PPP, Multilink PPP, or Cisco
HDLC

Cisco HDLC

This section contains the following topics:

■ Configuring Dialer Interfaces for Dial-In and Callback on page 339

■ Configuring an ISDN Interface to Screen Incoming Calls on page 340

■ Configuring the Device to Reject Incoming ISDN Calls on page 341
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Configuring Dialer Interfaces for Dial-In and Callback

To configure a dialer interface for dial-in and callback:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 94 on page 339.

3. If you are finished configuring the device, commit the configuration.

4. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.

Table 94: Configuring the Dialer Interface for Dial-In and Callback

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces dl0

1. In the J-Web interface, select
Configure>CLI Tools>Point
and Click CLI.

2. Next to Interfaces, click
Configure or Edit.

3. Next to dl0, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy, and select a dialer
interface—for example, dl0.

1. Enter

edit unit 0

2. Enter

edit dialer-options

3. Enter

set incoming-map caller
4085550115

1. In the Unit section, for logical
unit number 0, click Dialer
options under Encapsulation.

2. Next to Incoming map, click
Configure.

3. From the Caller type menu,
select Caller.

Next to Caller, click Add new
entry.

4. In the Caller id box, type
4085550115.

5. Click OK until you return to the
Dialer option page.

On a logical interface—for example,
0—configure the incoming map options for the
dialer interface. To use dial-in, you must
configure an incoming map on the dialer
interface.

■ Accept all—Dialer interface accepts all
incoming calls.

You can configure this option for only one
of the dialer interfaces associated with an
ISDN physical interface. The dialer
interface configured to accept all calls is
used only if the incoming call's caller ID
does not match the caller IDs configured
on other dialer interfaces.

■ Caller—Dialer interface accepts calls from
a specific caller ID—for example,
4085550115. You can configure a
maximum of 15 caller IDs per dialer
interface.

The same caller ID must not be configured
on different dialer interfaces. However,
you can configure caller IDs with more or
fewer digits on different dialer interfaces.
For example, you can configure the caller
IDs 14085550115, 4085550115, and
5550115 on different dialer interfaces.
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Table 94: Configuring the Dialer Interface for Dial-In and Callback (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. Enter

set callback

2. Enter

set callback-wait-period 5

1. Select Callback.

2. In the Callback wait period box,
type 5.

Configure callback options for the dialer
interface

■ Callback—Enable this feature to allow the
ISDN interface to reject incoming calls, wait
for 5 seconds (the default callback wait
period), and then call back the incoming
number.

Before configuring callback on a dialer
interface, ensure that the following
conditions exist:

■ The dialer interface is not configured
as a backup for a primary interface.

■ The dialer interface does not have a
watch list configured.

■ Only one dial string is configured for
the dialer interface.

■ Dial-in is configured on the dialer
interface of the remote device that is
dialing in.

■ Callback wait period—Number of seconds
to wait before redialing an incoming ISDN
call.

Configuring an ISDN Interface to Screen Incoming Calls

By default, an ISDN interface is configured to accept all incoming calls. If multiple
devices are connected to the same ISDN line, you can configure an ISDN interface
to screen incoming calls based on the incoming called number.

You can configure the incoming called numbers that you want an ISDN interface to
accept. You can also use the reject option to configure a called number that you want
an ISDN interface to ignore because the number belongs to another device connected
to the same ISDN line. For example, if another device on the same ISDN line has the
called number 4085551091, you can configure the called number 4085551091 with
the reject option on the ISDN interface so that it does not accept calls with that
number.

When it receives an incoming ISDN call, the device matches the incoming called
number against the called numbers configured on its ISDN interfaces. If an exact
match is not found, or if the called number is configured with the reject option, the
incoming call is ignored. Each ISDN interface accepts only the calls whose called
numbers are configured on it.

To configure an ISDN interface to screen incoming ISDN calls:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 95 on page 341.
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3. If you are finished configuring the device, commit the configuration.

4. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.

Table 95: Configuring an ISDN Interface to Screen Incoming ISDN Calls

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level:

■ For ISDN BRI, enter

edit interfaces br-1/0/3

■ For ISDN PRI, enter

edit interfaces ct1-1/0/1

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

3. Under Interface name:

■ For ISDN BRI, click br-1/0/3.

■ For ISDN PRI, click ct1-1/0/1.

Navigate to the Interfaces level in the
configuration hierarchy, and select an
ISDN physical interface—for example,
br-1/0/3.

For ISDN PRI, select a channelized
T1/E1/ISDN PRI interface—for example,
ct1-1/0/1.

Enter

set isdn-options incoming-called-number
4085550115

1. Next to Isdn options, click Edit.

2. Next to Incoming called number,
click Add new entry.

3. In the Called number box, type
4085550115.

4. Click OK.

Configure the incoming called
number—for example,
4085550115—for the ISDN interface.

To configure the ISDN interface to ignore
the incoming called number, use the
reject option.

Configuring the Device to Reject Incoming ISDN Calls

By default, the device is configured to accept incoming ISDN calls. The incoming
calls are accepted if dial-in is configured on the device. You can configure the device
to reject all incoming ISDN calls.

To configure the device to reject incoming ISDN calls:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 96 on page 342.

3. If you are finished configuring the device, commit the configuration.

4. To verify that the network interface is configured correctly, see “Verifying the
ISDN Configuration” on page 343.
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Table 96: Configuring the Device to Reject Incoming ISDN Calls

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

set system processes
isdn-signaling reject-incoming

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to System, click Configure or Edit.

3. Next to Processes, click Configure.

4. Next to Isdn signaling, click Configure.

Navigate to the Processes level in
the configuration hierarchy.

1. Select the Reject Incoming check box.

2. Click OK.

Configure the device to reject
incoming calls.

Disabling Dialing Out Through Dialer Interfaces

The JUNOS ISDN dialer services process manages dialing out through dialer interfaces.
You can disable dialing out through all dialer interfaces by disabling the dialer services
process.

CAUTION: Never disable a software processes unless instructed to do so by a
Customer Support engineer.

To disable dialing out through dialer interfaces:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 97 on page 342.

3. If you are finished configuring the device, commit the configuration.

Table 97: Disabling Dialing Out Through Dialer Interfaces

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

set system processes
dialer-services disable

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to System, click Configure or Edit.

3. Next to Processes, click Configure.

4. Next to Dialer services, click Configure.

Navigate to the Processes level in
the configuration hierarchy.

1. Select the Disable check box.

2. Click OK.

Disable dialing out through dialer
interfaces.
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Disabling ISDN Signaling

The JUNOS ISDN signaling process manages ISDN signaling by initializing ISDN
connections. You can disable ISDN signaling by disabling the ISDN signaling process.

CAUTION: Never disable a software processes unless instructed to do so by a
Customer Support engineer.

To disable ISDN signaling:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 98 on page 343.

3. If you are finished configuring the device, commit the configuration.

Table 98: Disabling ISDN Signaling

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

set system processes
isdn-signaling disable

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to System, click Configure or Edit.

3. Next to Processes, click Configure.

4. Next to Isdn signaling, click Configure.

Navigate to the Processes level in
the configuration hierarchy.

1. Select the Disable check box.

2. Click OK.

Disable ISDN signaling on the
device.

Verifying the ISDN Configuration

To verify an ISDN configuration, perform the following tasks:

■ Displaying the ISDN Status on page 344

■ Verifying an ISDN BRI Interface on page 345

■ Verifying an ISDN PRI Interface and Checking B-Channel Interface
Statistics on page 346

■ Checking D-Channel Interface Statistics on page 347

■ Displaying the Status of ISDN Calls on page 349

■ Verifying Dialer Interface Configuration on page 350
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Displaying the ISDN Status

Purpose Display the status of ISDN service on the ISDN interface. For example, you can display
ISDN BRI status on the br-6/0/0 interface and ISDN PRI status on the ct1-2/0/0
interface.

Action From the operational mode in the CLI, enter show isdn status.

Sample Output user@host> show isdn status
Interface: br-6/0/0 
 Layer 1 status: active
 Layer 2 status: 
  CES: 0, Q.921: up, TEI: 12
 Layer 3 status: 1 Active calls
  Switch Type           : ETSI
  Interface Type        : USER
  T310                  : 10 seconds
 Tei Option            : Power Up

user@host> show isdn status
Interface: ct1-2/0/0
 Layer 1 status: active
 Layer 2 status:
  CES: 0, Q.921: up, TEI: 0
 Layer 3 status: 8 Active calls
  Switch Type           : NI2
  Interface Type        : USER
  T310                  : 10 seconds
  Tei Option            : Power Up

Meaning The output shows a summary of interface information. Verify the following
information:

■ Interface—ISDN interface currently active on the device. For ISDN BRI, the
interface is a br-pim/0/port interface, as shown in the first example for br-6/0/0.
For ISDN PRI, the interface displayed is a channelized T1 or channelized E1
interface, as shown in the second example for ct1-2/0/0.

■ Layer 1 status—Indicates whether Layer 1 is active or inactive.

■ Layer 2 status—Indicates whether Q.921 (the D-channel protocol) is up or down.

■ TEI—Assigned terminal endpoint identifier (TEI) number.

■ Layer 3 status—Number of active calls.

■ Switch Type—Type of ISDN switch connected to the device interface.

■ Interface Type—Default value for the local interface.

■ Calling number—Telephone number configured for dial-out.

■ T310—Q.931-specific timer.

■ TEI Option—Indicates when TEI negotiations occur on the interface.
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Related Topics For a complete description of show isdn status output, see the Junos Interfaces
Command Reference.

Verifying an ISDN BRI Interface

Purpose Verify that the ISDN BRI interface is correctly configured.

Action From the CLI, enter the show interfaces extensive command. Alternatively, from the
J-Web interface select Monitor>Interfaces>br-6/0/0.

Sample Output user@host> show interfaces br-6/0/0 extensive
Physical interface: br-6/0/0, Enabled, Physical link is Up
  Interface index: 143, SNMP ifIndex: 59, Generation: 24
  Type: BRI, Link-level type: Controller, MTU: 4092, Clocking: 1, Speed: 144kbps,

  Parent: None
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps Internal: 0x4000
  Link type      : Full-Duplex
  Link flags     : None
  Physical info  : S/T
  Hold-times     : Up 0 ms, Down 0 ms
  Last flapped   : 2005-12-07 12:21:11 UTC (04:07:26 ago)
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :                    0                    0 bps
   Output bytes  :                    0                    0 bps
   Input  packets:                    0                    0 pps
   Output packets:                    0                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Framing errors: 0, Runts: 0, Giants: 0, Policed discards:
 0, 
    Resource errors: 0
  Output errors:
    Carrier transitions: 0, Errors: 0, Drops: 0, MTU errors: 0, Resource errors:
 0

Meaning The output shows a summary of interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).
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■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates likely link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

Related Topics For a complete description of show interfaces (ISDN BRI) output, see the Junos
Interfaces Command Reference.

Verifying an ISDN PRI Interface and Checking B-Channel Interface Statistics

Purpose Verify that an ISDN B-channel interface is operating properly. For ISDN PRI, verify
that a B-channel interface is configured correctly. (To display a list of B-channel
interfaces, enter the show isdn calls command.)

Action From the CLI, enter the show interfaces extensive command. Alternatively, from the
J-Web interface select Monitor>Interfaces>bc-0/0/4:1.

Sample Output user@host> show interfaces bc-0/0/4:1 extensive
Physical interface: bc-0/0/4:1, Administratively down, Physical link is Up
  Interface index: 145, SNMP ifIndex: 75, Generation: 26
  Type: Serial, Link-level type: Multilink-PPP, MTU: 1510, Clocking: Internal,
  Speed: 64kbps, 
  Parent: br-0/0/4 Interface index 143
  Device flags   : Present Running
  Interface flags: Admin-Test SNMP-Traps 16384
  Link type      : Full-Duplex
  Link flags     : None
  Physical info  : Unspecified
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: Unspecified, Hardware address: Unspecified
  Alternate link address: Unspecified
  CoS queues     : 8 supported, 8 maximum usable queues
  Last flapped   : Never
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :                 5787                    0 bps
   Output bytes  :                 3816                    0 bps
   Input  packets:                  326                    0 pps
   Output packets:                  264                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Framing errors: 0, Runts: 0, Giants: 0, Policed discards:
 6,
    Resource errors: 0
  Output errors:
    Carrier transitions: 0, Errors: 0, Drops: 0, MTU errors: 0, Resource errors:
 0
    Queue counters      Queued packets   Transmitted Packets   Dropped packets
       0 best-effort            314335                     0                 0
       1 best-effort                 0                     0                 0
       2 best-effort                 5                     0                 0
       3 best-effort              5624                  5624                 0
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    Packet Forwarding Engine configuration:
    Destination slot: 5, PLP byte: 1 (0x00)
    CoS transmit queue               Bandwidth               Buffer Priority   
Limit
                              %            bps     %           usec
    0 best-effort            95          60800    95              0      low    
none
    3 network-control         5           3200     5              0      low    
none

  Logical interface bc-0/0/4:1.0 (Index 71) (SNMP ifIndex 61) (Generation 33)
    Flags: Device Down Point-To-Point SNMP-Traps Encapsulation: PPP
    Protocol mlppp, Multilink bundle: dl0.0, MTU: 1506, Generation: 18, Route 
table: 0

Meaning The output shows a summary of B-channel interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).

■ For ISDN BRI, the Parent interface is a br-pim/0/port interface—br-0/0/4 in this
example. For ISDN PRI, the Parent interface is a channelized T1 or channelized
E1 interface—ct1–pim/0/port or ce1–pim/0/port.

■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates possible link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

Related Topics For a complete description of show interfaces (ISDN B-channel) output, see the Junos
Interfaces Command Reference.

Checking D-Channel Interface Statistics

Purpose Verify that the ISDN D-channel interface is operating properly. For ISDN PRI, verify
that the D-channel interface is configured correctly.

Action From the CLI, enter the show interfaces extensive command. Alternatively, from the
J-Web interface select Monitor>Interfaces>dc-0/0/4.
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Sample Output user@host> show interfaces dc-0/0/4 extensive
Physical interface: dc-0/0/4, Enabled, Physical link is Up
  Interface index: 144, SNMP ifIndex: 60, Generation: 25
  Type: Serial, Link-level type: 55, MTU: 4092, Clocking: Internal, Speed: 16kbps,

  Parent: br-0/0/4 Interface index 143
  Device flags   : Present Running
  Interface flags: SNMP-Traps Internal: 0x4000
  Link type      : Full-Duplex
  Link flags     : None
  Physical info  : Unspecified
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: Unspecified, Hardware address: Unspecified
  Alternate link address: Unspecified
  Last flapped   : 2005-12-07 12:21:12 UTC (05:46:00 ago)
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :                13407                    0 bps
   Output bytes  :                16889                    0 bps
   Input  packets:                 3262                    0 pps
   Output packets:                 3262                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Framing errors: 0, Runts: 0, Giants: 0, Policed discards:
 0, 
    Resource errors: 0
  Output errors:
    Carrier transitions: 1, Errors: 0, Drops: 0, MTU errors: 0, Resource errors:
 0
  ISDN  alarms   : None
  ISDN media:            Seconds        Count  State
    LOF                       0            1  0K
    LOS                       0            0  0K

  Logical interface dc-0/0/4.32767 (Index 70) (SNMP ifIndex 72) (Generation 8)
    Flags: Point-To-Point SNMP-Traps Encapsulation: 60
    Traffic statistics:
     Input  bytes  :                13407
     Output bytes  :                82129
     Input  packets:                 3262
     Output packets:                 3262
    Local statistics:
     Input  bytes  :                13407
     Output bytes  :                82129
     Input  packets:                 3262
     Output packets:                 3262

Meaning The output shows a summary of D-channel interface information. Verify the following
information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.
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■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).

■ For ISDN BRI, the Parent interface is a br-pim/0/port interface—br-0/0/4 in this
example. For ISDN PRI, the Parent interface is a channelized T1 or channelized
E1 interface—ct1–pim/0/port or ce1–pim/0/port.

■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates possible link-layer errors.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

Related Topics For a complete description of show interfaces (ISDN D-channel) output, see the Junos
Interfaces Command Reference.

Displaying the Status of ISDN Calls

Purpose Display the status of ISDN calls. This information helps you to verify the dialer
interface configuration as described in “Verifying Dialer Interface Configuration” on
page 350. The command also provides a list of the B-channels configured on an ISDN
BRI or ISDN PRI interface.

Action From the CLI, enter the show isdn calls command.

Sample Output user@host> show isdn calls
Interface: bc-6/0/0:1
  Status: No call in progress
  Most recent error code: No error
Interface: bc-6/0/0:2
  Status: Connected to 384070
  Call Duration: 43 seconds
  Call Direction: Dialout
  Most recent error code: No error

user@host> show isdn calls
Interface: bc-2/0/0:1
  Status: Connected to 384010
  Call Duration: 49782 seconds
  Call Direction: Dialin
  Most recent error code: destination out of order
Interface: bc-2/0/0:2
  Status: Connected to 384011
  Call Duration: 49782 seconds
  Call Direction: Dialin
  Most recent error code: destination out of order
Interface: bc-2/0/0:3
  Status: Connected to 384020
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  Call Duration: 49782 seconds
  Call Direction: Dialin
  Most recent error code: destination out of order
...
Interface: bc-2/0/0:20
  Status: No call in progress
  Most recent error code: No error
Interface: bc-2/0/0:21
  Status: No call in progress
  Most recent error code: No error
Interface: bc-2/0/0:22
  Status: No call in progress
  Most recent error code: No error
Interface: bc-2/0/0:23
  Status: No call in progress
  Most recent error code: No error

Meaning The output shows a summary of B-channel interfaces and the active ISDN calls on
the interfaces. The first example shows the two B-channels on an ISDN BRI
interface—bc-2/0/0:1 and bc-2/0/0:2. The second example indicates B-channels
bc-2/0/0:1 through bc-2/0/0:23, the 23 B-channels on an ISDN PRI interface.
Determine the following information:

■ The interfaces on which ISDN calls are in progress

■ Whether the call is a dial-in call, dial-out call, or a callback call

Related Topics For a complete description of show isdn calls output, see the Junos Interfaces Command
Reference.

Verifying Dialer Interface Configuration

Purpose Verify that the dialer interface is correctly configured. To determine the ISDN
interfaces on which calls are taking place, see “Displaying the Status of ISDN Calls”
on page 349.

Action From the CLI, enter the show interfaces dl0 extensive command. Alternatively, from
the J-Web interface select Monitor>Interfaces>dl0.

Sample Output user@host> show interfaces dl0 extensive
Physical interface: dl0, Enabled, Physical link is Up
  Interface index: 173, SNMP ifIndex: 26, Generation: 77
  Type: 27, Link-level type: PPP, MTU: 1504, Clocking: Unspecified, Speed: 
Unspecified
  Device flags   : Present Running
  Interface flags: SNMP-Traps
  Link type      : Full-Duplex
  Link flags     : Keepalives
  Physical info  : Unspecified
  Hold-times     : Up 0 ms, Down 0 ms
  Current address: Unspecified, Hardware address: Unspecified
  Alternate link address: Unspecified
  Last flapped   : Never
  Statistics last cleared: Never
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  Traffic statistics:
   Input  bytes  :                13859                    0 bps
   Output bytes  :                    0                    0 bps
   Input  packets:                  317                    0 pps
   Output packets:                    0                    0 pps
  Input errors:
    Errors: 0, Drops: 0, Framing errors: 0, Runts: 0, Giants: 0, Policed discards:
 0, 
    Resource errors: 0
  Output errors:
    Carrier transitions: 0, Errors: 0, Drops: 0, MTU errors: 0, Resource errors:
 0

  Logical interface dl0.0 (Index 76) (SNMP ifIndex 28) (Generation 148)
    Flags: Point-To-Point SNMP-Traps 0x4000 LinkAddress 23-0 Encapsulation: PPP
    Dialer:  
      State: Active, Dial pool: 1
      Dial strings: 384070
      Subordinate interfaces: bc-6/0/0:2 (Index 172)
      Watch list: 11.12.13.14/32
      Activation delay: 0, Deactivation delay: 0
      Initial route check delay: 120
      Redial delay: 3
      Callback wait period: 5
      Load threshold: 0, Load interval: 60
    Bandwidth: 64kbps
    Traffic statistics:
     Input  bytes  :                24839
     Output bytes  :                17792
     Input  packets:                  489
     Output packets:                  340
    Local statistics:
     Input  bytes  :                10980
     Output bytes  :                17792
     Input  packets:                  172
     Output packets:                  340
    Transit statistics:
     Input  bytes  :                13859                    0 bps
     Output bytes  :                    0                    0 bps
     Input  packets:                  317                    0 pps
     Output packets:                    0                    0 pps
  Keepalive settings: Interval 10 seconds, Up-count 1, Down-count 3
  Keepalive statistics:
    Input : 0 (last seen: never)
    Output: 36 (last sent 00:00:09 ago)
  LCP state: Opened 
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, 
  mpls: Not-configured
  CHAP state: Success
    Protocol inet, MTU: 1500, Generation: 74, Route table: 0
      Flags: Negotiate-Address
      Addresses, Flags: Kernel Is-Preferred Is-Primary
        Destination: 43.1.1.2, Local: 43.1.1.19, Broadcast: Unspecified, 
        Generation: 37

user@host> show interfaces dl0 extensive
Physical interface: dl0, Enabled, Physical link is Up
  Interface index: 140, SNMP ifIndex: 35, Generation: 141
  Link-level type: LinkService, MTU: 1504
  Device flags   : Present Running
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  Interface flags: Point-To-Point SNMP-Traps
  Last flapped   : 2007-02-27 01:50:38 PST (1d 15:48 ago)
  Statistics last cleared: Never
  Traffic statistics:
   Input  bytes  :             42980144                    0 bps
   Output bytes  :                  504                    0 bps
   Input  packets:               934346                    0 pps
   Output packets:                    6                    0 pps
  Frame exceptions:
    Oversized frames                  0
    Errored input frames              0
    Input on disabled link/bundle     0
    Output for disabled link/bundle   0
    Queuing drops                     0
  Buffering exceptions:
    Packet data buffer overflow       0
    Fragment data buffer overflow     0
  Assembly exceptions:
    Fragment timeout                  0
    Missing sequence number           0
    Out-of-order sequence number      0
    Out-of-range sequence number      0
  Hardware errors (sticky):
    Data memory error                 0
    Control memory error              0
  Egress queues: 8 supported, 8 in use
  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 q1                             6                    6                    0

    1 q2                             0                    0                    0

    2 assured-forw                   0                    0                    0

    3 q3                             0                    0                    0

  Logical interface dl0.0 (Index 66) (SNMP ifIndex 36) (Generation 133)
    Flags: Point-To-Point SNMP-Traps 0x4000 Encapsulation: Multilink-PPP
    Dialer:
      State: Active, Dial pool: 1
      Dial strings: 384010
      Subordinate interfaces: bc-2/0/0:8 (Index 161), bc-2/0/0:7 (Index 160),
      bc-2/0/0:6 (Index 159), bc-2/0/0:5 (Index 158), bc-2/0/0:4 (Index 157),
      bc-2/0/0:3 (Index 156), bc-2/0/0:2 (Index 155), bc-2/0/0:1 (Index 154)
      Activation delay: 0, Deactivation delay: 0
      Initial route check delay: 120
      Redial delay: 3
      Callback wait period: 5
      Load threshold: 100, Load interval: 60
    Bandwidth: 512kbps
    Bundle options:
      MRRU                                 1504
      Remote MRRU                          1504
      Drop timer period                    0
      Inner PPP Protocol field compression enabled
      Sequence number format               long (24 bits)
      Fragmentation threshold              0
      Links needed to sustain bundle       1
      Interleave fragments                 Disabled
    Bundle errors:
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      Packet drops                    0 (0 bytes)
      Fragment drops                  15827 (759696 bytes)
      MRRU exceeded                   0
      Exception events                0
    Statistics         Frames        fps         Bytes          bps
    Bundle:
      Fragments:
        Input :        963116          0      50963104            0
        Output:             6          0           540            0
      Packets:
        Input :        934346          0      42980144            0
        Output:             6          0           504            0
    Link:
      bc-2/0/0:1.0
        Input :        119656          0       6341806            0
        Output:             1          0            90            0
      bc-2/0/0:2.0
        Input :        120176          0       6369366            0
        Output:             1          0            90            0
      bc-2/0/0:3.0
        Input :        119856          0       6352368            0
        Output:             1          0            90            0
      bc-2/0/0:4.0
        Input :        120315          0       6376695            0
        Output:             0          0             0            0
      bc-2/0/0:5.0
        Input :        120181          0       6369593            0
        Output:             0          0             0            0
      bc-2/0/0:6.0
        Input :        121154          0       6421200            0
        Output:             0          0             0            0
      bc-2/0/0:7.0
        Input :        121181          0       6340321            0
        Output:             0          0             0            0
      bc-2/0/0:8.0
        Input :        120594          0       6391482            0
        Output:             0          0             0            0
  NCP state: inet: Opened, inet6: Not-configured, iso: Not-configured, mpls:
  Not-configured
    Protocol inet, MTU: 1500, Generation: 138, Route table: 0
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 1.1.1.0/30, Local: 1.1.1.2, Broadcast: Unspecified,
        Generation: 134

Meaning The output shows a summary of dialer interface information. The first example is
for ISDN BRI service, and the second example is for ISDN PRI service. Verify the
following information:

■ The physical interface is Enabled. If the interface is shown as Disabled, do either
of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.

■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ The physical link is Up. A link state of Down indicates a problem with the interface
module, interface port, or physical connection (link-layer errors).
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■ The Last Flapped time is an expected value. The Last Flapped time indicates the
last time the physical interface became unavailable and then available again.
Unexpected flapping indicates possible link-layer errors.

■ Subordinate interfaces correctly lists the B-channel interface or interfaces
associated with this dialer interface. The ISDN BRI output in the first example
shows that dl0 supports bc-6/0/0:2.

The ISDN PRI output in the second example shows that dl0 supports bc-2/0/0:1
through bc-2/0/0:8.

■ The traffic statistics reflect expected input and output rates. Verify that the
number of inbound and outbound bytes and packets matches expected
throughput for the physical interface. To clear the statistics and see only new
changes, use the clear interfaces statistics interface-name command.

■ The dialer state is Active when an ISDN call is in progress.

■ The LCP state is Opened when an ISDN call is in progress. An LCP state of Closed
or Not Configured indicates a problem with the dialer configuration that needs
to be debugged with the monitor traffic interface interface-name command. For
information about the monitor traffic command, see the Junos OS Administration
Guide for Security Devices.

Related Topics For a complete description of show interfaces (ISDN dialer) output, see the Junos
Interfaces Command Reference.
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Chapter 12

Configuring 3G Wireless Modems for WAN
Connections

3G refers to the third generation of mobile phone standards and technology based
on the International Telecommunication Union (ITU) International Mobile
Telecommunications-2000 (IMT-2000) global standard. 3G networks are wide area
cellular telephone networks that have evolved to include high-data rate services of
up to 3 Mbps. This increased bandwidth makes 3G networks a viable option as
primary or backup wide area network (WAN) links for a branch office.

Juniper Networks supports 3G wireless modem cards that you can install into the
ExpressCard slot in SRX210 devices. When used in a branch office, the SRX210
device can provide dial-out services to PC users and forward IP traffic through a
service provider’s cellular network.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter includes the following topics:

■ 3G Wireless Modem Support on Different Device Types on page 356

■ 3G Wireless Overview on page 356

■ Understanding the 3G Wireless Modem Interface on page 359

■ Understanding the Dialer Interface on page 360

■ Understanding the GSM Profile on page 361

■ 3G Wireless Modem Configuration Overview on page 362

■ Configuring the 3G Wireless Modem Interface—Quick Configuration on page 363

■ Configuring the Dialer Interface on page 365

■ Configuring the 3G Wireless Modem Interface on page 367

■ Configuring the GSM Profile on page 368

■ Configuring PAP on the Dialer Interface on page 370

■ Configuring CHAP on the Dialer Interface on page 371

■ Configuring the Dialer Interface as a Backup WAN Connection on page 373

■ Configuring Dialer Watch for the 3G Wireless Modem Interface on page 374

■ Configuring Dialer Filter for the 3G Wireless Modem Interface on page 375

■ Understanding Account Activation for CDMA EV-DO Cards on page 376
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■ Activating the CDMA EV-DO Modem Card with OTASP Provisioning on page 378

■ Activating the CDMA EV-DO Modem Card Manually on page 379

■ Activating the CDMA EV-DO Modem Card with IOTA Provisioning on page 380

■ Unlocking the GSM 3G Wireless Modem on page 381

3G Wireless Modem Support on Different Device Types

The following table lists key 3G wireless modem features, specifies whether the
features are supported on various device types, and indicates where you can find
more information about each feature.

Table 99: Support Information: 3G Wireless Modems

More Information
SRX210
Devices

J Series
DevicesFeature

“3G Wireless Overview” on
page 356

YesNo3G Global System for Mobile Communications (GSM)
High-Speed Downlink Packet Access (HSDPA) wireless
modem card

“3G Wireless Overview” on
page 356

YesNo3G Code-Division Multiple Access (CDMA)
Evolution-Data Optimized (EV-DO) wireless modem
card

3G Wireless Overview

Figure 45 on page 357illustrates a basic setup for 3G wireless connectivity for two
branch offices. Branch Office A has a T1 leased line as the primary wide area network
(WAN) link and a 3G wireless modem connection as the failover link. Branch Office
B uses the 3G wireless modem connection as the primary WAN link.
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Figure 45: Wireless WAN Connections for Branch Offices

Internet/carrier network

Supported Devices and 3G Wireless Modem Cards

Juniper Networks supports 3G wireless modem cards that you can install into the
ExpressCard slot in SRX210 devices. When used in a branch office, the SRX210
device can provide dial-out services to PC users as well as forward IP traffic onto the
service provider’s cellular network.

Juniper Networks supports the following 3G wireless modem cards:

■ Sierra Wireless AirCard Global System for Mobile Communications (GSM)
High-Speed Downlink Packet Access (HSDPA) ExpressCard

■ Sierra Wireless AirCard Code-Division Multiple Access (CDMA) 1xEvolution-Data
Optimized (EV-DO) rev. A ExpressCard

GSM and CDMA are competing digital cellular phone technologies. GSM is used by
AT&T, T-Mobile, and by cellular networks in countries other than the U.S., Japan,
India, and Korea. CDMA is used by Sprint and Verizon.

3G Terms

Before configuring 3G wireless modems, become familiar with the terms defined in
Table 100 on page 358.
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Table 100: 3G Terms

DefinitionTerm

Provides routing information for GPRS. The APN consists of two parts: the Network
ID, which identifies the external service requested by a user of the GPRS service, and
the Operator ID, which specifies routing information.

Access point name (APN)

A set of modem commands, preceded by AT, originally developed by Hayes, Inc. for
their modems. The structure (but not the specific commands, which vary greatly from
manufacturer to manufacturer) is a de facto industry standard for modems.

AT

Located at the cellular service provider network, BTS provides the radio or the Physical
Layer connectivity between the mobile user and the mobile network.

Base Transceiver Station (BTS)

Multiplexing protocols used in wireless communications. CDMA is used by Sprint and
Verizon cellular networks.

Code-Division Multiple Access (CDMA)

These messages are used to:

■ Query 3G modem status

■ Set parameters and configuration of the 3G modem device

■ Control the traffic of event notifications from the 3G modem device

■ Receive event notification from modem device

Control and Status (CNS) message

Qualcomm Diagnostic Mode is the protocol specification and mechanism that is used
to allow collection of debug logs from Sierra 3G wireless modem firmware.

Diagnostic Mode (DM)

Feature that reestablishes network connectivity through one or more backup dialer
interfaces after a primary interface fails. When the primary interface is reestablished,
the backup is disconnected.

dial backup

Logical interface for configuring properties for a 3G wireless modem connection.dialer interface

One or more physical interfaces that are associated with a dialer profile.dialer pool

Set of characteristics configured for the 3G wireless modem interface. Dialer profiles
allow the configuration of physical interfaces to be separated from the logical
configuration of dialer interfaces required for 3G wireless modem connectivity. This
feature also allows physical and logical interfaces to be bound together dynamically
on a per-connection basis.

dialer profile

Standard for transmitting data through radio signals.Evolution Data Optimized (EV-DO)

Number that is printed on the 3G wireless modem card itself. You can also use the
show modem wireless interface firmware command to display this number.

Electronic Serial Number (ESN)

Packet-based wireless service used in GSM networks.General Packet Radio Services (GPRS)

Standard used by AT&T and T-Mobile cellular networks.Global System for Mobile
Communications (GSM)

3G mobile communications protocol.High Speed Downlink Packet Access
(HSDPA)

Activation method used by cellular network providers such as Sprint for CDMA EV-DO
3G wireless modem cards.

Internet-based Over the Air (IOTA)
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Table 100: 3G Terms (continued)

DefinitionTerm

Activation method used by cellular network providers such as Verizon for CDMA
EV-DO 3G wireless modem cards.

Over the Air Service Provisioning
(OTASP)

File that contains information for accessing the device's home network, as well as the
service provider's roaming partners.

Preferred Roaming List (PRL)

Detachable smart card on the GSM HSDPA 3G wireless modem.Subscriber Identity Module (SIM)

Related Topics

■ Understanding the 3G Wireless Modem Interface on page 359

■ Understanding the Dialer Interface on page 360

Understanding the 3G Wireless Modem Interface

You configure two types of interfaces for 3G wireless modem connectivity—the
physical interface and a logical dialer interface.

The physical interface for the 3G wireless modem uses the name cl-0/0/8. This
interface is automatically created when a 3G wireless modem is installed in the
device.

You configure the following for the physical interface:

■ A dialer pool to which the physical interface belongs and the priority of the
interface in the pool. A physical interface can belong to more than one dialer
pool. The dialer pool priority has a range from 1 to 255, with 1 designating the
lowest-priority interfaces and 255 designating the highest-priority interfaces.

■ Modem initialization string (optional). These strings begin with AT and execute
Hayes modem commands that specify modem operation.

■ GSM profile for establishing a data call with a GSM cellular network. For more
information, see “Understanding the GSM Profile” on page 361.

By default, the modem allows access to networks other than the home network.

Related Topics

■ 3G Wireless Modem Configuration Overview on page 362

■ Understanding the Dialer Interface on page 360

■ Understanding the GSM Profile on page 361
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Understanding the Dialer Interface

The dialer interface, dln, is a logical interface for configuring properties for modem
connections. You can configure multiple dialer interfaces on an SRX Series device.
A dialer interface and a dialer pool (which includes the physical interface) are bound
together in a dialer profile.

The following rules apply when you configure dialer interfaces for 3G wireless modem
connections:

■ The dialer interface must be configured to to use the default Point-to-Point
Protocol (PPP) encapsulation. You cannot configure Cisco High-Level Data Link
Control (HDLC) or Multilink PPP (MLPPP) encapsulation on dialer interfaces.

■ You cannot configure the dialer interface as a constituent link in a multilink
bundle.

■ You cannot configure any dial-in options for the dialer interface.

You configure the following for a dialer interface:

■ A dialer pool to which the physical interface belongs.

■ Source IP address for the dialer interface.

■ Dial string (optional) is the destination number to be dialed.

■ Authentication, for GSM HSDPA 3G wireless modem cards.

■ Watch list, if the dialer interface is a backup WAN link. See “Configuring Dialer
Watch for the 3G Wireless Modem Interface” on page 374.

Authentication for GSM HSDPA 3G Wireless Modems

For GSM HSDPA 3G wireless modems, you configure a dialer interface to support
authentication through Challenge Handshake Authentication Protocol (CHAP) or
Password Authentication Protocol (PAP).

CHAP is a server-driven, three-step authentication method that depends on a shared
secret password that resides on both the server and the client. When you enable
CHAP on a dialer interface, the device can authenticate its peer and be authenticated
by its peer.

PAP allows a simple method for a peer to establish its identity using a two-way
handshake during initial link establishment. After the link is established, an
identification and password pair is repeatedly sent by the peer to the authenticator
until authentication is acknowledged or the connection is terminated.

Backup, Dialer Filter, and Dialer Watch

The dialer interface can perform backup, dialer filter, and dialer watch functions, but
these operations are mutually exclusive. You can configure a single dialer interface
to operate in only one of the following ways:
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■ As a backup interface for a single primary WAN connection. The dialer interfaces
are activated only when the primary interface fails. The 3G wireless modem
backup connectivity is supported on all interfaces except lsq-0/0/0.

■ As a dialer filter. Dialer filter enables the 3G wireless modem connection to be
activated only when specific network traffic is sent on the backup WAN link.
You configure a firewall rule with the dialer filter option, and then apply the
dialer filter to the dialer interface.

■ As a dialer watch interface. With dialer watch, the SRX Series device monitors
the status of a specified route and if the route disappears, the dialer interface
initiates the 3G wireless modem connection as a backup connection. To configure
dialer watch, you first add the routes to be monitored to a watch list in a dialer
interface; specify a dialer pool for this configuration. Then configure the 3G
wireless modem interface to use the dialer pool.

Operating Parameters

You can also specify optional operating parameters for the dialer interface:

■ Activation delay—Number of seconds after the primary interface is down before
the backup interface is activated. The default value is 0 seconds, and the
maximum value is 60 seconds. Use this option only if dialer watch is configured.

■ Deactivation delay—Number of seconds after the primary interface is up before
the backup interface is deactivated. The default value is 0 seconds, and the
maximum value is 60 seconds. Use this option only if dialer watch is configured.

■ Idle timeout—Number of seconds the connection remains idle before
disconnecting. The default value is 120 seconds, and the range is from 0 to
4294967295 seconds.

■ Initial route check—Number of seconds before the primary interface is checked
to see if it is up. The default value is 120 seconds, and the range is from 1 to
300 seconds.

Related Topics

■ 3G Wireless Modem Configuration Overview on page 362

■ Understanding the 3G Wireless Modem Interface on page 359

Understanding the GSM Profile

To allow data calls to a GSM network, you must obtain the following information
from your service provider:

■ Username and password

■ Access point name (APN)

■ Whether the authentication is CHAP or PAP
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You configure this information in a GSM profile associated with the 3G wireless
modem physical interface. You can configure up to 16 different GSM profiles, although
only one profile can be active at a time.

NOTE: You also need to configure a CHAP or PAP profile with the specified username
and password for the dialer interface.

Subscriber information is written to the Subscriber Identity Module (SIM) on the GSM
HSDPA 3G wireless modem card. If the SIM is locked, you must unlock it before
activation by using the master subsidy lock (MSL) value given by the service provider
when you purchase the cellular network service. See “Unlocking the GSM 3G Wireless
Modem” on page 381.

Some service providers may preload subscriber profile information on a SIM card.
The assigned subscriber information is stored in profile 1, while profile 0 is a default
profile created during manufacturing. If this is the case, specify profile 1 for the GSM
profile associated with the 3G wireless modem physical interface.

Related Topics

■ 3G Wireless Modem Configuration Overview on page 362

3G Wireless Modem Configuration Overview

Before You Begin

1. Install your SRX Series device and establish basic connectivity for your device. For more
information, see the Hardware Guide for your device.

2. Obtain a supported 3G wireless modem card for the device.

3. Establish an account with a cellular network service provider. Contact your service provider
for more information.

4. With the services router powered off, insert the 3G wireless modem card into the ExpressCard
slot. Power on the device. The PIM LED on the front panel of the device indicates the status
of the 3G wireless modem interface.

WARNING: The device must be powered off before you insert the 3G wireless modem card in
the ExpressCard slot. You cannot insert or remove the card when the device is powered on.

5. For background information, read the following:

■ 3G Wireless Overview on page 356

■ Understanding the 3G Wireless Modem Interface on page 359

■ Understanding the Dialer Interface on page 360

■ Understanding the GSM Profile on page 361

To configure and activate the 3G wireless modem card, perform the following tasks:
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1. Configure a dialer interface.

2. Configure the 3G wireless modem interface.

3. Configure security zones and policies, as needed, to allow traffic through the
WAN link.

Related Topics

■ Configuring the Dialer Interface on page 365

■ Configuring the 3G Wireless Modem Interface—Quick Configuration on page 363

■ Configuring the 3G Wireless Modem Interface on page 367

■ Configuring the GSM Profile on page 368

Configuring the 3G Wireless Modem Interface—Quick Configuration

The physical interface for the 3G wireless modem, cl-0/0/8, is automatically created
when a 3G wireless modem is installed in the device. You can use J-Web Quick
Configuration to configure the 3G wireless interface and activate a CDMA EV-DO 3G
wireless modem card.

NOTE: The J-Web Quick Configuration does not support configuration of a GSM
profile. Use the CLI configuration editor or the J-Web Edit Configuration page to
configure a GSM profile.

Before You Begin

For background information, read “3G Wireless Modem Configuration Overview” on page 362.

To configure the 3G wireless interface with Quick Configuration:

1. In the J-Web user interface, select Configure>Interfaces.

A list of network interfaces installed on the device is displayed.

2. Click the cl-0/0/0 interface name.

The 3G Interface Configuration is displayed.

3. Enter information into the 3G Interface Configuration, as described in Table 101
on page 364.

4. To apply the configuration and return to the Quick Configuration Interfaces page,
click OK. (To cancel your entries and return to the Quick Configuration Interfaces
page, click Cancel.)

5. From the Interfaces Quick Configuration page, click Apply to apply the
configuration.
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Table 101: 3G Wireless Interface Quick Configuration Summary

Your ActionFunctionField

Configuring 3G Wireless Interfaces

Type a text description of the physical 3G
wireless interface in the box to clearly identify
the interface when viewing displays.

(Optional) Adds supplemental information
about the 3G wireless physical interface on the
device.

Description

Type a string that begins with AT and includes
Hayes modem commands.

(Optional) Specifies modem operation.Modem Options: Init String

Dialer Pool Options

■ To add a dialer pool to the interface, click
Add.

■ To edit a dialer pool, select the name from
the list. You can change the priority, but
not the name.

■ To delete a dialer pool, select the check
box and click Delete.

Displays the list of configured dialer pools on
the device.

Dialer Pools

Type the dialer pool name—for example, 1.Specifies the group of physical interfaces to be
used by the dialer interface.

Dialer Pool Name
(required)

1. Type a priority value from 0 (lowest) to
255 (highest). The default is 0.

2. Click OK to return to the Quick
Configuration Interfaces page.

Specifies the priority of this interface within
the dialer pool. Interfaces with a higher priority
are the first to interact with the dialer interface.

Priority

Card Activation Options

1. Select the type of card activation:

■ IOTA—Internet-based over the air
provisioning.

■ Manual Activation—Requires manual
entry of the required information.

■ OTASP—Over the air service
provisioning.

2. Click Activate.

3. If you selected Manual Activation or
OTASP, you are prompted to enter
information required for card activation.
(No additional information is needed for
IOTA card activation.)

4. Click OK.

Enables the CDMA wireless modem card to
connect to the service provider’s cellular
network.

Card Activation

OTASP Activation Parameters

Enter the dial number supplied by the service
provider.

Number that the modem uses to contact the
service provider’s network.

Dial String

Manual Activation Parameters

Enter the number supplied by the service
provider.

Mobile subscriber informationInternational Mobile
Station Identity
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Table 101: 3G Wireless Interface Quick Configuration Summary (continued)

Your ActionFunctionField

Enter the number supplied by the service
provider.

10-digit user phone numberMobile Directory Number

Enter the code supplied by the service provider.Activation codeMaster Subsidy Lock

Enter the NID number displayed with the CLI
show modem wireless interface cl-0/0/8 network
command.

Number between 0 and 65535Network identification

Enter the SID number displayed with the CLI
show modem wireless interface cl-0/0/8 network
command.

Number between 0 and 32767System identification

Enter the user name supplied by the service
provider.

User nameSimple IP password

Enter the password supplied by the service
provider.

PasswordSimple IP user ID

Related Topics

■ Configuring the GSM Profile on page 368

Configuring the Dialer Interface

Before You Begin

For background information, read “Understanding the Dialer Interface” on page 360.

In this example, you configure the dialer interface dl0, specifying PPP encapsulation,
dialer pool 1, dial string 14691, and the negotiate address option for the interface
IP address.

You can use either J-Web or the CLI configuration editor to configure the dialer
interface.

This topic covers:

■ J-Web Configuration on page 365

■ CLI Configuration on page 366

■ Related Topics on page 366

J-Web Configuration

To configure a dialer interface:
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1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Next to Interface, click Add new entry.

4. In the Interface name box, type dl0.

5. In the Description box, type 3g-wireless.

6. Click OK.

7. Under Interface, click the Interface name dl0.

8. From the Encapsulation list, select ppp.

9. Next to Unit, click Add new entry.

10. In the Interface unit number box, type 0.

NOTE: You can only specify 0 for the unit.

11. Next to Dialer options, select Yes and then click Configure.

12. In the Pool box, type 1.

13. Next to Dial string, click Add new entry.

14. In the Dial string box, type 14691.

15. Click OK until you return to the Unit page.

16. Select Inet under Family, and click Configure.

17. Select Yes for Negotiate address.

18. Click OK.

CLI Configuration

To configure a dialer interface:

user@host# set interfaces dl0 description 3g-wireless encapsulation ppp unit 0
dialer-options pool 1 dial-string 14691

user@host# set interfaces dl0 unit 0 family inet negotiate-address

Related Topics

■ Configuring the 3G Wireless Modem Interface—Quick Configuration on page 363

■ Configuring the 3G Wireless Modem Interface on page 367

366 ■ Configuring the Dialer Interface

JUNOS Software Interfaces and Routing Configuration Guide



Configuring the 3G Wireless Modem Interface

Before You Begin

Configure a dialer interface, as described in “Configuring the Dialer Interface” on page 365.

In this example, you configure the physical interface for the 3G wireless modem to
use the dialer pool 1 (previously configured for the dialer interface) and a priority for
the dialer pool of 25. You also configure a modem initialization string to set the
modem to autoanswer after two rings.

You can use either J-Web or the CLI configuration editor to configure the 3G wireless
modem interface.

This topic covers:

■ J-Web Configuration on page 367

■ CLI Configuration on page 367

■ Related Topics on page 368

J-Web Configuration

To configure the dialer pool for the 3G wireless modem interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, click the cl-0/0/8 interface name.

4. Next to Dialer options, select Yes and then click Configure.

5. Next to Pool, click Add new entry.

6. In the Pool identifier box, type 1.

7. In the Priority box, type 25.

8. Click OK until you return to the Interface page.

To configure modem options for the 3G wireless modem interface:

1. On the Interface page, next to Modem options, click Configure.

2. In the Init command string box, type ATSO=2\n to configure the modem to
autoanswer after two rings.

3. Click OK.

CLI Configuration

To configure the dialer pool for the 3G wireless modem interface:
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user@host# set interfaces cl-0/0/8 dialer-options pool 1 priority 25

To configure modem options for the 3G wireless modem interface:

user@host# set interfaces cl-0/0/8 modem-options init-command-string “ATSO=2\n”

Related Topics

■ (Optional) “Configuring CHAP on the Dialer Interface” on page 371

■ (Optional) “Configuring PAP on the Dialer Interface” on page 370

■ (Optional) “Configuring the Dialer Interface as a Backup WAN Connection” on
page 373

■ (Optional) “Configuring Dialer Watch for the 3G Wireless Modem Interface” on
page 374

■ (Optional) “Configuring Dialer Filter for the 3G Wireless Modem Interface” on
page 375

■ (Optional) “Configuring the GSM Profile” on page 368

Configuring the GSM Profile

This topic describes the configuration of the GSM profile for use with service provider
networks such as AT&T and T-Mobile.

Before You Begin

For background information, read “Understanding the GSM Profile” on page 361 and “Configuring
the 3G Wireless Modem Interface” on page 367.

In this example, the following information provided by the service provider is
configured in a GSM profile jnpr that is associated with the 3G wireless modem
physical interface cl-0/0/8:

■ Username—juniper99

■ Password—1@#6ahgfh

■ Access point name (APN)—apn.service.com

■ Authentication method—CHAP

You also need to configure a CHAP profile with the specified username and password
for the dialer interface. See “Configuring CHAP on the Dialer Interface” on page 371.

You can use either J-Web or the CLI configuration editor to configure the information
required to activate the GSM 3G wireless modem card.
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This topic covers:

■ J-Web Configuration on page 369

■ CLI Configuration on page 369

■ Related Topics on page 370

J-Web Configuration

To configure a GSM profile for the 3G wireless modem interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. For cl-0/0/8, click Edit.

4. Next to Cellular options, click Yes and then click Configure.

5. Next to GSM options, click Yes and then click Configure.

6. Next to Profiles, click Add new entry.

7. In the Profile name box, type jnpr.

8. In the Access point name box, type apn.service.com.

9. In the Authentication method list, select chap.

10. In the Sip user id box, type juniper99.

11. In the Sip password box, type 1@#6ahgfh.

12. Click OK to return to the GSM options page.

To designate the GSM profile you just configured as the active profile:

1. On the GSM options page, in Select profile, select jnpr.

2. Click OK to return to the Cellular options page.

3. Click OK.

CLI Configuration

To configure a GSM profile for the 3G wireless modem interface:

user@host> request modem wireless gsm create-profile profile-id 1 sip-user-id
juniper99 sip-password 16ahgfh access-point-name apn.service.com
authentication-method chap

To designate the GSM profile you just configured as the active profile:

user@host# set interface cl-0/0/8 cellular-options gsm-options select-profile profile-id
1
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Related Topics

■ Unlocking the GSM 3G Wireless Modem on page 381

Configuring PAP on the Dialer Interface

With GSM HSDPA 3G wireless modem cards, you may need to configure either
Challenge Handshake Authentication Protocol (CHAP) or Password Authentication
Protocol (PAP) for authentication with the service provider network. The service
provider must supply the username and password, which you configure in an access
profile. You then specify this access profile in a dialer interface.

Before You Begin

Configure a dialer interface. See “Configuring the Dialer Interface” on page 365.

In this example, you configure the username and password in the PAP access profile
pap-1, then associate the pap-1 profile with the dialer interface dl0.

You can use either J-Web or the CLI configuration editor to configure the PAP access
profile.

This topic covers:

■ J-Web Configuration on page 370

■ CLI Configuration on page 371

■ Related Topics on page 371

J-Web Configuration

To configure a PAP access profile:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Access, click Configure or Edit.

3. Next to Profile, click Add new entry.

4. In the Profile name box, type pap-1.

5. Next to Client, click Add new entry.

6. In the Name box, type clientX.

7. In the Pap password box, type \&7a^6b%5c.

8. Click OK until you return to the main Configuration page.

To associate the PAP access profile with a dialer interface:
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1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name box, click dl0.

4. In the Interface unit number box, click 0.

5. Next to Ppp options, click Configure.

6. Next to Pap, click Configure.

7. In the Access profile box, type pap-1.

8. Click OK until you return to the main Configuration page.

CLI Configuration

To configure a PAP access profile:

user@host# set access profile pap-1 client clientX pap-password &7a^6b%5c

To associate the PAP access profile with a dialer interface:

user@host# set interfaces dl0 unit 0 ppp-options pap access-profile pap-1

Related Topics

■ Configuring CHAP on the Dialer Interface on page 371

Configuring CHAP on the Dialer Interface

With GSM HSDPA 3G wireless modem cards, you may need to configure either
Challenge Handshake Authentication Protocol (CHAP) or Password Authentication
Protocol (PAP) for authentication with the service provider network. The service
provider must supply the username and password, which you configure in an access
profile. You then specify this access profile in a dialer interface.

Before You Begin

Configure a dialer interface. See “Configuring the Dialer Interface” on page 365.

In this example, you configure the username and password in the CHAP access
profile chap-1, then associate the chap-1 profile with the dialer interface dl0.

You can use either J-Web or the CLI configuration editor to configure the CHAP access
profile.
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This topic covers:

■ J-Web Configuration on page 372

■ CLI Configuration on page 372

■ Related Topics on page 373

J-Web Configuration

To configure a CHAP access profile:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Access, click Configure or Edit.

3. Next to Profile, click Add new entry.

4. In the Profile name box, type chap-1.

5. Next to Client, click Add new entry.

6. In the Name box, type clientX.

7. In the Chap secret box, type \&7a^6b%5c.

8. Click OK until you return to the main Configuration page.

To associate the CHAP access profile with a dialer interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name box, click dl0.

4. In the Interface unit number box, click 0.

5. Next to Ppp options, click Configure.

6. Next to Chap, click Configure.

7. In the Access profile box, type chap-1.

8. Click OK until you return to the main Configuration page.

CLI Configuration

To configure a CHAP access profile:

user@host# set access profile chap-1 client clientX chap-secret &7a^6b%5c

To associate the CHAP access profile with a dialer interface:

user@host# set interfaces dl0 unit 0 ppp-options chap access-profile chap-1
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Related Topics

■ Configuring PAP on the Dialer Interface on page 370

Configuring the Dialer Interface as a Backup WAN Connection

Before You Begin

1. For background information, read “Understanding the Dialer Interface” on page 360.

2. Configure a dialer interface. See “Configuring the Dialer Interface” on page 365.

In this example, you configure the dialer interface dl0 as the backup WAN link for
the ge-0/0/1.0 interface.

You can use either J-Web or the CLI configuration editor to configure the backup
interface.

This topic covers:

■ J-Web Configuration on page 373

■ CLI Configuration on page 373

■ Related Topics on page 374

J-Web Configuration

To configure a dialer interface as a backup to a primary interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, click ge-0/0/1.

4. Under Unit, click the Interface unit number 0.

5. Next to Backup options, click Configure.

6. In the Interface box, type dl0.

7. Click OK until you return to the Interfaces page.

CLI Configuration

To configure a dialer interface as a backup to a primary interface:

user@host# set interfaces ge-0/0/1.0 unit 0 backup-options interface dl0
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Related Topics

■ Configuring Dialer Watch for the 3G Wireless Modem Interface on page 374

■ Configuring Dialer Filter for the 3G Wireless Modem Interface on page 375

Configuring Dialer Watch for the 3G Wireless Modem Interface

Before You Begin

1. For background information, read “Understanding the Dialer Interface” on page 360.

2. Configure a dialer interface. See “Configuring the Dialer Interface” on page 365.

In this example, you configure dialer watch to enable the device to monitor the route
to the head office router at 200.200.201.1/32.

You can use either J-Web or the CLI configuration editor to configure dialer watch.

This topic covers:

■ J-Web Configuration on page 374

■ CLI Configuration on page 374

■ Related Topics on page 375

J-Web Configuration

To create a dialer watch list:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Next to Interface name, select dl0.

4. Under Unit, click the Interface unit number 0.

5. Next to Dialer options, click Yes. Click Configure.

6. In the Pool box, type dw-pool.

7. Next to Watch list, click Add new entry.

8. In the Prefix box, type 200.200.201.1/32.

9. Click OK.

CLI Configuration

To create a dialer watch list:
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user@host# set interfaces dl0 description dialer-watch unit 0 dialer-options watch-list
200.200.201.1/32

user@host# set interfaces dl0 description dialer-watch unit 0 dialer-options pool
dw-pool

Related Topics

■ Configuring Dialer Filter for the 3G Wireless Modem Interface on page 375

■ Configuring the Dialer Interface as a Backup WAN Connection on page 373

Configuring Dialer Filter for the 3G Wireless Modem Interface

Before You Begin

1. For background information, read “Understanding the Dialer Interface” on page 360.

2. Configure a dialer interface. See “Configuring the Dialer Interface” on page 365.

In this example, you configure a dialer filter firewall rule for traffic from the branch
office to the main office router. In this example, the branch office router has the IP
address 20.20.90.4/32 and the main office router has the IP address
200.200.201.1/32.

You can use either J-Web or the CLI configuration editor to configure dialer filter.

This topic covers:

■ J-Web Configuration on page 375

■ CLI Configuration on page 376

■ Related Topics on page 376

J-Web Configuration

To create a dialer filter:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Firewall, click Configure or Edit.

3. Next to Inet, click Configure.

4. Next to Dialer filter, click Add new entry.

5. In the Filter name box, type corporate-traffic-only.

6. Next to Term, click Add new entry.

7. In the Rule name box, type term1.

8. Next to From, click Configure.

9. Next to Address, click Add new entry.
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10. In the Address box, type 20.20.90.4/32.

11. Click OK.

12. Next to Destination address, click Add new entry.

13. In the Address box, type 200.200.201.1/32.

14. Click OK.

15. Click OK to return to the Firewall page.

16. Next to Then, click Configure.

17. From the Designation list, select Note.

18. Click OK.

To associate the dialer filter with a dialer interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, click dl0.

4. Under Unit, click the Interface unit number 0.

5. In the Family section, next to Inet, click Edit.

6. Next to Filter, click Configure.

7. In the Dialer box, type corporate-traffic-only, the dialer filter configured previously.

8. Click OK.

CLI Configuration

To create a dialer filter:

user@host# set firewall family inet dialer-filter corporate-traffic-only term term1 from
source-address 20.20.90.4/32 destination-address 200.200.201.1/32 then note

To associate the dialer filter with a dialer interface:

user@host# set interfaces dl0 unit 0 family inet filter dialer corporate-traffic-only

Related Topics

■ Configuring Dialer Watch for the 3G Wireless Modem Interface on page 374

■ Configuring the Dialer Interface as a Backup WAN Connection on page 373

Understanding Account Activation for CDMA EV-DO Cards

Account activation is the process of enabling the CDMA EV-DO wireless modem card
to connect to your service provider’s cellular network. This is a one-time process
where your subscriber information is saved in nonvolatile memory on the card. The
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procedure you use to perform account activation depends upon the the service
provider network.

Before activating an account, you can verify the signal strength on the 3G wireless
modem interface by using the show modem wireless interface cl-0/0/8 rssi command.
The signal strength should be at least -90 dB and preferably better than -80 dB (-125
dB indicates nil signal strength). If the signal strength is below -90 dB, activation may
not be possible from that location. For example:

user@host> show modem wireless interface cl-0/0/8 rssi
Current Radio Signal Strength (RSSI) = -98 dBm

The service provider requires the electronic serial number (ESN) of the 3G wireless
modem card to activate your account and to generate the necessary information you
need to activate the card. You can obtain the ESN number of the modem card in the
following ways:

■ Inspect the modem card itself; the ESN is printed on the card.

■ Use the CLI show modem wireless interface cl-0/0/8 firmware command, as shown
in the following example, and note the value for the Electronic Serial Number
(ESN) field:

user@host> show modem wireless interface cl-0/0/8 firmware

Modem Firmware Version : p2005600

Modem Firmware built date : 12-09-07

Card type : Aircard 597E - CDMA EV-DO revA 

Manufacturer : Sierra Wireless, Inc.

Hardware Version : 1.0 

Electronic Serial Number (ESN) : 0x6032688F 

Preferred Roaming List (PRL) Version : 20224 

Supported Mode : 1xev-do rev-a, 1x 

Current Modem Temperature : 32 degrees Celsius

Modem Activated : YES 

Activation Date: 2-06-08 

Modem PIN Security : Unlocked 

Power-up lock : Disabled

For the CDMA EV-DO 3G wireless modem card, account activation can be done
through one or more of the following modes:

■ Over the air service provisioning (OTASP)—protocol for programming phones
over the air using Interim Standard 95 (IS-95) Data Burst Messages.

To activate the 3G wireless modem card with OTASP, you need to obtain from
the service provider the dial number that the modem will use to contact the
network. Typically, OTASP dial numbers begin with the feature code *228 to
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indicate an activation call type to the cellular network's base transceiver station,
followed by additional digits specified by the service provider.

■ Internet-based over the air (IOTA) provisioning—method for programming phones
for voice and data services

■ Manually providing the required information by entering in a CLI operational
mode command

Sprint uses manual and IOTA activation, whereas Verizon uses only OTASP.

NOTE: The 3G wireless modem is set into Single-Carrier Radio Transmission
Technology (1xRTT) mode automatically when it is activated for Verizon networks.

Related Topics

■ Activating the CDMA EV-DO Modem Card with OTASP Provisioning on page 378

■ Activating the CDMA EV-DO Modem Card Manually on page 379

■ Activating the CDMA EV-DO Modem Card with IOTA Provisioning on page 380

Activating the CDMA EV-DO Modem Card with OTASP Provisioning

This topic describes the activation of the CDMA EV-DO 3G wireless modem card for
use with service provider networks such as Verizon.

Before You Begin

Before you can activate the 3G wireless modem card, you need to obtain from the service provider
the dial number that the modem will use to contact the network.

The service provider must activate your account before OTASP provisioning can proceed.

Use the CLI operational mode command to activate the 3G wireless modem card.

In this example, the dial number from the service provider is *22864.

CLI Operational Mode Command

To activate the CDMA EV-DO 3G wireless modem card with OTASP provisioning:

user@host> request modem wireless interface cl-0/0/8 activate otasp dial-string
*22864
OTASP number *22286*, Selecting NAM 0 
Beginning OTASP Activation. It can take up to 5 minutes 
Please check the trace logs for details.

To check the trace log for account activation details:

378 ■ Activating the CDMA EV-DO Modem Card with OTASP Provisioning

JUNOS Software Interfaces and Routing Configuration Guide



user@host> tail -f /var/log/wwand.log
Jun 25 04:42:55: OTASP cl-0/0/8 OTA SPL unlock... Success 
Jun 25 04:43:42: OTASP cl-0/0/8 OTA PRL download... Success 
Jun 25 04:43:55: OTASP cl-0/0/8 OTA Profile downloaded... Success 
Jun 25 04:43:58: OTASP cl-0/0/8 OTA MDN download... Success 
Jun 25 04:44:04: OTASP cl-0/0/8 Committing OTA Parameters to NVRAM... Success 
Jun 25 04:44:45: Over the air provisioning... Complete

Activating the CDMA EV-DO Modem Card Manually

Manual activation stores the supplied values into the 3G wireless modem card's
nonvolatile memory. This topic describes the activation of the CDMA EV-DO 3G
wireless modem card for use with service provider networks such as Sprint.

Before You Begin

The service provider must activate your account before you can activate the CDMA EV-DO 3G
wireless modem card.

Using the electronic serial number (ESN) you provided and your account information,
the service provider supplies you with the following information for manual activation
of the 3G wireless modem card:

■ Master subsidy lock (MSL)—activation code

■ Mobile directory number (MDN)—10-digit user phone number

■ International mobile station identify (IMSI)—Mobile subscriber information

■ Simple IP user identification (SIP-ID)—Username

■ Simple IP password (SIP-Password)—Password

You also need to obtain the following information from the 3G wireless modem card
itself for the activation:

■ System identification (SID)—Number between 0 and 32767

■ Network identification (NID)—Number between 0 and 65535

Use the CLI show modem wireless interface cl-0/0/8 network command to display the
SID and NID, as shown in the following example:

user@host> show modem wireless interface cl-0/0/8 network
Running Operating mode : 1xEV-DO (Rev A) and 1xRTT
Call Setup Mode : Mobile IP only 
System Identifier (SID) : 3421 
Network Identifier (NID) : 91 
Roaming Status(1xRTT) : Home 
Idle Digital Mode : HDR 
System Time : Wed Jun6 15:16:9 2008

Use the CLI operational mode command to manually activate the 3G wireless modem
card.
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This example uses the following values for manual activation:

■ MSL (from service provider)—43210

■ MDN (from service provider)—0123456789

■ IMSI (from service provider)—0123456789

■ SIP-ID (from service provider)—jnpr

■ SIP-Password (from service provider)—jn9rl

■ SID (from modem card)—12345

■ NID (from modem card)—12345

CLI Operational Mode Command

To activate the CDMA EV-DO 3G wireless modem card manually:

user@host> request modem wireless interface cl-0/0/8 activate manual msl 43210
mdn 0123456789 imsi 0123456789 sid 12345 nid 12345 sip-id jnpr sip-password jn9rl
Checking status... 
Modem current activation status: Not Activated 
Starting activation... 
Performing account activation step 1/6 : [Unlock] Done 
Performing account activation step 2/6 : [Set MDN] Done 
Performing account activation step 3/6 : [Set SIP Info] Done 
Performing account activation step 4/6 : [Set IMSI] Done 
Performing account activation step 5/6 : [Set SID/NID] Done 
Performing account activation step 6/6 : [Commit/Lock] Done
Configuration Commit Result: PASS 
Resetting the modem ... Done 
Account activation in progress. It can take up to 5 minutes
Please check the trace logs for details.

To check the trace log for account activation details:

user@host> tail -f /var/log/wwand.log
Jun 25 04:42:55: IOTA cl-0/0/8 Event: IOTA Start... Success 
Jun 25 04:43:45: IOTA cl-0/0/8 OTA SPL unlock...  Success 
Jun 25 04:43:56: IOTA cl-0/0/8 Committing OTA Parameters to NVRAM... Success 
Jun 25 04:44:02: IOTA cl-0/0/8 Over the air provisioning... Complete 
Jun 25 04:44:04: IOTA cl-0/0/8 IOTA Event: IOTA End... Success

Related Topics

■ Activating the CDMA EV-DO Modem Card with IOTA Provisioning on page 380

Activating the CDMA EV-DO Modem Card with IOTA Provisioning

Manual activation stores the supplied values in the 3G wireless modem card's
nonvolatile memory. If the modem card is reset or you need to update Mobile IP
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(MIP) parameters, use the CLI operational mode command to activate the modem
card with IOTA.

Before You Begin

Activate the CDMA EV-DO 3G wireless modem card. For information, see “Activating the CDMA
EV-DO Modem Card Manually” on page 379.

CLI Operational Mode Command

To activate the CDMA EV-DO 3G wireless modem card with IOTA:

user@host> request modem wireless interface cl-0/0/8 activate iota
Beginning IOTA Activation. It can take up to 5 minutes
Please check the trace logs for details.

To check the trace log for account activation details:

user@host> tail -f /var/log/wwand.log
Jun 25 04:42:55: IOTA cl-0/0/8 Event: IOTA Start... Success 
Jun 25 04:43:45: IOTA cl-0/0/8 OTA SPL unlock...  Success 
Jun 25 04:43:56: IOTA cl-0/0/8 Committing OTA Parameters to NVRAM... Success 
Jun 25 04:44:02: IOTA cl-0/0/8 Over the air provisioning... Complete 
Jun 25 04:44:04: IOTA cl-0/0/8 IOTA Event: IOTA End... Success

Unlocking the GSM 3G Wireless Modem

The subscriber identity module (SIM) in the GSM 3G wireless modem card is a
detachable smart card. Swapping out the SIM allows you to change the service
provider network, however some service providers lock the SIM to prevent
unauthorized access to the service provider's network. If this is the case, you will
need to unlock the SIM by using an personal identification number (PIN), a four-digit
number provided by the service provider.

Before You Begin

Obtain the PIN from the service provider.

Use the CLI operational mode command to unlock the SIM on the GSM 3G wireless
modem card.

This example uses the PIN 3210 from the service provider.

To unlock the SIM on the GSM 3G wireless modem card:

user@host> request modem wireless gsm sim-unlock cl-0/0/8 pin 3210

A SIM is blocked after three consecutive failed unlock attempts; this is a security
feature to prevent brute force attempts to unlock the SIM. When the SIM is blocked,
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you need to unblock the SIM with an eight-digit PIN unlocking key (PUK) obtained
from the service provider.

Use the CLI operational mode command to unblock the SIM.

This example uses the PUK 76543210 from the service provider.

To unblock the SIM:

user@host> request modem wireless gsm sim-unblock cl-0/0/8 puk 76543210

NOTE: If you enter the PUK incorrectly ten times, you will need to return the SIM to
the service provider for reactivation.
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Chapter 13

Configuring USB Modems for Dial Backup

You can configure your device to “fail over” to a USB modem connection when the
primary Internet connection experiences interruption.

NOTE: Low-latency traffic such as VoIP traffic is not supported over USB modem
connections.

NOTE: We recommend using a US Robotics USB 56k V.92 Modem, model number
USR Model 5637.

You use either the J-Web configuration editor or CLI configuration editor to configure
the USB modem for dial backup.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter includes the following topics:

■ USB Modem Terms on page 383

■ USB Modem Interface Overview on page 384

■ Before You Begin on page 385

■ Connecting the USB Modem to the Device's USB Port on page 385

■ Configuring USB Modems for Dial Backup with a Configuration Editor on page 386

USB Modem Terms

Before configuring USB modems and their supporting dialer interfaces, become
familiar with the terms defined in Table 102 on page 384.
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Table 102: USB Modem Terminology

DefinitionTerm

Telephone number of the caller on the remote end of a backup USB modem connection, used
to dial in and also to identify the caller. Multiple caller IDs can be configured on a dialer interface.
During dial-in, the device matches the incoming call's caller ID against the caller IDs configured
on its dialer interfaces. Each dialer interface accepts calls from only callers whose caller IDs are
configured on it.

caller ID

Feature that reestablishes network connectivity through one or more backup dialer interfaces
after a primary interface fails. When the primary interface is reestablished, the USB modem
backup is disconnected.

dial backup

Logical interface for configuring dialing properties and the control interface for a backup USB
modem connection.

dialer interface

Set of characteristics configured for the USB modem dialer interface. Dialer profiles allow the
configuration of physical interfaces to be separated from the logical configuration of dialer
interfaces required for USB modem connectivity. This feature also allows physical and logical
interfaces to be bound together dynamically on a per-connection basis.

dialer profile

Feature that enables devices to receive calls from the remote end of a backup USB modem
connection. The remote end of the USB modem call might be a service provider, a corporate
central location, or a customer premises equipment (CPE) branch office. All incoming calls can
be verified against caller IDs configured on the device's dialer interface.

dial-in

USB Modem Interface Overview

You configure two types of interfaces for USB modem connectivity: a physical
interface and a logical interface called the dialer interface:

■ The USB modem physical interface uses the naming convention umd0. The device
creates this interface when a USB modem is connected to the USB port.

■ The dialer interface, dln, is a logical interface for configuring dialing properties
for USB modem connections. The dialer interface can be configured using
Point-to-Point Protocol (PPP) encapsulation. You can also configure the dialer
interface to support authentication protocols—PPP Challenge Handshake (CHAP)
or Password Authentication Protocol (PAP).

For information about interface names, see “Interface Naming Conventions” on
page 9.

The USB modem provides a dial-in remote management interface, and supports
dialer interface features by sharing the same dial pool as a dialer interface. The dial
pool allows the logical dialer interface and the physical interface to be bound together
dynamically on a per-call basis. You can configure the USB modem to operate either
as a dial-in console for management or as a dial-in WAN backup interface.

The following rules apply when you configure dialer interfaces for USB modem
connections:
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■ The dialer interface must be configured to use PPP encapsulation. You cannot
configure Cisco High-Level Data Link Control (HDLC) or Multilink PPP (MLPPP)
encapsulation on dialer interfaces.

■ The dialer interface cannot be configured as a constituent link in a multilink
bundle. For information about configuring multilink bundles, see “Configuring
Link Services Interfaces” on page 399.

■ The dialer interface can perform backup, dialer filter, and dialer watch functions,
but these operations are mutually exclusive. You can configure a single dialer
interface to operate in only one of the following ways:

■ As a backup interface—for one primary interface

■ As a dialer filter

■ As a dialer watch interface

Before You Begin

Before you configure USB modems, you need to perform the following tasks:

■ Install device hardware. For more information, see the Getting Started Guide for
your device.

■ Establish basic connectivity. For more information, see the Getting Started Guide
for your device.

■ Order a US Robotics USB 56k V.92 Modem, model number USR Model 5637
from US Robotics (http://www.usr.com/).

■ Order a public switched telephone network (PSTN) line from your
telecommunications service provider. Contact your service provider for more
information.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

Connecting the USB Modem to the Device's USB Port

NOTE: J Series devices have two USB ports. However, you can connect only one USB
modem to the USB ports on these devices. If you connect USB modems to both ports,
the device detects only the first modem connected.

NOTE: When you connect the USB modem to the USB port on the device, the USB
modem is initialized with the modem initialization string configured for the USB
modem interface on the device.

To connect the USB modem to the USB port on the device:
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1. Plug the modem into the USB port.

2. Connect the modem to your telephone network.

Configuring USB Modems for Dial Backup with a Configuration Editor

To configure USB modem interfaces, perform the following tasks.

■ Configuring a USB Modem Interface for Dial Backup on page 386

■ Configuring a Dialer Interface for USB Modem Dial Backup on page 387

■ Configuring Dial-In for a USB Modem Connection on page 394

■ Configuring PAP on Dialer Interfaces (Optional) on page 396

■ Configuring CHAP on Dialer Interfaces (Optional) on page 397

Configuring a USB Modem Interface for Dial Backup

To configure a USB modem interface for the device:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 103 on page 386.

3. Go on to “Configuring a Dialer Interface for USB Modem Dial Backup” on page 387.

Table 103: Configuring a USB Modem Interface for Dial Backup

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces umd0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

Navigate to the Interfaces  level in the
configuration hierarchy.

1. Next to Interface, click Add new
entry.

2. In the Interface name box, type the
name of the new interface, umd0.

3. Click OK.

Create the new interface umd0.
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Table 103: Configuring a USB Modem Interface for Dial Backup (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set dialer-options pool
usb-modem-dialer-pool priority 25

1. In the Encapsulation column, next
to the new interface, click Edit.

2. Next to Dialer options, select Yes,
and then click Configure.

3. Next to Pool, click Add new entry.

4. In the Pool identifier box, type
usb-modem-dialer-pool.

5. In the Priority box, type 25.

6. Click OK until you return to the
Interface page.

Configure dialer options.

■ Name the dialer pool configured on
the dialer interface you want to use
for USB modem connectivity—for
example, usb-modem-dialer-pool. For
more information, see “Configuring
a Dialer Interface for USB Modem
Dial Backup” on page 387.

■ Set the dialer pool priority—for
example, 25.

Dialer pool priority has a range from 1
to 255, with 1 designating
lowest-priority interfaces and 255
designating the highest-priority
interfaces.

Enter

set modem-options init-command-string
"ATS0=2 \n"

1. Next to Modem options, click
Configure.

2. In the Init command string box,
type ATS0=2 \n to configure the
modem to autoanswer after two
rings.

Configure the modem to automatically
answer (autoanswer) calls after a
specified number of rings.

NOTE: The default modem initialization
string is AT S7=45 S0=0 V1 X4 &C1 E0
Q0 &Q8 %C0. The modem command
S0=0 disables the modem from
autoanswering calls.

Enter

set modem-options dialin routable

1. On the Modem options page, in the
Dialin box, select routable.

2. Click OK.

Configure the modem to act as a dial-in
WAN backup interface.

Configuring a Dialer Interface for USB Modem Dial Backup

The dialer interface (dl) is a logical interface configured to establish USB modem
connectivity. You can configure multiple dialer interfaces for different functions on
the device.

After configuring the dialer interface, you must configure a backup method—either
dialer backup, a dialer filter, or dialer watch.

For example, suppose you have a branch office router and a head office router each
with a USB modem interface and a dialer interface. To establish a backup connection
between the branch office and head office routers, you can configure them as
described in Table 104 on page 388.
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Table 104: Configuring Branch Office and Head Office Routers for USB Modem Backup Connectivity

InstructionsConfiguration RequirementRouter Location

■ To configure the logical dialer
interface, see Table 105 on
page 388.

■ To configure dl0 as a backup for
t1-1/0/0 see “Configuring Dial
Backup for a USB Modem
Connection” on page 390.

■ To configure a dialer filter on dl0,
see “Configuring a Dialer Filter for
USB Modem Dial Backup” on
page 391.

■ To configure a dialer watch on dl0,
see “Configuring Dialer Watch for
USB Modem Dial Backup” on
page 393.

1. Configure the logical dialer interface on
the branch office router for USB modem
dial backup.

2. Configure the dialer interface dl0 in one
of the following ways on the branch
office router:

■ Configure the dialer interface dl0
as the backup interface on the
branch office router's primary T1
interface t1-1/0/0.

■ Configure a dialer filter on the
branch office router's dialer
interface.

■ Configure a dialer watch on the
branch office router's dialer
interface.

Branch Office

To configure dial-in on the head office
router, see “Configuring Dial-In for a USB
Modem Connection” on page 394.

Configure dial-in on the dialer interface dl0
on the head office router.

Head Office

To configure a logical dialer interface for USB modem dial backup:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 105 on page 388.

3. To configure a backup method, go on to one of the following tasks:

■ Configuring Dial Backup for a USB Modem Connection on page 390

■ Configuring a Dialer Filter for USB Modem Dial Backup on page 391

■ Configuring Dialer Watch for USB Modem Dial Backup on page 393

Table 105: Adding a Dialer Interface for USB Modem Dial Backup

CLI Configuration Editor
J-Web Configuration
EditorTask

From the [edit] hierarchy
level, enter

edit interfaces

1. In the J-Web
interface, select
Configure>CLI
Tools>Point and
Click CLI.

2. Next to Interfaces,
click Configure or
Edit.

Navigate to the Interfaces  level in the configuration hierarchy.
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Table 105: Adding a Dialer Interface for USB Modem Dial Backup (continued)

CLI Configuration Editor
J-Web Configuration
EditorTask

Create and name the
interface:

1. edit dl0

2. set description
USB-modem-backup

1. Next to Interface,
click Add new
entry.

2. In the Interface
name box, type
dl0.

3. In the Description
box, type
USB-modem-backup.

4. Click OK.

Create the new interface—for example, dl0.

Adding a description can differentiate between different dialer
interfaces—for example, USB-modem-backup.

Enter

set encapsulation ppp

1. In the
Encapsulation
column, next to the
new interface, click
Edit.

2. From the
Encapsulation list,
select ppp.

Configure Point-to-Point Protocol (PPP) encapsulation.

NOTE: You cannot configure Cisco High-Level Data Link Control (HDLC)
or Multilink PPP (MLPPP) encapsulation on dialer interfaces used in USB
modem connections.

Enter

set unit 0

1. Next to Unit, click
Add new entry.

2. In the Interface unit
number box, type
0.

3. Next to Dialer
options, select Yes,
and then click
Configure.

Create the logical unit 0.

NOTE: You can set the logical unit to 0 only.
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Table 105: Adding a Dialer Interface for USB Modem Dial Backup (continued)

CLI Configuration Editor
J-Web Configuration
EditorTask

1. Enter

edit unit 0
dialer-options

2. Enter

set activation-delay
60

3. Enter

set
deactivation-delay
30

4. Enter

set idle-timeout 30
initial-route-check 30
pool
usb-modem-dialer-pool

1. In the Activation
delay box, type 60.

2. In the Deactivation
delay box, type 30.

3. In the Idle timeout
box, type 30.

4. In the Initial route
check box, type 30.

5. In the Pool box,
type
usb-modem-dialer-pool.

Configure dialer options.

■ Activation delay—Number of seconds to wait before activating
the backup USB modem interface after the primary interface is
down—for example, 30. The default value is 0 seconds, and the
maximum value is 60 seconds. Use this option only for dialer
backup and dialer watch.

■ Deactivation delay—Number of seconds to wait before deactivating
the backup USB modem interface after the primary interface is
up—for example, 30. The default value is 0 seconds, and the
maximum value is 60 seconds. Use this option only for dialer
backup and dialer watch.

■ Idle timeout—Number of seconds a connection is idle before
disconnecting—for example, 30. The default value is 120 seconds,
and the range is from 0 to 4294967295.

■ Initial route check—Number of seconds to wait before checking
if the primary interface is up—for example, 30. The default value
is 120 seconds, and the range is from 1 to 300 seconds.

■ Pool—Name of the dialer pool to use for USB modem
connectivity—for example, usb-modem-dialer-pool.

Enter

set dial-string 5551212

1. Next to Dial string,
click Add new
entry.

2. In the Dial string
box, type 5551212.

3. Click OK until you
return to the Unit
page.

Configure the telephone number of the remote destination to call if the
primary interface goes down—for example, 5551212.

1. From the [edit]
hierarchy level,
enter

edit interfaces dl0
unit 0

2. Enter

set family inet
address
172.20.10.2
destination
172.20.10.1

1. Select Inet under
Family, and click
Edit.

2. Next to Address,
click Add new
entry.

3. In the Source box,
type 172.20.10.2.

4. In the Destination
box, type
172.20.10.1.

5. Click OK.

Configure source and destination IP addresses for the dialer
interface—for example, 172.20.10.2 and 172.20.10.1.

NOTE: If you configure multiple dialer interfaces, ensure that the same
IP subnet address is not configured on different dialer interfaces.
Configuring the same IP subnet address on multiple dialer interfaces
can result in inconsistency in the route and packet loss. Packets can be
routed through any of the dialer interfaces with the IP subnet address,
instead of being routed through the dialer interface to which the USB
modem call is mapped.

Configuring Dial Backup for a USB Modem Connection

Dial backup allows one or more dialer interfaces to be configured as the backup link
for the primary serial interface. The backup dialer interfaces are activated only when
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the primary interface fails. USB modem backup connectivity is supported on all
interfaces except lsq-0/0/0.

To configure a primary interface for backup connectivity:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 106 on page 391.

3. If you are finished configuring the device, commit the configuration.

Table 106: Configuring a Primary Interface for USB Modem Dial Backup

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces t1-1/0/0 unit 0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

1. In the Interface name column, click
the physical interface name.

2. Under Unit, in the Interface unit
number column, click 0.

Select the physical interface for USB
modem USB modem backup
connectivity—for example, t1–1/0/0.

Enter

set backup-options interface dl0.0

1. Next to Backup options, click
Configure.

2. In the Interface box, type dl0.0.

3. Click OK until you return to the
Interfaces page.

Configure the backup dialer
interface—for instance, dl0.0.

Configuring a Dialer Filter for USB Modem Dial Backup

This dial-on-demand routing backup method allows a USB modem connection to be
activated only when network traffic configured as an “interesting packet” arrives on
the network. Once the network traffic is sent, an inactivity timer is triggered and the
connection is closed.

You define an interesting packet using the dialer filter feature of the device.

To configure dial-on-demand routing backup using a dialer filter, you first configure
the dialer filter and then apply the filter to the dialer interface.

To configure the dialer filter and apply it to the dialer interface:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 107 on page 392.
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3. Go on to Table 108 on page 392.

4. When you are finished configuring the device, commit the configuration.

Table 107: Configuring a Dialer Filter for USB Modem Dial Backup

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit firewall

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Firewall, click Edit.

Navigate to the Firewall level in the
configuration hierarchy.

1. Enter

edit family inet

2. Then enter

edit dialer-filter
interesting-traffic

1. Next to Inet, click Configure or Edit.

2. Next to Dialer filter, click Add new entry.

3. In the Filter name box, type
interesting-traffic.

Configure the dialer filter name—for example,
interesting-traffic.

1. Enter

edit term term1

2. Enter

set from
source-address
20.20.90.4/32

3. Enter

set from
destination-address
200.200.201.1/32

1. Next to Term, click Add new entry.

2. In the Rule name box, type term1.

3. Next to From, click Configure.

4. Next to Source address, click Add new
entry.

5. In the Address box, type 20.20.90.4/32.

6. Click OK.

7. Next to Destination address, click Add
new entry.

8. In the Address box, type
200.200.201.1/32.

9. Click OK until you return to the Term
page.

Configure the dialer filter rule name—for
example, term1.

Configure term behavior. For example, you
might want to configure the dialer filter to allow
only traffic between the branch office router
and the head office router over the backup USB
modem connection. In this example, the branch
office router has the IP address 20.20.90.4/32
and the head office router has the IP address
200.200.201.1/32.

To configure the term completely, include both
from and then statements.

Enter

set then note

1. Next to Then, click Configure.

2. From the Designation list, select Note.

3. Click OK.

Configure the then part of the dialer filter to
discard Telnet traffic between the branch office
router and the head office router.

Table 108: Applying the Dialer Filter to the Dialer Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level,
enter

edit interfaces dl0 unit 0

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in
the configuration hierarchy.
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Table 108: Applying the Dialer Filter to the Dialer Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. In the Interface name column, click dl0.

2. Under Unit, in the Interface unit number column,
click 0.

Select the dialer interface to apply
the filter—for example, dl0.

1. Enter

edit family inet filter

2. Enter

set dialer interesting-traffic

1. In the Family section, next to Inet, click Edit.

2. Next to Filter, click Configure.

3. In the Dialer box, type interesting-traffic, the dialer
filter configured in “Configuring the Dialer Filter”
on page 328.

4. Click OK.

Apply the dialer filter to the dialer
interface.

Configuring Dialer Watch for USB Modem Dial Backup

Dialer watch is a backup method that integrates backup dialing with routing
capabilities and provides reliable connectivity without relying on a dialer filter to
trigger outgoing USB modem connections. With dialer watch, the device monitors
the existence of a specified route and if the route disappears, the dialer interface
initiates the USB modem connection as a backup connection.

In this example, you configure dialer watch to enable the device to monitor the
existence of the route to the head office router and initiate USB modem backup
connectivity if the route disappears.

To configure dialer watch, you first add a dialer watch interface and then configure
the USB modem interface to participate as a dialer watch interface.

To configure a dialer watch:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 109 on page 393.

3. Go on to Table 110 on page 394.

4. When you are finished configuring the device, commit the configuration.

Table 109: Adding a Dialer Watch Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.
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Table 109: Adding a Dialer Watch Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. Enter

edit dl0

2. Enter

set description dialer-watch

1. Under Interface name, select dl0.

2. In the Description box, type
dialer-watch.

Select a dialer interface—for example,
dl0.

Adding a description, such as
dialer-watch, can help you identify one
dialer interface from another.

1. Enter

edit unit 0 dialer-options

2. Enter

set watch-list 200.200.201.1/32

1. Under Unit, click the logical unit
number 0.

2. Next to Dialer options, click Edit.

3. Next to Watch list, click Add new
entry.

4. In the Prefix box, type
200.200.201.1/32.

5. Click OK.

On a logical interface—for example,
0—configure the route to the head office
router for dialer watch—for example,
200.200.201.1/32.

Enter

set pool dw-pool

1. In the Pool box, type dw-pool.

2. Click OK.

Configure the name of the dialer pool to
use for dialer watch—for example,
dw-pool.

Table 110: Configuring a USB Modem Interface for Dialer Watch

CLI Configuration
EditorJ-Web Configuration EditorTask

From the [edit]
hierarchy level, enter

edit interfaces umd0
dialer-options pool
dw-pool

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

3. Under Interface name, click umd0.

Navigate to the Interfaces level in the configuration
hierarchy, and select the USB modem physical
interface umd0.

1. Next to Dialer options, click Edit.

2. Next to Pool, click Add new entry.

3. In the Pool identifier box, type
dw-pool.

4. Click OK.

Configure dialer watch options for the USB modem
interface participating in the dialer watch.

The USB modem interface must have the same pool
identifier to participate in dialer watch. Therefore, the
dialer pool name dw-pool, for the dialer watch interface
configured in Table 109 on page 393, is used when
configuring the USB modem interface.

Configuring Dial-In for a USB Modem Connection

You can configure a dialer interface to accept all incoming calls or accept only calls
from one or more caller IDs.
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If the dialer interface is configured to accept only calls from a specific caller ID, the
device matches the incoming call's caller ID against the caller IDs configured on its
dialer interfaces. If an exact match is not found and the incoming call's caller ID has
more digits than the configured caller IDs, the device performs a right-to-left match
of the incoming call's caller ID with the configured caller IDs and accepts the incoming
call if a match is found. For example, if the incoming call's caller ID is 4085321091
and the caller ID configured on a dialer interface is 5321091, the incoming call is
accepted. Each dialer interface accepts calls from only callers whose caller IDs are
configured on it.

To configure a dialer interface for USB modem dial-in:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 111 on page 395.

3. If you are finished configuring the device, commit the configuration.

Table 111: Configuring the Dialer Interface for USB Modem Dial-In

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces dl0

1. In the J-Web interface, select
Configure>CLI Tools>Point
and Click CLI.

2. Next to Interfaces, click Edit.

3. Next to dl0, click Edit.

Navigate to the Interfaces level in the
configuration hierarchy, and select a dialer
interface—for example, dl0.

1. Enter

edit unit 0

2. Enter

edit dialer-options

3. Enter

set incoming-map caller
4085551515

1. In the Unit section, for logical
unit number 0, click Dialer
options under Encapsulation.

2. Next to Incoming map, click
Configure.

3. From the Caller type menu,
select Caller.

4. Next to Caller, click Add new
entry.

5. In the Caller id box, type
4085551515.

On logical interface 0, configure the incoming
map options for the dialer interface.

■ accept-all—Dialer interface accepts all
incoming calls.

You can configure the accept-all option for
only one of the dialer interfaces associated
with a USB modem physical interface. The
dialer interface with the accept-all option
configured is used only if the incoming
call's caller ID does not match the caller
IDs configured on other dialer interfaces.

■ caller—Dialer interface accepts calls from
a specific caller ID—for example,
4085551515. You can configure a
maximum of 15 caller IDs per dialer
interface.

The same caller ID must not be configured
on different dialer interfaces. However,
you can configure caller IDs with more or
fewer digits on different dialer interfaces.
For example, you can configure the caller
IDs 14085551515, 4085551515, and
5551515 on different dialer interfaces.
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Configuring PAP on Dialer Interfaces (Optional)

You can configure dialer interfaces to support the Password Authentication Protocol
(PAP). PAP allows a simple method for a peer to establish its identity using a two-way
handshake during initial link establishment. After the link is established, an ID and
password pair is repeatedly sent by the peer to the authenticator until authentication
is acknowledged or the connection is terminated.

For more information about PAP, see the Junos Network Interfaces Configuration
Guide.

To configure PAP on the dialer interface, create an access profile and then configure
the dialer interface:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 112 on page 396.

3. If you are finished configuring the device, commit the configuration.

Table 112: Configuring PAP on Dialer Interfaces

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

set access profile pap-access-profile client
pap-access-user pap-password my-pap

1. On the main Configuration page
next to Access, click Configure or
Edit.

2. Next to Profile, click Add new
entry.

3. In the Profile name box, type
pap-access-profile.

4. Next to Client, click Add new
entry.

5. In the Name box, type
pap-access-user.

6. In the Pap-password box, type
my-pap.

7. Click OK until you return to the
main Configuration page.

Define a PAP access profile—for
example, pap-access-profile with a client
(username) named pap-access-user and
the PAP password my-pap.

From the [edit] hierarchy level, enter

edit interfaces dl0 unit 0

1. On the main Configuration page
next to Interfaces, click Configure
or Edit.

2. In the interface name box, click
dl0.

3. In the Interface unit number box,
click 0.

Navigate to the appropriate dialer
interface level in the configuration
hierarchy—for example, dl0 unit 0.
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Table 112: Configuring PAP on Dialer Interfaces (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set ppp-options pap local-name
pap-access-user local-password my-pap

1. Next to Ppp options, click
Configure.

2. Next to Pap, click Configure.

3. In the Local name box, type
pap-access-profile.

4. In the Local password box, type
my-pap.

5. Click OK.

Configure PAP on the dialer interface
and specify the local name and
password—for example,
pap-access-profile and my-pap.

Configuring CHAP on Dialer Interfaces (Optional)

You can optionally configure dialer interfaces to support the PPP Challenge Handshake
Authentication Protocol (CHAP). CHAP is a server-driven, three-step authentication
method that depends on a shared secret password residing on both the server and
the client. When you enable CHAP on a dialer interface, the device can authenticate
its peer and be authenticated by its peer.

For more information about CHAP, see the Junos Network Interfaces Configuration
Guide.

To configure CHAP on the dialer interface:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 113 on page 398.

3. If you are finished configuring the device, commit the configuration.
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Table 113: Configuring CHAP on Dialer Interfaces

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

set access profile
usb-modem-access-profile client
usb-modem-user chap-secret my-secret

1. On the main Configuration page
next to Access, click Configure or
Edit.

2. Next to Profile, click Add new
entry.

3. In the Profile name box, type
usb-modem-access-profile.

4. Next to Client, click Add new
entry.

5. In the Name box, type
usb-modem-user.

6. In the Chap secret box, type
my-secret.

7. Click OK until you return to the
main Configuration page.

Define a CHAP access profile—for
example, usb-modem-access-profile with
a client (username) named
usb-modem-user and the secret
(password) my-secret.

From the [edit] hierarchy level, enter

edit interfaces dl0 unit 0

1. On the main Configuration page
next to Interfaces, click Configure
or Edit.

2. In the interface name box, click
dl0.

3. In the Interface unit number box,
click 0.

Navigate to the appropriate dialer
interface level in the configuration
hierarchy—for example, dl0 unit 0.

Enter

set ppp-options chap access-profile
usb-modem-access-profile

1. Next to Ppp options, click
Configure.

2. Next to Chap, click Configure.

3. In the Access profile box, type
usb-modem-access-profile.

4. Click OK.

Configure CHAP on the dialer interface
and specify a unique profile name
containing a client list and access
parameters—for example,
usb-modem-access-profile.
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Chapter 14

Configuring Link Services Interfaces

Link services include the multilink services Multilink Point-to-Point Protocol (MLPPP),
Multilink Frame Relay (MLFR), and Compressed Real-Time Transport Protocol (CRTP).
J Series devices support link services on the lsq-0/0/0 link services interface.

You can use either J-Web Quick Configuration or a configuration editor to configure
the link services interface.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Link Services Terms on page 399

■ Link Services Interfaces Overview on page 400

■ Before You Begin on page 410

■ Configuring the Link Services Interface with Quick Configuration on page 410

■ Configuring the Link Services Interface with a Configuration Editor on page 413

■ Verifying the Link Services intelligent queuing Interface Configuration on page 431

■ Frequently Asked Questions About the Link Services Interface on page 439

Link Services Terms

Before configuring a link services interface, become familiar with the terms defined
in Table 114 on page 399.

Table 114: Link Services Terminology

DefinitionTerm

Protocol defined in RFC 2508 that compresses the size of IP, UDP, and
Real-Time Transport Protocol (RTP) headers and works with reliable
and fast point-to-point links for voice over IP (VoIP) traffic.

Compressed Real-Time Transport Protocol (CRTP)

Identifier for a Frame Relay virtual connection, also called a logical
interface.

data-link connection identifier (DLCI)
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Table 114: Link Services Terminology (continued)

DefinitionTerm

For MLFR with Frame Relay traffic or MLPPP with PPP traffic, a method
of reducing excessive delays by fragmenting long packets into smaller
packets and interleaving them with real-time frames. For example,
short delay-sensitive packets, such as those of packetized voice, can
race ahead of larger delay-insensitive packets, such as common data
packets.

link fragmentation and interleaving (LFI)

Capabilities on an interface that use Multilink Frame Relay (MLFR) and
Multilink Point-to-Point Protocol (MLPPP), link fragmentation and
interleaving (LFI), Compressed Real-Time Transport Protocol (CRTP),
and certain class-of-service (CoS) components to improve packet
transmission, especially for time-sensitive voice packets.

link services

Protocol that allows multiple Frame Relay links to be aggregated by
inverse multiplexing.

Multilink Frame Relay (MLFR)

Protocol that allows you to bundle multiple Point-to-Point Protocol (PPP)
links into a single logical unit. MLPPP improves bandwidth efficiency
and fault tolerance and reduces latency.

Multilink Point-to-Point Protocol (MLPPP)

Link-layer protocol defined in RFC 1661 that provides multiprotocol
encapsulation. PPP is used for link-layer and network-layer
configuration.

Point-to-Point Protocol (PPP)

In class of service (CoS) classification, a method of controlling the
maximum rate of traffic transmitted on an interface.

shaping rate

Link Services Interfaces Overview

You configure the link services queuing interface (lsq-0/0/0) on a J Series device to
support multilink services and Compressed Real-Time Transport Protocol (CRTP).

The link services interface on a J Series device consists of services provided by the
following interfaces on the Juniper Networks M Series and T Series routing platforms:
multilink services interface (ml-fpc/pic/port), link services interface (ls-fpc/pic/port),
and link services intelligent queuing interface (lsq-fpc/pic/port). Although the multilink
services, link services, and link services intelligent queuing (IQ) interfaces on M Series
and T Series routing platforms are installed on Physical Interface Cards (PICs), the
link services interface on a J Series device is an internal interface only and is not
associated with a physical medium or Physical Interface Module (PIM).

NOTE: (ls-fpc/pic/port) is not supported on J series and SRX platforms.

For information about interface names, see “Network Interface Naming” on page 9.

For more information about the link services interfaces, see the Junos Services
Interfaces Configuration Guide.
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This section contains the following topics.

■ Services Available on J Series Link Services Interface on page 401

■ Link Services Exceptions on J Series Services Routers on page 402

■ Multilink Bundles Overview on page 402

■ Link Fragmentation and Interleaving Overview on page 403

■ Compressed Real-Time Transport Protocol Overview on page 404

■ Configuring Fragmentation by Forwarding Class on page 405

■ Configuring Link-Layer Overhead on page 406

■ Configuring Multiclass MLPPP on page 407

■ Queuing with LFI on J Series Devices on page 409

■ Configuring CoS Components with LFI on page 409

Services Available on J Series Link Services Interface

On a J Series device, the link services interface is a logical interface available by
default. Table 115 on page 401 summarizes the services available on a J Series link
services interface.

Table 115: Services Available on J Series Link Services Interface

More InformationPurposeServices

■ Configuring an MLPPP Bundle on page 414

■ Configuring MLFR FRF.15 Bundles on
page 424

■ Configuring MLFR FRF.16 Bundles on
page 427

Aggregates multiple constituent links into one
larger logical bundle to provide additional
bandwidth, load balancing, and redundancy.

Multilink bundles by means
of MLPPP and MLFR
encapsulation

“Link Fragmentation and Interleaving
Overview” on page 403

Reduces delay and jitter on links by breaking
up large data packets and interleaving
delay-sensitive voice packets with the resulting
smaller packets.

Link fragmentation and
interleaving (LFI)

“Compressed Real-Time Transport Protocol
Overview” on page 404

Reduces the overhead caused by Real-Time
Transport Protocol (RTP) on voice and video
packets.

Compressed Real-Time
Transport Protocol (CRTP)
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Table 115: Services Available on J Series Link Services Interface (continued)

More InformationPurposeServices

■ Defining Classifiers and Forwarding
Classes on page 417

■ Defining and Applying Scheduler Maps on
page 420

■ Applying Shaping Rates to Interfaces on
page 423

■ Configuring Fragmentation by Forwarding
Class on page 405

■ Junos OS Class of Service Configuration
Guide for Security Devices

Provide a higher priority to delay-sensitive
packets—by configuring class of service (CoS)
components, such as the following:

■ Classifiers—To classify different type of
traffic, such as voice, data and network
control packets

■ Forwarding classes—To direct different
types of traffic to different output queues

■ Fragmentation map—To define mapping
between forwarding class and multilink
class, forwarding class and fragment
threshold. In forwarding class and
multilink class mapping, drop timeout can
be configured.

■ Schedulers and scheduler maps—To
define properties for the output queues
such as delay-buffer, transmission rate,
and transmission priority

■ Shaping rate—To define certain
bandwidth usage by an interface

Class-of-service (CoS)
classifiers, forwarding
classes, schedulers and
scheduler maps, and
shaping rates

Link Services Exceptions on J Series Services Routers

The link and multilink services implementation on a J Series Services Router is similar
to the implementation on the M Series and T Series routing platforms, with the
following exceptions:

■ J Series devices support link and multilink services on the lsq-0/0/0 interface
instead of the ml-fpc/pic/port, lsq-fpc/pic/port, and ls-fpc/pic/port interfaces.

■ When LFI is enabled, fragmented packets are queued in a round-robin fashion
on the constituent links to enable per-packet and per-fragment load balancing.
For more information, see “Queuing with LFI on J Series Devices” on page 409.

■ J Series devices support per-unit scheduling on all types of constituent links (on
all types of interfaces).

■ J Series devices support Compressed Real-Time Transport Protocol (CRTP) with
MLPPP as well as PPP.

Multilink Bundles Overview

The J Series device supports MLPPP and MLFR multilink encapsulations. MLPPP
enables you to bundle multiple PPP links into a single multilink bundle, and MLFR
enables you to bundle multiple Frame Relay data-link connection identifiers (DLCIs)
into a single multitlink bundle. Multilink bundles provide additional bandwidth, load
balancing, and redundancy by aggregating low-speed links, such as T1, E1, and serial
links.
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You configure multilink bundles as logical units or channels on the link services
interface lsq-0/0/0:

■ With MLPPP and MLFR FRF.15, multilink bundles are configured as logical units
on lsq-0/0/0—for example, lsq-0/0/0.0 and lsq-0/0/0.1.

■ With MLFR FRF.16, multilink bundles are configured as channels on
lsq-0/0/0—for example, lsq-0/0/0:0 and lsq-0/0/0:1.

After creating multilink bundles, you add constituent links to the bundle. The
constituent links are the low-speed physical links that are to be aggregated. You can
create 64 multilink bundles, and on each multilink bundle you can add up to 8
constituent links. The following rules apply when you add constituent links to a
multilink bundle:

■ On each multilink bundle, add only interfaces of the same type. For example,
you can add either T1 or E1, but not both.

■ Only interfaces with a PPP encapsulation can be added to an MLPPP bundle,
and only interfaces with a Frame Relay encapsulation can be added to an MLFR
bundle.

■ If an interface is a member of an existing bundle and you add it to a new bundle,
the interface is automatically deleted from the existing bundle and added to the
new bundle.

For information about configuring MLPPP bundles, see “Configuring an MLPPP
Bundle” on page 414. For information about configuring MLFR bundles, see
“Configuring MLFR FRF.15 Bundles” on page 424 and “Configuring MLFR FRF.16
Bundles” on page 427.

Link Fragmentation and Interleaving Overview

As it does on any other interface, priority scheduling on a multilink bundle determines
the order in which an output interface transmits traffic from an output queue. The
queues are serviced in a weighted round-robin fashion. But when a queue containing
large packets starts using the multilink bundle, small and delay-sensitive packets
must wait their turn for transmission. Because of this delay, some slow links, such
as T1 and E1, can become useless for delay-sensitive traffic.

Link fragmentation and interleaving (LFI) solves this problem. It reduces delay and
jitter on links by fragmenting large packets and interleaving delay-sensitive packets
with the resulting smaller packets for simultaneous transmission across multiple links
of a multilink bundle.

Figure 46 on page 404 illustrates how LFI works. In this figure, Device R0 and Device
R1 have LFI enabled. When Device R0 receives large and small packets, such as data
and voice packets, it divides them into two categories. All voice packets and any
other packets configured to be treated as voice packets are categorized as LFI packets
and transmitted without fragmentation or an MLPPP header. If CRTP is configured
on the bundle, LFI packets are transmitted through CRTP processing. The remaining
non-LFI (data) packets can be fragmented or unfragmented based on the configured
fragmentation threshold. The packets larger than the fragmentation threshold are

Link Services Interfaces Overview ■ 403

Chapter 14:  Configuring Link Services Interfaces



fragmented. An MLPPP header (containing a multilink sequence number) is added
to all non-LFI packets, fragmented and unfragmented.

The fragmentation is performed according to the fragmentation threshold that you
configure. For example, if you configure a fragmentation threshold of 128 bytes, all
packets larger than 128 bytes are fragmented. When Device R1 receives the packets,
it sends the unfragmented voice packets immediately but buffers the packet fragments
until it receives the last fragment for a packet. In this example, when Device R1
receives fragment 5, it reassembles the fragments and transmits the whole packet.

The unfragmented data packets are treated as a single fragment. Thus Device R1
does not buffer the unfragmented data packets and transmits them as it receives
them.

Figure 46: LFI on a Services Router

For information about configuring LFI, see “Enabling Link Fragmentation and
Interleaving” on page 416.

Compressed Real-Time Transport Protocol Overview

Real-Time Transport Protocol (RTP) can help achieve interoperability among different
implementations of network audio and video applications. However, in some cases,
the header, which includes the IP, UDP, and RTP headers, can be too large (around
40 bytes) on networks using low-speed lines such as dial-up modems. Compressed
Real-Time Transport Protocol (CRTP) can be configured to reduce network overhead
on low-speed links. CRTP replaces the IP, UDP, and RTP headers with a 2-byte context
ID (CID), reducing the header overhead considerably.

Figure 47 on page 405 shows how CRTP compresses the RTP headers in a voice packet
and reduces a 40-byte header to a 2-byte header.
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Figure 47: CRTP

On J Series devices, you can configure CRTP with MLPPP or PPP logical interface
encapsulation on link services interfaces. For more information about configuring
MLPPP, see “Configuring an MLPPP Bundle” on page 414.

Real-time and non-real-time data frames are carried together on lower-speed links
without causing excessive delays to the real-time traffic. For more information about
LFI, see “Link Fragmentation and Interleaving Overview” on page 403.

Configuring Fragmentation by Forwarding Class

For lsq-0/0/0 on SRX210, SRX240, SRX650, J2320, J2350, J4350, and J6350 devices,
you can specify fragmentation properties for specific forwarding classes. Traffic on
each forwarding class can be either multilink encapsulated (fragmented and
sequenced) or nonencapsulated (hashed with no fragmentation). By default, traffic
in all forwarding classes is multilink encapsulated.

When you do not configure fragmentation properties for the queues on MLPPP
interfaces, the fragmentation threshold you set at the [edit interfaces interface-name
unit logical-unit-number fragment-threshold] hierarchy level is the fragmentation
threshold for all forwarding classes within the MLPPP interface. For MLFR FRF.16
interfaces, the fragmentation threshold you set at the [edit interfaces interface-name
mlfr-uni-nni-bundle-options fragment-threshold] hierarchy level is the fragmentation
threshold for all forwarding classes within the MLFR FRF.16 interface.

If you do not set a maximum fragment size anywhere in the configuration, packets
are still fragmented if they exceed the smallest maximum transmission unit (MTU)
or maximum received reconstructed unit (MRRU) of all the links in the bundle. A
nonencapsulated flow uses only one link. If the flow exceeds a single link, then the
forwarding class must be multilink encapsulated, unless the packet size exceeds the
MTU/MRRU.

Even if you do not set a maximum fragment size anywhere in the configuration, you
can configure the MRRU by including the mrru statement at the [edit interfaces
lsq-0/0/0 unit  logical-unit-number] or [edit interfaces interface-name
mlfr-uni-nni-bundle-options] hierarchy level. The MRRU is similar to the MTU, but is
specific to link services interfaces. By default the MRRU size is 1504 bytes, and you
can configure it to be from 1500 through 4500 bytes.

To configure fragmentation properties on a queue, include the fragmentation-maps
statement at the [edit class-of-service] hierarchy level:
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[edit class-of-service]

fragmentation-maps {
map-name {

forwarding-class class-name {
fragment-threshold bytes;
multilink-class number;
no-fragmentation;

}
}

}

To set a per-forwarding class fragmentation threshold, include the fragment-threshold
statement in the fragmentation map. This statement sets the maximum size of each
multilink fragment.

To set traffic on a queue to be nonencapsulated rather than multilink encapsulated,
include the no-fragmentation statement in the fragmentation map. This statement
specifies that an extra fragmentation header is not prepended to the packets received
on this queue and that static link load balancing is used to ensure in-order packet
delivery.

For a given forwarding class, you can include either the fragment-threshold or
no-fragmentation statement; they are mutually exclusive.

You use the multilink-class statement to map a forwarding class into a multiclass
MLPPP. For a given forwarding class, you can include either the multilink-class or
no-fragmentation statement; they are mutually exclusive.

To associate a fragmentation map with a multilink PPP interface or MLFR FRF.16
DLCI, include the fragmentation-map statement at the [edit class-of-service interfaces
interface-name unit logical-unit-number] hierarchy level:

[edit class-of-service interfaces]

lsq-0/0/0 {
unit logical-unit-number { # Multilink PPP
fragmentation-map map-name;
}

}

lsq-0/0/0:channel { # MLFR FRF.16
unit logical-unit-number
fragmentation-map map-name;
}

}

Configuring Link-Layer Overhead

Link-layer overhead can cause packet drops on constituent links because of bit stuffing
on serial links. Bit stuffing is used to prevent data from being interpreted as control
information.

406 ■ Link Services Interfaces Overview

JUNOS Software Interfaces and Routing Configuration Guide



By default, 4 percent of the total bundle bandwidth is set aside for link-layer overhead.
In most network environments, the average link-layer overhead is 1.6 percent.
Therefore, we recommend 4 percent as a safeguard.

For lsq-0/0/0 on SRX210, SRX240, SRX650, J2320, J2350, J4350, and J6350 devices,
(lsq), you can configure the percentage of bundle bandwidth to be set aside for
link-layer overhead. To do this, include the link-layer-overhead statement:

link-layer-overhead percent;

You can include this statement at the following hierarchy levels:

■ [edit interfaces interface-name mlfr-uni-nni-bundle-options]

■ [edit interfaces interface-name unit logical-unit-number]

■ [edit logical-routers logical-router-name interfaces interface-name unit
logical-unit-number]

You can configure the value to be from 0 percent through 50 percent.

Configuring Multiclass MLPPP

For lsq-0/0/0  on SRX210, SRX240, SRX650, J2320, J2350, J4350, and J6350 devices,
with MLPPP encapsulation, you can configure multiclass MLPPP. If you do not
configure multiclass MLPPP, fragments from different classes cannot be interleaved.
All fragments for a single packet must be sent before the fragments from another
packet are sent. Nonfragmented packets can be interleaved between fragments of
another packet to reduce latency seen by nonfragmented packets. In effect,
latency-sensitive traffic is encapsulated as regular PPP traffic, and bulk traffic is
encapsulated as multilink traffic. This model works as long as there is a single class
of latency-sensitive traffic, and there is no high-priority traffic that takes precedence
over latency-sensitive traffic. This approach to LFI, used on the Link Services PIC,
supports only two levels of traffic priority, which is not sufficient to carry the
four-to-eight forwarding classes that are supported by M series and T series routing
platforms.

Multiclass MLPPP makes it possible to have multiple classes of latency-sensitive traffic
that are carried over a single multilink bundle with bulk traffic. In effect, multiclass
MLPPP allows different classes of traffic to have different latency guarantees. With
multiclass MLPPP, you can map each forwarding class into a separate multilink class,
thus preserving priority and latency guarantees.
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NOTE: Configuring both LFI and multiclass MLPPP on the same bundle is not
necessary, nor is it supported, because multiclass MLPPP represents a superset of
functionality. When you configure multiclass MLPPP, LFI is automatically enabled.

The JUNOS Software PPP implementation does not support the negotiation of address
field compression and protocol field compression PPP NCP options, which means
that the software always sends a full 4-byte PPP header.

The JUNOS Software implementation of multiclass MLPPP does not support
compression of common header bytes.

Multiclass MLPPP greatly simplifies packet ordering issues that occur when multiple
links are used. Without multiclass MLPPP, all voice traffic belonging to a single flow
is hashed to a single link to avoid packet ordering issues. With multiclass MLPPP,
you can assign voice traffic to a high-priority class, and you can use multiple links.
For more information about voice services support on the lsq-0/0/0 interface, see
the Junos OS Feature Support Reference for SRX Series and J Series Devices.

To configure multiclass MLPPP on a link services IQ interface, you must specify how
many multilink classes should be negotiated when a link joins the bundle, and you
must specify the mapping of a forwarding class into an multiclass MLPPP class.

To specify how many multilink classes should be negotiated when a link joins the
bundle, include the multilink-max-classes  statement:

multilink-max-classes number;

You can include this statement at the following hierarchy levels:

■ [edit interfaces interface-name unit logical-unit-number]

■ [edit logical-routers logical-router-name interfaces interface-name unit
logical-unit-number]

The number of multilink classes can be 1 through 8. The number of multilink classes
for each forwarding class must not exceed the number of multilink classes to be
negotiated.

To specify the mapping of a forwarding class into a multiclass MLPPP class, include
the multilink-class statement at the [edit class-of-service fragmentation-maps
forwarding-class class-name] hierarchy level:

[edit class-of-service fragmentation-maps forwarding-class class-name] multilink-class
number;

The multilink class index number can be 0 through 7. The multilink-class statement
and the no-fragmentation statement are mutually exclusive.

To view the number of multilink classes negotiated, issue the show interfaces
lsq-0/0/0.logical-unit-number detail  command.
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Queuing with LFI on J Series Devices

LFI or non-LFI packets are placed into queues on constituent links based on the
queues in which they arrive. No changes in the queue number occur while the
fragmented, non-fragmented, or LFI packets are being queued.

For example, assume that Queue Q0 is configured with fragmentation threshold 128,
Q1 is configured with no fragmentation, and Q2 is configured with fragmentation
threshold 512. Q0 is receiving stream of traffic with packet size 512. Q1 is receiving
voice traffic of 64 bytes, and Q2 is receiving stream of traffic with 128-byte packets.
Next the stream on Q0 gets fragmented and queued up into Q0 of a constituent link.
The stream on Q1 is considered to be LFI because no fragmentation is configured.
Therefore, all packets on Q1 are queued up on Q1 on constituent link. Because the
fragmentation threshold of Q2 is more than the packet size it is receiving, the packet
is queued on Q2 of a constituent link without fragmenting, but with multilink header
because it is a non-LFI packet.

Using lsq-0/0/0, Compressed Real-Time Transport Protocol (CRTP) can be applied
on LFI and non-LFI packets. There will be no changes in their queue numbers because
of CRTP.

Queuing on Q2s of Constituent Links

When using class of service on a multilink bundle, all Q2 traffic from the multilink
bundle is queued to Q2 of constituent links based on a hash computed from the
source address, destination address, and the IP protocol of the packet. If the IP
payload is TCP or UDP traffic, the hash also includes the source port and destination
port. As a result of this hash algorithm, all traffic belonging to one traffic flow is
queued to Q2 of one constituent link. This method of traffic delivery to the constituent
link is applied at all times, including when the bundle has not been set up with LFI.

Configuring CoS Components with LFI

If you configure CoS components with LFI on a J Series device, we recommend that
you follow certain recommendations for shaping rate, scheduling priority, and buffer
size. For configuration instructions, see “Configuring MLPPP Bundles and LFI on
Serial Links” on page 413. For more information about other CoS components, see
Junos OS Class of Service Configuration Guide for Security Devices.

Shaping Rate

When you configure LFI, we recommend that you configure the shaping rate on each
constituent link of the multilink bundle. Shaping rate configuration on the constituent
links is required to limit the jitter on the LFI queue. If you anticipate no delay-sensitive
or jitter-sensitive traffic on the LFI queue, or if there is no LFI traffic at all, shaping
rate configuration is optional.

For information about how to configure a shaping rate, see Junos OS Class of Service
Configuration Guide for Security Devices.
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Scheduling Priority

J Series devices support per-unit scheduling that allows you to configure scheduler
maps on each MLPPP or MLFR multilink bundle. You can also configure scheduler
maps on constituent links, but you must maintain the same relative priority on the
constituent links and on the multilink bundle.

Table 116 on page 410 shows an example of correct and incorrect relative priorities
on a multilink bundle and its constituent link. In this example, you have assigned a
high priority to LFI packets and a low priority to data packets on the multilink bundle.
To maintain the relative priority on the constituent links, you can assign a high priority
to the LFI packets and a medium-high priority to the data packets, but you cannot
assign a medium-high priority to LFI packets and a high priority to data packets.

Table 116: Relative Priorities on Multilink Bundles and Constituent Links

Incorrect Constituent Link PrioritiesCorrect Constituent Link PrioritiesMultilink Bundle

LFI packet—Medium-high priorityLFI packets—High priorityLFI packets—High priority

Data packets—High priorityData packets—Medium-high priorityData packets—Low priority

Before You Begin

Before you configure a link services interface, you need to perform the following
tasks:

■ Install device hardware. For more information, see the J Series Services Routers
Hardware Guide.

■ Establish basic connectivity. For more information, see the Getting Started Guide
for your device.

■ If you do not already have a basic understanding of physical and logical interfaces
and Juniper Networks interface conventions, read “Interfaces Overview” on
page 3.

Although it is not a requirement, you might also want to plan how you are going to
use the link services interface on your network before you begin configuring it. Read
“Link Services Interfaces Overview” on page 400 for a basic understanding of the link
services interface implementation.

Configuring the Link Services Interface with Quick Configuration

You can use the services interfaces Quick Configuration pages to do the following:

■ Configure the lsq-0/0/0 link services interface.

■ Configure multilink logical interfaces on the lsq-0/0/0 interface. Multilink logical
interfaces allow you to bundle multiple serial interfaces such as T1, T3, E1, E3,
and serial interfaces into a single logical link as follows:
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■ Bundle multiple Point-to-Point Protocol (PPP) links into a single Multilink
Point-to-Point Protocol (MLPPP) logical link.

■ Bundle multiple Frame Relay data-link connection identifiers (DLCIs) into a
single Multilink Frame Relay (MLFR) logical link.

To configure the link services interface:

1. From the Quick Configuration page, as shown in Figure 16 on page 82, select
the link services interface—for example, lsq-0/0/0—you want to configure.

2. Enter information into the Quick Configuration page, as described in Table 117
on page 411.

3. Click one of the following buttons:

■ To apply the configuration and stay on the Quick Configuration page, click
Apply.

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 117: Link Services Interface Quick Configuration Summary

Your ActionFunctionField

Logical Interfaces

Click Add.Defines one or more logical units that you
connect to this link services interface. You must
define at least one logical unit for the link
services interface.

Add logical interfaces

Type a text description of the logical interface
to more clearly identify it in monitoring
displays.

(Optional) Describes the logical interface.Logical Interface
Description

1. Type one or more IPv4 addresses and
prefixes. For example:

10.10.10.10/24

2. Click Add.

3. Click OK.

Specifies one or more IPv4 addresses for the
interface.

IPv4 Addresses and
Prefixes

Type a text description of the link services
interface to more clearly identify it in
monitoring displays.

(Optional) Adds supplementary information
about the physical link services interface.

Physical Interface
Description

■ To enable subunit queuing, select the
check box.

■ To disable subunit queuing, clear the
check box.

Enables or disables subunit queuing on Frame
Relay or VLAN IQ interfaces.

Enable subunit queuing

Multilink Bundle Options
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Table 117: Link Services Interface Quick Configuration Summary (continued)

Your ActionFunctionField

Type the value.Specifies the informational-only bandwidth
value for the logical interface.

Bandwidth

Type a value between 0 and 2000.Specifies a drop timeout value (in milliseconds)
to provide a recovery mechanism if individual
links in the multilink bundle drop one or more
packets.

NOTE: Ensure that the value you specify is
larger than the expected differential delay
across the links, so that the timeout period
does not elapse under normal jitter conditions,
but only when there is actual packet loss.

Drop Timer Period

From the list, select one of the following:

■ multilink-ppp—Creates a Multilink
Point-to-Point Protocol (MLPPP) bundle.

■ multilink-frame-relay-end-to-end—Creates a
Multilink Frame Relay (MLFR) bundle.

Specifies the encapsulation type for which you
want to create a multilink bundle.

Encapsulation

Type a value that is a multiple of 64 bytes
between 64 and 16320—for example, 1024.

Specifies the maximum size, in bytes, for
multilink packet fragments.

Fragmentation Threshold

Type a value between 1 and 8.Specifies the minimum number of links
required to sustain the multilink bundle.

Links needed to sustain
bundle

Type a value between 1500 and 4500.Specifies the maximum packet size, in bytes,
that the multilink interface can process.

MRRU

Select this check box.Sets the length of the packet sequence
identification number to 12 bits.

Short Sequence

412 ■ Configuring the Link Services Interface with Quick Configuration

JUNOS Software Interfaces and Routing Configuration Guide



Table 117: Link Services Interface Quick Configuration Summary (continued)

Your ActionFunctionField

■ To add an interface in the multilink
bundle, select the interface in the Logical
Interfaces list and click the left arrow
button to add it in the Member Interfaces
list.

■ To remove an interface from the multilink
bundle, select the interface in the Member
Interfaces list and click the right arrow
button to remove it from the Member
Interfaces list.

Specifies the interfaces that are members of
the multilink bundle.

The Logical Interfaces list displays all the serial
interfaces on the device. The Member
Interfaces list displays the interfaces that are
members of the multilink bundle.

The following rules apply when you add
interfaces to a multilink bundle:

■ Only interfaces of the same type can be
added to a multilink bundle. For example,
a T1 and an E1 interface cannot be added
to the same bundle.

■ Only interfaces with the PPP
encapsulation can be added to an MLPPP
bundle and interfaces with the Frame
Relay encapsulation can be added to an
MLFR bundle.

■ If you add an interface that is a member
of an existing bundle, the interface is
deleted from the existing bundle and
added to the new bundle.

Member Interfaces

Configuring the Link Services Interface with a Configuration Editor

This section contains the following topics:

■ Configuring MLPPP Bundles and LFI on Serial Links on page 413

■ Configuring MLFR FRF.15 Bundles on page 424

■ Configuring MLFR FRF.16 Bundles on page 427

■ Configuring CRTP on page 430

Configuring MLPPP Bundles and LFI on Serial Links

Figure 48 on page 414 shows a network topology that is used as an example in this
section. In this example, your company's branch office is connected to its main
branch using J Series devices R0 and R1. You transmit data and voice traffic on two
low-speed 1-Mbps serial links. To increase bandwidth, you configure MLPPP and join
the two serial links se-1/0/0 and se-1/0/1 into a multilink bundle lsq-0/0/0.0. Then
you configure LFI and CoS on R0 and R1 to enable them to transmit voice packets
ahead of data packets.
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Figure 48: Configuring MLPPP and LFI on Serial Links

Configuring a multilink bundle on the two serial links increases the bandwidth by
70 percent from approximately 1 Mbps to 1.7 Mbps and prepends each packet with
a multilink header as specified in the FRF.12 standard. To increase the bandwidth
further, you can add up to 8 serial links to the bundle. In addition to a higher
bandwidth, configuring the multilink bundle provides load balancing and redundancy.
If one of the serial links fails, traffic continues to be transmitted on the other links
without any interruption. In contrast, independent links require routing policies for
load balancing and redundancy. Independent links also require IP addresses for each
link as opposed to one IP address for the bundle. In the routing table, the multilink
bundle is represented as a single interface.

This example uses MLPPP for providing multilink services. For information about
configuring MLFR, see “Configuring MLFR FRF.15 Bundles” on page 424 and
“Configuring MLFR FRF.16 Bundles” on page 427.

You can use the LFI and CoS configurations provided in this example with MLFR
FRF.15 and MLFR FRF.16 bundles, too. You can also use the same LFI and CoS
configurations for other interfaces, such as on T1 or E1.

To configure MLPPP bundles and LFI, perform the following tasks:

■ Configuring an MLPPP Bundle on page 414

■ Enabling Link Fragmentation and Interleaving on page 416

■ Defining Classifiers and Forwarding Classes on page 417

■ Defining and Applying Scheduler Maps on page 420

■ Applying Shaping Rates to Interfaces on page 423

Configuring an MLPPP Bundle

In this example, you create an MLPPP bundle (lsq-0/0/0.0) at the logical unit level
of the link services interface (lsq-0/0/0) on J Series devices R0 and R1. Then you
add the two serial interfaces se-1/0/0 and se-1/0/1 as constituent links to the
multilink bundle. Adding multiple links does not require you to configure and manage
more addresses.

To configure an MLPPP bundle on a J Series device:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 118 on page 415 on Device
R0 and Device R1.

3. Go on to “Enabling Link Fragmentation and Interleaving” on page 416.
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Table 118: Configuring an MLPPP Bundle

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces lsq-0/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

3. Next to Interface, click Add new
entry.

4. In the Interface name box, type
lsq-0/0/0.

5. Click OK.

Navigate to the Interfaces  level in the
configuration hierarchy. Specify the link
services interface to be configured.

Set the appropriate source address for
the interface:

■ On R0, enter

set unit 0 family inet address
10.0.0.10/24

■ On R1, enter

set unit 0 family inet address
10.0.0.9/24

1. Next to lsq-0/0/0, click Edit.

2. Next to Unit, click Add new entry.

3. In the Interface unit number box,
type 0.

4. Under Family, select Inet and click
Configure.

5. Next to Address, click Add new
entry.

6. In the Source box, type the
appropriate source address:

■ On R0—10.0.0.10/24

■ On R1—10.0.0.9/24

7. Click OK until you return to the
Interfaces page.

Configure a logical unit on the lsq-0/0/0
interface and define the family type—for
example, Inet.

Configure an IP address for the multilink
bundle at the unit level of the link
services interface.

From the [edit] hierarchy level, add the
constituent links to the multilink bundle.

■ To add se-1/0/0 to the multilink
bundle, enter

edit interfaces se-1/0/0

■ To add se-1/0/1 to the multilink
bundle, enter

edit interfaces se-1/0/1

1. On the Interfaces page, Next to
Interface, click Add new entry.

2. In the Interface name box, type the
name of the interface to be added
to the multilink bundle—for
example se-1/0/0 or se-1/0/1.

3. Click OK.

4. Click Edit next to the appropriate
interface name—for example,
se-1/0/0 or se-1/0/1.

From the Interfaces  level in the
configuration hierarchy, specify the
names of the constituent links to be
added to the multilink bundle—for
example, se-1/0/0 and se-1/0/1.
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Table 118: Configuring an MLPPP Bundle (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set unit 0 family mlppp bundle lsq-0/0/0.0

1. Next to Unit, click Add new entry.

2. In the Interface unit number box,
type 0.

3. Under Family, select Mlppp and
click Configure.

4. In the Bundle box, type
lsq-0/0/0.0.

5. Click OK until you return to the
Interfaces page.

Create the multilink bundle by specifying
a logical unit on each constituent link
and defining it as an MLPPP bundle—for
example, lsq-0/0/0.0.

1. On R0, from the [edit] hierarchy
level, set serial options for the
interface.

■ To set options on se-1/0/0,
enter

edit interfaces se-1/0/0

■ To set options on se-1/0/1,
enter

edit interfaces se-1/0/1

2. Enter

set serial-options clocking-mode dce
clock-rate 2.0mhz

1. On the Interfaces page, click Edit.

2. Next to the interface that you want
to configure (se-1/0/0 or se-1/0/1),
click Edit.

3. Next to Serial options, click
Configure.

4. From the Clocking mode list, select
dce.

5. From the Clock rate list, select
2.0mhz.

6. Click OK twice.

Set the serial options to the same values
for both interfaces on R0—se-1/0/0 and
se-1/0/1.

For more information about serial
options, see “Configuring Serial
Interfaces with Quick Configuration” on
page 104.

NOTE: In this example, R0 is set as a
data circuit-terminating equipment
(DCE) device. The serial options are not
set for interfaces on R1. You can set the
serial options according to your network
setup.

Enabling Link Fragmentation and Interleaving

To configure link fragmentation and interleaving (LFI), you define the MLPPP
encapsulation type and enable fragmentation and interleaving of packets by specifying
the following properties—the fragmentation threshold and fragmentation—maps
with a no-fragmentation knob mapped to the forwarding class of choice. In this
example, a fragmentation threshold of 128 bytes is set on the MLPPP bundle that
applies to all traffic on both constituent links, so that any packet larger than 128
bytes transmitted on these links is fragmented.

For more information about LFI, see “Link Fragmentation and Interleaving Overview”
on page 403.

To enable LFI:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 119 on page 417 on Device
R0 and Device R1.

3. Go on to “Defining Classifiers and Forwarding Classes” on page 417.
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Table 119: Enabling LFI

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces lsq-0/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Edit.

3. Under Interface, next to lsq-0/0/0,
click Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

Specify the link services intelligent
queuing interface for fragmentation.

Enter

set unit 0 encapsulation multilink-ppp
fragment-threshold 128

1. Under Unit, next to 0, click Edit

2. From the Encapsulation list, select
multilink-ppp as the encapsulation
type.

3. In the Fragment threshold box,
type 128.

4. Click OK.

Specify the multilink encapsulation type,
enable LFI, and set the fragmentation
threshold for the multilink interface.

Fragment Threshold—Set the maximum
size, in bytes, for multilink packet
fragments—for example, 128. Any
nonzero value must be a multiple of 64
bytes. The value can be between 128
and 16320. The default is 0 bytes (no
fragmentation).

Defining Classifiers and Forwarding Classes

By defining classifiers you associate incoming packets with a forwarding class and
loss priority. Based on the associated forwarding class, you assign packets to output
queues. To configure classifiers, you specify the bit pattern for the different types of
traffic. The classifier takes this bit pattern and attempts to match it to the type of
packet arriving on the interface. If the information in the packet’s header matches
the specified pattern, the packet is sent to the appropriate queue, defined by the
forwarding class associated with the classifier.

In this example, an IP precedence classifier, classify_input, is assigned to all incoming
traffic. The precedence bit value in the type of service (ToS) field is assumed to be
000 for all incoming data traffic and 010 for all incoming voice traffic. This classifier
assigns all data traffic to Q0 and all voice traffic to Q2, and fragmentation-map maps
Q2 to no-fragmentation. On a J Series device, when LFI is enabled, all traffic assigned
to Q2 is treated as LFI (voice) traffic. You do not need to assign network control
traffic to a queue explicitly, because it is assigned to Q3 by default.

For more information about configuring CoS components, see Junos OS Class of
Service Configuration Guide for Security Devices.

To define classifiers and forwarding classes:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 120 on page 418 on Device
R0 and Device R1.

3. Go on to “Defining and Applying Scheduler Maps” on page 420.
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Table 120: Defining Classifiers and Forwarding Classes

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click
Configure or Edit.

Navigate to the Class of service level in
the configuration hierarchy.

Enter

edit classifiers inet-precedence
classify_input

1. Next to Classifiers, click Configure.

2. Next to Inet precedence, click Add
new entry.

3. In the Name box, type
classify_input.

Configure a behavior aggregate (BA)
classifier for classifying packets.

In this example, you specify the default
IP precedence classifier, which maps IP
precedence bits to forwarding classes
and loss priorities.

Enter

set forwarding-class DATA loss-priority low
code-points 000

1. On the Inet precedence page, next
to Forwarding class, click Add new
entry.

2. In the Class name box, type DATA.

3. Next to Loss priority, click Add new
entry.

4. From the Loss val list, select low.

5. Next to Code points, click Add new
entry.

6. In the Value box, type 000.

7. Click OK until you return to the Inet
precedence page.

For the classifier to assign an output
queue to each packet, it must associate
the packet with a forwarding class.

Assign packets with IP precedence bits
000 to the DATA forwarding class, and
specify a low loss priority.

Enter

set forwarding-class VOICE loss-priority low
code-points 010

1. Next to Forwarding class, click Add
new entry.

2. In the Class name box, type VOICE.

3. Next to Loss priority, click Add new
entry.

4. From the Loss val list, select low.

5. Next to Code points, click Add new
entry.

6. In the Value box, type 010.

7. Click OK until you return to the
Class of service page.

Assign packets with IP precedence bits
010 to the VOICE forwarding class, and
specify a low loss priority.
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Table 120: Defining Classifiers and Forwarding Classes (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit class-of-service] hierarchy
level, enter

set forwarding-classes queue 0 DATA

set forwarding-classes queue 2 VOICE

set forwarding-classes queue 3 NC

1. On the Class of service page, next
to Forwarding classes, click
Configure.

2. Next to Queue, click Add new
entry.

3. In the Queue num box, type 0.

4. In the Class name box, type DATA.

5. Click OK.

6. Next to Queue, click Add new
entry.

7. In the Queue num box, type 2.

8. In the Class name box, type VOICE.

9. Click OK.

10. Next to Queue, click Add new
entry.

11. In the Queue num box, type 3.

12. In the Class name box, type NC.

13. Click OK until you return to the
Class of service page.

Assign each forwarding class one-to-one
with the output queues.

■ DATA—Assign to Queue 0.

■ VOICE—Assign to Queue 2.

■ NC (Network Control)—Assign to
Queue 3. NC is assigned to Queue
3 by default.

1. From the [edit class-of-service]
hierarchy level, enter

edit interfaces ge-0/0/1

2. Enter

set unit 0 classifiers inet-precedence
classify_input

1. On the Class of service page, next
to Interfaces, click Configure or
Edit.

2. Next to Interface, click Add new
entry.

3. In the Interface name box, type
ge-0/0/1.

4. Next to Unit, click Add new entry.

5. In the Unit number box, type 0.

6. Next to Classifiers, click Configure.

7. Under Inet precedence, in the
Classifier name box, type
classify_input.

8. Click OK.

Apply the behavior aggregate classifier
to the incoming interface.

Enter

set class-of-service fragmentation-maps
FM forwarding-class VOICE
no-fragmentation

-Configure fragmentation-map
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Table 120: Defining Classifiers and Forwarding Classes (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set class-of-service interfaces lsq-0/0/0
unit unit fragmentation-map

-Attach fragmentation-map to lsq

Defining and Applying Scheduler Maps

By defining schedulers you configure the properties of output queues that determine
the transmission service level for each queue. These properties include the amount
of interface bandwidth assigned to the queue, the size of the memory buffer allocated
for storing packets, and the priority of the queue. After defining schedulers you
associate them with forwarding classes by means of scheduler maps. You then
associate each scheduler map with an interface, thereby configuring the hardware
queues and packet schedulers that operate according to this mapping.

In this example, you define and apply scheduler maps as follows:

■ Enable per-unit scheduling that allows configuration of scheduler maps on the
bundle.

■ Create three schedulers—DATA, VOICE, and NC. Define the VOICE and NC
schedulers to have a high priority and the DATA scheduler to have the default
priority (low). These priority assignments allow all voice and network control
traffic to be transmitted ahead of data packets. For more information about
scheduling priorities, see “Queuing with LFI on J Series Devices” on page 409.

■ Create a scheduler map s_map that associates these schedulers with
corresponding forwarding classes.

■ Apply the scheduler map to the multilink bundle and the serial interfaces.

To define and apply scheduler maps:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 121 on page 420 on Device
R0 and Device R1.

3. Go on to “Applying Shaping Rates to Interfaces” on page 423.

Table 121: Defining and Applying Scheduler Maps

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

Navigate to the Interface level in the
configuration hierarchy.
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Table 121: Defining and Applying Scheduler Maps (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set lsq-0/0/0 per-unit-scheduler

set se-1/0/0 per-unit-scheduler

set se-1/0/1 per-unit-scheduler

1. Under Interfaces, select lsq-0/0/0.

2. From the Scheduler type list, select
Per unit scheduler.

3. Click OK.

4. Under Interfaces, select se-1/0/0.

5. From the Scheduler type list, select
Per unit scheduler.

6. Click OK.

7. Under Interfaces, select se-1/0/1.

8. From the Scheduler type list, select
Per unit scheduler.

9. Click OK twice.

To configure CoS components for each
multilink bundle, enable per-unit
scheduling on the interface.

From the [edit class-of-service] hierarchy
level, enter

edit interfaces lsq-0/0/0

1. On the Class of service page, next
to Interfaces, click Configure or
Edit.

2. Next to Interface, click Add new
entry.

3. In the Interface name box, type
lsq-0/0/0.

Navigate to the Interfaces level in the
Class of Service configuration hierarchy
and specify the link services intelligent
queuing interface to be configured.

Enter

set unit 0 scheduler-map s_map

1. Next to Unit, type Add new entry.

2. In the Unit number box, type 0.

3. In the Scheduler map box, type
s_map.

4. Click OK twice.

Define a scheduler map—for example,
s_map.

1. From the [edit] hierarchy level,
specify the interface to be
configured.

■ To apply the scheduler map to
se-1/0/0, enter

edit interfaces se-1/0/0

■ To apply the scheduler map to
se-1/0/1, enter

edit interfaces se-1/0/1

2. Apply the scheduler map to the
logical interface.

set unit 0 scheduler-map s_map

1. On the Class of service page, next
to Interfaces, click Configure or
Edit.

2. Next to Interface, click Add new
entry.

3. In the Interface name box, type the
name of the interface on which
scheduler map s_map is to be
applied—for example, se-1/0/0 or
se-1/0/1.

4. Next to Unit, type Add new entry.

5. In the Unit number box, type 0.

6. In the Scheduler map box, type
s_map.

7. Click OK twice.

Apply the scheduler map to the
constituent links of the multilink
bundle—for example, se-1/0/0 and
se-1/0/1.
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Table 121: Defining and Applying Scheduler Maps (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit class-of-service] hierarchy
level, enter

set scheduler-maps s_map forwarding-class
DATA scheduler DATA

set scheduler-maps s_map forwarding-class
VOICE scheduler VOICE

set scheduler-maps s_map forwarding-class
NC scheduler NC

1. On the Class of service page, next
to Scheduler maps, click Add new
entry.

2. In the Map name box, type s_map.

3. Next to Forwarding class, click Add
new entry.

4. In the Class name box, type DATA.

5. In the Scheduler box, type DATA.

6. Click OK.

7. Next to Forwarding class, click Add
new entry.

8. In the Class name box, type VOICE.

9. In the Scheduler box, type VOICE.

10. Click OK.

11. Next to Forwarding class, click Add
new entry.

12. In the Class name box, type NC.

13. In the Scheduler box, type NC.

14. Click OK until you return to the
Class of service page.

Associate a scheduler with each
forwarding class.

■ DATA—A scheduler associated with
the DATA forwarding class.

■ VOICE—A scheduler associated with
the VOICE forwarding class.

■ NC—A scheduler associated with
the NC forwarding class.

A scheduler receives the forwarding
class and loss priority settings, and
queues the outgoing packet based on
those settings.

Enter

set schedulers DATA transmit-rate
percent 49

set schedulers DATA buffer-size percent 49

1. On the Class of service page, next
to Schedulers, click Add new entry.

2. In the Scheduler name box, type
DATA.

3. Next to Transmit rate, click
Configure.

4. From the Transmit rate choice list,
select Percent.

5. In the Percent box, type 49.

6. Click OK.

7. Next to Buffer size, click Configure.

8. From the Buffer size choice list,
select Percent.

9. In the Percent box, type 49.

10. Click OK twice.

Define the properties of output queues
for the DATA scheduler:

■ Transmit rate—Specify a
percentage of transmission
capacity—49.

■ Buffer size—Specify a percentage
of total buffer—49.

■ Priority—Do not specify the
transmission priority for the DATA
scheduler to apply the default
setting—low.

For more information about transmit
rate and buffer size, see Junos OS Class
of Service Configuration Guide for Security
Devices.
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Table 121: Defining and Applying Scheduler Maps (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set schedulers VOICE transmit-rate percent
50

set schedulers VOICE buffer-size percent 
5

set schedulers VOICE priority high

1. On the Class of service page, next
to Schedulers, click Add new entry.

2. In the Scheduler name box, type
VOICE.

3. Next to Transmit rate, click
Configure.

4. From the Transmit rate choice list,
select Percent.

5. In the Percent box, type 50.

6. Click OK.

7. Next to Buffer size, click Configure.

8. From the Buffer size choice list,
select Percent.

9. In the Percent box, type 5.

10. Click OK.

11. In the Priority box, type high.

12. Click OK.

Define the properties of output queues
for the VOICE scheduler:

■ Transmit rate—Specify a
percentage of transmission
capacity—50.

■ Buffer size—Specify a percentage
of total buffer—5.

■ Priority—Specify a transmission
priority—high.

Enter

set schedulers NC transmit-rate percent 
1

set schedulers NC buffer-size percent  1

set schedulers NC priority high

1. On the Class of service page, next
to Schedulers, click Add new entry.

2. In the Scheduler name box, type
NC.

3. Next to Transmit rate, click
Configure.

4. From the Transmit rate choice list,
select Percent.

5. In the Percent box, type 1.

6. Click OK.

7. Next to Buffer size, click Configure.

8. From the Buffer size choice list,
select Percent.

9. In the Percent box, type 1.

10. Click OK.

11. In the Priority box, type high.

12. Click OK.

Define the properties of output queues
for the NC scheduler:

■ Transmit rate—Specify a
percentage of transmission
capacity—1.

■ Buffer size—Specify a percentage
of total buffer—1.

■ Priority—Specify a transmission
priority—high.

Applying Shaping Rates to Interfaces

To control the voice traffic latency within acceptable limits, you configure the shaping
rate on constituent links of the MLPPP bundle. Shaping rate at the interface level is
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required only when you enable LFI. To apply shaping rates to interfaces, you have
to first enable per-unit scheduling. For information about shaping rates and LFI, see
“Configuring CoS Components with LFI” on page 409.

You must configure the shaping rate to be equal to the combined physical interface
bandwidth for the constituent links. In this example, the combined bandwidth capacity
of the two constituent links—se-1/0/0 and se-1/0/1—is 2 Mbps. Hence, configure
a shaping rate of 2 Mbps on each constituent link.

To apply a shaping rate to the constituent links of the multilink bundle:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 122 on page 424 on Device
R0 and Device R1.

3. Go on to “Verifying the Link Services intelligent queuing Interface Configuration”
on page 431, to verify your configuration.

Table 122: Applying Shaping Rate to Interfaces

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click Edit.

Navigate to the Class of service level in
the configuration hierarchy.

1. Set the shaping rate on both the
constituent links:

■ To set the shaping rate for
se-1/0/0, enter

edit interfaces se-1/0/0

■ To set the shaping rate for
se-1/0/1, enter

edit interfaces se-1/0/1

2. Set the shaping rate:

set unit 0 shaping-rate 2000000

1. Under Interfaces, select the name
of the interface on which you want
to apply the shaping rate—se-1/0/0
or se-1/0/1.

2. Next to Unit 0, click Edit.

3. Select Shaping rate, and click
Configure.

4. From the Shaping rate choice list,
select Rate.

5. In the Rate box, type 2000000.

6. Click OK.

Apply the shaping rate to the constituent
links of the multilink bundle—for
example, se-1/0/0 and se-1/0/1. The
shaping rate specifies the amount of
bandwidth to be allocated for this
multilink bundle.

Configuring MLFR FRF.15 Bundles

J Series devices support Multilink Frame Relay end-to-end (MLFR FRF.15) on the link
services intelligent queuing interface lsq-0/0/0.

With MLFR FRF.15, multilink bundles are configured as logical units on the link
services intelligent queuing interface, such as lsq-0/0/0.0. MLFR FRF.15 bundles
combine multiple permanent virtual circuits (PVCs) into one aggregated virtual circuit
(AVC). This process provides fragmentation over multiple PVCs on one end and
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reassembly of the AVC on the other end. For more information about multilink
bundles, see “Multilink Bundles Overview” on page 402.

You can configure LFI and CoS with MLFR in the same way that you configure them
with MLPPP. For information about configuring LFI and CoS, see “Configuring MLPPP
Bundles and LFI on Serial Links” on page 413.

In this example, you aggregate two T1 links to create an MLFR FRF.15 bundle on
two J Series devices—Device R0 and Device R1.

To configure an MLFR FRF.15 bundle:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor on Device R0 and Device R1.

2. Perform the configuration tasks described in Table 123 on page 425.

3. If you are finished configuring the device, commit the configuration.

4. Go on to “Verifying the Link Services intelligent queuing Interface Configuration”
on page 431, to verify your configuration.

Table 123: Configuring MLFR FRF.15 Bundles

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces lsq-0/0/0

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Interfaces, click Configure
or Edit.

3. Next to Interface, click Add new
entry.

4. In the Interface name box, type
lsq-0/0/0.

5. Click OK.

Navigate to the Interfaces  level in the
configuration hierarchy. Specify the link
services intelligent queuing interface as
an interface to be configured.
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Table 123: Configuring MLFR FRF.15 Bundles (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Set the appropriate source address for
the interface:

■ On R0, enter

set unit 0 family inet address
10.0.0.4/24

■ On R1, enter

set unit 0 family inet address
10.0.0.5/24

1. On the Interfaces page, next to
lsq-0/0/0, click Edit.

2. Next to Unit, click Add new entry.

3. In the Interface unit number box,
type 0.

4. Under Family, select Inet and click
Configure.

5. Next to Address, click Add new
entry.

6. In the Source box, type the
appropriate source address:

■ On R0—10.0.0.4/24

■ On R1—10.0.0.5/24

7. Click OK until you return to the
Interfaces page.

Configure a logical unit on the lsq-0/0/0
interface, and define the family
type—for example, Inet.

Configure an IP address for the multilink
bundle on the unit level of the link
services intelligent queuing interface.

From the [edit interfaces lsq-0/0/0]
hierarchy level, enter

set unit 0 encapsulation
multilink-frame-relay-end-to-end

1. On the Interfaces page, next to
lsq-0/0/0, click Edit.

2. Under Unit, next to 0, click Edit.

3. From the Encapsulation list, select
multilink-frame-relay-end-to-end.

4. Click OK until you return to the
Interfaces page.

Define the multilink bundle as an MLFR
FRF.15 bundle by specifying the
Multilink Frame Relay end-to-end
encapsulation type.

1. From the [edit] hierarchy level, enter

■ For configuring  t1-2/0/0

edit interfaces t1-2/0/0

■ For configuring t1-2/0/1

edit interfaces t1-2/0/1

2. Enter

set encapsulation frame-relay

1. On the Interfaces page, next to
Interface, click Add new entry.

2. In the Interface name box, type the
name of the interface:

■ To configure t1–2/0/0, type
t1-2/0/0.

■ To configure t1–2/0/1, type
t1-2/0/1.

3. Click OK.

4. Next to the interface you want to
configure, click Edit.

5. From the Encapsulation list, select
frame-relay.

Specify the names of the constituent
links to be added to the multilink
bundle—for example, t1-2/0/0 and
t1-2/0/1.

Define the Frame Relay encapsulation
type.
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Table 123: Configuring MLFR FRF.15 Bundles (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

On R0 only, enter

set dce

On R0 only, select Dce.Define R0 to be a data
circuit-terminating equipment (DCE)
device. R1 performs as a data terminal
equipment (DTE) device, which is the
default with Frame Relay encapsulation.

For more information about DCE and
DTE, see “Serial Interface Overview” on
page 28.

Enter

set unit 0 dlci 100 family mlfr-end-to-end
bundle lsq-0/0/0.0

1. Next to Unit, click Add new entry.

2. In the Interface unit number box,
type 0.

3. In the Dlci box, type 100.

4. Under Family, select
mlfr-end-to-end and click
Configure.

5. In the Bundle box, type
lsq-0/0/0.0.

6. Click OK.

On the logical unit level of the interface,
specify the data-link connection
identifier (DLCI). The DLCI field identifies
which logical circuit the data travels
over. DLCI is a value from 16 through
1022—for example, 100. (Numbers 1
through 15 are reserved for future use.)

Specify the multilink bundle to which
the interface is to be added as a
constituent link—lsq-0/0/0.0.

Configuring MLFR FRF.16 Bundles

J Series devices support Multilink Frame Relay (MLFR) user-to-network interface (UNI)
network-to-network interface (NNI) (MLFR FRF.16) on the link services intelligent
queuing interface lsq-0/0/0.

MLFR FRF.16 configures multilink bundles as channels on the link services intelligent
queuing interface, such as lsq-0/0/0:0. A multilink bundle carries Frame Relay
permanent virtual circuits (PVCs), identified by their data-link connection identifiers
(DLCIs). Each DLCI is configured at the logical unit level of the link services intelligent
queuing interface and is also referred as a logical interface. Packet fragmentation
and reassembly occur on each virtual circuit. For more information about multilink
bundles, see “Multilink Bundles Overview” on page 402.

You can configure LFI and CoS with MLFR in the same way that you configure them
with MLPPP. For information about configuring LFI and CoS, see “Configuring MLPPP
Bundles and LFI on Serial Links” on page 413.

In this example, you aggregate two T1 interfaces to create an MLFR FRF.16 bundle
on two J Series devices—Device R0 and Device R1.

To configure an MLFR FRF.16 bundle:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor on Device R0 and Device R1.

2. Perform the configuration tasks described in Table 124 on page 428.
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3. If you are finished configuring the device, commit the configuration.

4. Go on to “Verifying the Link Services intelligent queuing Interface Configuration”
on page 431, to verify your configuration.

Table 124: Configuring MLFR FRF.16 Bundles

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit chassis

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Chassis, click Configure or
Edit.

Navigate to the Chassis level in the
configuration hierarchy.

Enter

set fpc 0 pic 0 mlfr-uni-nni-bundles 1

1. Next to Fpc, click Add new entry.

2. In the Slot box, type 0.

3. Next to Pic, click Add new entry.

4. In the Slot box, type 0.

5. In the Mlfr uni nni bundles box,
type 1.

6. Click OK.

Specify the number of multilink frame
relay UNI NNI (FRF.16) bundles to be
created on the interface. You can specify
a number from 1 through 255.

From the [edit] hierarchy level, enter

edit interfaces lsq-0/0/0:0

1. On the main Configuration page,
next to Interfaces, click Configure
or Edit.

2. Next to Interface, click Add new
entry.

3. In the Interface name box, type
lsq-0/0/0:0.

4. Click OK.

Specify the channel to be configured as
a multilink bundle.

Enter

set encapsulation
multilink-frame-relay-uni-nni

1. Next to lsq-0/0/0:0, click Edit.

2. From the Encapsulation list, select
multilink-frame-relay-uni-nni.

Define the multilink bundle as an MLFR
FRF.16 bundle by specifying the
Multilink Frame Relay UNI NNI
encapsulation type.

On R0 only, enter

set dce

On R0 only, select Dce.Define R0 to be a data
circuit-terminating equipment (DCE)
device. R1 performs as a data terminal
equipment (DTE) device, which is the
default with Frame Relay encapsulation.

For more information about DCE and
DTE, see “Serial Interface Overview” on
page 28
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Table 124: Configuring MLFR FRF.16 Bundles (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Set the appropriate address for the
interface:

■ On R0, enter

set unit 0 dlci 400 family inet address
10.0.0.10/24

■ On R1, enter

set unit 0 dlci 400 family inet address
10.0.0.9/24

1. Next to Unit, click Add new entry.

2. In the Interface unit number box,
type 0.

3. In the Dlci box, type 400.

4. Under Family, select Inet and click
Configure.

5. Next to Address, click Add new
entry.

6. In the Source box, type the
appropriate source address:

■ On R0—10.0.0.10/24

■ On R1—10.0.0.9/24

7. Click OK until you return to the
Interfaces page.

Configure a logical unit on the multilink
bundle lsq-0/0/0:0, and define the
family type—for example, Inet.

Assign a data link connection identifier
(DLCI) to the multilink bundle. The DLCI
field identifies which logical circuit the
data travels over. DLCI is a value from
16 through 1022—for example, 400.
(Numbers 1 through 15 are reserved for
future use.)

Assign an IP address to the multilink
bundle.

1. From the [edit] hierarchy level, enter

■ For configuring t1-2/0/0

edit interfaces t1-2/0/0

■ For configuring t1-2/0/1

edit interfaces t1-2/0/1

2. Enter

set encapsulation
multilink-frame-relay-uni-nni

1. On the Interfaces page, next to
Interface, click Add new entry.

2. In the Interface name box, type the
name of the interface:

■ To configure t1-2/0/0, type
t1-2/0/0.

■ To configure t1-2/0/1, type
t1-2/0/1.

3. Click OK.

4. Next to the interface you want to
configure, click Edit.

5. From the Encapsulation list, select
multilink-frame-relay-uni-nni.

Create the T1 interfaces that are to be
added as constituent links to the
multilink bundle—t1-2/0/0 and
t1-2/0/1.

Define the Frame Relay encapsulation
type.

Enter

set unit 0 family mlfr-uni-nni bundle
lsq-0/0/0:0

1. Next to Unit, click Add new entry.

2. In the Interface unit number box,
type 0.

3. Under Family, select mlfr-uni-nni
and click Configure.

4. In the Bundle box, type
lsq-0/0/0:0.

5. Click OK.

Specify the multilink bundle to which
the interface is to be added as a
constituent link—lsq-0/0/0:0.
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Configuring CRTP

Compressed Real-Time Transport Protocol (CRTP) is typically used for compressing
voice and video packets. You can configure CRTP with LFI on the link services
interface of a J Series device.

On the J Series device, CRTP can be configured as a compression device on a T1 or
E1 interface with PPP encapsulation, using the link services interface.

For more information about configuring CRTP on a single link, see the Junos Network
Interfaces Configuration Guide and the Junos Services Interfaces Configuration Guide.

To configure CRTP on the device:

1. Navigate to the top of the interfaces configuration hierarchy in either the J-Web
or CLI configuration editor.

2. Perform the configuration tasks described in Table 125 on page 430.

3. If you are finished configuring the device, commit the configuration.

Table 125: Adding CRTP to a T1 or E1 Interface

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit interfaces
interface-name

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

Navigate to the  Interfaces level in the
configuration hierarchy.

1. Enter

set encapsulation ppp

2. Enter

edit unit 0

1. Next to a T1 or E1 interface, click Edit.

2. From the Encapsulation list, select ppp as the
encapsulation type.

3. Next to Unit, click Add new entry.

4. In the Interface unit number box, type 0.

Select an E1 or T1 interface—for example,
t1–1/0/0.

Set PPP as the type of encapsulation for the
physical interface.

Enter

set compression-device
lsq-0/0/0.0

1. In the Compression device box, enter
lsq-0/0/0.0.

2. Click OK until you return to the Interfaces
page.

Add the link services intelligent queuing
interface, lsq-0/0/0.0, to the physical
interface.

From the [edit interfaces]
hierarchy level, enter

edit interfaces lsq-0/0/0
unit 0

1. Next to Interface, click Add new entry.

2. In the Interface name box, type lsq-0/0/0.

3. Click OK to return to the Interfaces page.

4. On the main Interface page, next to lsq-0/0/0,
click Edit.

5. Next to Unit, click Add new entry.

6. In the Interface unit number box, type 0.

Add the link services intelligent queuing
interface, lsq-0/0/0, to the device.
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Table 125: Adding CRTP to a T1 or E1 Interface (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set compression rtp
f-max-period 2500 port
minimum 2000 maximum
64009

1. Next to Compression, select yes, and then
click Configure.

2. Select RTP, and then click Configure.

3. In the F-Max period box, type 2500.

4. Select Port, then click Configure.

5. In the Minimum value box, type 2000.

6. In the Maximum value box, type 64009.

7. Click OK.

Configure the link services intelligent
queuing interface, lsq-0/0/0, properties.

F-max period—Maximum number of
compressed packets allowed between
transmission of full headers. It has a range
from 1 to 65535.

Maximum and Minimum—UDP port values
from 1 to 65536 reserve these ports for RTP
compression. CRTP is applied to network
traffic on ports within this range. This feature
is applicable only to voice services interfaces.

Verifying the Link Services intelligent queuing Interface Configuration

To verify a link services configuration, perform the following tasks:

■ Displaying Multilink Bundle Configurations on page 431

■ Displaying Link Services CoS Configurations on page 432

■ Verifying Link Services Interface Statistics on page 434

■ Verifying Link Services CoS on page 437

Displaying Multilink Bundle Configurations

Purpose Verify the multilink bundle configuration.

Action From the J-Web interface, select Configure>CLI Tools>CLI Viewer. Alternatively,
from configuration mode in the CLI, enter the show interfaces command.

The sample output in this section displays the multilink bundle configurations provided
in “Configuring MLPPP Bundles and LFI on Serial Links” on page 413.

NOTE: The MLFR FRF.15 and MLFR FRF.16 configurations are not displayed in this
section, but you can display MLFR configurations in the same manner.

[edit]
user@R0# show interfaces
interfaces {

lsq-0/0/0 {
per-unit-scheduler;
unit 0 {

encapsulation multilink-ppp;
fragment-threshold 128;
family inet {
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address 10.0.0.10/24;
}

}
}
ge-0/0/1 {

unit 0 {
family inet {

address 192.1.1.1/24;
}

}
}
se-1/0/0 {

per-unit-scheduler;
dce-options {

clocking-mode dce;
clocking-rate 2.0mhz;

}
unit 0 {

family mlppp {
bundle lsq-0/0/0.0;

}
}

}
se-1/0/1 {

per-unit-scheduler;
dce-options {

clocking-mode dce;
clocking-rate 2.0mhz;

}
unit 0 {

family mlppp {
bundle lsq-0/0/0.0;

}
}

}
}

Meaning Verify that the output shows the intended multilink bundle configurations.

Related Topics For more information about the format of a configuration file, see the J-Web Interface
User Guide or the Junos CLI User Guide.

Displaying Link Services CoS Configurations

Purpose Displaying the CoS configurations on the link services interface.

Action From the J-Web interface, select Configure>CLI Tools>CLI Viewer. Alternatively,
from the configuration mode in the CLI, enter the show class-of-service command.

The sample output in this section displays the CoS configurations provided in
“Configuring MLPPP Bundles and LFI on Serial Links” on page 413.
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[edit]
user@R0# show class-of-service
classifiers {

inet-precedence classify_input {
forwarding-class DATA {

loss-priority low code-points 000;
}
forwarding-class VOICE {

loss-priority low code-points 010;
}

}
}
forwarding-classes {

queue 0 DATA;
queue 2 VOICE;
queue 3 NC;

}
interfaces {

ls-0/0/0 {
unit 0 {

scheduler-map s_map;
fragmentation-maps fm;

}
}
ge-0/0/1 {

unit 0 {
classifiers {

inet-precedence classify_input
}

}
}
se-1/0/0 {

unit 0 {
scheduler-map s_map;
shaping-rate 2000000;

}
}
se-1/0/1 {

unit 0 {
scheduler-map s_map;
shaping-rate 2000000;

}
}

}
scheduler-maps {

s_map {
forwarding-class DATA scheduler DATA;
forwarding-class VOICE scheduler VOICE;
forwarding-class NC scheduler NC;

}
}
schedulers {

DATA {
transmit-rate percent 49;
buffer-size percent 49;

}
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VOICE {
transmit-rate percent 50;
buffer-size percent 5;
priority high;

}
NC {

transmit-rate percent 1;
buffer-size percent 1;
priority high;

}
}
fragmentation-maps fm {

forwarding-class {
VOICE {

no-fragmentation;
}

}
}

Meaning Verify that the output shows the intended CoS configurations.

Related Topics For more information about the format of a configuration file, see the J-Web Interface
User Guide or the Junos CLI User Guide.

Verifying Link Services Interface Statistics

Purpose Verify the link services interface statistics.

Action The sample output provided in this section is based on the configurations provided
in “Configuring MLPPP Bundles and LFI on Serial Links” on page 413. To verify that
the constituent links are added to the bundle correctly and the packets are fragmented
and transmitted correctly, take the following actions:

1. On Device R0 and Device R1, the two J Series devices used in this example,
configure MLPPP and LFI as described in “Configuring MLPPP Bundles and LFI
on Serial Links” on page 413.

2. From the CLI, enter the ping command to verify that a connection is established
between R0 and R1.

3. Transmit 10 data packets, 200 bytes each, from R0 to R1.

4. On R0, from the CLI, enter the show interfaces interface-name statistics command.

Sample Output user@R0> show interfaces lsq-0/0/0 statistics detail
Physical interface: lsq-0/0/0, Enabled, Physical link is Up
  Interface index: 134, SNMP ifIndex: 29, Generation: 135
  Link-level type: LinkService, MTU: 1504
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Last flapped   : 2006-06-23 11:36:23 PDT (03:38:43 ago)
  Statistics last cleared: 2006-06-23 15:13:12 PDT (00:01:54 ago)
  Traffic statistics:
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   Input  bytes  :                    0                    0 bps
   Output bytes  :                 1820                    0 bps
   Input  packets:                    0                    0 pps
   Output packets:                   10                    0 pps
  ...
  Egress queues: 8 supported, 8 in use
  Queue counters:       Queued packets  Transmitted packets      Dropped packets

    0 DATA                          10                   10                    0

    1 expedited-fo                   0                    0                    0

    2 VOICE                          0                    0                    0

    3 NC                             0                    0                    0

  Logical interface lsq-0/0/0.0 (Index 67) (SNMP ifIndex 41) (Generation 133)
    Flags: Point-To-Point SNMP-Traps 0x4000 Encapsulation: Multilink-PPP
    Bandwidth: 16mbps
    Bundle options:
      ...
      Drop timer period               0
      Sequence number format          long (24 bits)
      Fragmentation threshold         128
      Links needed to sustain bundle  1
      Interleave fragments            Enabled
    Bundle errors:
      Packet drops                    0 (0 bytes)
      Fragment drops                  0 (0 bytes)
     ...
    Statistics         Frames        fps         Bytes          bps
    Bundle:
      Fragments:
        Input :             0          0             0            0
        Output:            20          0          1920            0
      Packets:
        Input :             0          0             0            0
        Output:            10          0          1820            0
    Link:
      se-1/0/0.0
        Input :             0          0             0            0
        Output:            10          0          1320            0
      se-1/0/1.0
        Input :             0          0             0            0
        Output:            10          0           600            0
  ...
      Destination: 10.0.0.9/24, Local: 10.0.0.10, Broadcast: Unspecified, 
Generation:144

Meaning This output shows a summary of interface information. Verify the following
information:

■ Physical interface—The physical interface is Enabled. If the interface is shown as
Disabled, do either of the following:

■ In the CLI configuration editor, delete the disable statement at the [edit
interfaces interface-name] level of the configuration hierarchy.
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■ In the J-Web configuration editor, clear the Disable check box on the
Interfaces>interface-name page.

■ Physical link—The physical link is Up. A link state of Down indicates a problem
with the interface module, interface port, or physical connection (link-layer
errors).

■ Last flapped—The Last Flapped time is an expected value. The Last Flapped time
indicates the last time the physical interface became unavailable and then
available again. Unexpected flapping indicates likely link-layer errors.

■ Traffic statistics—Number and rate of bytes and packets received and transmitted
on the interface. Verify that the number of inbound and outbound bytes and
packets match the expected throughput for the physical interface. To clear the
statistics and see only new changes, use the clear interfaces statistics
interface-name command.

■ Queue counters—Name and number of queues are as configured. This sample
output shows that 10 data packets were transmitted and no packets were
dropped.

■ Logical interface—Name of the multilink bundle you configured—lsq-0/0/0.0.

■ Bundle options—Fragmentation threshold is correctly configured, and fragment
interleaving is enabled.

■ Bundle errors—Any packets and fragments dropped by the bundle.

■ Statistics—The fragments and packets are received and transmitted correctly
by the device. All references to traffic direction (input or output) are defined with
respect to the device. Input fragments received by the device are assembled into
input packets. Output packets are segmented into output fragments for
transmission out of the device.

In this example, 10 data packets of 200 bytes were transmitted. Because the
fragmentation threshold is set to 128 bytes, all data packets were fragmented
into two fragments. The sample output shows that 10 packets and 20 fragments
were transmitted correctly.

■ Link—The constituent links are added to this bundle and are receiving and
transmitting fragments and packets correctly. The combined number of fragments
transmitted on the constituent links must be equal to the number of fragments
transmitted from the bundle. This sample output shows that the bundle
transmitted 20 fragments and the two constituent links se-1/0/0.0 and
se-1/0/1.0.0 correctly transmitted 10+10=20 fragments.

■ Destination and Local—IP address of the remote side of the multilink bundle and
the local side of the multilink bundle. This sample output shows that the
destination address is the address on R1 and the local address is the address on
R0.

Related Topics For a complete description of show interfaces output, see the Junos Interfaces Command
Reference.
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Verifying Link Services CoS

Purpose Verify CoS configurations on the link services interface.

Action From the CLI, enter the following commands:

■ show class-of-service interface interface-name

■ show class-of-service classifier name classifier-name

■ show class-of-service scheduler-map scheduler-map-name

The sample output provided in this section is based on the configurations provided
in “Configuring MLPPP Bundles and LFI on Serial Links” on page 413.

Sample Output user@R0> show class-of-service interface lsq-0/0/0
Physical interface: lsq-0/0/0, Index: 136
Queues supported: 8, Queues in use: 4
  Scheduler map: [default], Index: 2
  Input scheduler map: [default], Index: 3
  Chassis scheduler map: [default-chassis], Index: 4
 Logical interface: lsq-0/0/0.0, Index: 69
    Object               Name                    Type              Index
    Scheduler-map        s_map                   Output            16206
    Classifier          ipprec-compatibility     ip                   12

user@R0> show class-of-service interface ge-0/0/1
Physical interface: ge-0/0/1, Index: 140
          Queues supported: 8, Queues in use: 4
          Scheduler map: [default], Index: 2
          Input scheduler map: [default], Index: 3

         Logical interface: ge-0/0/1.0, Index: 68
         Object              Name                   Type         Index
         Classifier         classfy_input            ip           4330

user@R0> show class-of-service classifier name classify_input
Classifier: classfy_input, Code point type: inet-precedence, Index: 4330

  Code point       Forwarding class            Loss priority
    000                  DATA                       low         
    010                  VOICE                      low   

user@R0> show class-of-service scheduler-map s_map
Scheduler map: s_map, Index: 16206

  Scheduler: DATA, Forwarding class: DATA, Index: 3810
  Transmit rate: 49 percent, Rate Limit: none, Buffer size: 49 percent, 
Priority:low
    Drop profiles:
      Loss priority        Protocol         Index         Name
      Low                    any             1         [default-drop-profile]   

      Medium low             any             1         [default-drop-profile]   

      Medium high            any             1         [default-drop-profile]   

      High                   any             1         [default-drop-profile]   
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  Scheduler: VOICE, Forwarding class: VOICE, Index: 43363
  Transmit rate: 50 percent, Rate Limit: none, Buffer size: 5 percent, 
Priority:high
    Drop profiles:
      Loss priority        Protocol          Index        Name
      Low                      any             1        [default-drop-profile]  

      Medium low               any             1        [default-drop-profile]  

      Medium high              any             1        [default-drop-profile]  

      High                     any             1        [default-drop-profile]  

  Scheduler: NC, Forwarding class: NC, Index: 2435
  Transmit rate: 1 percent, Rate Limit: none, Buffer size: 1 percent, Priority:high

    Drop profiles:
      Loss priority        Protocol         Index      Name
      Low                     any             1       [default-drop-profile]    

      Medium low              any             1       [default-drop-profile]    

      Medium high             any             1       [default-drop-profile]    

      High                    any             1       [default-drop-profile]  

Meaning These output examples show a summary of configured CoS components. Verify the
following information:

■ Logical Interface—Name of the multilink bundle and the CoS components applied
to the bundle. The sample output shows that the multilink bundle is lsq-0/0/0.0,
and the CoS scheduler-map s_map is applied to it.

■ Classifier—Code points, forwarding classes, and loss priorities assigned to the
classifier. The sample output shows that a default classifier, ipprec-compatibility,
was applied to the lsq-0/0/0 interface and the classifier classify_input was applied
to the ge-0/0/1 interface.

■ Scheduler—Transmit rate, buffer size, priority, and loss priority assigned to each
scheduler. The sample output displays the data, voice, and network control
schedulers with all the configured values.

Related Topics For complete descriptions of show class-of-service commands and output, see the
Junos System Basics and Services Command Reference.
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Frequently Asked Questions About the Link Services Interface

Use answers to the following questions to solve configuration problems on a link
services interface:

■ Which CoS Components Are Applied to the Constituent Links? on page 439

■ What Causes Jitter and Latency on the Multilink Bundle? on page 440

■ Are LFI and Load Balancing Working Correctly? on page 441

■ Why Are Packets Dropped on a PVC Between a J Series Device and Another
Vendor? on page 447

Which CoS Components Are Applied to the Constituent Links?

Problem—I have configured a multilink bundle, but I also have traffic without MLPPP
encapsulation passing through constituent links of the multilink bundle. Do I apply
all CoS components to the constituent links, or is applying them to the multilink
bundle enough?

Solution—On a J Series device you can apply a scheduler map to the multilink bundle
and its constituent links. Although you can apply several CoS components with the
scheduler map, configure only the ones that are required. We recommend that you
keep the configuration on the constituent links simple to avoid unnecessary delay
in transmission.

Table 126 on page 439 shows the CoS components to be applied on a multilink bundle
and its constituent links. For more information, see the Junos Class of Service
Configuration Guide.

Table 126: CoS Components Applied on Multilink Bundles and Constituent Links

Explanation
Constituent
LinksMultilink BundleCos Component

CoS classification takes place on the incoming side of
the interface, not on the transmitting side, so no
classifiers are needed on constituent links.

NoYesClassifier

Forwarding class is associated with a queue, and the
queue is applied to the interface by a scheduler map.
The queue assignment is predetermined on the
constituent links. All packets from Q2 of the multilink
bundle are assigned to Q2 of the constituent link, and
packets from all the other queues are queued to Q0 of
the constituent link.

NoYesForwarding class
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Table 126: CoS Components Applied on Multilink Bundles and Constituent Links (continued)

Explanation
Constituent
LinksMultilink BundleCos Component

Apply scheduler maps on the multilink bundle and the
constituent links, as follows:

■ Transmit rate—Make sure that the relative order of
the transmit rate configured on Q0 and Q2 is the
same on the constituent links as on the multilink
bundle.

■ Scheduler priority—Make sure that the relative
order of the scheduler priority configured on Q0
and Q2 is the same on the constituent links as on
the multilink bundle.

■ Buffer size—Because all non-LFI packets from the
multilink bundle transit Q0 of constituent links,
make sure that the buffer size on Q0 of the
constituent links is large enough.

■ RED drop profile—Configure a RED drop profile on
the multilink bundle only. Configuring the RED drop
profile on the constituent links applies a back
pressure mechanism that changes the buffer size
and introduces variation. Because this behavior
might cause fragment drops on the constituent
links, make sure to leave the RED drop profile at
the default settings on the constituent links.

YesYesScheduler map

Because per-unit scheduling is applied only at the end
point, apply this shaping rate to the constituent links
only. Any configuration applied earlier is overwritten by
the constituent link configuration.

YesNoShaping rate for a per-unit
scheduler or an interface-level
scheduler

The interface-level shaping applied on the constituent
links overrides any shaping on the queue. Thus apply
transmit-rate exact shaping on the multilink bundle only.

NoYesTransmit-rate exact or
queue-level shaping

Rewrite bits are copied from the packet into the
fragments automatically during fragmentation. Thus
what you configure on the multilink bundle is carried
on the fragments to the constituent links.

NoYesRewrite rules

Virtual channel groups are identified through firewall
filter rules that are applied on packets only before the
multilink bundle. Thus you do not need to apply the
virtual channel group configuration to the constituent
links.

NoYesVirtual channel group

What Causes Jitter and Latency on the Multilink Bundle?

Problem—To test jitter and latency on a J Series device, I sent three streams of IP
packets. All packets have the same IP precedence settings. After I configured LFI and
CRTP, the latency increased even over a non-congested link. How can I reduce jitter
and latency?

Solution—To reduce jitter and latency, do the following:
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1. Make sure that you have configured a shaping rate on each constituent link.

2. Make sure that you have not configured a shaping rate on the link services
interface.

3. Make sure that the configured shaping rate value is equal to the physical interface
bandwidth. For more information, see “Applying Shaping Rates to Interfaces”
on page 423.

4. If shaping rates are configured correctly, and jitter still persists, contact the
Juniper Networks Technical Assistance Center (JTAC). (See “Requesting Technical
Support” on page xl.)

Are LFI and Load Balancing Working Correctly?

Problem—I have a single network that supports multiple services. My network
transmits data and delay-sensitive voice traffic. I configured MLPPP and LFI to make
sure that voice packets are transmitted across the network with very little delay and
jitter. How can I find out if voice packets are being treated as LFI packets and load
balancing is performed correctly?

Solution—When LFI is enabled, data (non-LFI) packets are encapsulated with an
MLPPP header and fragmented to packets of a specified size. The delay-sensitive,
voice (LFI) packets are PPP-encapsulated and interleaved between data packet
fragments. Queuing and load balancing are performed differently for LFI and non-LFI
packets.

To verify that LFI is performed correctly, determine that packets are fragmented and
encapsulated as configured. After you know whether a packet is treated as an LFI
packet or a non-LFI packet, you can confirm whether the load balancing is performed
correctly.

Solution Scenario—Suppose two J Series devices R0 and R1 are connected by a
multilink bundle lsq-0/0/0.0 that aggregates two serial links, se-1/0/0 and se-1/0/1.
On R0 and R1, MLPPP and LFI are enabled on the link services interface and the
fragmentation threshold is set to 128 bytes.

In this example, we used a packet generator to generate voice and data streams.
You can use the packet capture feature to capture and analyze the packets on the
incoming interface. For more information, see the Junos OS Administration Guide for
Security Devices.

The following two data streams were sent on the multilink bundle:

■ 100 data packets of 200 bytes (larger than the fragmentation threshold)

■ 500 data packets of 60 bytes (smaller than the fragmentation threshold)

The following two voice streams were sent on the multilink bundle:

■ 100 voice packets of 200 bytes from source port 100

■ 300 voice packets of 200 bytes from source port 200
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To confirm that LFI and load balancing are performed correctly, first verify that the
link services interface is performing packet fragmentation as configured. Second,
verify that the interface is encapsulating packets as configured. Finally, use the results
to verify load balancing.

NOTE: Only the significant portions of command output are displayed and described
in this example. For more information, see “Verifying the Link Services intelligent
queuing Interface Configuration” on page 431.

Step 1: Verifying Packet Fragmentation

From the CLI, enter the show interfaces lsq-0/0/0 command, to check that large
packets are fragmented correctly.

user@R0#> show interfaces lsq-0/0/0
Physical interface: lsq-0/0/0, Enabled, Physical link is Up
  Interface index: 136, SNMP ifIndex: 29
  Link-level type: LinkService, MTU: 1504
  Device flags   : Present Running
  Interface flags: Point-To-Point SNMP-Traps
  Last flapped   : 2006-08-01 10:45:13 PDT (2w0d 06:06 ago)
  Input rate     : 0 bps (0 pps)
  Output rate    : 0 bps (0 pps)

  Logical interface lsq-0/0/0.0 (Index 69) (SNMP ifIndex 42) 
    Flags: Point-To-Point SNMP-Traps 0x4000 Encapsulation: Multilink-PPP
    Bandwidth: 16mbps
    Statistics         Frames      fps       Bytes        bps
    Bundle:
      Fragments:
        Input :             0        0           0          0
        Output:          1100        0      118800          0
      Packets:
        Input :             0        0           0          0
        Output:          1000        0      112000          0
   ...
    Protocol inet, MTU: 1500
      Flags: None
      Addresses, Flags: Is-Preferred Is-Primary
        Destination: 9.9.9/24, Local: 9.9.9.10

What It Means—The output shows a summary of packets transiting the device on
the multilink bundle. Verify the following information on the multilink bundle:

■ The total number of transiting packets = 1000

■ The total number of transiting fragments=1100

■ The number of data packets that were fragmented =100

The total number of packets sent (600 + 400) on the multilink bundle match the
number of transiting packets (1000), indicating that no packets were dropped.

The number of transiting fragments exceeds the number of transiting packets by
100, indicating that 100 large data packets were correctly fragmented.
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Corrective Action—If the packets are not fragmented correctly, check your
fragmentation threshold configuration. Packets smaller than the specified
fragmentation threshold are not fragmented. For information about configuring the
fragmentation threshold, see “Configuring the Link Services Interface with a
Configuration Editor” on page 413.

Step 2: Verifying Packet Encapsulation

To find out whether a packet is treated as an LFI or non-LFI packet, determine its
encapsulation type. LFI packets are PPP encapsulated, and non-LFI packets are
encapsulated with both PPP and MLPPP. PPP and MLPPP encapsulations have
different overheads resulting in different-sized packets. You can compare packet
sizes to determine the encapsulation type.

A small unfragmented data packet contains a PPP header and a single MLPPP header.
In a large fragmented data packet, the first fragment contains a PPP header and an
MLPPP header, but the consecutive fragments contain only an MLPPP header.

PPP and MLPPP encapsulations add the following number of bytes to a packet:

■ PPP encapsulation adds 7 bytes:

4 bytes of header+2 bytes of frame check sequence (FCS)+1 byte that is idle
or contains a flag

■ MLPPP encapsulation adds between 6 and 8 bytes:

4 bytes of PPP header+2 to 4 bytes of multilink header

Figure 49 on page 443 shows the overhead added to PPP and MLPPP headers.

Figure 49: PPP and MLPPP Headers

For CRTP packets, the encapsulation overhead and packet size are even smaller than
for an LFI packet. For more information, see “Configuring CRTP” on page 430.

Table 127 on page 444 shows the encapsulation overhead for a data packet and a
voice packet of 70 bytes each. After encapsulation, the size of the data packet is
larger than the size of the voice packet.
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Table 127: PPP and MLPPP Encapsulation Overhead

Packet Size
after
EncapsulationEncapsulation Overhead

Initial
Packet SizeEncapsulationPacket Type

77 bytes4 + 2 + 1 = 7 bytes70 bytesPPPVoice packet (LFI)

83 bytes4 + 2 + 1 + 4 + 2 = 13 bytes70 bytesMLPPPData fragment (non-LFI)
with short sequence

85 bytes4 + 2 + 1 + 4 + 4 = 15 bytes70 bytesMLPPPData fragment (non-LFI)
with long sequence

From the CLI, enter the show interfaces queue command to display the size of
transmitted packet on each queue. Divide the number of bytes transmitted by the
number of packets to obtain the size of the packets and determine the encapsulation
type.

Step 3: Verifying Load Balancing

From the CLI, enter the show interfaces queue command on the multilink bundle and
its constituent links to confirm whether load balancing is performed accordingly on
the packets.

user@R0> show interfaces queue lsq-0/0/0
Physical interface: lsq-0/0/0, Enabled, Physical link is Up
  Interface index: 136, SNMP ifIndex: 29
Forwarding classes: 8 supported, 8 in use
Egress queues: 8 supported, 8 in use
Queue: 0, Forwarding classes: DATA 
  Queued:
    Packets              :                600                  0 pps
    Bytes                :              44800                  0 bps
  Transmitted:
    Packets              :                600                  0 pps
    Bytes                :              44800                  0 bps
    Tail-dropped packets :                  0                  0 pps
    RED-dropped packets  :                  0                  0 pps
    …
Queue: 1, Forwarding classes: expedited-forwarding 
  Queued:
    Packets              :                  0                  0 pps
    Bytes                :                  0                  0 bps
  …
Queue: 2, Forwarding classes: VOICE 
  Queued:
    Packets              :                400                  0 pps
    Bytes                :              61344                  0 bps
  Transmitted:
    Packets              :                400                  0 pps
    Bytes                :              61344                  0 bps
    …
Queue: 3, Forwarding classes: NC 
  Queued:
    Packets              :                  0                  0 pps
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    Bytes                :                  0                  0 bps
 …

user@R0> show interfaces queue se-1/0/0
Physical interface: se-1/0/0, Enabled, Physical link is Up
  Interface index: 141, SNMP ifIndex: 35
Forwarding classes: 8 supported, 8 in use
Egress queues: 8 supported, 8 in use
Queue: 0, Forwarding classes: DATA 
  Queued:
    Packets              :                350                 0 pps
    Bytes                :              24350                 0 bps
  Transmitted:
    Packets              :                350                 0 pps
    Bytes                :              24350                 0 bps
   ...
Queue: 1, Forwarding classes: expedited-forwarding 
  Queued:
    Packets              :                  0                 0 pps
    Bytes                :                  0                 0 bps
  …
Queue: 2, Forwarding classes: VOICE 
  Queued:
    Packets              :                100                 0 pps
    Bytes                :              15272                 0 bps
  Transmitted:
    Packets              :                100                 0 pps
    Bytes                :              15272                 0 bps
    …
Queue: 3, Forwarding classes: NC 
  Queued:
    Packets              :                 19                 0 pps
    Bytes                :                247                 0 bps
  Transmitted:
    Packets              :                 19                 0 pps
    Bytes                :                247                 0 bps
    …

user@R0> show interfaces queue se-1/0/1
Physical interface: se-1/0/1, Enabled, Physical link is Up
  Interface index: 142, SNMP ifIndex: 38
Forwarding classes: 8 supported, 8 in use
Egress queues: 8 supported, 8 in use
Queue: 0, Forwarding classes: DATA 
  Queued:
    Packets              :                350                 0 pps
    Bytes                :              24350                 0 bps
  Transmitted:
    Packets              :                350                 0 pps
    Bytes                :              24350                 0 bps
    …
Queue: 1, Forwarding classes: expedited-forwarding 
  Queued:
    Packets              :                  0                 0 pps
    Bytes                :                  0                 0 bps
  …
Queue: 2, Forwarding classes: VOICE 
  Queued:
    Packets              :                300                 0 pps
    Bytes                :              45672                 0 bps
  Transmitted:
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    Packets              :                300                 0 pps
    Bytes                :              45672                 0 bps
    …
Queue: 3, Forwarding classes: NC 
  Queued:
    Packets              :                 18                 0 pps
    Bytes                :                234                 0 bps
  Transmitted:
    Packets              :                 18                 0 pps
    Bytes                :                234                 0 bps

What It Means—The output from these commands shows the packets transmitted
and queued on each queue of the link services interface and its constituent links.
Table 128 on page 446 shows a summary of these values. (Because the number of
transmitted packets equaled the number of queued packets on all the links, this table
shows only the queued packets.)

Table 128: Number of Packets Transmitted on a Queue

Explanation
Constituent Link
se-1/0/1

Constituent Link
se-1/0/0

Bundle
lsq-0/0/0.0Packets Queued

The total number of packets transiting
the constituent links (350+350 =
700) exceeded the number of packets
queued (600) on the multilink bundle.

350350600Packets on Q0

The total number of packets transiting
the constituent links equaled the
number of packets on the bundle.

300100400Packets on Q2

The packets transiting Q3 of the
constituent links are for keepalive
messages exchanged between
constituent links. Thus no packets
were counted on Q3 of the bundle.

18190Packets on Q3

On the multilink bundle, verify the following:

■ The number of packets queued matches the number transmitted. If the numbers
match, no packets were dropped. If more packets were queued than were
transmitted, packets were dropped because the buffer was too small. The buffer
size on the constituent links controls congestion at the output stage. To correct
this problem, increase the buffer size on the constituent links. For more
information, see “Defining and Applying Scheduler Maps” on page 420.

■ The number of packets transiting Q0 (600) matches the number of large and
small data packets received (100+500) on the multilink bundle. If the numbers
match, all data packets correctly transited Q0.

■ The number of packets transiting Q2 on the multilink bundle (400) matches the
number of voice packets received on the multilink bundle. If the numbers match,
all voice LFI packets correctly transited Q2.
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On the constituent links, verify the following:

■ The total number of packets transiting Q0 (350+350) matches the number of
data packets and data fragments (500+200). If the numbers match, all the data
packets after fragmentation correctly transited Q0 of the constituent links.

Packets transited both constituent links, indicating that load balancing was
correctly performed on non-LFI packets.

■ The total number of packets transiting Q2 (300+100) on constituent links
matches the number of voice packets received (400) on the multilink bundle. If
the numbers match, all voice LFI packets correctly transited Q2.

LFI packets from source port 100 transited se-1/0/0, and LFI packets from source
port 200 transited se-1/0/1. Thus all LFI (Q2) packets were hashed based on
the source port and correctly transited both constituent links.

Corrective Action—If the packets transited only one link, take the following steps
to resolve the problem:

1. Determine whether the physical link is up (operational) or down (unavailable).
An unavailable link indicates a problem with the PIM, interface port, or physical
connection (link-layer errors). If the link is operational, move to the next step.

2. Verify that the classifiers are correctly defined for non-LFI packets. Make sure
that non-LFI packets are not configured to be queued to Q2. All packets queued
to Q2 are treated as LFI packets.

3. Verify that at least one of the following values is different in the LFI packets:
source address, destination address, IP protocol, source port, or destination port.
If the same values are configured for all LFI packets, the packets are all hashed
to the same flow and transit the same link.

Why Are Packets Dropped on a PVC Between a J Series Device and Another Vendor?

Problem—I configured a permanent virtual circuit (PVC) between T1, E1, T3, or E3
interfaces on my Juniper Networks device and another vendor's device, and packets
are being dropped and ping fails.

Solution—If the other vendor's device does not have the same FRF.12 support as
the J Series device or supports FRF.12 in a different way, the J Series interface on
the PVC might discard a fragmented packet containing FRF.12 headers and count it
as a "Policed Discard." As a workaround for this problem, configure multilink bundles
on both peers, and configure fragmentation thresholds on the multilink bundles.
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Chapter 15

Aggregated Ethernet

This chapter describes aggregated Ethernet and how to configure aggregated Ethernet
interfaces. It also describes the Link Aggregation Control Protocol (LACP), which
provides additional functionality for link aggregation groups (LAGs) and, in the case
of chassis clusters, for redundant Ethernet interface LAGs.

NOTE: This chapter is specific to the SRX3000 and SRX5000 line devices. For
information about link aggregation for other SRX Series devices and J Series devices,
see the “Configuring Ethernet Ports for Switching” chapter in the Junos OS Layer 2
Bridging and Switching Configuration Guide for Security Devices.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Aggregated Ethernet Overview on page 449

■ Configuring Aggregated Ethernet Interfaces on page 450

■ Understanding Chassis Cluster Redundant Ethernet Interface Link Aggregation
Groups on page 454

■ Understanding the Link Aggregation Control Protocol on page 455

■ Understanding LACP in Chassis Cluster Mode on page 456

■ Configuring LACP on Stand-Alone Devices on page 457

■ Configuring LACP on Chassis Clusters on page 458

■ Verifying Aggregated Ethernet Interfaces on page 459

Aggregated Ethernet Overview

Link aggregation of Ethernet interfaces is defined in the IEEE 802.3ad standard. The
JUNOS Software implementation of 802.3ad balances traffic across the member links
within an aggregated Ethernet bundle based on Layer 3 or Layer 4 (or both)
information carried in the packet or based on session ID data. (The session ID data
has higher precedence than the Layer 3 or 4 information.) This implementation uses
the same load-balancing algorithm used for per-packet load balancing.

You can combine multiple physical Ethernet ports to form a logical point-to-point
link, known as a link aggregation group (LAG) or bundle. Support for LAGs based on
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IEEE 802.3ad makes it possible to aggregate physical interface links on your device.
LAGs provide increased interface bandwidth and link availability by linking physical
ports and load-balancing traffic crossing the combined interface.

In a chassis cluster configuration, link aggregation allows a redundant Ethernet
interface to add multiple child interfaces from both nodes and thereby create a
redundant Ethernet interface link aggregation group (LAG).

Link aggregation allows one or more links to be combined together to form a LAG,
such that a media access control (MAC) client can treat the LAG as if it were a single
link. For the LAG to operate correctly, it is necessary to coordinate the two end
systems connected by the LAG, either manually or automatically.

Internally, a LAG is a virtual interface presented on SRX3000 and SRX5000 line
devices or on any system (consisting of devices such as routers and switches)
supporting 802.3ad link aggregation. Externally, a LAG corresponds to a bundle of
physical Ethernet links connected between an SRX3000 or SRX5000 line device and
another system capable of link aggregation. This bundle of physical links is a virtual
link.

JUNOS Software supports the Link Aggregation Control Protocol (LACP), which is a
subcomponent of IEEE 802.3ad. LACP provides additional functionality for LAGs.

LACP is supported in standalone (single chassis) deployments, where aggregated
Ethernet interfaces are supported, and in chassis cluster deployments, where
aggregated Ethernet interfaces and redundant Ethernet interfaces are supported
simultaneously.

Aggregated Ethernet interfaces can be Layer 3 interfaces (VLAN-tagged or untagged)
and Layer 2 interfaces. LACP is supported on Layer 3 only.

Related Topics

■ Configuring Aggregated Ethernet Interfaces on page 450

■ Understanding Chassis Cluster Redundant Ethernet Interface Link Aggregation
Groups on page 454

■ Understanding the Link Aggregation Control Protocol on page 455

Configuring Aggregated Ethernet Interfaces

You configure an aggregated Ethernet virtual link by specifying the link number as
a physical device and then associating a set of ports that have the same speed and
are in full-duplex mode. The physical ports can be 100-Megabit Ethernet, 1-Gigabit
Ethernet, and 10-Gigabit Ethernet.

Note the following support details for the SRX3000 and SRX5000 lines:

■ The devices support a maximum of 16 physical interfaces per single aggregated
Ethernet bundle.

■ Aggregated Ethernet interfaces can use interfaces from the same or different
Flexible PIC Concentrators (FPCs) and PICs.
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■ On the aggregated bundle, capabilities such as MAC accounting, VLAN rewrites,
and VLAN queuing are available.

Aggregated Ethernet interfaces can be either VLAN-tagged or untagged, with LACP
enabled or disabled. Aggregated Ethernet interfaces on the SRX3000 and SRX5000
lines support the configuration of native-vlan-id, which consists of the following
configuration statements:

■ inner-tag-protocol-id

■ inner-vlan-id

■ pop-pop

■ pop-swap

■ push-push

■ swap-push

■ swap-swap

NOTE: You can enable promiscuous mode on aggregated Ethernet interfaces. When
promiscuous mode is enabled on a Layer 3 Ethernet interface, all packets received
on the interface are sent to the central point or Services Processing Unit regardless
of the destination MAC address of the packet. If you enable promiscuous mode on
an aggregated Ethernet interface, promiscuous mode is then enabled on all member
interfaces.

You must set the number of aggregated Ethernet interfaces on the chassis. You can
also set the member link speed and the minimum links in a bundle.

Configuring the Number of Aggregated Ethernet Interfaces on the Device

By default, no aggregated Ethernet interfaces are created. You must set the number
of aggregated Ethernet interfaces on the routing device before you can configure
them.

Once the device-count statement is specified, the system creates that number of
empty aggregated Ethernet interfaces. A globally unique MAC address is assigned to
every aggregated Ethernet interface. More aggregated Ethernet interfaces can be
created by increasing the parameter.

The maximum number of aggregated devices you can configure is 128. The
aggregated interfaces are numbered from ae0 through ae127.

To set the number of aggregated Ethernet interfaces to 2:

user@host# set chassis aggregated-devices ethernet device-count 2
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Associating Physical Interfaces with Aggregated Ethernet Interfaces

You associate a physical interface with an aggregated Ethernet interface. Doing so
associates the physical child links with the logical aggregated parent interface to form
a link aggregation group (LAG). You must also specify the constituent physical links
by including the 802.3ad statement.

A physical interface can be added to any aggregated Ethernet interface as long as all
member links have the same link speed and the maximum number of member links
does not exceed 16. The aggregated Ethernet interface instance number aex can be
from 0 through 127, for a total of 128 aggregated interfaces.

To associate physical interfaces with ae0 and ae1, respectively:

user@host# set interfaces ge-1/0/0 gigether-options 802.3ad ae0
user@host# set interfaces ge-2/0/0 gigether-options 802.3ad ae0
user@host# set interfaces ge-3/0/0 gigether-options 802.3ad ae1
user@host# set interfaces ge-3/0/1 gigether-options 802.3ad ae1
user@host# set interfaces ge-4/0/0 gigether-options 802.3ad ae1

NOTE: If you specify (on purpose or accidentally) that a link already associated with
an aggregated Ethernet interface be associated with another aggregated Ethernet
interface, the link is removed from the previous interface (there is no need for you
to explicitly delete it) and it is added to the other one.

Configuring Aggregated Ethernet Link Speed

On aggregated Ethernet interfaces, you can set the required link speed for all
interfaces included in the bundle. All interfaces that make up a bundle must be the
same speed. If you include in the aggregated Ethernet interface an individual link
that has a speed different from the speed you specify in the link-speed parameter,
an error message will be logged.

The speed value is specified in bits per second either as a complete decimal number
or as a decimal number followed by the abbreviation k (1000), m (1,000,000), or g
(1,000,000,000).

Aggregated Ethernet interfaces on SRX3000 and SRX5000 line devices can have one
of the following speed values:

■ 100m—Links are 100 Mbps.

■ 10g—Links are 10 Gbps.

■ 1g—Links are 1 Gbps.

To set the required link speed for all interfaces included in the bundle to 10 Gbps:

user@host# set interfaces ae0 aggregated-ether-options link-speed 10g
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Configuring Aggregated Ethernet Minimum Links

On aggregated Ethernet interfaces, you can configure the minimum number of links
that must be up for the bundle as a whole to be labeled as up. By default, only one
link must be up for the bundle to be labeled as up.

On SRX3000 and SRX5000 line devices, the valid range for the minimum links
number is 1 through 16. When the maximum value (16) is specified, all configured
links of a bundle must be up for the bundle to be labeled as up.

To set the minimum number of links to 8:

user@host# set interfaces ae0 aggregated-ether-options minimum-links 8

If the number of links configured in an aggregated Ethernet interface is less than the
minimum-links value configured in the minimum-links statement, the configuration
commit fails and an error message is displayed.

Deleting Aggregated Ethernet Interfaces

There are two approaches to deleting an aggregated Ethernet interface:

■ You can delete an aggregated Ethernet interface from the interface configuration.
The JUNOS Software removes the configuration statements related to aex and
sets this interface to the down state. The deleted aggregated Ethernet interface
still exists, but it becomes an empty interface.

To delete aggregated Ethernet interface ae4:

user@host# delete interfaces ae4

■ You can also permanently remove the aggregated Ethernet interface from the
device configuration by deleting it from the device-count on the routing device.

WARNING: Be aware that this approach deletes the aggregated Ethernet interface
objects from the device configuration. The following command deletes all the interface
objects.

To delete all aggregated Ethernet interfaces from the device count:

user@host# delete chassis aggregated-devices ethernet device-count

If you reduce the device-count, only the aggregated Ethernet interface objects at
the end of the list are removed, leaving the newly specified number of interfaces.
That is, if you configure the device- count as 10 and then reduce it to 6, the system
removes the last 4 interface objects from the list.

To reduce the number of aggregated Ethernet interfaces to 6:

user@host# delete chassis aggregated-devices ethernet device-count 6
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Related Topics

■ Aggregated Ethernet Overview on page 449

■ Understanding Chassis Cluster Redundant Ethernet Interface Link Aggregation
Groups on page 454

■ Verifying Aggregated Ethernet Interfaces on page 459

Understanding Chassis Cluster Redundant Ethernet Interface Link Aggregation
Groups

Link aggregation groups (LAGs) can be established across nodes in a chassis cluster.
Link aggregation allows a redundant Ethernet interface (known as a reth interface in
CLI commands) to add multiple child interfaces from both nodes and thereby create
a redundant Ethernet interface LAG.

Instead of one active/standby link, you can configure up to 8 links per node. Having
multiple active redundant Ethernet interface links reduces the possibility of failover.
For example, when an active link is out of service, all traffic on this link is distributed
to other active redundant Ethernet interface links, instead of triggering a redundant
Ethernet active/standby failover.

Standalone link aggregation group interfaces (ae) are supported on clustered devices
but cannot be added to redundant Ethernet interfaces. Likewise any child interface
of an existing LAG cannot be added to a redundant Ethernet interface and vice versa.
The maximum number of total combined standalone aggregate interfaces (ae) and
redundant Ethernet interfaces (reth) per cluster is 128.

Redundant Ethernet interface configuration also includes a minimum-links setting that
allows you to set a minimum number of physical child links in a redundant Ethernet
interface LAG that must be working on the primary node for the interface to be up.
The default minimum-links value is 1. When the number of physical links on the
primary node in a redundant Ethernet interface falls below the minimum-links value,
the interface will be down even if some links are still working.

For more information about Ethernet interface link aggregation with redundant
Ethernet interfaces in a chassis cluster deployment, see the “Chassis Cluster
Redundant Ethernet Interface Link Aggregation Groups” section of the JUNOS Software
Security Configuration Guide.

Related Topics

■ Aggregated Ethernet Overview on page 449

■ Configuring Aggregated Ethernet Interfaces on page 450

■ Understanding LACP in Chassis Cluster Mode on page 456

■ Configuring LACP on Chassis Clusters on page 458
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Understanding the Link Aggregation Control Protocol

JUNOS Software supports the Link Aggregation Control Protocol (LACP), which is a
subcomponent of IEEE 802.3ad. LACP provides additional functionality for LAGs.

LACP provides a standardized means for exchanging information between partner
systems on a link to allow their link aggregation control instances to reach agreement
on the identity of the LAG to which the link belongs, and then to move the link to
that LAG, and to enable the transmission and reception processes for the link to
function in an orderly manner.

For example, when LACP is not enabled, a local LAG might attempt to transmit
packets to a remote individual interface, which causes the communication to fail.
(An individual interface is a non-aggregatable interface.) When LACP is enabled, a
local LAG cannot transmit packets unless a LAG with LACP is also configured on the
remote end of the link.

LACP does not support automatic configuration on SRX3000 and SRX5000 line
devices, but partner systems are allowed to perform automatic configuration. When
an SRX3000 or SRX5000 line device is connected to a fully 802.3ad-compliant partner
system, static configuration of LAGs is initiated on the SRX3000 and SRX5000 line
device side, and static configuration is not needed on the partner side.

NOTE: When an SRX3000 or SRX5000 line device is connected to a Juniper Networks
MX Series router, static configuration of LAGs is needed at both the actor and partner
systems.

LACP is supported in standalone deployments, where aggregated Ethernet interfaces
are supported, and in chassis cluster deployments, where aggregated Ethernet
interfaces and redundant Ethernet interfaces are supported simultaneously.

By default, aggregated and redundant Ethernet links do not exchange link aggregation
control protocol data units (PDUs), which contain information about the state of the
link. You can configure Ethernet links to actively transmit link aggregation control
PDUs, or you can configure the links to passively transmit them, sending out link
aggregation control PDUs only when they receive them from the remote end of the
same link. The local end of a child link is known as the actor and the remote end of
the link is known as the partner. That is, the actor sends link aggregation control
PDUs to its protocol partner that convey what the actor knows about its own state
and that of the partner’s state.

NOTE: Although the LACP functions on the SRX3000 and SRX5000 line devices are
similar to the LACP features on Juniper Networks MX Series routers, the following
LACP features on MX Series routers are not supported on SRX3000 and SRX5000
line devices: link protection, system priority, and port priority for aggregated Ethernet
interfaces. Instead, SRX3000 and SRX5000 line devices provide active/standby
support with redundant Ethernet interface LAGs in chassis cluster deployments.
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Related Topics

■ Aggregated Ethernet Overview on page 449

■ Understanding LACP in Chassis Cluster Mode on page 456

■ Configuring LACP on Stand-Alone Devices on page 457

■ Configuring LACP on Chassis Clusters on page 458

Understanding LACP in Chassis Cluster Mode

In chassis cluster mode, aggregated Ethernet interfaces (ae) and redundant Ethernet
interfaces (reth) coexist. Because the functionality of a redundant Ethernet interface
relies on the JUNOS aggregated Ethernet framework, you can think of it as a special
aggregated Ethernet interface.

A redundant Ethernet interface has active and standby links located on two nodes
in a chassis cluster. All active links in a redundant Ethernet interface are located on
a node, and all standby links are on the other node. The total number of active and
standby links is limited to 16 (8 active and 8 standby).

LACP maintains a point-to-point LAG. Any port connected to the third point is denied.
However, a redundant Ethernet interface does connect to two different systems or
two remote aggregated Ethernet interfaces by design. To support LACP on both
redundant Ethernet interface active and standby links, a redundant Ethernet interface
can be modeled to consist of two sub-LAGs, where all active links form an active
sub-LAG and all standby links form a standby sub-LAG. In this model, LACP selection
logic is applied and limited to one sub-LAG at a time. In this way, two redundant
Ethernet interface sub-LAGs are maintained simultaneously while all the LACP
advantages are preserved for each sub-LAG.

It is necessary for the switches used to connect the nodes in the cluster to have a
LAG link configured and 802.3ad enabled for each LAG on both nodes so that the
aggregate links will be recognized as such and correctly pass traffic.

NOTE: The redundant Ethernet interface LAG child links from each node in the chassis
cluster must be connected to a different LAG at the peer devices. If a single peer
switch is used to terminate the redundant Ethernet interface LAG, two separate LAGs
must be used in the switch.

With LACP, it is essential for the redundant Ethernet interface to support hitless
failover between the active and standby links in normal operation. The term hitless
means that the redundant Ethernet interface state remains up during failover.

The lacpd process manages both the active and standby links of the redundant
Ethernet interfaces. A redundant Ethernet interface pseudolink is in the up condition
when the number of active up links is not less than the number of minimum links
configured. Therefore, to support hitless failover, the LACP state on the redundant
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Ethernet interface standby links must be collecting and distributing before failover
occurs.

Related Topics

■ Aggregated Ethernet Overview on page 449

■ Understanding Chassis Cluster Redundant Ethernet Interface Link Aggregation
Groups on page 454

■ Understanding the Link Aggregation Control Protocol on page 455

■ Configuring LACP on Chassis Clusters on page 458

Configuring LACP on Stand-Alone Devices

LACP is configured on aggregated Ethernet interfaces at the [edit interfaces
interface-name aggregated-ether-options] hierarchy.

Configuring LACP

You configure LACP on an aggregated Ethernet interface by setting the LACP mode
for the parent link with the lacp statement. The LACP mode can be off (the default),
active, or passive.

LACP is enabled by setting the mode to either passive or active. If the actor and
partner are both in passive mode, they do not exchange link aggregation control
PDUs, which results in the aggregated Ethernet links not coming up. If either the
actor or partner is active, they exchange link aggregation control PDUs. To initiate
transmission of link aggregation control PDUs and response link aggregation control
PDUs, you must enable LACP at both the local and remote ends of the links, and one
end must be active.

To set the LACP mode to passive for ae0:

[edit interfaces]
user@host# set ae0 aggregated-ether-options lacp passive

To set the LACP mode to active for ae0:

[edit interfaces]
user@host# set ae0 aggregated-ether-options lacp active

Configuring the Link Aggregation Control PDU Transmit Interval

You configure the interval at which the interfaces on the remote side of the link
transmit link aggregation control PDUs by configuring the periodic statement on the
interfaces on the local side. It is the configuration on the local side that specifies the
behavior of the remote side. That is, the remote side transmits link aggregation
control PDUs at the specified interval. The interval can be fast (every second) or slow
(every 30 seconds).
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By default, the actor and partner transmit link aggregation control PDUs every second.
You can configure different periodic rates on active and passive interfaces. When
you configure the active and passive interfaces at different rates, the transmitter
honors the receiver’s rate.

To configure the interval to be every 30 seconds:

[edit interfaces]
user@host# set ae0 aggregated-ether-options lacp periodic slow

Related Topics

■ Aggregated Ethernet Overview on page 449

■ Configuring Aggregated Ethernet Interfaces on page 450

■ Understanding the Link Aggregation Control Protocol on page 455

■ Verifying Aggregated Ethernet Interfaces on page 459

Configuring LACP on Chassis Clusters

LACP is configured on redundant Ethernet interfaces at the [edit interfaces
interface-name redundant-ether-options] hierarchy.

Configuring LACP

You configure LACP on a redundant Ethernet interface by setting the LACP mode
for the parent link with the lacp statement. The LACP mode can be off (the default),
active, or passive.

LACP is enabled by setting the mode to either passive or active. If the actor and
partner are both in passive mode, they do not exchange link aggregation control
PDUs, which results in the redundant Ethernet links not coming up. If either the actor
or partner is active, they exchange link aggregation control PDUs. To initiate
transmission of link aggregation control PDUs and response link aggregation control
PDUs, you must enable LACP at both the local and remote ends of the links, and one
end must be active.

To set the LACP mode to passive for reth0:

{primary:node1} [edit interfaces]
set reth0 redundant-ether-options lacp passive

To set the LACP mode to active for reth0:

{primary:node1} [edit interfaces]
set reth0 redundant-ether-options lacp active

Configuring the Link Aggregation Control PDU Transmit Interval

You configure the interval at which the interfaces on the remote side of the link
transmit link aggregation control PDUs by configuring the periodic statement on the
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interfaces on the local side. It is the configuration on the local side that specifies the
behavior of the remote side. That is, the remote side transmits link aggregation
control PDUs at the specified interval. The interval can be fast (every second) or slow
(every 30 seconds).

By default, the actor and partner transmit link aggregation control PDUs every second.
You can configure different periodic rates on active and passive interfaces. When
you configure the active and passive interfaces at different rates, the transmitter
honors the receiver’s rate.

To configure the interval to be every 30 seconds:

[edit interfaces]
user@host# set reth0 redundant-ether-options lacp periodic slow

Related Topics

■ Aggregated Ethernet Overview on page 449

■ Understanding Chassis Cluster Redundant Ethernet Interface Link Aggregation
Groups on page 454

■ Understanding the Link Aggregation Control Protocol on page 455

■ Understanding LACP in Chassis Cluster Mode on page 456

■ Verifying Aggregated Ethernet Interfaces on page 459

Verifying Aggregated Ethernet Interfaces

To verify an aggregated Ethernet interface configuration, perform these tasks:

■ Verifying Aggregated Ethernet Interfaces (terse) on page 459

■ Verifying Aggregated Ethernet Interfaces (extensive) on page 460

■ Verifying LACP Statistics on page 461

■ Verifying LACP Aggregated Ethernet Interfaces on page 461

■ Verifying LACP Redundant Ethernet Interfaces on page 462

Verifying Aggregated Ethernet Interfaces (terse)

Purpose Display status information in terse (concise) format for aggregated Ethernet interfaces.

Action From the CLI, enter the show interfaces ae0 terse command.

Sample Output user@host> show interfaces ae0 terse
ge-2/0/0.0              up    up   aenet    --> ae0.0
ge-2/0/0.32767          up    up   aenet    --> ae0.32767
ge-2/0/1.0              up    up   aenet    --> ae0.0
ge-2/0/1.32767          up    up   aenet    --> ae0.32767
ae0                     up    up  
ae0.0                   up    up   bridge  
ae0.32767               up    up   multiservice
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Meaning The output shows the bundle relationship for the aggregated Ethernet interface and
the overall status of the interface, including information such as the following:

■ The link aggregation control PDUs run on the .0 child logical interfaces for the
untagged aggregated Ethernet interface.

■ The link aggregation control PDUs run on the .32767 child logical interfaces for
the VLAN-tagged aggregated Ethernet interface.

■ The .32767 logical interface is created for the parent link and all child links.

Related Topics For a complete description of show interfaces output, see the Junos OS CLI Reference.

Verifying Aggregated Ethernet Interfaces (extensive)

Purpose Display status information and statistics in extensive format for aggregated Ethernet
interfaces.

Action From the CLI, enter the show interfaces ae0 extensive command.

Sample Output user@host> show interfaces ae0 extensive
Physical interface: ae0, Enabled, Physical link is Up
  ...
  Logical interface ae0.0 (Index 67) (SNMP ifIndex 628) (Generation 134)
    ...
    LACP info:        Role     System             System      Port    Port  Port

                             priority          identifier  priority  number   key

      ge-5/0/0.0     Actor        127  00:1f:12:8c:af:c0       127     832     1

      ge-5/0/0.0   Partner        127  00:1f:12:8f:d7:c0       127     640     1

      ge-5/0/1.0     Actor        127  00:1f:12:8c:af:c0       127     833     1

      ge-5/0/1.0   Partner        127  00:1f:12:8f:d7:c0       127     641     1

    LACP Statistics:       LACP Rx     LACP Tx   Unknown Rx   Illegal Rx 
      ge-5/0/0.0             12830        7090            0            0
      ge-5/0/1.0             10304        4786            0            0
    ...
  Logical interface ae0.32767 (Index 70) (SNMP ifIndex 630) (Generation 135)
    ...
    LACP info:        Role     System             System      Port    Port  Port

                             priority          identifier  priority  number   key

      ge-5/0/0.32767    Actor      127 00:1f:12:8c:af:c0       127     832     1

      ge-5/0/0.32767  Partner      127 00:1f:12:8f:d7:c0       127     640     1

      ge-5/0/1.32767    Actor      127 00:1f:12:8c:af:c0       127     833     1

      ge-5/0/1.32767  Partner      127 00:1f:12:8f:d7:c0       127     641     1

    LACP Statistics:       LACP Rx     LACP Tx   Unknown Rx   Illegal Rx 
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      ge-5/0/0.32767         12830        7090            0            0
      ge-5/0/1.32767         10304        4786            0            0
   ...

Meaning The output shows detailed aggregated Ethernet interface information. This portion
of the output shows LACP information and LACP statistics for each logical aggregated
Ethernet interface.

Related Topics For a complete description of show interfaces output, see the Junos OS CLI Reference.

Verifying LACP Statistics

Purpose Display LACP statistics for aggregated Ethernet interfaces.

Action From the CLI, enter the show lacp statistics interfaces ae0 command.

Sample Output user@host> show lacp statistics interfaces ae0
Aggregated interface: ae0
    LACP Statistics:       LACP Rx     LACP Tx   Unknown Rx   Illegal Rx 
      ge-2/0/0                1352        2035            0            0
      ge-2/0/1                1352        2056            0            0
      ge-2/2/0                1352        2045            0            0
      ge-2/2/1                1352        2043            0            0

Meaning The output shows LACP statistics for each physical interface associated with the
aggregated Ethernet interface, such as the following:

■ The LACP received counter that increments for each normal hello

■ The number of LACP transmit packet errors logged

■ The number of unrecognized packet errors logged

■ The number of invalid packets received

Use the following command to clear the statistics and see only new changes:

user@host# clear lacp statistics interfaces ae0

Related Topics For a complete description of show lacp statistics interfaces output, see the Junos OS
CLI Reference.

Verifying LACP Aggregated Ethernet Interfaces

Purpose Display LACP status information for aggregated Ethernet interfaces.

Action From the CLI, enter the show lacp interfaces ae0 command.
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Sample Output user@host> show lacp interfaces ae0
Aggregated interface: ae0
    LACP state:       Role   Exp   Def  Dist  Col  Syn  Aggr  Timeout  Activity
      ge-2/0/0       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/0/0     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/0/1       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/0/1     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/2/0       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/2/0     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/2/1       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-2/2/1     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
    LACP protocol:        Receive State  Transmit State          Mux State 
      ge-2/0/0                  Current   Fast periodic Collecting distributing
      ge-2/0/1                  Current   Fast periodic Collecting distributing
      ge-2/2/0                  Current   Fast periodic Collecting distributing
      ge-2/2/1                  Current   Fast periodic Collecting distributing

Meaning The output shows aggregated Ethernet interface information, such as the following:

■ The LACP state—Indicates whether the link in the bundle is an actor (local or
near-end of the link) or partner (remote or far-end of the link).

■ The LACP mode—Indicates whether both ends of the aggregated Ethernet
interface are enabled (active or passive)—at least one end of the bundle must
be active.

■ The periodic link aggregation control PDU transmit rate.

■ The LACP protocol state—When the link is up, it is collecting and distributing
packets.

Related Topics For a complete description of show lacp interfaces output, see the Junos OS CLI
Reference.

Verifying LACP Redundant Ethernet Interfaces

Purpose Display LACP status information for redundant Ethernet interfaces.

Action From the CLI, enter the show lacp interfaces reth0 command.

Sample Output user@host> show lacp interfaces reth0
Aggregated interface: reth0
    LACP state:       Role   Exp   Def  Dist  Col  Syn  Aggr  Timeout  Activity
      ge-11/0/0      Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/0    Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/1      Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/1    Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/2      Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/2    Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/3      Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-11/0/3    Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/0       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/0     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/1       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/1     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
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      ge-3/0/2       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/2     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/3       Actor    No    No   Yes  Yes  Yes   Yes     Fast    Active
      ge-3/0/3     Partner    No    No   Yes  Yes  Yes   Yes     Fast    Active
    LACP protocol:        Receive State  Transmit State          Mux State 
      ge-11/0/0                 Current   Fast periodic Collecting distributing
      ge-11/0/1                 Current   Fast periodic Collecting distributing
      ge-11/0/2                 Current   Fast periodic Collecting distributing
      ge-11/0/3                 Current   Fast periodic Collecting distributing
      ge-3/0/0                  Current   Fast periodic Collecting distributing
      ge-3/0/1                  Current   Fast periodic Collecting distributing
      ge-3/0/2                  Current   Fast periodic Collecting distributing
      ge-3/0/3                  Current   Fast periodic Collecting distributing
{primary:node1} 

Meaning The output shows redundant Ethernet interface information, such as the following:

■ The LACP state—Indicates whether the link in the bundle is an actor (local or
near-end of the link) or partner (remote or far-end of the link).

■ The LACP mode—Indicates whether both ends of the aggregated Ethernet
interface are enabled (active or passive)—at least one end of the bundle must
be active.

■ The periodic link aggregation control PDU transmit rate.

■ The LACP protocol state—When the link is up, it is collecting and distributing
packets.

Related Topics For a complete description of show lacp interfaces output, see the Junos OS CLI
Reference.
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Part 2

Routing Protocols

■ Routing Overview on page 467

■ Static Routing on page 475

■ RIP on page 485

■ OSPF on page 503

■ IS-IS on page 525

■ BGP on page 535

■ Multicast on page 559
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Chapter 16

Routing Overview

■ Routing Overview on page 467

Routing Overview

Routing is the transmission of data packets from a source to a destination address.
It involves delivering a message across a network or networks. This process has two
primary components: the exchange of routing information to forward packets
accurately from source to destination and the packet-forwarding procedure.

NOTE: Before configuring routing protocols, you must first configure security filters.
See the Security Policies Overview in the Junos OS Security Configuration Guide.

For packets to be correctly forwarded to the appropriate host address, the host must
have a unique numeric identifier or IP address. The unique IP address of the
destination host forms entries in the routing table. These entries are primarily
responsible for determining the path that a packet traverses when transmitted from
source to destination.

To use the routing capabilities of a Juniper Networks device, you must understand
the fundamentals of IP routing and the routing protocols that are primarily responsible
for the transmission of unicast traffic. To understand this topic, you need a basic
understanding of IP addressing and TCP/IP.

NOTE: When configuring IPv6 addressing and routing on a J Series device, you must
enable IPv6 in secure context. .

This topic contains the following sections:

■ Networks and Subnetworks on page 468

■ Autonomous Systems on page 468

■ Interior and Exterior Gateway Protocols on page 468

■ Routing Tables on page 468

■ Forwarding Tables on page 469

■ Dynamic and Static Routing on page 470
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■ Route Advertisements on page 470

■ Route Aggregation on page 471

Networks and Subnetworks

Large groups of machines that are interconnected and can communicate with one
another form networks. Typically, networks identify large systems of computers and
devices that are owned or operated by a single entity. Traffic is routed between or
through the networks as data is passed from host to host.

As networks grow large, the ability to maintain the network and effectively route
traffic between hosts within the network becomes increasingly difficult. To
accommodate growth, networks are divided into subnetworks. Fundamentally,
subnetworks behave exactly like networks, except that they are identified by a more
specific network address and subnet mask (destination prefix). Subnetworks have
routing gateways and share routing information in exactly the same way as large
networks.

Autonomous Systems

A large network or collection of routers under a single administrative authority is
termed an autonomous system (AS). Autonomous systems are identified by a unique
numeric identifier that is assigned by the Internet Assigned Numbers Authority (IANA).
Typically, the hosts within an AS are treated as internal peers, and hosts in a peer
AS are treated as external peers. The status of the relationship between hosts—internal
or external—governs the protocol used to exchange routing information.

Interior and Exterior Gateway Protocols

Routing information that is shared within an AS is transmitted by an interior gateway
protocol (IGP). Of the different IGPs, the most common are RIP, OSPF, and IS-IS.
IGPs are designed to be fast acting and light duty. They typically incorporate only a
moderate security system, because trusted internal peers do not require the stringent
security measures that untrusted peers require. As a result, you can usually begin
routing within an AS by enabling the IGP on all internal interfaces and performing
minimal additional configuration. You do not need to establish individual adjacencies.

Routing information that is shared with a peer AS is transmitted by an exterior
gateway protocol (EGP). The primary EGP in use in almost all networks is the Border
Gateway Protocol (BGP). BGP is designed to be very secure. Individual connections
must be explicitly configured on each side of the link. As a result, although large
numbers of connections are difficult to configure and maintain, each connection is
secure.

Routing Tables

To route traffic from a source host to a destination host, the devices through which
the traffic will pass must learn the path that the packet is to take. Once learned, the
information is stored in routing tables. The routing table maintains a list of all the
possible paths from point A to point B. Figure 50 on page 469 shows a simple network
of routers.
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Figure 50: Simple Network Topology

This simple network provides multiple ways to get from host San Francisco to host
Miami. The packet can follow the path through Denver and Cleveland. Alternatively,
the packet can be routed through Phoenix and directly to Miami. The routing table
includes all the possible paths and combinations—an exhaustive list of all the ways
to get from the source to the destination.

The routing table must include every possible path from a source to a destination.
Routing tables for the network in Figure 50 on page 469 must include entries for San
Francisco-Denver, San Francisco-Cleveland, San Francisco-Miami, Denver-Cleveland,
and so on. As the number of sources and destinations increases, the routing table
quickly becomes large. The unwieldy size of routing tables is the primary reason for
the division of networks into subnetworks.

Forwarding Tables

If the routing table is a list of all the possible paths a packet can take, the forwarding
table is a list of only the best routes to a particular destination. The best path is
determined according to the particular routing protocol being used, but generally
the number of hops between the source and destination determines the best possible
route.

In the network shown in Figure 50 on page 469, because the path with the fewest
number of hops from San Francisco to Miami is through Phoenix, the forwarding
table distills all the possible San Francisco-Miami routes into the single route through
Phoenix. All traffic with a destination address of Miami is sent directly to the next
hop, Phoenix.

After it receives a packet, the Phoenix router performs another route lookup, using
the same destination address. The Phoenix router then routes the packet
appropriately. Although it considers the entire path, the router at any individual hop
along the way is responsible only for transmitting the packet to the next hop in the
path. If the Phoenix router is managing its traffic in a particular way, it might send
the packet through Houston on its route to Miami. This scenario is likely if specific
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customer traffic is treated as priority traffic and routed through a faster or more
direct route, while all other traffic is treated as nonpriority traffic.

Dynamic and Static Routing

Entries are imported into a router's routing table from dynamic routing protocols or
by manual inclusion as static routes. Dynamic routing protocols allow routers to learn
the network topology from the network. The routers within the network send out
routing information in the form of route advertisements. These advertisements
establish and communicate active destinations, which are then shared with other
routers in the network.

Although dynamic routing protocols are extremely useful, they have associated costs.
Because they use the network to advertise routes, dynamic routing protocols consume
bandwidth. Additionally, because they rely on the transmission and receipt of route
advertisements to build a routing table, dynamic routing protocols create a delay
(latency) between the time a router is powered on and the time during which routes
are imported into the routing table. Some routes are therefore effectively unavailable
until the routing table is completely updated, when the router first comes online or
when routes change within the network (due to a host going offline, for example).

Static routing avoids the bandwidth cost and route import latency of dynamic routing.
Static routes are manually included in the routing table, and never change unless
you explicitly update them. Static routes are automatically imported into the routing
table when a router first comes online. Additionally, all traffic destined for a static
address is routed through the same router. This feature is particularly useful for
networks with customers whose traffic must always flow through the same routers.
Figure 51 on page 470 shows a network that uses static routes.

Figure 51: Static Routing Example

In Figure 51 on page 470, the customer routes in the 192.176.14/24 subnetwork are
static routes. These are hard links to specific customer hosts that never change.
Because all traffic destined for any of these routes is forwarded through Router A,
these routes are included as static routes in Router A's routing table. Router A then
advertises these routes to other hosts so that traffic can be routed to and from them.

Route Advertisements

The routing table and forwarding table contain the routes for the routers within a
network. These routes are learned through the exchange of route advertisements.
Route advertisements are exchanged according to the particular protocol being
employed within the network.
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Generally, a router transmits hello packets out each of its interfaces. Neighboring
routers detect these packets and establish adjacencies with the router. The adjacencies
are then shared with other neighboring routers, which allows the routers to build up
the entire network topology in a topology database, as shown in Figure 52 on page 471.

Figure 52: Route Advertisement
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In Figure 52 on page 471, Router A sends out hello packets to each of its neighbors.
Routers B and C detect these packets and establish an adjacent relationship with
Router A. Router B and C then share this information with their neighbors, Routers
D and E, respectively. By sharing information throughout the network, the routers
create a network topology, which they use to determine the paths to all possible
destinations within the network. The routes are then distilled into the forwarding
table of best routes according to the route selection criteria of the protocol in use.

Route Aggregation

As the number of hosts in a network increases, the routing and forwarding tables
must establish and maintain more routes. As these tables become larger, the time
routers require to look up particular routes so that packets can be forwarded becomes
prohibitive. The solution to the problem of growing routing tables is to group
(aggregate) the routers by subnetwork, as shown in Figure 53 on page 472.
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Figure 53: Route Aggregation

170.16.124/24

172.16/16

170.16.124.17

172.16/16

AS 10
AS 3

AS 17

g0
15

00
4

Figure 53 on page 472 shows three different ASs. Each AS contains multiple
subnetworks with thousands of host addresses. To allow traffic to be sent from any
host to any host, the routing tables for each host must include a route for each
destination. For the routing tables to include every combination of hosts, the flooding
of route advertisements for each possible route becomes prohibitive. In a network
of hosts numbering in the thousands or even millions, simple route advertisement
is not only impractical but impossible.

By employing route aggregation, instead of advertising a route for each host in AS
3, the gateway router advertises only a single route that includes all the routes to all
the hosts within the AS. For example, instead of advertising the particular route
170.16.124.17, the AS 3 gateway router advertises only 170.16/16. This single route
advertisement encompasses all the hosts within the 170.16/16 subnetwork, which
reduces the number of routes in the routing table from 216 (one for every possible
IP address within the subnetwork) to 1. Any traffic destined for a host within the AS
is forwarded to the gateway router, which is then responsible for forwarding the
packet to the appropriate host.

Similarly, in this example, the gateway router is responsible for maintaining 216

routes within the AS (in addition to any external routes). The division of this AS into
subnetworks allows for further route aggregation to reduce this number. In the
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subnetwork in the example, the subnetwork gateway router advertises only a single
route (170.16.124/24), which reduces the number of routes from 28 to 1.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ RIP Overview on page 485

■ OSPF Overview on page 503

■ IS-IS Overview on page 525

■ BGP Overview on page 535

■ Multicast Overview on page 559

■ Routing Policies Overview on page 581

■ IPv6 Overview in the Junos Routing Protocols Configuration Guide
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Chapter 17

Static Routing

■ Static Routing Configuration Overview on page 475

■ Basic Static Routes on page 476

■ Static Route Selection on page 477

■ Static Route Control in Routing and Forwarding Tables on page 480

■ Default Static Route Behavior on page 482

■ Verifying the Static Route Configuration on page 483

Static Routing Configuration Overview

To configure static routing:

1. Configure network interfaces. See the Junos OS Interfaces Configuration Guide for
Security Devices.

2. Configure security filters. See Security Policies Overview in the Junos OS Security
Configuration Guide.

3. Configure the static routes and define their next hop addresses. See “Example:
Configuring a Basic Set of Static Routes (CLI)” on page 476.

4. (Optional) Specify how traffic should be routed to a destination if multiple next
hops exist for a single static route. See “Example: Controlling Static Route
Selection (CLI)” on page 478.

5. (Optional) Determine how static routes are inserted and maintained in the routing
and forwarding tables. See “Example: Controlling Static Routes in the Routing
and Forwarding Tables (CLI)” on page 481.

6. (Optional) Define the static routes’ default properties. See “Example: Defining
Default Behavior for All Static Routes (CLI)” on page 483.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ Verifying the Static Route Configuration on page 483

■ Understanding Basic Static Routing on page 476

■ Understanding Static Route Preferences and Qualified Next Hops on page 477
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■ Understanding Static Route Control in Routing and Forwarding Tables on page 480

■ Understanding Static Routing Default Properties on page 482

Basic Static Routes

■ Understanding Basic Static Routing on page 476

■ Example: Configuring a Basic Set of Static Routes (CLI) on page 476

Understanding Basic Static Routing

Routes that are permanent fixtures in the routing and forwarding tables are often
configured as static routes. These routes generally do not change, and often include
only one or very few paths to the destination.

To create a static route in the routing table, you must, at minimum, define the route
as static and associate a next-hop address with it. The static route in the routing table
is inserted into the forwarding table when the next-hop address is reachable. All
traffic destined for the static route is transmitted to the next-hop address for transit.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Example: Configuring a Basic Set of Static Routes (CLI) on page 476

Example: Configuring a Basic Set of Static Routes (CLI)

Customer routes that are connected to stub networks are often configured as static
routes. Figure 54 on page 476 shows a sample network.

Figure 54: Customer Routes Connected to a Stub Network
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To configure customer routes as static routes, like the ones in Figure 54 on page 476,
follow these steps on the device to which the customer routes are connected:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 129 on page 477.

3. If you are finished configuring the router, commit the configuration.

4. Go on to one of the following procedures:

■ To manually control static route selection, see “Example: Controlling Static
Route Selection (CLI)” on page 478.

■ To determine how static routes are imported into the routing and forwarding
tables, see “Example: Controlling Static Routes in the Routing and Forwarding
Tables (CLI)” on page 481.

■ To define default properties for static routes, see “Example: Defining Default
Behavior for All Static Routes (CLI)” on page 483.

■ To check the configuration, see “Verifying the Static Route Configuration”
on page 483.

Table 129: Configuring Basic Static Routes

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options static

Navigate to the Static level in the configuration hierarchy.

Define the static route and set the next-hop address:

set route 192.168.47.5 next-hop 10.10.10.10

Add the static route 192.168.47.5/32, and define the next-hop
address 10.10.10.10.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding Basic Static Routing on page 476

■ Static Routing Configuration Overview on page 475

Static Route Selection

■ Understanding Static Route Preferences and Qualified Next Hops on page 477

■ Example: Controlling Static Route Selection (CLI) on page 478

Understanding Static Route Preferences and Qualified Next Hops

A static route destination address can have multiple next hops associated with it. In
this case, multiple routes are inserted into the routing table, and route selection must
occur. Because the primary criterion for route selection is the route preference, you
can control the routes that are used as the primary route for a particular destination
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by setting the route preference associated with a particular next hop. The routes with
a higher preference are always used to route traffic. When you do not set a preferred
route, traffic is alternated between routes in round-robin fashion.

In general, the default properties assigned to a static route apply to all the next-hop
addresses configured for the static route. If, however, you want to configure two
possible next-hop addresses for a particular route and have them treated differently,
you can define one as a qualified next hop.

Qualified next hops allow you to associate one or more properties with a particular
next-hop address. You can set an overall preference for a particular static route and
then specify a different preference for the qualified next hop. For example, suppose
two next-hop addresses (10.10.10.10 and 10.10.10.7) are associated with the static
route 192.168.47.5/32. A general preference is assigned to the entire static route,
and then a different preference is assigned to only the qualified next-hop address
10.10.10.7. For example:

route 192.168.47.5/32 {
next-hop 10.10.10.10;
qualified-next-hop 10.10.10.7 {

preference 2;
}
preference 6;

}

In this example, the qualified next hop 10.10.10.7 is assigned the preference 2, and
the next-hop 10.10.10.10 is assigned the preference 6.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Example: Controlling Static Route Selection (CLI) on page 478

Example: Controlling Static Route Selection (CLI)

When multiple next hops exist for a single static route (see Figure 55 on page 479),
you can specify how traffic is to be routed to the destination.
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Figure 55: Controlling Static Route Selection

In this example, the static route 192.168.47.5/32 has two possible next hops. Because
of the links between those next-hop hosts, host 10.10.10.7 is the preferred path. To
configure the static route 192.168.47.5/32 with two next hops and give preference
to host 10.10.10.7, follow these steps:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 130 on page 479.

3. If you are finished configuring the router, commit the configuration.

4. Go on to one of the following procedures:

■ To determine how static routes are imported into the routing and forwarding
tables, see “Example: Controlling Static Routes in the Routing and Forwarding
Tables (CLI)” on page 481.

■ To define default properties for static routes, see “Example: Defining Default
Behavior for All Static Routes (CLI)” on page 483.

■ To check the configuration, see “Verifying the Static Route Configuration”
on page 483.

Table 130: Controlling Static Route Selection

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options static

Navigate to the Static level in the configuration hierarchy.

Define the static route and set the next-hop address:

set route 192.168.47.5 next-hop 10.10.10.10

Add the static route 192.168.47.5/32, and define the
next-hop address 10.10.10.10.

Set the preference to 7:

set route 192.168.47.5 next-hop 10.10.10.10 preference 7

Set the preference for the 10.10.10.10 next hop to 7.
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Table 130: Controlling Static Route Selection (continued)

CLI Configuration EditorTask

Set the qualified-next-hop address:

set route 192.168.47.5 qualified-next-hop 10.10.10.7

Define the qualified next-hop address 10.10.10.7.

Set the preference to 6:

set route 192.168.47.5 qualified-next-hop 10.10.10.7 preference 6

Set the preference for the 10.10.10.7 qualified next hop
to 6.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding Static Route Preferences and Qualified Next Hops on page 477

■ Static Routing Configuration Overview on page 475

Static Route Control in Routing and Forwarding Tables

■ Understanding Static Route Control in Routing and Forwarding Tables on page 480

■ Example: Controlling Static Routes in the Routing and Forwarding Tables
(CLI) on page 481

Understanding Static Route Control in Routing and Forwarding Tables

You can control the importation of static routes into the routing and forwarding tables
in a number of ways. Primary ways include assigning one or more of the following
attributes to the route:

■ retain—Keeps the route in the forwarding table after the routing process shuts
down or the device reboots.

■ no-readvertise—Prevents the route from being readvertised to other routing
protocols.

■ passive—Rejects traffic destined for the route.

This topic includes the following sections:

■ Route Retention on page 480

■ Readvertisement Prevention on page 481

■ Forced Rejection of Passive Route Traffic on page 481

Route Retention

By default, static routes are not retained in the forwarding table when the routing
process shuts down. When the routing process starts up again, any routes configured
as static routes must be added to the forwarding table again. To avoid this latency,
routes can be flagged as retain, so that they are kept in the forwarding table even
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after the routing process shuts down. Retention ensures that the routes are always
in the forwarding table, even immediately after a system reboot.

Readvertisement Prevention

Static routes are eligible for readvertisement by other routing protocols by default.
In a stub area where you might not want to readvertise these static routes under any
circumstances, you can flag the static routes as no-readvertise.

Forced Rejection of Passive Route Traffic

Generally, only active routes are included in the routing and forwarding tables. If a
static route's next-hop address is unreachable, the route is marked passive, and it is
not included in the routing or forwarding tables. To force a route to be included in
the routing tables regardless of next-hop reachability, you can flag the route as passive.
If a route is flagged passive and its next-hop address is unreachable, the route is
included in the routing table and all traffic destined for the route is rejected.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Example: Controlling Static Routes in the Routing and Forwarding Tables (CLI)
on page 481

Example: Controlling Static Routes in the Routing and Forwarding Tables (CLI)

Static routes have a number of attributes that define how they are inserted and
maintained in the routing and forwarding tables. To customize this behavior for the
static route 192.168.47.5/32, perform these steps:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 131 on page 481.

3. If you are finished configuring the router, commit the configuration.

4. Go on to one of the following procedures:

■ To define default properties for static routes, see “Example: Defining Default
Behavior for All Static Routes (CLI)” on page 483.

■ To check the configuration, see “Verifying the Static Route Configuration”
on page 483.

Table 131: Controlling Static Routes in the Routing and Forwarding Tables

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options static route 192.168.47.5/32

Navigate to the 192.168.47.5/32 level in the configuration hierarchy.
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Table 131: Controlling Static Routes in the Routing and Forwarding Tables (continued)

CLI Configuration EditorTask

Set the retain attribute:

set retain

Specify that the route is to be retained in the forwarding table after the
routing process shuts down. By default, static routes are not retained.

Set the no-readvertise attribute:

set no-readvertise

Specify that the static route is not to be readvertised. By default, static routes
are eligible to be readvertised.

Set the passive attribute:

set passive

Specify that the static route is to be included in the routing table whether
the route is active or not. By default, passive routes are not included in the
routing table.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding Static Route Control in Routing and Forwarding Tables on page 480

■ Static Routing Configuration Overview on page 475

Default Static Route Behavior

■ Understanding Static Routing Default Properties on page 482

■ Example: Defining Default Behavior for All Static Routes (CLI) on page 483

Understanding Static Routing Default Properties

The basic configuration of static routes defines properties for a particular route. To
define a set of properties to be used as defaults on all static routes, set those properties
as default values. For example:

defaults {
retain;
no-readvertise;
passive;

}
route 0.0.0.0/0 next-hop 192.168.1.1;
route 192.168.47.5/32 {

next-hop 10.10.10.10;
qualified-next-hop 10.10.10.7 {

preference 6;
}
preference 2;

}

In this example, the retain, no-readvertise, and passive attributes are set as defaults
for all static routes. If any local setting for a particular route conflicts with the default
values, the local setting supersedes the default.
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Attributes that define static route behavior can be configured either at the individual
route level or as a default behavior that applies to all static routes. In the case of
conflicting configuration, the configuration at the individual route level overrides
static route defaults.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Example: Defining Default Behavior for All Static Routes (CLI) on page 483

Example: Defining Default Behavior for All Static Routes (CLI)

To configure static route defaults, perform these steps:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 132 on page 483.

3. If you are finished configuring the router, commit the configuration.

4. To check the configuration, see “Verifying the Static Route Configuration” on
page 483.

Table 132: Defining Static Route Defaults

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options static defaults

Navigate to the Defaults level in the configuration hierarchy.

Set the retain attribute:

set retain

Specify that the route is to be retained in the forwarding table after the
routing process shuts down. By default, static routes are not retained.

Set the no-readvertise attribute:

set no-readvertise

Specify that the static route is not to be readvertised. By default, static routes
are eligible to be readvertised.

Set the passive attribute:

set passive

Specify that the static route is to be included in the routing table whether
the route is active or not. By default, passive routes are not included in the
routing table.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding Static Routing Default Properties on page 482

■ Static Routing Configuration Overview on page 475

Verifying the Static Route Configuration

Purpose Verify that the static routes are in the routing table and that those routes are active.
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Action From the CLI, enter the show route terse command.

Sample Output user@host> show route terse
inet.0: 20 destinations, 20 routes (20 active, 0 holddown, 0 hidden)
+ = Active Route, - = Last Active, * = Both
A Destination        P Prf   Metric 1   Metric 2  Next hop        AS path
* 192.168.47.5/32        S   5                        Reject
* 172.16.0.0/12      S   5                       >192.168.71.254
* 192.168.0.0/18     S   5                       >192.168.71.254
* 192.168.40.0/22    S   5                       >192.168.71.254
* 192.168.64.0/18    S   5                       >192.168.71.254
* 192.168.64.0/21    D   0                       >fxp0.0
* 192.168.71.246/32  L   0                        Local
* 192.168.220.4/30   D   0                       >ge-0/0/1.0
* 192.168.220.5/32   L   0                        Local
* 192.168.220.8/30   D   0                       >ge-0/0/2.0
* 192.168.220.9/32   L   0                        Local
* 192.168.220.12/30  D   0                       >ge-0/0/3.0
* 192.168.220.13/32  L   0                        Local
* 192.168.220.17/32  L   0                        Reject
* 192.168.220.21/32  L   0                        Reject
* 192.168.220.24/30  D   0                       >at-1/0/0.0
* 192.168.220.25/32  L   0                        Local
* 192.168.220.28/30  D   0                       >at-1/0/1.0
* 192.168.220.29/32  L   0                        Local
* 224.0.0.9/32       R 100          1             MultiRecv

Meaning The output shows a list of the routes that are currently in the inet.0 routing table.
Verify the following information:

■ Each configured static route is present. Routes are listed in ascending order by
IP address. Static routes are identified with an S in the protocol (P) column of
the output.

■ Each static route is active. Routes that are active show the next-hop IP address
in the Next hop column. If a route's next-hop address is unreachable, the next-hop
address is identified as Reject. These routes are not active routes, but they appear
in the routing table because the passive attribute is set.

■ The preference for each static route is correct. The preference for a particular
route is listed in the Prf column of the output.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Static Routing Configuration Overview on page 475

■ show route terse in the Junos Routing Protocols and Policies Command Reference
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Chapter 18

RIP

■ RIP Overview on page 485

■ RIPng Overview on page 489

■ RIP Configuration Overview on page 491

■ Basic RIP Routing on page 491

■ RIP Traffic Control Through Metrics on page 493

■ RIP Authentication on page 497

■ Verifying a RIP Configuration on page 499

RIP Overview

In a RIP network, each router's forwarding table is distributed among the nodes
through the flooding of routing table information. Because topology changes are
flooded throughout the network, every node maintains the same list of destinations.
Packets are then routed to these destinations based on path-cost calculations done
at each node in the network.

NOTE: In general, the term RIP refers to RIP version 1 and RIP version 2.

This topic contains the following sections:

■ Distance-Vector Routing Protocols on page 485

■ Maximizing Hop Count on page 486

■ RIP Packets on page 486

■ Split Horizon and Poison Reverse Efficiency Techniques on page 487

■ Limitations of Unidirectional Connectivity on page 488

Distance-Vector Routing Protocols

Distance-vector routing protocols transmit routing information that includes a distance
vector, typically expressed as the number of hops to the destination. This information
is flooded out all protocol-enabled interfaces at regular intervals (every 30 seconds
in the case of RIP) to create a network map that is stored in each node's local topology
database. Figure 56 on page 486 shows how distance-vector routing works.
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Figure 56: Distance-Vector Protocol

In Figure 56 on page 486, Routers A and B have RIP enabled on adjacent interfaces.
Router A has known RIP neighbors Routers C, D, and E, which are 1, 2, and 3 hops
away, respectively. Router B has known RIP neighbors Routers X, Y, and Z, which
are 1, 2, and 3 hops away, respectively. Every 30 seconds, each router floods its
entire routing table information out all RIP-enabled interfaces. In this case, flooding
exchanges routing table information across the RIP link.

When Router A receives routing information from Router B, it adds 1 to the hop
count to determine the new hop count. For example, Router X has a hop count of
1, but when Router A imports the route to X, the new hop count is 2. The imported
route also includes information about where the route was learned, so that the original
route is imported as a route to Router X through Router B with a hop count of 2.

When multiple routes to the same host are received, RIP uses the distance-vector
algorithm to determine which path to import into the forwarding table. The route
with the smallest hop count is imported. If there are multiple routes with the same
hop count, all are imported into the forwarding table, and traffic is sent along the
paths in round-robin fashion.

Maximizing Hop Count

The successful routing of traffic across a RIP network requires that every node in the
network maintain the same view of the topology. Topology information is broadcast
between RIP neighbors every 30 seconds. If Router A is many hops away from a
new host, Router B, the route to B might take significant time to propagate through
the network and be imported into Router A's routing table. If the two routers are 5
hops away from each other, Router A cannot import the route to Router B until 2.5
minutes after Router B is online. For large numbers of hops, the delay becomes
prohibitive. To help prevent this delay from growing arbitrarily large, RIP enforces
a maximum hop count of 15 hops. Any prefix that is more than 15 hops away is
treated as unreachable and assigned a hop count equal to infinity. This maximum
hop count is called the network diameter.

RIP Packets

Routing information is exchanged in a RIP network by RIP request and RIP response
packets. A router that has just booted can broadcast a RIP request on all RIP-enabled
interfaces. Any routers running RIP on those links receive the request and respond
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by sending a RIP response packet immediately to the router. The response packet
contains the routing table information required to build the local copy of the network
topology map.

In the absence of RIP request packets, all RIP routers broadcast a RIP response packet
every 30 seconds on all RIP-enabled interfaces. The RIP broadcast is the primary
way in which topology information is flooded throughout the network.

Once a router learns about a particular destination through RIP, it starts a timer.
Every time it receives a new response packet with information about the destination,
the router resets the timer to zero. However, if the router receives no updates about
a particular destination for 180 seconds, it removes the destination from its RIP
routing table.

In addition to the regular transmission of RIP packets every 30 seconds, if a router
detects a new neighbor or detects that an interface is unavailable, it generates a
triggered update. The new routing information is immediately broadcast out all
RIP-enabled interfaces, and the change is reflected in all subsequent RIP response
packets.

Split Horizon and Poison Reverse Efficiency Techniques

Because RIP functions by periodically flooding the entire routing table out to the
network, it generates a lot of traffic. The split horizon and poison reverse techniques
can help reduce the amount of network traffic originated by RIP hosts and make the
transmission of routing information more efficient.

If a router receives a set of route advertisements on a particular interface, RIP
determines that those advertisements do not need to be retransmitted out the same
interface. This technique, known as split horizon, helps limit the amount of RIP routing
traffic by eliminating information that other neighbors on that interface have already
learned. Figure 57 on page 487 shows an example of the split horizon technique.

Figure 57: Split Horizon Example

In Figure 57 on page 487, Router A advertises routes to Routers C, D, and E to Router
B. In this example, Router A can reach Router C in 2 hops. When Router A advertises
the route to Router B, B imports it as a route to Router C through Router A in 3 hops.
If Router B then readvertised this route to Router A, A would import it as a route to
Router C through Router B in 4 hops. However, the advertisement from Router B to
Router A is unnecessary, because Router A can already reach the route in 2 hops.
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The split horizon technique helps reduce extra traffic by eliminating this type of route
advertisement.

Similarly, the poison reverse technique helps to optimize the transmission of routing
information and improve the time to reach network convergence. If Router A learns
about unreachable routes through one of its interfaces, it advertises those routes as
unreachable (hop count of 16) out the same interface. Figure 58 on page 488 shows
an example of the poison reverse technique.

Figure 58: Poison Reverse Example

In Figure 58 on page 488, Router A learns through one of its interfaces that routes to
Routers C, D, and E are unreachable. Router A readvertises those routes out the same
interface as unreachable. The advertisement informs Router B that Hosts C, D, and
E are definitely not reachable through Router A.

Limitations of Unidirectional Connectivity

Because RIP processes routing information based solely on the receipt of routing
table updates, it cannot ensure bidirectional connectivity. As Figure 59 on page 488
shows, RIP networks are limited by their unidirectional connectivity.

Figure 59: Limitations of Unidirectional Connectivity
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In Figure 59 on page 488, Routers A and D flood their routing table information to
Router B. Because the path to Router E has the fewest hops when routed through
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Router A, that route is imported into Router B's forwarding table. However, suppose
that Router A can transmit traffic but is not receiving traffic from Router B because
of an unavailable link or invalid routing policy. If the only route to Router E is through
Router A, any traffic destined for Router A is lost, because bidirectional connectivity
was never established.

OSPF establishes bidirectional connectivity with a three-way handshake.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ RIP Configuration Overview on page 491

■ Understanding Basic RIP Routing on page 492

■ Understanding RIP Traffic Control with Metrics on page 493

■ Understanding RIP Authentication on page 497

■ RIPng Overview on page 489

■ OSPF Overview on page 503

RIPng Overview

The Routing Information Protocol next generation (RIPng) is an interior gateway
protocol (IGP) that uses a distance-vector algorithm to determine the best route to a
destination, using hop count as the metric. RIPng exchanges routing information
used to compute routes and is intended for IP version 6 (IPv6)-based networks. RIPng
is disabled by default.

On devices in secure context, IPv6 is disabled. You must enable IPv6 to use RIPng.
For instructions, see the Junos OS Interfaces Configuration Guide for Security Devices.

This topic contains the following sections:

■ RIPng Protocol Overview on page 489

■ RIPng Standards on page 490

■ RIPng Packets on page 490

RIPng Protocol Overview

The RIPng IGP uses the Bellman-Ford distance-vector algorithm to determine the
best route to a destination, using hop count as the metric. RIPng allows hosts and
routers to exchange information for computing routes through an IP-based network.
RIPng is intended to act as an IGP for moderately-sized autonomous systems.

RIPng is a distinct routing protocol from RIPv2. The JUNOS Software implementation
of RIPng is similar to RIPv2, but has the following differences:

■ RIPng does not need to implement authentication on packets.

■ JUNOS Software does not support multiple instances of RIPng.
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■ JUNOS Software does not support RIPng routing table groups.

RIPng is a UDP-based protocol and uses UDP port 521.

RIPng has the following architectural limitations:

■ The longest network path cannot exceed 15 hops (assuming that each network,
or hop, has a cost of 1).

■ RIPng is prone to routing loops when the routing tables are reconstructed.
Especially when RIPng is implemented in large networks that consist of several
hundred routers, RIPng might take an extremely long time to resolve routing
loops.

■ RIPng uses only a fixed metric to select a route. Other IGPs use additional
parameters, such as measured delay, reliability, and load.

RIPng Standards

RIPng is defined in the following documents:

■ RFC 2080, RIPng for IPv6

■ RFC 2081, RIPng Protocol Applicability Statement

To access Internet Requests for Comments (RFCs) and drafts, see the Internet
Engineering Task Force (IETF) website at http://www.ietf.org.

RIPng Packets

A RIPng packet header contains the following fields:

■ Command—Indicates whether the packet is a request or response message.
Request messages seek information for the router’s routing table. Response
messages are sent periodically or when a request message is received. Periodic
response messages are called update messages. Update messages contain the
command and version fields and a set of destinations and metrics.

■ Version number—Specifies the version of RIPng that the originating router is
running. This is currently set to Version 1.

The rest of the RIPng packet contains a list of routing table entries consisting of the
following fields:

■ Destination prefix—128-bit IPv6 address prefix for the destination.

■ Prefix length—Number of significant bits in the prefix.

■ Metric—Value of the metric advertised for the address.

■ Route tag—A route attribute that must be advertised and redistributed with the
route. Primarily, the route tag distinguishes external RIPng routes from internal
RIPng routes when routes must be redistributed across an exterior gateway
protocol (EGP).
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ RIP Overview on page 485

■ Configuring RIPng in the Junos Routing Protocols Configuration Guide

■ Minimum RIPng Configuration in the Junos Routing Protocols Configuration Guide

RIP Configuration Overview

To achieve basic connectivity between all RIP hosts in a RIP network, you enable
RIP on every interface that is expected to transmit and receive RIP traffic, as described
in the steps that follow.

To configure a RIP network:

1. Configure network interfaces. See Junos OS Interfaces Configuration Guide for
Security Devices.

2. Configure security filters. See Security Policies Overview in the Junos OS Security
Configuration Guide.

3. Define RIP groups, which are logical groupings of interfaces, and add interfaces
to the groups. Then, configure a routing policy to export directly connected routes
and routes learned through RIP routing exchanges. See “Example: Configuring
a Basic RIP Network (CLI)” on page 492.

4. (Optional) Configure metrics to control traffic through the RIP network.
See“Example: Controlling Traffic with the Incoming Metric (CLI)” on page 494
and “Example: Controlling Traffic with the Outgoing Metric (CLI)” on page 496.

5. (Optional) Configure authentication to ensure that only trusted routers participate
in the autonomous system’s routing. See“Enabling Authentication with Plain-Text
Passwords (CLI Procedure)” on page 498 and “Enabling Authentication with MD5
Authentication (CLI Procedure)” on page 498.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ RIP Overview on page 485

■ Verifying a RIP Configuration on page 499

■ Configuring RIP in the Junos Routing Protocols Configuration Guide

■ Minimum RIP Configuration in the Junos Routing Protocols Configuration Guide

Basic RIP Routing

■ Understanding Basic RIP Routing on page 492

■ Example: Configuring a Basic RIP Network (CLI) on page 492
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Understanding Basic RIP Routing

RIP is an interior gateway protocol (IGP) that routes packets within a single
autonomous system (AS). By default, RIP does not advertise the subnets that are
directly connected through the device's interfaces. For traffic to pass through a RIP
network, you must create a routing policy to export these routes. Advertising only
the direct routes propagates the routes to the immediately adjacent RIP-enabled
router only. To propagate all routes through the entire RIP network, you must
configure the routing policy to export the routes learned through RIP.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ RIP Overview on page 485

■ Example: Configuring a Basic RIP Network (CLI) on page 492

Example: Configuring a Basic RIP Network (CLI)

To use RIP on the device, you must configure RIP on all the RIP interfaces within a
network like the one shown in Figure 60 on page 492.

Figure 60: Typical RIP Network Topology

To configure a RIP network like the one in Figure 60 on page 492, with a routing
policy, perform these steps on each device in the network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 133 on page 493.

3. If you are finished configuring the router, commit the configuration.

After you add the appropriate interfaces to the RIP group, RIP begins sending
routing information. No additional configuration is required to enable RIP traffic
on the network.
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Table 133: Configuring a RIP Network

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols rip

Navigate to the Rip level in the
configuration hierarchy.

1. Create the RIP group alpha1, and add an interface:

set group alpha1 neighbor ge-0/0/0.0

2. Repeat Step 1 for each interface on this device that you are adding to the
RIP group. Only one interface is required.

Create the RIP group alpha1.

1. From the [edit] hierarchy level, enter

edit policy-options

2. Set the match condition to match on direct routes:

set policy-statement advertise-rip-routes term from-direct from protocol direct

3. Set the match action to accept these routes:

set policy-statement advertise-rip-routes term from-direct then accept

Configure a routing policy to advertise
directly connected routes.

1. From the [edit] hierarchy level, enter

edit policy-options

2. Set the match condition to match on direct routes:

set policy-statement advertise-rip-routes term from-rip from protocol rip

3. Set the match action to accept these routes:

set policy-statement advertise-rip-routes term from-rip then accept

Configure the previous routing policy to
advertise routes learned from RIP.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding Basic RIP Routing on page 492

■ RIP Overview on page 485

RIP Traffic Control Through Metrics

■ Understanding RIP Traffic Control with Metrics on page 493

■ Example: Controlling Traffic with the Incoming Metric (CLI) on page 494

■ Example: Controlling Traffic with the Outgoing Metric (CLI) on page 496

Understanding RIP Traffic Control with Metrics

To tune a RIP network and control traffic flowing through the network, you increase
or decrease the cost of the paths through the network. RIP provides two ways to
modify the path cost: an incoming metric and an outgoing metric, which are each

RIP Traffic Control Through Metrics ■ 493
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set to 1 by default. These metrics are attributes that manually specify the cost of any
route advertised through a host. By increasing or decreasing the metrics—and thus
the cost—of links throughout the network, you can control packet transmission across
the network.

The incoming metric modifies the cost of an individual segment when a route across
the segment is imported into the routing table. For example, if you set the incoming
metric on the segment to 3, the individual segment cost along the link is changed
from 1 to 3. The increased cost affects all route calculations through that link. Other
routes that were previously excluded because of a high hop count might now be
selected into the router's forwarding table.

The outgoing metric modifies the path cost for all the routes advertised out a particular
interface. Unlike the incoming metric, the outgoing metric modifies the routes that
other routers are learning and thereby controls the way they send traffic.

If an exported route was learned from a member of the same RIP group, the metric
associated with that route is the normal RIP metric. For example, a RIP route with
a metric of 5 learned from a neighbor configured with an incoming metric of 2 is
advertised with a combined metric of 7 when advertised to neighbors in the same
group. However, if this route was learned from a RIP neighbor in a different group
or from a different protocol, the route is advertised with the metric value configured
in the outgoing metric for that group.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ RIP Overview on page 485

■ Example: Controlling Traffic with the Incoming Metric (CLI) on page 494

■ Example: Controlling Traffic with the Outgoing Metric (CLI) on page 496

Example: Controlling Traffic with the Incoming Metric (CLI)

Depending on the RIP network topology and the links between nodes in the network,
you might want to control traffic flow through the network to maximize flow across
higher-bandwidth links. Figure 61 on page 494 shows a network with alternate routes
between Routers A and D.

Figure 61: Controlling Traffic in a RIP Network with the Incoming Metric
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In this example, routes to Router D are received by Router A across both of its
RIP-enabled interfaces. Because the route through Router B and the route through
Router C have the same number of hops, both routes are imported into the forwarding
table. However, because the T3 link from Router B to Router D has a higher bandwidth
than the T1 link from Router C to Router D, you want traffic to flow from A through
B to D.

To force this flow, you can modify the route metrics as they are imported into
Router A's routing table. By setting the incoming metric on the interface from Router A
to Router C, you modify the metric on all routes received through that interface.
Setting the incoming route metric on Router A changes only the routes in Router A's
routing table, and affects only how Router A sends traffic to Router D. Router D's
route selection is based on its own routing table, which, by default, includes no
adjusted metric values.

In the example, Router C receives a route advertisement from Router D and
readvertises the route to Router A. When Router A receives the route, it applies the
incoming metric on the interface. Instead of incrementing the metric by 1 (the
default), Router A increments it by 3 (the configured incoming metric), giving the
route from Router A to Router D through Router C a total path metric of 4. Because
the route through Router B has a metric of 2, it becomes the preferred route for all
traffic from Router A to Router D.

To modify the incoming metric on all routes learned on the link between Router A
and Router C and to force traffic through Router B:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 134 on page 495.

3. If you are finished configuring the router, commit the configuration.

Table 134: Modifying the Incoming Metric

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols rip group alpha1 neighbor ge-0/0/0

In the configuration hierarchy, navigate to the level of an
interface in the alpha1 RIP group.

Set the incoming metric to 3:

set metric-in 3

Increase the incoming metric to 3.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding RIP Traffic Control with Metrics on page 493

■ Example: Controlling Traffic with the Outgoing Metric (CLI) on page 496

■ RIP Overview on page 485
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Example: Controlling Traffic with the Outgoing Metric (CLI)

Figure 62 on page 496 shows a RIP network with alternative routes between Routers
A and D.

Figure 62: Controlling Traffic in a RIP Network with the Outgoing Metric

In this example, each route from Router A to Router D has two hops. However,
because the link from Router A to Router B in RIP group Beta 1 has a higher bandwidth
than the link from Router A to Router C in RIP group Alpha 1, you want traffic from
Router D to Router A to flow through Router B. To control the way Router D sends
traffic to Router A, you can alter the routes that Router D receives by configuring the
outgoing metric on Router A's interfaces in the Alpha 1 RIP group.

If the outgoing metric for the Alpha 1 RIP group—the A-to-C link—is changed to 3,
Router D calculates the total path metric from to A through C as 4. In contrast, the
unchanged default total path metric to A through B in the Beta 1 RIP group is 2. The
fact that Router A's interfaces belong to two different RIP groups allows you to
configure two different outgoing metrics on its interfaces, because you configure
path metrics at the group level.

By configuring the incoming metric, you control the way Router A sends traffic to
Router D. By configuring the outgoing metric on the same router, you control the
way Router D sends traffic to Router A.

To modify the outgoing metric on Router A and force traffic through Router B:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 135 on page 497.

3. If you are finished configuring the router, commit the configuration.
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Table 135: Modifying the Outgoing Metric

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols rip group alpha1

Navigate to the alpha1 level in the configuration hierarchy.

Set the outgoing metric to 3:

set metric-out 3

Increase the outgoing metric to 3.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding RIP Traffic Control with Metrics on page 493

■ Example: Controlling Traffic with the Incoming Metric (CLI) on page 494

■ RIP Overview on page 485

RIP Authentication

■ Understanding RIP Authentication on page 497

■ Enabling Authentication with Plain-Text Passwords (CLI Procedure) on page 498

■ Enabling Authentication with MD5 Authentication (CLI Procedure) on page 498

Understanding RIP Authentication

RIPv2 provides authentication support so that RIP links can require authentication
keys (passwords) before they become active. Authentication provides an additional
layer of security on the network beyond the other security features. By default, this
authentication is disabled.

Authentication keys can be specified in either plain-text or MD5 form. Authentication
requires all routers within the RIP network or subnetwork to have the same
authentication type and key (password) configured.

This type of authentication is not supported on RIPv1 networks.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ RIP Overview on page 485

■ Enabling Authentication with Plain-Text Passwords (CLI Procedure) on page 498

■ Enabling Authentication with MD5 Authentication (CLI Procedure) on page 498
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Enabling Authentication with Plain-Text Passwords (CLI Procedure)

To configure authentication that requires a plain-text password to be included in the
transmitted packet, enable simple authentication by performing these steps on all
RIP devices in the network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 136 on page 498.

3. If you are finished configuring the router, commit the configuration.

Table 136: Configuring Simple RIP Authentication

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols rip

Navigate to Rip level in the configuration hierarchy.

Set the authentication type to simple:

set authentication-type simple

Set the authentication type to simple.

Set the authentication key to a simple-text password:

set authentication-key password

Set the authentication key to a simple-text password.

The password can be from 1 through 16 contiguous characters
long and can include any ASCII strings.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding RIP Authentication on page 497

■ Enabling Authentication with MD5 Authentication (CLI Procedure) on page 498

Enabling Authentication with MD5 Authentication (CLI Procedure)

To configure authentication that requires an MD5 password to be included in the
transmitted packet, enable MD5 authentication by performing these steps on all RIP
devices in the network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 137 on page 499.

3. If you are finished configuring the router, commit the configuration.
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Table 137: Configuring MD5 RIP Authentication

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols rip

Navigate to Rip level in the configuration hierarchy.

Set the authentication type to md5:

set authentication-type md5

Set the authentication type to MD5.

Set the MD5 authentication key:

set authentication-key password

Set the MD5 authentication key (password).

The key can be from 1 through 16 contiguous characters long
and can include any ASCII strings.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding RIP Authentication on page 497

■ Enabling Authentication with Plain-Text Passwords (CLI Procedure) on page 498

Verifying a RIP Configuration

To verify a RIP configuration, perform the following tasks:

■ Verifying the Exchange of RIP Messages on page 499

■ Verifying the RIP-Enabled Interfaces on page 500

■ Verifying Reachability of All Hosts in the RIP Network on page 501

Verifying the Exchange of RIP Messages

Purpose Verify that RIP messages are being sent and received on all RIP-enabled interfaces.

Action From the CLI, enter the show rip statistics command.

Sample Output user@host> show rip statistics
RIPv2 info: port 520; holddown 120s.
    rts learned  rts held down  rqsts dropped  resps dropped
             10              0              0              0

t1-0/0/2.0:  0 routes learned; 13 routes advertised; timeout 120s; update interval
 45s
Counter                         Total   Last 5 min  Last minute
-------                   -----------  -----------  -----------
Updates Sent                     2855           11            2
Triggered Updates Sent              5            0            0
Responses Sent                      0            0            0
Bad Messages                        0            0            0
RIPv1 Updates Received              0            0            0
RIPv1 Bad Route Entries             0            0            0
RIPv1 Updates Ignored               0            0            0
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RIPv2 Updates Received             41            0            0
RIPv2 Bad Route Entries             0            0            0
RIPv2 Updates Ignored               0            0            0
Authentication Failures             0            0            0
RIP Requests Received               0            0            0
RIP Requests Ignored                0            0            0

ge-0/0/1.0:  10 routes learned; 3 routes advertised; timeout 180s; update interval
 30s
Counter                         Total   Last 5 min  Last minute
-------                   -----------  -----------  -----------
Updates Sent                     2855           11            2
Triggered Updates Sent              3            0            0
Responses Sent                      0            0            0
Bad Messages                        1            0            0
RIPv1 Updates Received              0            0            0
RIPv1 Bad Route Entries             0            0            0
RIPv1 Updates Ignored               0            0            0
RIPv2 Updates Received           2864           11            2
RIPv2 Bad Route Entries            14            0            0
RIPv2 Updates Ignored               0            0            0
Authentication Failures             0            0            0
RIP Requests Received               0            0            0
RIP Requests Ignored                0            0            0

Meaning The output shows the number of RIP routes learned. It also shows the number of
RIP updates sent and received on the RIP-enabled interfaces. Verify the following
information:

■ The number of RIP routes learned matches the number of expected routes
learned. Subnets learned by direct connectivity through an outgoing interface
are not listed as RIP routes.

■ RIP updates are being sent on each RIP-enabled interface. If no updates are being
sent, the routing policy might not be configured to export routes.

■ RIP updates are being received on each RIP-enabled interface. If no updates are
being received, the routing policy might not be configured to export routes on
the host connected to that subnet. The lack of updates might also indicate an
authentication error.

Verifying the RIP-Enabled Interfaces

Purpose Verify that all the RIP-enabled interfaces are available and active.

Action From the CLI, enter the show rip neighbor command.

Sample Output user@host> show rip neighbor
Source          Destination     Send   Receive   In
Neighbor          State  Address         Address         Mode   Mode     Met
--------          -----  -------         -----------     ----   -------  ---
ge-0/0/0.0           Dn (null)          (null)          mcast  both       1
ge-0/0/1.0           Up 192.168.220.5   224.0.0.9       mcast  both       1
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Meaning The output shows a list of the RIP neighbors that are configured on the device. Verify
the following information:

■ Each configured interface is present. Interfaces are listed in alphabetical order.

■ Each configured interface is up. The state of the interface is listed in the
Destination State column. A state of Up indicates that the link is passing RIP
traffic. A state of Dn indicates that the link is not passing RIP traffic. In a
point-to-point link, this state generally means that either the end point is not
configured for RIP or the link is unavailable.

Verifying Reachability of All Hosts in the RIP Network

Purpose By using the traceroute tool on each loopback address in the network, verify that all
hosts in the RIP network are reachable from each Juniper Networks device.

Action For each device in the RIP network:

1. In the J-Web interface, select Troubleshoot>Traceroute.

2. In the Remote Host box, type the name of a host for which you want to verify
reachability from the device.

3. Click Start. Output appears on a separate page.

Sample Output 1 172.17.40.254 (172.17.40.254) 0.362 ms 0.284 ms 0.251 ms
2 routera-fxp0.englab.mycompany.net (192.168.71.246) 0.251 ms 0.235 ms 0.200 ms

Meaning Each numbered row in the output indicates a routing hop in the path to the host.
The three-time increments indicate the round-trip time (RTT) between the device
and the hop for each traceroute packet.

To ensure that the RIP network is healthy, verify the following information:

■ The final hop in the list is the host you want to reach.

■ The number of expected hops to the host matches the number of hops in the
traceroute output. The appearance of more hops than expected in the output
indicates that a network segment is probably unreachable. It might also indicate
that the incoming or outgoing metric on one or more hosts has been set
unexpectedly.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ RIP Configuration Overview on page 491

■ show rip statistics in the Junos Routing Protocols and Policies Command Reference

■ show rip neighbor in the Junos Routing Protocols and Policies Command Reference

■ traceroute in the Junos System Basics and Services Command Reference

■ RIP Overview on page 485
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Chapter 19

OSPF

■ OSPF Overview on page 503

■ OSPF Configuration Overview on page 504

■ OSPF Designated Routers on page 506

■ OSPF Areas, Area Border Routers, and Backbone Areas on page 508

■ OSPF Stub Areas and Not-So-Stubby Areas on page 513

■ OSPF Authentication on page 515

■ OSPF Traffic Control on page 517

■ Verifying an OSPF Configuration on page 519

OSPF Overview

OSPF is an interior gateway protocol (IGP) that routes packets within a single
autonomous system (AS). In an OSPF network, the network topology is distributed
among the nodes of the AS and is regularly updated through the exchange of link-state
advertisements (LSAs). As a result, OSPF is known as a link-state protocol. Because
topology changes are flooded throughout the network, every node maintains the
same copy of the network map in its local topological database. Packets are then
routed based on the shared topology using the shortest path first (SPF) algorithm.

NOTE: In this topic, the term OSPF refers to OSPF version 2 and OSPF version 3.

OSPF creates a topology map by flooding LSAs across OSPF-enabled links. LSAs
announce the presence of OSPF-enabled interfaces to adjacent OSPF interfaces. The
exchange of LSAs establishes bidirectional connectivity between all adjacent OSPF
interfaces (neighbors) using a three-way handshake, as shown in Figure 63 on
page 504.
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Figure 63: OSPF Three-Way Handshake

In Figure 63 on page 504, Router A sends hello packets out all its OSPF-enabled
interfaces when it comes online. Router B receives the packet, which establishes that
Router B can receive traffic from Router A. Router B generates a response to Router
A to acknowledge receipt of the hello packet. When Router A receives the response,
it establishes that Router B can receive traffic from Router A. Router A then generates
a final response packet to inform Router B that Router A can receive traffic from
Router B. This three-way handshake ensures bidirectional connectivity.

As new neighbors are added to the network or existing neighbors lose connectivity,
the adjacencies in the topology map are modified accordingly through the exchange
(or absence) of LSAs. These LSAs advertise only the incremental changes in the
network, which helps minimize the amount of OSPF traffic on the network. The
adjacencies are shared and used to create the network topology in the topological
database.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ OSPF Configuration Overview on page 504

■ Understanding OSPF Designated Routers on page 506

■ Understanding OSPF Areas, Area Border Routers, and Backbones on page 508

■ Understanding OSPF Stub Areas and Not-So-Stubby Areas on page 513

■ Understanding OSPF Authentication on page 515

■ Understanding OSPF Traffic Control on page 517

OSPF Configuration Overview

To activate OSPF on a network, you must enable the protocol on all interfaces within
the network on which OSPF traffic is to travel, as explained in the steps that follow.
To enable OSPF, you must configure one or more interfaces on the device within an
OSPF area. Once the interfaces are configured, OSPF link-state advertisements (LSAs)
are transmitted on all OSPF-enabled interfaces, and the network topology is shared
throughout the network.

504 ■ OSPF Configuration Overview

JUNOS Software Interfaces and Routing Configuration Guide



To configure the Juniper Networks device as a node in an OSPF network:

1. Configure network interfaces. See Configuring OSPF on Interfaces and the JUNOS
Software Interfaces Configuration Guide for Security Devices.

2. Configure security filters. See Security Policies Overview in the Junos OS Security
Configuration Guide.

3. Configure the router identifiers for the devices in your OSPF network. See
“Example: Configuring the OSPF Router Identifier (CLI)” on page 506.

4. Create the backbone area for your OSPF network and add the appropriate
interfaces to the area. See “Example: Configuring a Single-Area OSPF Network
(CLI)” on page 509.

NOTE: Once you complete this step, OSPF begins sending LSAs. No additional
configuration is required to enable OSPF traffic on the network.

5. (Optional) Add additional areas to your network and configure area border
routers. See “Example: Configuring a Multiarea OSPF Network (CLI)” on page 511.

6. Enable dial-on-demand routing backup on the OSPF-enabled interface if you are
configuring OSPF across a demand circuit such as an ISDN link. (You must have
already configured an ISDN interface.) Because demand circuits do not pass all
traffic required to maintain an OSPF adjacency (hello packets, for example), you
configure dial-on-demand routing so individual nodes in an OSPF network can
maintain adjacencies despite the lack of LSA exchanges. See the JUNOS Software
Interfaces Configuration Guide for Security Devices.

7. (Optional) Reduce the amount of memory that the nodes use to maintain the
topology database by configuring stub and not-so-stubby areas. See “Example:
Configuring OSPF Stub and Not-So-Stubby Areas (CLI)” on page 514.

8. (Optional) Ensure that only trusted routers participate in the autonomous system’s
(AS’s) routing by enabling authentication. See “Example: Enabling Authentication
for OSPF Exchanges (CLI)” on page 516.

9. (Optional) Control the flow of traffic across the network by configuring path
metrics and route selection. See“Example: Controlling the Cost of Individual
OSPF Network Segments (CLI)” on page 518 and “Example: Controlling OSPF
Route Selection in the Forwarding Table (CLI)” on page 519.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ OSPF Overview on page 503

■ Verifying an OSPF Configuration on page 519

■ Configuring OSPF in the Junos Routing Protocols Configuration Guide

■ Minimum OSPF Configuration in the Junos Routing Protocols Configuration Guide
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OSPF Designated Routers

■ Understanding OSPF Designated Routers on page 506

■ Example: Configuring the OSPF Router Identifier (CLI) on page 506

■ Example: Controlling OSPF Designated Router Election (CLI) on page 507

Understanding OSPF Designated Routers

Large LANs that have many routers and therefore many OSPF adjacencies can produce
heavy control-packet traffic as link-state advertisements (LSAs) are flooded across
the network. To alleviate the potential traffic problem, OSPF uses designated routers.
Rather than broadcasting LSAs to all their OSPF neighbors, the routers send their
LSAs to the designated router, which processes the LSAs, generates responses, and
multicasts topology updates to all OSPF routers.

In LANs, the election of the designated router takes place when the OSPF network
is initially established. When the first OSPF links are active, the router with the highest
router identifier (defined by the router-id configuration value or the loopback address)
is elected designated router. The router with the second highest router identifier is
elected the backup designated router. If the designated router fails or loses
connectivity, the backup designated router assumes its role and a new backup
designated router election takes place between all the routers in the OSPF network.

OSPF uses the router identifier to elect a designated router, unless you manually
specify a priority value. At designated router election, the router priorities are
evaluated first, and the router with the highest priority is elected designated router.

By default, routers have a priority of 128. A priority of 0 marks the router as ineligible
to become the designated router. To configure a router so it is always the designated
router, set its priority to 255.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ OSPF Overview on page 503

■ Example: Configuring the OSPF Router Identifier (CLI) on page 506

■ Example: Controlling OSPF Designated Router Election (CLI) on page 507

Example: Configuring the OSPF Router Identifier (CLI)

To configure the router identifier for the device:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 138 on page 507.
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Table 138: Configuring the Router Identifier

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options

Navigate to the Routing-options level in the configuration
hierarchy.

Enter

set router-id 177.162.4.24

Set the router ID value to the IP address of the device—for
example, 177.162.4.24.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Designated Routers on page 506

■ Example: Controlling OSPF Designated Router Election (CLI) on page 507

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503

Example: Controlling OSPF Designated Router Election (CLI)

To change the priority of a device to control designated router election:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 139 on page 507.

Table 139: Controlling Designated Router Election

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf area 0.0.0.3 interface ge-0/0/1

Navigate to the OSPF interface address for the device. For example,
navigate to the ge-/0/0/1 level in the configuration hierarchy.

Set the priority value:

set priority 200

Set the device priority to a value between 0 and 255—for example,
200. The default value is 128.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Designated Routers on page 506

■ Example: Configuring the OSPF Router Identifier (CLI) on page 506

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503
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OSPF Areas, Area Border Routers, and Backbone Areas

■ Understanding OSPF Areas, Area Border Routers, and Backbones on page 508

■ Example: Configuring a Single-Area OSPF Network (CLI) on page 509

■ Example: Configuring a Multiarea OSPF Network (CLI) on page 511

Understanding OSPF Areas, Area Border Routers, and Backbones

OSPF networks in an autonomous system (AS) are administratively grouped into
areas. Each area within an AS operates like an independent network and has a unique
32-bit area ID, which functions like a network address. Within an area, the topology
database contains only information about the area, link-state advertisements (LSAs)
are flooded only to nodes within the area, and routes are computed only within the
area. Subnetworks are divided into other areas, which are connected to form the
whole of the main network.

The central area of an AS, called the backbone area, has a special function and is
always assigned the area ID 0.0.0.0. (Within a simple, single-area network, this is
also the ID of the area.) Area IDs are unique numeric identifiers, in dotted decimal
notation, but they are not IP addresses. Area IDs need only be unique within an AS.
All other networks or areas in the AS must be directly connected to the backbone
area by a router that has interfaces in more than one area. These connecting routers
are called area border routers (ABRs). Figure 64 on page 508 shows an OSPF topology
of three areas connected by two ABRs.

Figure 64: Multiarea OSPF Topology

Because all areas are adjacent to the backbone area, OSPF routers send all traffic not
destined for their own area through the backbone area. The ABRs in the backbone
area are then responsible for transmitting the traffic through the appropriate ABR to
the destination area. The ABRs summarize the link-state records of each area and
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advertise destination address summaries to neighboring areas. The advertisements
contain the ID of the area in which each destination lies, so that packets are routed
to the appropriate ABR. For example, in the OSPF areas shown in Figure 64 on
page 508, packets sent from Router A to Router C are automatically routed through
ABR B.

An OSPF restriction requires all areas to be directly connected to the backbone area
so that packets can be properly routed. All packets are routed first to the backbone
area by default. Packets that are destined for an area other than the backbone area
are then routed to the appropriate ABR and on to the remote host within the
destination area.

In large networks with many areas, in which direct connectivity between all areas
and the backbone area is physically difficult or impossible, you can configure virtual
links to connect noncontiguous areas. For example, Figure 65 on page 509 shows a
virtual link between a noncontiguous area and the backbone area through an area
connected to both.

Figure 65: OSPF Topology with a Virtual Link
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In the topology shown in Figure 65 on page 509, a virtual link is established between
area 0.0.0.3 and the backbone area through area 0.0.0.2. All outbound traffic destined
for other areas is routed through area 0.0.0.2 to the backbone area and then to the
appropriate ABR. All inbound traffic destined for area 0.0.0.3 is routed to the
backbone area and then through area 0.0.0.2.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ OSPF Overview on page 503

■ Example: Configuring a Single-Area OSPF Network (CLI) on page 509

■ Example: Configuring a Multiarea OSPF Network (CLI) on page 511

Example: Configuring a Single-Area OSPF Network (CLI)

To use OSPF on the device, you must configure at least one OSPF area, like the one
shown in Figure 66 on page 510.
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Figure 66: Typical Single-Area OSPF Network Topology

To configure a single-area OSPF network with a backbone area, like the one in Figure
66 on page 510, perform these steps on each device in the network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 140 on page 510.

3. If you are finished configuring the router, commit the configuration.

Table 140: Configuring a Single-Area OSPF Network

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf

Navigate to the Ospf level in the configuration hierarchy.

1. Set the backbone area ID to 0.0.0.0 and add an
interface:

set area 0.0.0.0 interface ge-0/0/0

2. Repeat Step 1 for each interface on this device
that you are adding to the backbone area. Only
one interface is required.

Create the backbone area with area ID 0.0.0.0.

Add interfaces as needed to the OSPF area—for example, ge-0/0/0.

For information about interface names, see JUNOS Software Interfaces
Configuration Guide for Security Devices.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Areas, Area Border Routers, and Backbones on page 508

■ Example: Configuring a Multiarea OSPF Network (CLI) on page 511

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503
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Example: Configuring a Multiarea OSPF Network (CLI)

To reduce traffic and topology maintenance for the devices in an OSPF autonomous
system (AS), you can group them into multiple areas, as shown in Figure 67 on
page 511

Figure 67: Typical Multiarea OSPF Network Topology

To configure a multiarea OSPF network shown in Figure 5, perform the following
tasks on the appropriate devices in the network. You must create a backbone area.
To link each additional area to the backbone area, you must configure one of the
devices as an area border router (ABR).

■ Creating the Backbone Area on page 511

■ Creating Additional OSPF Areas on page 511

■ Configuring Area Border Routers on page 512

Creating the Backbone Area

On each device that is to operate as an ABR in the network, create backbone area
0.0.0.0 with at least one interface enabled for OSPF.

For instruction, see “Example: Configuring a Single-Area OSPF Network (CLI)” on
page 509.

Creating Additional OSPF Areas

To create additional OSPF areas:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 141 on page 512.

3. If you are finished configuring the router, commit the configuration.
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Table 141: Configuring a Multiarea OSPF Network

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf

Navigate to the Ospf level in the configuration hierarchy.

1. Set the area ID to 0.0.0.2 and add an interface:

set area 0.0.0.2 interface ge-0/0/0

2. Repeat Step 1 for each interface on this device that
you are adding to the area. Only one interface is
required.

Create the additional area with a unique area ID, in dotted decimal
notation—for example, 0.0.0.2.

Add interfaces as needed to the OSPF area—for example, ge-0/0/0.

Configuring Area Border Routers

To configure an area border router:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 142 on page 512.

3. If you are finished configuring the router, commit the configuration.

After you create the areas on the appropriate devices and add and enable the
appropriate interfaces to the areas, no additional configuration is required to
enable OSPF traffic within or across the areas.

Table 142: Configuring Area Border Routers

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf

Navigate to the Ospf level in the configuration
hierarchy.

View the configuration using the show command:

show

For example, device B in Figure 67 on page 511 has the following
interfaces enabled for OSPF in the backbone area:

area 0.0.0.0 { interface ge-0/0/0.0; interface ge-0/0/1.0; }

To enable an interface on the backbone area, see “Example: Configuring
a Single-Area OSPF Network (CLI)” on page 509.

Verify that the backbone area has at least one
interface enabled for OSPF.

1. Set the area ID to 0.0.0.2 and add an interface:

set area 0.0.0.2 interface ge-0/0/0

2. Repeat Step 1 for each interface on this device that you are adding
to the area. Only one interface is required.

Create the additional area with a unique area ID—for
example, 0.0.0.2.

Add interfaces as needed to the OSPF area—for
example, ge-0/0/0.
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Areas, Area Border Routers, and Backbones on page 508

■ Example: Configuring a Single-Area OSPF Network (CLI) on page 509

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503

OSPF Stub Areas and Not-So-Stubby Areas

■ Understanding OSPF Stub Areas and Not-So-Stubby Areas on page 513

■ Example: Configuring OSPF Stub and Not-So-Stubby Areas (CLI) on page 514

Understanding OSPF Stub Areas and Not-So-Stubby Areas

Figure 68 on page 513 shows an autonomous system (AS) across which many external
routes are advertised. If external routes make up a significant portion of a topology
database, you can suppress the advertisements in areas that do not have links outside
the network. By doing so, you can reduce the amount of memory the nodes use to
maintain the topology database and free it for other uses.

Figure 68: OSPF AS Network with Stub Areas and NSSAs
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Area 0.0.0.3 Area 0.0.0:4
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To control the advertisement of external routes into an area, OSPF uses stub areas.
By designating an area border router (ABR) interface to the area as a stub interface,
you suppress external route advertisements through the ABR. Instead, the ABR
automatically advertises a default route (through itself) in place of the external routes.
Packets destined for external routes are automatically sent to the ABR, which acts
as a gateway for outbound traffic and routes them appropriately.
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For example, area 0.0.0.3 in Figure 68 on page 513 is not directly connected to the
outside network. All outbound traffic is routed through the ABR to the backbone and
then to the destination addresses. By designating area 0.0.0.3 as a stub area, you
reduce the size of the topology database for that area by limiting the route entries
to only those routes internal to the area.

Similar to area 0.0.0.3 in Figure 68 on page 513, area 0.0.0.4 has no external
connections. However, area 0.0.0.4 has static customer routes that are not internal
OSPF routes. You can limit the external route advertisements to the area and advertise
the static customer routes by designating it a not-so-stubby area (NSSA). External
routes are flooded into the NSSA and then leaked to the other areas, but external
routes from other areas are not advertised within the NSSA.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ OSPF Overview on page 503

■ Example: Configuring OSPF Stub and Not-So-Stubby Areas (CLI) on page 514

Example: Configuring OSPF Stub and Not-So-Stubby Areas (CLI)

To control the advertisement of external routes into an area, you can create stub
areas and not-so-stubby areas (NSSAs) in an OSPF network. In the network shown
in Figure 69 on page 514, area 0.0.0.7 has no external connections and can be
configured as a stub area. Area 0.0.0.9 only has external connections to static routes
and can be configured as an NSSA.

Figure 69: OSPF Network Topology with Stub Areas and NSSAs

To configure stub areas and NSSAs in an OSPF network like the one shown in Figure
69 on page 514:

1. Navigate to the top of the configuration hierarchy.
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2. To configure each device in area 0.0.0.7 as a stub area router, perform the
configuration tasks described in Table 143 on page 515.

3. If you are finished configuring the router, commit the configuration.

Table 143: Configuring Stub Area and Not-So-Stubby Area Routers

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf area 0.0.0.7

Navigate to the 0.0.0.7 level in the configuration hierarchy.

1. Set the stub attribute:

set stub

2. Repeat Step 1 for every device in the stub area to
configure them with the stub parameter for the area.

Configure each device in area 0.0.0.7 as a stub router.

From the [edit] hierarchy level, enter

edit protocols ospf area 0.0.0.9

Navigate to the 0.0.0.9 level in the configuration hierarchy.

1. Set the nssa attribute:

set nssa

2. Repeat Step 1 for every device in the NSSA to configure
them with the nssa parameter for the area.

Configure each device in area 0.0.0.9 as an NSSA router.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Stub Areas and Not-So-Stubby Areas on page 513

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503

OSPF Authentication

■ Understanding OSPF Authentication on page 515

■ Example: Enabling Authentication for OSPF Exchanges (CLI) on page 516

Understanding OSPF Authentication

All OSPF version 2 (OSPFv2) protocol exchanges can be authenticated to guarantee
that only trusted routers participate in the autonomous system’s (AS’s) routing. By
default, OSPF authentication is disabled.
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NOTE: OSPFv3 does not support authentication.

You can enable either of two authentication types:

■ Simple authentication—Authenticates by means of a plain-text password (key)
included in the transmitted packet.

■ MD5 authentication—Authenticates by means of an MD5 checksum included in
the transmitted packet.

Because OSPF performs authentication at the area level, all routers within the area
must have the same authentication and corresponding password (key) configured.
For MD5 authentication to work, both the receiving and transmitting routers must
have the same MD5 key.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ OSPF Overview on page 503

■ Example: Enabling Authentication for OSPF Exchanges (CLI) on page 516

Example: Enabling Authentication for OSPF Exchanges (CLI)

To enable OSPF authentication on the stub area:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 144 on page 516.

Table 144: Enabling OSPF Authentication

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf area 0.0.0.0

Navigate to the 0.0.0.0 level in the configuration hierarchy.

Set the authentication type:

set authentication-type md5

Set the authentication type for the stub area to either simple or
MD5—for example, MD5.

From the [edit] hierarchy level, enter

edit protocols ospf area 0.0.0.0 interface interface-name

Navigate to the interface-name level in the configuration hierarchy.
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Table 144: Enabling OSPF Authentication (continued)

CLI Configuration EditorTask

1. Set the authentication password and, for MD5
authentication only, set the key identifier:

set authentication-key Chey3nne key-id 2

2. Repeat Step 1 for each interface in the stub area
for which you are enabling authentication.

Set the authentication password (key) and, for MD5 authentication
only, the key identifier to associate with the MD5 password:

■ For simple authentication, set a password of from 1 through
8 ASCII characters—for example, Chey3nne.

■ For MD5 authentication:

■ Set a password of from 1 through 16 ASCII characters—for
example, Chey3nne.

■ Set a key identifier between 0 (the default) and 255—for
example, 2.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Authentication on page 515

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503

OSPF Traffic Control

■ Understanding OSPF Traffic Control on page 517

■ Example: Controlling the Cost of Individual OSPF Network Segments
(CLI) on page 518

■ Example: Controlling OSPF Route Selection in the Forwarding Table
(CLI) on page 519

Understanding OSPF Traffic Control

Once a topology is shared across the network, OSPF uses the topology to route
packets between network nodes. Each path between neighbors is assigned a cost
based on the throughput, round-trip time, and reliability of the link. (OSPF assigns
a default cost metric of 1 to any link faster than 100 Mbps.) The sum of the costs
across a particular path between hosts determines the overall cost of the path. Packets
are then routed along the shortest path using the shortest path first (SPF) algorithm.
If multiple equal-cost paths exist between a source and destination address, OSPF
routes packets along each path alternately, in round-robin fashion.

To control the flow of packets across the network, OSPF allows you to manually
assign a cost (or metric) to a particular path segment. For example, if all routers in
the OSPF network use default metric values, and you increase the metric on one
interface to 5, all paths through this interface have a calculated metric higher than
the default and are not preferred.

You can also control the flow of packets through the network using route preferences.
When several routes have the same SPF calculation, OSPF uses route preferences to
select the route that is installed in the forwarding table. To evaluate a route, OSPF
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calculates the sum of the individual preferences of every router along the path and
selects the route with the lowest total preference.

By default, internal OSPF routes have a preference value of 10, and external OSPF
routes have a preference value of 150. Suppose all routers in your OSPF network use
the default preference values. By setting the internal preference to 7 and the external
preference to 130, you can ensure that the path through a particular device is selected
for the forwarding table any time multiple equal-cost paths to a destination exist.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ OSPF Overview on page 503

■ Example: Controlling the Cost of Individual OSPF Network Segments (CLI) on
page 518

■ Example: Controlling OSPF Route Selection in the Forwarding Table (CLI) on
page 519

■ Configuring the Metric Value for OSPF Interfaces

Example: Controlling the Cost of Individual OSPF Network Segments (CLI)

To manually set the cost of a network segment on the stub area's Fast Ethernet
interface by modifying the interface metric:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 145 on page 518.

Table 145: Controlling the Cost of Individual Network Segments by Modifying the Metric

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf area 0.0.0.0 interface ge-0/0/0.0

Navigate to the ge-0/0/0.0 level in the configuration
hierarchy.

Set the interface metric:

set metric 5

Set the interface metric.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Traffic Control on page 517

■ OSPF Configuration Overview on page 504

■ Example: Controlling OSPF Route Selection in the Forwarding Table (CLI) on
page 519

■ OSPF Overview on page 503
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Example: Controlling OSPF Route Selection in the Forwarding Table (CLI)

To modify the default OSPF route preferences on a device:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 146 on page 519.

Table 146: Controlling Route Selection in the Forwarding Table by Setting Preferences

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols ospf

Navigate to the Ospf level in the configuration
hierarchy.

1. Set the external preference:

set external-preference 130

2. Set the internal preference:

set preference 7

Set the external and internal route preferences.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding OSPF Traffic Control on page 517

■ Example: Controlling the Cost of Individual OSPF Network Segments (CLI) on
page 518

■ OSPF Configuration Overview on page 504

■ OSPF Overview on page 503

Verifying an OSPF Configuration

To verify an OSPF configuration, perform these tasks:

■ Verifying OSPF-Enabled Interfaces on page 519

■ Verifying OSPF Neighbors on page 520

■ Verifying the Number of OSPF Routes on page 521

■ Verifying Reachability of All Hosts in an OSPF Network on page 522

Verifying OSPF-Enabled Interfaces

Purpose Verify that OSPF is running on a particular interface and that the interface is in the
desired area.

Action From the CLI, enter the show ospf interface command.
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Sample Output user@host> show ospf interface
Intf                State     Area            DR ID           BDR ID       Nbrs
at-5/1/0.0          PtToPt   0.0.0.0         0.0.0.0         0.0.0.0         1
ge-2/3/0.0          DR       0.0.0.0         192.168.4.16    192.168.4.15    1
lo0.0               DR       0.0.0.0         192.168.4.16    0.0.0.0         0
so-0/0/0.0          Down     0.0.0.0         0.0.0.0         0.0.0.0         0
so-6/0/1.0          PtToPt   0.0.0.0         0.0.0.0         0.0.0.0         1
so-6/0/2.0          Down     0.0.0.0         0.0.0.0         0.0.0.0         0
so-6/0/3.0          PtToPt   0.0.0.0         0.0.0.0         0.0.0.0         1

Meaning The output shows a list of the device interfaces that are configured for OSPF. Verify
the following information:

■ Each interface on which OSPF is enabled is listed.

■ Under Area, each interface shows the area for which it was configured.

■ Under Intf and State, the device loopback (lo0.0) interface and LAN interface that
are linked to the OSPF network's designated router (DR) are identified.

■ Under DR ID, the IP address of the OSPF network's designated router appears.

■ Under State, each interface shows a state of PtToPt to indicate a point-to-point
connection. If the state is Waiting, check the output again after several seconds.
A state of Down indicates a problem.

■ The designated router addresses always show a state of DR.

Verifying OSPF Neighbors

Purpose OSPF neighbors are interfaces that have an immediate adjacency. On a point-to-point
connection between the device and another router running OSPF, verify that each
router has a single OSPF neighbor.

Action From the CLI, enter the show ospf neighbor command.

Sample Output user@host> show ospf neighbor
 Address         Intf               State      ID              Pri  Dead
192.168.254.225  fxp3.0              2Way      10.250.240.32    128   36
192.168.254.230  fxp3.0              Full      10.250.240.8     128   38
192.168.254.229  fxp3.0              Full      10.250.240.35    128   33
10.1.1.129       fxp2.0              Full      10.250.240.12    128   37
10.1.1.131       fxp2.0              Full      10.250.240.11    128   38
10.1.2.1         fxp1.0              Full      10.250.240.9     128   32
10.1.2.81        fxp0.0              Full      10.250.240.10    128   33

Meaning The output shows a list of the device's OSPF neighbors and their addresses, interfaces,
states, router IDs, priorities, and number of seconds allowed for inactivity (“dead”
time). Verify the following information:

■ Each interface that is immediately adjacent to the device is listed.

■ The device's own loopback address and the loopback addresses of any routers
with which the device has an immediate adjacency are listed.
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■ Under State, each neighbor shows a state of Full. Because full OSPF connectivity
is established over a series of packet exchanges between clients, the OSPF link
might take several seconds to establish. During that time, the state might be
displayed as Attempt, Init, or 2way, depending on the stage of negotiation.

If, after 30 seconds, the state is not Full, the OSPF configuration between the
neighbors is not functioning correctly.

Verifying the Number of OSPF Routes

Purpose Verify that the OSPF routing table has entries for the following:

■ Each subnetwork reachable through an OSPF link

■ Each loopback address reachable on the network

For example, Figure 70 on page 521 shows a sample network with an OSPF topology.

Figure 70: Sample OSPF Network Topology

In this topology, OSPF is being run on all interfaces. Each segment in the network
is identified by an address with a /24 prefix, with interfaces on either end of the
segment being identified by unique IP addresses.

Action From the CLI, enter the show ospf route command.

Sample Output user@host> show ospf route
Prefix               Path   Route       NH   Metric  NextHop       Nexthop
                     Type   Type        Type         Interface     addr/label
10.10.10.1/24        Intra  Network     IP   1       ge-0/0/2.0    10.0.21.1
10.10.10.2/24        Intra  Network     IP   1       ge-0/0/2.0    10.0.21.1
10.10.10.4/24        Intra  Network     IP   1       ge-0/0/1.0    10.0.13.1
10.10.10.5/24        Intra  Network     IP   1       ge-0/0/2.0    10.0.21.1
10.10.10.6/24        Intra  Network     IP   1       ge-0/0/1.0    10.0.13.1
10.10.10.10/24       Intra  Network     IP   1       ge-0/0/2.0    10.0.21.1
10.10.10.11/24       Intra  Network     IP   1       ge-0/0/1.0    10.0.13.1
10.10.10.13/24       Intra  Network     IP   1       ge-0/0/1.0
10.10.10.16/24       Intra  Network     IP   1       ge-0/0/1.0    10.0.13.1
10.10.10.19/24       Intra  Network     IP   1       ge-0/0/1.0    10.0.13.1
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10.10.10.20/24       Intra  Network     IP   1       ge-0/0/2.0    10.0.21.1
10.10.10.21/24       Intra  Network     IP   1       ge-0/0/2.0
192.168.5.1          Intra  Router      IP   1       ge-0/0/2.0    10.0.21.1
192.168.5.2          Intra  Router      IP   1       lo0
192.168.5.3          Intra  Router      IP   1       ge-0/0/1.0    10.0.13.1
192.168.5.4          Intra  Router      IP   1       ge-0/0/1.0    10.0.13.1
192.168.5.5          Intra  Router      IP   1       ge-0/0/1.0    10.0.13.1
192.168.5.6          Intra  Router      IP   1       ge-0/0/2.0    10.0.21.1
192.168.5.7          Intra  Router      IP   1       ge-0/0/2.0    10.0.21.1
192.168.5.8          Intra  Router      IP   1       ge-0/0/2.0    10.0.21.1
192.168.5.9          Intra  Router      IP   1       ge-0/0/1.0    10.0.13.1

Meaning The output lists each route, sorted by IP address. Routes are shown with a route type
of Network, and loopback addresses are shown with a route type of Router.

For the example shown in Figure 70 on page 521, verify that the OSPF routing table
has 21 entries, one for each network segment and one for each router's loopback
address.

Verifying Reachability of All Hosts in an OSPF Network

Purpose By using the traceroute tool on each loopback address in the network, verify that all
hosts in the network are reachable from each device.

Action For each device in the OSPF network:

1. In the J-Web interface, select Troubleshoot>Traceroute.

2. In the Host Name box, type the name of a host for which you want to verify
reachability from the device.

3. Click Start. Output appears on a separate page.

Sample Output
1 172.17.40.254 (172.17.40.254) 0.362 ms 0.284 ms 0.251 ms
2 routera-fxp0.englab.mycompany.net (192.168.71.246) 0.251 ms 0.235 ms 0.200 ms

Meaning Each numbered row in the output indicates a routing “hop” in the path to the host.
The three-time increments indicate the round-trip time (RTT) between the device
and the hop, for each traceroute packet. To ensure that the OSPF network is healthy,
verify the following information:

■ The final hop in the list is the host you want to reach.

■ The number of expected hops to the host matches the number of hops in the
traceroute output. The appearance of more hops than expected in the output
indicates that a network segment is likely not reachable. In this case, verify the
routes with the show ospf route command.

For information about show ospf route, see “Verifying the Number of OSPF Routes”
on page 521.
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ OSPF Configuration Overview on page 504

■ traceroute in the Junos System Basics and Services Command Reference
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Chapter 20

IS-IS

■ IS-IS Overview on page 525

■ IS-IS Configuration Overview on page 529

■ Example: Configuring IS-IS (CLI) on page 529

■ IS-IS Designated Routers on page 530

■ Verifying the IS-IS Configuration on page 531

IS-IS Overview

The Intermediate System-to-Intermediate System (IS-IS) protocol is a classless interior
routing protocol developed by the International Organization for Standardization
(ISO) as part of the development of the Open Systems Interconnection (OSI) protocol
suite. Like OSPF routing, IS-IS uses hello packets that allow network convergence to
occur quickly when network changes are detected. IS-IS uses the shortest path first
(SPF) algorithm to determine routes. Using SPF, IS-IS evaluates network topology
changes and determines if a full or partial route calculation is required.

This topic contains the following sections:

■ IS-IS Areas on page 525

■ System Identifier Mapping on page 526

■ ISO Network Addresses on page 526

■ IS-IS Path Selection on page 527

■ Protocol Data Units on page 527

IS-IS Areas

An IS-IS network is a single autonomous system (AS), also called a routing domain,
that consists of end systems and intermediate systems. End systems are network
entities that send and receive packets. Intermediate systems (routers) send, receive,
and relay (forward) packets.

IS-IS does not force the network to use a hierarchical physical topology. Instead, a
single AS can be divided into two types of areas: Level 1 areas and Level 2 areas. A
Level 1 area is similar to an OSPF stub area, and a Level 2 area interconnects all
Level 1 areas. The router and its interfaces reside within one area, and Level 2 routers
share link-state information. No IS-IS area functions strictly as a backbone.
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Level 1 routers share intra-area routing information, and Level 2 routers share
interarea information about IP addresses available within each area. Uniquely, IS-IS
routers can act as both Level 1 and Level 2 routers, sharing intra-area routes with
other Level 1 routers and interarea routes with other Level 2 routers.

The propagation of link-state updates is determined by the level boundaries. All
routers within a level maintain a complete link-state database of all other routers in
the same level. Each router then uses the Dijkstra algorithm to determine the shortest
path from the local router to other routers in the link-state database.

System Identifier Mapping

To provide assistance with debugging IS-IS, JUNOS Software supports dynamic
mapping of ISO system identifiers to the hostname. Each router can be configured
with a hostname that allows the system identifier-to-hostname mapping to be sent
in a dynamic hostname type length value (TLV) in the IS-IS link-state PDU (LSP). The
mapping permits an intermediate system in the routing domain to learn the ISO
system identifier of another intermediate system.

ISO Network Addresses

IS-IS uses ISO network addresses. Each address identifies a point of connection to
the network, such as a router interface, which is called network service access point
(NSAP). NSAP addresses are supported on the loopback (lo0) interface.

An end system can have multiple NSAP addresses, which differ by the last byte called
an n-selector. Each NSAP represents a service that is available at the node. In addition
to multiple services, a single node can belong to multiple areas.

Each network entity also has a special address called a network entity title (NET) with
an identical structure to an NSAP address but an n-selector of 00. Most end systems
and intermediate systems have one NET address, while intermediate systems
participating in more than one area can have more than one NET address.

The following ISO addresses are examples of the IS-IS address format:

49.0001.00a0.c96b.c490.00

49.0001.2081.9716.9018.00

NETs take several forms, depending on your network requirements. NET addresses
are hexadecimal and range from 8 octets to 20 octets in length. Generally, the format
consists of an authority and format Identifier (AFI), a domain ID, an area ID, a system
identifier, and a selector. The simplest format omits the domain ID and is 10 octets
long. For example, the NET address 49.0001.1921.6800.1001.00 consists of the
following parts:

■ 49—AFI

■ 0001—Area ID

■ 1921.6800.1001—System identifier

■ 00—Selector
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The system identifier must be unique within the network. For an IP-only network,
we recommend using the IP address of an interface on the router. Configuring a
loopback NET address with the IP address is helpful when troubleshooting is required
on the network.

The first part of the address is the area number, which is a variable number from 1
to 13 bytes. The first byte of the area number, 49, is the authority and format indicator
(AFI). The next bytes are the assigned area identifier and can be from 0 to 12 bytes.
In the examples, 0001 is the area identifier.

The next 6 bytes are the system identifier and can be any 6 bytes unique throughout
the entire domain. The system identifier is commonly the media access control (MAC)
address, as shown in the first example, 00a0.c96b.c490. Otherwise, the system
identifier is the IP address expressed in binary-coded decimal (BCD) format, as shown
in the second example, 2081.9716.9018, which corresponds to 208.197.169.18.
The last byte, 00, is the n-selector.

NOTE: The system identifier cannot be configured as 0000.0000.0000. Using all
zeros as an identifier is not supported and does not form an adjacency.

IS-IS Path Selection

Level 1 routers store information about all the subnets within an area, and choose
intranetwork paths over internetwork paths. Using the area ID portion of the NET
address, Level 1 routers determine which neighboring routers are Level 1 routers
within the same area.

If the destination address is not within the area, Level 1 routers forward the packet
to the nearest router configured as both a Level 1 and Level 2 router within the area.
The Level 1 and Level 2 router forwards the packet, using the Level 2 topology, to
the proper area. The destination router, which is configured as a Level 1 and Level 2
router, then determines the best path through the destination area.

Protocol Data Units

IS-IS routers use protocol data units (PDUs) to exchange information. Each protocol
data unit (PDU) shares a common header.

IS-IS Hello PDU

IS-IS hello PDUs establish adjacencies with other routers and have three different
formats: one for point-to-point hello packets, one for Level 1 broadcast links, and
one for Level 2 broadcast links. Level 1 routers must share the same area address
to form an adjacency, while Level 2 routers do not have this limitation. The request
for adjacency is encoded in the Circuit type field of the PDU.

Hello PDUs have a preset length assigned to them. The IS-IS router does not resize
any PDU to match the maximum transmission unit (MTU) on a router interface. Each
interface supports the maximum IS-IS PDU of 1492 bytes, and hello PDUs are padded
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to meet the maximum value. When the hello is sent to a neighboring router, the
connecting interface supports the maximum PDU size.

Link-State PDU

A link-state PDU (LSP) contains information about each router in the network and
the connected interfaces. Also included is metric and IS-IS neighbor information.
Each LSP must be refreshed periodically on the network and is acknowledged by
information within a sequence number packet.

On point-to-point links, each LSP is acknowledged by a partial sequence number
PDU (PSNP), but on broadcast links, a complete sequence number PDU (CSNP) is
sent out over the network. Any router that finds newer LSP information in the CSNP
then purges the out-of-date entry and updates the link-state database.

LSPs support variable-length subnet mask addressing.

Complete Sequence Number PDU

The complete sequence number PDU (CSNP) lists all the link-state PDUs (LSPs) in
the link-state database of the local router. Contained within the CSNP is an LSP
identifier, a lifetime, a sequence number, and a checksum for each entry in the
database. Periodically, a CSNP is sent on both broadcast and point-to-point links to
maintain a correct database. Also, the advertisement of CSNPs occurs when an
adjacency is formed with another router. Like IS-IS hello PDUs, CSNPs come in two
types: Level 1 and Level 2.

When a device receives a CSNP, it checks the database entries against its own local
link-state database. If it detects missing information, the device requests specific LSP
details using a partial sequence number PDU (PSNP).

Partial Sequence Number PDU

A partial sequence number PDU (PSNP) is used by an IS-IS router to request LSP
information from a neighboring router. A PSNP can also explicitly acknowledge the
receipt of an LSP on a point-to-point link. On a broadcast link, a CSNP is used as
implicit knowledge. Like hello PDUs and CSNPs, the PSNP also has two types: Level
1 and Level 2.

When a device compares a CSNP to its local database and determines that an LSP
is missing, the router issues a PSNP for the missing LSP, which is returned in a
link-state PDU from the router sending the CSNP. The received LSP is then stored in
the local database, and an acknowledgement is sent back to the originating router.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ Understanding IS-IS Designated Routers on page 530

■ IS-IS Configuration Overview on page 529

■ OSPF Overview on page 503
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IS-IS Configuration Overview

To configure IS-IS:

1. Enable IS-IS if your router is in secure context.

[edit]
user@host# set security forwarding-options family iso mode packet-based

JUNOS Software security processing is not applied to IS-IS packets forwarded by
the router. By default in secure context, the router drops IS-IS packets.

2. Obtain ISO addresses for participating routers in the autonomous system (AS).

3. Configure security filters. See Security Policies Overview in the Junos OS Security
Configuration Guide.

4. Configure IS-IS. See “Example: Configuring IS-IS (CLI)” on page 529.

5. (Optional) Configure designated routers. “Configuring IS-IS Designated Routers
(CLI Procedure)” on page 531.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ IS-IS Overview on page 525

■ Verifying the IS-IS Configuration on page 531

■ Configuring IS-IS in the Junos Routing Protocols Configuration Guide

■ Minimum IS-IS Configuration in the Junos Routing Protocols Configuration Guide

Example: Configuring IS-IS (CLI)

To configure IS-IS, you must enable IS-IS on the device and configure a NET address
on one of the device interfaces (preferably, the lo0 interface). Additionally, you must
configure the ISO family on all interfaces that are supporting the IS-IS protocol.

In this example, you configure the 49.0001.00a0.c96b.c490.00 NET address on the
lo0 interface. Additionally, you configure the ISO family on the ge-0/0/1 physical
interface.

To configure IS-IS:

1. Navigate to the interfaces level in the configuration hierarchy.

[edit]
user@host# edit interfaces

2. Configure the loopback interface lo0.

[edit interfaces]
user@host# edit lo0

3. Configure the logical unit on the loopback interface (for example, 0).
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[edit interfaces lo0]
user@host# edit unit 0

4. Add the NET address (for example, 49.0001.00a0.c96b.c490.00) to the loopback
interface.

[edit interfaces lo0 unit 0]
user@host# set family iso address 49.0001.00a0.c96b.c490.00

5. Configure a physical interface (for example, ge-0/0/1) with the NET address, and
add the family type iso.

[edit interfaces lo0 unit 0]
user@host# top
[edit]
user@host# edit interfaces ge-0/0/01 unit 0
[edit interfaces ge-0/0/0 unit 0]
user@host# set family iso address 49.0001.00a0.c96b.c490.00

6. Navigate to the protocols level in the configuration hierarchy.

[edit interfaces ge-0/0/0 unit 0]
user@host# top
[edit]
user@host# edit protocols

7. Add the IS-IS protocol to all interfaces on the device.

[edit protocols]
user@host# set isis interface all

8. Verify the configuration. See “Verifying the IS-IS Configuration” on page 531.

9. Commit the configuration if you are done configuring the device.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ IS-IS Overview on page 525

■ IS-IS Configuration Overview on page 529

IS-IS Designated Routers

■ Understanding IS-IS Designated Routers on page 530

■ Configuring IS-IS Designated Routers (CLI Procedure) on page 531

Understanding IS-IS Designated Routers

A router advertises its priority to become a designated router in its hello packets. On
all multiaccess networks, IS-IS uses the advertised priorities to elect a designated
router for the network. This router is responsible for sending network link-state
advertisements, which describe all the routers attached to the network. These

530 ■ IS-IS Designated Routers

JUNOS Software Interfaces and Routing Configuration Guide



advertisements are flooded throughout a single area. The priority value is meaningful
only on a multiaccess network. It has no meaning on a point-to-point interface. A
router's priority for becoming the designated router is indicated by an arbitrary
number from 0 through 127. The router with the highest priority is elected as the
designated router. If routers in the network have the same priority, then the router
with the highest MAC address is elected as the designated router. By default, routers
have a priority value of 64.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ IS-IS Overview on page 525

■ Configuring IS-IS Designated Routers (CLI Procedure) on page 531

Configuring IS-IS Designated Routers (CLI Procedure)

To modify the interface's priority value, include the following priority statement:

priority number;

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding IS-IS Designated Routers on page 530

■ IS-IS Configuration Overview on page 529

■ Verifying the IS-IS Configuration on page 531

Verifying the IS-IS Configuration

To verify IS-IS, perform these tasks:

■ Verifying IS-IS Interface Configuration on page 531

■ Verifying IS-IS Interface Configuration Detail on page 532

■ Verifying IS-IS Adjacencies on page 533

■ Verifying IS-IS Adjacencies in Detail on page 533

Verifying IS-IS Interface Configuration

Purpose Verify the status of IS-IS-enabled interfaces.

Action From the CLI, enter the show isis interface brief command.

Sample Output user@host> show isis interface brief
IS-IS interface database:
Interface  L CirID Level 1 DR Level 2 DR
lo0.0      3  0x1  router1  router.01
ge-0/0/1.0 2  0x9  Disabled  router.03
ge-1/0/0.0 2 0x7  Disabled  router.05
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Meaning Verify that the output shows the intended configuration of the interfaces on which
IS-IS is enabled.

Verifying IS-IS Interface Configuration Detail

Purpose Verify the details of IS-IS-enabled interfaces.

Action From the CLI, enter the show isis interface detail command.

Sample Output user@host> show isis interface detail
lo0.0
   Index:3, State:0x7, Circuit id: 0x1, Circuit type:3
   LSP interval: 100 ms, Sysid: router1
   Level Adjacencies Priority Metric Hello(s) Hold(s)
       1           0       64      0       9    27
       2           0       64      0       9    27
  ge-0/0/1.0
       Index:3, State:0x106, Circuit id: 0x9, Circuit type:2
   LSP interval: 100 ms, Sysid: router1
   Level Adjacencies Priority Metric Hello(s) Hold(s)
       1           0       64      0       9    27
       2           0       64      0       9    27

Meaning Check the following output fields and verify that the output shows the intended
configuration of IS-IS-enabled interfaces:

■ Interface—Interface configured for IS-IS

■ State—Internal implementation information

■ Circuit id—Circuit identifier

■ Circuit type—Configured level of IS-IS:

■ 1—Level 1 only

■ 2—Level 2 only

■ 3—Level 1 and Level 2

■ LSP interval—Time between IS-IS information messages

■ Sysid—System identifier

■ L or Level—Type of adjacency:

■ 1—Level 1 only

■ 2—Level 2 only

■ 3—Level 1 and Level 2

■ Adjacencies—Adjacencies established on the interface

■ Priority—Priority value established on the interface

■ Metric—Metric value for the interface
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■ Hello(s)—Intervals between hello PDUs

■ Hold(s)—Hold time on the interface

Verifying IS-IS Adjacencies

Purpose Display brief information about IS-IS neighbors.

Action From the CLI, enter the show isis adjacency brief command.

Sample Output user@host> show isis adjacency brief
IS-IS adjacency database:
   Interface  System    L  State    Hold (secs) SNPA
   ge-0/0/0.0  1921.6800.5067  2  Up        13
   ge-0/0/1.0  1921.6800.5067  2 Up        25
   ge-0/0/2.0  1921.6800.5067  2  Up        19

Meaning Verify adjacent routers in the IS-IS database.

Verifying IS-IS Adjacencies in Detail

Purpose Display extensive information about IS-IS neighbors.

Action From the CLI, enter the show isis adjacency extensive command.

Sample Output user@host> show isis adjacency extensive
R1
  Interface: so-0/0/0.0, Level: 2, State: Up, Expires in 25 secs
  Priority: 0, Up/Down transitions: 1, Last transition: 4w6d 19:38:52 ago
  Circuit type: 2, Speaks: IP, IPv6
  Topologies: Unicast
  Restart capable: Yes
  IP addresses: 10.1.12.1
  Transition log:
  When                  State        Reason
  Wed Jul 13 16:26:11   Up           Seenself

R3
  Interface: so-0/0/1.0, Level: 2, State: Up, Expires in 23 secs
  Priority: 0, Up/Down transitions: 1, Last transition: 6w5d 19:07:16 ago
  Circuit type: 2, Speaks: IP, IPv6
  Topologies: Unicast
  Restart capable: Yes
  IP addresses: 10.1.23.2
  Transition log:
  When                  State        Reason
  Thu Jun 30 16:57:46   Up           Seenself

R6
  Interface: so-0/0/2.0, Level: 2, State: Up, Expires in 25 secs
  Priority: 0, Up/Down transitions: 1, Last transition: 6w0d 18:01:18 ago
  Circuit type: 2, Speaks: IP, IPv6
  Topologies: Unicast
  Restart capable: Yes
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  IP addresses: 10.1.26.2
  Transition log:
  When                  State        Reason
  Tue Jul  5 18:03:45   Up           Seenself 

Meaning Check the following fields and verify adjacency information about IS-IS neighbors:

■ Interface—Interface through which the neighbor is reachable

■ L or Level—Configured level of IS-IS:

■ 1—Level 1 only

■ 2—Level 2 only

■ 3—Level 1 and Level 2

An exclamation point before the level number indicates that the adjacency is
missing an IP address.

■ State—Status of the adjacency: Up, Down, New, One-way, Initializing, or Rejected

■ Event—Message that identifies the cause of a state

■ Down reason—Reason the adjacency is down

■ Restart capable—Denotes a neighbor configured for graceful restart

■ Transition log—List of transitions including When, State, and Reason

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ IS-IS Configuration Overview on page 529

■ show isis interface in the Junos Routing Protocols and Policies Command Reference

■ show isis adjacency in the Junos Routing Protocols and Policies Command Reference
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Chapter 21

BGP

■ BGP Overview on page 535

■ BGP Configuration Overview on page 542

■ BGP Peering Sessions on page 543

■ BGP Route Reflectors on page 547

■ BGP Confederations on page 551

■ Verifying a BGP Configuration on page 554

BGP Overview

Connections between peering networks are typically made through an exterior
gateway protocol (EGP), most commonly BGP. BGP is an EGP used primarily to
establish point-to-point connections and transmit data between peer autonomous
systems (ASs). Unlike RIP and OSPF links, BGP peering sessions must be explicitly
configured at both ends. BGP must explicitly advertise the routes between its peers.
The route advertisements determine prefix reachability and the way packets are
routed between BGP neighbors. Because BGP uses the packet path to determine
route selection, it is considered a path-vector protocol.

This overview contains the following topics:

■ BGP Messages for Session Establishment on page 535

■ BGP Messages for Session Maintenance on page 536

■ IBGP and EBGP on page 536

■ Route Selection on page 537

■ Local Preference on page 538

■ AS Path on page 539

■ Origin on page 539

■ Multiple Exit Discriminator on page 540

■ Scaling BGP for Large Networks on page 542

BGP Messages for Session Establishment

When the routers on either end of a BGP session first boot, the session between them
is in the Idle state. The BGP session remains idle until a start event is detected.
Typically, the start event is the configuration of a new BGP session or the resetting
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of an existing BGP session. At boot time, the start event is generated by the router
as the BGP session is initiated.

After it detects a start event, the BGP host sends TCP request packets to its configured
BGP neighbors. These packets are directed only to neighboring interfaces that have
been explicitly configured as BGP neighbors. Upon receipt of the TCP request packet,
the neighboring host generates a TCP response to complete the three-way handshake
and establish a TCP connection between the peers. While this handshake is taking
place, the BGP state for the connection is Connect. If a TCP timeout occurs while the
originating host is waiting for a TCP response packet, the BGP state for the connection
is Active. The Active state indicates that the router is actively listening for a TCP
response and the TCP retry timer has been initiated.

Once a TCP connection has been established between both ends of a BGP session,
the BGP session state is OpenSent, indicating that the originating router has generated
an open message. The open message is an initial BGP handshake that must occur
before any route advertisement can take place. Upon receipt of the open message,
the neighboring router generates a keepalive message. Receipt of the keepalive
message establishes a point-to-point connection, and the BGP session state transitions
to Established. While the originating host waits for the keepalive response packet,
the BGP session state is OpenConfirm.

BGP Messages for Session Maintenance

Once a BGP session has been established, the BGP peers exchange route
advertisements by means of update messages. Update messages contain one or
more route advertisements, and they can contain one or more prefixes that are to
be removed from the BGP routing table. If the peers need to advertise multiple routes,
they generate and send multiple update messages as they detect changes to the
network. In the absence of changes to the routing table, no update messages are
generated.

While a BGP session is active, each router on the BGP session generates keepalive
messages periodically. The timing of these messages is determined by the hold time
on the session. The hold time is a negotiated value specifying the number of seconds
that can elapse without keepalive messages before BGP designates the link inactive.
Three messages are sent during every hold time interval.

When a peer connection is closed (either by error or if the BGP session is closed), a
notification message is generated and sent to the peer router that did not experience
the error or did not terminate the BGP session.

IBGP and EBGP

Peer ASs establish links through an external peer BGP session. As a result, all route
advertisement between the external peers takes place by means of the EBGP mode
of information exchange. To propagate the routes through the AS and advertise them
to internal peers, BGP uses IBGP. To advertise the routes to a different peer AS, BGP
again uses EBGP.

BGP uses two primary modes of information exchange, internal BGP (IBGP) and
external BGP (EBGP), to communicate with internal and external peers, respectively.
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To avoid routing loops, IBGP does not advertise routes learned from an internal BGP
peer to other internal BGP peers. For this reason, BGP cannot propagate routes
throughout an AS by passing them from one router to another. To achieve an IBGP
full mesh, you configure a direct peering session every host to every other host within
the network. These sessions are configured on every router within the network, as
type internal.

As a network grows, the full mesh requirement becomes increasingly difficult to
manage. In a network with 1000 routers, the addition of a single router requires that
all the routers in the network be modified to account for the new addition. To combat
these scaling problems, BGP uses route reflection and BGP confederations.

Route Selection

The BGP route selection process compares BGP attributes to select a single best path
or active route for each prefix in the routing table. The attributes are compared in a
particular order. A local BGP router uses the following criteria, in the order presented,
to select a route from the routing table for the forwarding table.

1. Next-hop accessibility—If the next hop is inaccessible, the local router does not
consider the route. The router must verify that it has a route to the BGP next-hop
address. If a local route to the next hop does not exist, the local route does not
include the router in its forwarding table. If such a route exists, route selection
continues.

2. Highest local preference—The local router selects the route with the highest local
preference value. If multiple routes have the same preference, route selection
continues. (See “Local Preference” on page 538.)

3. Shortest AS path—The local router selects the route with the fewest entries in
the AS path. If multiple routes have the same AS path length, route selection
continues.

4. Lowest origin—The local router selects the route with the lowest origin value. If
multiple routes have the same origin value, route selection continues. (See
“Origin” on page 539.)

5. Lowest MED value—The local router selects the route with the lowest multiple
exit discriminator (MED) value, comparing the routes from the same AS only. If
multiple routes have the same MED value, route selection continues. See “Multiple
Exit Discriminator” on page 540.

6. Strictly external paths—The local router prefers strictly external (EBGP) paths
over external paths learned through interior sessions (IBGP). If multiple routes
have the same strictly external paths, route selection continues.

7. Lowest IGP route metric— The local router selects the path for which the next
hop is resolved through the IGP route with the lowest metric. If multiple routes
have the same IGP route metric, route selection continues.

8. Maximum IGP next hops—The local router selects the path for which the BGP
next hop is resolved through the IGP route with the largest number of next hops.
If multiple routes have the same number of next hops, route selection continues.

9. Shortest route reflection cluster list—The local router selects the path with the
shortest route reflection cluster list. Routes without a cluster list are considered
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to have a cluster list of length 0. If multiple routes have the same route reflection
cluster list, route selection continues.

10. Lowest router ID—The local router selects the route with the lowest IP address
value for the BGP router ID. By default, the router IDs of routes received from
different ASs are not compared. You can change this default behavior.

11. Lowest peer IP address—The local router selects the path that was learned from
the neighbor with the lowest peer IP address.

For configuration instructions, see Configuring Routing Table Path Selection for BGP
in the Junos Routing Protocols Configuration Guide.

Local Preference

The local preference is typically used to direct all outbound AS traffic to a certain
peer. When you configure a local preference, all routes that are advertised through
that peer are assigned the preference value. The preference is a numeric value, and
higher values are preferred during BGP route selection. Figure 71 on page 538 illustrates
how to use local preference to determine BGP route selection.

Figure 71: Local Preference

The network in Figure 71 on page 538 shows two possible routes to the prefixes
accessible through Host E. The first route, through Router A, uses an OC3 link to
Router C and is then forwarded to Host E. The second route, through Router B, uses
an OC48 link to Router D and is then forwarded to Host E. Although the number of
hops to Host E is identical regardless of the route selected, the route through Router
B is more desirable because of the increased bandwidth. To force traffic through
Router B, you can set the local preference on Router A to 100 and the local preference
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on Router B to 300. During BGP route selection, the route with the higher local
preference is selected.

NOTE: In contrast to almost every other metric associated with dynamic routing
protocols, the local preference gives higher precedence to the larger value.

For configuration instructions, see Configuring the Local Preference Value for BGP
Routes in the Junos Routing Protocols Configuration Guide.

AS Path

Routes advertised by BGP maintain a list of the ASs through which the route travels.
This information is stored in the route advertisement as the AS path, and it is one
of the primary criteria that a local router uses to evaluate BGP routes for inclusion
in its forwarding table. Figure 72 on page 539 shows how BGP creates an AS path.

Figure 72: BGP AS Path

In the network shown in Figure 72 on page 539, the route from Host A to Host B
travels through two intermediate ASs. As the route advertisement is propagated
through the BGP network, it accumulates an AS path number each time it exits one
AS and enters another. Each AS number is prepended to the AS path, which is stored
as part of the route advertisement. When the route advertisement first leaves Host
B's AS, the AS path is 17. When the route is advertised between intermediate ASs,
the AS number 7 is prepended to the AS path, which becomes 7 17. When the route
advertisement exits the third AS, the AS path becomes 4 7 17. The route with the
shortest AS path is preferred for inclusion into the BGP forwarding table.

Origin

The BGP router that first advertises a route assigns it one of the following values to
identify its origin. During route selection, the lowest origin value is preferred.

■ 0—The router originally learned the route through an IGP (OSPF, IS-IS, or a static
route).

■ 1—The router originally learned the route through an EGP (most likely BGP).

■ 2—The route's origin is unknown.
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Multiple Exit Discriminator

A multiple exit discriminator (MED) is an arbitrary metric assigned to a route to
determine the exit point to a destination when all other factors are equal. By default,
MED metrics are compared only for routes to the same peer AS, but you can also
configure routing table path selection options for different ways of comparing MEDs.

Default MED Usage

Because the AS path rather than the number of hops between hosts is the primary
criterion for BGP route selection, an AS with multiple connections to a peer AS can
have multiple equivalent AS paths. When the routing table contains two routes to
the same host in a neighboring AS, an MED metric assigned to each route can
determine which to include in the forwarding table. The MED metric you assign can
force traffic through a particular exit point in an AS.

Figure 73 on page 540 illustrates how MED metrics are used to determine route
selection.

Figure 73: Default MED Example

Figure 73 on page 540 shows AS 1 and AS 2 connected by two separate BGP links to
Routers C and D. Host E in AS 1 is located nearer to Router C. Host F, also in AS 1,
is located nearer to Router D. Because the AS paths are equivalent, two routes exist
for each host, one through Router C and one through Router D. To force all traffic
destined for Host E through Router C, the network administrator for AS 2 assigns an
MED metric for each router to Host E at its exit point. An MED metric of 10 is assigned
to the route to Host E through Router C, and an MED metric of 20 is assigned to the
route to Host E through Router D. BGP routers in AS 2 then select the route with the
lower MED metric for the forwarding table.
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Additional MED Options for Path Selection

By default, only the MEDs of routes that have the same peer ASs are compared.
However, you can configure the routing table path selection options listed in Table
147 on page 541 to compare MEDs in different ways. The MED options are not
mutually exclusive and can be configured in combination or independently. For the
MED options to take effect, you must configure them uniformly all through your
network. The MED option or options you configure determine the route selected.
Thus we recommend that you carefully evaluate your network for preferred routes
before configuring the MED options. See Configuring Routing Table Path Selection
for BGP in the Junos Routing Protocols Configuration Guide.

Table 147: MED Options for Routing Table Path Selection

UseFunctionOption (Name)

Useful when all enterprises participating
in a network agree on a uniform policy
for setting MEDs. For example, in a
network shared by two ISPs, both must
agree that a certain path is the better
path to configure the MED values
correctly.

Ensures that the MEDs for paths from
peers in different ASs are always
compared in the route selection process.

Always comparing MEDs
(always-compare-med)

Useful when the downstream AS requires
the complete cost of a certain route that
is received across multiple ASs.

Before comparing MED values for path
selection, adds to the MED the cost of
the IGP route to the BGP next-hop
destination.

This option replaces the MED value for
the router, but does not affect the IGP
metric comparison. As a result, when
multiple routes have the same value after
the MED-plus-IPG comparison, and route
selection continues, the IGP route metric
is also compared, even though it was
added to the MED value and compared
earlier in the selection process.

Adding IGP cost to MED (med-plus-igp)

We recommend that you do not
configure this option, because the
nondeterministic behavior sometimes
prevents the system from properly
comparing the MEDs between paths.

Specifies the nondeterministic behavior
of the Cisco IOS software:

■ The active path is always first. All
nonactive but eligible paths follow
the active path and are maintained
in the order in which they were
received. Ineligible paths remain at
the end of the list.

■ When a new path is added to the
routing table, path comparisons are
made among all routes, including
those paths that must never be
selected because they lose the MED
tie-breaking rule.

Applying Cisco IOS nondeterministic
behavior (cisco-non-deterministic)
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Scaling BGP for Large Networks

BGP is not a flooding protocol like RIP or OSPF. Instead, it is a peering protocol that
exchanges routes with fully meshed peers only. However, in large networks, the full
mesh requirement causes scaling problems. BGP combats scaling problems using
route reflectors and confederations.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ BGP Configuration Overview on page 542

■ Understanding BGP Peering Sessions on page 543

■ Understanding BGP Route Reflectors on page 547

■ Understanding BGP Confederations on page 551

■ BGP Overview in the Junos Routing Protocols Configuration Guide

BGP Configuration Overview

To configure the device as a node in a BGP network:

1. Configure network interfaces. See Junos OS Interfaces Configuration Guide for
Security Devices.

2. Configure security filters. See Security Policies Overview in the Junos OS Security
Configuration Guide.

3. Configure point-to-point peering sessions. See “Example: Configuring BGP
Point-to-Point Peering Sessions (CLI)” on page 544.

4. Configure IBGP sessions between peers. See “Example: Configuring Internal BGP
Peering Sessions (CLI)” on page 545.

5. Configure a routing policy to advertise the BGP routes.

6. (Optional) Configure route reflector clusters. See “Example: Configuring a Route
Reflector (CLI)” on page 549.

7. (Optional) Subdivide autonomous systems (ASs). See “Example: Configuring BGP
Confederations (CLI)” on page 552.

8. (Optional) Assign a router ID to each routing device running BGP.

9. (Optional) Configure a local preference to direct all outbound AS traffic to a
specific peer. See Configuring the Local Preference Value for BGP Routes in the
Junos Routing Protocols Configuration Guide.

10. (Optional) Configure routing table path selection options that define different
ways to compare multiple exit discriminators (MEDs). See Configuring Routing
Table Path Selection for BGP in the Junos Routing Protocols Configuration Guide.

542 ■ BGP Configuration Overview

JUNOS Software Interfaces and Routing Configuration Guide



Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ BGP Overview on page 535

■ Verifying a BGP Configuration on page 554

■ Configuring BGP in the Junos Routing Protocols Configuration Guide

■ Minimum BGP Configuration in the Junos Routing Protocols Configuration Guide

BGP Peering Sessions

■ Understanding BGP Peering Sessions on page 543

■ Example: Configuring BGP Point-to-Point Peering Sessions (CLI) on page 544

■ Example: Configuring Internal BGP Peering Sessions (CLI) on page 545

Understanding BGP Peering Sessions

To establish point-to-point connections between peer autonomous systems (ASs),
you configure a BGP session on each interface of a point-to-point link. Generally,
such sessions are made at network exit points with neighboring hosts outside the
AS. Figure 74 on page 543 shows an example of a BGP peering session.

Figure 74: BGP Peering Session
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In Figure 74 on page 543, Router A is a gateway router for AS 3, and Router B is a
gateway router for AS 10. For traffic internal to either AS, an IGP (OSPF, for instance)
is used. To route traffic between peer ASs, a BGP session is used.

In addition to configuring BGP sessions between peering networks, you must also
configure BGP internally to provide a means by which BGP route advertisements can
be forwarded throughout the network. Because of the full mesh requirement of IBGP,
you must configure individual peering sessions between all internal nodes of the
network—unless you use route reflectors or confederations.
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ BGP Overview on page 535

■ Example: Configuring BGP Point-to-Point Peering Sessions (CLI) on page 544

■ Example: Configuring Internal BGP Peering Sessions (CLI) on page 545

Example: Configuring BGP Point-to-Point Peering Sessions (CLI)

Figure 75 on page 544 shows a network with BGP peering sessions. In the sample
network, a device in AS 17 has BGP peering sessions to a group of peers called
external-peers. Peers A, B, and C reside in AS 22 and have IP addresses 10.10.10.10,
10.10.10.11, and 10.10.10.12. Peer D resides in AS 79, at IP address 10.21.7.2.

Figure 75: Typical Network with BGP Peering Sessions

To configure the BGP peering sessions in the sample network:

1. Navigate to the routing-options level in the configuration hierarchy.

[edit]
user@host# edit routing-options

2. Set the network's AS number to 17.

[edit routing-options]
user@host# set autonomous-system 17

3. Navigate to the bgp level in the configuration hierarchy.

[edit routing-options]
user@host# top
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[edit]
user@host# edit protocols bgp

4. Create the BGP group external-peers, and add the external neighbor address
10.10.10.10 to the group.

[edit protocols bgp]
user@host# set group external-peers neighbor 10.10.10.10

NOTE: Repeat Step 4 for each BGP neighbor (10.10.10.11 and 10.10.10.12) within
the external peer group that you are configuring.

5. Set the AS number at the group level for the group external-peers to 22. Because
three of the peers in this group (peers A, B, and C) reside in one AS, you can set
their AS number as a group.

[edit protocols bgp]
user@host# set group external-peers peer-as 22

6. Set the AS number at the individual neighbor level for peer D to 79. Because
peer D is a member of the group external-peers, it inherits the peer AS number
configured at the group level. You must override this value at the individual
neighbor level.

[edit protocols bgp]
user@host# edit group external-peers
[edit protocols bgp group external-peers]
user@host# set neighbor 10.21.7.2 peer-as 79

7. Set the group type to external.

[edit protocols bgp group external-peers]
user@host# set type external

8. Commit the configuration if you are done configuring the device.

[edit protocols bgp group external-peers]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding BGP Peering Sessions on page 543

■ Example: Configuring Internal BGP Peering Sessions (CLI) on page 545

■ BGP Configuration Overview on page 542

Example: Configuring Internal BGP Peering Sessions (CLI)

Figure 76 on page 546 shows a typical network with external and internal peer
sessions. In the sample network, the device in AS 17 is fully meshed with its internal
peers in the group internal-peers, which have IP addresses starting at 192.168.6.4.
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Figure 76: Typical Network with EBGP External Sessions and IBGP Internal Sessions

To configure IBGP in the sample network:

1. Navigate to the bgp level in the configuration hierarchy.

[edit]
user@host# edit protocols bgp

2. Create the BGP group internal-peers, and add the internal neighbor address
192.168.6.4 to the group. You must configure a full IBGP mesh, which requires
that each peer be configured with every other internal peer as a BGP neighbor.

[edit protocols bgp]
user@host# edit group internal-peers
[edit protocols bgp group internal-peers]
user@host# set neighbor 192.168.6.4

NOTE: Repeat Step 2 for each internal BGP neighbor (192.168.6.5, 192.168.6.6,
192.168.6.7, and 192.168.40.4) within the network.

3. Set the group type to internal.

[edit protocols bgp group internal-peers]
user@host# set type internal

4. Commit the configuration if you are done configuring the device.

[edit protocols bgp group internal-peers]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding BGP Peering Sessions on page 543

■ Example: Configuring BGP Point-to-Point Peering Sessions (CLI) on page 544

■ BGP Configuration Overview on page 542
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BGP Route Reflectors

■ Understanding BGP Route Reflectors on page 547

■ Example: Configuring a Route Reflector (CLI) on page 549

Understanding BGP Route Reflectors

Because of the internal BGP (IBGP) full-mesh requirement, most networks use route
reflectors to simplify configuration. Using a route reflector, you group routers into
clusters, which are identified by numeric identifiers unique to the autonomous system
(AS). Within the cluster, you must configure a BGP session from a single router (the
route reflector) to each internal peer. With this configuration, the IBGP full-mesh
requirement is met.

To use route reflection in an AS, you designate one or more routers as a route
reflector—typically, one per point of presence (POP). Route reflectors have the special
BGP ability to readvertise routes learned from an internal peer to other internal peers.
So rather than requiring all internal peers to be fully meshed with each other, route
reflection requires only that the route reflector be fully meshed with all internal peers.
The route reflector and all its internal peers form a cluster, as shown in Figure 77 on
page 547.

NOTE: You must have an Advanced BGP Feature license installed on each device
that uses a route reflector. For license details, see the JUNOS Software Administration
Guide.

Figure 77: Simple Route Reflector Topology (One Cluster)

Figure 77 on page 547 shows Router RR configured as the route reflector for
Cluster 127. The other routers are designated internal peers within the cluster. BGP
routes are advertised to Router RR by any of the internal peers. RR then readvertises
those routes to all other peers within the cluster.
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You can configure multiple clusters and link them by configuring a full mesh of route
reflectors (see Figure 78 on page 548).

Figure 78: Basic Route Reflection (Multiple Clusters)

Figure 78 on page 548 shows Route Reflectors RR1, RR2, RR3, and RR4 as fully
meshed internal peers. When a router advertises a route to RR1, RR1 readvertises
the route to the other route reflectors, which, in turn, readvertise the route to the
remaining routers within the AS. Route reflection allows the route to be propagated
throughout the AS without the scaling problems created by the full mesh requirement.

However, as clusters become large, a full mesh with a route reflector becomes difficult
to scale, as does a full mesh between route reflectors. To help offset this problem,
you can group clusters of routers together into clusters of clusters for hierarchical
route reflection (see Figure 79 on page 549).
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Figure 79: Hierarchical Route Reflection (Clusters of Clusters)

Figure 79 on page 549 shows RR2, RR3, and RR4 as the route reflectors for Clusters
127, 19, and 45, respectively. Rather than fully mesh those route reflectors, the
network administrator has configured them as part of another cluster (Cluster 6) for
which RR1 is the route reflector. When a router advertises a route to RR2, RR2
readvertises the route to all the routers within its own cluster, and then readvertises
the route to RR1. RR1 readvertises the route to the routers in its cluster, and those
routers propagate the route down through their clusters.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ BGP Overview on page 535

■ Example: Configuring a Route Reflector (CLI) on page 549

Example: Configuring a Route Reflector (CLI)

Figure 80 on page 550 shows an IBGP network with a Juniper Networks device at IP
address 192.168.40.4 acting as a route reflector. In the sample network, each device
in Cluster 2.3.4.5 has an internal client relationship to the route reflector. To configure
the cluster:

■ Create an internal group on the Juniper Networks device, configure an internal
peer (neighbor) relationship to every other device in the cluster, and assign a
cluster identifier.

■ On the other devices you are assigning to the cluster, create the cluster group
and configure a client relationship to the route reflector.
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Figure 80: Typical IBGP Network Using a Route Reflector

To configure IBGP in the network using the Juniper Networks device as a route
reflector:

1. On the device that you are using as a route reflector, navigate to the bgp level
in the configuration hierarchy.

[edit]
user@host# edit protocols bgp

2. On the device that you are using as a route reflector, create the BGP group
cluster-peers, and add to the group the IP addresses of the internal neighbors
that you want in the cluster.

[edit protocols bgp]
user@host# set group cluster-peers neighbor 192.168.6.4

NOTE: Repeat Step 2 for each BGP neighbor within the cluster that you are
configuring.

3. 3. On the device that you are using as a route reflector, set the group type to
internal.

[edit protocols bgp]
user@host# edit group internal-peers
[edit protocols bgp group internal-peers]
user@host# set type internal

4. On the device that you are using as a route reflector, configure the cluster
identifier for the route reflector.

[edit protocols bgp group internal-peers]
user@host# set cluster 2.3.4.5
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5. On the other devices in the cluster, create the BGP group cluster-peers, and add
the internal IP address of the route reflector. You do not need to include the
neighbor addresses of the other internal peers, or configure the cluster identifier
on these route reflector clients. They need only be configured as internal
neighbors.

NOTE: If the other devices in the network are from Juniper Networks, then follow
these steps. Otherwise, consult the device’s documentation for instructions.

[edit protocols bgp group internal-peers]
user@host# top
[edit]
user@host# edit protocols bgp
[edit protocols bgp]
user@host# set group cluster-peers neighbor 192.168.40.4

6. Commit the configuration if you are done configuring the device.

[edit protocols bgp]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding BGP Route Reflectors on page 547

■ BGP Configuration Overview on page 542

■ Configuring BGP Route Reflection in the Junos Routing Protocols Configuration
Guide

BGP Confederations

■ Understanding BGP Confederations on page 551

■ Example: Configuring BGP Confederations (CLI) on page 552

Understanding BGP Confederations

BGP confederations are another way to solve the scaling problems created by the
BGP full mesh requirement. BGP confederations effectively break up a large
autonomous system (AS) into subautonomous systems (sub-ASs). Each sub-AS must
be uniquely identified within the confederation AS by a sub-AS number. Typically,
sub-AS numbers are taken from the private AS numbers between 64,512 and 65,535.

Within a sub-AS, the same internal BGP (IBGP) full mesh requirement exists.
Connections to other confederations are made with standard external BGP (EBGP),
and peers outside the sub-AS are treated as external. To avoid routing loops, a sub-AS
uses a confederation sequence, which operates like an AS path but uses only the
privately assigned sub-AS numbers.
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The confederation AS appears whole to other confederation ASs. The AS path received
by other ASs shows only the globally assigned AS number. It does not include the
confederation sequence or the privately assigned sub-AS numbers. The sub-AS
numbers are removed when the route is advertised out of the confederation AS.
Figure 81 on page 552 shows an AS divided into four confederations.

Figure 81: BGP Confederations

Figure 81 on page 552 shows AS 3 divided into four sub-ASs, 64517, 64550, 65300,
and 65410, which are linked through EBGP sessions. Because the confederations are
connected by EBGP, they do not need to be fully meshed. EBGP routes are
readvertised to other sub-ASs.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ BGP Overview on page 535

■ Example: Configuring BGP Confederations (CLI) on page 552

Example: Configuring BGP Confederations (CLI)

Figure 82 on page 553shows a sample network in which AS 17 has two separate
confederations (sub-AS 64512 and sub-AS 64513), each of which has multiple routers.
Within a sub-AS, an IGP (OSPF, for example) is used to establish network connectivity
with internal peers. Between sub-ASs, an external BGP peering session is established.
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Figure 82: Typical Network Using BGP Confederations

To configure the BGP confederations shown in the sample network:

1. Navigate to the routing-options level in the configuration hierarchy.

[edit]
user@host# edit routing-options

2. Set the AS number to the sub-AS number 64512. The sub-AS number is a unique
AS number that is usually taken from the pool of private AS numbers from 64512
through 65535.

[edit routing-options]
user@host# set autonomous-system 64512

3. Navigate to the confederation level in the configuration hierarchy.

[edit routing-options]
user@host# edit confederation

4. Set the confederation number to the AS number 17.

[edit routing-options confederation]
user@host# set 17

5. Add the sub-ASs as members of the confederation. Every sub-AS within the AS
must be added as a confederation member.

[edit routing-options confederation]
user@host# set 17 members 64512
[edit routing-options confederation]
user@host# set 17 members 64513

6. Commit the configuration if you are done configuring the device.

[edit routing-options confederation]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding BGP Confederations on page 551
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■ BGP Configuration Overview on page 542

■ Examples: Configuring BGP Groups, Peers, and Confederations in the Junos
Routing Protocols Configuration Guide

Verifying a BGP Configuration

To verify a BGP configuration, perform these tasks.

■ Verifying BGP Neighbors on page 554

■ Verifying BGP Groups on page 555

■ Verifying BGP Summary Information on page 556

■ Verifying Reachability of All Peers in a BGP Network on page 556

Verifying BGP Neighbors

Purpose Verify that BGP is running on configured interfaces and that the BGP session is active
for each neighbor address.

Action From the CLI, enter the show bgp neighbor command.

Sample Output user@host> show bgp neighbor
Peer: 10.255.245.12+179 AS 35  Local: 10.255.245.13+2884 AS 35
  Type: Internal    State: Established  (route reflector client)Flags: Sync
  Last State: OpenConfirm   Last Event: RecvKeepAlive
  Last Error: None
  Options: Preference LocalAddress HoldTime Cluster AddressFamily Rib-group Refresh

  Address families configured: inet-vpn-unicast inet-labeled-unicast
  Local Address: 10.255.245.13 Holdtime: 90 Preference: 170
  Flags for NLRI inet-vpn-unicast: AggregateLabel
  Flags for NLRI inet-labeled-unicast: AggregateLabel
  Number of flaps: 0
  Peer ID: 10.255.245.12    Local ID: 10.255.245.13    Active Holdtime: 90
  Keepalive Interval: 30
  NLRI advertised by peer: inet-vpn-unicast inet-labeled-unicast
  NLRI for this session: inet-vpn-unicast inet-labeled-unicast
  Peer supports Refresh capability (2)
Restart time configured on the peer: 300
  Stale routes from peer are kept for: 60
  Restart time requested by this peer: 300
  NLRI that peer supports restart for: inet-unicast inet6-unicast
  NLRI that restart is negotiated for: inet-unicast inet6-unicast
  NLRI of received end-of-rib markers: inet-unicast inet6-unicast
  NLRI of all end-of-rib markers sent: inet-unicast inet6-unicast
  Table inet.0 Bit: 10000
    RIB State: restart is complete
    Send state: in sync
    Active prefixes: 4
    Received prefixes: 6
    Suppressed due to damping: 0
  Table inet6.0 Bit: 20000
    RIB State: restart is complete
    Send state: in sync
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    Active prefixes: 0
    Received prefixes: 2
    Suppressed due to damping: 0
  Last traffic (seconds): Received 3    Sent 3    Checked 3
  Input messages:  Total 9      Updates 6       Refreshes 0     Octets 403
  Output messages: Total 7      Updates 3       Refreshes 0     Octets 365
  Output Queue[0]: 0
  Output Queue[1]: 0
  Trace options: detail packets
  Trace file: /var/log/bgpgr size 131072 files 10

Meaning The output shows a list of the BGP neighbors with detailed session information. Verify
the following information:

■ Each configured peering neighbor is listed.

■ For State, each BGP session is Established.

■ For Type, each peer is configured as the correct type (either internal or external).

■ For AS, the AS number of the BGP neighbor is correct.

Verifying BGP Groups

Purpose Verify that the BGP groups are configured correctly.

Action From the CLI, enter the show bgp group command.

Sample Output user@host> show bgp group
Group Type: Internal    AS: 10045       Local AS: 10045
  Name: pe-to-asbr2                                     Flags: Export Eval
  Export: [ match-all ]
  Total peers: 1        Established: 1
  10.0.0.4+179
  bgp.l3vpn.0: 1/1/0
  vpn-green.inet.0: 1/1/0

Groups: 1   Peers: 1    External: 0    Internal: 1    Down peers: 0   Flaps: 0
Table          Tot Paths  Act Paths Suppressed    History Damp State    Pending
bgp.l3vpn.0            1          1          0          0          0          0

Meaning The output shows a list of the BGP groups with detailed group information. Verify
the following information:

■ Each configured group is listed.

■ For AS, each group's remote AS is configured correctly.

■ For Local AS, each group's local AS is configured correctly.

■ For Group Type, each group has the correct type (either internal or external).

■ For Total peers, the expected number of peers within the group is shown.
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■ For Established, the expected number of peers within the group have BGP sessions
in the Established state.

■ The IP addresses of all the peers within the group are present.

Verifying BGP Summary Information

Purpose Verify that the BGP configuration is correct.

Action From the CLI, enter the show bgp summary command.

Sample Output user@host> show bgp summary
Groups: 1 Peers: 3 Down peers: 0
Table          Tot Paths  Act Paths Suppressed    History Damp State    Pending
inet.0                 6          4          0          0          0          0
Peer               AS      InPkt     OutPkt    OutQ   Flaps Last Up/Dwn 
State|#Active/Received/Damped...
10.0.0.2        65002      88675      88652       0       2       42:38 2/4/0   
             0/0/0
10.0.0.3        65002      54528      54532       0       1     2w4d22h 0/0/0   
             0/0/0
10.0.0.4        65002      51597      51584       0       0     2w3d22h 2/2/0   
             0/0/0

Meaning The output shows a summary of BGP session information. Verify the following
information:

■ For Groups, the total number of configured groups is shown.

■ For Peers, the total number of BGP peers is shown.

■ For Down Peers, the total number of unestablished peers is 0. If this value is not
zero, one or more peering sessions are not yet established.

■ Under Peer, the IP address for each configured peer is shown.

■ Under AS, the peer AS for each configured peer is correct.

■ Under Up/Dwn State, the BGP state reflects the number of paths received from
the neighbor, the number of these paths that have been accepted, and the number
of routes being damped (such as 0/0/0). If the field is Active, it indicates a problem
in the establishment of the BGP session.

Verifying Reachability of All Peers in a BGP Network

Purpose By using the ping tool on each peer address in the network, verify that all peers in
the network are reachable from each device.

Action For each device in the BGP network:

1. In the J-Web interface, select Troubleshoot>Ping Host.

2. In the Remote Host box, type the name of a host for which you want to verify
reachability from the device.
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3. Click Start. Output appears on a separate page.

Sample Output
PING 10.10.10.10 : 56 data bytes
64 bytes from 10.10.10.10: icmp_seq=0 ttl=255 time=0.382 ms
64 bytes from 10.10.10.10: icmp_seq=1 ttl=255 time=0.266 ms

Meaning If a host is active, it generates an ICMP response. If this response is received, the
round-trip time is listed in the time field.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ BGP Configuration Overview on page 542

■ BGP Overview on page 535

■ show bgp neighbor in the Junos Routing Protocols and Policies Command Reference

■ show bgp summary in the Junos Routing Protocols and Policies Command Reference

■ show bgp group in the Junos Routing Protocols and Policies Command Reference

■ ping in the Junos System Basics and Services Command Reference
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Chapter 22

Multicast

■ Multicast Overview on page 559

■ Multicast Configuration Overview on page 565

■ SAP and SDP Multicast Session Announcements on page 566

■ Multicast IGMP on page 567

■ Multicast PIM and Static RPs on page 569

■ PIM Register Messages on page 570

■ PIM RPF Routing Tables on page 573

■ Verifying a Multicast Configuration on page 575

Multicast Overview

NOTE: Both Protocol Independent Multicast (PIM) version 1 and PIM version 2 are
supported. In this topic, the term PIM refers to both versions of the protocol.

Multicast traffic lies between the extremes of unicast (one source, one destination)
and broadcast (one source, all destinations). Multicast is a “one source, many
destinations” method of traffic distribution, meaning that the destinations needing
to receive the information from a particular source receive the traffic stream.

IP network destinations (clients) do not often communicate directly with sources
(servers), so the routers between source and destination must be able to determine
the topology of the network from the unicast or multicast perspective to avoid routing
traffic haphazardly. The multicast router must find multicast sources on the network,
send out copies of packets on several interfaces, prevent routing loops, connect
interested destinations with the proper source, and keep the flow of unwanted packets
to a minimum. Standard multicast routing protocols provide most of these capabilities.

This chapter contains the following topics:

■ Multicast Architecture on page 560

■ Dense and Sparse Routing Modes on page 561

■ Strategies for Preventing Routing Loops on page 562

■ Multicast Protocol Building Blocks on page 563
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Multicast Architecture

Multicast-capable routers replicate packets on the multicast network, which has
exactly the same topology as the unicast network it is based on. Multicast routers
use a multicast routing protocol to build a distribution tree that connects receivers
(also called listeners) to sources.

Upstream and Downstream Interfaces

A single upstream interface on the router leads toward the source to receive multicast
packets. The downstream interfaces on the router lead toward the receivers to
transmit packets. A router can have as many downstream interfaces as it has logical
interfaces, minus 1. To prevent looping, the router's upstream interface must never
receive copies of its own downstream multicast packets.

Subnetwork Leaves and Branches

On a multicast router, each subnetwork of hosts that includes at least one interested
receiver is a leaf on the multicast distribution tree (see Figure 83 on page 561). The
router must send out a copy of the IP multicast packet on each interface with a leaf.
When a new leaf subnetwork joins the tree, a new branch is built so that the router
can send out replicated packets on the interface. The number of leaves on an interface
does not affect the router. The action is the same for one leaf or a hundred.

A branch that no longer has leaves is pruned from the distribution tree. No multicast
packets are sent out on a router interface leading to an IP subnetwork with no
interested hosts. Because packets are replicated only where the distribution tree
branches, no link ever carries a duplicate flow of packets.

In IP multicast networks, traffic is delivered to multicast groups based on an IP
multicast group address instead of a unicast destination address. The groups
determine the location of the leaves, and the leaves determine the branches on the
multicast network.
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Figure 83: Multicast Elements in an IP Network

Multicast IP Address Ranges

Multicast uses the Class D IP address range (224.0.0.0 through 239.255.255.255).
Multicast addresses usually have a prefix length of /32, although other prefix lengths
are allowed. Multicast addresses represent logical groupings of receivers and not
physical collections of devices, and can appear only as the destination in an IP packet,
never as the source address.

Notation for Multicast Forwarding States

The multicast forwarding state in a router is usually represented by one of the
following notations:

■ (S,G) notation—S refers to the unicast IP address of the source for the multicast
traffic and G refers to the particular multicast group IP address for which S is the
source. All multicast packets sent from this source have S as the source address
and G as the destination address.

■ (*, G) notation—The asterisk (*) is a wildcard for the address of any multicast
application source sending to group G. For example, if two sources are originating
exactly the same content for multicast group 224.1.1.2, a router can use (*,
224.1.1.2) to represent the state of a router forwarding traffic from both sources
to the group.

Dense and Sparse Routing Modes

To keep packet replication to a minimum, multicast routing protocols use the two
primary modes shown in Table 148 on page 562.
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CAUTION: A common multicast guideline is not to run dense mode on a WAN under
any circumstances.

Table 148: Primary Multicast Routing Modes

Appropriate Network for UseDescriptionMulticast Mode

LANs—Networks in which all possible subnets
are likely to have at least one receiver.

Network is flooded with traffic on all possible branches,
then pruned back as branches explicitly (by message)
or implicitly (time-out silence) eliminate themselves.

Dense mode

WANs—Network in which very few of the
possible receivers require packets from this
source.

Network establishes and sends packets only on branches
that have at least one leaf indicating (by message) a need
for the traffic.

Sparse mode

Strategies for Preventing Routing Loops

Routing loops are disastrous in multicast networks because of the risk of repeatedly
replicated packets, which can overwhelm a network. One of the complexities of
modern multicast routing protocols is the need to avoid routing loops, packet by
packet, much more rigorously than in unicast routing protocols. Three multicast
strategies—reverse-path forwarding (RPF), shortest-path tree (SPT), and administrative
scoping—help prevent routing loops by defining routing paths in different ways.

Reverse-Path Forwarding for Loop Prevention

The router's multicast forwarding state runs more logically based on the reverse
path, from the receiver back to the root of the distribution tree. In RPF, every multicast
packet received must pass an RPF check before it can be replicated or forwarded on
any interface. When it receives a multicast packet on an interface, the router verifies
that the source address in the multicast IP packet is the destination address for a
unicast IP packet back to the source.

If the outgoing interface found in the unicast routing table is the same interface that
the multicast packet was received on, the packet passes the RPF check. Multicast
packets that fail the RPF check are dropped, because the incoming interface is not
on the shortest path back to the source. Routers can build and maintain separate
tables for RPF purposes. See “Understanding PIM RPF Routing Tables” on page 573.

Shortest-Path Tree for Loop Prevention

The distribution tree used for multicast is rooted at the source and is the shortest-path
tree (SPT), but this path can be long if the source is at the periphery of the network.
Providing a shared tree on the backbone as the distribution tree locates the multicast
source more centrally in the network. Shared distribution trees with roots in the core
network are created and maintained by a multicast router operating as a rendezvous
point (RP), a feature of sparse mode multicast protocols.
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Administrative Scoping for Loop Prevention

Scoping limits the routers and interfaces that can forward a multicast packet. Multicast
scoping is administrative in the sense that a range of multicast addresses is reserved
for scoping purposes, as described in RFC 2365, Administratively Scoped IP Multicast.
Routers at the boundary must filter multicast packets and ensure that packets do not
stray beyond the established limit.

Multicast Protocol Building Blocks

Multicast is not a single protocol, but a collection of protocols working together to
form trees, prune branches, locate sources and groups, and prevent routing loops:

■ Distance Vector Multicast Routing Protocol (DVMRP) and Protocol Independent
Multicast (PIM) operate between routers. PIM can operate in dense mode and
sparse mode.

■ Three versions of the Internet Group Management Protocol (IGMP) run between
receiver hosts and routers.

■ Several other routing mechanisms and protocols enhance multicast networks
by providing useful functions not included in other protocols. These include the
bootstrap router (BSR) mechanism, auto-rendezvous point (RP), Multicast Source
Discovery Protocol (MSDP), Session Announcement Protocol (SAP), Session
Description Protocol (SDP), and Pragmatic General Multicast (PGM) protocol.

Table 149 on page 563 lists and summarizes these protocols.

Table 149: Multicast Protocol Building Blocks

UsesDescriptionMulticast Protocol

Not appropriate for large-scale Internet
use.

Dense-mode-only protocol that uses the
flood-and-prune or implicit join method
to deliver traffic everywhere and then
determine where the uninterested
receivers are. DVRMP uses source-based
distribution trees in the form (S,G) and
builds its own multicast routing tables for
RPF checks.

DVMRP

Most promising multicast protocol in
use for LANs.

Sends an implicit join message, so routers
use the flood-and-prune method to deliver
traffic everywhere and then determine
where the uninterested receivers are.

PIM dense mode uses source-based
distribution trees in the form (S,G), and
also supports sparse-dense mode, with
mixed sparse and dense groups. Both PIM
modes use unicast routing information
for RPF checks.

PIM dense mode
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Table 149: Multicast Protocol Building Blocks  (continued)

UsesDescriptionMulticast Protocol

Most promising multicast protocol in
use for WANs. See “Understanding PIM
and Static RPs” on page 569.

Sends an explicit join message, so routers
determine where the interested receivers
are and send join messages upstream to
their neighbors, building trees from
receivers to an RP router, which is the
initial source of multicast group traffic.

PIM sparse mode builds distribution trees
in the form (*,G), but migrates to an (S,G)
source-based tree if that path is shorter
than the path through the RP router for
a particular multicast group's traffic. Both
PIM modes use unicast routing
information for RPF checks.

PIM sparse “Understanding IGMP and
Multicast” on page 567mode

Used with IGMPv3 to create a
shortest-path tree between receiver and
source.

Enhancement to PIM sparse mode that
allows a client to receive multicast traffic
directly from the source, without the help
of an RP.

PIM source-specific multicast (SSM)

See “Understanding IGMP and
Multicast” on page 567.

The original protocol defined in RFC
1112, Host Extensions for IP Multicasting.
IGMPv1 sends an explicit join message
to the router, but uses a timeout to
determine when hosts leave a group.

IGMPv1

Used by default. ee “Understanding
IGMP and Multicast” on page 567.

Defined in RFC 2236, Internet Group
Management Protocol, Version 2. Among
other features, IGMPv2 adds an explicit
leave message to the join message.

IGMPv2

Used with PIM SSM to create a
shortest-path tree between receiver and
source.

Defined in RFC 3376, Internet Group
Management Protocol, Version 3. Among
other features, IGMPv3 optimizes support
for a single source of content for a
multicast group, or source-specific
multicast (SSM).

IGMPv3

Allow sparse-mode routing protocols to
find RPs within the routing domain
(autonomous system, or AS). RP
addresses can also be statically
configured.

BSR and Auto-RP

Typically runs on the same router as
PIM sparse mode RP.

Not appropriate if all receivers and
sources are located in the same routing
domain.

Allows groups located in one multicast
routing domain to find RPs in other
routing domains. MSDP is not used on
an RP if all receivers and sources are
located in the same routing domain.

MSDP “Understanding SAP and SDP
Multicast Session Announcements” on
page 566.
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Table 149: Multicast Protocol Building Blocks  (continued)

UsesDescriptionMulticast Protocol

Display multicast session names and
correlate the names with multicast traffic.
SDP is a session directory protocol that
advertises multimedia conference
sessions and communicates setup
information to participants who want to
join the session. A client commonly uses
SDP to announce a conference session
by periodically multicasting an
announcement packet to a well-known
multicast address and port using SAP.

SAP and SDP

Special protocol layer for multicast traffic
that can be used between the IP layer and
the multicast application to add reliability
to multicast traffic. PGM allows a receiver
to detect missing information in all cases
and request replacement information if
the receiver application requires it.

PGM

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Overview on page 467

■ Multicast Configuration Overview on page 565

■ Comparing Multicast to Unicast in the Junos Multicast Protocols Configuration
Guide

■ IP Multicast Uses in the Junos Multicast Protocols Configuration Guide

Multicast Configuration Overview

You configure a router network to support multicast applications with a related family
of protocols. To use multicast, you must understand the basic components of a
multicast network and their relationships, and then configure the device to act as a
node in the network.

To configure the device as a node in a multicast network:

1. Determine whether the router is directly attached to any multicast sources.
Receivers must be able to locate these sources.

2. Determine whether the router is directly attached to any multicast group receivers.
If receivers are present, IGMP is needed.

3. Determine whether to use the sparse, dense, or sparse-dense mode of multicast
operation. Each mode has different configuration considerations.

4. Determine the address of the rendezvous point (RP) if sparse or sparse-dense
mode is used.
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5. Determine whether to locate the RP with the static configuration, bootstrap router
(BSR), or auto-RP method.

6. Determine whether to configure multicast to use its own reverse-path forwarding
(RPF) routing table when configuring PIM in sparse, dense, or sparse-dense
modes.

7. (Optional) Configure the SAP and SDP protocols to listen for multicast session
announcements. See “Example: Configuring SAP and SDP to Listen for Session
Announcements (CLI)” on page 567.

8. Configure IGMP. See “Example: Configuring IGMP for Multicast (CLI)” on page 568.

9. (Optional) Configure the PIM static RP. See “Understanding PIM and Static RPs”
on page 569.

10. (Optional) Filter PIM register messages from unauthorized groups and sources.
See “Example: Rejecting Incoming PIM Register Messages on an RP Router (CLI)”
on page 571 and “Example: Stopping Outgoing PIM Register Messages on a
Designated Router (CLI)” on page 572.

11. (Optional) Configure a PIM RPF routing table. See “Example: Configuring a PIM
RPF Routing Table (CLI)” on page 574.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Multicast Overview on page 559

■ Verifying a Multicast Configuration on page 575

SAP and SDP Multicast Session Announcements

■ Understanding SAP and SDP Multicast Session Announcements on page 566

■ Example: Configuring SAP and SDP to Listen for Session Announcements
(CLI) on page 567

Understanding SAP and SDP Multicast Session Announcements

Multicast session announcements are handled by two protocols, the Session
Announcement Protocol (SAP), and Session Description Protocol (SDP). These two
protocols display multicast session names and correlate the names with multicast
traffic. Enabling SDP and SAP allows the router to receive announcements about
multimedia and other multicast sessions from sources. Enabling SAP automatically
enables SDP.

The device listens for session announcements on one or more addresses and ports.
By default, the router listens to address and port 224.2.127.254:9875.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Multicast Overview on page 559
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■ Example: Configuring SAP and SDP to Listen for Session Announcements (CLI)
on page 567

Example: Configuring SAP and SDP to Listen for Session Announcements (CLI)

To configure SAP and SDP:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 150 on page 567.

Table 150: Configuring SAP and SDP

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols sap

Navigate to the Listen level in the configuration
hierarchy.

1. Set the address value to the IP address that the device can listen
to session announcements on, in dotted decimal notation. For
example:

set listen 224.2.127.254

2. Set the port value to the number of the port that the device can
listen to session announcements on, in decimal notation. For
example:

set listen 224.2.127.254 port 9875.

(Optional) Enter one or more addresses and ports for
the device to listen to session announcements on. By
default, the device listens to address and port
224.2.127.254:9875.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Understanding SAP and SDP Multicast Session Announcements on page 566

■ Multicast Configuration Overview on page 565

Multicast IGMP

■ Understanding IGMP and Multicast on page 567

■ Example: Configuring IGMP for Multicast (CLI) on page 568

Understanding IGMP and Multicast

The Internet Group Management Protocol (IGMP) manages the membership of hosts
and routers in multicast groups. IGMP is an integral part of IP and must be enabled
on all routers and hosts that need to receive IP multicasts. IGMP is automatically
enabled on all broadcast interfaces when you configure PIM or DVMRP.
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By default, the device runs IGMPv2. However, you might still want to set the IGMP
version explicitly on an interface, or all interfaces. Routers running different versions
of IGMP negotiate the lowest common version of IGMP supported by hosts on their
subnet. One host running IGMPv1 forces the device to use that version and lose
features important to other hosts.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Multicast Overview on page 559

■ Example: Configuring IGMP for Multicast (CLI) on page 568

■ IGMP Overview in the Junos Multicast Protocols Configuration Guide

Example: Configuring IGMP for Multicast (CLI)

To explicitly configure the IGMP version, perform these steps on each device in the
network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 151 on page 568.

3. If you are finished configuring the router, commit the configuration.

Table 151: Explicitly Configuring the IGMP version

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols igmp

Navigate to the Interface level in the configuration hierarchy.

1. Set the interface value to the interface name, or all. For
example:

set igmp interface all

2. Set the version value to 1, 2, or 3. For example:

set igmp interface all version 2

Set the IGMP version. By default, the device uses IGMPv2, but
this version can be changed through negotiation with hosts
unless explicitly configured.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding IGMP and Multicast on page 567

■ Configuring IGMP in the Junos Multicast Protocols Configuration Guide

■ Enabling IGMP in the Junos Multicast Protocols Configuration Guide

■ Multicast Configuration Overview on page 565
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Multicast PIM and Static RPs

■ Understanding PIM and Static RPs on page 569

■ Example: Configuring PIM Sparse Mode and RP Static IP Addresses
(CLI) on page 569

Understanding PIM and Static RPs

Protocol Independent Multicast (PIM) sparse mode is the most common multicast
protocol used on the Internet. PIM sparse mode is the default mode whenever PIM
is configured on any interface of the device. However, because PIM must not be
configured on the network management interface, you must disable it on that
interface.

Each any-source multicast (ASM) group has a shared tree through which receivers
learn about new multicast sources and new receivers learn about all multicast sources.
The rendezvous point (RP) router is the root of this shared tree and receives the
multicast traffic from the source. To receive multicast traffic from the groups served
by the RP, the device must determine the IP address of the RP for the source.

One common way for the device to locate RPs is by static configuration of the IP
address of the RP. For information about alternate methods of locating RPs, see the
JUNOS Multicast Protocols Configuration Guide.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Multicast Overview on page 559

■ Example: Configuring PIM Sparse Mode and RP Static IP Addresses (CLI) on
page 569

■ Protocol Independent Multicast Overview in the Junos Multicast Protocols
Configuration Guide

■ PIM Sparse Mode in the Junos Multicast Protocols Configuration Guide

Example: Configuring PIM Sparse Mode and RP Static IP Addresses (CLI)

To configure PIM sparse mode, disable PIM on ge-0/0/0, and configure the IP address
of the RP, and perform these steps on each device in the network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 152 on page 570.
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Table 152: Configuring PIM Sparse Mode and the RP

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit protocols pim

Navigate to the Interface level in the configuration hierarchy.

Set the interface value to all. For example:

set pim interface all

Enable PIM on all network interfaces.

Changes in the CLI are applied automatically when you execute
the set command.

Apply your configuration changes.

Remain at the [edit protocols pim interface] hierarchy level.Remain at the Interface level in the configuration hierarchy.

Disable the ge-0/0/0 interface:

set pim interface ge-0/0/0 unit 0 disable

Disable PIM on the network management interface.

Changes in the CLI are applied automatically when you execute
the set command.

Apply your configuration changes.

From the [edit] hierarchy level, enter

edit protocols pim rp

Navigate to the Rp level in the configuration hierarchy.

Set the address value to the IP address of the RP:

set static address 192.168.14.27

Configure the IP address of the RP—for example,
192.168.14.27.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding PIM and Static RPs on page 569

■ PIM Configuration Statements in the Junos Multicast Protocols Configuration Guide

■ Configuring Static PIM RPs in the Junos Multicast Protocols Configuration Guide

■ Multicast Configuration Overview on page 565

PIM Register Messages

■ Understanding PIM Register Messages on page 571

■ Example: Rejecting Incoming PIM Register Messages on an RP Router
(CLI) on page 571

■ Example: Stopping Outgoing PIM Register Messages on a Designated Router
(CLI) on page 572
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Understanding PIM Register Messages

When a source in a multicast network becomes active, the source’s designated router
(DR) encapsulates multicast data packets into a PIM register message and sends them
by means of unicast to the rendezvous point (RP) router.

To prevent unauthorized groups and sources from registering with an RP router, you
can define a routing policy to reject PIM register messages from specific groups and
sources and configure the policy on the designated router or the RP router.

■ If you configure the reject policy on an RP router, it rejects incoming PIM register
messages from the specified groups and sources. The RP router also sends a
register stop message by means of unicast to the designated router. On receiving
the register stop message, the designated router sends periodic null register
messages for the specified groups and sources to the RP router.

■ If you configure the reject policy on a designated router, it stops sending PIM
register messages for the specified groups and sources to the RP router.

NOTE: If you have configured the reject policy on an RP router, we recommend that
you configure the same policy on all the RP routers in your multicast network.

NOTE: If you delete a group and source address from the reject policy configured on
an RP router and commit the configuration, the RP router will register the group and
source only when the designated router sends a null register message.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Multicast Overview on page 559

■ Example: Rejecting Incoming PIM Register Messages on an RP Router (CLI) on
page 571

■ Example: Stopping Outgoing PIM Register Messages on a Designated Router
(CLI) on page 572

■ Filtering Multicast Messages in the Junos Multicast Protocols Configuration Guide

■ Routing Policies Overview on page 581

Example: Rejecting Incoming PIM Register Messages on an RP Router (CLI)

To reject incoming PIM register messages on an RP router:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 153 on page 572.

3. If you are finished configuring the router, commit the configuration.
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Table 153: Rejecting Incoming PIM Register Messages on an RP Router

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit policy-options

Navigate to the Policy options level in the
configuration hierarchy.

1. Set the match condition for the group address:

set policy statement reject-pim-register-msg-rp from route-filter 224.1.1.1/32
exact

2. Set the match condition for the address of a source in the group:

set policy statement reject-pim-register-msg-rp from source-address-filter
10.10.10.1/32 exact

3. Set the match action to reject PIM register messages from the group and
source address:

set policy statement reject-pim-register-msg-rp then reject

Define a policy to reject PIM register messages
from a group and source address.

1. From the [edit] hierarchy level, enter

edit protocols pim rp

2. Assign the policy on the RP:

set rp-register-policy reject-pim-register-msg-rp

Configure the reject-pim-register-msg-rp policy
on the RP router.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding PIM Register Messages on page 571

■ Example: Stopping Outgoing PIM Register Messages on a Designated Router
(CLI) on page 572

■ Configuring Register Message Filtering on a PIM RP or DR in the Junos Multicast
Protocols Configuration Guide

■ Example: Configuring Register Message Filters on PIM RPs and DRs in the Junos
Multicast Protocols Configuration Guide

■ Multicast Configuration Overview on page 565

Example: Stopping Outgoing PIM Register Messages on a Designated Router (CLI)

To stop outgoing PIM register messages on a designated router:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 154 on page 573.

3. If you are finished configuring the router, commit the configuration.
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Table 154: Stopping Outgoing PIM Register Messages on a Designated Router

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit policy-options

Navigate to the Policy options level in the
configuration hierarchy.

1. Set the match condition for the group address:

set policy statement stop-pim-register-msg-dr from route-filter 224.2.2.2/32
exact

2. Set the match condition for the address of a source in the group:

set policy statement stop-pim-register-msg-dr from source-address-filter
20.20.20.1/32 exact

3. Set the match action to not send PIM register messages for the group
and source address:

set policy statement stop-pim-register-msg-dr then reject

Define a policy to not send PIM register
messages for a group and source address.

1. From the [edit] hierarchy level, enter

edit protocols pim rp

2. Assign the policy on the designated router:

set dr-register-policy stop-pim-register-msg-dr

Configure the stop-pim-register-msg-dr policy
on the designated router.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding PIM Register Messages on page 571

■ Example: Rejecting Incoming PIM Register Messages on an RP Router (CLI) on
page 571

■ Configuring Register Message Filtering on a PIM RP or DR in the Junos Multicast
Protocols Configuration Guide

■ Example: Configuring Register Message Filters on PIM RPs and DRs in the Junos
Multicast Protocols Configuration Guide

■ Multicast Configuration Overview on page 565

PIM RPF Routing Tables

■ Understanding PIM RPF Routing Tables on page 573

■ Example: Configuring a PIM RPF Routing Table (CLI) on page 574

Understanding PIM RPF Routing Tables

By default, PIM uses inet.0 as its reverse-path forwarding (RPF) routing table group.
PIM uses an RPF routing table group to resolve its RPF neighbor for a particular
multicast source address and for the RP address. PIM can optionally use inet.2 as its
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RPF routing table group. The inet.2 routing table is organized more efficiently for
RPF checks.

Once configured, the RPF routing table must be applied to a PIM as a routing table
group.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Multicast Overview on page 559

■ Example: Configuring a PIM RPF Routing Table (CLI) on page 574

■ Configuring a PIM RPF Routing Table in the Junos Multicast Protocols Configuration
Guide

Example: Configuring a PIM RPF Routing Table (CLI)

To configure and apply a PIM RPF routing table, perform these steps on each device
in the network:

1. Navigate to the top of the configuration hierarchy.

2. Perform the configuration tasks described in Table 155 on page 574.

3. If you are finished configuring the router, commit the configuration.

Table 155: Configuring a PIM RPF Routing Table

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options

Navigate to the Routing options level in the configuration hierarchy.

Enter

edit rib-groups

Configure a new group for the RPF routing table.

Enter

set multicast-rpf-rib export-rib inet.2

Configure a name for the new RPF routing table group—for example,
multicast-rfp-rib—and use inet.2 for its export routing table.

Enter

set multicast-rpf-rib import-rib inet.2

Configure the new RPF routing table group to use inet.2 for its import
routing table.

From the [edit] hierarchy level, enter

edit protocols pim

Navigate to the Rib group level in the configuration hierarchy.

Enter

set rib-group multicast-rpf-rib

Apply the new RPF routing table to PIM.
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Table 155: Configuring a PIM RPF Routing Table (continued)

CLI Configuration EditorTask

From the [edit] hierarchy level, enter

edit routing-options rib-groups.

Create a routing table group for the interface routes.

Enter

set if-rib import-rib inet.2

set if-rib import-rib inet.0

Configure a name for the RPF routing table group—for example,
if-rib—and use inet.2 and inet.0 for its import routing tables.

From the [edit] hierarchy level, enter

edit routing-options interface-routes

set rib-group inet if-rib

Add the new interface routing table group to the interface routes.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding PIM RPF Routing Tables on page 573

■ Configuring a PIM RPF Routing Table in the Junos Multicast Protocols Configuration
Guide

■ Multicast Configuration Overview on page 565

Verifying a Multicast Configuration

To verify a multicast configuration, perform these tasks:

■ Verifying SAP and SDP Addresses and Ports on page 575

■ Verifying the IGMP Version on page 576

■ Verifying the PIM Mode and Interface Configuration on page 576

■ Verifying the PIM RP Configuration on page 577

■ Verifying the RPF Routing Table Configuration on page 577

Verifying SAP and SDP Addresses and Ports

Purpose Verify that SAP and SDP are configured to listen on the correct group addresses and
ports.

Action From the CLI, enter the show sap listen command.

Sample Output user@host> show sap listen
Group Address   Port
224.2.127.254   9875
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Meaning The output shows a list of the group addresses and ports that SAP and SDP listen on.
Verify the following information:

■ Each group address configured, especially the default 224.2.127.254, is listed.

■ Each port configured, especially the default 9875, is listed.

Verifying the IGMP Version

Purpose Verify that IGMP version 2 is configured on all applicable interfaces.

Action From the CLI, enter the show igmp interface command.

Sample Output user@host> show igmp interface
Interface: ge–0/0/0.0
    Querier: 192.168.4.36
    State:         Up Timeout:     197 Version:  2 Groups:      0

Configured Parameters:
IGMP Query Interval: 125.0
IGMP Query Response Interval: 10.0
IGMP Last Member Query Interval: 1.0
IGMP Robustness Count: 2

Derived Parameters:
IGMP Membership Timeout: 260.0
IGMP Other Querier Present Timeout: 255.0

Meaning The output shows a list of the interfaces that are configured for IGMP. Verify the
following information:

■ Each interface on which IGMP is enabled is listed.

■ Next to Version, the number 2 appears.

Verifying the PIM Mode and Interface Configuration

Purpose Verify that PIM sparse mode is configured on all applicable interfaces.

Action From the CLI, enter the show pim interfaces command.

Sample Output user@host> show pim interfaces
Instance: PIM.master
Name                   Stat Mode       IP V State Count DR address
lo0.0                  Up   Sparse      4 2 DR        0 127.0.0.1
pime.32769             Up   Sparse      4 2 P2P       0

Meaning The output shows a list of the interfaces that are configured for PIM. Verify the
following information:

■ Each interface on which PIM is enabled is listed.

■ The network management interface, either ge–0/0/0 or fe–0/0/0, is not listed.
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■ Under Mode, the word Sparse appears.

Verifying the PIM RP Configuration

Purpose Verify that the PIM RP is statically configured with the correct IP address.

Action From the CLI, enter the show pim rps command.

Sample Output user@host> show pim rps
Instance: PIM.master
Address family INET
RP address      Type      Holdtime Timeout Active groups Group prefixes
192.168.14.27   static           0    None             2 224.0.0.0/4

Meaning The output shows a list of the RP addresses that are configured for PIM. At least one
RP must be configured. Verify the following information:

■ The configured RP is listed with the proper IP address.

■ Under Type, the word static appears.

Verifying the RPF Routing Table Configuration

Purpose Verify that the PIM RPF routing table is configured correctly.

Action From the CLI, enter the show multicast rpf command.

Sample Output user@host> show multicast rpf
Multicast RPF table: inet.0 , 2 entries...

Meaning The output shows the multicast RPF table that is configured for PIM. If no multicast
RPF routing table is configured, RPF checks use inet.0. Verify the following
information:

■ The configured multicast RPF routing table is inet.0.

■ The inet.0 table contains entries.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Multicast Configuration Overview on page 565

■ show sap listen  in the Junos Routing Protocols and Policies Command Reference

■ show igmp interface in the Junos Routing Protocols and Policies Command Reference

■ show pim interfaces in the Junos Routing Protocols and Policies Command Reference

■ show pim rps in the Junos Routing Protocols and Policies Command Reference

■ show multicast rpf in the Junos Routing Protocols and Policies Command Reference
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Part 3

Routing Policies and Stateless Firewall
Filters

■ Routing Policies on page 581

■ Stateless Firewall Filters on page 607

Routing Policies and Stateless Firewall Filters ■ 579
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Chapter 23

Routing Policies

■ Routing Policies Overview on page 581

■ Routing Policies Configuration Overview on page 582

■ Routing Policies on page 583

■ Routing Policy Terms on page 584

■ Routing Policy Match Conditions and Actions on page 586

■ Routing Policy Damping Parameters on page 602

Routing Policies Overview

A routing policy has a major impact on the flow of routing information or packets
within and through the device. The match conditions and actions allow you to
configure a customized policy to fit your needs.

Routing protocols send information about routes to a router's neighbors. This
information is processed and used to create routing tables, which are then distilled
into forwarding tables. Routing policies control the flow of information between the
routing protocols and the routing tables and between the routing tables and the
forwarding tables. Using policies, you can determine which routes are advertised,
specify which routes are imported into the routing table, and modify routes to control
which routes are added to the forwarding table.

To create a routing policy, you configure criteria against which routes are compared,
and the action that is performed if the criteria are met.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Configuration Overview on page 582

■ Routing Overview on page 467
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Routing Policies Configuration Overview

To configure a routing policy:

1. Determine what you want to accomplish with the policy, and thoroughly
understand how to achieve your goal using the various match conditions and
actions.

2. Make certain that you understand the default policies and actions for the policy
you are configuring.

3. Configure an interface on the router. See the Junos OS Interfaces Configuration
Guide for Security Devices.

4. Configure an Interior Gateway Protocol (IGP) and Border Gateway Protocol (BGP),
if necessary. See:

■ RIP Configuration Overview on page 491

■ OSPF Configuration Overview on page 504

■ IS-IS Configuration Overview on page 529

■ BGP Configuration Overview on page 542

5. Configure the router interface to reject or accept routes, if necessary.

6. Configure static routes, if necessary. See “Static Routing Configuration Overview”
on page 475.

7. Name the policy. See “Example: Creating a Routing Policy” on page 583.

8. Configure the policy term. See “Example: Creating a Routing Policy Term” on
page 585.

9. (Optional) Reject useless routes. See “Example: Rejecting Known Invalid Routes”
on page 592.

10. (Optional) Advertise additional routes. See “Example: Injecting OSPF Routes into
the BGP Routing Table” on page 597.

11. (Optional) Create a forwarding class. See “Example: Grouping Source and
Destination Prefixes into a Forwarding Class” on page 594.

12. (Optional) Make a route less preferable to BGP. See “Example: Configuring a
Routing Policy to Prepend the AS Path” on page 600.

13. (Optional) Suppress route information. See “Example: Configuring Damping
Parameters” on page 603.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Overview on page 581

■ Minimum Routing Policy Configuration in the Junos Policy Framework
Configuration Guide

■ Testing Routing Policies in the Junos Policy Framework Configuration Guide
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Routing Policies

■ Understanding Routing Policies on page 583

■ Example: Creating a Routing Policy on page 583

Understanding Routing Policies

Each routing policy is identified by a policy name. The name can contain letters,
numbers, and hyphens (-) and can be up to 255 characters long. To include spaces
in the name, enclose the entire name in double quotation marks. Each routing policy
name must be unique within a configuration.

Once a policy is created and named, it must be applied before it is active. You apply
routing policies using the import and export statements at the protocols>protocol-name
level in the configuration hierarchy.

In the import statement, you list the name of the routing policy to be evaluated when
routes are imported into the routing table from the routing protocol.

In the export statement, you list the name of the routing policy to be evaluated when
routes are being exported from the routing table into a dynamic routing protocol.
Only active routes are exported from the routing table.

To specify more than one policy and create a policy chain, you list the policies using
a space as a separator. If multiple policies are specified, the policies are evaluated
in the order in which they are specified. As soon as an accept or reject action is
executed, the policy chain evaluation ends.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Overview on page 581

■ Example: Creating a Routing Policy on page 583

■ Router Flows Affected by Policies in the Junos Policy Framework Configuration
Guide

Example: Creating a Routing Policy

This example shows how to create a simple routing policy.

■ Requirements on page 584

■ Overview on page 584

■ Configuration on page 584

■ Verification on page 584
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Requirements

Before you begin, determine what you want to accomplish with the policy, configure
router interfaces, and configure routing protocols, as explained in “Routing Policies
Configuration Overview” on page 582.

Overview

In this example, you create a routing policy called policy1.

Configuration

Step-by-Step Procedure To create a routing policy:

1. Create the routing policy.

[edit]
user@host# set policy-options policy-statement policy1

2. Commit the configuration if you are done configuring the device.

[edit]
user@host# commit

NOTE: The policy does not take effect until you apply it.

Verification

To verify your configuration, use the show policy-options command.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Configuration Overview on page 582

■ Understanding Routing Policies on page 583

Routing Policy Terms

■ Understanding Routing Policy Terms on page 585

■ Example: Creating a Routing Policy Term on page 585
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Understanding Routing Policy Terms

Routing policies are made up of one or more terms. Each routing policy term is
identified by a term name. The name can contain letters, numbers, and hyphens (-)
and can be up to 255 characters long. To include spaces in the name, enclose the
entire name in double quotation marks.

Each term contains a set of match conditions and a set of actions:

■ Match conditions are criteria that a route must match before the actions can be
applied. If a route matches all criteria, one or more actions are applied to the
route.

■ Actions specify whether to accept or reject the route, control how a series of
policies are evaluated, and manipulate the characteristics associated with a route.

Generally, a router compares a route against the match conditions of each term in
a routing policy, starting with the first and moving through the terms in the order in
which they are defined, until a match is made and an explicitly configured or default
action of accept or reject is taken. If none of the terms in the policy match the route,
the router compares the route against the next policy, and so on, until either an
action is taken or the default policy is evaluated.

If none of the match conditions of each term evaluates to true, the final action is
executed. The final action is defined in an unnamed term. Additionally, you can
define a default action (either accept or reject) that overrides any action intrinsic to
the protocol.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Overview on page 581

■ Example: Creating a Routing Policy Term on page 585

Example: Creating a Routing Policy Term

This example shows how to create a routing policy term.

■ Requirements on page 585

■ Overview on page 586

■ Configuration on page 586

■ Verification on page 586

Requirements

Before you begin, determine what you want to accomplish with the policy, configure
router interfaces, and configure routing protocols, as explained in “Routing Policies
Configuration Overview” on page 582.
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Overview

In this example, you create a routing policy called policy1 and a term for the policy
called term1.

Configuration

Step-by-Step Procedure To configure a routing policy term:

1. Create the routing policy.

[edit]
user@host# edit policy-options policy-statement policy1

2. Create the policy term.

[edit policy-options policy-statement policy1]
user@host# set term term1

3. Commit the configuration if you are done configuring the device.

[edit policy-options policy-statement policy1]
user@host# commit

NOTE: The policy does not take effect until you apply it.

Verification

To verify your configuration, use the show policy-options command.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Configuration Overview on page 582

■ Understanding Routing Policy Terms on page 585

Routing Policy Match Conditions and Actions

■ Understanding Routing Policy Match Conditions and Actions on page 587

■ Route-Based Match Conditions on page 591

■ Protocol-Based Match Conditions on page 596

■ Autonomous System Path-Based Actions on page 599
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Understanding Routing Policy Match Conditions and Actions

A match condition defines the criteria that a route must match for an action to take
place. Each term can have one or more match conditions. If a route matches all the
match conditions for a particular term, the actions defined for that term are processed.

This topic contains the following sections:

■ Match Conditions on page 587

■ Actions on page 588

Match Conditions

Each term can consist of two statements, from and to, that define match conditions:

■ In the from statement, you define the criteria that an incoming route must match.
You can specify one or more match conditions. If you specify more than one,
all conditions must match the route for a match to occur.

■ In the to statement, you define the criteria that an outgoing route must match.
You can specify one or more match conditions. If you specify more than one,
all conditions must match the route for a match to occur.

The order of match conditions in a term is not important, because a route must
match all match conditions in a term for an action to be taken.

Table 156 on page 587 summarizes key routing policy match conditions.

Table 156: Summary of Key Routing Policy Match Conditions

DescriptionMatch Condition

Matches routes that are contributing to a configured aggregate. This match condition
can be used to suppress a contributor in an aggregate route.

aggregate-contributor

Matches a route learned from the specified OSPF area during the exporting of OSPF
routes into other protocols.

area area-id

Matches the name of the path regular expression of an autonomous systems (AS). BGP
routes whose AS path matches the regular expression are processed.

as-path name

Matches a color value. You can specify preference values that are finer-grained than
those specified in the preference match conditions. The color value can be a number
from 0 through 4,294,967,295 (232 – 1). A lower number indicates a more preferred
route.

color preference

Matches the name of one or more communities. If you list more than one name, only
one name needs to match for a match to occur. (The matching is effectively a logical
OR operation.)

community

Matches external OSPF routes, including routes exported from one level to another.
In this match condition, type is an optional keyword. The metric-type value can be either
1 or 2. When you do not specify type, this condition matches all external routes.

external [type metric-type]
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Table 156: Summary of Key Routing Policy Match Conditions (continued)

DescriptionMatch Condition

Matches the name or IP address of one or more router interfaces. Use this condition
with protocols that are interface-specific. For example, do not use this condition with
internal BGP (IBGP).

Depending on where the policy is applied, this match condition matches routes learned
from or advertised through the specified interface.

interface interface-name

Matches a routing policy against the internal flag for simplified next-hop self policies.internal

Matches the IS-IS level. Routes that are from the specified level or are being advertised
to the specified level are processed.

level level

Matches a BGP local preference attribute. The preference value can be from 0 through
4,294,967,295 (232 – 1).

local-preference value

Matches a metric value. The metric value corresponds to the multiple exit discriminator
(MED), and metric2 corresponds to the IGP metric if the BGP next hop runs back through
another route.

metric metric

metric2 metric

Matches the address of one or more neighbors (peers).

For BGP export policies, the address can be for a directly connected or indirectly
connected peer. For all other protocols, the address is for the neighbor from which the
advertisement is received.

neighbor address

Matches the next-hop address or addresses specified in the routing information for a
particular route. For BGP routes, matches are performed against each protocol next
hop.

next-hop address

Matches the BGP origin attribute, which is the origin of the AS path information. The
value can be one of the following:

■ egp—Path information originated from another AS.

■ igp—Path information originated from within the local AS.

■ incomplete—Path information was learned by some other means.

origin value

Matches the preference value. You can specify a primary preference value (preference)
and a secondary preference value (preference2). The preference value can be a number
from 0 through 4,294,967,295 (232 – 1). A lower number indicates a more preferred
route.

preference preference

preference2 preference

Matches the name of the protocol from which the route was learned or to which the
route is being advertised. It can be one of the following: aggregate, bgp, direct, dvmrp,
isis, local, ospf, pim-dense, pim-sparse, rip, ripng, or static.

protocol protocol

Matches the type of route. The value can be either external or internal.route-type value

Actions

An action defines what the router does with the route when the route matches all
the match conditions in the from and to statements for a particular term. If a term
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does not have from and to statements, all routes are considered to match and the
actions apply to all routes.

Each term can have one or more of the following types of actions. The actions are
configured under the then statement.

■ Flow control actions, which affect whether to accept or reject the route and
whether to evaluate the next term or routing policy

■ Actions that manipulate route characteristics

■ Trace action, which logs route matches

If you do not specify an action, one of the following results occurs:

■ The next term in the routing policy, if one exists, is evaluated.

■ If the routing policy has no more terms, the next routing policy, if one exists, is
evaluated.

■ If there are no more terms or routing policies, the accept or reject action specified
by the default policy is executed.

Table 157 on page 589 summarizes the routing policy actions.

Table 157: Summary of Key Routing Policy Actions

DescriptionAction

These actions control the flow of routing information into and out of the routing table.Flow Control Actions

Accepts the route and propagates it. After a route is accepted, no other terms in the
routing policy and no other routing policies are evaluated.

accept

Rejects the route and does not propagate it. After a route is rejected, no other terms
in the routing policy and no other routing policies are evaluated.

reject

Skips to and evaluates the next term in the same routing policy. Any accept or reject
action specified in the then statement is ignored. Any actions specified in the then
statement that manipulate route characteristics are applied to the route.

next term

Skips to and evaluates the next routing policy. Any accept or reject action specified in
the then statement is ignored. Any actions specified in the then statement that
manipulate route characteristics are applied to the route.

next policy

These actions manipulate the route characteristics.Route Manipulation Actions

Appends one or more AS numbers at the beginning of the AS path. If you are specifying
more than one AS number, include the numbers in quotation marks.

The AS numbers are added after the local AS number has been added to the path. This
action adds AS numbers to AS sequences only, not to AS sets. If the existing AS path
begins with a confederation sequence or set, the appended AS numbers are placed
within a confederation sequence. Otherwise, the appended AS numbers are placed
with a nonconfederation sequence.

as-path-prepend as-path
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Table 157: Summary of Key Routing Policy Actions (continued)

DescriptionAction

Extracts the last AS number in the existing AS path and appends that AS number to
the beginning of the AS path n times. Replace n with a number from 1 through 32.

The AS numbers are added after the local AS number has been added to the path. This
action adds AS numbers to AS sequences only, not to AS sets. If the existing AS path
begins with a confederation sequence or set, the appended AS numbers are placed
within a confederation sequence. Otherwise, the appended AS numbers are placed
with a nonconfederation sequence.

as-path-expand last-as count n

Applies the specified class-of-service (CoS) parameters to routes installed into the
routing table.

class class-name

Sets the preference value to the specified value. The color and color2 preference values
can be a number from 0 through 4,294,967,295 (232 – 1). A lower number indicates
a more preferred route.

color preference

color2 preference

Applies the specified route-damping parameters to the route. These parameters override
BGP's default damping parameters.

This action is useful only in import policies.

damping name

Sets the BGP local preference attribute. The preference can be a number from 0 through
4,294,967,295 (232 – 1).

local-preference value

Sets the metric. You can specify up to four metric values, starting with metric (for the
first metric value) and continuing with metric2, metric3, and metric4.

For BGP routes, metric corresponds to the MED, and metric2 corresponds to the IGP
metric if the BGP next hop loops through another router.

metric metric

metric2 metric

metric3 metric

metric4 metric

Sets the next hop.

If you specify address as self, the next-hop address is replaced by one of the local
router's addresses. The advertising protocol determines which address to use.

next-hop address

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Overview on page 581

■ Understanding Route-Based Match Conditions on page 591

■ Understanding Protocol-Based Match Conditions on page 596

■ Understanding Autonomous System Path-Based Actions on page 599

■ Configuring Match Conditions in Routing Policy Terms in the Junos Policy
Framework Configuration Guide

■ Configuring Actions in Routing Policy Terms in the Junos Policy Framework
Configuration Guide
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Route-Based Match Conditions

■ Understanding Route-Based Match Conditions on page 591

■ Example: Rejecting Known Invalid Routes on page 592

■ Example: Grouping Source and Destination Prefixes into a Forwarding
Class on page 594

Understanding Route-Based Match Conditions

You can specify known invalid (“bad”) routes to ignore by specifying matches on
destination prefixes. When specifying a destination prefix, you can specify an exact
match with a specific route, or a less precise match by using match types. You can
configure either a common reject action that applies to the entire list, or an action
associated with each prefix.

Additionally, you can specify that “good” routes be processed in a particular way.
For instance, you can group traffic from specific source or destination addresses into
forwarding classes to be processed using the class of service (CoS) feature.

Table 158 on page 591 lists route list match types.

Table 158: Route List Match Types

Match ConditionsMatch Type

The route shares the same most-significant bits (described by
prefix-length), and prefix-length is equal to the route's prefix length.

exact

The route shares the same most-significant bits (described by
prefix-length), and prefix-length is greater than the route's prefix length.

longer

The route shares the same most-significant bits (described by
prefix-length), and prefix-length is equal to or greater than the route's prefix
length.

orlonger

The route shares the same most-significant bits (described by
prefix-length), and the route's prefix length falls between prefix-length2
and prefix-length3, inclusive.

prefix-length-range prefix-length2-prefix-length3

All the following are true:

■ The route shares the same most-significant bits (described by
prefix-length) of the first destination prefix.

■ The route shares the same most-significant bits (described by
prefix-length) of the second destination prefix for the number of bits
in the prefix length.

■ The number of bits in the route's prefix length is less than or equal
to the number of bits in the second prefix.

You do not use the through match type in most routing policy
configurations. See the JUNOS Policy Framework Configuration Guide.

through destination-prefix
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Table 158: Route List Match Types (continued)

Match ConditionsMatch Type

The route shares the same most-significant bits (described by prefix-length)
and the route's prefix length falls between prefix-length and prefix-length2.

upto prefix-length2

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding Routing Policy Match Conditions and Actions on page 587

■ Example: Rejecting Known Invalid Routes on page 592

■ Example: Grouping Source and Destination Prefixes into a Forwarding Class on
page 594

■ Routing Policies Configuration Overview on page 582

■ Junos OS Class of Service Configuration Guide for Security Devices

Example: Rejecting Known Invalid Routes

This example shows how to create route-based match conditions for a routing policy.

■ Requirements on page 592

■ Overview on page 592

■ Configuration on page 592

■ Verification on page 593

Requirements

Before you begin, configure router interfaces and configure routing protocols, as
explained in “Routing Policies Configuration Overview” on page 582.

Overview

In this example, you create a policy called rejectpolicy1 that rejects routes with a
mask of /8 and greater (/8, /9, /10, and so on) that have the first 8 bits set to 0. This
policy also accepts routes less than 8 bits in length by creating a mask of 0/0 up to
/7.

Configuration

CLI Quick Configuration To quickly create a policy that rejects known invalid routes copy the following
commands and paste them into the CLI.

[edit]
set policy-options policy-statement rejectpolicy1 term rejectterm1 from route-filter

0.0.0.0/0 upto /7 accept
set policy-options policy-statement rejectpolicy1 term rejectterm1 from route-filter

0.0.0.0/8 orlonger reject
set policy-options policy-statement test term 1 from protocol direct
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Step-by-Step Procedure To create a policy that rejects known invalid routes:

1. Create the routing policy.

[edit]
user@host# edit policy-options policy-statement rejectpolicy1

2. Create the policy term.

[edit policy-options policy-statement rejectpolicy1]
user@host# edit term rejectterm1

3. Create a mask that specifies which routes to accept.

[edit policy-options policy-statement rejectpolicy1 term rejectterm1]
user@host# set from route-filter 0/0 upto /7 accept

4. Create a mask that specifies which routes to reject.

[edit policy-options policy-statement rejectpolicy1 term rejectterm1]
user@host# set from route-filter 0/8 orlonger reject

Results Confirm your configuration by entering the show policy-options command from
configuration mode. If the output does not display the intended configuration, repeat
the configuration instructions in this example to correct it.

user@host# show policy-options
policy-statement rejectpolicy1 {

term rejectterm1 {
from {

route-filter 0.0.0.0/0 upto /7 accept;
route-filter 0.0.0.0/8 orlonger reject;

}
}

}

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying the Route-Based Match Conditions on page 593

Verifying the Route-Based Match Conditions

Purpose Verify that the policy and term are configured on the device with the appropriate
route-based match conditions.

Action From operational mode, enter the show policy-options command.

Verification ■ 593
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Configuration Overview on page 582

■ Understanding Route-Based Match Conditions on page 591

■ Example: Grouping Source and Destination Prefixes into a Forwarding Class on
page 594

Example: Grouping Source and Destination Prefixes into a Forwarding
Class

This example shows how to group source and destination prefixes into a forwarding
class.

■ Requirements on page 594

■ Overview on page 594

■ Configuration on page 594

■ Verification on page 596

Requirements

Before you begin, configure router interfaces and configure routing protocols, as
explained in “Routing Policies Configuration Overview” on page 582.

Overview

In this example, you configure a routing policy called policy1and a corresponding
routing term called term1. Within the term, you configure the route filter to include
source routes greater than or equal to 10.210.0.0/16 and destination routes greater
than or equal to 10.215.0.0/16. Then you group the source and destination prefixes
into a forwarding class called forwarding-class1 and apply policy1 to the forwarding
table. The routing policy is evaluated when routes are being exported from the routing
table into the forwarding table. Only the active routes are exported from the routing
table.

Configuration

CLI Quick Configuration To quickly group source and destination prefixes in a forwarding class, copy the
following commands and paste them into the CLI.

[edit]
set policy-options policy-statement policy1 term term1 from route-filter

10.210.0.0/16 orlonger
set policy-options policy-statement policy1 term term1 from route-filter

10.215.0.0/16 orlonger
set policy-options policy-statement policy1 term term1 then forwarding-class

forwarding-class1
set routing-options forwarding-table export policy1
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Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To group source and destination prefixes in a forwarding class:

1. Create the routing policy.

[edit]
user@host# edit policy-options policy-statement policy1

2. Create the routing term.

[edit policy-options policy-statement policy1]
user@host# edit term term1

3. Specify the source routes to include in the route filter.

[edit policy-options policy-statement policy1 term term1]
user@host# set from route-filter 10.210.0.0/16 orlonger

4. Specify the destination routes to include in the route filter.

[edit policy-options policy-statement policy1 term term1]
user@host# set from route-filter 10.215.0.0/16 orlonger

5. Group the source and destination prefixes into the forwarding class.

[edit policy-options policy-statement policy1 term term1]
user@host# set then forwarding-class forwarding-class1

6. Apply the routing policy to the forwarding table.

[edit]
user@host# set routing-options forwarding-table export policy1

NOTE: You can refer to the same routing policy one or more times in the same or
different export statement.

Results Confirm your configuration by entering the show policy-options and show routing-options
commands from configuration mode. If the output does not display the intended
configuration, repeat the configuration instructions in this example to correct it.

user@host# show policy-options
policy-statement policy1 {

term term1 {
from {

route-filter 10.210.0.0/16 orlonger;
route-filter 10.215.0.0/16 orlonger;

}
then forwarding-class forwarding-class1;

}
}
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user@host# show routing-options
forwarding-table {

export policy1;
}

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying the Forwarding Class on page 596

■ Verifying the Routing Policy on page 596

Verifying the Forwarding Class

Purpose Verify that the forwarding table is applied to the routing policy.

Action From operational mode, enter the show routing-options command.

Verifying the Routing Policy

Purpose Verify that the policy and term are configured on the device with the appropriate
routes included in the forwarding class.

Action From operational mode, enter the show policy-options command.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Configuration Overview on page 582

■ Understanding Route-Based Match Conditions on page 591

■ Example: Rejecting Known Invalid Routes on page 592

Protocol-Based Match Conditions

■ Understanding Protocol-Based Match Conditions on page 596

■ Example: Injecting OSPF Routes into the BGP Routing Table on page 597

Understanding Protocol-Based Match Conditions

You can specify a match condition for policies based on protocols by naming a
protocol from which the route is learned or to which the route is being advertised.
You can specify one of the following protocols: aggregate, BGP, direct, DVMRP, IS-IS,
local, OSPF, PIM-dense, PIM-sparse, RIP, or static.
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding Routing Policy Match Conditions and Actions on page 587

■ Example: Injecting OSPF Routes into the BGP Routing Table on page 597

■ Routing Policies Configuration Overview on page 582

Example: Injecting OSPF Routes into the BGP Routing Table

This example shows you how to create a policy that injects OSPF routes into the BGP
routing table.

■ Requirements on page 597

■ Overview on page 597

■ Configuration on page 597

■ Verification on page 598

Requirements

Before you begin, configure router interfaces and configure routing protocols, as
explained in “Routing Policies Configuration Overview” on page 582.

Overview

In this example, you create a routing policy called injectpolicy1 and a routing term
called injectterm1. The policy injects OSPF routes into the BGP routing table.

Configuration

CLI Quick Configuration To quickly create a policy that injects OSPF routes into the BGP routing table, copy
the following commands and paste them into the CLI.

[edit]
set policy-options policy-statement injectpolicy1 term injectterm1 from protocol

ospf
set policy-options policy-statement injectpolicy1 term injectterm1 from area 0.0.0.1
set policy-options policy-statement injectpolicy1 term injectterm1 then accept
set policy-options policy-statement test term 1 from protocol direct
set protocols bgp export injectpolicy1

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To inject OSPF routes into a BGP routing table:

1. Create the routing policy.

[edit]
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user@host# edit policy-options policy-statement injectpolicy1

2. Create the policy term.

[edit policy-options policy-statement injectpolicy1]
user@host# edit term injectterm1

3. Specify OSPF as a match condition.

[edit policy-options policy-statement injectpolicy1 term injectterm1]
user@host# set from protocol ospf

4. Specify the routes from an OSPF area as a match condition.

[edit policy-options policy-statement injectpolicy1 term injectterm1]
user@host# set from area 1

5. Specify that the route is to be accepted if the previous conditions are matched.

[edit policy-options policy-statement injectpolicy1 term injectterm1]
user@host# set then accept

6. Apply the routing policy to BGP.

[edit]
user@host# set protocols bgp export injectpolicy1

Results Confirm your configuration by entering the show policy-options and show protocols
bgp commands from configuration mode. If the output does not display the intended
configuration, repeat the configuration instructions in this example to correct it.

user@host# show policy-options
policy-statement injectpolicy1 {

term injectterm1 {
from {

protocol ospf;
area 0.0.0.1;

}
then accept;

}
}

user@host# show protocols bgp
export injectpolicy1;

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying the OSPF-Based Match Conditions on page 599

■ Verifying the Routing Policy on page 599
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Verifying the OSPF-Based Match Conditions

Purpose Verify that the policy and term are configured on the device with the appropriate
OSPF-based match conditions.

Action From operational mode, enter the show policy-options command.

Verifying the Routing Policy

Purpose Verify that the routing policy is applied to the routing protocol.

Action From operational mode, enter the show protocols bgp command.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Configuration Overview on page 582

■ Understanding Protocol-Based Match Conditions on page 596

Autonomous System Path-Based Actions

■ Understanding Autonomous System Path-Based Actions on page 599

■ Example: Configuring a Routing Policy to Prepend the AS Path on page 600

Understanding Autonomous System Path-Based Actions

You can prepend or add one or more autonomous system (AS) numbers at the
beginning of an AS path. The AS numbers are added after the local AS number has
been added to the path. Prepending an AS path makes a shorter AS path look longer
and therefore less preferable to the Border Gateway Protocol (BGP).

For example, from AS 1, there are two equal paths (through AS 2 and AS 3) to reach
AS 4. You might want packets from certain sources to use the path through AS 2.
Therefore, you must make the path through AS 3 look less preferable so that BGP
chooses the path through AS 2. In AS 1, you can prepend multiple AS numbers.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Configuration Overview on page 582

■ Understanding Routing Policy Match Conditions and Actions on page 587

■ Example: Configuring a Routing Policy to Prepend the AS Path on page 600
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Example: Configuring a Routing Policy to Prepend the AS Path

This example shows how to configure a routing policy to prepend the AS path.

■ Requirements on page 600

■ Overview on page 600

■ Configuration on page 600

■ Verification on page 602

Requirements

Before you begin, configure router interfaces and configure routing protocols, as
explained in “Routing Policies Configuration Overview” on page 582.

Overview

In this example, you create a routing policy called prependpolicy1 and a term called
prependterm1. The routing policy prepends the AS numbers 1 1 1 1 to routes that
are greater than or equal to 172.16.0.0/12, 192.168.0.0/16, and 10.0.0.0/8. The
policy is applied as an import policy to all BGP routes and is evaluated when routes
are imported to the routing table.

Configuration

CLI Quick Configuration To quickly group source and destination prefixes in a forwarding class, copy the
following commands and paste them into the CLI.

[edit]
set policy-options policy-statement prependpolicy1 term prependterm1 from

route-filter 172.16.0.0/12 orlonger
set policy-options policy-statement prependpolicy1 term prependterm1 from

route-filter 192.168.0.0/16 orlonger
set policy-options policy-statement prependpolicy1 term prependterm1 from

route-filter 10.0.0.0/8 orlonger
set policy-options policy-statement prependpolicy1 term prependterm1 then

as-path-prepend "1 1 1 1"
set policy-options policy-statement test term 1 from protocol direct
set protocols bgp import prependpolicy1

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To create a routing policy that prepends AS numbers to multiple routes:

1. Create the routing policy.

[edit]
user@host# edit policy-options policy-statement prependpolicy1
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2. Create the routing term.

[edit policy-options policy-statement prependpolicy1]
user@host# edit term prependterm1

3. Specify the routes to prepend with AS numbers.

[edit policy-options policy-statement prependpolicy1 term prependterm1]
user@host# set from route-filter 172.16.0.0/12 orlonger
user@host# set from route-filter 192.168.0.0/16 orlonger
user@host# set from route-filter 10.0.0.0/8 orlonger

4. Specify the AS numbers to prepend.

[edit policy-options policy-statement prependpolicy1 term prependterm1]
user@host# set then as-path-prepend “1 1 1 1”

NOTE: If you enter multiple numbers, you must separate each number with a space.
Enclose the numbers in double quotation marks.

5. Apply the policy as an import policy for all BGP routes.

[edit]
user@host# set protocols bgp import prependpolicy1

NOTE: You can refer to the same routing policy one or more times in the same or
different import statement.

Results Confirm your configuration by entering the show policy-options and show protocols
bgp commands from configuration mode. If the output does not display the intended
configuration, repeat the configuration instructions in this example to correct it.

user@host# show policy-options
policy-statement prependpolicy1 {

term prependterm1 {
from {

route-filter 172.16.0.0/12 orlonger;
route-filter 192.168.0.0/16 orlonger;
route-filter 10.0.0.0/8 orlonger;

}
then as-path-prepend "1 1 1 1";

}
}

user@host# show protocols bgp
import prependpolicy1;

If you are done configuring the device, enter commit from configuration mode.

Configuration ■ 601

Chapter 23: Routing Policies



Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying the AS Numbers to Prepend on page 602

■ Verifying the Routing Policy on page 602

Verifying the AS Numbers to Prepend

Purpose Verify that the policy and term are configured on the device and that the appropriate
routes are specified to prepend with AS numbers.

Action From operational mode, enter the show policy-options command.

Verifying the Routing Policy

Purpose Verify that the routing policy is applied to the routing protocol.

Action From operational mode, enter the show protocols bgp command.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Configuration Overview on page 582

■ Understanding Autonomous System Path-Based Actions on page 599

Routing Policy Damping Parameters

■ Understanding Damping Parameters on page 602

■ Example: Configuring Damping Parameters on page 603

Understanding Damping Parameters

Flap damping reduces the number of update messages by marking routes as ineligible
for selection as the active or preferable route. Marking routes in this way leads to
some delay, or suppression, in the propagation of route information, but the result
is increased network stability. You typically apply flap damping to external BGP
(EBGP) routes (routes in different ASs). You can also apply flap damping within a
confederation, between confederation member ASs. Because routing consistency
within an AS is important, do not apply flap damping to internal BGP (IBGP) routes.
(If you do, it is ignored.)

You can specify one or more of the damping parameters described in Table 159 on
page 603. If you do not specify a damping parameter, the default value of the
parameter is used.
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Table 159: Damping Parameters

Possible ValuesDefault ValueDescriptionDamping Parameter

1 through 415 (minutes)Decay half-life—Number of minutes after which an
arbitrary value is halved if a route stays stable.

half-life minutes

1 through 72060 (minutes)Maximum hold-down time for a route, in minutes.max-suppress minutes

1 through 20,000750Reuse threshold—Arbitrary value below which a
suppressed route can be used again.

reuse

1 through 20,0003000Cutoff (suppression) threshold—Arbitrary value above
which a route can no longer be used or included in
advertisements.

suppress

To change the default BGP flap damping values, you define actions by creating a
named set of damping parameters and including it in a routing policy with the
damping action. For the damping routing policy to work, you also must enable BGP
route flap damping.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Routing Policies Overview on page 581

■ Example: Configuring Damping Parameters on page 603

Example: Configuring Damping Parameters

This example shows how to configure damping parameters.

■ Requirements on page 603

■ Overview on page 603

■ Configuration on page 604

■ Verification on page 606

Requirements

Before you begin, configure router interfaces and configure routing protocols, as
explained in “Routing Policies Configuration Overview” on page 582.

Overview

In this example, you configure a routing policy called policy1and a corresponding
routing term called term1. Within the term, you configure the route filter to include
source routes greater than or equal to 10.210.0.0/16 and destination routes greater
than or equal to 10.215.0.0/16. Then you group the source and destination prefixes
into a forwarding class called forwarding-class1 and apply policy1 to the forwarding
table. The routing policy is evaluated when routes are being exported from the routing
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table into the forwarding table. Only the active routes are exported from the routing
table.

Configuration

CLI Quick Configuration To quickly group source and destination prefixes in a forwarding class, copy the
following commands and paste them into the CLI.

[edit]
set policy-options policy-statement dampenpolicy1 term dampenterm1 from

route-filter 172.16.0.0/12 orlonger damping group1
set policy-options policy-statement dampenpolicy1 term dampenterm1 from

route-filter 192.168.0.0/16 orlonger
set policy-options policy-statement dampenpolicy1 term dampenterm1 from

route-filter 10.0.0.0/8 orlonger
set policy-options policy-statement test term 1 from protocol direct
set policy-options damping group1 half-life 30 set policy-options damping group1

reuse 750
set policy-options damping group1 suppress 3000
set policy-options damping group1 max-suppress 60
set policy-options damping group2 half-life 40
set policy-options damping group2 reuse 1000
set policy-options damping group2 suppress 400
set policy-options damping group2 max-suppress 45
set policy-options damping group3 disable
set protocols bgp damping
set protocols bgp group groupA neighbor 172.16.15.14 import dampenpolicy1

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To configure damping parameters:

1. Create the routing policy.

[edit]
user@host# edit policy-options policy-statement dampenpolicy1

2. Create the routing term.

[edit policy-options policy-statement policy-statement dampenpolicy1]
user@host# edit term dampenterm1

3. Specify the routes to dampen and associate each group of routes with a group
name.

[edit policy-options policy-statement dampenpolicy1 term dampenterm1]
user@host# set from route-filter 172.16.0.0/12 orlonger damping group1
user@host# set from route-filter 192.168.0.0/16 orlonger
user@host# set from route-filter 10.0.0.0/8 orlonger

4. Create and configure the damping parameter groups.

[edit policy-options damping]
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user@host# set group1 half-life 30 max-suppress 60 reuse 750 suppress 3000
user@host# set group2 half-life 40 max-suppress 45 reuse 1000 suppress 400
user@host# set group3 disable

5. Enable damping for BGP.

[edit]
user@host# set protocols bgp damping

6. Apply the policy as an import policy for the BGP neighbor.

[edit ]
user@host# set protocols bgp group groupA neighbor 172.16.15.14 import

dampenpolicy1

NOTE: You can refer to the same routing policy one or more times in the same or
different import statement.

Results Confirm your configuration by entering the show policy-options and show protocols
bgp commands from configuration mode. If the output does not display the intended
configuration, repeat the configuration instructions in this example to correct it.

user@host# show policy-options
policy-statement dampenpolicy1 {

term dampenterm1 {
from {

route-filter 172.16.0.0/12 orlonger damping group1;
route-filter 192.168.0.0/16 orlonger;
route-filter 10.0.0.0/8 orlonger;

}
}

}
damping group1 {

half-life 30;
reuse 750;
suppress 3000;
max-suppress 60;

}
damping group2 {

half-life 40;
reuse 1000;
suppress 400;
max-suppress 45;

}
damping group3 {

disable;
}

user@host# show protocols bgp
damping;
group groupA {
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neighbor 172.16.15.14 {
import dampenpolicy1;

}
}

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying the Damping Parameters on page 606

■ Verifying the Routing Policy on page 606

Verifying the Damping Parameters

Purpose Verify that the policy and term are configured on the device and that the appropriate
damping parameters are specified within the term.

Action From operational mode, enter the show policy-options command.

Verifying the Routing Policy

Purpose Verify that damping is enabled for BGP and that the routing policy is applied to the
routing protocol.

Action From operational mode, enter the show protocols bgp command.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Routing Policies Configuration Overview on page 582

■ Understanding Damping Parameters on page 602
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Chapter 24

Stateless Firewall Filters

■ Stateless Firewall Filter Overview on page 607

■ Stateless Firewall Filter Configuration Overview on page 608

■ Stateless Firewall Filter Terms on page 609

■ Trusted Source Stateless Firewall Filters on page 618

■ Flood Prevention Stateless Firewall Filters on page 623

■ Fragment Handling Stateless Firewall Filters on page 631

Stateless Firewall Filter Overview

A stateless firewall filter evaluates the contents of packets transiting the device from
a source to a destination, or packets originating from, or destined for, the Routing
Engine. Stateless firewall filters applied to the Routing Engine interface protect the
processes and resources owned by the Routing Engine. A stateless firewall filter
evaluates every packet, including fragmented packets.

The primary goal of a typical stateless firewall filter is to protect the Routing Engine
processes and resources from malicious or untrusted packets. You can configure a
firewall filter to do the following:

■ Restrict traffic destined for the Routing Engine based on its source, protocol, and
application.

■ Limit the traffic rate of packets destined for the Routing Engine to protect against
flood, or denial-of-service (DoS), attacks.

■ Address special circumstances associated with fragmented packets destined for
the Routing Engine. Because the device evaluates every packet against a firewall
filter (including fragments), you must configure the filter to accommodate
fragments that do not contain packet header information. Otherwise, the filter
discards all but the first fragment of a fragmented packet.

You can apply a stateless firewall filter to an input or output interface, or to both.
Every packet, including fragmented packets, is evaluated against stateless firewall
filters.
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NOTE: A stateless firewall filter, often called a firewall filter or access control list
(ACL), statically evaluates packet contents. In contrast, a stateful firewall filter, or
stateful firewall policy, uses connection state information derived from past
communications and other applications to make dynamic control decisions.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ SRX Series Services Gateways Processing Overview in the Junos OS Security
Configuration Guide

■ Understanding Stateful and Stateless Data Processing for J Series Services Routers
in the Junos OS Security Configuration Guide

■ Security Policies Overview in the Junos OS Security Configuration Guide

■ Firewall Filter Overview in the Junos Policy Framework Configuration Guide

■ Firewall Filter Components in the Junos Policy Framework Configuration Guide

Stateless Firewall Filter Configuration Overview

Before you create a stateless firewall filter, determine your objectives:

■ Purpose of the firewall filter—For example, the purpose might be to limit traffic
to certain protocols, IP source or destination addresses, or data rates, or to
prevent denial-of-service (DoS) attacks.

■ Appropriate packet header fields to match—For example, you might want to
match IP header fields (such as source and destination IP addresses, protocols,
and IP options), TCP header fields (such as source and destination ports and
flags), or ICMP header fields (such as ICMP packet type and code).

■ Action to take if a match occurs—For example, you might want to accept, discard,
or evaluate the next term.

■ (Optional) Action modifiers (additional actions to take if a packet matches)—For
example, you might want to count, log, rate limit, or police a packet.

■ Interface on which the firewall filter is applied—For example, you might want
the input or output side, or both sides, of the Routing Engine interface or a
non-Routing Engine interface.

To create the firewall filter:

1. Create and configure the filter. (Unlike a stateful firewall filter, you can configure
a stateless firewall filter before configuring the interfaces on which the filter is
applied.) See:

■ Example: Configuring a Stateless Firewall Filter to Accept Traffic From Trusted
Sources on page 618

■ Example: Configuring a Stateless Firewall Filter to Protect Against TCP and
ICMP Floods on page 624
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■ Example: Configuring a Stateless Firewall Filter to Handle Fragments on
page 632

■ Configuring Firewall Filters in the Junos Policy Framework Configuration Guide

■ Configuring Standard Firewall Filters in the Junos Policy Framework
Configuration Guide

2. Apply the filter to an interface. You can apply a stateless firewall to the input or
output sides, or both, of an interface.

■ To filter packets transiting the device, apply the firewall filter to any
non-Routing Engine interface.

■ To filter packets originating from, or destined for, the Routing Engine, apply
the firewall filter to the loopback (lo0) interface.

See Applying Firewall Filters to Interfaces in the Junos Policy Framework
Configuration Guide.

CAUTION: If a packet does not match any terms in a firewall filter rule, the packet
is discarded. Avoid configuring a stateless firewall filter that prevents you from
accessing the device after you commit the configuration. For example, if you configure
a firewall filter that does not match HTTP or HTTPS packets, you cannot access the
device with the J-Web interface.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

Stateless Firewall Filter Terms

■ Understanding Stateless Firewall Filter Terms on page 609

■ Stateless Firewall Filter Match Conditions on page 610

■ Stateless Firewall Filter Actions and Action Modifiers on page 615

Understanding Stateless Firewall Filter Terms

All stateless firewall filters contain one or more terms, and each term consists of two
components—match conditions and actions. The match conditions define the values
or fields that the packet must contain to be considered a match. If a packet is a
match, the corresponding action is taken. By default, a packet that does not match
a firewall filter is discarded.

NOTE: A firewall filter with a large number of terms can adversely affect both the
configuration commit time and the performance of the Routing Engine.
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Additionally, you can configure a stateless firewall filter within the term of another
filter. This method enables you to add common terms to multiple filters without
having to modify all filter definitions. You can configure one filter with the desired
common terms, and configure this filter as a term in other filters. Consequently, to
make a change in these common terms, you need to modify only one filter that
contains the common terms, instead of multiple filters.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ How Firewall Filters Are Evaluated in the Junos Policy Framework Configuration
Guide

■ Configuring Nested Firewall Filters in the Junos Policy Framework Configuration
Guide

Stateless Firewall Filter Match Conditions

Table 160 on page 610 and Table 161 on page 613 list the match conditions you can
specify in stateless firewall filter terms.

NOTE: When the device compares the stateless firewall filter match conditions to a
packet, it compares only the header fields specified in the match condition. There
is no implied protocol match. For example, if you specify a match of
destination-port ssh, the device checks for a value of 0x22 in the 2-byte field that is
two bytes after the IP packet header. The protocol field of the packet is not checked.

Table 160: IPv4 Stateless Firewall Filter Match Conditions

DescriptionMatch Condition

Numeric Range Match Conditions

Negates a match—for example, destination-port-except number.

The following keywords accept the -except extension: destination-port, dscp, esp-spi,
forwarding-class, fragment-offset, icmp-code, icmp-type, interface-group, ip-options,
packet-length, port, precedence, protocol, and source-port.

keyword-except

Matches a TCP or UDP destination port field. You cannot specify both the port and
destination-port match conditions in the same term. Normally, you specify this match
in conjunction with the protocol tcp or protocol udp match statement to determine which
protocol is being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify telnet or 23.

destination-port number

Matches an IPsec ESP SPI value. Match on this specific SPI value. You can specify the
ESP SPI value in hexadecimal, binary, or decimal form.

esp-spi spi-value

Matches a forwarding class. Specify assured-forwarding, best-effort, expedited-forwarding,
or network-control.

forwarding-class class
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Table 160: IPv4 Stateless Firewall Filter Match Conditions (continued)

DescriptionMatch Condition

Matches the fragment offset field.fragment-offset number

Matches the ICMP code field. Normally, you specify this match condition in conjunction
with the protocol icmp match statement to determine which protocol is being used on
the port.

This value or keyword provides more specific information than icmp-type. Because the
value's meaning depends on the associated icmp-type, you must specify icmp-type along
with icmp-code.

In place of the numeric value, you can specify a text synonym. For example, you can
specify ip-header-bad or 0.

icmp-code number

Matches the ICMP packet type field. Normally, you specify this match condition in
conjunction with the protocol icmp match statement to determine which protocol is
being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify time-exceeded or 11.

icmp-type number

Matches the interface group on which the packet was received. An interface group is
a set of one or more logical interfaces.

interface-group group-number

Matches the length of the received packet, in bytes. The length refers only to the IP
packet, including the packet header, and does not include any Layer 2 encapsulation
overhead.

packet-length bytes

Matches a TCP or UDP source or destination port field. You cannot specify both the
port match and either the destination-port or source-port match conditions in the same
term. Normally, you specify this match condition in conjunction with the protocol tcp
or protocol udp match statement to determine which protocol is being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify bgp or 179.

port number

Matches the IP precedence field. You can specify precedence in hexadecimal, binary,
or decimal form.

In place of the numeric value, you can specify a text synonym. For example, you can
specify immediate or 0x40.

precedence ip-precedence-field

Matches the IP protocol field. In place of the numeric value, you can specify a text
synonym. For example, you can specify ospf or 89.

protocol number

Matches the TCP or UDP source port field. You cannot specify the port and source-port
match conditions in the same term. Normally, you specify this match condition in
conjunction with the protocol tcp or protocol udp match statement to determine which
protocol is being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify http or 80.

source-port number

Address Match Conditions
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Table 160: IPv4 Stateless Firewall Filter Match Conditions (continued)

DescriptionMatch Condition

Matches the IP source or destination address field. You cannot specify both the address
and the destination-address or source-address match conditions in the same term.

address prefix

Matches the IP destination address field. You cannot specify the destination-address
and address match conditions in the same term.

destination-address prefix

Matches the IP destination prefix list field. You cannot specify the destination-prefix-list
and prefix-list match conditions in the same term.

destination-prefix-list prefix-list

Matches the IP source or destination prefix list field. You cannot specify both the
prefix-list and the destination-prefix-list or source-prefix-list match conditions in the same
term.

prefix-list prefix-list

Matches the IP source address field. You cannot specify the source-address and address
match conditions in the same rule.

source-address prefix

Matches the IP source prefix list field. You cannot specify the source-prefix-list and
prefix-list match conditions in the same term.

source-prefix-list prefix-list

Bit-Field Match Conditions with Values

Matches an IP fragmentation flag. In place of the numeric value, you can specify a text
synonym. For example, you can specify more-fragments or 0x2000.

fragment-flags number

Matches an IP option. In place of the numeric value, you can specify a text synonym.
For example, you can specify record-route or 7.

ip-options number

Matches a TCP flag. Normally, you specify this match condition in conjunction with
the protocol tcp match statement to determine which protocol is being used on the
port. In place of the numeric value, you can specify a text synonym. For example, you
can specify syn or 0x02.

tcp-flags number

Bit-Field Text Synonym Match Conditions

Matches the first fragment of a fragmented packet. This condition does not match
unfragmented packets.

first-fragment

Matches the trailing fragment of a fragmented packet. It does not match the first
fragment of a fragmented packet. To match both first and trailing fragments, you can
use two terms, or you can use fragment-offset 0-8191.

is-fragment

Matches a TCP packet other than the first packet of a connection. This match condition
is a synonym for "(ack | rst)".

This condition does not implicitly check that the protocol is TCP. To do so, specify the
protocol tcp match condition.

tcp-established

Matches the first TCP packet of a connection. This match condition is a synonym for
"(syn & !ack)".

This condition does not implicitly check that the protocol is TCP. To do so, specify the
protocol tcp match condition.

tcp-initial
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Table 161: IPv6 Stateless Firewall Filter Match Conditions

DescriptionMatch Condition

Numeric Range Match Conditions

Negates a match—for example, destination-port-except number.

The following keywords accept the -except extension: destination-port, dscp, esp-spi,
forwarding-class, fragment-offset, icmp-code, icmp-type, interface-group, ip-options,
packet-length, port, precedence, protocol, and source-port.

keyword-except

Matches a TCP or UDP destination port field. You cannot specify both the port and
destination-port match conditions in the same term. Normally, you specify this match
in conjunction with the protocol tcp or protocol udp match statement to determine which
protocol is being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify telnet or 23.

destination-port number

Matches the TCP or UDP source port field. You cannot specify the port and source-port
match conditions in the same term. Normally, you specify this match condition in
conjunction with the protocol tcp or protocol udp match statement to determine which
protocol is being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify http or 80.

source-port number

Matches a forwarding class. Specify assured-forwarding, best-effort, expedited-forwarding,
or network-control.

NOTE:

forwarding-class class

Matches the ICMP code field. Normally, you specify this match condition in conjunction
with the protocol icmp match statement to determine which protocol is being used on
the port.

This value or keyword provides more specific information than icmp-type. Because the
value's meaning depends on the associated icmp-type, you must specify icmp-type along
with icmp-code.

In place of the numeric value, you can specify a text synonym. For example, you can
specify ip-header-bad or 0.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

icmp-code number

Matches the ICMP packet type field. Normally, you specify this match condition in
conjunction with the protocol icmp match statement to determine which protocol is
being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify time-exceeded or 11.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

icmp-type number

Matches the interface group on which the packet was received. An interface group is
a set of one or more logical interfaces.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

interface-group group-number
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Table 161: IPv6 Stateless Firewall Filter Match Conditions (continued)

DescriptionMatch Condition

Matches the length of the received packet, in bytes. The length refers only to the IP
packet, including the packet header, and does not include any Layer 2 encapsulation
overhead.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

packet-length bytes

Matches a TCP or UDP source or destination port field. You cannot specify both the
port match and either the destination-port or source-port match conditions in the same
term. Normally, you specify this match condition in conjunction with the protocol tcp
or protocol udp match statement to determine which protocol is being used on the port.

In place of the numeric value, you can specify a text synonym. For example, you can
specify bgp or 179.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

port number

Address Match Conditions

Matches the IP destination address field. You cannot specify the destination-address
and address match conditions in the same term.

destination-address prefix

Matches the IP source address field. You cannot specify the source-address and address
match conditions in the same rule.

source-address prefix

Bit-Field Match Conditions with Values

Matches a TCP flag. Normally, you specify this match condition in conjunction with
the protocol tcp match statement to determine which protocol is being used on the
port. In place of the numeric value, you can specify a text synonym. For example, you
can specify syn or 0x02.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

tcp-flags number

Bit-Field Text Synonym Match Conditions

Matches a TCP packet other than the first packet of a connection. This match condition
is a synonym for "(ack | rst)".

This condition does not implicitly check that the protocol is TCP. To do so, specify the
protocol tcp match condition.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

tcp-established

Matches the first TCP packet of a connection. This match condition is a synonym for
"(syn & !ack)".

This condition does not implicitly check that the protocol is TCP. To do so, specify the
protocol tcp match condition.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

tcp-initial
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To specify a bit-field match condition with values, such as tcp-flags, you must enclose
the values in quotation marks (“ “). You can use bit-field logical operators to create
expressions that are evaluated for matches. For example, if the following expression
is used in a filter term, a match occurs if the packet is the initial packet of a TCP
session:

tcp-flags “syn & !ack”

You can use text synonyms to specify some common bit-field matches. In the previous
example, you can specify tcp-initial as the same match condition.

NOTE:

Some of the numeric range and bit-field match conditions allow you to specify a text
synonym. For a complete list of synonyms:

■ If you are using the J-Web interface, select the synonym from the appropriate
list.

■ If you are using the CLI, type a question mark (?) after the from statement.

Table 162 on page 615 lists the bit-field logical operators in order of highest to lowest
precedence.

Table 162: Stateless Firewall Filter Bit-Field Logical Operators

DescriptionLogical Operator

Grouping(...)

Negation!

Logical AND& or +

Logical OR| or ,

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Configuring IPv4 Match Conditions in the Junos Policy Framework Configuration
Guide

■ Configuring IPv6 Match Conditions in the Junos Policy Framework Configuration
Guide

■ How to Specify Firewall Filter Match Conditions in the Junos Policy Framework
Configuration Guide

Stateless Firewall Filter Actions and Action Modifiers

Table 163 on page 616 and Table 164 on page 616 list the actions and action modifiers
you can specify in stateless firewall filter terms.
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Table 163: IPv4 Stateless Firewall Filter Actions and Action Modifiers

DescriptionAction or Action Modifier

Accepts a packet. This is the default if the packet matches. However, we strongly recommend
that you always explicitly configure an action in the then statement.

accept

Discards a packet silently, without sending an ICMP message. Packets are available for logging
and sampling before being discarded.

discard

Continues to the next term for evaluation.next term

Discards a packet, sending an ICMP destination unreachable message. Rejected packets are
available for logging and sampling. You can specify one of the following message types:
administratively-prohibited (default), bad-host-tos, bad-network-tos, host-prohibited, host-unknown,
host-unreachable, network-prohibited, network-unknown, network-unreachable, port-unreachable,
precedence-cutoff, precedence-violation, protocol-unreachable, source-host-isolated, source-route-failed,
or tcp-reset. If you specify tcp-reset, a TCP reset is returned (indicating the end of a TCP flow), if
the packet is a TCP packet. Otherwise, nothing is returned.

reject message-type

Routes the packet using the specified routing instance.routing-instance
routing-instance

Action Modifiers

Counts the number of packets passing this term. The name can contain letters, numbers, and
hyphens (-), and can be up to 24 characters long. A counter name is specific to the filter that
uses it, so all interfaces that use the same filter increment the same counter.

count counter-name

Classifies the packet to the specified forwarding class.forwarding-class class-name

Logs the packet's header information in the Routing Engine. You can access this information by
entering the CLI show firewall log command.

log

Sets the scheduling priority of the packet. The priority can be low or high.loss-priority priority

Updates a bit field in the packet key buffer, which specifies traffic that will bypass flow-based
forwarding. Packets with the packet-mode action modifier follow the packet-based forwarding
path and bypass flow-based forwarding completely. For more information about selective stateless
packet-based services, see the JUNOS Software Administration Guide.

packet-mode

Applies rate limits to the traffic using the named policer.policer policer-name

Samples the traffic on the interface. Use this modifier only when traffic sampling is enabled. See
the JUNOS Policy Framework Configuration Guide.

sample

Records information in the system logging facility. This action can be used in conjunction with
all options except discard.

syslog

Table 164: IPV6 Stateless Firewall Filter Actions and Action Modifiers

DescriptionAction or Action Modifier

Accepts a packet. This is the default if the packet matches. However, we strongly recommend
that you always explicitly configure an action in the then statement.

accept
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Table 164: IPV6 Stateless Firewall Filter Actions and Action Modifiers (continued)

DescriptionAction or Action Modifier

Discards a packet silently, without sending an ICMP message. Packets are available for logging
and sampling before being discarded.

discard

Continues to the next term for evaluation.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

next term

Discards a packet, sending an ICMP destination unreachable message. Rejected packets are
available for logging and sampling. You can specify one of the following message types:
administratively-prohibited (default), bad-host-tos, bad-network-tos, host-prohibited, host-unknown,
host-unreachable, network-prohibited, network-unknown, network-unreachable, port-unreachable,
precedence-cutoff, precedence-violation, protocol-unreachable, source-host-isolated, source-route-failed,
or tcp-reset. If you specify tcp-reset, a TCP reset is returned (indicating the end of a TCP flow), if
the packet is a TCP packet. Otherwise, nothing is returned.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

reject message-type

Routes the packet using the specified routing instance.

In filter-based forwarding, the IPv6 filter does not identify fragmented IPv6 packets and does
not forward them to routing instances other than those used by normal packets.

routing-instance
routing-instance

Action Modifiers

Counts the number of packets passing this term. The name can contain letters, numbers, and
hyphens (-), and can be up to 24 characters long. A counter name is specific to the filter that
uses it, so all interfaces that use the same filter increment the same counter.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

count counter-name

Sets the scheduling priority of the packet. The priority can be low, high,  medium high, or  medium
low.

loss-priority priority

Logs the packet's header information in the Routing Engine. You can access this information by
entering the CLI show firewall log command.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

log

Classifies the packet to the specified forwarding class.forwarding-class class-name

Applies rate limits to the traffic using the named policer.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

policer policer-name

Records information in the system-logging facility. This action can be used in conjunction with
all options except discard.

NOTE: Applies to SRX100, SRX210, SRX240, and SRX650 devices only.

syslog

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Configuring Actions in Firewall Filter Terms in the Junos Policy Framework
Configuration Guide
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Trusted Source Stateless Firewall Filters

■ Understanding Trusted Source Stateless Firewall Filters on page 618

■ Example: Configuring a Stateless Firewall Filter to Accept Traffic from Trusted
Sources on page 618

Understanding Trusted Source Stateless Firewall Filters

You can create a stateless firewall filter that specifies which protocols and services,
or applications, are allowed to reach the Routing Engine. Applying this type of filter
ensures that packets are from a trusted source and protects the processes running
on the Routing Engine from an external attack.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Example: Blocking Telnet and SSH Access in the Junos Policy Framework
Configuration Guide

■ Example: Blocking TFTP Access in the Junos Policy Framework Configuration
Guide

■ Example: Accepting OSPF Packets from Certain Addresses in the Junos Policy
Framework Configuration Guide

■ Example: Accepting DHCP Packets with Specific Addresses in the Junos Policy
Framework Configuration Guide

Example: Configuring a Stateless Firewall Filter to Accept Traffic from Trusted Sources

This example shows how to create a stateless firewall filter that protects the Routing
Engine from traffic originating from untrusted sources.

■ Requirements on page 618

■ Overview on page 619

■ Configuration on page 619

■ Verification on page 621

Requirements

No special configuration beyond device initialization is required before configuring
stateless firewall filters.
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Overview

In this example, you create a stateless firewall filter called protect-RE that discards
all traffic destined for the Routing Engine except SSH and BGP protocol packets from
specified trusted sources. This example includes the following firewall filter terms:

■ ssh-term—Accepts TCP packets with a source address of 192.168.122.0/24 and
a destination port that specifies SSH.

■ bgp-term—Accepts TCP packets with a source address of 10.2.1.0/24 and a
destination port that specifies BGP.

■ discard-rest-term—For all packets that are not accepted by ssh-term or bgp-term,
creates a firewall filter log and system logging records, then discards all packets.

NOTE: You can move terms within the firewall filter using the insert command. See
insert in the Junos CLI User Guide.

Configuration

CLI Quick Configuration To quickly configure the stateless firewall filter, copy the following commands and
paste them into the CLI.

[edit]
set firewall family inet filter protect-RE term ssh-term from source-address

192.168.122.0/24
set firewall family inet filter protect-RE term ssh-term from protocol tcp
set firewall family inet filter protect-RE term ssh-term from destination-port ssh
set firewall family inet filter protect-RE term ssh-term then accept
set firewall family inet filter protect-RE term bgp-term from source-address

10.2.1.0/24
set firewall family inet filter protect-RE term bgp-term from protocol tcp
set firewall family inet filter protect-RE term bgp-term from destination-port bgp
set firewall family inet filter protect-RE term bgp-term then accept
set firewall family inet filter protect-RE term discard-rest-term then log
set firewall family inet filter protect-RE term discard-rest-term then syslog
set firewall family inet filter protect-RE term discard-rest-term then discard
set interfaces lo0 unit 0 family inet filter input protect-RE

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To configure the stateless firewall filter:

1. Create the stateless firewall filter.

[edit]
user@host# edit firewall family inet filter protect-RE
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2. Create the first filter term.

[edit firewall family inet filter protect-RE]
user@host# edit term ssh-term

3. Define the protocol, destination port, and source address match conditions for
the term.

[edit firewall family inet filter protect-RE term ssh-term]
user@host# set from protocol tcp destination-port ssh source-address

192.168.122.0/24

4. Define the actions for the term.

[edit firewall family inet filter protect-RE term ssh-term]
user@host# set then accept

5. Create the second filter term.

[edit firewall family inet filter protect-RE]
user@host# edit term bgp-term

6. Define the protocol, destination port, and source address match conditions for
the term.

[edit firewall family inet filter protect-RE term bgp-term]
user@host# set from protocol tcp destination-port bgp source-address

10.2.1.0/24

7. Define the action for the term.

[edit firewall family inet filter protect-RE term bgp-term]
user@host# set then accept

8. Create the third filter term.

[edit firewall family inet filter protect-RE]
user@host# edit term discard-rest-term

9. Define the action for the term.

[edit firewall family inet filter protect-RE term discard-rest]
user@host# set then log syslog discard

10. Apply the filter to the input side of the Routing Engine interface.

[edit]
user@host# set interfaces lo0 unit 0 family inet filter input protect-RE

Results Confirm your configuration by entering the show firewall command and the show
interfaces lo0 command from configuration mode. If the output does not display the
intended configuration, repeat the configuration instructions in this example to
correct it.

user@host# show firewall
family inet {

filter protect-RE {
term ssh-term {
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from {
source-address {

192.168.122.0/24;
}
protocol tcp;
destination-port ssh;

}
then accept;

}
term bgp-term {

from {
source-address {

10.2.1.0/24;
}
protocol tcp;
destination-port bgp;

}
then accept;

}
term discard-rest-term {

then {
log;
syslog;
discard;

}
}

}
}

user@host# show interfaces lo0
unit 0 {

family inet {
filter {

input protect-RE;
}
address 127.0.0.1/32;

}
}

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Displaying Stateless Firewall Filter Configurations on page 621

■ Verifying a Services, Protocols, and Trusted Sources Firewall Filter on page 622

■ Displaying Stateless Firewall Filter Logs on page 622

Displaying Stateless Firewall Filter Configurations

Purpose Verify the configuration of the firewall filter.
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Action From configuration mode, enter the show firewall command and the show interfaces
lo0 command.

Meaning Verify that the output shows the intended configuration of the firewall filter. In
addition, verify that the terms are listed in the order in which you want the packets
to be tested. You can move terms within a firewall filter by using the insert CLI
command.

Verifying a Services, Protocols, and Trusted Sources Firewall Filter

Purpose Verify that the actions of the firewall filter terms are taken.

Action Send packets to the device that match the terms. In addition, verify that the filter
actions are not taken for packets that do not match.

■ Use the ssh host-name command from a host at an IP address that matches
192.168.122.0/24 to verify that you can log in to the device using only SSH
from a host with this address prefix.

■ Use the show route summary command to verify that the routing table on the
device does not contain any entries with a protocol other than Direct, Local, BGP,
or Static.

Sample Output % ssh 192.168.249.71
%ssh host
user@host's password: 
--- JUNOS 6.4-20040518.0 (JSERIES) #0: 2004-05-18 09:27:50 UTC

user@host>

user@host> show route summary
Router ID: 192.168.249.71

inet.0: 34 destinations, 34 routes (33 active, 0 holddown, 1 hidden)
              Direct:     10 routes,      9 active
               Local:      9 routes,      9 active
                 BGP:     10 routes,     10 active
              Static:      5 routes,      5 active
...

Meaning Verify the following information:

■ You can successfully log in to the device using SSH.

■ The show route summary command does not display a protocol other than Direct,
Local, BGP, or Static.

Displaying Stateless Firewall Filter Logs

Purpose Verify that packets are being logged. If you included the log or syslog action in a
term, verify that packets matching the term are recorded in the firewall log or your
system logging facility.
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Action From operational mode, enter the show firewall log command.

Sample Output user@host> show firewall log
Log :
Time      Filter    Action Interface     Protocol Src Addr      Dest Addr
15:11:02  pfe       D      ge-0/0/0.0    TCP      172.17.28.19  192.168.70.71
15:11:01  pfe       D      ge-0/0/0.0    TCP      172.17.28.19  192.168.70.71
15:11:01  pfe       D      ge-0/0/0.0    TCP      172.17.28.19  192.168.70.71
15:11:01  pfe       D      ge-0/0/0.0    TCP      172.17.28.19  192.168.70.71
...

Meaning Each record of the output contains information about the logged packet. Verify the
following information:

■ Under Time, the time of day the packet was filtered is shown.

■ The Filter output is always pfe.

■ Under Action, the configured action of the term matches the action taken on the
packet—A (accept), D (discard), R (reject).

■ Under Interface, the inbound (ingress) interface on which the packet arrived is
appropriate for the filter.

■ Under Protocol, the protocol in the IP header of the packet is appropriate for the
filter.

■ Under Src Addr, the source address in the IP header of the packet is appropriate
for the filter.

■ Under Dest Addr, the destination address in the IP header of the packet is
appropriate for the filter.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ show route summary in the Junos Routing Protocols and Policies Command
Reference

■ show firewall in the Junos Routing Protocols and Policies Command Reference

■ show firewall log in the Junos Routing Protocols and Policies Command Reference

■ show interfaces (Loopback) in the Junos Interfaces Command Reference

Flood Prevention Stateless Firewall Filters

■ Understanding Flood Prevention Stateless Firewall Filters on page 624

■ Example: Configuring a Stateless Firewall Filter to Protect Against TCP and ICMP
Floods on page 624

Flood Prevention Stateless Firewall Filters ■ 623
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Understanding Flood Prevention Stateless Firewall Filters

You can create stateless firewall filters that limit certain TCP and ICMP traffic destined
for the Routing Engine. A router without this kind of protection is vulnerable to TCP
and ICMP flood attacks—also called denial-of-service (DoS) attacks. For example:

■ A TCP flood attack of SYN packets initiating connection requests can overwhelm
the device until it can no longer process legitimate connection requests, resulting
in denial of service.

■ An ICMP flood can overload the device with so many echo requests (ping requests)
that it expends all its resources responding and can no longer process valid
network traffic, also resulting in denial of service.

Applying the appropriate firewall filters to the Routing Engine protects against these
types of attacks.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Example: Blocking TCP Connections to a Certain Port Except from BGP Peers in
the Junos Policy Framework Configuration Guide

■ Example: Accepting Packets with Specific IPv6 TCP Flags in the Junos Policy
Framework Configuration Guide

■ Example: Defining a Policer for a Destination Class in the Junos Policy Framework
Configuration Guide

Example: Configuring a Stateless Firewall Filter to Protect Against TCP and ICMP Floods

This example shows how to create a stateless firewall filter that protects against TCP
and ICMP denial-of-service attacks.

■ Requirements on page 624

■ Overview on page 625

■ Configuration on page 626

■ Verification on page 629

Requirements

No special configuration beyond device initialization is required before configuring
stateless firewall filters.
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Overview

In this example, you create a stateless firewall filter called protect-RE that polices
TCP and ICMP packets. This example includes the following policers:

■ tcp-connection-policer—Limits the traffic rate of the TCP packets to 500,000 bps
and the burst size to 15,000 bytes. Packets that exceed the traffic rate are
discarded.

■ icmp-policer—Limits the traffic rate of the ICMP packets to 1,000,000 bps and
the burst size to 15,000 bytes. Packets that exceed the traffic rate are discarded.

When specifying limits, the bandwidth limit can be from 32,000 bps to
32,000,000,000 bps and the burst size limit can be from 1,500 bytes through
100,000,000 bytes. Use the following abbreviations when specifying limits: k (1,000),
m (1,000,000), and g (1,000,000,000).

Each policer is incorporated into the action of a filter term. This example includes
the following terms:

■ tcp-connection-term—Polices certain TCP packets with a source address of
192.168.122.0/24 or 10.2.1.0/24. These addresses are defined in the
trusted-addresses prefix list.

Policed packets include connection request packets (SYN and ACK flag bits equal
1 and 0), connection release packets (FIN flag bit equals 1), and connection reset
packets (RST flag bit equals 1).

■ icmp-term—Polices echo request packets, echo response packets, unreachable
packets, and time-exceeded packets. All of these ICMP packets are counted in
the icmp-counter counter.

NOTE: You can move terms within the firewall filter using the insert command. See
insert in the Junos CLI User Guide.

If you want to include the terms created in this procedure in the protect-RE firewall
filter configured in “Example: Configuring a Stateless Firewall Filter to Accept Traffic
From Trusted Sources” on page 618, perform the configuration tasks in this example
first, then configure the terms as described in “Example: Configuring a Stateless
Firewall Filter to Accept Traffic From Trusted Sources” on page 618. This approach
ensures that the rate-limiting terms are included as the first two terms in the firewall
filter.

NOTE: You can move terms within the firewall filter using the insert command. See
insert in the Junos CLI User Guide.
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Configuration

CLI Quick Configuration To quickly configure the stateless firewall filter, copy the following commands and
paste them into the CLI.

[edit]
set firewall family inet filter protect-RE term tcp-connection-term from

source-prefix-list trusted-addresses
set firewall family inet filter protect-RE term tcp-connection-term from protocol tcp
set firewall family inet filter protect-RE term tcp-connection-term from tcp-flags

"(syn & !ack) | fin | rst"
set firewall family inet filter protect-RE term tcp-connection-term then policer

tcp-connection-policer
set firewall family inet filter protect-RE term tcp-connection-term then accept
set firewall family inet filter protect-RE term icmp-term from protocol icmp
set firewall family inet filter protect-RE term icmp-term from icmp-type echo-request
set firewall family inet filter protect-RE term icmp-term from icmp-type echo-reply
set firewall family inet filter protect-RE term icmp-term from icmp-type unreachable
set firewall family inet filter protect-RE term icmp-term from icmp-type time-exceeded
set firewall family inet filter protect-RE term icmp-term then policer icmp-policer
set firewall family inet filter protect-RE term icmp-term then count icmp-counter
set firewall family inet filter protect-RE term icmp-term then accept
set firewall policer tcp-connection-policer filter-specific
set firewall policer tcp-connection-policer if-exceeding bandwidth-limit 1m
set firewall policer tcp-connection-policer if-exceeding burst-size-limit 15k
set firewall policer tcp-connection-policer then discard
set firewall policer icmp-policer filter-specific
set firewall policer icmp-policer if-exceeding bandwidth-limit 1m
set firewall policer icmp-policer if-exceeding burst-size-limit 15k
set firewall policer icmp-policer then discard
set policy-options prefix-list trusted-addresses 10.2.1.0/24
set policy-options prefix-list trusted-addresses 192.168.122.0/24

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To configure stateless firewall filter policers:

1. Define the first policer.

[edit]
user@host# edit firewall policer tcp-connection-policer

2. Define the action for the policer.

[edit firewall policer tcp-connection-policer]
user@host# set then discard

3. Define the rate limits for the policer.

[edit firewall policer tcp-connection-policer]
user@host# set filter-specific if-exceeding burst-size-limit 15k

bandwidth-limit 500k
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4. Define the second policer.

[edit]
user@host# edit firewall policer imcp-policer

5. Define the action for the policer.

[edit firewall policer icmp-policer]
user@host# set then discard

6. Set the rate limits for the policer.

[edit firewall policer imcp-policer]
user@host# set filter-specific if-exceeding burst-size-limit 15k

bandwidth-limit 1m

7. Define the prefix list.

[edit]
user@host# set policy-options prefix-list trusted-addresses 192.168.122.0/24
user@host# set policy-options prefix-list trusted-addresses 10.2.1.0/24

8. Create the stateless firewall filter.

[edit]
user@host# edit firewall family inet filter protect-RE

9. Define the first term for the filter.

[edit firewall family inet filter protect-RE]
user@host# edit term tcp-connection-term

10. Define the source address match condition for the term.

[edit firewall family inet filter protect-RE term tcp-connection-term]
user@host# set from source-prefix-list trusted-addresses

11. Define protocol match conditions for the term.

[edit firewall family inet filter protect-RE term tcp-connection-term]
user@host# set from protocol tcp tcp-flags "(syn & !ack) | fin | rst"

12. Define the actions for the term.

[edit firewall family inet filter protect-RE term tcp-connection-term]
user@host# set then policer tcp-connection-policer accept

13. Define the second term.

[edit]
user@host# edit firewall family inet filter protect-RE term icmp-term

14. Define the protocol for the term.

[edit firewall family inet filter protect-RE term icmp-term]
user@host# set from protocol icmp

15. Define the match conditions for the term.

[edit firewall family inet filter protect-RE term icmp-term]
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user@host# set from icmp-type [echo-request echo-reply unreachable
time-exceeded]

16. Define the action for the term.

[edit firewall family inet filter protect-RE term icmp-term]
user@host# set then policer icmp-policer count icmp-counter accept

Results Confirm your configuration by entering the show firewall command and the show
policy-options command from configuration mode. If the output does not display the
intended configuration, repeat the configuration instructions in this example to
correct it.

user@host# show firewall
family inet {

filter protect-RE {
term tcp-connection-term {

from {
source-prefix-list {

trusted-addresses;
}
protocol tcp;
tcp-flags "(syn & !ack) | fin | rst";

}
then {

policer tcp-connection-policer;
accept;

}
}
term icmp-term {

from {
protocol icmp;
icmp-type [ echo-request echo-reply unreachable time-exceeded ];

}
then {

policer icmp-policer;
count icmp-counter;
accept;

}
}

}
}

policer tcp-connection-policer {
filter-specific;
if-exceeding {

bandwidth-limit 1m;
burst-size-limit 15k;

}
then discard;

}
policer icmp-policer {

filter-specific;
if-exceeding {
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bandwidth-limit 1m;
burst-size-limit 15k;

}
then discard;

}

user@host# show policy-options
prefix-list trusted-addresses {

10.2.1.0/24;
192.168.122.0/24;

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Displaying Stateless Firewall Filter Configurations on page 629

■ Verifying a TCP and ICMP Flood Firewall Filter on page 629

■ Displaying Firewall Filter Statistics on page 630

Displaying Stateless Firewall Filter Configurations

Purpose Verify the configuration of the firewall filter.

Action From configuration mode, enter the show firewall command.

Meaning Verify that the output shows the intended configuration of the firewall filter. In
addition, verify that the terms are listed in the order in which you want the packets
to be tested. You can move terms within a firewall filter by using the insert CLI
command.

Verifying a TCP and ICMP Flood Firewall Filter

Purpose Verify that the actions of the firewall filter terms are taken.

Action Send packets to the device that match the terms. In addition, verify that the filter
actions are not taken for packets that do not match.

■ Verify that the device can establish only TCP sessions with a host at an IP address
that matches 192.168.122.0/24 or 10.2.1.0/24. For example, log in to the
device with the telnet host-name command from another host with one of these
address prefixes.

■ Use the ping host-name command to verify that the device responds only to ICMP
packets (such as ping requests) that do not exceed the policer traffic rates.

■ Use the ping host-name size bytes command to exceed the policer traffic rates by
sending ping requests with large data payloads.

Sample Output user@host> telnet 192.168.249.71
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Trying 192.168.249.71...
Connected to host.acme.net.
Escape character is '^]'.

host (ttyp0)

login: user
Password:

--- JUNOS 6.4-20040521.1 built 2004-05-21 09:38:12 UTC

user@host> 

user@host> ping 192.168.249.71
PING host-ge-000.acme.net (192.168.249.71): 56 data bytes
64 bytes from 192.168.249.71: icmp_seq=0 ttl=253 time=11.946 ms
64 bytes from 192.168.249.71: icmp_seq=1 ttl=253 time=19.474 ms
64 bytes from 192.168.249.71: icmp_seq=2 ttl=253 time=14.639 ms
...

user@host> ping 192.168.249.71 size 20000
PING host-ge-000.acme.net (192.168.249.71): 20000 data bytes
^C
--- host-ge-000.acme.net ping statistics ---
12 packets transmitted, 0 packets received, 100% packet loss

Meaning Verify the following information:

■ You can successfully log in to the device using Telnet.

■ The device sends responses to the ping host command.

■ The device does not send responses to the ping host size 20000 command.

Displaying Firewall Filter Statistics

Purpose Verify that packets are being policed and counted.

Action From operational mode, enter the show firewall filter filter-name command.

Sample Output user@host> show firewall filter protect-RE
Filter: protect-RE                                                  
Counters:
Name                                                Bytes              Packets
icmp-counter                                      1040000                 5600
Policers:
Name                                              Packets 
tcp-connection-policer                          643254873
icmp-policer                                         7391

Meaning Verify the following information:

■ Next to Filter, the name of the firewall filter is correct.

■ Under Counters:
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■ Under Name, the names of any counters configured in the firewall filter are
correct.

■ Under Bytes, the number of bytes that match the filter term containing the
count counter-name action are shown.

■ Under Packets, the number of packets that match the filter term containing
the count counter-name action are shown.

■ Under Policers:

■ Under Name, the names of any policers configured in the firewall filter are
correct.

■ Under Packets, the number of packets that match the conditions specified
for the policer are shown.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ show firewall in the Junos Routing Protocols and Policies Command Reference

■ ping in the Junos System Basics and Services Command Reference.

■ telnet in the Junos System Basics and Services Command Reference.

Fragment Handling Stateless Firewall Filters

■ Understanding Fragment Handling Stateless Firewall Filters on page 631

■ Example: Configuring a Stateless Firewall Filter to Handle Fragments on page 632

■ Example: Configuring a Filter to Match on IPv6 Flags on page 636

Understanding Fragment Handling Stateless Firewall Filters

You can create stateless firewall filters that handle fragmented packets destined for
the Routing Engine. By applying these policies to the Routing Engine, you protect
against the use of IP fragmentation as a means to disguise TCP packets from a firewall
filter.

For example, consider an IP packet that is fragmented into the smallest allowable
fragment size of 8 bytes (a 20-byte IP header plus an 8-byte payload). If this IP packet
carries a TCP packet, the first fragment (fragment offset of 0) that arrives at the
device contains only the TCP source and destination ports (first 4 bytes), and the
sequence number (next 4 bytes). The TCP flags, which are contained in the next 8
bytes of the TCP header, arrive in the second fragment (fragment offset of 1).

See RFC 1858, Security Considerations for IP Fragment Filtering.
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Example: Configuring a Stateless Firewall Filter to Handle Fragments

This example shows how to create a stateless firewall filter that handles packet
fragments.

■ Requirements on page 632

■ Overview on page 632

■ Configuration on page 632

■ Verification on page 635

Requirements

No special configuration beyond device initialization is required before configuring
stateless firewall filters.

Overview

In this example, you create a stateless firewall filter called fragment-RE that handles
fragmented packets. This example includes the following firewall filter terms:

■ small-offset-term—Discards small (1–5) offset packets to ensure that subsequent
terms in the firewall filter can be matched against all the headers in the packet.
In addition, the term adds a record to the system logging facility.

■ not-fragmented-term—Accepts unfragmented TCP packets with a source address
of 10.2.1.0/24 and a destination port that specifies the BGP protocol. A packet
is considered unfragmented if its MF flag and its fragment offset in the TCP
header equal 0.

■ first-fragment-term—Accepts the first fragment of a fragmented TCP packet with
a source address of 10.2.1.0/24 and a destination port that specifies the BGP
protocol.

■ fragment-term—Accepts all fragments that were not discarded by small-offset-term.
(packet fragments 6–8191). However, only those fragments that are part of a
packet containing a first fragment accepted by first-fragment-term are reassembled
by the device.

Packet fragments offset can be from 1 through 8191.

NOTE: You can move terms within the firewall filter using the insert command. See
insert in the Junos CLI User Guide.

Configuration

CLI Quick Configuration To quickly configure the stateless firewall filter, copy the following commands and
paste them into the CLI.

[edit]
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set firewall family inet filter fragment-RE term small-offset-term from fragment-offset
1-5

set firewall family inet filter fragment-RE term small-offset-term then syslog
set firewall family inet filter fragment-RE term small-offset-term then discard
set firewall family inet filter fragment-RE term not-fragmented-term from

source-address 10.2.1.0/24
set firewall family inet filter fragment-RE term not-fragmented-term from

fragment-offset 0
set firewall family inet filter fragment-RE term not-fragmented-term from

fragment-flags 0x0
set firewall family inet filter fragment-RE term not-fragmented-term from protocol

tcp
set firewall family inet filter fragment-RE term not-fragmented-term from

destination-port bgp
set firewall family inet filter fragment-RE term not-fragmented-term then accept
set firewall family inet filter fragment-RE term first-fragment-term from source-address

10.2.1.0/24
set firewall family inet filter fragment-RE term first-fragment-term from first-fragment
set firewall family inet filter fragment-RE term first-fragment-term from protocol tcp
set firewall family inet filter fragment-RE term first-fragment-term from

destination-port bgp
set firewall family inet filter fragment-RE term first-fragment-term then accept
set firewall family inet filter fragment-RE term fragment-term from fragment-offset

6-8191
set firewall family inet filter fragment-RE term fragment-term then accept

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To configure the stateless firewall filter:

1. Define the stateless firewall filter.

[edit]
user@host# edit firewall family inet filter fragment-RE

2. Define the first term for the filter.

[edit firewall family inet filter fragment-RE]
user@host# edit term small-offset-term

3. Define the match conditions for the term.

[edit firewall family inet filter fragment-RE term small-offset-term]
user@host# set from fragment-offset 1-5

4. Define the action for the term.

[edit firewall family inet filter fragment-RE term small-offset-term]
user@host# set then syslog discard

5. Define the second term for the filter.

[edit]
user@host# edit firewall family inet filter fragment-RE term not-fragmented-term
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6. Define the match conditions for the term.

[edit firewall family inet filter fragment-RE term not-fragmented-term]
user@host# set from fragment-flags 0x0 fragment-offset 0 protocol tcp

destination-port bgp source-address 10.2.1.0/24

7. Define the action for the term.

[edit firewall family inet filter fragment-RE term not-fragmented-term]
user@host# set then accept

8. Define the third term for the filter.

[edit]
user@host# edit firewall family inet filter fragment-RE term first-fragment-term

9. Define the match conditions for the term.

[edit firewall family inet filter fragment-RE term first-fragment-term]
user@host# set from first-fragment protocol tcp destination-port bgp

source-address 10.2.1.0/24

10. Define the action for the term.

[edit firewall family inet filter fragment-RE term first-fragment-term]
user@host# set then accept

11. Define the last term for the filter.

[edit]
user@host# edit firewall family inet filter fragment-RE term fragment-term

12. Define the match conditions for the term.

[edit firewall family inet filter fragment-RE term fragment-term]
user@host# set from fragment-offset 6–8191

13. Define the action for the term.

[edit firewall family inet filter fragment-RE term fragment-term]
user@host# set then accept

Results Confirm your configuration by entering the show firewall command from configuration
mode. If the output does not display the intended configuration, repeat the
configuration instructions in this example to correct it.

user@host# show firewall
family inet {

filter fragment-RE {
term small-offset-term {

from {
fragment-offset 1-5;

}
then {

syslog;
discard;

}
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}
term not-fragmented-term {

from {
source-address {

10.2.1.0/24;
}
fragment-offset 0;
fragment-flags 0x0;
protocol tcp;
destination-port bgp;

}
then accept;

}
term first-fragment-term {

from {
source-address {

10.2.1.0/24;
}
first-fragment;
protocol tcp;
destination-port bgp;

}
then accept;

}
term fragment-term {

from {
fragment-offset 6-8191;

}
then accept;

}
}

}

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Displaying Stateless Firewall Filter Configurations on page 635

■ Verifying a Firewall Filter that Handles Fragments on page 636

Displaying Stateless Firewall Filter Configurations

Purpose Verify the configuration of the firewall filter. You can analyze the flow of the filter
terms by displaying the entire configuration.

Action From configuration mode, enter the show firewall command.

Meaning Verify that the output shows the intended configuration of the firewall filter. In
addition, verify that the terms are listed in the order in which you want the packets
to be tested. You can move terms within a firewall filter by using the insert CLI
command.
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Verifying a Firewall Filter that Handles Fragments

Purpose Verify that the actions of the firewall filter terms are taken.

Action Send packets to the device that match the terms. In addition, verify that the filter
actions are not taken for packets that do not match.

■ Verify that packets with small fragment offsets are recorded in the router's system
logging facility.

■ Use the show route summary command to verify that the routing table does not
contain any entries with a protocol other than Direct, Local, BGP, or Static.

Sample Output user@host> show route summary
Router ID: 192.168.249.71

inet.0: 34 destinations, 34 routes (33 active, 0 holddown, 1 hidden)
              Direct:     10 routes,      9 active
               Local:      9 routes,      9 active
                 BGP:     10 routes,     10 active
              Static:      5 routes,      5 active
...

Meaning Verify that the show route summary command does not display a protocol other than
Direct, Local, BGP, or Static.

Related Topics show route summary  in the JUNOS Routing Protocols and Policies Command Reference.

Example: Configuring a Filter to Match on IPv6 Flags

This example shows how to configure a filter to match on IPv6 TCP flags.

■ Requirements on page 636

■ Overview on page 636

■ Configuration on page 637

■ Verification on page 637

Requirements

No special configuration beyond device initialization is required before configuring
stateless firewall filters.

Overview

In this example, you configure a filter to match on IPv6 TCP flags. You can use this
example to configure IPv6 TCP flags in the SRX100, SRX210, SRX240, SRX650, and
J Series devices.
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Configuration

Step-by-Step Procedure To configure a filter to match on IPv6 TCP flags:

1. Include the family statement at the firewall hierarchy level, specifying inet6 as
the protocol family.

[edit]
user@host# firewall family inet6

2. Create the stateless firewall filter.

[edit firewall family inet6]
user@host# filter tcpfilt

3. Define the first term for the filter.

[edit edit firewall family inet6 filter tcpfilt]
user@host# term 1

4. Define the source address match conditions for the term.

[edit firewall family inet6 filter tcpfilt term 1]
user@host# from next-header tcp tcp-flags syn

5. Define the actions for the term.

[edit firewall family inet6 filter tcpfilt term 1 from next-header tcp tcp-flags syn]
user@host# then count tcp_syn_pkt log accept

6. If you are done configuring the device, commit the configuration.

[edit]
user@host# commit

Verification

To verify that the configuration is working properly, enter the show firewall filter tcpfilt
command.
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Part 4

Layer 2 Bridging and Switching

■ Configuring Ethernet Ports for Switching on page 641

■ Configuring Layer 2 Bridging and Transparent Mode on page 675
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Chapter 25

Configuring Ethernet Ports for Switching

Certain ports on Juniper Networks devices can function as Ethernet access switches
that switch traffic at Layer 2 and route traffic at Layer 3.

For information about Ethernet link aggregation for SRX3000 and SRX5000 line
devices, see the “Aggregated Ethernet” chapter of the Junos OS Interfaces Configuration
Guide for Security Devices.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Ethernet Ports Switching Overview on page 641

■ Switching Features Overview on page 642

■ Understanding Switching Modes on the J Series Services Router on page 653

■ Connecting J Series uPIMs in a Daisy-Chain on page 654

■ Configuring Switching Modes on J Series uPIMs on page 654

■ Verifying Switching Mode Configuration on J Series uPIMs on page 656

■ Configuring Enhanced Switching Mode Features on page 657

Ethernet Ports Switching Overview

You can deploy supported devices in branch offices as an access or desktop switch
with integrated routing capability, thus eliminating intermediate access switch devices
from your network topology. The Ethernet ports provide switching while the Routing
Engine provides routing functionality, enabling you to use a single device to provide
routing, access switching, and WAN interfaces.

Supported Devices and Ports

Juniper Networks supports switching features on the following Ethernet ports and
devices:

■ Multiport Gigabit Ethernet uPIMs on the J Series device

■ Onboard Ethernet ports (Gigabit and Fast Ethernet built-in ports) on the SRX100,
SRX210, and SRX240 devices

■ Multiport Gigabit Ethernet XPIM on the SRX650 device
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Table 165: Supported Devices and Ports for Switching Features

PortsDevice

Multiport Gigabit Ethernet uPIMsJ Series devices

Onboard Gigabit Ethernet ports (ge-0/0/0 through ge-0/0/15)SRX240 devices

Onboard Gigabit Ethernet ports (ge-0/0/0 and ge-0/0/1)

Onboard Fast Ethernet ports (fe-0/0/2 and fe-0/0/7)

SRX210 devices

Onboard Fast Ethernet ports (fe-0/0/0 and fe-0/0/7)SRX100 devices

Multiport Gigabit Ethernet XPIM modulesSRX650 devices

On J Series and SRX650 devices, you can set multiport switch modules (uPIMs and
XPIMs, respectively) to three modes of operation: routing (the default), switching, or
enhanced switching. Routed traffic is forwarded from any port of the Gigabit Ethernet
uPIM to the WAN interface. Switched traffic is forwarded from one port of the Gigabit
Ethernet uPIM to another port on the same Gigabit Ethernet uPIM. Switched traffic
is not forwarded from a port on one uPIM to a port on a different uPIM.

On the SRX100, SRX220, and SRX240 devices, you can set the onboard Gigabit
Ethernet ports to operate as either switched ports or routed ports.

Related Topics

■ Switching Features Overview on page 642

Switching Features Overview

This topic describes the Layer 2 switching features for supported devices and ports.
For more information, see the JUNOS Software Documentation for EX Series Switches.

This topic covers:

■ VLANs on page 643

■ Integrated Bridging and Routing on page 644

■ Spanning Tree Protocols on page 644

■ Generic VLAN Registration Protocol on page 644

■ Link Aggregation on page 644

■ 802.1X Port-Based Network Authentication on page 646

■ Link Layer Discovery Protocol (LLDP) and Link Layer Discovery Protocol-Media
Endpoint Discovery (LLDP-MED) on page 649

■ IGMP Snooping on page 651

■ Q-in-Q VLAN Tagging on page 652
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VLANs

Bridging divides a single physical LAN into two or more virtual LANs, or VLANs. Each
VLAN is a collection of network nodes that are grouped together to form a separate
broadcast domain. On an Ethernet network that is a single LAN, all traffic is forwarded
to all nodes on the LAN. On VLANs, frames whose origin and destination are in the
same VLAN are forwarded only within the VLAN. VLANs thus limit the amount of
traffic flowing across the entire LAN, reducing the possible number of collisions and
packet retransmissions within a VLAN and on the LAN as a whole.

On an Ethernet LAN, all network nodes must be physically connected to the same
network. Each VLAN is identified by a single IP subnetwork and by standardized
IEEE 802.1Q encapsulation.

To pass traffic within a VLAN, the switch uses Layer 2 forwarding protocols, including
IEEE 802.1Q, Spanning Tree Protocol (STP), and Generic VLAN Registration Protocol
(GVRP). To pass traffic between two VLANs, the switch uses standard Layer 3 routing
protocols, such as static routing, OSPF, and RIP.

NOTE: Independent VLAN learning (IVL) is supported on SRX100, SRX240, and
SRX650 devices and shared VLAN learning (SVL) is supported on J Series devices
and SRX210 devices.

Types of Switch Ports

The ports, or interfaces, on a switch operate in either access mode or trunk mode.

An interface in access mode connects to a network device, such as a desktop
computer, an IP telephone, a printer, a file server, or a security camera. The interface
itself belongs to a single VLAN. The frames transmitted over an access interface are
normal Ethernet frames.

Trunk interfaces handle traffic for multiple VLANs, multiplexing the traffic for all
those VLANs over the same physical connection. Trunk interfaces are generally used
to interconnect switches to one another.

IEEE 802.1Q Encapsulation and Tags

To identify which VLAN the traffic belongs to, all frames on an Ethernet VLAN are
identified by a tag, as defined in the IEEE 802.1Q standard. These frames are tagged
and are encapsulated with 802.1Q tags.

For a simple network that has only a single VLAN, all traffic has the same 802.1Q
tag. When an Ethernet LAN is divided into VLANs, each VLAN is identified by a unique
802.1Q tag. The tag is applied to all frames so that the network nodes receiving the
frames know to which VLAN a frame belongs. Trunk ports, which multiplex traffic
among a number of VLANs, use the tag to determine the origin of frames and where
to forward them.
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Integrated Bridging and Routing

Integrated bridging and routing (IRB) provides support for simultaneous Layer 2
bridging and Layer 3 routing within the same bridge domain. Packets arriving on an
interface of the bridge domain are switched or routed based on the destination MAC
address of the packet. Packets with the router’s MAC address as the destination are
routed to other Layer 3 interfaces.

Spanning Tree Protocols

Spanning Tree Protocol (STP), defined in IEEE 802.1D, creates a tree of links in the
Ethernet switched network. Links that cause loops in the network are disabled,
thereby providing a single active link between any two switches.

NOTE: Only STP is supported on the SRX210 device.

Rapid Spanning Tree Protocol (RSTP), originally defined in IEEE 802.1w and later
merged into IEEE 802.1D, facilitates faster spanning tree convergence after a topology
change.

Multiple Spanning Tree Protocol (MSTP), initially defined in IEEE 802.1s and later
included in IEEE 802.1Q, supports mapping of multiple VLANs onto a single spanning
tree instance. This reduces the number of spanning tree instances required in a
switched network with many VLANs.

Generic VLAN Registration Protocol

The Generic VLAN Registration Protocol (GVRP) is an application protocol of the
Generic Attribute Registration Protocol (GARP) and is defined in the IEEE 802.1Q
standard. GVRP learns VLANs on a particular 802.1Q trunk port and adds the
corresponding trunk port to the VLAN if the advertised VLAN is preconfigured on the
switch.

The VLAN registration information sent by GVRP includes the current VLAN
membership—that is, which switches are members of which VLANs—and which
switch ports are in which VLAN. GVRP shares all VLAN information configured
manually on a local switch.

As part of ensuring that VLAN membership information is current, GVRP removes
switches and ports from the VLAN information when they become unavailable.
Pruning VLAN information limits the network VLAN configuration to active participants
only, reducing network overhead, and targets the scope of broadcast, unknown
unicast, and multicast (BUM) traffic to interested devices only.

Link Aggregation

You can combine multiple physical Ethernet ports to form a logical point-to-point
link, known as a link aggregation group (LAG) or bundle. A LAG provides more
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bandwidth than a single Ethernet link can provide. Additionally, link aggregation
provides network redundancy by load-balancing traffic across all available links. If
one of the links should fail, the system automatically load-balances traffic across all
remaining links. You can select up to eight Ethernet interfaces and include them
within a link aggregation group.

NOTE: Link aggregation is supported only for Ethernet interfaces that are configured
in switching mode (family ethernet-switching). Aggregating interfaces that are configured
in routed mode (family inet) is not supported.

Link aggregation can be used for point-to-point connections. It balances traffic across
the member links only within an aggregated Ethernet bundle and effectively increases
the uplink bandwidth. Another advantage of link aggregation is increased availability,
because the LAG is composed of multiple member links. If one member link fails,
the LAG continues to carry traffic over the remaining links.

Link Aggregation Group (LAG)

You can configure a LAG by specifying the link number as a physical device and then
associating a set of ports with the link. All the ports must have the same speed and
be in full-duplex mode. JUNOS Software assigns a unique ID and port priority to each
port.

NOTE: You must enable Link Aggregation Control Protocol (LACP) when you configure
a LAG.

The ID and priority are not configurable. When configuring a LAG, consider the
following guidelines:

■ Up to 8 Ethernet ports can be created in each bundle.

■ Each LAG must be configured on both sides of the link.

■ The ports on either side of the link must be set to the same speed.

A typical deployment for a LAG would be to aggregate trunk links between an access
switch and a distribution switch or customer edge (CE) device. LAGs are not supported
on virtual chassis port links. LAGs can only be used for a point-to-point connection.
At least one end of the LAG should be configured as active.

Link Aggregation Control Protocol (LACP)

LACP, a subcomponent of IEEE 802.3ad, provides additional functionality for LAGs.

When LACP is not enabled, a local LAG might attempt to transmit packets to a remote
single interface, which causes the communication to fail. When LACP is enabled, a
local LAG cannot transmit packets unless a LAG with LACP is also configured on the
remote end of the link.
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By default, Ethernet links do not exchange protocol data units (PDUs), which contain
information about the state of the link. You can configure Ethernet links to actively
transmit PDUs, or you can configure the links to passively transmit them, sending
out LACP PDUs only when they receive them from another link. The transmitting
link is known as the actor and the receiving link is known as the partner.

NOTE: Presently, LACP can be configured only for the Ethernet switching family.

802.1X Port-Based Network Authentication

IEEE 802.1X, also known as port-based network access control (PNAC), is a
mechanism to provide authentication to devices attached on the LAN. Hosts are
authenticated when they initially connect to a LAN. Authenticating hosts before they
receive an IP address from a DHCP server prevents unauthorized hosts from gaining
access to the LAN.

A LAN network configured for 802.1X authentication contains three basic components:

■ Supplicant—The IEEE term for a host that requests to join the network. The host
can be responsive or nonresponsive. A responsive host is one on which 802.1X
authentication is enabled and that provides authentication credentials (such as
a user name and password). A nonresponsive host is one on which 802.1X
authentication is not enabled.

■ Authenticator Port Access Entity—The IEEE term for the authenticator. The SRX
Series or J Series device is the authenticator and controls access by blocking all
traffic to and from supplicants until they are authenticated.

■ Authentication server—The server containing the back-end database that makes
authentication decisions. (JUNOS Software supports RADIUS authentication
servers.) The authentication server contains credential information for each
supplicant that can connect to the network. The authenticator forwards credentials
supplied by the supplicant to the authentication server. If the credentials
forwarded by the authenticator match the credentials in the authentication server
database, access is granted. If the credentials forwarded do not match, access
is denied.

The implementation of 802.1X authentication provides the following features for the
specified devices:

J SeriesSRX650SRX240SRX210SRX100Feature

NoYesYesYesNoDynamic VLAN assignment

Yes (without
VLAN option)

YesYesYesYes (without
VLAN option)

Authentication bypass

NoYesYesYesNoGuest VLAN

NoYesYesYesNoRADIUS server failure fallback
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NoYesYesYesNoVoIP VLAN support

NoYesYesYesYesRADIUS accounting

NoYesYesYesYesMAC RADIUS authentication

The 802.1X implementation provides the following supplicant capacities:

J SeriesSRX650SRX240SRX210SRX100

6464646464Supplicants per port

2K2K2K2K2KSupplicants per system

Not supported2K1K64Not supportedSupplicants with dynamic VLAN
assignments

See “Configuring 802.1X Features” on page 666 for information about configuring
the 802.1X authentication options.

Dynamic VLAN Assignment

When a supplicant first connects to an SRX Series or J Series device, the authenticator
sends a request to the supplicant to begin 802.1X authentication. If the supplicant
is an 802.1X-enabled device, it responds, and the authenticator relays an
authentication request to the RADIUS server.

As part of the reply to the authentication request, the RADIUS server returns
information about the VLAN to which the port belongs. By configuring the VLAN
information at the RADIUS server, you can control the VLAN assignment on the port.

MAC RADIUS Authentication

If the authenticator sends three requests to a supplicant to begin 802.1X authentication
and receives no response, the supplicant is considered nonresponsive. For a
nonresponsive supplicant, the authenticator sends a request to the RADIUS server
for authentication of the supplicant’s MAC address. If the MAC address matches an
entry in a predefined list of MAC addresses on the RADIUS server, authentication is
granted and the authenticator opens LAN access on the interface where the supplicant
is connected.

You can configure the number of times the authenticator attempts to receive a
response and the time period between attempts.

Static MAC Bypass

The authenticator can allow particular supplicants direct access to the LAN and bypass
the authentication server by including the supplicants’ MAC addresses in the static
MAC bypass list configured on the SRX Series or J Series device. This list is checked
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first. If a match is found, the supplicant is considered successfully authenticated and
the interface is opened up for it. No further authentication is done for that supplicant.
If a match is not found and 802.1X authentication is enabled for the supplicant, the
device continues with MAC RADIUS authentication on the authentication server.

For each MAC address in the list, you can configure the VLAN to which the supplicant
is moved or the interfaces on which the supplicant can connect.

Guest VLAN

You can specify a guest VLAN that provides limited network access for nonresponsive
supplicants. If a guest-vlan is configured, the authenticator connects all nonresponsive
supplicants to the predetermined VLAN, providing limited network access, often only
to the Internet. This type of configuration can be used to provide Internet access to
visitors without compromising company security.

NOTE: If you specify a guest VLAN, all nonresponsive supplicants are connected to
the guest VLAN without an attempt to authenticate by MAC address.

VoIP VLAN Support

When VoIP is used with 802.1X, the RADIUS server authenticates the phone, and
Link Layer Discovery Protocol–Media Endpoint Discovery (LLDP-MED) provides the
class-of-service (CoS) parameters for the phone. (For more information, refer to “Link
Layer Discovery Protocol (LLDP) and Link Layer Discovery Protocol-Media Endpoint
Discovery (LLDP-MED)” on page 649.)

You can configure 802.1X authentication to work with VoIP in multiple-supplicant
or single-supplicant mode:

■ Multiple-supplicant mode—Allows multiple supplicants to connect to the
interface. Each supplicant is authenticated individually.

■ Single-supplicant mode—Authenticates only the first supplicant. All other
supplicants who connect later to the interface are allowed to “piggyback” on the
first supplicant’s authentication and gain full access.

Server Reject VLAN

By default, when authentication fails, the supplicant is denied access to the network.
However, you can specify a VLAN to which the supplicant is moved if authentication
fails. The server reject VLAN is similar to a guest VLAN. With a server reject VLAN,
however, authentication is first attempted by credential, then by MAC address. If
both authentication methods fail, the supplicant is given access to a predetermined
VLAN with limited network access.
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RADIUS Server Failure Fallback

You can define one of four actions to be taken if no RADIUS authentication server
is reachable (if, for example, a server failure or a timeout has occurred on the
authentication server).

■ deny—(default) Prevent traffic from flowing from the supplicant through the
interface.

■ permit—Allow traffic to flow from the supplicant through the interface as if the
supplicant were successfully authenticated by the RADIUS server.

■ use-cache—Force successful authentication if authentication was granted before
the failure or timeout. This ensures that authenticated users are not adversely
affected by a failure or timeout.

■ vlan vlan-name | vlan-id —Move the supplicant to a different VLAN specified
by name or ID. This applies only to the first supplicant connecting to the interface.

NOTE: For permit, use-cache, and vlan fallback actions to work, 802.1X supplicants
need to accept an out of sequence SUCCESS packet.

RADIUS Accounting

Configuring RADIUS accounting on a SRX Series or J Series device lets you collect
statistical data about users logging on and off a LAN, and sends it to a RADIUS
accounting server. The collected data can be used for general network monitoring,
to analyze and track usage patterns, or to bill a user based on the amount of time or
type of services accessed.

To configure RADIUS accounting, specify one or more RADIUS accounting servers
to receive the statistical data from the device, and select the type of accounting data
to be collected. To view the collected statistics, you can access the log file configured
to receive them.

Link Layer Discovery Protocol (LLDP) and Link Layer Discovery Protocol-Media Endpoint
Discovery (LLDP-MED)

Devices use LLDP and LLDP-MED to learn and distribute device information on
network links. The information allows the device to quickly identify a variety of
systems, resulting in a LAN that interoperates smoothly and efficiently.

LLDP-capable devices transmit information in Type Length Value (TLV) messages to
neighbor devices. Device information can include specifics, such as chassis and port
identification and system name and system capabilities. The TLVs leverage this
information from parameters that have already been configured in the Juniper
Networks JUNOS Software.

LLDP-MED goes one step further, exchanging IP-telephony messages between the
device and the IP telephone. These TLV messages provide detailed information on
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PoE policy. The PoE Management TLVs let the device ports advertise the power level
and power priority needed. For example, the device can compare the power needed
by an IP telephone running on a PoE interface with available resources. If the device
cannot meet the resources required by the IP telephone, the device could negotiate
with the telephone until a compromise on power is reached.

The following basic TLVs are supported:

■ Chassis Identifier—The MAC address associated with the local system.

■ Port identifier—The port identification for the specified port in the local system.

■ Port Description—The user-configured port description. The port description can
be a maximum of 256 characters.

■ System Name—The user-configured name of the local system. The system name
can be a maximum of 256 characters.

■ System Description—The system description containing information about the
software and current image running on the system. This information is not
configurable, but taken from the software.

■ System Capabilities—The primary function performed by the system. The
capabilities that system supports; for example, bridge or router. This information
is not configurable, but based on the model of the product.

■ Management Address—The IP management address of the local system.

The following LLDP-MED TLVs are supported:

■ LLDP-MED Capabilities—A TLV that advertises the primary function of the port.
The capabilities values range 0 through 15:

■ 0—Capabilities

■ 1—Network policy

■ 2—Location identification

■ 3—Extended power via medium-dependent interface power-sourcing
equipment (MDI-PSE)

■ 4—Inventory

■ 5–15—Reserved

■ LLDP-MED Device Class Values:

■ 0—Class not defined

■ 1—Class 1 device

■ 2—Class 2 device

■ 3—Class 3 device

■ 4—Network connectivity device

■ 5–255— Reserved
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■ Network Policy—A TLV that advertises the port VLAN configuration and associated
Layer 2 and Layer 3 attributes. Attributes include the policy identifier, application
types, such as voice or streaming video, 802.1Q VLAN tagging, and 802.1p
priority bits and Diffserv code points.

■ Endpoint Location—A TLV that advertises the physical location of the endpoint.

■ Extended Power via MDI—A TLV that advertises the power type, power source,
power priority, and power value of the port. It is the responsibility of the PSE
device (network connectivity device) to advertise the power priority on a port.

LLDP and LLDP-MED must be explicitly configured on uPIMs (in enhanced switching
mode) on J Series devices, base ports on SRX100, SRX210, and SRX240 devices,
and Gigabit Backplane Physical Interface Modules (GPIMs) on SRX650 devices. To
configure LLDP on all interfaces or on a specific interface, use the lldp statement at
the [set protocols] hierarchy. To configure LLDP-MED on all interfaces or on a specific
interface, use the lldp-med statement at the [set protocols] hierarchy.

IGMP Snooping

Internet Group Management Protocol (IGMP) snooping regulates multicast traffic in
a switched network. With IGMP snooping enabled, a LAN switch monitors the IGMP
transmissions between a host (a network device) and a multicast router, keeping
track of the multicast groups and associated member ports. The switch uses that
information to make intelligent multicast-forwarding decisions and forward traffic
to the intended destination interfaces. J Series devices support IGMPv1 and IGMPv2.

How IGMP Snooping Works

A J Series device usually learns unicast MAC addresses by checking the source address
field of the frames it receives. However, a multicast MAC address can never be the
source address for a packet. As a result, the switch floods multicast traffic on the
VLAN, consuming significant amounts of bandwidth.

IGMP snooping regulates multicast traffic on a VLAN to avoid flooding. When IGMP
snooping is enabled, the switch intercepts IGMP packets and uses the content of the
packets to build a multicast cache table. The cache table is a database of multicast
groups and their corresponding member ports. The cache table is then used to
regulate multicast traffic on the VLAN.

When the router receives multicast packets, it uses the cache table to selectively
forward the packets only to the ports that are members of the destination multicast
group.

How Hosts Join and Leave Multicast Groups

Hosts can join multicast groups in either of two ways:

■ By sending an unsolicited IGMP join message to a multicast router that specifies
the IP multicast that the host is attempting to join.

■ By sending an IGMP join message in response to a general query from a multicast
router.
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A multicast router continues to forward multicast traffic to a VLAN provided that at
least one host on that VLAN responds to the periodic general IGMP queries. For a
host to remain a member of a multicast group, therefore, it must continue to respond
to the periodic general IGMP queries.

To leave a multicast group, a host can either not respond to the periodic general
IGMP queries, which results in a “silent leave” (the only leave option for hosts
connected to switches running IGMPv1), or send a group-specific IGMPv2 leave
message.

Q-in-Q VLAN Tagging

Q-in-Q tunneling, defined by the IEEE 802.1ad standard, allows service providers on
Ethernet access networks to extend a Layer 2 Ethernet connection between two
customer sites.

In Q-in-Q tunneling, as a packet travels from a customer VLAN (C-VLAN) to a service
provider's VLAN, a service provider-specific 802.1Q tag is added to the packet. This
additional tag is used to segregate traffic into service–provider–defined service VLANs
(S-VLANs). The original customer 802.1Q tag of the packet remains and is transmitted
transparently, passing through the service provider's network. As the packet leaves
the S-VLAN in the downstream direction, the extra 802.1Q tag is removed.

There are three ways to map C-VLANs to an S-VLAN:

■ All-in-one bundling—Use the dot1q-tunneling statement at the [edit vlans] hierarchy
to map without specifying customer VLANs. All packets from a specific access
interface are mapped to the S-VLAN.

■ Many-to-one bundling—Use the customer-vlans statement at the [edit vlans]
hierarchy to specify which C-VLANs are mapped to the S-VLAN.

■ Mapping C-VLAN on a specific interface—Use the mapping statement at the [edit
vlans] hierarchy to map a specific C-VLAN on a specified access interface to the
S-VLAN.

The following table lists the C-VLAN to S-VLAN mapping supported on SRX Series
devices:

J Series Devices (PIM)SRX650SRX240SRX210Mapping

YesYesYesYesAll-in-one bundling

NoYesNoNoMany-to-one bundling

NoYesNoNoMapping C-VLAN on a
specific interface
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NOTE: On SRX650 devices, in the dot1q-tunneling configuration options, customer
VLANs range and VLAN push do not work together for the same S-VLAN, even when
you commit the configuration. If both are configured, then VLAN push takes priority
over customer VLANs range.

Integrated bridging and routing (IRB) interfaces are supported on Q-in-Q VLANs for
SRX210, SRX240, SRX650, and J Series devices. Packets arriving on an IRB interface
on a Q-in-Q VLAN are routed regardless of whether the packet is single or double
tagged. The outgoing routed packets contain an S-VLAN tag only when exiting a trunk
interface; the packets exit the interface untagged when exiting an access interface.

In a Q-in-Q deployment, customer packets from downstream interfaces are
transported without any changes to source and destination MAC addresses. You can
disable MAC address learning at both the interface level and the VLAN level. Disabling
MAC address learning on an interface disables learning for all the VLANs of which
that interface is a member. When you disable MAC address learning on a VLAN, MAC
addresses that have already been learned are flushed.

Understanding Switching Modes on the J Series Services Router

On the J Series device, you set the uPIM to one of three operating modes: routing
(the default), switching, or enhanced switching.

When you set a multiport uPIM to switching mode, the uPIM appears as a single
entity for monitoring purposes. The only physical port settings that you can configure
are autonegotiation, speed, and duplex mode on each uPIM port, and these settings
are optional.

Routing Mode

In routing mode, the multiport uPIM has the same configuration options as any other
Gigabit Ethernet interface. To configure uPIM Gigabit Ethernet interfaces in routing
mode, see ”Configuring Gigabit Ethernet Interfaces—Quick Configuration” and
”Configuring Network Interfaces with a Configuration Editor.”

Switching Mode

In switching mode, the uPIM appears in the list of interfaces as a single interface,
which is the first interface on the uPIM—for example, ge-2/0/0. You can optionally
configure each uPIM port only for autonegotiation, speed, and duplex mode. A uPIM
in switching mode can perform the following functions:

■ Layer 3 forwarding—Routes traffic destined for WAN interfaces and other PIMs
present on the chassis.

■ Layer 2 forwarding—Switches intra-LAN traffic from one host on the LAN to
another LAN host (one port of uPIM to another port of same uPIM).
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Enhanced Switching Mode

In enhanced switching mode, each port can be configured for switching or routing
mode. This usage differs from the routing and switching modes, in which all ports
must be in either switching or routing mode. The uPIM in enhanced switching mode
provides the following features:

■ Supports configuration of different types of VLANs and inter-VLAN routing

■ Supports Layer 2 control plane protocols such as Spanning Tree Protocol (STP)
and Link Aggregation Control Protocol (LACP)

■ Supports port-based Network Access Control (PNAC) by means of authentication
servers

NOTE: The SRX100 and SRX210 devices support enhanced switching mode only.
When you set a multiport uPIM to enhanced switching mode, all the Layer 2 switching
features are supported on the uPIM.

NOTE: You can configure uPIM in enhanced switching mode only in JUNOS 9.2 or
later releases.

Connecting J Series uPIMs in a Daisy-Chain

You cannot combine multiple uPIMs to act as a single integrated switch. However,
you can connect uPIMs on the same chassis externally by physically connecting a
port on one uPIM to a port on another uPIM in a daisy-chain fashion.

Two or more uPIMs daisy-chained together create a single switch with a higher port
count than either individual uPIM. One port on each uPIM is used solely for the
connection. For example, if you daisy-chain a 6-port uPIM and an 8-port uPIM, the
result operates as a 12-port uPIM. Any port of a uPIM can be used for daisy-chaining.

Configure the IP address for only one of the daisy-chained uPIMs, making it the
primary uPIM. The secondary uPIM routes traffic to the primary uPIM, which forwards
it to the Routing Engine. This results in some increase in latency and packet drops
due to oversubscription of the external link.

Only one link between the two uPIMs is supported. Connecting more than one link
between uPIMs creates a loop topology, which is not supported.

Configuring Switching Modes on J Series uPIMs

You can set a multiport Gigabit Ethernet uPIM on a J Series device to either switching
or enhanced switching mode. The default mode of operation is routing mode.
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When you set a multiport uPIM to switching mode, the uPIM appears as a single
entity for monitoring purposes. The only physical port settings that you can configure
are autonegotiation, speed, and duplex mode on each uPIM port, and these settings
are optional.

Before You Begin

For background information, read “Understanding Switching Modes on the J Series Services
Router” on page 653.

NOTE: You cannot configure switch ports from J-Web Quick Configuration pages.
You must use the J-Web or CLI configuration editor.

J-Web Configuration

To set the uPIM mode of operation to switching:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Chassis, click Configure or Edit.

3. Next to Fpc, click Add new entry.

4. In the Slot field, enter the number of the slot of the chassis in which the uPIM is
inserted, and click OK.

5. Next to Pic, click Add new Entry.

6. Enter 0 in the Slot field. (This number is always 0 on a J Series device.)

7. Next to Ethernet, click Configure.

8. From the Pic mode list, choose switching and click OK.

To set the uPIM mode of operation to enhanced switching:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Chassis, click Configure or Edit.

3. Next to Fpc, click Add new entry.

4. In the Slot field, enter the number of the slot of the chassis in which the uPIM is
inserted, and click OK.

5. Next to Pic, click Add new Entry.

6. Enter 0 in the Slot field. (This number is always 0 on a J Series device.)

7. Next to Ethernet, click Configure.

8. From the Pic mode list, choose enhanced-switching and click OK.

To set a physical parameter on a port on the uPIM:
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1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Click the name of the uPIM interface—for example ge-2/0/0.

4. Next to Switch options, click Configure.

5. Next to Switch port, click Add new entry.

6. In the Port field, enter the number of the port you want to configure.

7. Choose the settings for Autonegotiation, Link mode, and Speed, and click OK.

CLI Configuration

To set the uPIM mode of operation to switching:

user@host# set chassis fpc slot-number pic 0 ethernet pic-mode switching

To set the uPIM mode of operation to enhanced switching:

user@host# set chassis fpc slot-number pic 0 ethernet pic-mode enhanced-switching

To set a physical parameter on a port on the uPIM:

user@host# set interfaces ge-2/0/0 switch-options switch-port 1 auto-negotiation

Related Topics

■ Verifying Switching Mode Configuration on J Series uPIMs on page 656

Verifying Switching Mode Configuration on J Series uPIMs

The operational mode command for checking the status and statistics for multiport
uPIMs in switching mode is different from that in routing mode. For uPIMs in routing
mode, the operational commands are the same as for other Gigabit Ethernet
interfaces, such as the 1-port Gigabit Ethernet ePIM and built-in Gigabit Ethernet
ports.

However, not all operational mode commands are supported for ports of a uPIM in
switching mode. For example, the operational mode command for monitoring port
statistics is not supported.

Before You Begin

See “Configuring Switching Modes on J Series uPIMs” on page 654.

NOTE: To clear the statistics for the individual switch ports, use the clear interfaces
statistics ge-pim/0/0 switch-port port-number command.
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To verify the status and view statistics for a port on a uPIM in switching mode:

user@host# show interfaces ge-slot/0/0 switch-port port-number

Port 0, Physical link is Up
        Speed: 100mbps, Auto-negotiation: Enabled       
   Statistics:                          Receive         Transmit
          Total bytes                       28437086         21792250
          Total packets                       409145            88008
          Unicast packets                       9987            83817
          Multicast packets                   145002                0
          Broadcast packets                   254156             4191
          Multiple collisions                     23               10
          FIFO/CRC/Align errors                    0                0
          MAC pause frames                         0                0
          Oversized frames                         0
          Runt frames                              0
          Jabber frames                            0
          Fragment frames                          0
          Discarded frames                         0
        Autonegotiation information:
          Negotiation status: Complete
          Link partner:
              Link mode: Full-duplex, Flow control: None, Remote fault: OK, Link
 partner Speed: 100 Mbps
          Local resolution:
              Flow control: None, Remote fault: Link OK

Configuring Enhanced Switching Mode Features

This section describes how to configure enhanced switching mode features on SRX
Series and J Series devices.

Before You Begin

See “Configuring Switching Modes on J Series uPIMs” on page 654.

This section covers:

■ Configuring VLANs—Quick Configuration on page 657

■ Configuring a Spanning Tree—Quick Configuration on page 660

■ Configuring LACP in J-Web on page 663

■ Configuring 802.1X Features on page 666

■ Configuring IGMP Snooping—Quick Configuration on page 671

■ Configuring GVRP—Quick Configuration on page 673

Configuring VLANs—Quick Configuration

Each VLAN is a collection of network nodes that are grouped together to form separate
broadcast domains. On an Ethernet network that is a single LAN, all traffic is
forwarded to all nodes on the LAN. On VLANs, frames whose origin and destination
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are in the same VLAN are forwarded only within the local VLAN. Frames that are not
destined for the local VLAN are the only ones forwarded to other broadcast domains.
VLANs thus limit the amount of traffic flowing across the entire LAN, reducing the
possible number of collisions and packet retransmissions within a VLAN and on the
LAN as a whole.

On an Ethernet LAN, all network nodes must be physically connected to the same
network. On VLANs, the physical location of the nodes is not important, so you can
group network devices in any way that makes sense for your organization, such as
by department or business function, by types of network nodes, or even by physical
location. Each VLAN is identified by a single IP subnetwork and by standardized IEEE
802.1Q encapsulation.

You can use the J-Web Quick Configuration to add a new VLAN or to edit or delete
an existing VLAN.

To access the VLAN Quick Configuration:

1. In the J-Web user interface, select Configure>Switching>VLAN.

The VLAN Configuration page displays a list of existing VLANs. If you select a
specific VLAN, the specific VLAN details are displayed in the Details section.

2. Click one:

■ Add—Creates a VLAN.

■ Edit—Edits an existing VLAN configuration.

■ Delete—Deletes an existing VLAN.

NOTE: If you delete a VLAN, the VLAN configuration for all the associated interfaces
is also deleted.

When you are adding or editing a VLAN, enter information as described in Table
166 on page 658.

3. Click one:

■ To apply changes to the configuration, click OK.

■ To cancel the configuration without saving changes, click Cancel.

Table 166: VLAN Configuration Details

ActionFunctionField

General tab

Enter a name.Specifies a unique name for the VLAN.VLAN Name
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Table 166: VLAN Configuration Details (continued)

ActionFunctionField

Select one:

■ VLAN ID—Type a unique identification number
from 1 through 4094. If no value is specified,
it defaults to 0.

■ VLAN Range—Type a number range to create
VLANs with IDs corresponding to the range.
For example, the range 2–3 will create two
VLANs with the ID 2 and 3.

Specifies the identifier or range for the VLAN.VLAN ID/Range

Enter a brief description for the VLAN.Describes the VLAN.Description

Type the number of seconds from 60 through
1000000.

Specifies the maximum time that an entry
can remain in the forwarding table before it
ages out.

MAC-Table-Aging-Time

To apply an input firewall filter, select the firewall
filter from the list.

Specifies the VLAN firewall filter that is applied
to incoming packets.

Input Filter

To apply an output firewall filter, select the firewall
filter from the list.

Specifies the VLAN firewall filter that is applied
to outgoing packets.

Output Filter

Ports tab

Click one:

■ Add—Select the ports from the available list.

■ Remove—Select the port that you do not want
associated with the VLAN.

Specifies the ports to be associated with this
VLAN for data traffic. You can also remove
the port association.

Ports

IP Address tab

Select to enable the IP address options.Specifies IP address options for the VLAN.Layer 3 Information

Enter the IP address.Specifies the IP address of the VLAN.IP Address

Enter the address, for example, 255.255.255.0. You
can also specify the address prefix.

Specifies the range of logical addresses within
the address space that is assigned to an
organization.

Subnet Mask

To apply an input firewall filter to an interface, select
the firewall filter from the list.

Specifies the VLAN interface firewall filter that
is applied to incoming packets.

Input Filter

To apply an output firewall filter to an interface,
select the firewall filter from the list.

Specifies the VLAN interface firewall filter that
is applied to outgoing packets.

Output Filter

Click the ARP/MAC Details button. Enter the static
IP address and MAC address in the window that is
displayed.

Specifies the details for configuring the static
IP address and MAC.

ARP/MAC Details

VoIP tab
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Table 166: VLAN Configuration Details (continued)

ActionFunctionField

Click one:

■ Add—Select the ports from the available list.

■ Remove—Select the port that you do not want
associated with the VLAN.

Specifies the ports to be associated with this
VLAN for voice traffic. You can also remove
the port association.

Ports

Configuring a Spanning Tree—Quick Configuration

Juniper devices provide Layer 2 loop prevention through Spanning Tree Protocol
(STP), Rapid Spanning Tree Protocol (RSTP), and Multiple Spanning Tree Protocol
(MSTP). You can configure bridge protocols data unit (BPDU) protection on interfaces
to prevent them from receiving BPDUs that could result in STP misconfigurations,
which could lead to network outages.

You can use the J-Web Quick Configuration to add a spanning tree or to edit or delete
an existing spanning tree.

To access the Spanning Tree Quick Configuration:

1. In the J-Web user interface, select Configure>Switching>Spanning Tree.

The Spanning Tree Configuration page displays a list of existing spanning trees.
If you select a specific spanning tree, the specific spanning tree details are
displayed in the General and Interfaces tabs.

2. Click one of the following:

■ Add—Creates a spanning tree.

■ Edit—Edits an existing spanning-tree configuration.

■ Delete—Deletes an existing spanning tree.

When you are adding a spanning tree, select a protocol name:

■ If you select STP, enter information as described in Table 167 on page 661.

■ If you select RSTP, enter information as described in Table 168 on page 661.

■ If you select MSTP, enter information as described in Table 169 on page 662.

Select the Ports tab to configure the ports associated with this spanning tree.
Click one of the following:

■ Add—Creates a new spanning-tree interface configuration.

■ Edit—Modifies an existing spanning-tree interface configuration.

■ Delete—Deletes an existing spanning-tree interface configuration.

When you are adding or editing a spanning-tree port, enter information as
described in Table 170 on page 663.

3. Click one:
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■ To apply changes to the configuration, click OK.

■ To cancel the configuration without saving changes, click Cancel.

Table 167: STP Configuration Parameters

ActionFunctionField

View only.Displays the spanning-tree protocol.Protocol Name

To enable this option, select the
check box.

Disables STP on the interface.Disable

To enable this option, select the
check box.

Specifies that BPDU blocks are to be processed.BPDU Protect

Select a value.Specifies the bridge priority. The bridge priority determines which
bridge is elected as the root bridge. If two bridges have the same
path cost to the root bridge, the bridge priority determines which
bridge becomes the designated bridge for a LAN segment.

Bridge Priority

Enter a value from 4 through 30
seconds.

Specifies the number of seconds an interface waits before changing
from spanning-tree learning and listening states to the forwarding
state.

Forward Delay

Enter a value from 1 through 10
seconds.

Specifies time interval in seconds at which the root bridge transmits
configuration BPDUs.

Hello Time

Enter a value from 6 through 40
seconds.

Specifies the maximum aging time in seconds for all MST instances.
The maximum aging time is the number of seconds a switch waits
without receiving spanning-tree configuration messages before
attempting a reconfiguration.

Max Age

Table 168: RSTP Configuration Parameters

ActionFunctionField

View only.Displays the spanning-tree protocol.Protocol Name

To enable this option, select the
check box.

Specifies whether RSTP must be disabled on the interface.Disable

To enable this option, select the
check box.

Specifies that BPDU blocks are to be processed.BPDU Protect

Select a value.Specifies the bridge priority. The bridge priority determines which
bridge is elected as the root bridge. If two bridges have the same
path cost to the root bridge, the bridge priority determines which
bridge becomes the designated bridge for a LAN segment.

Bridge Priority

Enter a value from 4 through 30
seconds.

Specifies the number of seconds a port waits before changing from
its spanning-tree learning and listening states to the forwarding
state.

Forward Delay

Enter a value from 1 through 10
seconds.

Specifies the hello time in seconds for all MST instances.Hello Time
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Table 168: RSTP Configuration Parameters (continued)

ActionFunctionField

Enter a value from 6 through 40
seconds.

Specifies the maximum aging time in seconds for all MST instances.
The maximum aging time is the number of seconds a switch waits
without receiving spanning-tree configuration messages before
attempting a reconfiguration.

Max Age

Table 169: MSTP Configuration Parameters

ActionFunctionField

View only.Displays the spanning-tree protocol.Protocol Name

To enable this option, select the check
box.

Specifies whether MSTP must be disabled on the interface.Disable

To enable this option, select the check
box.

Specifies that BPDU blocks are to be processed.BPDU Protect

Select a value.Specifies the bridge priority. The bridge priority determines
which bridge is elected as the root bridge. If two bridges have
the same path cost to the root bridge, the bridge priority
determines which bridge becomes the designated bridge for
a LAN segment.

Bridge Priority

Enter a value from 4 through 30
seconds.

Specifies the number of seconds a port waits before changing
from its spanning-tree learning and listening states to the
forwarding state.

Forward Delay

Enter a value from 1 through 10
seconds.

Specifies the hello time in seconds for all MST instances.Hello Time

Enter a value from 6 through 40
seconds.

Specifies the maximum aging time for all MST instances. The
maximum aging time is the number of seconds a switch waits
without receiving spanning-tree configuration messages before
attempting a reconfiguration.

Max Age

Enter a name.MSTP region name carried in the MSTP bridge protocol data
units (BPDUs).

Configuration
Name

Enter a value from 1 through 255.Maximum number of hops a BPDU can be forwarded in the
MSTP region

Max Hops

Enter a value from 0 through 65535.Revision number of the MSTP region configuration.Revision Level

MSTI tab

Click one:

■ Add—Creates a MSTI.

■ Edit—Edits an existing MSTI.

■ Delete—Deletes an existing MSTI.

Specifies the multiple spanning-tree instance (MSTI) identifier.
MSTI IDs are local to each region, so you can reuse the same
MSTI ID in different regions.

MSTI Id
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Table 169: MSTP Configuration Parameters (continued)

ActionFunctionField

Select a value.Specifies the bridge priority. The bridge priority determines
which bridge is elected as the root bridge. If two bridges have
the same path cost to the root bridge, the bridge priority
determines which bridge becomes the designated bridge for
a LAN segment.

Bridge Priority

Click one:

■ Add—Selects VLANs from the list.

■ Remove—Deletes the selected
VLAN.

Specifies the VLANs for the MSTI.VLAN

Click one:

■ Add—Selects interfaces from the
list.

■ Edit—Edits the selected interface.

■ Remove—Deletes the selected
interface.

Specifies the interface for the MSTP protocol.Interfaces

Table 170: Spanning-Tree Ports Configuration Details

ActionFunctionField

Select an interface.Specifies the interface for the
spanning-tree protocol type.

Interface Name

Enter a value from 1 through
200,000,000.

Specifies the link cost to control which
bridge is the designated bridge and
which interface is the designated
interface.

Cost

Select a value.Specifies the interface priority to control
which interface is elected as the root
port.

Priority

Select to configure the interface as an
edge interface.

Configures the interface as an edge
interface. Edge interfaces immediately
transition to a forwarding state.

Edge

Select one:

■ Point to Point—For full-duplex
links, select this mode.

■ Shared—For half-duplex links,
select this mode.

Specifies the link mode.Mode

Configuring LACP in J-Web

Use the link aggregation feature to aggregate one or more Ethernet interfaces to form
a virtual link or link aggregation group (LAG). The MAC client can treat this virtual
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link like a single link. Link aggregation increases bandwidth, provides graceful
degradation as failure occurs, and increases availability.

You can use the J-Web interface to add a new LAG or to edit or delete an existing
LAG.

NOTE: The interfaces that are already configured with MTU, duplex, flow control, or
logical interfaces are displayed. However, when you select an already configured
interface, a warning message is displayed.

To access the LACP Configuration:

1. In the J-Web user interface, select Configure>Interfaces>Link Aggregation.

The Aggregated Interfaces list is displayed.

2. Click one of the following:

■ Device Count—Creates an aggregated Ethernet interface, or LAG. You can
choose the number of device that you want to create. Information displayed
on the link aggregation page are specified in Table 171 on page 664 and the
details of aggregation are specified in Table 172 on page 665

■ Add—Adds a new aggregated Ethernet Interface, or LAG. Enter information
as specified in Table 173 on page 665.

■ Edit— Modifies a selected LAG

■ Aggregation—Modifies an selected LAG. Enter information as specified
in Table 173 on page 665.

■ VLAN—Specifies VLAN options for the selected LAG. See Table 174 on
page 666 for details on the options.

■ IP Option—Configuring IP address to LAG is not supported and when
you try to configure the IP address an error message is displayed.

■ Delete—Deletes the selected LAG.

■ Disable Port or Enable Port—Disables or enables the administrative status
on the selected interface.

Table 171: LACP (Link Aggregation Control Protocol) Configuration

FunctionField

Indicates the name of the aggregated interface.Aggregated Interface

Indicates whether the interface is linked (Up) or not linked
(Down).

Link Status

Virtual LAN identifier value for IEEE 802.1Q VLAN tags
(0.4094).

VLAN (VLAN ID)

The description for the LAG.Description
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Table 172: Details of Aggregation

FunctionField

Displays if the interface is enabled (Up) or disabled (Down).Administrative Status

Shows the logical interface of the aggregated interface.Logical Interfaces

Member interfaces hold all the aggregated interfaces of the
selected interfaces.

Member Interfaces

Specifies the mode of operation for the port: trunk or access.Port Mode

VLAN identifier to associate with untagged packets received
on the interface.

Native VLAN (VLAN ID)

Specifies the address of the aggregated interfaces.IP Address/Subnet Mask

Specifies the IPV6 address of the aggregated interfaces.IPV6 Address/Subnet Mask

Table 173: Aggregated Ethernet Interface Options

ActionFunctionField

Enter the aggregated interface name. If
an aggregated interface already exists,
then the field is displayed as read-only.

Indicates the name of the aggregated
interface.

Aggregated Interface

Select from the drop-down list.Specifies the mode in which LACP
packets are exchanged between the
interfaces. The modes are:

■ None—Indicates that no mode is
applicable.

■ Active—Indicates that the interface
initiates transmission of LACP
packets

■ Passive—Indicates that the interface
only responds to LACP packets.

LACP Mode

Enter the description.The description for the LAG.Description

Click Add to select the interfaces.

NOTE: Only interfaces that are
configured with the same speeds can be
selected together for a LAG.

Indicates that the interfaces available for
aggregation.

Interface

Indicates the speed of the interface.Speed

Select to enable log generation.Specifies whether to enable generation
of log entries for LAG.

Enable Log
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Table 174: Edit VLAN Options

ActionFunctionField

If you select Trunk, you can:

1. Click Add to add a VLAN member.

2. Select the VLAN and click OK.

3. (Optional) Associate a native VLAN
ID with the port.

If you select Access, you can:

1. Select the VLAN member to be
associated with the port.

2. (Optional) Associate a VoIP VLAN
with the interface. Only a VLAN
with a VLAN ID can be associated
as a VoIP VLAN.

3. Click OK.

Specifies the mode of operation for the
port: trunk or access.

Port Mode

Click Add to select VLAN members.For trunk interfaces, the VLANs for which
the interface can carry traffic.

VLAN Options

Select the VLAN identifier.VLAN identifier to associate with
untagged packets received on the
interface.

Native VLAN

Configuring 802.1X Features

IEEE 802.1X and MAC RADIUS authentication both provide network edge security,
protecting Ethernet LANs from unauthorized user access by blocking all traffic to
and from devices at the interface until the supplicant's credential or MAC address is
presented and matched on the authentication server (a RADIUS server). When the
supplicant is authenticated, the switch stops blocking access and opens the interface
to the supplicant.

See the JUNOS Software Documentation for EX Series Switches for detailed examples
of configuring 802.1X features.

Configuring Authentication Features (J-Web)

To configure 802.1X settings using the J-Web interface:

1. From the Configure menu, select Security > 802.1X.

The 802.1X screen displays a list of interfaces, whether 802.1X security has been
enabled, and the assigned port role.

When you select a particular interface, the Details section displays 802.1X details
for the selected interface.
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NOTE: After you make changes to the configuration, you must commit the changes
for them to take effect. To commit all changes to the active configuration, select
Commit Options > Commit.

2. Click one:

■ RADIUS Servers—specifies the RADIUS server to be used for authentication.
Select the check box to select the server. Click Add or Edit to add or modify
the RADIUS server settings. Enter information as specified in Table 175 on
page 667.

■ Exclusion List—implements the authentication bypass option by listing the
MAC address of each host to be excluded from 802.1X authentication. Click
Add or Edit in the Exclusion list screen to include or modify the MAC address
list. Enter information as specified in Table 176 on page 668.

■ Edit—specifies 802.1X settings for the selected interface.

■ Apply 802.1X Profile—applies a predefined 802.1X profile based on the
port role. If a message appears asking if you want to configure a RADIUS
server, click Yes and enter information as specified in Table 175 on
page 667.

■ 802.1X Configuration—configures custom 802.1X settings for the
selected interface. If a message appears asking if you want to configure
a RADIUS server, click Yes and enter information as specified in Table
175 on page 667. To configure 802.1X settings, enter information as
specified in Table 177 on page 668.

■ Delete—deletes the existing 802.1X authentication configuration on the
selected interface.

Table 175: RADIUS Server Settings

Your ActionFunctionField

Enter the IP address in dotted decimal
notation.

Specifies the IP address of the server.IP Address

Enter the password.Specifies the login password.Password

Reenter the password.Verifies the login password for the server.Confirm Password

Type the port number.Specifies the port with which the server is associated.Server Port Number

Type the IP address in dotted decimal
notation.

Specifies the source address of the SRX Series device
for communicating with the server.

Source Address

Type the number.Specifies the number of login retries allowed after a
login failure.

Retry Attempts

Type the interval in seconds.Specifies the time interval to wait before the connection
to the server is closed.

Timeout
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Table 176: 802.1X Exclusion List

Your ActionFunctionField

Enter the MAC address.Specifies the MAC address to be excluded from
802.1X authentication.

MAC Address

Select to enable the option. Select the port
through which the supplicant is connected.

Specifies that a supplicant can bypass
authentication if it is connected through a
particular interface.

Exclude if connected
through the port

Select to enable the option. Select the
VLAN from the list.

Moves the host to a specific VLAN once the host
is authenticated.

Move the host to the VLAN

Table 177: 802.1X Port Settings

Your ActionFunctionField

Supplicant Mode

Select the required mode.Specifies the mode to be adopted for supplicants:

■ Single—allows only one host for authentication.

■ Multiple—allows multiple hosts for authentication. Each host
is checked before being admitted to the network.

■ Single authentication for multiple hosts—allows multiple hosts
but only the first is authenticated.

Supplicant Mode

Authentication

Select to enable
reauthentication. Enter the
timeout for reauthentication in
seconds.

Specifies enabling reauthentication on the selected interface.Enable
re-authentication

Select the desired action.Specifies the action to be taken in case a supplicant is
non-responsive:

■ Move to the Guest VLAN—moves the supplicant to the specified
Guest VLAN.

■ Deny—does not permit access to the supplicant.

Action for
nonresponsive hosts

Enter timeout values in seconds
for the appropriate options.

Specifies timeout values for:

■ Port waiting time after an authentication failure

■ EAPOL re-transmitting interval

■ Maximum EAPOL requests

■ Maximum number of retries

■ Port timeout value for a response from the supplicant

■ Port timeout value for a response from the RADIUS server

Timeouts
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Specifying RADIUS Server Connections on an SRX Series or J Series Device
(CLI)

To use 802.1X or MAC RADIUS authentication, you must specify the connections on
the SRX Series or J Series device for each RADIUS server to which you will connect.

To configure a RADIUS server:

1. Navigate to the access hierarchy and define the RADIUS server by its IP address
and secret password. The secret password on the SRX Series or J Series device
must match the secret password on the server.

NOTE: For 802.1X authentication, the RADIUS server must be configured at the
access hierarchy level.

[edit]
user@host# edit access
[edit access]
user@host# set radius-server 10.0.0.100 port 1812 secret abc

To define more than one RADIUS server, you need to enter separate radius-server
commands.

2. (Optional) Specify the IP address that the RADIUS server uses to identify the SRX
Series or J Series device.

By default, the RADIUS server uses the address of the interface sending the
RADIUS request to determine the source of a request. If the request has been
diverted on an alternate route to the RADIUS server, however, the interface
relaying the request might not be an interface on the SRX Series or J Series
device. To ensure that the source is identified correctly, specify its IP address
explicitly.

[edit access]
user@host# set radius-server 10.0.0.100 source-address 10.93.14.100

3. Create a profile and configure the authentication order, making radius the first
method of authentication.

[edit access]
user@host# set profile profile1 authentication-order radius

4. Specify one or more RADIUS servers to be associated with profile1.

[edit access]
user@host# set profile profile1 radius authentication-server 10.0.0.100

5. Navigate to the top of the hierarchy and define profile1 as the authentication
profile for 802.1X or MAC RADIUS authenticator.

[edit access]
user@host# top
[edit]
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user@host# set protocols dot1x authenticator authentication-profile-name
profile1

6. Configure the IP address of the SRX Series or J Series device in the list of clients
on the RADIUS server. For specifics on configuring the RADIUS server, consult
the documentation for your server.

Configuring 802.1X Interface Settings (CLI)

To configure 802.1X authentication on an interface:

1. Navigate to the [edit protocols dot1x] hierarchy and configure the supplicant
mode as single (authenticates the first supplicant), single-secure (authenticates
only one supplicant), or multiple (authenticates multiple supplicants).

[edit]
user@host# edit protocols dot1x
[edit protocols dot1x]
user@host# set authenticator interface ge-0/0/5 supplicant multiple

2. Enable reauthentication and specify the reauthentication interval.

[edit protocols dot1x]
user@host# set authenticator interface ge-0/0/5/0 reauthentication 120

3. Configure the interface timeout value for the response from the supplicant.

[edit protocols dot1x]
user@host# set authenticator interface ge-0/0/5 supplicant-timeout 5

4. Configure the timeout for the interface before it resends an authentication request
to the RADIUS server.

[edit protocols dot1x]
user@host# set authenticator interface ge-0/0/5 server-timeout 5

5. Configure how long, in seconds, the interface waits before retransmitting the
initial EAPOL PDUs to the supplicant.

[edit protocols dot1x]
user@host# set authenticator interface ge-0/0/5 transmit-period 60

6. Configure the maximum number of times an EAPOL request packet is
retransmitted to the supplicant before the authentication session times out.

[edit protocols dot1x]
user@host# set authenticator interface ge-0/0/5 maximum-requests 5

Example: Configuring a Guest VLAN (CLI)

802.1X provides LAN access to nonresponsive hosts (hosts where 802.1X is not
enabled). These hosts, referred to as guests, typically are provided access only to the
Internet.

To create a guest VLAN and to verify the configuration:
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1. Configure a VLAN named visitor-vlan.

[edit]

user@host# set vlans visitor-vlan vlan-id 300

2. Navigate to the top of the hierarchy to configure visitor-vlan as the guest VLAN.

top
[edit]
user@host# set protocols dot1x authenticator interface all guest-vlan
visitor-vlan

3. Check the configuration.

[edit]
user@host> show configuration

protocols {
dot1x {

authenticator {
interface {

all {
guest-vlan {

visitor-vlan;
}

}
}

}
}

}
vlans {

visitor-vlan {
vlan-id 300;

}
}

4. If you are finished configuring the VLAN, commit the configuration.

Configuring IGMP Snooping—Quick Configuration

IGMP snooping regulates multicast traffic in a switched network. With IGMP snooping
enabled, the Juniper device monitors the IGMP transmissions between a host (a
network device) and a multicast router, keeping track of the multicast groups and
associated member interfaces. The Juniper device uses that information to make
intelligent multicast-forwarding decisions and forward traffic to the intended
destination interfaces.

You can use the J-Web Quick Configuration to add a new IGMP snooping configuration
or to edit or delete an existing configuration.

To access the IGMP Snooping Quick Configuration:

1. In the J-Web user interface, select Configure>Switching>IGMP Snooping.
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The VLAN Configuration page displays a list of existing IGMP snooping
configurations.

2. Click one:

■ Add—Creates an IGMP snooping configuration for the VLAN.

■ Edit—Edits an existing IGMP snooping configuration for the VLAN.

■ Delete—Deletes member settings for the interface.

NOTE: If you delete a configuration, the VLAN configuration for all the associated
interfaces is also deleted.

■ Disable Vlan—Disables IGMP snooping on the selected VLAN.

When you are adding or editing a VLAN, enter information as described in Table
178 on page 672.

3. Click one:

■ To apply changes to the configuration, click OK.

■ To cancel the configuration without saving changes, click Cancel.

Table 178: IGMP Snooping Configuration Fields

ActionFunctionField

Select the VLAN from the list.Specifies the VLAN on which to enable
IGMP snooping.

VLAN Name

To enable the option, select the check
box.

To disable the option, clear the check
box.

Immediately removes a multicast group
membership from an interface when it
receives a leave message from that
interface and suppresses the sending of
any group-specific queries for the
multicast group

Immediate Leave

Enter a value from 1 through 1024
seconds.

Configures how frequently the switch
sends host-query timeout messages to
a multicast group.

Query Interval

Enter a value from 1 through 1024
seconds.

Configures the interval between
group-specific query timeout messages
sent by the switch.

Query Last Member Interval

Enter a value from 1 through 25
seconds.

Configures the length of time the switch
waits to receive a response to a specific
query message from a host.

Query Response Interval

Enter a value from 2 through 10.Specifies the number of timeout
intervals the switch waits before timing
out a multicast group.

Robust Count
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Table 178: IGMP Snooping Configuration Fields (continued)

ActionFunctionField

1. Click Add.

2. Select an interface from the list.

3. Select Multicast Router Interface.

4. Enter the maximum number of
groups an interface can join in
Group Limit.

5. In Static, choose one:

■ Click Add, type a group IP
address, and click OK.

■ Select a group and click
Remove to remove the group
membership.

Statically configures an interface as a
switching interface toward a multicast
router (the interface to receive multicast
traffic).

Interfaces List

Configuring GVRP—Quick Configuration

As a network expands and the number of clients and VLANs increases, VLAN
administration becomes complex, and the task of efficiently configuring VLANs on
multiple EX Series switches becomes increasingly difficult. To automate VLAN
administration, you can enable GARP VLAN Registration Protocol (GVRP) on the
network.

GVRP learns VLANs on a particular 802.1Q trunk port, and adds the corresponding
trunk interface to the VLAN if the advertised VLAN is preconfigured or existing already
on the switch. For example, a VLAN named “sales” is advertised to trunk interface
1 on the GVRP-enabled switch. The switch adds trunk interface 1 to the sales VLAN
if the sales VLAN already exists on the switch.

As individual interfaces become active and send requests to join a VLAN, the VLAN
configuration is updated and propagated among the switches. Limiting the VLAN
configuration to active participants reduces the network overhead. GVRP also provides
the benefit of pruning VLANs to limit the scope of broadcast, unknown unicast, and
multicast (BUM) traffic to interested network devices only.

You can use the J-Web Quick Configuration to enable or disable GVRP on an interface.

To access the GVRP Quick Configuration:

1. In the J-Web user interface, select Configure>Switching>GVRP.

The GVRP Configuration page displays a list of interfaces on which GVRP is
enabled.

2. Click one:

■ Global Settings—Modifies GVRP timers. Enter the information as described
in Table 179 on page 674.

■ Add—Enables GVRP on an interface.
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■ Disable Port—Disables an interface.

■ Delete—Deletes an interface.

3. Click one:

■ To apply changes to the configuration, click OK.

■ To cancel the configuration without saving changes, click Cancel.

Table 179: GVRP Global Settings

ActionFunctionField

Click to select.Disables GVRP on all the interfaces.Disable GVRP

Enter a value from 0 through
4294967295 milliseconds.

Specifies the number of milliseconds an interface must wait
before sending VLAN advertisements.

Join Timer

Enter a value from 0 through
4294967295 milliseconds.

Specifies the number of milliseconds an interface must wait
after receiving a leave message to remove itself from the VLAN
specified in the message.

Leave Timer

Enter a value from 0 through
4294967295 milliseconds.

Specifies the interval in milliseconds at which Leave All
messages are sent on interfaces. Leave All messages help to
maintain current GVRP VLAN membership information in the
network.

Leave All Timer
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Chapter 26

Configuring Layer 2 Bridging and
Transparent Mode

For SRX3400, SRX3600, SRX5600, and SRX5800 devices, transparent mode provides
full security services for Layer 2 bridging capabilities. This chapter describes how to
configure bridge domains on SRX Series devices and how to configure Layer 2 security
zones and security policies between these zones.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Layer 2 Bridging and Transparent Mode Overview on page 676

■ Understanding Bridge Domains on page 677

■ Understanding Transparent Mode Conditions on page 679

■ Understanding Layer 2 Interfaces on page 680

■ Configuring Bridge Domains on page 680

■ Configuring Layer 2 Logical Interfaces on page 682

■ Understanding Layer 2 Security Zones on page 684

■ Understanding Security Policies in Transparent Mode on page 685

■ Creating Layer 2 Security Zones on page 686

■ Configuring Security Policies for Transparent Mode on page 687

■ Understanding VLAN Retagging on page 689

■ Configuring VLAN Retagging on page 690

■ Changing the Default Forwarding Behavior on page 691

■ Understanding Integrated Routing and Bridging Interfaces on page 692

■ Understanding Firewall User Authentication in Transparent Mode on page 693

■ Configuring an IRB Interface on page 694

■ Understanding Layer 2 Forwarding Tables on page 696

■ Changing the Default Learning for Unknown MAC Addresses on page 698

■ Understanding Layer 2 Transparent Mode Chassis Clusters on page 699

■ Configuring Redundant Ethernet Interfaces for Layer 2 Transparent Mode Chassis
Clusters on page 700
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■ Overview of Class of Service Functions in Transparent Mode on page 702

■ Understanding BA Traffic Classification on Transparent Mode Devices on page 703

■ Configuring and Applying BA Classifiers on Transparent Mode Devices on page 703

■ Understanding Rewrite of Packet Headers on Transparent Mode
Devices on page 704

■ Configuring and Applying Rewrite Rules on Transparent Mode Devices on page 705

Layer 2 Bridging and Transparent Mode Overview

On SRX3400, SRX3600, SRX5600, and SRX5800 devices, you can configure one or
more bridge domains to perform Layer 2 bridging. A bridge domain is a set of logical
interfaces that share the same flooding or broadcast characteristics. Like a virtual
LAN (VLAN), a bridge domain spans one or more ports of multiple devices. Thus, the
SRX Series device can function as a Layer 2 switch with multiple bridge domains
that participate in the same Layer 2 network.

In transparent mode, the SRX Series device filters packets that traverse the device
without modifying any of the source or destination information in the IP packet
headers. Transparent mode is useful for protecting servers that mainly receive traffic
from untrusted sources because there is no need to reconfigure the IP settings of
routers or protected servers.

NOTE: Transparent mode is supported only for IPv4 traffic.

In transparent mode, all physical ports on the device are assigned to Layer 2
interfaces. Do not route Layer 3 traffic through the device. Layer 2 zones can be
configured to host Layer 2 interfaces, and security policies can be defined between
Layer 2 zones. When packets travel between Layer 2 zones, security policies can be
enforced on these packets.

NOTE: Not all security features are supported in transparent mode:

■ NAT is not supported.

■ IPsec VPN is not supported.

■ Only DNS, FTP, RTSP, and TFTP ALGs are supported. Other ALGs are not
supported in this release.

Related Topics

■ Understanding Bridge Domains on page 677

■ Understanding Transparent Mode Conditions on page 679
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Understanding Bridge Domains

The packets that are forwarded within a bridge domain are determined by the VLAN
ID of the packets and the VLAN ID of the bridge domain. Only the packets with VLAN
IDs that match the VLAN ID configured for a bridge domain are forwarded within
the bridge domain.

When configuring bridge domains, you can specify either a single VLAN ID or a list
of specific VLAN IDs. If you specify a list of VLAN IDs, a bridge domain is created for
each VLAN ID in the list. Certain bridge domain properties, such as the integrated
routing and bridging interface (IRB), are not configurable if bridge domains are created
in this manner (see “Understanding Integrated Routing and Bridging Interfaces” on
page 692).

Each Layer 2 logical interface configured on the device is implicitly assigned to a
bridge domain based on the VLAN ID of the packets accepted by the interface (see
“Understanding Layer 2 Interfaces” on page 680). You do not need to explicitly define
the logical interfaces when configuring a bridge domain.

You can configure one or more static MAC addresses for a logical interface in a bridge
domain; this is only applicable if you specified a single VLAN ID when creating the
bridge domain.

NOTE: If a static MAC address you configure for a logical interface appears on a
different logical interface, packets sent to that interface are dropped.

You can configure the following properties that apply to all bridge domains on the
SRX Series device:

■ Disable or enable Layer 2 address learning. Layer 2 address learning is enabled
by default. A bridge domain learns unicast media access control (MAC) addresses
to avoid flooding packets to all interfaces in the bridge domain. Each bridge
domain creates a source MAC entry in its forwarding tables for each source MAC
address learned from packets received on interfaces that belong to the bridge
domain. When you disable MAC learning, source MAC addresses are not
dynamically learned, and any packets sent to these source addresses are flooded
into a bridge domain.

■ Maximum number of MAC addresses learned from all logical interfaces on the
SRX Series device. After the MAC address limit is reached, the default is for any
incoming packets with a new source MAC address to be forwarded. You can
specify that the packets be dropped instead. The default limit is 131,071 MAC
addresses. The range that you can configure is 16 through 131,071.

■ Timeout interval for MAC table entries. By default, the timeout interval for MAC
table entries is 300 seconds. The minimum you can configure is 10 seconds and
the maximum is 64,000 seconds. The timeout interval applies only to dynamically
learned MAC addresses. This value does not apply to configured static MAC
addresses, which never time out.
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Layer 2 Bridging Exceptions on SRX Series Devices

The bridging functions on the SRX3400, SRX3600, SRX5600, and SRX5800 devices
are similar to the bridging features on Juniper Networks MX Series routers. However,
the following Layer 2 networking features on MX Series routers are not supported
on SRX Series devices:

■ Layer 2 control protocols—These protocols are used on MX Series routers for
Rapid Spanning Tree Protocol (RSTP) or Multiple Spanning Tree Protocol (MSTP)
in customer edge interfaces of a VPLS routing instance.

■ Virtual switch routing instance—The virtual switching routing instance is used
on MX Series routers to group one or more bridge domains.

■ Virtual private LAN services (VPLS) routing instance—The VPLS routing instance
is used on MX Series routers for point-to-multipoint LAN implementations between
a set of sites in a VPN.

In addition, the SRX Series devices do not support the following Layer 2 features:

■ Spanning Tree Protocol (STP), RSTP, or MSTP—It is the user’s responsibility to
ensure that no flooding loops exist in the network topology.

■ Internet Group Management Protocol (IGMP) snooping

■ Double-tagged VLANs, or IEEE 802.1Q VLAN identifiers encapsulated within
802.1Q packets (also called “Q in Q” VLAN tagging)—Only untagged or
single-tagged VLAN identifiers are supported on SRX Series devices.

■ Nonqualified VLAN learning, where only the MAC address is used for learning
within the bridge domain—VLAN learning on SRX Series devices is qualified;
that is, both the VLAN identifier and MAC address are used.

Layer 2 Bridging Terms

Before configuring Layer 2 bridge domains, become familiar with the terms defined
in Table 180 on page 678.

Table 180: Layer 2 Bridging Terms

DefinitionTerm

Logical Layer 2 interface configured to accept untagged packets and to assign a specified VLAN
ID to the packets.

Access interface

A network component defined by the IEEE that forwards frames from one LAN segment or VLAN
to another. This bridging function can be contained in a router, LAN switch, or other specialized
device.

Bridge

A set of logical interfaces that share the same flooding or broadcast characteristics. As in a VLAN,
a bridge domain spans one or more ports of multiple devices. By default, each bridge domain
maintains its own forwarding database of MAC addresses learned from packets received on
interfaces that belong to that bridge domain.

Bridge domain
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Table 180: Layer 2 Bridging Terms (continued)

DefinitionTerm

JUNOS Software forwarding information base (also called the forwarding table). The JUNOS routing
protocol process installs active routes from its routing tables into the Routing Engine forwarding
table. The kernel copies this forwarding table into the Packet Forwarding Engine, which determines
the interface that transmits the packets.

Forwarding Information
Base (FIB)

Pseudointerface that contains both routing domain and bridge domain and facilitates simultaneous
Layer 2 bridging and Layer 3 routing within the same bridge domain. Packets arriving on an
interface of the bridge domain are switched or routed based on the destination MAC address.
Packets addressed to the router’s MAC address are routed to other Layer 3 interfaces.

Integrated routing and
bridging (IRB) interface

A MAC address database in the bridge domain where the MAC addresses are added based on
VLAN tags.

Learning domain

Logical Layer 2 interface that accepts any packets tagged with a VLAN ID that matches a specified
list of VLAN IDs.

Trunk interface

Defines a broadcast domain, a set of logical ports that share flooding or broadcast characteristics.
VLANs span one or more ports on multiple devices. By default, each VLAN maintains its own
Layer 2 forwarding database containing MAC addresses learned from packets received on ports
belonging to the VLAN.

VLAN

Related Topics

■ Configuring Bridge Domains on page 680

■ Understanding Integrated Routing and Bridging Interfaces on page 692

■ Understanding Layer 2 Forwarding Tables on page 696

Understanding Transparent Mode Conditions

A device operates in Layer 2 transparent mode when all physical interfaces on the
device are configured as Layer 2 interfaces. A physical interface is a Layer 2 interface
if its logical interface is configured with the bridge family.

There is no command to define or enable transparent mode on the device. The device
operates in transparent mode when there are interfaces defined as Layer 2 interfaces.
The device operates in route mode (the default mode) if there are no physical
interfaces configured as Layer 2 interfaces.

NOTE: In this release, the SRX Series device can operate at either route mode or
transparent mode, but not both modes at the same time. Changing the mode requires
a reboot of the device.

You can configure the fxp0 out-of-band management interface on the SRX Series
device as a Layer 3 interface, even if Layer 2 interfaces are defined on the device.
With the exception of the fxp0 interface, you must not define Layer 2 and Layer 3
interfaces on the device’s network ports.
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Related Topics

■ Understanding Layer 2 Interfaces on page 680

Understanding Layer 2 Interfaces

Layer 2 logical interfaces are created by defining one or more logical units on a
physical interface with the family address type bridge. If a physical interface has a
bridge family logical interface, it cannot have any other family type in its logical
interfaces. A logical interface can be configured in one of the following modes:

■ Access mode—Interface accepts untagged packets, assigns the specified VLAN
identifier to the packet, and forwards the packet within the bridge domain that
is configured with the matching VLAN identifier.

■ Trunk mode—Interface accepts any packet tagged with a VLAN identifier that
matches a specified list of VLAN identifiers. Trunk mode interfaces are generally
used to interconnect switches. To configure a VLAN identifier for untagged packets
received on the physical interface, use the native-vlan-id option. If the native-vlan-id
option is not configured, untagged packets are dropped.

Tagged packets arriving on a trunk mode interface can be rewritten or “retagged”
with a different VLAN identifier. This allows incoming packets to be selectively
redirected to a firewall or other security device. For more information, see
“Understanding VLAN Retagging” on page 689.

NOTE: Multiple trunk mode logical interfaces can be defined, as long as the VLAN
identifiers of a trunk interface do not overlap with those of another trunk interface.
The native-vlan-id must belong to a VLAN identifier list configured for a trunk interface.

Related Topics

■ Configuring Layer 2 Logical Interfaces on page 682

Configuring Bridge Domains

To configure a bridge domain, you must specify one or more VLAN identifiers; only
packets that contain a specified VLAN identifier are forwarded within the bridge
domain. A logical interface is implicitly assigned to a bridge domain based on the
VLAN identifier configured for the interface.

Before You Begin

For background information, read “Understanding Bridge Domains” on page 677.
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This example configures a bridge domain bd1 for VLANs 1 and 10, and a bridge
domain bd2 for VLAN 2. The number of MAC addresses learned on all logical
interfaces on the device is limited to 64,000 addresses; when this limit is reached,
incoming packets with a new source MAC address will be dropped.

You can use either J-Web or the CLI configuration editor to configure bridge domains.

This topic covers:

■ J-Web Configuration on page 681

■ CLI Configuration on page 682

■ Related Topics on page 682

J-Web Configuration

To configure bridge domains:

1. Select Configure>CLI Tools>Point and Click CLI.

The Configuration page appears.

2. Next to Bridge domains, click Configure or Edit.

3. Next to Domain, click Add new entry.

4. In the Domain name box, type bd1.

5. Next to Domain type, select bridge.

6. Next to Vlan choice, select Vlan id list.

7. In the Vlan id box, type 1,10.

8. Click OK to return to the Configuration page.

9. Select Bridge domains.

10. Next to Domain, click Add new entry.

11. In the Domain box , type bd2

12. Next to Domain type, select bridge.

13. Next to Vlan choice, select Vlan id.

14. Next to Vlan id, select Enter a specific value.

15. In the Vlan id box, type 2.

16. Click OK to return to the Configuration page.

To limit the number of MAC addresses learned on all logical interfaces on the device:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Protocols, click Configure or Edit.

3. Next to L2 learning, click Configure.

4. Select Global mac limit, then click Configure.

5. In the Mac limit box, type 64000.
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6. Next to packet action, select Drop.

7. Click OK to return to the L2 learning page.

8. Click OK to return to the Protocols page.

9. Click OK to return to the Configuration page.

CLI Configuration

To configure bridge domains:

user@host# set bridge-domains bd1 domain-type bridge vlan-id-list 1,10
user@host# set bridge-domains bd2 domain-type bridge vlan-id 2

To limit the number of MAC addresses learned on all logical interfaces on the device:

user@host# set protocols l2-learning global-mac-limit 64000 packet-action drop

Related Topics

■ Configuring Layer 2 Logical Interfaces on page 682

■ Configuring an IRB Interface on page 694

Configuring Layer 2 Logical Interfaces

To configure a Layer 2 logical interface as an access interface, you must specify the
VLAN identifier that the interface assigns to untagged packets. To configure a Layer
2 logical interface as a trunk interface, you specify one or more VLAN identifiers
accepted by the interface.

Before You Begin

For background information, read “Understanding Layer 2 Interfaces” on page 680. Refer to the
example configuration in “Configuring Bridge Domains” on page 680.

This example configures logical interface ge-3/0/0.0 as a trunk port that carries traffic
for packets tagged with VLAN identifiers 1 through 10; this interface is implicitly
assigned to the previously configured bridge domains bd1 and bd2. Any untagged
packets received on the physical interface ge-3/0/0 are assigned the VLAN identifier
10.

You can use either J-Web or the CLI configuration editor to configure Layer 2 logical
interfaces.
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This topic covers:

■ J-Web Configuration on page 683

■ CLI Configuration on page 683

■ Related Topics on page 684

J-Web Configuration

To configure a Layer 2 logical interface as a trunk port:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, select ge-3/0/0.

4. Under Unit, in the Interface unit number column, click 0.

5. Next to Family group, select Bridge and then click Configure.

6. Next to Interface mode, select trunk.

7. Next to Vlan list, select Vlan id list.

8. In the Vlan id box, type 1–10.

9. Click OK to return to the Family page.

10. Click OK to return to the Unit page.

11. Click OK to return to the Interface page.

12. Click OK to return to the Interfaces page.

To configure a VLAN ID for untagged packets received on a physical interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, select ge-3/0/0.

4. In the Native vlan id box, type 10.

5. Next to Vlan tag mode, select Vlan tagging.

6. Click OK to return to the Interfaces page.

CLI Configuration

To configure a Layer 2 logical interface as a trunk port:

user@host# set interfaces ge-3/0/0 unit 0 family bridge interface-mode trunk
vlan-id-list 1–10

To configure a VLAN identifier for untagged packets received on a physical interface:

user@host# set interfaces ge-3/0/0 vlan-tagging native-vlan-id 10
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Related Topics

■ Configuring Bridge Domains on page 680

■ Creating Layer 2 Security Zones on page 686

Understanding Layer 2 Security Zones

A Layer 2 security zone is a zone that hosts Layer 2 interfaces. A security zone can
be either a Layer 2 or Layer 3 zone; it can host either all Layer 2 interfaces or all
Layer 3 interfaces, but it cannot contain a mix of Layer 2 and Layer 3 interfaces.

The security zone type—Layer 2 or Layer 3—is implicitly set from the first interface
configured for the security zone. Subsequent interfaces configured for the same
security zone must be the same type as the first interface.

NOTE: In this release, you cannot configure a device with both Layer 2 and Layer 3
security zones.

You can configure the following properties for Layer 2 security zones:

■ Interfaces—List of interfaces in the zone.

■ Policies—Active security policies that enforce rules for the transit traffic, in terms
of what traffic can pass through the firewall, and the actions that need to take
place on the traffic as it passes through the firewall.

■ Screens—A Juniper Networks stateful firewall secures a network by inspecting,
and then allowing or denying, all connection attempts that require passage from
one security zone to another. For every security zone, and the MGT zone, you
can enable a set of predefined screen options that detect and block various kinds
of traffic that the device determines as potentially harmful.

NOTE: You can configure the same screen options for a Layer 2 security zone as for
a Layer 3 security zone, with the exception of IP spoofing. Detection of IP spoofing
is not supported on Layer 2 security zones. For more information about configuring
screen options, see the Junos OS Security Configuration Guide.

■ Address books—IP addresses and address sets that make up an address book
to identify its members so that you can apply policies to them.

■ TCP-RST—When this feature is enabled, the system sends a TCP segment with
the reset flag set when traffic arrives that does not match an existing session
and does not have the synchronize flag set.

In addition, you can configure a Layer 2 zone for host-inbound traffic. This allows
you to specify the kinds of traffic that can reach the device from systems that are
directly connected to the interfaces in the zone. You must specify all expected
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host-inbound traffic because inbound traffic from devices directly connected to the
device's interfaces is dropped by default.

For more information about security zones and configuring security zone properties,
see the Junos OS Security Configuration Guide.

Related Topics

■ Creating Layer 2 Security Zones on page 686

■ Configuring Layer 2 Logical Interfaces on page 682

Understanding Security Policies in Transparent Mode

In transparent mode, security policies can be configured only between Layer 2 zones.
When packets are forwarded through the bridge domain, the security policies are
applied between security zones. A security policy for transparent mode is similar to
a policy configured for Layer 3 zones, with the following exceptions:

■ NAT is not supported.

■ IPsec VPN is not supported.

■ Junos-H323 ALGs and IDP are not supported.

■ Application ANY is used.

Layer 2 forwarding does not permit any interzone traffic unless there is a policy
explicitly configured on the device. By default, Layer 2 forwarding performs the
following actions:

■ Allows or denies traffic specified by the configured policy.

■ Allows Address Resolution Protocol (ARP) and Layer 2 non-IP multicast and
broadcast traffic. The device can receive and pass Layer 2 broadcast traffic for
STP.

■ Continues to block all non-IP and non-ARP unicast traffic.

This default behavior can be changed for bridge packet flow by using either J-Web
or the CLI configuration editor:

■ Configure the block-non-ip-all option to block all Layer 2 non-IP and non-ARP
traffic, including multicast and broadcast traffic.

■ Configure the bypass-non-ip-unicast option to allow all Layer 2 non-IP traffic to
pass through the device.

NOTE: You cannot configure both options at the same time.

For more information about security policies, see Junos OS Security Configuration
Guide.
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Related Topics

■ Configuring Security Policies for Transparent Mode on page 687

■ Changing the Default Forwarding Behavior on page 691

Creating Layer 2 Security Zones

A Layer 2 security zone is a zone that hosts Layer 2 interfaces.

Before You Begin

For background information, read “Understanding Layer 2 Security Zones” on page 684.

This example configures the security zone l2–zone1 to include the previously
configured Layer 2 logical interface ge-3/0/0.0 and security zone l2-zone2 to include
the Layer 2 logical interface ge-3/0/1.0. In addition, l2-zone2 is configured to allow
all supported application services (such as SSH, Telnet, SNMP, and other services)
as host-inbound traffic.

You can use either J-Web or the CLI configuration editor to configure Layer 2 security
zones.

This topic covers:

■ J-Web Configuration on page 686

■ CLI Configuration on page 687

■ Related Topics on page 687

J-Web Configuration

To create a Layer 2 security zone:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Security, click Configure or Edit.

3. Next to Zones, click Configure.

4. Next to Security zone, click Add new entry.

5. In the Name box, type l2–zone1, and then click OK to return to the Security
Zones page.

To create a Layer 2 security zone and allow host-bound traffic:

1. Next to Security zone, click Add new entry.

2. In the Name box, type l2–zone2.

3. Next to Host inbound traffic, click Configure.
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4. To allow the security zone to use all supported application services, next to
System services, click Add new entry.

5. From the Service name list, select All, and then click OK.

6. Click OK to return to the Security Zones page.

To configure an interface and assign it to the created security zone:

1. On the Security Zones page, next to the newly created security zone l2–zone1,
click Edit.

2. Next to Interfaces, click Add new entry.

3. In the Interface unit box, type ge-3/0/0.0, and then click OK to return to the
Security Zones page.

4. Next to the newly created security zone l2–zone2, click Edit.

5. Next to Interfaces, click Add new entry.

6. In the Interface unit box, type ge-3/0/1.0, and then click OK to return to the
Security Zones page.

7. Click OK to return to the Zones page.

8. Click OK to return to the Security page.

CLI Configuration

To create a Layer 2 security zone and assign interfaces to the zone:

user@host# set security zones security-zone l2–zone1 interfaces ge-3/0/0.0
user@host# set security zones security-zone l2–zone2 interfaces ge-3/0/1.0

To configure a Layer 2 security zone to allow host-inbound traffic:

user@host# set security zones security-zone l2–zone2 host-inbound-traffic
system-services all

Related Topics

■ Configuring Layer 2 Logical Interfaces on page 682

■ Configuring Security Policies for Transparent Mode on page 687

Configuring Security Policies for Transparent Mode

In transparent mode, security policies can be configured only between Layer 2 zones.

Before You Begin

For background information, read “Understanding Security Policies in Transparent Mode” on
page 685.
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This example configures a security policy to allow HTTP traffic from the 10.1.1.1/24
subnetwork in the l2–zone1 security zone to the server at 20.1.1.1/32 in l2–zone2.

You can use either J-Web or the CLI configuration editor to configure Layer 2 security
zones.

This topic covers:

■ J-Web Configuration on page 688

■ CLI Configuration on page 689

■ Related Topics on page 689

J-Web Configuration

To configure Layer 2 security policies:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Security, select Configure or Edit.

3. Next to Policy, select the check box, and then click Configure.

4. Next to Policy, click Add new entry.

5. In the From zone name box, type l2–zone1.

6. In the To zone name box, type l2–zone2.

7. Next to Policy, click Add new entry.

8. In the Policy name box, type p1.

9. Select the Match check box, then click Configure.

10. From the Source address choice list, select Source address.

11. Next to Source address, click Add new entry.

12. From the Value keyword list, select Enter specific value.

13. In the Address box, type 10.1.1.1/24, and then click OK.

14. From the Destination address choice list, select Destination address.

15. Next to Destination address, click Add new entry.

16. In the Value keyword list, select Enter specific value.

17. In the Address box, type 20.1.1.1/32 , and then click OK.

18. To match the policy to an application set name, from the Application choice list,
select Application.

19. Next to Application, click Add new entry.

20. To specify the application set name to match the policy, in the Value keyword
list box type http, and then click OK.

21. Select the Then check box, and then click Configure.

22. From the Action list, select Permit, and then click OK.
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CLI Configuration

To configure Layer 2 security policies:

user@host# set security policies from-zone l2–zone1 to-zone l2–zone2 policy p1
match source-address 10.1.1.1/24

user@host# set security policies from-zone l2–zone1 to-zone l2–zone2 policy p1
match destination-address 20.1.1.1/32

user@host# set security policies from-zone l2–zone1 to-zone l2–zone2 policy p1
match application http

user@host# set security policies from-zone l2–zone1 to-zone l2–zone2 policy p1
then permit

Related Topics

■ Changing the Default Forwarding Behavior on page 691

Understanding VLAN Retagging

The VLAN identifier in packets arriving on a Layer 2 trunk port can be rewritten or
“retagged” with a different internal VLAN identifier. VLAN retagging is a symmetric
operation; upon exiting the same trunk port, the retagged VLAN identifier is replaced
with the original VLAN identifier. VLAN retagging provides a way to selectively screen
incoming packets and redirect them to a firewall or other security device without
affecting other VLAN traffic.

VLAN retagging can be applied only to interfaces configured as Layer 2 trunk
interfaces. These interfaces can include redundant Ethernet interfaces in a Layer 2
transparent mode chassis cluster configuration.

NOTE: If a trunk port is configured for VLAN retagging, untagged packets received
on the port cannot be assigned a VLAN identifier with the VLAN retagging
configuration. To configure a VLAN identifier for untagged packets received on the
physical interface, use the native-vlan-id statement.

To configure VLAN retagging for a Layer 2 trunk interface, specify a one-to-one
mapping of the following:

■ Incoming VLAN identifier—VLAN identifier of the incoming packet that is to be
retagged. This VLAN identifier must not be the same VLAN identifier configured
with the native-vlan-id statement for the trunk port.

■ Internal VLAN identifier—VLAN identifier for the retagged packet. This VLAN
identifier must be in the VLAN identifier list for the trunk port and must not be
the same VLAN identifier configured with the native-vlan-id statement for the
trunk port.
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Related Topics

■ Configuring VLAN Retagging on page 690

Configuring VLAN Retagging

Configuring VLAN retagging on a Layer 2 trunk interface requires a one-to-one
mapping of the incoming and internal VLAN identifiers.

Before You Begin

For background information, read:

■ Understanding VLAN Retagging on page 689

In the following example, a Layer 2 trunk interface is configured to receive packets
with VLAN identifiers 1 through 10. Packets that arrive on the interface with VLAN
identifier 11 are retagged with VLAN identifier 2. Before exiting the trunk interface,
VLAN identifier 2 in the retagged packets is replaced with VLAN identifier 11.

You can use either J-Web or the CLI configuration editor to configure VLAN retagging.

This topic covers:

■ J-Web Configuration on page 690

■ CLI Configuration on page 691

■ Related Topics on page 691

J-Web Configuration

To create a Layer 2 trunk interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, select ge-3/0/0.

4. Under Unit, in the Interface unit number column, click 0.

5. Next to Family group, select Bridge and then click Configure.

6. Next to Interface mode, select trunk.

7. Next to Vlan list, select Vlan id list.

8. In the Vlan id box, type 1–10.

To configure VLAN retagging:
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1. Next to Vlan rewrite, click Configure.

2. Next to Translate, click Add new entry.

3. In the From vlan id box, type 11.

4. In the To vlan id box, type 2.

5. Click OK to return to the Vlan rewrite page.

6. Click OK to return to the Family page.

7. Click OK to return to the Unit page.

8. Click OK to return to the Interface page.

9. Click OK to return to the Interfaces page.

CLI Configuration

To create a Layer 2 trunk interface:

user@host# set interface ge-3/0/0 unit 0 family bridge interface-mode trunk
vlan-id-list 1–10

To configure VLAN retagging:

user@host# set interface xe-9/3/0 unit 0 family bridge vlan-rewrite translate 11 2

Related Topics

■ Configuring Layer 2 Logical Interfaces on page 682

Changing the Default Forwarding Behavior

By default, Layer 2 forwarding on the device allows or denies traffic specified by the
configured policy and allows ARP and Layer 2 non-IP multicast and broadcast traffic.
You can configure the device to block all Layer 2 non-IP and non-ARP traffic.

Before You Begin

For background information, read “Understanding Security Policies in Transparent Mode” on
page 685.

You can use either J-Web or the CLI configuration editor to change the default
forwarding behavior on the device.

This topic covers:

■ J-Web Configuration on page 692

■ CLI Configuration on page 692

■ Related Topics on page 692
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J-Web Configuration

To block all Layer 2 non-IP and non-ARP traffic:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Security, click Configure or Edit.

3. Next to Flow, click Configure or Edit.

4. Next to Bridge, click Configure.

5. Select Block non ip all.

6. Click OK to return to the Flow page.

7. Click OK to return to the Security page.

To allow all Layer 2 non-IP traffic to pass through the device:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Security, click Configure or Edit.

3. Next to Flow, click Configure or Edit.

4. Next to Bridge, click Configure.

5. Select Bypass non ip unicast.

6. Click OK to return to the Flow page.

7. Click OK to return to the Security page.

CLI Configuration

To block all Layer 2 non-IP and non-ARP traffic:

user@host# set security flow bridge block-non-ip-all

To allow all Layer 2 non-IP traffic to pass through the device:

user@host# set security flow bridge bypass-non-ip-unicast

Related Topics

■ Configuring Security Policies for Transparent Mode on page 687

Understanding Integrated Routing and Bridging Interfaces

For bridge domains configured with a single VLAN identifier, you can optionally
configure an integrated routing and bridging (IRB) interface for management traffic
in the bridge domain. An IRB interface acts as a Layer 3 routing interface for a bridge
domain.
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NOTE: If you specify a VLAN identifier list in the bridge domain configuration, you
cannot configure an IRB interface for the bridge domain.

In this release, the IRB interface on the SRX Series device does not support traffic
forwarding or routing. In transparent mode, packets arriving on a Layer 2 interface
that are destined for the device’s MAC address are classified as Layer 3 traffic while
packets that are not destined for the device’s MAC address are classified as Layer 2
traffic. Packets destined for the device’s MAC address are sent to the IRB interface.
Packets from the device’s routing engine are sent out the IRB interface.

You create an IRB logical interface in a similar manner as a Layer 3 interface, but
the IRB interface does not support traffic forwarding or routing. The IRB interface
cannot be assigned to a security zone; however, you can configure certain services
on a per-zone basis to allow host-inbound traffic for management of the device. This
allows you to control the type of traffic that can reach the device from interfaces
bound to a specific zone.

NOTE: You can configure only one IRB logical interface for each bridge domain.

To configure an IRB logical interface:

1. Configure a logical interface by using the irb interface in the [edit interfaces]
hierarchy.

2. Reference the IRB logical interface in the bridge domain configuration.

Related Topics

■ Configuring an IRB Interface on page 694

Understanding Firewall User Authentication in Transparent Mode

A firewall user is a network user who must provide a username and password for
authentication when initiating a connection across the firewall. Firewall user
authentication enables administrators to restrict and permit users accessing protected
resources behind a firewall based on their source IP address and other credentials.
JUNOS Software supports the following types of firewall user authentication for
transparent mode on the SRX Series device:

■ Pass-through authentication—A host or a user from one zone tries to access
resources on another zone. You must use an FTP, Telnet, or HTTP client to access
the IP address of the protected resource and be authenticated by the firewall.
The device uses FTP, Telnet, or HTTP to collect username and password
information, and subsequent traffic from the user or host is allowed or denied
based on the result of this authentication.

■ Web authentication—Users try to connect, by using HTTP, to an IP address on
the IRB interface that is enabled for Web authentication (see “Configuring an
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IRB Interface” on page 694). You are prompted for the username and password
that are verified by the device. Subsequent traffic from the user or host to the
protected resource is allowed or denied based on the result of this authentication.

For information about configuring pass-through or Web authentication, see the Junos
OS Security Configuration Guide.

Related Topics

■ Configuring an IRB Interface on page 694

Configuring an IRB Interface

To configure an IRB interface, you first create an IRB logical interface, and then
reference the interface in the bridge domain configuration. Configure a security zone
to control the host-inbound traffic from systems that are directly connected to the
interfaces in the zone.

NOTE: An IRB interface can be configured only for a bridge domain defined with a
single VLAN identifier. In a previous example, bridge domain bd1 was configured
with a VLAN identifier list; you would not be able to add the IRB interface to the bd1
bridge domain.

Before You Begin

For background information, read “Understanding Integrated Routing and Bridging Interfaces”
on page 692 and “Understanding Firewall User Authentication in Transparent Mode” on page 693.

In this example, you configure an IRB logical unit 0 with the family type inet and IP
address 10.1.1.1/24, and then reference the IRB interface in the bd2 bridge domain
configuration. This example also enables Web authentication on the IRB interface
and actives the webserver on the device.

NOTE: To complete the Web authentication configuration, you will also need to
define the following:

■ Access profile and password for a Web authentication client

■ Security policy that enables Web authentication for the client

Either the local database or an external authentication server can be used as the Web
authentication server. For more information about configuring Web authentication,
see the Junos OS Security Configuration Guide.

You can use either J-Web or the CLI configuration editor to configure an IRB interface.
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This topic covers:

■ J-Web Configuration on page 695

■ CLI Configuration on page 696

■ Related Topics on page 696

J-Web Configuration

To configure an IRB interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. In the Interface name column, select irb.

4. Under Unit, in the Interface unit number column, click 0.

5. Next to Family group, select Inet, and then click Configure.

6. Next to Address, click Add new entry.

7. In the Source box, type the address 10.1.1.1/24.

8. Next to Web authentication, click Configure.

9. Select the Http check box, and then click OK.

10. Click OK to return to the Unit page.

11. Click OK to return to the Interface page.

12. Click OK to return to the Interfaces page.

To reference the IRB interface in a bridge domain:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Bridge domains, click Configure or Edit .

3. Next to Domain, click bd2.

4. In the Routing interface box, type irb.0.

5. Click OK to return to the Configuration page.

To activate the webserver on the device:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to System, click Configure.

3. Next to Services, select the check box, and then click Configure.

4. Next to Web management, click Configure.

5. Select the Http check box, and then click OK.

6. Click OK to return to the Services page.

7. Click OK to return to the System page.

8. Click OK to return to the Configuration page.
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CLI Configuration

To configure an IRB interface:

user@host# set interface irb unit 0 family inet address 10.1.1.1/24
web-authentication http

To reference the IRB interface in a bridge domain:

user@host# set bridge-domains bd2 routing-interface irb.0

To activate the webserver on the device:

user@host# set system services web-management http

Related Topics

■ Configuring Bridge Domains on page 680

■ Creating Layer 2 Security Zones on page 686

Understanding Layer 2 Forwarding Tables

The SRX Series device maintains forwarding tables that contain MAC addresses and
associated interfaces for each Layer 2 bridge domain. When a packet arrives with a
new source MAC address in its frame header, the device adds the MAC address to
its forwarding table and tracks the interface at which the packet arrived. The table
also contains the corresponding interface through which the device can forward
traffic for a particular MAC address.

If the destination MAC address of a packet is unknown to the device (that is, the
destination MAC address in the packet does not have an entry in the forwarding
table), the device duplicates the packet and floods it on all interfaces in the bridge
domain other than the interface on which the packet arrived. This is known as packet
flooding and is the default behavior for the device to determine the outgoing interface
for an unknown destination MAC address. Packet flooding is performed at two levels:
packets are flooded to different zones as permitted by configured Layer 2 security
policies, and packets are also flooded to different interfaces with the same VLAN
identifier within the same zone. The device learns the forwarding interface for the
MAC address when a reply with that MAC address arrives at one of its interfaces.

You can specify that the SRX Series device use ARP queries and trace-route requests
(which are ICMP echo requests with the time-to-live values set to 1) instead of packet
flooding to locate an unknown destination MAC address. This method is considered
more secure than packet flooding because the device floods ARP queries and
trace-route packets—not the initial packet—on all interfaces. When ARP or trace-route
flooding is used, the original packet is dropped. The device broadcasts an ARP or
ICMP query to all other devices on the same subnetwork, requesting the device at
the specified destination IP address to send back a reply. Only the device with the
specified IP address replies, which provides the requestor with the MAC address of
the responder.
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ARP allows the device to discover the destination MAC address for a unicast packet
if the destination IP address is in the same subnetwork as the ingress IP address.
(The ingress IP address refers to the IP address of the last device to send the packet
to the device. The device might be the source that sent the packet or a router
forwarding the packet.) Trace-route allows the device to discover the destination
MAC address even if the destination IP address belongs to a device in a subnetwork
beyond that of the ingress IP address.

When you enable ARP queries to locate an unknown destination MAC address,
trace-route requests are also enabled. You can also optionally specify that trace-route
requests not be used; however, the device can then discover destination MAC
addresses for unicast packets only if the destination IP address is in the same
subnetwork as the ingress IP address.

Whether you enable ARP queries and trace-route requests or ARP-only queries to
locate unknown destination MAC addresses, the SRX Series device performs the
following series of actions:

1. The device notes the destination MAC address in the initial packet. The device
adds the source MAC address and its corresponding interface to its forwarding
table, if they are not already there.

2. The device drops the initial packet.

3. The device generates an ARP query packet and optionally a trace-route packet
and floods those packets out all interfaces except the interface on which the
initial packet arrived.

ARP packets are sent out with the following field values:

■ Source IP address set to the IP address of the IRB

■ Destination IP address set to the destination IP address of the original packet

■ Source MAC address set to the MAC address of the IRB

■ Destination MAC address set to the broadcast MAC address (all 0xf)

Trace-route (ICMP echo request or ping) packets are sent out with the following
field values:

■ Source IP address set to the IP address of the original packet

■ Destination IP address set to the destination IP address of the original packet

■ Source MAC address set to the source MAC address of the original packet

■ Destination MAC address set to the destination MAC address of the original
packet

■ Time-to-live (TTL) set to 1

4. Combining the destination MAC address from the initial packet with the interface
leading to that MAC address, the device adds a new entry to its forwarding table.

5. The device forwards all subsequent packets it receives for the destination MAC
address out the correct interface to the destination.
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Related Topics

■ Changing the Default Learning for Unknown MAC Addresses on page 698

Changing the Default Learning for Unknown MAC Addresses

By default, the Juniper Networks device uses packet flooding to learn the outgoing
interface for an unknown destination MAC address. You can specify that the device
use ARP and trace-route packets or only ARP requests to learn this information.

Before You Begin

For background information, read “Understanding Layer 2 Forwarding Tables” on page 696.

This example configures the device to use ARP queries without trace-route requests
to learn the outgoing interface for an unknown destination MAC address.

You can use either J-Web or the CLI configuration editor to change the device’s default
method for learning unknown MAC addresses.

This topic covers:

■ J-Web Configuration on page 698

■ CLI Configuration on page 699

■ Related Topics on page 699

J-Web Configuration

To enable the device to use only ARP requests to learn unknown destination MAC
addresses:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Security, click Configure or Edit.

3. Next to Flow, click Configure or Edit.

4. Next to Bridge, click Configure.

5. Select No packet flooding, and select Configure.

6. Select No trace route.

7. Click OK to return to the Bridge page.

8. Click OK to return to the Flow page.

9. Click OK to return to the Security page.
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CLI Configuration

To enable the device to use only ARP requests to learn unknown destination MAC
addresses:

user@host# set security flow bridge no-packet-flooding no-trace-route

Related Topics

■ Changing the Default Forwarding Behavior on page 691

Understanding Layer 2 Transparent Mode Chassis Clusters

A pair of SRX Series devices in Layer 2 transparent mode can be connected in a
chassis cluster to provide network node redundancy. When configured in a chassis
cluster, one node acts as the primary device and the other as the secondary device,
ensuring stateful failover of processes and services in the event of system or hardware
failure. If the primary device fails, the secondary device takes over processing of
traffic.

NOTE:  If the primary device fails in a Layer 2 transparent mode chassis cluster, the
physical ports in the failed device become inactive (go down) for a few seconds
before they become active (come up) again.

To form a chassis cluster, a pair of the same kind of supported SRX Series devices
combines to act as a single system that enforces the same overall security. For more
information about chassis clusters and configuring SRX Series devices in chassis
cluster formations, see the Junos OS Security Configuration Guide.

Devices in Layer 2 transparent mode can be deployed in active/backup and
active/active chassis cluster configurations.

The following chassis cluster features are not supported for devices in Layer 2
transparent mode:

■ Gratuitous ARP—The newly elected master in a redundancy group cannot send
gratuitous ARP requests to notify network devices of a change in mastership on
the redundant Ethernet interface links.

■ IP address monitoring—Failure of an upstream device cannot be detected.

A redundancy group is a construct that includes a collection of objects on both nodes.
A redundancy group is primary on one node and backup on the other. When a
redundancy group is primary on a node, its objects on that node are active. When
a redundancy group fails over, all its objects fail over together.

You can create one or more redundancy groups numbered 1 through 128 for an
active/active chassis cluster configuration. Each redundancy group contains one or
more redundant Ethernet interfaces. A redundant Ethernet interface is a
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pseudointerface that contains physical interfaces from each node of the cluster. The
physical interfaces in a redundant Ethernet interface must be the same kind—either
Fast Ethernet or Gigabit Ethernet. If a redundancy group is active on node 0, then
the child links of all associated redundant Ethernet interfaces on node 0 are active.
If the redundancy group fails over to the node 1, then the child links of all redundant
Ethernet interfaces on node 1 become active.

NOTE: The maximum number of redundancy groups is equal to the number of
redundant Ethernet interfaces that you configure.

Configuring redundant Ethernet interfaces on a device in Layer 2 transparent mode
is similar to configuring redundant Ethernet interfaces on a device in Layer 3 route
mode, with the following difference: the redundant Ethernet interface on a device
in Layer 2 transparent mode is configured as a Layer 2 logical interface (see
“Understanding Layer 2 Interfaces” on page 680 and “Configuring Layer 2 Logical
Interfaces” on page 682).

The redundant Ethernet interface may be configured as either an access interface
(with a single VLAN ID assigned to untagged packets received on the interface) or as
a trunk interface (with a list of VLAN IDs accepted on the interface and, optionally,
a native-vlan-id for untagged packets received on the interface). Physical interfaces
(one from each node in the chassis cluster) are bound as child interfaces to the parent
redundant Ethernet interface.

In Layer 2 transparent mode, MAC learning is based on the redundant Ethernet
interface. The MAC table is synchronized across redundant Ethernet interfaces and
Services Processing Units (SPUs) between the pair of chassis cluster devices.

In this release, the IRB interface is used only for management traffic, and it cannot
be assigned to any redundant Ethernet interface or redundancy group.

All JUNOS screen options that are available for a single, nonclustered device are
available for devices in Layer 2 transparent mode chassis clusters.

Related Topics

■ Configuring Redundant Ethernet Interfaces for Layer 2 Transparent Mode Chassis
Clusters on page 700

Configuring Redundant Ethernet Interfaces for Layer 2 Transparent Mode Chassis
Clusters

On a device in a Layer 2 transparent mode chassis cluster, the redundant Ethernet
interface is configured as a Layer 2 logical interface. Physical interfaces are bound
to the parent redundant Ethernet interface. This topic describes how to configure
the redundant Ethernet interface as a Layer 2 logical interface and how to bind
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physical interfaces (one from each node in the chassis cluster) to the redundant
Ethernet interface.

Before You Begin

For background information, read:

■ “Chassis Clusters” in the Junos OS Security Configuration Guide

■ Understanding Layer 2 Transparent Mode Chassis Clusters on page 699

In this example, you create a redundant Ethernet interface reth0 for redundancy
group 1 and configure reth0 as an access interface with the VLAN identifier 1. Physical
interfaces are then bound to reth0.

NOTE: Spanning-tree protocols are not supported for Layer 2 transparent mode in
this release. You are responsible for ensuring that there are no loop connections in
the deployment topology.

You can use either the J-Web or CLI configuration editor to configure a redundant
Ethernet interface for a device in Layer 2 transparent mode.

This topic covers:

■ J-Web Configuration on page 701

■ CLI Configuration on page 702

J-Web Configuration

To configure a redundant Ethernet interface as a Layer 2 logical interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. Next to Interface, click Add new entry.

4. In the Interface name box, enter reth0.

5. Next to Redundant ether options, click Configure.

6. In the Redundancy group box, enter 1.

7. Click OK to return to the Interface page.

8. Next to Unit, click Add new entry.

9. In the Interface unit number box, enter 0.

10. Under Family, click the Bridge check box, then click Configure.

11. For Interface mode, select Access.

12. From the VLAN ID list, select 1.

13. Click OK.
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To assign a child physical interface on a chassis cluster node to the redundant Ethernet
interface:

1. Select Configure>CLI Tools>Point and Click CLI.

2. Next to Interfaces, click Configure or Edit.

3. For the physical interface, click Edit.

4. Next to Gigether options, click Configure.

5. Next to Redundant parent, click Configure.

6. In the Parent box, enter reth0.

7. Click OK.

CLI Configuration

To configure a redundant Ethernet interface as a Layer 2 logical interface:

user@host# set interfaces reth0 redundant-ether-options redundancy-group 1
user@host# set interfaces reth0 unit 0 family bridge interface-mode access vlan-id

1

To assign a physical interface on a chassis cluster node to the redundant Ethernet
interface:

user@host# set interface ge-2/0/2 gigether-options redundant-parent reth0

Overview of Class of Service Functions in Transparent Mode

Devices operating in Layer 2 transparent mode support the following Class-of-Service
(CoS) functions:

■ IEEE 802.1p behavior aggregate (BA) classifiers to determine the forwarding
treatment for packets entering the device

Note that only IEEE 802.1p BA classifier types are supported on devices operating
in transparent mode.

■ Rewrite rules to redefine IEEE 802.1 CoS values in outgoing packets

Note that rewrite rules that redefine IP precedence CoS values and Differentiated
Services Code Point (DSCP) CoS values are not supported on devices operating
in transparent mode.

■ Shapers to apply rate limiting to an interface

■ Schedulers that define the properties of an output queue

For more information about CoS components and configuring CoS on SRX Series
devices, see Junos OS Class of Service Configuration Guide for Security Devices.

You configure BA classifiers and rewrite rules on transparent mode devices in the
same way as on devices operating in Layer 3 mode. For transparent mode devices,
however, you apply BA classifiers and rewrite rules only to logical interfaces configured
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with the family bridge configuration statement. For more information about configuring
Layer 2 logical interfaces, see “Configuring Layer 2 Logical Interfaces” on page 682.

Related Topics Understanding BA Traffic Classification on Transparent Mode Devices on page 703■

■ Understanding Rewrite of Packet Headers on Transparent Mode Devices on
page 704

Understanding BA Traffic Classification on Transparent Mode Devices

A BA classifier checks the header information of an ingress packet. The resulting
traffic classification consists of a forwarding class (FC) and packet loss priority (PLP).
The FC and PLP associated with a packet specify the CoS behavior of a hop within
the system. For example, a hop can place a packet into a priority queue according
to its FC, and manage queues by checking the packet's PLP. JUNOS Software supports
up to eight FCs and four PLPs.

NOTE: MPLS EXP bit-based traffic classification is not supported.

BA classification can be applied within one DiffServ domain. BA classification can
also be applied between two domains, where each domain honors the CoS results
generated by the other domain. JUNOS Software performs BA classification for a
packet by examining its Layer 2 and Layer 3 CoS-related parameters. Those
parameters include the following:

■ Layer 2—IEEE 802.1p: User Priority

■ Layer 3—IPv4 Precedence, IPv4 DSCP, IPv6 DSCP

On SRX Series devices in transparent mode, a BA classifier evaluates only Layer 2
parameters. On SRX Series devices in Layer 3 mode, a BA classifier can evaluate
Layer 2 and Layer 3 parameters; in that case, classification resulting from Layer 3
parameters overrides that of Layer 2 parameters.

On SRX Series devices in transparent mode, you specify one of four PLP levels—high,
medium-high, medium-low, or low—when configuring a BA classifier.

Related Topics ■ Configuring and Applying BA Classifiers on Transparent Mode Devices on page 703

Configuring and Applying BA Classifiers on Transparent Mode Devices

In this example, the logical interface ge-0/0/4.0 is configured as a trunk port that
carries traffic for packets tagged with VLAN identifiers 200 through 390. This example
creates a BA classifier c1 for IEEE 802.1 traffic where incoming packets with IEEE
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802.1p priority bits 110 are assigned to the forwarding class fc1 with a low loss
priority. The BA classifier c1 is applied to interface ge-0/0/4.0.

Before You Begin

For background information, read:

■ Understanding BA Traffic Classification on Transparent Mode Devices on page 703

■ “Configuring Layer 2 Logical Interfaces” on page 682“

CLI Configuration

To configure the ge-0/0/4.0 logical interface as a Layer 2 trunk port:

user@host# set interfaces ge-0/0/0 vlan-tagging unit 0 family bridge interface-mode
trunk vlan-id-list 200–390

To configure the forwarding classes:

user@host# set class-of-service forwarding-classes queue 0 fc1
user@host# set class-of-service forwarding-classes queue 1 fc2
user@host# set class-of-service forwarding-classes queue 3 fc4
user@host# set class-of-service forwarding-classes queue 4 fc5
user@host# set class-of-service forwarding-classes queue 5 fc6
user@host# set class-of-service forwarding-classes queue 6 fc7
user@host# set class-of-service forwarding-classes queue 7 fc8
user@host# set class-of-service forwarding-classes queue 2 fc3

To configure a BA classifier:

user@host# set class-of-service classifiers ieee-802.1 c1 forwarding-class fc1
loss-priority low code-points 110

To apply the BA classifier to the ge-0/0/4.0 interface:

user@host# set class-of-service interfaces ge-0/0/4 unit 0 classifiers ieee-802.1
c1

Understanding Rewrite of Packet Headers on Transparent Mode Devices

Before a packet is transmitted from an interface, the CoS fields in the packet's header
can be rewritten for the forwarding class (FC) and packet loss priority (PLP) of the
packet. The rewriting function converts a packet's FC and PLP into corresponding
CoS fields in the packet header. In Layer 2 transparent mode, the CoS fields are the
IEEE 802.1p priority bits.

You can use either J-Web or the CLI configuration editor to configure the rewrite
rules that convert the FC and PLP into IEEE 802.1p priority bits and to apply the
rewrite rules to an egress logical interface.
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Related Topics ■ Configuring and Applying Rewrite Rules on Transparent Mode Devices on page 705

Configuring and Applying Rewrite Rules on Transparent Mode Devices

In this example, the logical interface ge-1/0/3.0 is configured as a trunk port that
carries traffic for packets tagged with VLAN identifiers 200 through 390. This example
creates a rewrite rule rw1 for IEEE 802.1 traffic. For outgoing packets in the
forwarding class fc1 with low loss priority, the IEEE 802.1p priority bits are rewritten
as 011. The rewrite rule rw1 is applied to interface ge-1/0/3.0.

Before You Begin

For background information, read:

■ Understanding Rewrite of Packet Headers on Transparent Mode Devices on page 704

■ Configuring Layer 2 Logical Interfaces on page 682

CLI Configuration

To configure the ge-1/0/3.0 logical interface as a Layer 2 trunk port:

user@host# set interfaces ge-1/0/3 vlan-tagging unit 0 family bridge interface
mode trunk vlan-id list 200–390

To configure the forwarding classes:

user@host# set class-of-service forwarding-classes queue 0 fc1
user@host# set class-of-service forwarding-classes queue 1 fc2
user@host# set class-of-service forwarding-classes queue 3 fc4
user@host# set class-of-service forwarding-classes queue 4 fc5
user@host# set class-of-service forwarding-classes queue 5 fc6
user@host# set class-of-service forwarding-classes queue 6 fc7
user@host# set class-of-service forwarding-classes queue 7 fc8
user@host# set class-of-service forwarding-classes queue 2 fc3

To configure a rewrite rule:

user@host# set class-of-service rewrite-rules ieee-802.1 rw1 forwarding-class fc1
loss-priority low code-point 011

To apply the rewrite rule to the ge-1/0/3.0 interface:

user@host# set class-of-service interfaces ge-1/0/3 unit 0 rewrite-rules ieee-802.1
rw1
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Part 5

MPLS

■ MPLS on page 709

■ Traffic Engineering on page 719

■ MPLS VPNs on page 737

■ CLNS VPNs on page 757

■ VPLS on page 769

MPLS ■ 707
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Chapter 27

MPLS

■ MPLS Overview on page 709

■ MPLS Configuration Overview on page 714

■ Example: Deleting Security Services (CLI) on page 715

■ Example: Enabling MPLS (CLI) on page 716

MPLS Overview

Multiprotocol Label Switching (MPLS) is a method for engineering traffic patterns by
assigning short labels to network packets that describe how to forward them through
the network. MPLS is independent of routing tables or any routing protocol and can
be used for unicast packets.

The MPLS framework supports traffic engineering and the creation of virtual private
networks (VPNs). Traffic is engineered (controlled) primarily by the use of signaling
protocols to establish label-switched paths (LSPs). VPN support includes Layer 2 and
Layer 3 VPNs and Layer 2 circuits.

When you enable your device to allow MPLS traffic, the device performs packet-based
processing and functions as a standard JUNOS router.

CAUTION: When MPLS is enabled on your router, all security features such as security
policies, zones, NAT, ALGs, chassis clustering, screens, firewall authentication, and
IPsec VPNs are unavailable.

This overview contains the following topics:

■ Label Switching on page 710

■ Label-Switched Paths on page 710

■ Label-Switching Routers on page 711

■ Labels on page 712

■ Label Operations on page 712

■ Penultimate Hop Popping on page 713

■ LSP Establishment on page 713

MPLS Overview ■ 709



Label Switching

In a traditional IP network, packets are transmitted with an IP header that includes
a source and destination address. When a router receives such a packet, it examines
its forwarding tables for the next-hop address associated with the packet's destination
address and forwards the packet to the next-hop location.

In an MPLS network, each packet is encapsulated with an MPLS header. When a
router receives the packet, it copies the header as an index into a separate MPLS
forwarding table. The MPLS forwarding table consists of pairs of inbound interfaces
and path information. Each pair includes forwarding information that the router uses
to forward the traffic and modify, when necessary, the MPLS header.

Because the MPLS forwarding table has far fewer entries than the more general
forwarding table, the lookup consumes less processing time and processing power.
The resultant savings in time and processing are a significant benefit for traffic that
uses the network to transit between outside destinations only.

Label-Switched Paths

Label-switched paths (LSPs) are unidirectional routes through a network or
autonomous system (AS). In normal IP routing, the packet has no predetermined
path. Instead, each router forwards a packet to the next-hop address stored in its
forwarding table, based only on the packet's destination address. Each subsequent
router then forwards the packet using its own forwarding table.

In contrast, MPLS routers within an AS determine paths through a network through
the exchange of MPLS traffic engineering information. Using these paths, the routers
direct traffic through the network along an established route. Rather than selecting
the next hop along the path as in IP routing, each router is responsible for forwarding
the packet to a predetermined next-hop address.

Figure 84 on page 711 shows a typical LSP topology.
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Figure 84: Typical LSP Topology
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In the topology shown in Figure 84 on page 711, traffic is forwarded from Host C1 to
the transit network with standard IP forwarding. When the traffic enters the transit
network, it is switched across a preestablished LSP through the network. In this
example, an LSP might switch the traffic from Router R4 to Router R2 to Router R1.
When the traffic exits the network, it is forwarded to its destination by IP routing
protocols.

Label-Switching Routers

Routers that are part of the LSP are label-switching routers (LSRs). Each LSR must
be configured with MPLS so that it can interpret MPLS headers and perform the MPLS
operations required to pass traffic through the network. An LSP can include four
types of LSRs:

■ Inbound router—The only entry point for traffic into MPLS. Native IPv4 packets
are encapsulated into the MPLS protocol by the inbound router. Each LSP can
have only one inbound router. Inbound routers are also known as ingress routers.

■ Transit router—Any router in the middle of an LSP. An individual LSP can contain
between 0 and 253 transit routers. Transit routers forward MPLS traffic along
the LSP, using only the MPLS header to determine how the packet is routed.

■ Penultimate router—The second-to-last router in the LSP. The penultimate router
in an LSP is responsible for stripping the MPLS header from the packet before
forwarding it to the outbound router.

■ Outbound router—The endpoint for the LSP. The outbound router receives MPLS
packets from the penultimate router and performs an IP route lookup. The router
then forwards the packet to the next hop of the route. Each LSP can have only
one outbound router. Outbound routers are also known as egress routers.
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Labels

To forward traffic through an MPLS network, MPLS routers encapsulate packets and
assign and manage headers known as labels. A label is a 20–bit unsigned integer in
the range 0 through 1,048,575. The routers use the labels to index the MPLS
forwarding tables that determine how packets are routed through the network.

When a network's inbound router receives traffic, it inserts an MPLS label between
the IP packet and the appropriate Layer 2 header for the physical link. The label
contains an index value that identifies a next-hop address for the particular LSP.
When the next-hop transit router receives the packet, it uses the index in the MPLS
label to determine the next-hop address for the packet and forwards the packet to
the next router in the LSP.

As each packet travels through the transit network, every router along the way
performs a lookup on the MPLS label and forwards the packet accordingly. When
the outbound router receives a packet, it examines the header to determine that it
is the final router in the LSP. The outbound router then removes the MPLS header,
performs a regular IP route lookup, and forwards the packet with its IP header to the
next-hop address.

Label Operations

Each LSR along an LSP is responsible for examining the MPLS label, determining the
LSP next hop, and performing the required label operations. LSRs can perform five
label operations:

■ Push—Adds a new label to the top of the packet. For IPv4 packets arriving at
the inbound router, the new label is the first label in the label stack. For MPLS
packets with an existing label, this operation adds a label to the stack and sets
the stacking bit to 0, indicating that more MPLS labels follow the first.

When it receives the packet, the inbound router performs an IP route lookup on
the packet. Because the route lookup yields an LSP next hop, the inbound router
performs a label push on the packet, and then forwards the packet to the LSP
next hop.

■ Swap—Replaces the label at the top of the label stack with a new label.

When a transit router receives the packet, it performs an MPLS forwarding table
lookup. The lookup yields the LSP next hop and the path index of the link between
the transit router and the next router in the LSP.

■ Pop—Removes the label from the top of the label stack. For IPv4 packets arriving
at the penultimate router, the entire MPLS label is removed from the label stack.
For MPLS packets with an existing label, this operation removes the top label
from the label stack and modifies the stacking bit as necessary—sets it to 1, for
example, if only a single label remains in the stack.

If multiple LSPs terminate at the same outbound router, the router performs
MPLS label operations for all outbound traffic on the LSPs. To share the operations
among multiple routers, most LSPs use penultimate hop popping (PHP).

■ Multiple push—Adds multiple labels to the top of the label stack. This action is
equivalent to performing multiple push operations.
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The multiple push operation is used with label stacking, which is beyond the
scope of this topic.

■ Swap and push—Replaces the top label with a new label and then pushes a new
label to the top of the stack.

The swap and push operation is used with label stacking, which is beyond the
scope of this topic.

Penultimate Hop Popping

Multiple LSPs terminating at a single outbound router load the router with MPLS label
operations for all their outbound traffic. Penultimate hop popping (PHP) transfers
the operation from the outbound router to penultimate routers.

With PHP, the penultimate router is responsible for popping the MPLS label and
forwarding the traffic to the outbound router. The outbound router then performs
an IP route lookup and forwards the traffic. For example, if four LSPs terminate at
the same outbound router and each has a different penultimate router, label
operations are shared across four routers.

LSP Establishment

An MPLS LSP is established by one of two methods: static LSPs and dynamic LSPs.

Static LSPs

Like a static route, a static LSP requires each router along the path to be configured
explicitly. You must manually configure the path and its associated label values.
Static LSPs require less processing by the LSRs because no signaling protocol is used.
However, because paths are statically configured, they cannot adapt to network
conditions. Topology changes and network outages can create black holes in the LSP
that exist until you manually reconfigure the LSP.

Dynamic LSPs

Dynamic LSPs use signaling protocols to establish themselves and propagate LSP
information to other LSRs in the network. You configure the inbound router with
LSP information that is transmitted throughout the network when you enable the
signaling protocols across the LSRs. Because the LSRs must exchange and process
signaling packets and instructions, dynamic LSPs consume more resources than
static LSPs. However, dynamic LSPs can avoid the network black holes of static LSPs
by detecting topology changes and outages and propagating them throughout the
network.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Configuration Overview on page 714

■ Example: Deleting Security Services on page 715

■ Example: Enabling MPLS on page 716
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■ MPLS Traffic Engineering and Signaling Protocols Overview on page 719

■ MPLS VPN Overview on page 737

MPLS Configuration Overview

When you first install JUNOS Software on your device, MPLS is disabled by default.
You must explicitly configure your device to allow MPLS traffic to pass through.
Complete the following steps for all devices in your MPLS network that are running
JUNOS software.

To enable MPLS:

1. Delete all configured security services from the device. If you do not complete
this step, you will get a commit failure. See “Example: Deleting Security Services”
on page 715

2. Enable MPLS on the device. See “Example: Enabling MPLS” on page 716

3. Commit the configuration.

4. Reboot the device.

5. Configure MPLS features such as traffic engineering, VPNs, and VPLS. See:

■ MPLS Traffic Engineering and Signaling Protocols Overview on page 719

■ MPLS VPN Overview on page 737

■ CLNS Overview on page 757

■ VPLS Overview on page 769

CAUTION: When MPLS is enabled, all flow-based security features are deactivated
and the device performs packet-based processing. Flow-based services such as
security policies, zones, NAT, ALGs, chassis clustering, screens, firewall authentication,
and IPSec VPNs are unavailable on the router.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Overview on page 709

■ Example: Deleting Security Services on page 715

■ Example: Enabling MPLS on page 716

■ Junos MPLS Applications Configuration Guide

■ Junos VPNs Configuration Guide
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Example: Deleting Security Services (CLI)

The following example shows how to save your current configuration to a file called
curfeb08.cfg before removing all configurations from the security level of the
configuration hierarchy and deleting all global groups and inherited configurations.

Before you enable MPLS, we recommend that you delete all configured security
services.

To delete the configured services in the security level of the configuration hierarchy:

1. Save your current configuration in the var/tmp/ directory with an appropriate
filename with the .cfg extension—for example, curfeb08.cfg.

[edit]
user@host# save /var/tmp/curfeb08.cfg

2. Remove all configurations in the security level of the configuration hierarchy.

[edit]
user@host# delete security

3. Remove all global group and inherited configurations.

[edit]
user@host# delete groups global security

CAUTION: Do not commit after deleting the security configurations. A commit without
any security configurations leaves the router unreachable through the management
port.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Overview on page 709

■ MPLS Configuration Overview on page 714

■ Example: Enabling MPLS on page 716
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Example: Enabling MPLS (CLI)

Before including a device running JUNOS Software in an MPLS network, you must
enable MPLS on the device. Perform these tasks on all of the devices running JUNOS
Software.

The following example shows how to enable MPLS for packet-based processing. It
also shows how to enable the MPLS family and MPLS process on the ge-1/0/0 transit
interface.

To enable MPLS:

1. Navigate to the security forwarding options level of the configuration hierarchy.

[edit]
user@host# edit security forwarding-options

2. Enable MPLS for packet-based processing.

[edit security forwarding-options]
user@host# set family mpls mode packet-based

3. Navigate to the interfaces level of the configuration hierarchy.

[edit security forwarding-options]
user@host# top
[edit]
user@host# edit interfaces

4. Enable the MPLS family on each transit interface that you want to include in the
MPLS network. For example:

[edit interfaces]
user@host# set interfaces ge-1/0/0 unit 0 family mpls

5. Navigate to the protocols mpls level of the configuration hierarchy.

[edit interfaces]
user@host# top
[edit]
user@host# edit protocols mpls

6. Enable the MPLS process on all of the transit interfaces in the MPLS network.
For example:

[edit protocols mpls]
user@host# set interface all

7. Commit the configuration when you are done configuring the device.

[edit]
user@host# commit

8. Reboot the device.
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CAUTION: If you disable MPLS and switch back to using the security services
(flow-based processing), we recommend that you restart your router. Management
sessions are reset, and transit traffic is interrupted.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Overview on page 709

■ MPLS Configuration Overview on page 714

■ Example: Deleting Security Services on page 715
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Chapter 28

Traffic Engineering

■ MPLS Traffic Engineering and Signaling Protocols Overview on page 719

■ LDP Signaling Protocol on page 720

■ RSVP Signaling Protocol on page 725

■ Point-to-Multipoint LSPs on page 733

MPLS Traffic Engineering and Signaling Protocols Overview

Traffic engineering facilitates efficient and reliable network operations while
simultaneously optimizing network resources and traffic performance. Traffic
engineering provides the ability to move traffic flow away from the shortest path
selected by the interior gateway protocol (IGP) to a potentially less congested physical
path across a network. To support traffic engineering, besides source routing, the
network must do the following:

■ Compute a path at the source by taking into account all the constraints, such as
bandwidth and administrative requirements.

■ Distribute the information about network topology and link attributes throughout
the network once the path is computed.

■ Reserve network resources and modify link attributes.

When transit traffic is routed through an IP network, MPLS is often used to engineer
its passage. Although the exact path through the transit network is of little importance
to either the sender or the receiver of the traffic, network administrators often want
to route traffic more efficiently between certain source and destination address pairs.
By adding a short label with specific routing instructions to each packet, MPLS
switches packets from router to router through the network rather than forwarding
packets based on next-hop lookups. The resulting routes are called label-switched
paths (LSPs). LSPs control the passage of traffic through the network and speed traffic
forwarding.

You can create LSPs manually, or through the use of signaling protocols. Signaling
protocols are used within an MPLS environment to establish LSPs for traffic across
a transit network. JUNOS Software supports two signaling protocols—LDP and the
Resource Reservation Protocol (RSVP).
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MPLS traffic engineering uses the following components:

■ MPLS LSPs for packet forwarding

■ IGP extensions for distributing information about the network topology and link
attributes

■ Constrained Shortest Path First (CSPF) for path computation and path selection

■ RSVP extensions to establish the forwarding state along the path and to reserve
resources along the path

JUNOS Software also supports traffic engineering across different OSPF regions.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding the LDP Signaling Protocol on page 720

■ Understanding the RSVP Signaling Protocol on page 725

■ Understanding Point-to-Multipoint LSPs on page 733

■ Enabling Interarea Traffic Engineering in the Junos MPLS Applications Configuration
Guide

LDP Signaling Protocol

■ Understanding the LDP Signaling Protocol on page 720

■ Example: Configuring LDP-Signaled LSPs on page 721

Understanding the LDP Signaling Protocol

LDP is a signaling protocol that runs on a device configured for MPLS support. The
successful configuration of both MPLS and LDP initiates the exchange of TCP packets
across the LDP interfaces. The packets establish TCP-based LDP sessions for the
exchange of MPLS information within the network. Enabling both MPLS and LDP on
the appropriate interfaces is sufficient to establish LSPs.

LDP is a simple, fast-acting signaling protocol that automatically establishes LSP
adjacencies within an MPLS network. Routers then share LSP updates such as hello
packets and LSP advertisements across the adjacencies. Because LDP runs on top of
an IGP such as IS-IS or OSPF, you must configure LDP and the IGP on the same set
of interfaces. After both are configured, LDP begins transmitting and receiving LDP
messages through all LDP-enabled interfaces. Because of LDP's simplicity, it cannot
perform the true traffic engineering which RSVP can perform. LDP does not support
bandwidth reservation or traffic constraints.

When you configure LDP on a label-switching router (LSR), the router begins sending
LDP discovery messages out all LDP-enabled interfaces. When an adjacent LSR
receives LDP discovery messages, it establishes an underlying TCP session. An LDP
session is then created on top of the TCP session. The TCP three-way handshake
ensures that the LDP session has bidirectional connectivity. After they establish the
LDP session, the LDP neighbors maintain, and terminate, the session by exchanging

720 ■ LDP Signaling Protocol

JUNOS Software Interfaces and Routing Configuration Guide



messages. LDP advertisement messages allow LSRs to exchange label information
to determine the next hops within a particular LSP. Any topology changes, such as
a router failure, generate LDP notifications that can terminate the LDP session or
generate additional LDP advertisements to propagate an LSP change.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Traffic Engineering and Signaling Protocols Overview on page 719

■ Example: Configuring LDP-Signaled LSPs on page 721

Example: Configuring LDP-Signaled LSPs

This example shows how to create and configure LDP instances within an MPLS
network.

■ Requirements on page 721

■ Overview on page 721

■ Configuration on page 722

■ Verification on page 723

Requirements

Before you begin:

1. Configure network interfaces. See the Junos OS Interfaces Configuration Guide for
Security Devices.

2. Configure an IGP across your network. (The LDP configuration is added to the
existing IGP configuration and included in the MPLS configuration.)

3. Configure a network to use LDP for LSP establishment by enabling MPLS on all
transit interfaces in the MPLS network.

NOTE: Because LDP runs on top of an IGP such as IS-IS or OSPF, you must configure
LDP and the IGP on the same set of interfaces.

Overview

To configure LDP-signaled RSPs, you must enable the MPLS family on all transit
interfaces in the MPLS network, enable the MPLS process on all router interfaces in
the MPLS network, and enable an LDP instance on each router. In this example, you
enable the MPLS family and create an LDP instance on the ge-0/0/0 interface.
Additionally, you enable the MPLS process on all router interfaces in the MPLS
network.
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Configuration

CLI Quick Configuration To quickly configure LDP instances within an MPLS network, copy the following
commands and paste them into the CLI.

[edit]
set interfaces ge-0/0/0 unit 0 family mpls
set protocols mpls interface all
set protocols ldp interface ge-0/0/0.0

Step-by-Step Procedure To enable LDP instances within an MPLS network:

1. Enable the MPLS family on the transit interface.

[edit]
user@host# set interfaces ge-0/0/0 unit 0 family mpls

2. Enable the MPLS process all interfaces.

[edit]
user@host# set protocols mpls interface all

3. Create the LDP instance on the transit interface.

[edit]
user@host# set protocols ldp interface ge-0/0/0

Results Confirm your configuration by entering the show command from configuration mode.
If the output does not display the intended configuration, repeat the configuration
instructions in this example to correct it.

For brevity, this show output includes only the configuration that is relevant to this
example. Any other configuration on the system has been replaced with ellipses (...).

user@host# show
...

interfaces {
ge-0/0/0 {

unit 0 {
family inet {

address 10.100.37.20/24;
}
family mpls;

}
}
}

...
protocols {

mpls {
interface all;

}
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ldp {
interface ge-0/0/0.0;

}
}

If you are done configuring the device, enter the commit command from the
configuration mode to activate the configuration.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying LDP Neighbors on page 723

■ Verifying LDP Sessions on page 723

■ Verifying the Presence of LDP-Signaled LSPs on page 724

■ Verifying Traffic Forwarding over the LDP-Signaled LSP on page 724

Verifying LDP Neighbors

Purpose Verify that each router shows the appropriate LDP neighbors.

Action From the CLI, enter the show ldp neighbor command.

Sample Output user@r5> show ldp neighbor
Address     Interface       Label space ID      Hold time
10.0.8.5    ge-0/0/0.0      10.0.9.6:0            14
10.0.8.10   ge-0/0/1.0      10.0.9.7:0            11

Meaning The output shows the IP addresses of the neighboring interfaces along with the
interface through which the neighbor adjacency is established. Verify the following
information:

■ Each interface on which LDP is enabled is listed.

■ Each neighboring LDP interface address is listed with the appropriate
corresponding LDP interface.

■ Under Label space ID, the appropriate loopback address for each neighbor
appears.

Verifying LDP Sessions

Purpose Verify that a TCP-based LDP session has been established between all LDP neighbors.
Also, verify that the modified keepalive value is active.

Action From the CLI, enter the show ldp session detail command.

Sample Output user@r5> show ldp session detail
Address: 10.0.9.7, State: Operational, Connection: Open, Hold time: 28
  Session ID: 10.0.3.5:0--10.0.9.7:0
  Next keepalive in 3 seconds
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  Passive, Maximum PDU: 4096, Hold time: 30, Neighbor count: 1
  Keepalive interval: 10, Connect retry interval: 1
  Local - Restart: disabled, Helper mode: enabled
  Remote - Restart: disabled, Helper mode: disabled
  Local maximum recovery time: 240000 msec
  Next-hop addresses received:
    10.0.8.10
    10.0.2.17

Meaning The output shows the detailed information, including session IDs, keepalive interval,
and next-hop addresses, for each established LDP session. Verify the following
information:

■ Each LDP neighbor address has an entry, listed by loopback address.

■ The state for each session is Operational, and the connection for each session is
Open. A state of Nonexistent or a connection of Closed indicates a problem with
one of the following:

■ LDP configuration

■ Passage of traffic between the two devices

■ Physical link between the two routers

■ For Keepalive interval, the appropriate value, 10, appears.

Verifying the Presence of LDP-Signaled LSPs

Purpose Verify that each Juniper Networks device's inet.3 routing table has an LSP for the
loopback address on each of the other routers.

Action From the CLI, enter the show route table inet.3 command.

Sample Output user@r5> show route table inet.3
inet.3: 2 destinations, 2 routes (2 active, 0 holddown, 0 hidden)
+ = Active Route, - = Last Active, * = Both

10.0.9.6/32         *[LDP/9/0] 00:05:29, metric 1
                    > to 10.0.8.5 via ge-0/0/0.0
10.0.9.7/32         *[LDP/9/0] 00:05:37, metric 1
                    > to 10.0.8.10 via ge-0/0/1.0

Meaning The output shows the LDP routes that exist in the inet.3 routing table. Verify that an
LDP-signaled LSP is associated with the loopback addresses of the other routers in
the MPLS network.

Verifying Traffic Forwarding over the LDP-Signaled LSP

Purpose Verify that traffic between hosts is forwarded over the LDP-signaled LSP. Because
traffic uses any configured gateway address by default, you must explicitly specify
that the gateway address is to be bypassed.
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Action From the CLI, enter the traceroute 220.220.0.0 source 200.200.0.1 bypass-routing
gateway 172.16.0.1 command.

Sample Output user@c1> traceroute 220.220.0.0 source 200.200.0.1 bypass-routing gateway
172.16.0.1
traceroute to 220.220.0.1 (172.16.0.1) from 200.200.0.1, 30 hops max, 40 byte 
packets
 1  172.16.0.1 (172.16.0.1)  0.661 ms  0.538 ms  0.449 ms
 2  10.0.8.9 (10.0.8.9)  0.511 ms  0.479 ms  0.468 ms
    MPLS Label=100004 CoS=0 TTL=1 S=1
 3  10.0.8.5 (10.0.8.5)  0.476 ms  0.512 ms  0.441 ms
 4  220.220.0.1 (220.220.0.1)  0.436 ms  0.420 ms  0.416 ms

Meaning The output shows the route that traffic travels between hosts without using the default
gateway. In this example, verify that traffic sent from Host C1 to Host C2 travels
through Router R7. The 10.0.8.9 address is the interface address for Router R5.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding the LDP Signaling Protocol on page 720

■ Junos OS Routing Protocols and Policies Configuration Guide for Security Devices

■ show ldp neighbor in the Junos Routing Protocols and Policies Command Reference

■ show ldp session in the Junos Routing Protocols and Policies Command Reference

■ show route table in the Junos Routing Protocols and Policies Command Reference

■ traceroute in the Junos System Basics and Services Command Reference

RSVP Signaling Protocol

■ Understanding the RSVP Signaling Protocol on page 725

■ Example: Configuring RSVP-Signaled LSPs on page 729

Understanding the RSVP Signaling Protocol

RSVP is a signaling protocol that handles bandwidth allocation and true traffic
engineering across an MPLS network. Like LDP, RSVP uses discovery messages and
advertisements to exchange LSP path information between all hosts. However, RSVP
also includes a set of features that control the flow of traffic through an MPLS network.
Whereas LDP is restricted to using the configured IGP's shortest path as the transit
path through the network, RSVP uses a combination of the Constrained Shortest Path
First (CSPF) algorithm and Explicit Route Objects (EROs) to determine how traffic is
routed through the network.

Basic RSVP sessions are established in exactly the same way that LDP sessions are
established. By configuring both MPLS and RSVP on the appropriate transit interfaces,
you enable the exchange of RSVP packets and the establishment of LSPs. However,
RSVP also lets you configure link authentication, explicit LSP paths, and link coloring.
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This topic contains the following sections:

■ RSVP Fundamentals on page 726

■ Bandwidth Reservation Requirement on page 726

■ Explicit Route Objects on page 726

■ Constrained Shortest Path First on page 727

■ Link Coloring on page 728

RSVP Fundamentals

RSVP uses unidirectional and simplex flows through the network to perform its
function. The inbound router initiates an RSVP path message and sends it downstream
to the outbound router. The path message contains information about the resources
needed for the connection. Each router along the path begins to maintain information
about a reservation.

When the path message reaches the outbound router, resource reservation begins.
The outbound router sends a reservation message upstream to the inbound router.
Each router along the path receives the reservation message and sends it upstream,
following the path of the original path message. When the inbound router receives
the reservation message, the unidirectional network path is established.

The established path remains open as long as the RSVP session is active. The session
is maintained by the transmission of additional path and reservation messages that
report the session state every 30 seconds. If a router does not receive the maintenance
messages for 3 minutes, it terminates the RSVP session and reroutes the LSP through
another active router.

Bandwidth Reservation Requirement

When a bandwidth reservation is configured, reservation messages propagate the
bandwidth value throughout the LSP. Routers must reserve the bandwidth specified
across the link for the particular LSP. If the total bandwidth reservation exceeds the
available bandwidth for a particular LSP segment, the LSP is rerouted through another
LSR. If no segments can support the bandwidth reservation, LSP setup fails and the
RSVP session is not established.

Explicit Route Objects

Explicit Route Objects (EROs) limit LSP routing to a specified list of LSRs. By default,
RSVP messages follow a path that is determined by the network IGP's shortest path.
However, in the presence of a configured ERO, the RSVP messages follow the path
specified.

EROs consist of two types of instructions: loose hops and strict hops. When a loose
hop is configured, it identifies one or more transit LSRs through which the LSP must
be routed. The network IGP determines the exact route from the inbound router to
the first loose hop, or from one loose hop to the next. The loose hop specifies only
that a particular LSR be included in the LSP.
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When a strict hop is configured, it identifies an exact path through which the LSP
must be routed. Strict-hop EROs specify the exact order of the routers through which
the RSVP messages are sent.

You can configure loose-hop and strict-hop EROs simultaneously. In this case, the
IGP determines the route between loose hops, and the strict-hop configuration
specifies the exact path for particular LSP path segments.

Figure 85 on page 727 shows a typical RSVP-signaled LSP that uses EROs.

Figure 85: Typical RSVP-Signaled LSP with EROs
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In the topology shown in Figure 85 on page 727, traffic is routed from Host C1 to
Host C2. The LSP can pass through Routers R4 or Router R7. To force the LSP to use
R4, you can set up either a loose-hop or strict-hop ERO that specifies R4 as a hop in
the LSP. To force a specific path through Router R4, R3, and R6, configure a strict-hop
ERO through the three LSRs.

Constrained Shortest Path First

Whereas IGPs use the Shortest Path First (SPF) algorithm to determine how traffic is
routed within a network, RSVP uses the Constrained Shortest Path First (CSPF)
algorithm to calculate traffic paths that are subject to the following constraints:

■ LSP attributes—Administrative groups such as link coloring, bandwidth
requirements, and EROs

■ Link attributes—Colors on a particular link and available bandwidth

These constraints are maintained in the traffic engineering database (TED). The
database provides CSPF with up-to-date topology information, the current reservable
bandwidth of links, and the link colors.

In determining which path to select, CSPF follows these rules:
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■ Computes LSPs one at a time, beginning with the highest priority LSP—the one
with the lowest setup priority value. Among LSPs of equal priority, CSPF starts
with those that have the highest bandwidth requirement.

■ Prunes the traffic engineering database of links that are not full duplex and do
not have sufficient reservable bandwidth.

■ If the LSP configuration includes the include statement, prunes all links that do
not share any included colors.

■ If the LSP configuration includes the exclude statement, prunes all links that
contain excluded colors. If a link does not have a color, it is accepted.

■ Finds the shortest path toward the LSP's outbound router, taking into account
any EROs. For example, if the path must pass through Router A, two separate
SPF algorithms are computed: one from the inbound router to Router A and one
from Router A to the outbound router.

■ If several paths have equal cost, chooses the one with a last-hop address the
same as the LSP's destination.

■ If several equal-cost paths remain, selects the path with the least number of
hops.

■ If several equal-cost paths remain, applies CSPF load-balancing rules configured
on the LSP.

Link Coloring

RSVP allows you to configure administrative groups for CSPF path selection. An
administrative group is typically named with a color, assigned a numeric value, and
applied to the RSVP interface for the appropriate link. Lower numbers indicate higher
priority.

After configuring the administrative group, you can either exclude, include, or ignore
links of that color in the TED:

■ If you exclude a particular color, all segments with an administrative group of
that color are excluded from CSPF path selection.

■ If you include a particular color, only those segments with the appropriate color
are selected.

■ If you neither exclude nor include the color, the metrics associated with the
administrative groups and applied on the particular segments determine the
path cost for that segment.

The LSP with the lowest total path cost is selected into the TED.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Traffic Engineering and Signaling Protocols Overview on page 719

■ Example: Configuring RSVP-Signaled LSPs on page 729
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Example: Configuring RSVP-Signaled LSPs

This example shows how to create an LSP between routers in an IP network using
RSVP as the signaling protocol.

■ Requirements on page 729

■ Overview and Topology on page 729

■ Configuration on page 730

■ Verification on page 731

Requirements

Before you begin, delete security services from the device. See “Example: Deleting
Security Services” on page 715.

Overview and Topology

Using RSVP as a signaling protocol, you can create LSPs between routers in an IP
network. In this example, you configure a sample network as shown in Figure 86 on
page 729.

Figure 86: Typical RSVP-Signaled LSP
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To establish an LSP between routers, you must individually enable the MPLS family
and configure RSVP on each of the transit interfaces in the MPLS network. (This
example shows how to enable MPLS and configure RSVP on the ge-0/0/0 transit
interface). Additionally, you must enable the MPLS process on all of the MPLS
interfaces in the network.

This example shows how to define an LSP from R1 to R7 on the ingress router (R1)
using R7’s loopback address (10.0.9.7). The configuration reserves 10 Mbps of
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bandwidth. Additionally, the configuration disables the CSPF algorithm, ensuring
that Hosts C1 and C2 use the RSVP-signaled LSP that correspond to the network
IGP's shortest path.

Configuration

CLI Quick Configuration To quickly configure RSVP, copy the following commands and paste them into the
CLI.

[edit]
set interfaces ge-0/0/0 unit 0 family mpls
set protocols rsvp interface ge-0/0/0.0
set protocols mpls label-switched-path r1-r7 to 10.0.9.7
set protocols mpls label-switched-path r1-r7 bandwidth 10m
set protocols mpls label-switched-path r1-r7 no-cspf
set protocols mpls interface all

Step-by-Step Procedure The following example requires you to navigate various levels in the configuration
hierarchy. For information about navigating the CLI, see Using the CLI Editor in
Configuration Mode.

To configure RSVP:

1. Enable the MPLS family on all transit interfaces in the MPLS network.

[edit]
user@host# set interfaces ge-0/0/0 unit 0 family mpls

2. Enable RSVP on each transit interface in the MPLS network.

[edit]
user @host# set protocols rsvp interface ge-0/0/0

3. Enable the MPLS process on all of the MPLS interfaces in the MPLS network.

[edit]
user@host# set protocols mpls interface all

4. Define the LSP on the ingress router.

[edit protocols mpls]
user@host# set label-switched-path r1-r7 to 10.0.9.7

5. Reserve 10 Mbps of bandwidth on the LSP.

[edit protocols mpls]
user @host# set label-switched-path r1-r7 bandwidth 10m

6. Disable the CSPF algorithm.

[edit protocols mpls]
user@host# set label-switched-path r1-r7 no-cspf
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Results Confirm your configuration by entering the show command from configuration mode.
If the output does not display the intended configuration, repeat the configuration
instructions in this example to correct it.

For brevity, this show command output includes only the configuration that is relevant
to this example. Any other configuration on the system has been replaced with
ellipses (...).

user@host# show
...

interfaces {
ge-0/0/0 {

family mpls;
}

}
}
...
protocols {

rsvp {
interface ge-0/0/0.0;

}
mpls {

label-switched-path r1-r7 {
to 10.0.9.7;
bandwidth 10m;
no-cspf;

}
interface all;

}
}

...

If you are done configuring the device, enter commit from configuration mode.

Verification

To confirm that the configuration is working properly, perform these tasks:

■ Verifying RSVP Neighbors on page 731

■ Verifying RSVP Sessions on page 732

■ Verifying the Presence of RSVP-Signaled LSPs on page 732

Verifying RSVP Neighbors

Purpose Verify that each device shows the appropriate RSVP neighbors—for example, that
Router R1 in Figure 86 on page 729 lists both Router R3 and Router R2 as RSVP
neighbors.

Action From the CLI, enter the show rsvp neighbor command.

Sample Output user@r1> show rsvp neighbor
RSVP neighbor: 2 learned
Address            Idle Up/Dn LastChange HelloInt HelloTx/Rx 
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10.0.6.2              0  3/2       13:01        3   366/349 
10.0.3.3              0  1/0       22:49        3   448/448 

Meaning The output shows the IP addresses of the neighboring routers. Verify that each
neighboring RSVP router loopback address is listed.

Verifying RSVP Sessions

Purpose Verify that an RSVP session has been established between all RSVP neighbors. Also,
verify that the bandwidth reservation value is active.

Action From the CLI, enter the show rsvp session detail command.

Sample Output user@r1> show rsvp session detail
Ingress RSVP: 1 sessions

10.0.9.7
  From: 10.0.6.1, LSPstate: Up, ActiveRoute: 0
  LSPname: r1–r7, LSPpath: Primary
  Bidirectional, Upstream label in: –, Upstream label out: -
  Suggested label received: -, Suggested label sent: –
  Recovery label received: -, Recovery label sent: 100000
  Resv style: 1 FF, Label in: -, Label out: 100000
  Time left:    -,  Since: Thu Jan 26 17:57:45 2002
  Tspec: rate 10Mbps size 10Mbps peak Infbps m 20 M 1500
  Port number: sender 3 receiver 17 protocol 0
  PATH rcvfrom: localclient
  PATH sentto: 10.0.4.13 (ge-0/0/1.0) 1467 pkts
  RESV rcvfrom: 10.0.4.13  (ge-0/0/1.0) 1467 pkts
  Record route: <self> 10.0.4.13  10.0.2.1  10.0.8.10  

Meaning The output shows the detailed information, including session IDs, bandwidth
reservation, and next-hop addresses, for each established RSVP session. Verify the
following information:

■ Each RSVP neighbor address has an entry for each neighbor, listed by loopback
address.

■ The state for each LSP session is Up.

■ For Tspec, the appropriate bandwidth value, 10Mbps, appears.

Verifying the Presence of RSVP-Signaled LSPs

Purpose Verify that the routing table of the entry (ingress) router has a configured LSP to the
loopback address of the other router. For example, verify that the inet.3 routing table
of the R1 entry router in Figure 86 on page 729 has a configured LSP to the loopback
address of Router R7.

Action From the CLI, enter the show route table inet.3 command.
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Sample Output user@r1> show route table inet.3
inet.3: 2 destinations, 2 routes (2 active, 0 holddown, 0 hidden)
+ = Active Route, - = Last Active, * = Both

10.0.9.7/32         *[RSVP/7] 00:05:29, metric 10
                    > to 10.0.4.17 via ge-0/0/0.0, label-switched-path r1–r7

Meaning The output shows the RSVP routes that exist in the inet.3 routing table. Verify that
an RSVP-signaled LSP is associated with the loopback address of the exit (egress)
router, R7, in the MPLS network.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding the RSVP Signaling Protocol on page 725

■ show rsvp neighbor in the Junos Routing Protocols and Policies Command Reference

■ show rsvp session in the Junos Routing Protocols and Policies Command Reference

Point-to-Multipoint LSPs

■ Understanding Point-to-Multipoint LSPs on page 733

■ Point-to-Multipoint LSP Configuration Overview on page 735

Understanding Point-to-Multipoint LSPs

A point-to-multipoint MPLS label-switched path (LSP) is an RSVP-signaled LSP with
a single source and multiple destinations. By taking advantage of the MPLS packet
replication capability of the network, point-to-multipoint LSPs avoid unnecessary
packet replication at the inbound (ingress) router. Packet replication takes place only
when packets are forwarded to two or more different destinations requiring different
network paths.

This process is illustrated in Figure 87 on page 734. Router PE1 is configured with a
point-to-multipoint LSP to Routers PE2, PE3, and PE4. When Router PE1 sends a
packet on the point-to-multipoint LSP to Routers P1 and P2, Router P1 replicates the
packet and forwards it to Routers PE2 and PE3. Router P2 sends the packet to Router
PE4.
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Figure 87: Point-to-Multipoint LSPs

The following are some of the properties of point-to-multipoint LSPs:

■ A point-to-multipoint LSP allows you to use MPLS for point-to-multipoint data
distribution. This functionality is similar to that provided by IP multicast.

■ You can add and remove branch LSPs from a main point-to-multipoint LSP
without disrupting traffic. The unaffected parts of the point-to-multipoint LSP
continue to function normally.

■ You can configure a node to be both a transit and an outbound (egress) router
for different branch LSPs of the same point-to-multipoint LSP.

■ You can enable link protection on a point-to-multipoint LSP. Link protection can
provide a bypass LSP for each of the branch LSPs that make up the
point-to-multipoint LSP. If any primary paths fail, traffic can be quickly switched
to the bypass.

■ You can configure sub-paths either statically or dynamically.

■ You can enable graceful restart on point-to-multipoint LSPs.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Traffic Engineering and Signaling Protocols Overview on page 719
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■ Point-to-Multipoint LSP Configuration Overview on page 735

Point-to-Multipoint LSP Configuration Overview

To set up a point-to-multipoint LSP:

1. Configure the primary LSP from the ingress router and the branch LSPs that
carry traffic to the egress routers.

2. Specify a pathname on the primary LSP and this same path name on each branch
LSP.

NOTE: By default, the branch LSPs are dynamically signaled by means of CSPF and
require no configuration. You can alternatively configure the branch LSPs as a static
path.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding Point-to-Multipoint LSPs on page 733

■ Configuring Primary and Branch LSPs for Point-to-Multipoint LSPs in the Junos
MPLS Applications Configuration Guide
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Chapter 29

MPLS VPNs

■ MPLS VPN Overview on page 737

■ MPLS Layer 2 VPNs on page 740

■ MPLS Layer 3 VPNs on page 750

■ MPLS Layer 2 Circuits on page 753

MPLS VPN Overview

Virtual private networks (VPNs) are private networks that use a public network to
connect two or more remote sites. Instead of dedicated connections between
networks, VPNs use virtual connections routed (tunneled) through public networks
that are typically service provider networks. VPNs are a cost-effective alternative to
expensive dedicated lines. The type of VPN is determined by the connections it uses
and whether the customer network or the provider network performs the virtual
tunneling.

You can configure a routers running JUNOS Software to participate in several types
of VPNs. This topic discusses MPLS VPNs.

This topic contains the following sections:

■ MPLS VPN Topology on page 737

■ MPLS VPN Routing on page 738

■ VRF Instances on page 738

■ Route Distinguishers on page 739

MPLS VPN Topology

There are many ways to set up an MPLS VPN and direct traffic through it. Figure 88
on page 738 shows a typical MPLS VPN topology.
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Figure 88: Typical VPN Topology
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There are three primary types of MPLS VPNs: Layer 2 VPNs, Layer 2 circuits, and
Layer 3 VPNs. All types of MPLS VPNs share certain components:

■ The provider edge (PE) routers in the provider's network connect to the customer
edge (CE) routers located at customer sites. PE routers support VPN and MPLS
label functionality. Within a single VPN, pairs of PE routers are connected through
a virtual tunnel, typically a label-switched path (LSP).

■ Provider routers within the core of the provider's network are not connected to
any routers at a customer site but are part of the tunnel between pairs of PE
routers. Provider routers support LSP functionality as part of the tunnel support,
but do not support VPN functionality.

■ CE routers are the routers or switches located at the customer site that connect
to the provider's network. CE routers are typically IP routers, but they can also
be Asynchronous Transfer Mode (ATM), Frame Relay, or Ethernet switches.

All VPN functions are performed by the PE routers. Neither CE routers nor provider
routers are required to perform any VPN functions.

MPLS VPN Routing

VPNs tunnel traffic as follows from one customer site to another customer site, using
a public network as a transit network, when certain requirements are met:

1. Traffic is forwarded by standard IP forwarding from the CE routers to the PE
routers.

2. The PE routers establish an LSP through the provider network.

3. The inbound PE router receives traffic, and it performs a route lookup. The lookup
yields an LSP next hop, and the traffic is forwarded along the LSP.

4. The traffic reaches the outbound PE router, and the PE router pops the MPLS
label and forwards the traffic with standard IP routing.

VRF Instances

A routing instance is a collection of routing tables, interfaces, and routing protocol
parameters. The interfaces belong to the routing tables, and the routing protocol
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parameters control the information in the routing tables. In the case of MPLS VPNs,
each VPN has a VPN routing and forwarding (VRF) instance.

A VRF instance consists of one or more routing tables, a derived forwarding table,
the interfaces that use the forwarding table, and the policies and routing protocols
that determine what goes into the forwarding table. Because each instance is
configured for a particular VPN, each VPN has separate tables, rules, and policies
that control its operation.

A separate VRF table is created for each VPN that has a connection to a CE router.
The VRF table is populated with routes received from directly connected CE sites
associated with the VRF instance, and with routes received from other PE routers in
the same VPN.

Route Distinguishers

Because a typical transit network is configured to handle more than one VPN, the
provider routers are likely to have multiple VRF instances configured. As a result,
depending on the origin of the traffic and any filtering rules applied to the traffic,
the BGP routing tables can contain multiple routes for a particular destination address.
Because BGP requires that exactly one BGP route per destination be imported into
the forwarding table, BGP must have a way to distinguish between potentially identical
network layer reachability information (NLRI) messages received from different VPNs.

A route distinguisher is a locally unique number that identifies all route information
for a particular VPN. Unique numeric identifiers allow BGP to distinguish between
routes that are otherwise identical.

Each routing instance that you configure on a PE router must have a unique route
distinguisher. There are two possible formats:

■ as-number:number, where as-number is an autonomous system (AS) number (a
2–byte value) in the range 1 through 65,535, and number is any 4–byte value.
We recommend that you use an Internet Assigned Numbers Authority
(IANA)-assigned, nonprivate AS number, preferably the ISP or the customer AS
number.

■ ip-address:number, where ip-address is an IP address (a 4–byte value) and number
is any 2–byte value. The IP address can be any globally unique unicast address.
We recommend that you use the address that you configure in the router-id
statement, which is a public IP address in your assigned prefix range.

The route target defines which route is part of a VPN. A unique route target helps
distinguish between different VPN services on the same router. Each VPN also has
a policy that defines how routes are imported into the VRF table on the router. A
Layer 2 VPN is configured with import and export policies. A Layer 3 VPN uses a
unique route target to distinguish between VPN routes.

The PE router then exports the route in IBGP sessions to the other provider routers.
Route export is governed by any routing policy that has been applied to the particular
VRF table. To propagate the routes through the provider network, the PE router must
also convert the route to VPN format, which includes the route distinguisher.
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When the outbound PE router receives the route, it strips off the route distinguisher
and advertises the route to the connected CE router, typically through standard BGP
IPv4 route advertisements.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Understanding MPLS Layer 2 VPNs on page 740

■ Understanding MPLS Layer 3 VPNs on page 750

■ Understanding MPLS Layer 2 Circuits on page 753

■ VPN Overview in the Junos VPNs Configuration Guide

MPLS Layer 2 VPNs

■ Understanding MPLS Layer 2 VPNs on page 740

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ Configuring Interfaces for MPLS VPNs (CLI Procedure) on page 742

■ Configuring MPLS for VPNs (CLI Procedure) on page 744

■ Configuring a BGP Session for MPLS VPNs (CLI Procedure) on page 744

■ Configuring an IGP and the LDP Signaling Protocol (CLI Procedure) on page 745

■ Configuring an IGP and the RSVP Signaling Protocol (CLI Procedure) on page 746

■ Configuring Routing Options for MPLS VPNs (CLI Procedure) on page 747

■ Configuring a Routing Instance for MPLS VPNs (CLI Procedure) on page 747

■ Configuring a Routing Policy for MPLS Layer 2 VPNs (CLI Procedure) on page 748

■ Verifying an MPLS Layer 2 VPN Configuration on page 749

Understanding MPLS Layer 2 VPNs

In an MPLS Layer 2 VPN, traffic is forwarded to the provider edge (PE) router in
Layer 2 format, carried by MPLS through an label-switched path (LSP) over the service
provider network, and then converted back to Layer 2 format at the receiving
customer edge (CE) router.

Routing occurs on the customer routers, typically on the CE router. The CE router
connected to a service provider on a Layer 2 VPN must select the appropriate circuit
on which to send traffic. The PE router receiving the traffic sends it across the network
to the PE router on the outbound side. The PE routers need no information about
the customer's routes or routing topology, and need only to determine the virtual
tunnel through which to send the traffic.

Implementing a Layer 2 VPN on the router is similar to implementing a VPN using
a Layer 2 technology such as Asynchronous Transfer Mode (ATM) or Frame Relay.
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Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS VPN Overview on page 737

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ Layer 2 VPN Overview in the Junos VPNs Configuration Guide

MPLS Layer 2 VPN Configuration Overview

To configure MPLS Layer 2 VPN functionality on a router running JUNOS Software,
you must enable support on the provider edge (PE) router and configure the PE router
to distribute routing information to other routers in the VPN, as explained in the
following steps. However, because the tunnel information is maintained at both PE
routers, neither the provider core routers nor the customer edge (CE) routers need
to maintain any VPN information in their configuration databases.

To configure an MPLS Layer 2 VPN:

1. Determine all of the routers that you want to participate in the VPN, and then
complete the initial configuration of their interfaces. See the Junos OS Interfaces
Configuration Guide for Security Devices.

2. For all of the routers in the VPN configuration, update the interface configurations
to enable participation in the Layer 2 VPN. As part of the interface configuration,
you must configure the MPLS address family for each interface that uses LDP or
RSVP. See “Configuring Interfaces for MPLS VPNs (CLI Procedure)” on page 742.

3. For all of the routers in the VPN configuration, configure the appropriate protocols.

a. MPLS—For PE routers and provider routers, use MPLS to advertise the Layer
2 VPN interfaces that communicate with other PE routers and provider
routers. See “Configuring MPLS for VPNs (CLI Procedure)” on page 744.

b. BGP and internal BGP (IBGP)—For PE routers, configure a BGP session to
enable the routers to exchange information about routes originating and
terminating in the VPN. (The PE routers use this information to determine
which labels to use for traffic destined to the remote sites. The IBGP session
for the VPN runs through the loopback address.) In addition, CE routers
require a BGP connection to the PE routers. See “Configuring a BGP Session
for MPLS VPNs (CLI Procedure)” on page 744.

c. IGP and a signaling protocol—For PE routers, configure a signaling protocol
(either LDP or RSVP) to dynamically set up label-switched paths (LSPs)
through the provider network. (LDP routes traffic using IGP metrics. RSVP
has traffic engineering that lets you override IGP metrics as needed.) You
must use LDP or RSVP between PE routers and provider routers, but you
cannot use them for interfaces between PE routers and CE routers.

In addition, configure an IGP such as OSPF or static routes for PE routers to
enable exchanges of routing information between the PE routers and provider
routers. Each PE router's loopback address must appear as a separate route.
Do not configure any summarization of the PE router's loopback addresses
at the area boundary. Configure the provider network to run OSPF or IS-IS
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as an IGP, as well as IBGP sessions through either a full mesh or route
reflector.

See “Configuring an IGP and the LDP Signaling Protocol (CLI Procedure)” on
page 745 and “Configuring an IGP and the RSVP Signaling Protocol (CLI
Procedure)” on page 746.

4. For all of the routers in the VPN configuration, configure routing options. The
only required routing option for VPNs is the AS number. You must specify it on
each router involved in the VPN. See “Configuring Routing Options for MPLS
VPNs (CLI Procedure)” on page 747.

5. For each PE router in the VPN configuration, configure a routing instance for
each VPN. The routing instance should have the same name on each PE router.
Each routing instance must have a unique route distinguisher associated with it.
(VPN routing instances need a route distinguisher to help BGP distinguish between
potentially identical network layer reachable information [NLRI] messages
received from different VPNs.) See “Configuring a Routing Instance for MPLS
VPNs (CLI Procedure)” on page 747.

6. For each PE router in the VPN configuration, configure a VPN routing policy if
you are not using a route target. Within the policy, describe which packets are
sent and received across the VPN and specify how routes are imported into and
exported from the router's VRF table. Each advertisement must have an
associated route target that uniquely identifies the VPN for which the
advertisement is valid. If the routing instance uses a policy for accepting and
rejecting packets instead of a route target, you must specify the import and
export routing policies and the community on each PE router. See “Configuring
a Routing Policy for MPLS Layer 2 VPNs (CLI Procedure)” on page 748.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Verifying an MPLS Layer 2 VPN Configuration on page 749

Configuring Interfaces for MPLS VPNs (CLI Procedure)

Configuring the router interfaces that participate in the VPN is similar to configuring
them for other uses, with a few requirements for the VPN. Perform the following
tasks for each interface involved in the VPN, except Layer 3 loopback interfaces,
which do not require other configuration.
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To configure an interface for an MPLS VPN:

1. Configure IPv4 on all of the routers’ interfaces.

■ For all interfaces except loopback interfaces and Layer 2 VPN interfaces
facing a CE router:

[edit]
user@host# edit interfaces interface-name unit logical_interface family inet

address ipv4_address

■ For a loopback address on a Layer 2 configuration:

[edit]
user@host# edit interfaces lo0 unit logical_interface family inet address

ipv4_address primary

■ For a Layer 2 VPN interface facing a CE router:

[edit]
user@host# set interfaces interface-name vlan-tagging encapsulation

vlan-ccc unit logical_interface encapsulation vlan-ccc vlan-id id-number

2. Configure the MPLS address family on the PE router or provider router interfaces
that communicate with other PE routers or provider routers (and not loopback
addresses).

[edit interfaces interface]
user@host# set unit logical_interface family mpls

3. Configure encapsulation for the interfaces on the PE routers that communicate
with the CE routers in Layer 2 VPNs and Layer 2 circuits. If multiple logical units
are configured, the encapsulation type is needed at the interface level only. It is
always required at the unit level.

[edit interfaces interface]
user@host# set encapsulation encapsulation_type
user@host# set unit logical_interface encapsulation encapsulation_type

4. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

■ MPLS Layer 2 Circuit Configuration Overview on page 754
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Configuring MPLS for VPNs (CLI Procedure)

To configure MPLS for VPNs:

1. Specify the interfaces used for communication between PE routers and between
PE routers and provider routers.

[edit]
user@host# edit protocols mpls interface interface-name

2. For RSVP only, configure the PE router interface communicating with another
PE router.

a. Configure an MPLS LSP to the destination point on the PE router. The path
name is defined on the source router only and is unique between two routers.

[edit protocols mpls]
user@host# edit label-switched-path path-name

b. Specify the IP address of the LSP destination point, which is an address on
the remote PE router.

[edit edit protocols mpls label-switched-path path-name ]
user@host# set to ip-address

3. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

■ MPLS Layer 2 Circuit Configuration Overview on page 754

Configuring a BGP Session for MPLS VPNs (CLI Procedure)

NOTE: This section is valid for Layer 2 VPNs and Layer 3 VPNs, but not Layer 2
circuits.

To configure an IBGP session, perform the following steps on each PE router:

1. Configure BGP.

[edit]
user@host# edit protocols bgp group group-name

2. Set the BGP type to internal.

[edit protocols bgp group group-name]
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user@host# set type internal

3. Specify the loopback interface.

[edit protocols bgp group group-name]
user@host# set local-address loopback-interface-ip-address

4. Set the Layer 2 or Layer 3 VPN family type to unicast.

[edit protocols bgp group group-name]
user@host# set family family-type unicast

Replace family-type with l2vpn for a Layer  2 VPN or inet–vpn for a Layer  3 VPN.

5. Enter the loopback address of the neighboring PE router.

[edit protocols bgp]
user@host# set neighbor ip-address

6. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

Configuring an IGP and the LDP Signaling Protocol (CLI Procedure)

The following example shows how to configure LDP and OSPF on PE routers and
provider routers. Within the example, you specify which interfaces to enable for
LDP. Perform this step on each PE router interface and provider router interface that
communicates with other PE routers and provider routers. For OSPF, you configure
at least one area on at least one of the router's interfaces. (An AS can be divided into
multiple areas.) This example uses the backbone area 0.0.0.0. The example also
shows how to enable traffic engineering for Layer 2 VPN circuits.

To configure LDP and OSPF:

1. Enable the ldp protocol.

[edit]
user@host# edit protocols ldp

NOTE: You must configure the IGP at the [protocols] level of the configuration
hierarchy, not within the routing instance at the [routing-instances] level of the
configuration hierarchy.

2. Specify which interfaces to enable for LDP.

[edit protocols ldp]
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user@host# edit interface interface-name

3. Configure OSPF for each interface that uses LDP.

[edit]
user@host# edit protocols ospf area 0.0.0.0 interface interface-name

4. (Layer 2 VPN circuits only) Enable traffic engineering.

[edit protocols ospf]
user@host# set traffic engineering

5. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

■ MPLS Layer 2 Circuit Configuration Overview on page 754

Configuring an IGP and the RSVP Signaling Protocol (CLI Procedure)

To configure RSVP and OSPF:

1. Configure OSPF with traffic engineering support on the PE routers.

[edit]
user@host# edit protocols ospf traffic-engineering shortcuts

NOTE: You must configure the IGP at the [edit protocols] level, not within the routing
instance at the [edit routing-instances] level.

2. Enable RSVP on interfaces that participate in the LSP. For PE routers, enable
interfaces on the source and destination points. For provider routers, enable
interfaces that connect the LSP between the PE routers.

[edit]
user@host# edit protocols rsvp interface interface-name

3. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741
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■ MPLS Layer 3 VPN Configuration Overview on page 751

■ MPLS Layer 2 Circuit Configuration Overview on page 754

Configuring Routing Options for MPLS VPNs (CLI Procedure)

To configure routing options for a VPN:

1. Configure the AS number.

[edit]
user@host# set routing-options autonomous-system as-number

2. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

■ MPLS Layer 2 Circuit Configuration Overview on page 754

Configuring a Routing Instance for MPLS VPNs (CLI Procedure)

To configure a VPN routing instance on each PE router:

1. Create the routing instance.

[edit]
user@host# edit routing-instances routing-instance-name

2. Create a routing instance description. (This text appears in the output of the show
route instance detail command.)

[edit routing-instances routing-instance-name]
user@host# set description “text”

3. Specify the instance type, either l2vpn for Layer 2 VPNs or vrf for Layer 3 VPNs.

[edit routing-instances routing-instance-name]
user@host# set instance-type instance-type

4. Specify the interface of the remote PE router.

[edit routing-instances routing-instance-name]
user@host# set interface interface-name

5. Specify the route distinguisher using one of the following commands:

[edit routing-instances routing-instance-name]
user@host# set route-distinguisheras-number:number
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user@host# set route-distinguisher ip-address:number

6. Specify the policy for the Layer 2 VRF table.

[edit routing-instances routing-instance-name]
user@host# set vrf-import import-policy-name vrf-export export-policy-name

7. Specify the policy for the Layer 3 VRF table.

[edit routing-instances routing-instance-name]
user@host# set vrf-target target:community-id

Where community-id is either as-number:number or ip-address:number.

8. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

Configuring a Routing Policy for MPLS Layer 2 VPNs (CLI Procedure)

This example shows how to configure a Layer 2 VPN routing policy on the PE routers
in the VPN.

After configuring an import routing policy for a Layer 2 VPN, configure an export
routing policy for the Layer 2 VPN. Configure this export policy on the PE routers in
the VPN. The export routing policy defines how routes are exported from the PE
router routing table. An export policy is applied to routes sent to other PE routers in
the VPN. The export policy must also evaluate all routes received over the routing
protocol session with the CE router. The export policy must also contain a second
term for rejecting all other routes.

To configure a Layer 2 VPN routing policy on a PE router:

1. Configure the import routing policy.

[edit]
user@host# edit policy-options policy-statement import-policy-name

2. Define the import policy’s term for accepting packets.

[edit edit policy-options policy-statement import-policy-name]
user@host# set term term-name-accept from protocol bgp community

community-name
user@host# set term term-name-accept then accept

3. Define the import policy’s term for rejecting packets.

[edit edit policy-options policy-statement import-policy-name]
user@host# set term term-name-reject then reject
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4. Configure the export routing policy.

[edit]
user@host# edit policy-options policy-statement export-policy-name

5. Define the export policy’s term for accepting packets.

[edit policy-options policy-statement export-policy-name]
user@host# set term term-name-accept from community add community-name
user@host# set termterm-name-accept then accept

6. Define the export policy’s term for rejecting packets.

[edit policy-options policy-statement export-policy-name]
user@host# set term term-name-reject from community add community-name
user@host# set term term-name-reject then reject

7. Define the export policy’s community using one of the following commands.

[edit policy-options policy-statement export-policy-name]
user@host# community community-name target: as-number
user@host# community community-name target: ip-address:number

8. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

Verifying an MPLS Layer 2 VPN Configuration

Purpose Verify the connectivity of MPLS Layer 2 VPNs using the ping mpls command. This
command helps to verify that a VPN has been enabled by testing the integrity of the
VPN connection between the PE routers. It does not test the connection between a
PE router and CE router.

Action To ping an interface configured for the Layer 2 VPN on the PE router, use the
following command:

ping mpls l2vpn interface interface-name

■

■ To ping a combination of the Layer 2 VPN routing instance name, the local site
identifier, and the remote site identifier to test the integrity of the Layer 2 VPN
connection (specified by identifiers) between the two PE routers, use the following
command:

ping mpls l2vpn instance l2vpn-instance-name local-site-id local-site-id-number
remote-site-id remote-site-id-number
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Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 2 VPN Configuration Overview on page 741

MPLS Layer 3 VPNs

■ Understanding MPLS Layer 3 VPNs on page 750

■ MPLS Layer 3 VPN Configuration Overview on page 751

■ Configuring a Routing Policy for MPLS Layer 3 VPNs (CLI Procedure) on page 752

■ Verifying an MPLS Layer 3 VPN Configuration on page 753

Understanding MPLS Layer 3 VPNs

An MPLS Layer 3 VPN operates at the Layer 3 level of the OSI model, the Network
layer. The VPN is composed of a set of sites that are connected over a service
provider's existing public Internet backbone. The sites share common routing
information and the connectivity of the sites is controlled by a collection of policies.

In an MPLS Layer 3 VPN, routing occurs on the service provider's routers. The provider
routers route and forward VPN traffic at the entry and exit points of the transit
network. The service provider network must learn the IP addresses of devices sending
traffic across the VPN and the routes must be advertised and filtered throughout the
provider network. As a result, Layer 3 VPNs require information about customer
routes and a more extensive VPN routing and forwarding (VRF) policy configuration
than a Layer 2 VPN. This information is used to share and filter routes that originate
or terminate in the VPN.

The MPLS Layer 3 VPN requires more processing power on the provider edge (PE)
routers than a Layer 2 VPN, because the Layer 3 VPN has larger routing tables for
managing network traffic on the customer sites. Route advertisements originate at
the customer edge (PE) routers and are shared with the inbound PE routers through
standard IP routing protocols, typically BGP. Based on the source address, the PE
router filters route advertisements and imports them into the appropriate VRF table.

The provider router uses OSPF and LDP to communicate with the PE routers. For
OSPF, the provider router interfaces that communicate with the PE routers are
specified, as well as the loopback interface. For the PE routers, the loopback interface
is in passive mode, meaning it does not send OSPF packets to perform the control
function.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS VPN Overview on page 737

■ MPLS Layer 3 VPN Configuration Overview on page 751

■ Layer 3 VPN Introduction in the Junos VPNs Configuration Guide
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MPLS Layer 3 VPN Configuration Overview

To configure MPLS Layer 3 VPN functionality on a router running JUNOS Software,
you must enable support on the provider edge (PE) router and configure the PE router
to distribute routing information to other routers in the VPN, as explained in the
following steps. However, because the tunnel information is maintained at both PE
routers, neither the provider core routers nor the customer edge (CE) routers need
to maintain any VPN information in their configuration databases.

To configure an MPLS Layer 3 VPN:

1. Determine all of the routers that you want to participate in the VPN, and then
complete the initial configuration of their interfaces. See the Junos OS Interfaces
Configuration Guide for Security Devices.

2. For all of the routers in the VPN configuration, update the interface configurations
to enable participation in the Layer 3 VPN. As part of the interface configuration,
you must configure the MPLS address family for each interface that uses LDP or
RSVP. See “Configuring Interfaces for MPLS VPNs (CLI Procedure)” on page 742.

3. For all of the routers in the VPN configuration, configure the appropriate protocols.

a. MPLS—If you are using RSVP, use MPLS to advertise the Layer 3 VPN
interfaces on the PE routers and provider routers that communicate with
other PE routers and provider routers. See “Configuring MPLS for VPNs (CLI
Procedure)” on page 744.

b. BGP, EBGP, and internal BGP (IBGP)—For PE routers, configure a BGP session
to enable the routers to exchange information about routes originating and
terminating in the VPN. (The PE routers use this information to determine
which labels to use for traffic destined to the remote sites. The IBGP session
for the VPN runs through the loopback address.) In addition, CE routers
require a BGP connection to the PE routers. See “Configuring a BGP Session
for MPLS VPNs (CLI Procedure)” on page 744.

c. IGP and a signaling protocol—For PE routers and provider, configure a
signaling protocol (either LDP or RSVP) to dynamically set up label-switched
paths (LSPs) through the provider network. (LDP routes traffic using IGP
metrics. RSVP has traffic engineering that lets you override IGP metrics as
needed.) You must use LDP or RSVP between PE routers and provider routers,
but cannot use them for interfaces between PE routers and CE routers.

In addition, configure an IGP such as OSPF or static routes on the PE routers
in order to enable exchanges of routing information between the PE routers
and provider routers. Each PE router's loopback address must appear as a
separate route. Do not configure any summarization of the PE router's
loopback addresses at the area boundary. Configure the provider network
to run OSPF or IS-IS as an IGP, as well as IBGP sessions through either a full
mesh or route reflector.

MPLS Layer 3 VPN Configuration Overview ■ 751

Chapter 29: MPLS VPNs



See “Configuring an IGP and the LDP Signaling Protocol (CLI Procedure)” on
page 745 and “Configuring an IGP and the RSVP Signaling Protocol (CLI
Procedure)” on page 746.

4. For all of the routers in the VPN configuration, configure routing options. The
only required routing option for VPNs is the autonomous system (AS) number.
You must specify it on each router involved in the VPN. See “Configuring Routing
Options for MPLS VPNs (CLI Procedure)” on page 747.

5. For each PE router in the VPN configuration, configure a routing instance for
each VPN. The routing instance should have the same name on each PE router.
Each routing instance must have a unique route distinguisher associated with it.
(VPN routing instances need a route distinguisher to help BGP distinguish between
potentially identical network layer reachable information [NLRI] messages
received from different VPNs.) See “Configuring a Routing Instance for MPLS
VPNs (CLI Procedure)” on page 747.

6. For CE routers, configure a routing policy. In addition, if you are not using a
route target, configure a VPN routing policy for each PE router in the VPN
configuration. Within the policy, describe which packets are sent and received
across the VPN and specify how routes are imported into and exported from the
router's VRF table. Each advertisement must have an associated route target
that uniquely identifies the VPN for which the advertisement is valid. See
“Configuring a Routing Policy for MPLS Layer 3 VPNs (CLI Procedure)” on page 752.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Verifying an MPLS Layer 3 VPN Configuration on page 753

Configuring a Routing Policy for MPLS Layer 3 VPNs (CLI Procedure)

To configure a Layer 3 VPN routing policy on a CE router:

1. Configure the routing policy for the loopback interface.

[edit]
user@host# edit policy-options policy-statement policy-name

2. Define the term for accepting packets.

[edit policy-options policy-statement policy-name]
user@host# set term term-name-accept from protocol direct route-filter

local-loopback-address/netmask exact
user@host# set termterm-name-accept then accept

3. Define the term for rejecting packets.

[edit policy-options policy-statement policy-name]
user@host# set termterm-name-reject then reject

4. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit
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Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 3 VPN Configuration Overview on page 751

Verifying an MPLS Layer 3 VPN Configuration

Purpose Verify the connectivity of MPLS Layer 3 VPNs using the ping mpls command. This
command helps to verify that a VPN has been enabled by testing the integrity of the
VPN connection between the source and destination routers. The destination prefix
corresponds to a prefix in the Layer 3 VPN. However, ping tests only whether the
prefix is present in a PE VRF table.

Action To a combination of a IPv4 destination prefix and a Layer 3 VPN name on the
destination PE router, use the following command:

ping mpls l3vpn l3vpn-name prefix prefix count count

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 3 VPN Configuration Overview on page 751

MPLS Layer 2 Circuits

■ Understanding MPLS Layer 2 Circuits on page 753

■ MPLS Layer 2 Circuit Configuration Overview on page 754

■ Configuring an MPLS Layer 2 Circuit (CLI Procedure) on page 755

■ Verifying an MPLS Layer 2 Circuit Configuration on page 756

Understanding MPLS Layer 2 Circuits

An MPLS Layer 2 circuit is a point-to-point Layer 2 connection that transports traffic
by means of MPLS or another tunneling technology on the service provider network.
The Layer 2 circuit creates a virtual connection to direct traffic between two customer
edge (CE) routers across a service provider network. The main difference between
a Layer 2 VPN and a Layer 2 circuit is the method of setting up the virtual connection.
As with a leased line, a Layer 2 circuit forwards all packets received from the local
interface to the remote interface.

Each Layer 2 circuit is represented by the logical interface connecting the local
provider edge (PE) router to the local CE router. All Layer 2 circuits using a particular
remote PE router neighbor is identified by its IP address and is usually the endpoint
destination for the label-switched path (LSP) tunnel transporting the Layer 2 circuit.

Each virtual circuit ID uniquely identifies the Layer 2 circuit among all the Layer 2
circuits to a specific neighbor. The key to identifying a particular Layer 2 circuit on
a PE router is the neighbor address and the virtual circuit ID. Based on the virtual
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circuit ID and the neighbor relationship, an LDP label is bound to an LDP circuit. LDP
uses the binding for sending traffic on that Layer 2 circuit to the remote CE router.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS VPN Overview on page 737

■ MPLS Layer 2 Circuit Configuration Overview on page 754

■ Layer 2 Circuit Overview in the Junos VPNs Configuration Guide

MPLS Layer 2 Circuit Configuration Overview

To configure an MPLS Layer 2 circuit:

1. Determine all of the routers that you want to participate in the circuit, and then
complete the initial configuration of their interfaces. See the Junos OS Interfaces
Configuration Guide for Security Devices.

2. For all of the routers in the circuit configuration, update the interface
configurations to enable participation in the Layer 2 circuit.

a. On the interface communicating with the other provider edge (PE) router,
specify MPLS and IPv4, and include the IP address. For the loopback
interface, specify inet, and include the IP address. For IPv4, designate the
loopback interface as primary so it can receive control packets. (Because it
is always operational, the loopback interface is best able to perform the
control function.)

b. On the PE router interface facing the customer edge (CE) router, specify a
circuit cross-connect (CCC) encapsulation type. The type of encapsulation
depends on the interface type. For example, an Ethernet interface uses
ethernet-ccc. (The encapsulation type determines how the packet is
constructed for that interface.)

c. On the CE router interface that faces the PE router, specify inet (for IPv4),
and include the IP address. In addition, specify a routing protocol such as
Open Shortest Path First (OSPF), which specifies the area and IP address of
the router interface.

See “Configuring Interfaces for MPLS VPNs (CLI Procedure)” on page 742.

3. For all of the routers in the circuit configuration, configure the appropriate
protocols.

a. MPLS—For PE routers and provider routers, use MPLS to advertise the Layer
2 circuit interfaces that communicate with other PE routers and provider
routers. See “Configuring MPLS for VPNs (CLI Procedure)” on page 744.

b. BGP—For PE routers, configure a BGP session.

c. IGP and a signaling protocol—For PE routers, configure a signaling protocol
(either LDP or RSVP) to dynamically set up label-switched paths (LSPs)
through the provider network. (LDP routes traffic using IGP metrics. RSVP
has traffic engineering that lets you override IGP metrics as needed.) You
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must use LDP or RSVP between PE routers and provider routers, but cannot
use them for interfaces between PE routers and CE routers.

In addition, configure an IGP such as OSPF or static routes on the PE routers
to enable exchanges of routing information between the PE routers and
provider routers. Each PE router's loopback address must appear as a
separate route. Do not configure any summarization of the PE router's
loopback addresses at the area boundary. Configure the provider network
to run OSPF or IS-IS as an IGP, as well as IBGP sessions through either a full
mesh or route reflector.

See “Configuring an IGP and the LDP Signaling Protocol (CLI Procedure)” on
page 745 and “Configuring an IGP and the RSVP Signaling Protocol (CLI
Procedure)” on page 746.

4. For all of the routers in the circuit configuration, configure routing options. The
only required routing option for circuits is the autonomous system (AS) number.
You must specify it on each router involved in the circuit. See “Configuring
Routing Options for MPLS VPNs (CLI Procedure)” on page 747.

5. For PE routers, configure Layer 2 circuits on the appropriate interfaces. See
“Configuring an MPLS Layer 2 Circuit (CLI Procedure)” on page 755.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ Verifying an MPLS Layer 2 Circuit Configuration on page 756

Configuring an MPLS Layer 2 Circuit (CLI Procedure)

To configure a Layer 2 circuit on a PE router:

1. Enable a Layer 2 circuit on the appropriate interface.

[edit]
user@host# edit protocols l2circuit neighbor interface-name interface

interface-name

2. Enter the circuit ID number.

[edit protocols l2circuit neighbor interface-name interface interface-name]
user@host# set virtual-circuit-id id-number

For neighbor, specify the local loopback address, and for interface, specify the
interface name of the remote PE router.

3. Commit the configuration if you are finished configuring the device.

[edit]
user@host# commit

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ MPLS Layer 2 Circuit Configuration Overview on page 754
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Verifying an MPLS Layer 2 Circuit Configuration

Purpose To verify the connectivity of MPLS Layer 2 circuits, use the ping mpls command. This
command helps to verify that the circuit has been enabled by testing the integrity
of the Layer 2 circuit between the source and destination routers.

Action To ping an interface configured for the Layer 2 circuit on the PE router, enter
the following command:

ping mpls l2circuit interface interface-name

■

■ To ping a combination of the IPv4 prefix and the virtual circuit ID on the
destination PE router, enter the following command:

ping mpls l2circuit virtual-circuitprefix virtual-circuit-id

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 Circuit Configuration Overview on page 754
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Chapter 30

CLNS VPNs

■ CLNS Overview on page 757

■ CLNS Configuration Overview on page 758

■ Example: Configuring a VPN Routing Instance for CLNS (CLI) on page 759

■ ES-IS for CLNS on page 760

■ IS-IS for CLNS on page 761

■ Static Routes for CLNS on page 763

■ BGP for CLNS VPNs on page 764

■ Verifying a CLNS VPN Configuration on page 765

CLNS Overview

Connectionless Network Service (CLNS) is a Layer 3 protocol similar to IP version 4
(IPv4) for linking hosts (end systems) with routers (intermediate systems) in an Open
Systems Interconnection (OSI) network. CLNS and its related OSI protocols,
Intermediate System-to-Intermediate System (IS-IS) and End System-to-Intermediate
System (ES-IS), are International Organization for Standardization (ISO) standards.

You can configure devices running JUNOS Software as provider edge (PE) routers
within a CLNS network. CLNS networks can be connected over an IP MPLS network
core using Border Gateway Protocol (BGP) and MPLS Layer 3 virtual private networks
(VPNs). See RFC 2547, BGP/MPLS VPNs.

CLNS uses network service access points (NSAPs), similar to IP addresses found in
IPv4, to identify end systems (hosts) and intermediate systems (routers). ES-IS enables
the hosts and routers to discover each other. IS-IS is the interior gateway protocol
(IGP) that carries ISO CLNS routes through a network.

For more information about CLNS, see the ISO 8473 standards.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ CLNS Configuration Overview on page 758

■ Understanding ES-IS for CLNS on page 760

■ Understanding IS-IS for CLNS on page 762
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■ Understanding Static Routes for CLNS on page 763

■ Understanding BGP for CLNS VPNs on page 764

CLNS Configuration Overview

To configure CLNS:

1. Configure the network interfaces. See the Junos OS Interfaces Configuration Guide
for Security Devices.

2. If applicable, configure BGP and VPNs. See:

■ Example: Configuring BGP for CLNS VPNs on page 764

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 3 VPN Configuration Overview on page 751

3. Configure a VPN routing instance. You typically configure ES-IS, IS-IS, and CLNS
static routes using a VPN routing instance. See “Example: Configuring a VPN
Routing Instance for CLNS” on page 759.

4. Configure one or more of the following protocols for CLNS (depending on your
network).

■ ES-IS—If a device is a PE router within a CLNS island that contains any end
systems, you must configure ES-IS on the device. If a CLNS island does not
contain any end systems, you do not need to configure ES-IS on a device.
See “Example: Configuring ES-IS for CLNS” on page 761.

NOTE: ES-IS is enabled only if either ES-IS or IS-IS is configured on the router. ES-IS
must not be disabled. If ES-IS is not explicitly configured, the interface sends and
receives only intermediate system hello (ISH) messages. If ES-IS is explicitly configured
and disabled, the interface does not send or receive ES-IS packets. If ES-IS is explicitly
configured and not disabled, the interface sends and receives ISH messages as well
as ES-IS packets.

One of the interfaces that is configured for ES-IS must be configured with an ISO
address for hello messages. The ISO address family must be configured on an interface
to support ES-IS on that interface.

■ IS-IS—You can configure IS-IS to exchange CLNS routes within a CLNS island.
See “Example: Configuring IS-IS for CLNS” on page 762.

NOTE: If you have a pure CLNS island—an island that does not contain any IP
devices—you must disable IPv4 and IPv6 routing. Also, to export BGP routes into
IS-IS, you must configure and apply an export policy.
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■ Static routes—If some devices in your network do not support IS-IS, you
must configure CLNS static routes. You can use static routing with or without
IS-IS. You might also consider using static routes if your network is simple.
See “Example: Configuring Static Routes for CLNS” on page 763.

■ BGP—See “Example: Configuring BGP for CLNS VPNs” on page 764.

NOTE: Many of the configuration statements used to configure CLNS and routing
protocols can be included at different hierarchy levels in the configuration. For more
information, see the Junos Routing Protocols Configuration Guide.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ CLNS Overview on page 757

■ Verifying a CLNS VPN Configuration on page 765

Example: Configuring a VPN Routing Instance for CLNS (CLI)

The following example shows how to create a CLNS routing instance called aaaa and
set the instance type to VRF for Layer 3 VPNs. Within the example, you specify that
the lo0.1 interface, e1–2/0/0.0 interface, and t1–3/0/0.0 interface all belong to the
routing instance. The route distinguisher is set as 10.255.245.1:1 and the policy for
the Layer 3 VRF table is set as target:11111:1.

To configure a VPN routing instance:

1. Create the routing instance.

[edit]
user@host# edit routing-instances aaaa

2. Specify the routing instance type.

[edit routing-instances aaaa]
user@host# set instance-type vrf

3. Specify the interfaces that belong to the routing instance.

[edit routing-instances aaaa]
user@host# set interface lo0.1
user@host# set interface e1–2/0/0.0
user@host# set interface t1–3/0/0.0

4. Specify the route distinguisher.

[edit routing-instances aaaa]
user@host# set route-distinguisher 10.255.245.1:1

5. Specify the policy for the Layer 3 VRF table.

[edit routing-instances aaaa]
user@host# set vrf-target target:11111:1
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6. Commit the configuration if you are done configuring the device.

[edit]
user@host# commit

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ CLNS Configuration Overview on page 758

■ Verifying a CLNS VPN Configuration on page 765

ES-IS for CLNS

■ Understanding ES-IS for CLNS on page 760

■ Example: Configuring ES-IS for CLNS (CLI) on page 761

Understanding ES-IS for CLNS

End System-to-Intermediate System (ES-IS) is a protocol that resolves Layer 3 ISO
network service access points (NSAP) to Layer 2 addresses. ES-IS has an equivalent
role as Address Resolution Protocol (ARP) in IP version 4 (IPv4).

ES-IS provides the basic interaction between Connectionless Network Service (CLNS)
hosts (end systems) and routers (intermediate systems). ES-IS allows hosts to advertise
NSAP addresses to other routers and hosts attached to the network. Those routers
can then advertise the address to the rest of the network by using Intermediate
System-to-Intermediate System (IS-IS). Routers use ES-IS to advertise their network
entity title (NET) to hosts and routers that are attached to that network.

ES-IS routes are exported to Layer 1 IS-IS by default. You can also export ES-IS routes
into Layer 2 IS-IS by configuring a routing policy. ES-IS generates and receives end
system hello (ESH) hello messages when the protocol is configured on an interface.
ES-IS is a resolution protocol that allows a network to be fully ISO integrated at both
the network layer and the data layer.

The resolution of Layer 3 ISO NSAPs to Layer 2 subnetwork point of attachments
(SNPAs) by ES-IS is equivalent to ARP within an IPv4 network. If a device is a provider
edge (PE) router within a CLNS island that contains any end systems, you must
configure ES-IS on the device.

For more information about ES-IS, see the ISO 9542 standard.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ CLNS Overview on page 757

■ Example: Configuring ES-IS for CLNS on page 761

760 ■ ES-IS for CLNS

JUNOS Software Interfaces and Routing Configuration Guide



Example: Configuring ES-IS for CLNS (CLI)

In the following example, you create a routing instance called aaaa and enable ES-IS
on all interfaces. You set the end system configuration timer for the interfaces to
180, set the graceful restart duration to 180, and set a preference value for ES-IS.

To configure ES-IS:

1. Create the routing instance.

[edit]
user@host# edit routing-instances aaaa

2. Enable ES-IS on all interfaces.

[edit routing-instances aaaa]
user@host# set protocols esis interface all

3. Configure the end system configuration timer.

[edit routing-instances aaaa]
user@host# set protocols esis interface all end-system-configuration-timer 180

4. Configure graceful restart.

[edit routing-instances aaaa]
user@host# set protocols esis graceful-restart restart-duration 180

5. Configure the preference value.

[edit routing-instances aaaa]
user@host# set protocols esis preference value

6. Commit the configuration if you are done configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ CLNS Configuration Overview on page 758

■ Understanding ES-IS for CLNS on page 760

■ Verifying a CLNS VPN Configuration on page 765

IS-IS for CLNS

■ Understanding IS-IS for CLNS on page 762

■ Example: Configuring IS-IS for CLNS (CLI) on page 762
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Understanding IS-IS for CLNS

Intermediate System-to-Intermediate System (IS-IS) extensions provide the basic
interior gateway protocol (IGP) support for collecting intradomain routing information
for Connectionless Network Service (CLNS) destinations within a CLNS network.
Routers that learn host addresses through End System-to-Intermediate System (ES-IS)
can advertise the addresses to other routers (intermediate systems) by using IS-IS.

For more information about IS-IS, see the ISO 10589 standard.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ CLNS Overview on page 757

■ Example: Configuring IS-IS for CLNS on page 762

Example: Configuring IS-IS for CLNS (CLI)

To configure IS-IS for CLNS:

1. Configure the routing instance.

[edit]
user@host# edit routing-instances aaaa

2. Enable CLNS routing.

[edit routing-instances aaaa]
user@host# set protocols isis clns-routing

3. Enable IS-IS on all interfaces.

[edit routing-instances aaaa]
user@host# set protocols isis interface all

4. (Optional) Disable IPv4 and IPv6 routing to configure a pure CLNS network.

[edit routing-instances aaaa]
user@host# set protocols isis no-ipv4-routing no-ipv6-routing

5. Define the BGP export policy name—for example, dist-bgp—and the family and
protocol.

[edit]
user@host# set policy-options policy-statement dist-bgp from family iso protocol

bgp

6. Define the action for the export policy.

[edit]
user@host# set policy-options policy-statement dist-bgp then accept

7. Apply the export policy to IS-IS.

[edit]
user@host# set routing-instances aaaa protocols isis export dist-bgp
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8. Commit the configuration if you are done configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ CLNS Configuration Overview on page 758

■ Understanding IS-IS for CLNS on page 762

■ Configuring CLNS for IS-IS in the Junos Routing Protocols Configuration Guide

■ clns-routing in the Junos Routing Protocols Configuration Guide

■ Verifying a CLNS VPN Configuration on page 765

Static Routes for CLNS

■ Understanding Static Routes for CLNS on page 763

■ Example: Configuring Static Routes for CLNS (CLI) on page 763

Understanding Static Routes for CLNS

You can configure static routes to exchange Connectionless Network Service (CLNS)
routes within a CLNS island. A CLNS island is typically an IS-IS level 1 area that is
part of a single IGP routing domain. An island can contain more than one area. CLNS
islands can be connected by VPNs.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ CLNS Overview on page 757

■ Example: Configuring Static Routes for CLNS on page 763

Example: Configuring Static Routes for CLNS (CLI)

This procedure uses the following ISO NET address and NSAP prefix:

■ 47.0005.80ff.f800.0000.aaaa.1000.1921.6800.4196.00

■ 47.0005.80ff.f800.0000.bbbb.1022/104

To configure CLNS static routes:

1. Configure the routing instance.

[edit]
user@host# edit routing-instances aaaa

2. Configure the next-hop ISO NET address for an NSAP prefix.

[edit routing-instances aaaa]
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user@host# set routing-options iso-route
47.0005.80ff.f800.0000.bbbb.1022/104 next-hop
47.0005.80ff.f800.0000.aaaa.1000.1921.6800.4196.00

3. Commit the configuration if you are done configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ CLNS Configuration Overview on page 758

■ Understanding Static Routes for CLNS on page 763

■ Configuring CLNS Static Routes in the Junos Routing Protocols Configuration Guide

■ Verifying a CLNS VPN Configuration on page 765

BGP for CLNS VPNs

■ Understanding BGP for CLNS VPNs on page 764

■ Example: Configuring BGP for CLNS VPNs (CLI) on page 764

Understanding BGP for CLNS VPNs

Border Gateway Protocol (BGP) extensions allow BGP to carry Connectionless Network
Service (CLNS) virtual private network (VPN) network layer reachability information
(NLRI) between provider edge (PE) routers. Each CLNS route is encapsulated into a
CLNS VPN NLRI and propagated between remote sites in a VPN.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ CLNS Overview on page 757

■ Example: Configuring BGP for CLNS VPNs on page 764

Example: Configuring BGP for CLNS VPNs (CLI)

In this example, you create a BGP group called pedge-pedge, define the
10.255.245.215 BGP peer neighbor address for the group, and define the family.

To configure BGP to carry CLNS VPN NLRI:

1. Configure BGP.

[edit]
user@host# set protocols bgp group pedge-pedge neighbor 10.255.245.215

family iso-vpn unicast

764 ■ BGP for CLNS VPNs

JUNOS Software Interfaces and Routing Configuration Guide



2. Commit the configuration if you are done configuring the device.

[edit]
user@host# commit

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ CLNS Configuration Overview on page 758

■ Understanding BGP for CLNS VPNs on page 764

■ Enabling BGP to Carry CLNS Routes in the Junos Routing Protocols Configuration
Guide

■ iso-vpn in the Junos Routing Protocols Configuration Guide

■ Verifying a CLNS VPN Configuration on page 765

Verifying a CLNS VPN Configuration

Purpose Verify that the device is configured correctly for CLNS VPNs.

Action From configuration mode in the CLI, enter the show command.

[edit]
user@host# show
interfaces {

e1–2/0/0.0 {
unit 0 {

family inet {
address 192.168.37.51/31;

}
family iso;
family mpls;

}
}
t1–3/0/0.0 {

unit 0 {
family inet {

address 192.168.37.24/32;
}
family iso;
family mpls;

}
}
lo0 {

unit 0 {
family inet {

address 127.0.0.1/32;
address 10.255.245.215/32;

}
family iso {

address 47.0005.80ff.f800.0000.0108.0001.1921.6800.4215.00;
}
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}
unit 1 {

family iso {
address 47.0005.80ff.f800.0000.0108.aaa2.1921.6800.4215.00;

}
}

}
}
routing-options {

autonomous-system 230;
}
protocols {

bgp {
group pedge-pedge {

type internal;
local-address 10.255.245.215;
neighbor 10.255.245.212 {

family iso-vpn {
unicast;

}
}

}
}

}
policy-options {

policy-statement dist-bgp {
from {

protocol bgp;
family iso;

}
then accept;

}
}
routing-instances {

aaaa {
instance-type vrf;
interface lo0.1;
interface e1–2/0/0.0;
interface t1–3/0/0.0;
route-distinguisher 10.255.245.1:1;
vrf-target target:11111:1;
routing-options {

rib aaaa.iso.0 {
static {

iso-route 47.0005.80ff.f800.0000.bbbb.1022/104
next-hop 47.0005.80ff.f800.0000.aaaa.1000.1921.6800.4196.00;

}
}

}
protocols {

esis {
interface all;

}
isis {

export dist-bgp;
no-ipv4–routing;
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no-ip64–routing;
clns–routing;
interface all;

}
}

}
}

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ CLNS Configuration Overview on page 758

■ show bgp neighbor in the Junos Routing Protocols and Policies Command Reference

■ show bgp summary in the Junos Routing Protocols and Policies Command Reference

■ show isis backup coverage  in the Junos Routing Protocols and Policies Command
Reference

■ show isis database in the Junos Routing Protocols and Policies Command Reference

■ show isis overview in the Junos Routing Protocols and Policies Command Reference

■ show isis route in the Junos Routing Protocols and Policies Command Reference

■ show isis spf in the Junos Routing Protocols and Policies Command Reference
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Chapter 31

VPLS

■ VPLS Overview on page 769

■ VPLS Configuration Overview on page 773

■ VPLS Interfaces on page 774

■ VPLS Routing Instances on page 777

■ Example: Configuring Routing Options on the VPLS PE Router (CLI) on page 781

■ Example: Configuring MPLS on the VPLS PE Router (CLI) on page 781

■ Example: Configuring RSVP on the VPLS PE Router (CLI) on page 782

■ Example: Configuring BGP on the VPLS PE Router (CLI) on page 782

■ Example: Configuring OSPF on the VPLS PE Router (CLI) on page 783

■ VPLS VLAN Encapsulation on page 783

VPLS Overview

Virtual private LAN service (VPLS) is an Ethernet-based point-to-multipoint Layer 2
VPN. It allows you to connect geographically dispersed Ethernet LAN sites to each
other across an MPLS backbone. For customers who implement VPLS, all sites appear
to be in the same Ethernet LAN even though traffic travels across the service provider's
network.

VPLS, in its implementation and configuration, has much in common with an MPLS
Layer 2 VPN. In a VPLS topology, a packet originating within a customer’s network
is sent first to a customer edge (CE) device (for example, a router or Ethernet switch).
It is then sent to a provider edge (PE) router within the service provider’s network.
The packet traverses the service provider’s network over an MPLS label-switched
path (LSP). It arrives at the egress PE router, which then forwards the traffic to the
CE device at the destination customer site.

The difference is that for VPLS, packets can traverse the service provider’s network
in point-to-multipoint fashion, meaning that a packet originating from a CE device
can be broadcast to all the PE routers participating in a VPLS routing instance. In
contrast, a Layer 2 VPN forwards packets in point-to-point fashion only. The paths
carrying VPLS traffic between each PE router participating in a routing instance are
signaled using BGP.
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This topic contains the following sections:

■ Sample VPLS Topology on page 770

■ VPLS on PE Routers on page 770

■ Using an Ethernet Switch as the VPLS CE Device on page 772

■ VPLS Exceptions on J Series and SRX Series Devices on page 772

Sample VPLS Topology

Figure 89 on page 770 shows a basic VPLS topology.

Figure 89: Basic VPLS Topology
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In this sample, the PE routers use the same autonomous system (AS). Within the AS,
routing information is communicated through an interior gateway protocol (IGP).
Outside the AS, routing information is shared with other ASs through BGP. The PE
routers must use the same signaling protocols to communicate.

VPLS on PE Routers

Within a VPLS configuration, a device running JUNOS Software can act as a PE router.
JUNOS Software passes the VPLS traffic through the following ports and PIMs on the
Juniper Networks device to CE routers in the VPLS network:

■ Built-in Ethernet ports on front panel

■ Gigabit Ethernet uPIMs

■ Gigabit Ethernet ePIMs

■ Fast Ethernet PIMs

■ Fast Ethernet ePIMs

NOTE: Ports on uPIMs and ePIMs must be in routing mode before you can configure
the corresponding interfaces for VPLS.
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Because a VPLS carries Ethernet traffic across a service provider network, it must
mimic an Ethernet network in some ways. When a PE router configured with a VPLS
routing instance receives a packet from a CE device, it first determines whether it
has the destination of the VPLS packet in the appropriate routing table. If it does, it
forwards the packet to the appropriate PE router or CE device. If it does not, it
broadcasts the packet to all other PE routers and CE devices that are members of
that VPLS routing instance. In both cases, the CE device receiving the packet must
be different from the one sending the packet.

When a PE router receives a packet from another PE router, it first determines
whether it has the destination of the VPLS packet in the appropriate routing table. If
it does, the PE router either forwards the packet or drops it depending on whether
the destination is a local or remote CE device:

■ If the destination is a local CE device, the PE router forwards the packet to it.

■ If the destination is a remote CE device (connected to another PE router), the
PE router discards the packet.

If the PE router cannot determine the destination of the VPLS packet, it floods the
packet to all attached CE devices. Figure 90 on page 771 illustrates this process.

Figure 90: Flooding a Packet with an Unknown Destination
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A VPLS can be directly connected to an Ethernet switch. Layer 2 information gathered
by an Ethernet switch, for example, MAC addresses and interface ports, is included
in the VPLS routing instance table.

An MPLS label-switched interface (LSI) label is used as the inner label for VPLS. This
label maps to a VPLS routing instance. On the PE router, the LSI label is stripped and
then mapped to a logical LSI interface. The Layer 2 Ethernet frame is then forwarded
using the LSI interface to the correct VPLS routing instance.

One restriction on flooding behavior in VPLS is that traffic received from remote PE
routers is never forwarded to other PE routers. This restriction helps prevent loops
in the core network. However, if a CE Ethernet switch has two or more connections
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to the same PE router, you must enable the Spanning Tree Protocol (STP) on the CE
switch to prevent loops.

NOTE: Under certain circumstances, VPLS PE routers might duplicate an Internet
Control Message Protocol (ICMP) reply from a CE device when a PE router has to
flood an ICMP request because the destination MAC address has not yet been learned.
The duplicate ICMP reply can be triggered when a CE device with promiscuous mode
enabled is connected to a PE router. The PE router automatically floods the
promiscuous mode enabled CE device, which then returns the ICMP request to the
VPLS PE routers. The VPLS PE routers consider the ICMP request to be new and flood
the request again, creating a duplicate ping reply.

Using an Ethernet Switch as the VPLS CE Device

For VPLS configurations, the CE device does not necessarily need to be a router. You
can link the PE routers directly to Ethernet switches. However, be aware of the
following configuration issues:

■ When you configure VPLS routing instances and establish two or more
connections between a CE Ethernet switch and a PE router, you must enable
the Spanning Tree Protocol (STP) on the switch to prevent loops.

■ JUNOS Software allows standard bridge protocol data unit (BPDU) frames to pass
through emulated Layer 2 connections, such as those configured with Layer 2
VPNs, Layer 2 circuits, and VPLS instances. However, CE Ethernet switches that
generate proprietary BPDU frames might not be able to run STP across Juniper
Networks routing platforms configured for these emulated Layer 2 connections.

VPLS Exceptions on J Series and SRX Series Devices

The VPLS implementation on a J Series or SRX Series device is similar to VPLS
implementations on M Series, T Series, and MX Series routers, with the following
exceptions:

■ J Series or SRX Series devices do not support aggregated Ethernet interfaces.
Therefore, aggregated Ethernet interfaces between CE devices and PE routers
are not supported for VPLS routing instances on J Series or SRX Series devices.

■ VPLS routing instances on J Series or SRX Series devices use BGP to send signals
to other PE routers. LDP signaling is not supported.

■ VPLS multihoming, which allows connecting a CE device to multiple PE routers
to provide redundant connectivity, is not supported on J Series or SRX Series
devices.

■ J Series or SRX Series devices do not support BGP mesh groups.

■ J Series or SRX Series devices support only the following encapsulation types on
VPLS interfaces that face CE devices: extended VLAN VPLS, Ethernet VPLS, and
VLAN VPLS. Ethernet VPLS over ATM LLC encapsulation is not supported.
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■ Virtual ports are generated dynamically on a Tunnel Services PIC on some Juniper
Networks routing platforms. J Series or SRX Series devices do not support Tunnel
Services modules or virtual ports.

■ The VPLS implementation on J Series or SRX Series devices does not support
dual-tagged frames. Therefore, VLAN rewrite operations are not supported on
dual-tagged frames. VLAN rewrite operations such as pop-pop, pop-swap,
push-push, swap-push, and swap-swap, which are supported on M Series and T
Series routing platforms, are not supported on J Series or SRX Series devices.

■ Firewall filters for VPLS are not supported.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ Understanding VPLS Interfaces on page 774

■ Understanding VPLS Routing Instances on page 777

■ Understanding VPLS VLAN Encapsulation on page 783

■ Understanding VPLS VLAN Encapsulation on a Logical Interface on page 785

■ VPLS Configuration Overview on page 773

VPLS Configuration Overview

To configure VPLS functionality, you must enable VPLS support on the provider edge
(PE) routers. You must also configure PE routers to distribute routing information to
the other PE routers in the VPLS and configure the circuits between the PE routers
and the customer edge (CE) devices, as explained in the steps that follow.

NOTE: Many configuration procedures for VPLS are identical to the procedures for
Layer 2 and Layer 3 VPNs.

To configure VPLS:

1. Determine which uPIM and ePIM ports correspond to the interfaces that will
carry the VPLS traffic and enable routing mode on those ports.

2. Configure the interfaces that will carry the VPLS traffic between the PE router
and CE devices. On the PE router interfaces that are facing the CE devices, specify
a VPLS encapsulation type. The type of encapsulation depends on the interface
type. See“Example: Configuring Routing Interfaces on the VPLS PE Router (CLI)”
on page 776 and “Example: Configuring the Interface to the VPLS CE Device” on
page 777.

3. Create a VPLS routing instance on each PE router that is participating in the
VPLS. For each VPLS routing instance, specify which interfaces will carry the
VPLS traffic between the PE and CE devices. On the CE device interface that
faces the PE router, you must specify inet (for IPv4), and include the IP address.
Additionally, each routing instance must have a unique route distinguisher
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associated with it. (VPN routing instances need a route distinguisher to help BGP
identify overlapping network layer reachability information (NLRI) messages
from different VPNs.) See “Example: Configuring the VPLS Routing Instance” on
page 780.

4. Configure routing options on the PE router. See “Example: Configuring Routing
Options on the VPLS PE Router” on page 781.

5. Configure MPLS LSPs between the PE routers. See “Example: Configuring MPLS
on the VPLS PE Router” on page 781.

6. Configure RSVP on the PE routers. Enable RSVP for all connections that participate
in the MPLS LSP. See “Example: Configuring RSVP on the VPLS PE Router” on
page 782.

7. Configure an IBGP session between PE routers so that the routers can exchange
information about routes originating and terminating in the VPLS. See “Example:
Configuring BGP on the VPLS PE Router” on page 782.

8. Configure an IGP on the PE routers to exchange routing information. See
“Example: Configuring OSPF on the VPLS PE Router” on page 783.

9. Configure VLAN encapsulation. See “Example: Configuring VPLS VLAN
Encapsulation on a Gigabit Ethernet Interface (CLI)” on page 784,“Example:
Configuring VPLS VLAN Encapsulation on an Aggregated Ethernet Interface (CLI)”
on page 785, and “Configuring VPLS VLAN Encapsulation for a VLAN Circuit (CLI
Procedure)” on page 785.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ MPLS Layer 2 VPN Configuration Overview on page 741

■ Example: Configuring MPLS on the VPLS PE Router on page 781

■ Example: Configuring RSVP on the VPLS PE Router on page 782

■ Example: Configuring BGP on the VPLS PE Router on page 782

■ Example: Configuring OSPF on the VPLS PE Router on page 783

VPLS Interfaces

■ Understanding VPLS Interfaces on page 774

■ Example: Configuring Routing Interfaces on the VPLS PE Router (CLI) on page 776

■ Example: Configuring the Interface to the VPLS CE Device (CLI) on page 777

Understanding VPLS Interfaces

For each VPLS routing instance on a PE router, you specify which interfaces are to
be used to carry VPLS traffic between the PE and CE devices.
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This topic contains the following sections:

■ Interface Name on page 775

■ Encapsulation Type on page 775

■ Flexible VLAN Tagging on page 776

■ VLAN Rewrite on page 776

Interface Name

Specify both the physical and logical portions of the interface name, in the following
format:

physical.logical

For example, in ge-1/2/1.2, ge-1/2/1 is the physical portion of the interface name
and 2 is the logical portion. If you do not specify the logical portion of the interface
name, 0 is set by default. A logical interface can be associated with only one routing
instance.

Encapsulation Type

The physical link-layer encapsulation type for a VPLS interface can be one of the
following:

■ ethernet-vpls—Use Ethernet VPLS encapsulation on Ethernet interfaces that have
VPLS enabled and that must accept packets carrying standard Tag Protocol
Identifier (TPID) values.

■ extended-vlan-vpls—Use extended virtual LAN (VLAN) VPLS encapsulation on
Ethernet interfaces that have VLAN 802.1Q tagging and VPLS enabled and that
must accept packets carrying TPIDs 0x8100, 0x9100, and 0x9901. All VLAN IDs
from 1 through 1023 are valid for VPLS VLANs on Fast Ethernet interfaces, and
all VLAN IDs from 1 through 4094 are valid for VPLS VLANs on Gigabit Ethernet
interfaces.

■ vlan-vpls—Use VLAN VPLS encapsulation on Ethernet interfaces with VLAN tagging
and VPLS enabled. Interfaces with VLAN VPLS encapsulation accept packets
carrying standard TPID values only. You must configure this encapsulation type
on both the physical interface and the logical interface. VLAN IDs 1 through 511
are reserved for normal Ethernet VLANs, IDs 512 through 1023 are reserved for
VPLS VLANs on Fast Ethernet interfaces, and IDs 512 through 4094 are reserved
for VPLS VLANs on Gigabit Ethernet interfaces.

■ flexible-ethernet-services—Use flexible Ethernet services encapsulation when you
want to configure multiple per-unit Ethernet encapsulations. This encapsulation
type allows you to configure any combination of route, TCC, CCC, and VPLS
encapsulations on a single physical port. Aggregated Ethernet bundles cannot
use this encapsulation type.

For flexible Ethernet services encapsulation, VLAN IDs from 1 through 511 are
no longer reserved for normal VLANs.
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Flexible VLAN Tagging

For untagged packets to be accepted on an 802.1Q VLAN-tagged port, specify the
native VLAN ID with the flexible VLAN tagging option. (No other flexible VLAN tagging
features are supported.)

VLAN Rewrite

You can rewrite VLAN tags on VPLS interfaces. Rewriting VLAN tags allows you to
use an additional (outer) VLAN tag to differentiate between CE devices that share a
VLAN ID.

You can configure rewrite operations to stack (push), remove (pop), or rewrite (swap)
tags on single-tagged frames. If a port is not configured for VLAN tagging, rewrite
operations are not supported on any logical interface on that port.

You can configure the following VLAN rewrite operations:

■ pop—Remove a VLAN tag from the top of the VLAN tag stack. The outer VLAN
tag of the frame is removed.

■ push—Add a new VLAN tag to the top of the VLAN stack. An outer VLAN tag is
pushed in front of the existing VLAN tag.

■ swap—Replace the VLAN tag at the top of the VLAN tag stack with a user-specified
VLAN tag value.

You perform VLAN rewrite operations by applying input and output VLAN maps at
the ingress and egress, respectively, of the interface. For incoming frames, use the
input-vlan-map; for outgoing frames, use the output-vlan-map.

The VPLS implementation on J Series or SRX Series devices does not support
dual-tagged frames. Therefore, VLAN rewrite operations are not supported on
dual-tagged frames. VLAN rewrite operations such as pop-pop, pop-swap, push-push,
swap-push, and swap-swap, which are supported on M Series and T Series routing
platforms, are not supported on J Series or SRX Series devices.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Example: Configuring Routing Interfaces on the VPLS PE Router (CLI) on page 776

■ Example: Configuring the Interface to the VPLS CE Device on page 777

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

■ Understanding VPLS VLAN Encapsulation on page 783

Example: Configuring Routing Interfaces on the VPLS PE Router (CLI)

This example shows how to configure the PE1 router loopback and the interface to
the PE2 router (so-2/0/1).
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To configure the loopback interface on the VPLS PE router:

user@host# set interfaces lo0 unit 0 family inet address 127.0.0.1/32
user@host# set interfaces lo0 unit 0 family inet address 10.255.7.168/32 primary
user@host# set interfaces lo0 unit 0 family iso address

47.0005.80ff.f800.0000.0108.001.0102.5500.7168.00
user@host# set interfaces lo0 unit 0 family inet6 address abcd::10:255:7:168/128

primary

To configure the interface to the PE2 router on the VPLS PE router:

user@host# set interfaces so-2/0/1 unit 0 family inet address 10.1.1.1/30
user@host# set interfaces so-2/0/1 unit 0 family mpls

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ Understanding VPLS Interfaces on page 774

Example: Configuring the Interface to the VPLS CE Device (CLI)

This example shows how to configure the PE1 router interface that is connected to
the CE device to include VPLS encapsulation.

To configure VPLS encapsulation for the interface facing the CE router:

user@host# set interfaces ge-1/2/1 encapsulation ethernet-vpls

To configure the interface for the vpls family group:

user@host# set interfaces ge-1/2/1 unit 0 family vpls

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ Understanding VPLS Interfaces on page 774

VPLS Routing Instances

■ Understanding VPLS Routing Instances on page 777

■ Example: Configuring the VPLS Routing Instance (CLI) on page 780

Understanding VPLS Routing Instances

To configure VPLS functionality, you must enable VPLS support on the PE router.
You must also configure PE routers to distribute routing information to the other PE
routers in the VPLS and configure the circuits between the PE routers and the CE
devices.
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You create a VPLS routing instance on each PE router that is participating in the
VPLS. The routing instance has the same name on each PE router. To configure the
VPLS routing instance, you specify the following:

■ Route distinguisher—Helps BGP distinguish between potentially identical network
layer reachability information (NLRI) messages received from different VPLS
instances. Each routing instance that you configure on a PE router must have a
unique route distinguisher.

■ Route target—Defines which route is part of a VPLS. A unique route target helps
distinguish between different VPLS services on the same router.

■ Site name—Provides unique name for the VPLS site.

■ Site identifier—Provides unique numerical identifier for the VPLS site.

■ Site range—Specifies total number of sites in the VPLS. The site range must be
greater than the site identifier.

■ Interface to the CE router—Specifies the physical interface to the CE router that
carries VPLS traffic. The interface must be configured for a VPLS encapsulation
type.

NOTE: In addition to the VPLS routing instance, you must configure MPLS
label-switched paths (LSPs) between the PE routers, internal BGP (IBGP) sessions
between the PE routers, and an interior gateway protocol (IGP) on the PE routers.

CAUTION: MPLS is disabled by default on J Series and SRX Series devices. You must
explicitly configure your router to allow MPLS traffic. However, when MPLS is enabled,
all flow-based security features are deactivated and the router performs packet-based
processing. Flow-based services such as security policies, zones, NAT, ALGs, chassis
clustering, screens, firewall authentication, and IPSec VPNs are unavailable on the
router.

This topic contains the following sections:

■ BGP Signaling on page 778

■ VPLS Routing Table on page 779

■ Trace Options on page 780

BGP Signaling

BGP is used to signal the paths between each of the PE routers participating in the
VPLS routing instance. These paths carry VPLS traffic across the service provider's
network between the VPLS sites.

NOTE: LDP signaling is not supported for the VPLS routing instance.
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To configure BGP signaling, you specify the following:

■ VPLS site name and site identifier—When you configure BGP signaling for the
VPLS routing instance, you must specify each VPLS site that has a connection
to the router. For each VPLS site, you must configure a site name and site
identifier (a numerical identifier between 1 to 65,534 that uniquely identifies
the VPLS site).

■ Site range—When you enable BGP signaling for the VPLS routing instance, you
need to configure a site range. The site range specifies the total number of sites
in the VPLS.

NOTE: The site range value must be greater than the largest site identifier.

■ Site preference—You can specify the preference value advertised for a particular
VPLS site. The site preference value is encoded in the BGP local preference
attribute. When a PE router receives multiple advertisements with the same
VPLS edge (VE) device identifier, the advertisement with the highest local
preference value is preferred.

VPLS Routing Table

The VPLS routing table contains MAC addresses and interface information for both
physical and virtual ports. You can configure the following characteristics for the
table:

■ Table size—You can modify the size of the VPLS MAC address table. The default
table size is 512 MAC addresses; the minimum is 16 addresses, and the maximum
is 65,536 addresses.

If the MAC table limit is reached, new MAC addresses can no longer be added
to the table. Eventually the oldest MAC addresses are removed from the MAC
address table automatically. This frees space in the table, allowing new entries
to be added. However, as long as the table is full, new MAC addresses are
dropped.

The interfaces affected include all of the interfaces within the VPLS routing
instance, including the local interfaces and the LSI interfaces.

■ Timeout interval—You can modify the timeout interval for the VPLS table. The
default timeout interval is 300 seconds; the minimum is 10 seconds, and the
maximum is 1,000,000 seconds. We recommend you configure longer values
for small, stable VPLS networks and shorter values for large, dynamic VPLS
networks. If the VPLS table does not receive any updates during the timeout
interval, the router waits one additional interval before automatically clearing
the MAC address entries from the VPLS table.

■ Number of addresses learned from an interface—You can configure a limit on
the number of MAC addresses learned by a VPLS routing instance by setting the
MAC table size. The default is 512 addresses; the minimum is 16, and the
maximum is 65,536 addresses. If the MAC table limit is reached, new MAC
addresses can no longer be added to the table. Eventually the oldest MAC
addresses are removed from the MAC address table automatically. This frees
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space in the table, allowing new entries to be added. However, as long as the
table is full, new MAC addresses are dropped.

Because this limit applies to each VPLS routing instance, the MAC addresses of
a single interface can consume all the available space in the table, preventing
the routing instance from acquiring addresses from other interfaces. You can
limit the number of MAC addresses learned from all interfaces configured for a
VPLS routing instance, as well as limit the number of MAC addresses learned
from a specific interface.

The MAC limit configured for an individual interface overrides the limit configured
for all interfaces for the VPLS routing instance. Also, the table limit can override
the limits configured for the interfaces.

The MAC address limit applies only to interfaces to CE devices.

Trace Options

The following trace flags display operations associated with VPLS:

■ all—All VPLS tracing options

■ connections—VPLS connections (events and state changes)

■ error—Error conditions

■ nlri—VPLS advertisements received or sent using BGP

■ route—Trace-routing information

■ topology—VPLS topology changes caused by reconsideration or advertisements
received from other PE routers using BGP

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Example: Configuring the VPLS Routing Instance on page 780

■ Example: Configuring Routing Options on the VPLS PE Router on page 781

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

■ Understanding VPLS VLAN Encapsulation on page 783

Example: Configuring the VPLS Routing Instance (CLI)

Create a VPLS routing instance on each PE router that is participating in the VPLS.

NOTE: You must specify no-tunnel-services in the VPLS routing instance configuration,
as J Series and SRX Series devices do not support tunnel serial PICs.

To create a VPLS routing instance:

user@host# set routing-instances green instance-type vpls
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To configure the VPLS site identifier and range for the VPLS routing instance:

user@host# set routing-instances green protocols vpls site-range 10 site R3
site-identifier 2

To configure the no-tunnel-services option for the VPLS routing instance green:

user@host# set routing-instances green protocols vpls no-tunnel-services

To configure the route distinguisher and route target for the VPLS routing instance:

user@host# set routing-instances green route-distinguisher 10.255.7.1:1
user@host# set routing-instances green vrf-target target:11111:1

To specify the VPLS interface to the CE router:

user@host# set routing-instances green instance-type vpls interface ge-1/2/1.0

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ Understanding VPLS Routing Instances on page 777

Example: Configuring Routing Options on the VPLS PE Router (CLI)

For each router involved in the VPLS, specify the router ID and autonomous system
(AS) number. In this sample, PE1 and PE2 use the same AS number (100).

To configure the router ID on the VPLS PE router:

user@host# set routing-options router-id 10.255.7.168

To configure the AS number on the VPLS PE router:

user@host# set routing-options autonomous-system 100

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

Example: Configuring MPLS on the VPLS PE Router (CLI)

Configure MPLS on the PE1 router to advertise the Layer 2 VPN interface that
communicates with the PE2 router.

CAUTION: MPLS is disabled by default on J Series and SRX Series devices. You must
explicitly configure your router to allow MPLS traffic. However, when MPLS is enabled,
all flow-based security features are deactivated and the router performs packet-based
processing. Flow-based services such as security policies, zones, NAT, ALGs, chassis
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clustering, screens, firewall authentication, and IPSec VPNs are unavailable on the
router.

To configure the interface to the PE2 router for MPLS:

user@host# set protocols mpls interface so-2/0/1.0

To configure the loopback for MPLS:

user@host# set protocols mpls interface lo0.0

To configure the path to destination 10.255.7.164:

user@host# set protocols mpls label-switched-path chelsea-sagar to 10.255.7.164

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

Example: Configuring RSVP on the VPLS PE Router (CLI)

Enable RSVP for all connections that participate in the label-switched path (LSP) on
the PE1 router.

To configure the interface to the PE2 router for RSVP:

user@host# set protocols rsvp interface so-2/0/1.0

To configure the loopback interface for RSVP:

user@host#set protocols rsvp interface lo0.0

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

Example: Configuring BGP on the VPLS PE Router (CLI)

You configure an internal BGP (IBGP) session between PE routers so that the routers
can exchange information about routes originating and terminating in the VPLS. The
PE routers use this information to determine which labels to use for traffic destined
for remote sites.

To configure the BGP internal group on the VPLS PE router:

user@host# set protocols bgp group ibgp type internal local-address 10.255.7.168
neighbor 10.255.7.164
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To configure the BGP family L2vpn and specify NLRI signaling:

user@host# set protocols bgp family l2vpn signaling

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

Example: Configuring OSPF on the VPLS PE Router (CLI)

The PE routers exchange routing information using an IGP such as OSPF.

To configure OSPF area 0.0.0.0 on the VPLS PE router:

user@host# set protocols ospf area 0.0.0.0 interface so-2/0/1.0
user@host# set protocols ospf area 0.0.0.0 interface lo0.0

To configure traffic engineering for OSPF:

user@host# set protocols ospf traffic-engineering

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ VPLS Overview on page 769

VPLS VLAN Encapsulation

■ Understanding VPLS VLAN Encapsulation on page 783

■ Example: Configuring VPLS VLAN Encapsulation on a Gigabit Ethernet Interface
(CLI) on page 784

■ Example: Configuring VPLS VLAN Encapsulation on an Aggregated Ethernet
Interface (CLI) on page 785

■ Configuring VPLS VLAN Encapsulation for a VLAN Circuit (CLI
Procedure) on page 785

■ Understanding VPLS VLAN Encapsulation on a Logical Interface on page 785

Understanding VPLS VLAN Encapsulation

Gigabit Ethernet IQ, Gigabit Ethernet PIMs with small form-factor pluggable optics
(SFPs), SRX Series devices with Gigabit Ethernet, J Series devices with Gigabit Ethernet,
Tri-Rate Ethernet copper, and 10-Gigabit Ethernet interfaces with VLAN tagging
enabled can use flexible Ethernet services, VLAN CCC, or VLAN virtual private LAN
service (VPLS) encapsulation.
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NOTE: VLAN encapsulation is not supported on SRX100 devices because there is no
Gigabit Ethernet port.

Aggregated Ethernet interfaces configured for VPLS can use Ethernet VPLS or VLAN
VPLS.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ Example: Configuring VPLS VLAN Encapsulation on a Gigabit Ethernet Interface
(CLI) on page 784

■ Example: Configuring VPLS VLAN Encapsulation on an Aggregated Ethernet
Interface (CLI) on page 785

■ Configuring VPLS VLAN Encapsulation for a VLAN Circuit (CLI Procedure) on
page 785

■ Understanding VPLS VLAN Encapsulation on a Logical Interface on page 785

■ VPLS Overview on page 769

Example: Configuring VPLS VLAN Encapsulation on a Gigabit Ethernet Interface (CLI)

To configure the encapsulation on a Gigabit Ethernet IQ or Gigabit Ethernet physical
interface, include the encapsulation statement at the [edit interfaces interface-name]
hierarchy level, specifying flexible-ethernet-services, vlan-ccc, or vlan-vpls:

[edit interfaces interface-name]
encapsulation (flexible-ethernet-services | vlan-ccc | vlan-vpls);

The following example shows VLAN CCC encapsulation configured on the Gigabit
Ethernet interface.

interfaces ge-2/1/0 {
vlan-tagging;
encapsulation vlan-ccc;
unit 0 {

encapsulation vlan-ccc;
vlan-id 600;

}
}

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ Understanding VPLS VLAN Encapsulation on page 783
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Example: Configuring VPLS VLAN Encapsulation on an Aggregated Ethernet Interface (CLI)

To configure the encapsulation on an aggregated Ethernet interface, include the
encapsulation statement at the [edit interfaces interface-name] hierarchy level,
specifying flexible-ethernet-services, ethernet-vpls, or vlan-vpls:

[edit interfaces interface-name]
encapsulation (flexible-ethernet-services | ethernet-vpls | vlan-vpls);

The following example shows VLAN CCC encapsulation configured on an aggregated
Gigabit Ethernet interface.

interfaces ae0 {
vlan-tagging;
encapsulation vlan-vpls;
unit 0 {

vlan-id 100;
}

}

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ Understanding VPLS VLAN Encapsulation on page 783

Configuring VPLS VLAN Encapsulation for a VLAN Circuit (CLI Procedure)

In general, you configure an interface’s encapsulation at the [edit interfaces
interface-name] hierarchy level. However, for some encapsulation types, including
flexible Ethernet services, Ethernet VLAN CCC and VLAN VPLS, you can also configure
the encapsulation type that is used inside the VLAN circuit itself. To do this, include
the encapsulation statement:

encapsulation (vlan-ccc | vlan-tcc | vlan-vpls);

You can include this statement at the [edit interfaces interface-name unit
logical-unit-number] hierarchy level.

Related Topics Junos OS Feature Support Reference for SRX Series and J Series Devices■

■ VPLS Configuration Overview on page 773

■ Understanding VPLS VLAN Encapsulation on page 783

Understanding VPLS VLAN Encapsulation on a Logical Interface

You cannot configure a logical interface with VLAN CCC or VLAN VPLS encapsulation
unless you also configure the physical device with the same encapsulation or with
flexible Ethernet services encapsulation. In general, the logical interface must have
a VLAN ID of 512 or higher; if the VLAN ID is 511 or lower, it will be subject to the
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normal destination filter lookups in addition to source address filtering. However if
you configure flexible Ethernet services encapsulation, this VLAN ID restriction is
removed.

Ethernet interfaces in VLAN mode can have multiple logical interfaces. In CCC and
VPLS modes, VLAN IDs from 1 through 511 are reserved for normal VLANs, and
VLAN IDs 512 through 4094 are reserved for CCC or VPLS VLANs. For 4-port Fast
Ethernet interfaces, you can use VLAN IDs 512 through 1024 for CCC or VPLS VLANs.

For encapsulation type flexible-ethernet-services, all VLAN IDs are valid.

Related Topics ■ Junos OS Feature Support Reference for SRX Series and J Series Devices

■ VPLS Configuration Overview on page 773

■ Understanding VPLS VLAN Encapsulation on page 783
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Part 6

Configuring Class of Service

■ Class of Service Overview on page 789

■ Configuring Class of Service on page 815

Configuring Class of Service ■ 787
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Chapter 32

Class of Service Overview

When a network experiences congestion and delay, some packets must be dropped.
JUNOS Software class of service (CoS) allows you to divide traffic into classes and
offer various levels of throughput and packet loss when congestion occurs. This allows
packet loss to happen according to the rules you configure.

For interfaces that carry IPv4, IPv6, or MPLS traffic, you can configure the JUNOS
Software CoS features to provide multiple classes of service for different applications.
On the device, you can configure multiple forwarding classes for transmitting packets,
define which packets are placed into each output queue, schedule the transmission
service level for each queue, and manage congestion using a random early detection
(RED) algorithm.

Traffic shaping is the allocation of the appropriate amount of network bandwidth to
every user and application on an interface. The appropriate amount of bandwidth
is defined as cost-effective carrying capacity at a guaranteed CoS. You can use a J
Series Services Router or an SRX Series Services Gateway to control traffic rate by
applying classifiers and shapers.

The CoS features provide a set of mechanisms that you can use to provide
differentiated services when best-effort delivery is insufficient.

Using JUNOS CoS features, you can assign service levels with different delay, jitter
(delay variation), and packet loss characteristics to particular applications served by
specific traffic flows. CoS is especially useful for networks supporting time-sensitive
video and audio applications. To configure CoS features on a device, see “Configuring
Class of Service” on page 815.

NOTE: Policing, scheduling, and shaping CoS services are not supported for
pre-encryption and post-encryption packets going into and coming out of an IPsec
VPN tunnel.

JUNOS Software supports the following RFCs for traffic classification and policing:

■ RFC 2474, Definition of the Differentiated Services Field in the IPv4 and IPv6

■ RFC 2475, An Architecture for Differentiated Services

■ RFC 2579, Assured Forwarding PHB Group

■ RFC 2598, An Expedited Forwarding PHB

■ 789



■ RFC 2697, A Single Rate Three Color Marker

■ RFC 2698, A Two Rate Three Color Marker

For more information about CoS, see the Junos Class of Service Configuration Guide.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ CoS Terms on page 790

■ Benefits of CoS on page 791

■ CoS Across the Network on page 792

■ JUNOS CoS Components on page 793

■ How CoS Components Work on page 801

■ Default CoS Settings on page 803

■ Transmission Scheduling on page 811

■ CoS Queuing for Tunnels on page 812

CoS Terms

Before configuring CoS, become familiar with the terms defined in Table 181 on
page 790.

Table 181: CoS Terms

DefinitionTerm

CoS packet forwarding class that provides a group of values you can define and includes four
subclasses, AF1, AF2, AF3, and AF4, each with three drop probabilities, low, medium, and high.

assured forwarding (AF)

Feature that can be used to determine the forwarding treatment for each packet. The behavior
aggregate classifier maps a code point to a forwarding class and loss priority. The loss priority
is used later in the work flow to select one of the two drop profiles used by random early detection
(RED).

behavior aggregate (BA)
classifier

CoS packet forwarding class that provides no service profile. For the BE forwarding class, loss
priority is typically not carried in a code point, and random early detection (RED) drop profiles
are more aggressive.

best effort (BE)

Method of classifying traffic on a packet-by-packet basis, using information in the type-of-service
(ToS) byte to assign traffic flows to different service levels.

class of service (CoS)

Services based on RFC 2474, Definition of the Differentiated Services Field (DS Field) in the IPv4
and IPv6 Headers. For IPv4, the DiffServ method of CoS uses the type-of-service (ToS) byte to
identify different packet flows on a packet-by-packet basis. For IPv6, DiffServ used the first six
bits of the 8-bit Traffic Class field of the IPv6 header.

DiffServ adds a Class Selector code point (CSCP) and a DiffServ code point (DSCP).

Differentiated Services
(DiffServ)
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Table 181: CoS Terms  (continued)

DefinitionTerm

Values for a 6-bit field defined in IP packet headers that can be used to enforce class-of-service
(CoS) distinctions.

DiffServ code point (DSCP)
values

Drop probabilities for different levels of buffer fullness that are used by random early detection
(RED) to determine when to drop packets from a given J Series or SRX Series device scheduling
queue.

drop profile

CoS packet forwarding class that provides end-to-end service with low loss, low latency, low
jitter, and assured bandwidth.

expedited forwarding (EF)

Firewall filter that scans through a variety of packet fields to determine the forwarding class and
loss priority for a packet and polices traffic to a specific bandwidth and burst size. Typically, a
classifier performs matching operations on the selected fields against a configured value.

multifield (MF) classifier

CoS packet forwarding class that is typically high priority because it supports protocol control.network control (NC)

Packet loss priority bit. Used to identify packets that have experienced congestion or are from
a transmission that exceeded a service provider's customer service license agreement. A J Series
or SRX Series device can use the PLP bit as part of a congestion control strategy. The bit can be
configured on an interface or in a filter.

PLP bit

Feature that limits the amount of traffic passing into or out of an interface. It is an essential
component of firewall filters that is designed to thwart denial-of-service (DoS) attacks. A policer
applies rate limits on bandwidth and burst size for traffic on a particular J Series device interface.

policer

Applying rate and burst size limits to traffic on an interface.policing

Gradual drop profile for a given class, used for congestion avoidance. RED attempts to anticipate
congestion and reacts by dropping a small percentage of packets from the tail of the queue to
prevent congestion.

random early detection
(RED)

Guide that the device follows when applying services. A rule consists of a match direction and
one or more terms.

rule

Benefits of CoS

IP routers normally forward packets independently, without controlling throughput
or delay. This type of packet forwarding, known as best-effort service, is as good as
your network equipment and links allow. Best-effort service is sufficient for many
traditional IP data delivery applications, such as e-mail or Web browsing. However,
newer IP applications such as real-time video and audio (or voice) require lower
delay, jitter, and packet loss than simple best-effort networks can provide.

CoS features allow a J Series or SRX Series device to improve its processing of critical
packets while maintaining best-effort traffic flows, even during periods of congestion.
Network throughput is determined by a combination of available bandwidth and
delay. CoS dedicates a guaranteed minimum bandwidth to a particular service class
by reducing forwarding queue delays. (The other two elements of overall network
delay, serial transmission delays determined by link speeds and propagation delays
determined by media type, are not affected by CoS settings.)
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Normally, packets are queued for output in their order of arrival, regardless of service
class. Queuing delays increase with network congestion and often result in lost
packets when queue buffers overflow. CoS packet classification assigns packets to
forwarding queues by service class.

Because CoS must be implemented consistently end-to-end through the network,
the CoS features on the Juniper Networks device are based on IETF Differentiated
Services (DiffServ) standards, to interoperate with other vendors’ CoS
implementations.

CoS Across the Network

CoS works by examining traffic entering at the edge of your network. The edge
devices classify traffic into defined service groups, which allow for the special
treatment of traffic across the network. For example, voice traffic can be sent across
certain links, and data traffic can use other links. In addition, the data traffic streams
can be serviced differently along the network path to ensure that higher-paying
customers receive better service. As the traffic leaves the network at the far edge,
you can reclassify the traffic.

To support CoS, you must configure each device in the network. Generally, each
device examines the packets that enter it to determine their CoS settings. These
settings then dictate which packets are first transmitted to the next downstream
device. In addition, the devices at the edges of your network might be required to
alter the CoS settings of the packets transmitting to the neighboring network.

Figure 91 on page 792 shows an example of CoS operating across an Internet Service
Provider (ISP) network.

Figure 91: CoS Across the Network

In the ISP network shown in Figure 91 on page 792, Device A is receiving traffic from
your network. As each packet enters, Device A examines the packet’s current CoS
settings and classifies the traffic into one of the groupings defined by the ISP. This
definition allows Device A to prioritize its resources for servicing the traffic streams
it is receiving. In addition, Device A might alter the CoS settings (forwarding class
and loss priority) of the packets to better match the ISP’s traffic groups. When
Device B receives the packets, it examines the CoS settings, determines the
appropriate traffic group, and processes the packet according to those settings.
Device B then transmits the packets to Device C, which performs the same actions.
Device D also examines the packets and determines the appropriate group. Because
it sits at the far end of the network, the ISP might decide once again to alter the CoS
settings of the packets before Device D transmits them to the neighboring network.
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JUNOS CoS Components

JUNOS Software supports CoS on J Series and SRX Series devices as indicated in the
following topics:

■ Code-Point Aliases on page 793

■ Classifiers on page 793

■ Forwarding Classes on page 796

■ Loss Priorities on page 796

■ Forwarding Policy Options on page 797

■ Transmission Queues on page 797

■ Schedulers on page 797

■ Virtual Channels on page 800

■ Policers for Traffic Classes on page 801

■ Rewrite Rules on page 801

Code-Point Aliases

A code-point alias assigns a name to a pattern of code-point bits. You can use this
name, instead of the bit pattern, when you configure other CoS components such
as classifiers, drop-profile maps, and rewrite rules.

Classifiers

Packet classification refers to the examination of an incoming packet. This function
associates the packet with a particular CoS servicing level. Two general types of
classifiers are supported—behavior aggregate (BA) classifiers and multifield (MF)
classifiers. When both BA and and MF classifications are performed on a packet, the
MF classification has higher precedence.

In JUNOS Software, classifiers associate incoming packets with a forwarding class
(FC) and packet loss priority (PLP) and, based on the associated forwarding class,
assign packets to output queues. FC and PLP associated with a packet specify the
behavior of a hop, within the system, to process the packet. The per hop behavior
(PHB) comprises packet forwarding, policing, scheduling, shaping, and marking. For
example, a hop can put a packet in one of the priority queues according to its FC
and then manage the queues by checking a packet's PLP. JUNOS Software supports
up to eight FCs and four PLPs.

Behavior Aggregate Classifiers

A behavior aggregate (BA) classifier operates on a packet as it enters the device.
Using behavior aggregate classifiers, the device aggregates different types of traffic
into a single forwarding class to receive the same forwarding treatment. The CoS
value in the packet header is the single field that determines the CoS settings applied
to the packet. Behavior aggregate classifiers allow you to set the forwarding class
and loss priority of a packet based on the Differentiated Services (DiffServ) code
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point (DSCP) value, DSCP IPv4 value, DSCP IPv6 value, IP precedence value, MPLS
EXP bits, or IEEE 802.1p value. The default classifier is based on the IP precedence
value. For more information, see “Default Behavior Aggregate Classifiers” on page 807.

JUNOS Software performs BA classification for a packet by examining its layer 2,
layer 3, and CoS-related parameters as shown in Table 182 on page 794.

Table 182: BA Classification

CoS ParameterLayer

IEEE 802.1p value: User PriorityLayer 2

IPv4 precedence

IPv4 Differentiated Services code point (DSCP) value

IPv6 DSCP value

Layer 3

NOTE: A BA classifier evaluates Layer 2 and Layer 3 parameters independently; the
results that generate from Layer 2 parameters override the results that generate from
the Layer 3 parameters.

Default IP Precedence Classifier

With JUNOS Software, all logical interface are automatically assigned a default IP
precedence classifier when the logical interface is configured. This default traffic
classifier maps IP precedence values to a forwarding class and packet loss priority
as shown in Table 183 on page 794. These mapping results take effect for an ingress
packet until it is further processed by another classification method.

Table 183: Default IP Precedence Classifier

Packet Loss PriorityForwarding ClassIP Precedence CoS Values

lowbest-effort000

highbest-effort001

lowbest-effort010

highbest-effort011

lowbest-effort100

highbest-effort101

lownetwork-control110

highnetwork-control111

794 ■ JUNOS CoS Components

JUNOS Software Interfaces and Routing Configuration Guide



Multifield Classifiers

A multifield (MF) classifier is a second method for classifying traffic flows. Unlike the
behavior aggregate classifier, a multifield classifier can examine multiple fields in
the packet—for example, the source and destination address of the packet or the
source and destination port numbers of the packet. With multifield classifiers, you
set the forwarding class and loss priority of a packet based on firewall filter rules.

NOTE: For a specified interface, you can configure both an MF classifier and a BA
classifier without conflicts. Because the classifiers are always applied in sequential
order, the BA classifier followed by the MF classifier, any BA classification result is
overridden by an MF classifier, if they conflict.

JUNOS Software performs MF traffic classification by directly scrutinizing multiple
fields of a packet to classify a packet without having to rely upon the output of the
previous BA traffic classification. JUNOS Software can simultaneously check a packet's
data ranging from layer 2 to layer 7 as shown in Table 184 on page 795

Table 184: MF Classification

CoS ParameterLayer

IEEE 802.1Q: VLAN ID

IEEE 802.1p: User Priority

Layer 2

IP Precedence value

DSCP or DSCP IPv6 value

Source IP address

Destination IP address

Protocol

ICMP: Code and type

Layer 3

TCP/UDP: Source port

TCP/UDP: Destination port

TCP: Flags

AH/ESP: SPI

Layer 4

Not supported for this release.Layer 7

Using JUNOS Software, you configure an MF classifier with a firewall filter and its
associated match conditions. This enables you to use any filter match criteria to
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locate packets that require classification. For more information on firewall filters and
policies, see the JUNOS Software Security Configuration Guide.

Forwarding Classes

Forwarding classes allow you to group packets for transmission. Based on forwarding
classes, you assign packets to output queues. The forwarding class plus the loss
priority define the per-hop behavior (PHB in DiffServ) of a packet. J Series Services
Routers and SRX Series Services Gateways support eight queues (0 through 7). For
a classifier to assign an output queue (default queues 0 through 3) to each packet, it
must associate the packet with one of the following forwarding classes:

■ Expedited forwarding (EF)—Provides a low loss, low latency, low jitter, assured
bandwidth, end-to-end service.

■ Assured forwarding (AF)—Provides a group of values you can define and includes
four subclasses: AF1, AF2, AF3, and AF4, each with three drop probabilities: low,
medium, and high.

■ Best effort (BE)—Provides no service profile. For the BE forwarding class, loss
priority is typically not carried in a class-of-service (CoS) value, and random early
detection (RED) drop profiles are more aggressive.

■ Network Control (NC)—This class is typically high priority because it supports
protocol control.

The SRX Series devices support eight queues.

NOTE: Queues 4 through 7 are not mapped to forwarding classes. To use queues 4
through 7, you must create custom forwarding class names and map them to the
queues. For more information, see “Forwarding Class Queue Assignments” on
page 806.

In addition to BA and MF classification, the forwarding class (FC) of a packet can be
directly determined by the logical interface that receives the packet. This FC of a
packet can be configured using CLI commands, and if configured, this FC overrides
the FC from any BA classification that was previously performed on the logical
interface.

The following CLI commands can assign a forwarding class directly to packets received
at a logical interface:

[edit class-of-service interfaces interface-name unit logical-unit-number]
forwarding-class class-name;

Loss Priorities

Loss priorities allow you to set the priority of dropping a packet. You can use the loss
priority setting to identify packets that have experienced congestion. Typically, you
mark packets exceeding some service level with a high loss priority—a greater
likelihood of being dropped. You set loss priority by configuring a classifier or a
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policer. The loss priority is used later in the work flow to select one of the drop profiles
used by random early detection (RED).

You can configure the packet loss priority (PLP) bit as part of a congestion control
strategy. The PLP bit can be configured on an interface or in a filter. A packet for
which the PLP bit is set has an increased probability of being dropped during
congestion.

Forwarding Policy Options

CoS-based forwarding (CBF) enables you to control next-hop selection based on a
packet’s class of service and, in particular, the value of the IP packet's precedence
bits. For example, you can specify a particular interface or next hop to carry
high-priority traffic while all best-effort traffic takes some other path. CBF allows path
selection based on class. When a routing protocol discovers equal-cost paths, it can
pick a path at random or load-balance across the paths through either hash selection
or round-robin selection.

Forwarding policy also allows you to create CoS classification overrides. You can
override the incoming CoS classification and assign the packets to a forwarding class
based on their input interface, input precedence bits, or destination address. When
you override the classification of incoming packets, any mappings you configured
for associated precedence bits or incoming interfaces to output transmission queues
are ignored.

Transmission Queues

After a packet is sent to the outgoing interface on a device, it is queued for
transmission on the physical media. The amount of time a packet is queued on the
device is determined by the availability of the outgoing physical media as well as the
amount of traffic using the interface.

J Series Services Routers and SRX Series Services Gateways support queues 0 through
7. If you configure more than eight queues on a device, the commit operation fails
and the device displays a detailed message stating the total number of queues
available.

Schedulers

An individual device interface has multiple queues assigned to store packets
temporarily before transmission. To determine the order to service the queues, the
device uses a round-robin scheduling method based on priority and the queue's
weighted round-robin (WRR) credits. JUNOS schedulers allow you to define the
priority, bandwidth, delay buffer size, rate control status, and RED drop profiles to
be applied to a particular queue for packet transmission. For more information, see
“Scheduler Settings” on page 807.

You can configure per-unit scheduling (also called logical interface scheduling). Per-unit
scheduling allows you to enable multiple output queues on a logical interface and
associate an output scheduler with each queue.
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Transmit Rate

The transmission rate determines the traffic transmission bandwidth for each
forwarding class you configure. The rate is specified in bits per second (bps). Each
queue is allocated some portion of the bandwidth of the outgoing interface.

This bandwidth amount can be a fixed value, such as 1 megabit per second (Mbps),
a percentage of the total available bandwidth, or the rest of the available bandwidth.
You can limit the transmission bandwidth to the exact value you configure, or allow
it to exceed the configured rate if additional bandwidth is available from other queues
(SRX3600, SRX3800, SRX5600, and SRX5800 devices do not support an exact value
transmit rate). This property helps ensure that each queue receives the amount of
bandwidth appropriate to its level of service.

The minimum transmit rate supported on high-speed interfaces is one-ten thousandth
of the speed of that interface. For example, on a Gigabit Ethernet interface with a
speed of 1000 Mbps, the minimum transmit rate is 100 Kbps (1000 Mbps x 1/10000).
You can configure transmit rates in the range 3200 bps through 160,000,000,000 bps.
When the configured rate is less than the minimum transmit rate, the minimum
transmit rate is used instead.

NOTE: Interfaces with slower interface speeds, like T1, E1, or channelized T1/E1/ISDN
PRI, cannot support minimum transmit rates because the minimum transmit rate
supported on a Services Router is 3200 bps.

Transmit rate assigns the weighted round-robin (WRR) priority values within a given
priority level and not between priorities. For more information, see “Transmission
Scheduling” on page 811.

Delay Buffer Size

You can configure the delay buffer size to control congestion at the output stage. A
delay buffer provides packet buffer space to absorb burst traffic up to a specified
duration of delay. When the buffer is full, all packets are dropped.

The system calculates the buffer size for a queue based on the buffer allocation
method you specify for it in the scheduler. See “Delay Buffer Size Allocation Methods”
on page 901 for different buffer allocation methods and “Specifying Delay Buffer Sizes
for Queues” on page 902 for buffer size calculations.

By default, all J Series device interfaces other than channelized T1/E1 interfaces
support a delay buffer time of 100,000 microseconds. On channelized T1/E1
interfaces, the default delay buffer time is 500,000 microseconds for clear-channel
interfaces, and 1,200,000 microseconds for NxDS0 interfaces.

On J Series devices, you can configure larger delay buffers on channelized T1/E1
interfaces. Larger delay buffers help these slower interfaces to avoid congestion and
packet dropping when they receive large bursts of traffic. For more information, see
“Configuring Large Delay Buffers with a Configuration Editor” on page 900.
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NOTE: For a J Series Services Router, if the buffer size percentage is set to zero for
T1 interfaces, traffic does not pass.

Scheduling Priority

Scheduling priority determines the order in which an output interface transmits traffic
from the queues, thus ensuring that queues containing important traffic are provided
better access to the outgoing interface.

The queues for an interface are divided into sets based on their priority. Each set
contains queues of the same priority. The device examines the sets in descending
order of priority. If at least one queue in a set has a packet to transmit, the device
selects that set. If multiple queues in the set have packets to transmit, the device
selects a queue from the set according to the weighted round-robin (WRR) algorithm
that operates within the set.

The packets in a queue are transmitted based on the configured scheduling priority,
the transmit rate, and the available bandwidth. For more information, see
“Transmission Scheduling” on page 811.

Shaping Rate

Shaping rates control the maximum rate of traffic transmitted on an interface. You
can configure the shaping rate so that the interface transmits less traffic than it is
physically capable of carrying.

You can configure shaping rates on logical interfaces. By default, output scheduling
is not enabled on logical interfaces. Logical interface scheduling (also called per-unit
scheduling) allows you to enable multiple output queues on a logical interface and
associate an output scheduler and shaping rate with the queues.

By default, the logical interface bandwidth is the average of unused bandwidth for
the number of logical interfaces that require default bandwidth treatment. You can
specify a peak bandwidth rate in bits per second (bps), either as a complete decimal
number or as a decimal number followed by the abbreviation k (1000), m (1,000,000),
or g (1,000,000,000). The range is from 1000 through 32,000,000,000 bps.

For low-speed interfaces, the queue-limit values might become lower than the interface
MTU so that traffic with large packets can no longer pass through some of the queues.
If you want larger-sized packets to flow through, set the buffer-size configuration in
the scheduler to a larger value. For more accuracy, the 100-ms queue-limit values
are calculated based on shaper rates and not on interface rates.

RED Drop Profiles

A drop profile is a feature of the random early detection (RED) process that allows
packets to be dropped before queues are full. Drop profiles are composed of two
main values—the queue fullness and the drop probability. The queue fullness
represents percentage of memory used to store packets in relation to the total amount
that has been allocated for that queue. The drop probability is a percentage value
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that correlates to the likelihood that an individual packet is dropped from the network.
These two variables are combined in a graph-like format.

When a packet reaches the head of the queue, a random number between 0 and
100 is calculated by the device. This random number is plotted against the drop
profile having the current queue fullness of that particular queue. When the random
number falls above the graph line, the packet is transmitted onto the physical media.
When the number falls below the graph line, the packet is dropped from the network.

When you configure the RED drop profile on an interface, the queue no longer drops
packets from the tail of the queue (the default). Rather, packets are dropped after
they reach the head of the queue.

You specify drop probabilities in the drop profile section of the class-of-service (CoS)
configuration hierarchy and reference them in each scheduler configuration. For
each scheduler, you can configure multiple separate drop profiles, one for each
combination of loss priority (low, medium-low, medium-high, or high) and IP transport
protocol (TCP or non-TCP or any).

NOTE: For J Series devices and SRX210, SRX240, and SRX650 devices, tcp and
non-tcp values are not supported, only the value “any” is supported.

You can configure a maximum of 32 different drop profiles.

To configure RED drop profiles, include the following statements at the [edit
class-of-service] hierarchy level of the configuration:

[edit class-of-service]
drop-profiles {

profile-name {
fill-level percentage drop-probability percentage;
interpolate {

drop-probability [ values ];
fill-level [ values ];

}
}

}

Default Drop Profiles

By default, if you configure no drop profiles, RED is still in effect and functions as
the primary mechanism for managing congestion. In the default RED drop profile,
when the fill level is 0 percent, the drop probability is 0 percent. When the fill level
is 100 percent, the drop probability is 100 percent.

Virtual Channels

On J Series devices, you can configure virtual channels to limit traffic sent from a
corporate headquarters to branch offices. Virtual channels might be required when
the headquarters site has an expected aggregate bandwidth higher than that of the
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individual branch offices. The router at the headquarters site must limit the traffic
sent to each branch office router to avoid oversubscribing their links.

You configure virtual channels on a logical interface. Each virtual channel has a set
of eight queues with a scheduler and an optional shaper. You can use an output
firewall filter to direct traffic to a particular virtual channel. For example, a filter can
direct all traffic with a destination address for branch office 1 to virtual channel 1,
and all traffic with a destination address for branch office 2 to virtual channel 2.

Although a virtual channel group is assigned to a logical interface, a virtual channel
is not the same as a logical interface. The only features supported on a virtual channel
are queuing, packet scheduling, and accounting. Rewrite rules and routing protocols
apply to the entire logical interface.

Policers for Traffic Classes

Policers allow you to limit traffic of a certain class to a specified bandwidth and burst
size. Packets exceeding the policer limits can be discarded, or can be assigned to a
different forwarding class, a different loss priority, or both. You define policers with
firewall filters that can be associated with input or output interfaces.

Rewrite Rules

A rewrite rule modifies the appropriate CoS bits in an outgoing packet. Modification
of CoS bits allows the next downstream device to classify the packet into the
appropriate service group. Rewriting or marking outbound packets is useful when
the device is at the border of a network and must alter the CoS values to meet the
policies of the targeted peer.

How CoS Components Work

On J Series and SRX Series devices, you configure CoS functions using different
components. These components are configured individually or in a combination to
define particular CoS services. Figure 92 on page 802 displays the relationship of
different CoS components to each other and illustrates the sequence in which they
interact. “JUNOS CoS Components” on page 793 defines the components and explains
their use.
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Figure 92: Packet Flow Through J Series or SRX Series Device

Each box in Figure 92 on page 802 represents a CoS component. The solid lines show
the direction of packet flow in a device. The upper row indicates an incoming packet,
and the lower row an outgoing packet. The dotted lines show the inputs and outputs
of particular CoS components. For example, the forwarding class and loss priority
are outputs of behavior aggregate classifiers and multifield classifiers and inputs for
rewrite markers and schedulers.

Typically, only a combination of some components shown in Figure 92 on page 802
(not all) is used to define a CoS service offering. For example, if a packet's class is
determined by a behavior aggregate classifier, it is associated with a forwarding class
and loss priority and does not need further classification by the multifield classifier.

CoS Process on Incoming Packets

Classifiers and policers perform the following operations on incoming packets:

1. A classifier examines an incoming packet and assigns a forwarding class and
loss priority to it.

2. Based on the forwarding class, the packet is assigned to an outbound transmission
queue.

3. Input policers meter traffic to see if traffic flow exceeds its service level. Policers
might discard, change the forwarding class and loss priority, or set the PLP bit
of a packet. A packet for which the PLP bit is set has an increased probability of
being dropped during congestion.
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CoS Process on Outgoing Packets

The scheduler map and rewrite rules perform the following operations on outgoing
packets:

1. Scheduler maps are applied to interfaces and associate the outgoing packets with
a scheduler and a forwarding class.

2. The scheduler defines how the packet is treated in the output transmission queue
based on the configured transmit rate, buffer size, priority, and drop profile.

■ The buffer size defines the period for which the packet is stored during
congestion.

■ The scheduling priority and transmit rate determine the order in which the
packet is transmitted.

■ The drop profile defines how aggressively to drop packets that are using a
particular scheduler.

3. Output policers meter traffic and might change the forwarding class and loss
priority of a packet if a traffic flow exceeds its service level.

4. The rewrite rule writes information to the packet (for example, EXP or DSCP
bits) according to the forwarding class and loss priority of the packet.

Default CoS Settings

Even when you do not configure any CoS settings on your routing platform, the
software performs some CoS functions to ensure that user traffic and protocol packets
are forwarded with minimum delay when the network is experiencing congestion.
Some default mappings are automatically applied to each logical interface that you
configure. Other default mappings, such as explicit default classifiers and rewrite
rules, are in operation only if you explicitly associate them with an interface.

You can display default CoS settings by running the show class-of-service operational
mode command.

This section contains the following topics:

■ Default CoS Values and Aliases on page 804

■ Forwarding Class Queue Assignments on page 806

■ Scheduler Settings on page 807

■ Default Behavior Aggregate Classifiers on page 807

■ CoS Value Rewrites on page 810

■ Sample Behavior Aggregate Classification on page 810
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Default CoS Values and Aliases

Table 185 on page 804 shows the default mappings between the bit values and
standard aliases.

Table 185: Well-Known CoS Aliases and Default CoS Values

CoS ValueAliasCoS Value Type

101110efDSCP and DSCP IPv6

001010af11

001100af12

001110af13

010010af21

010100af22

010110af23

011010af31

011100af32

011110af33

100010af41

100100af42

100110af43

000000be

001000cs1

010000cs2

011000cs3

100000cs4

101000cs5

110000nc1/cs6

111000nc2/cs7
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Table 185: Well-Known CoS Aliases and Default CoS Values (continued)

CoS ValueAliasCoS Value Type

000beMPLS EXP

001be1

010ef

011ef1

100af11

101af12

110nc1/cs6

111nc2/cs7

000beIEEE 802.1

001be1

010ef

011ef1

100af11

101af12

110nc1/cs6

111nc2/cs7

000beIP precedence

001be1

010ef

011ef1

100af11

101af12

110nc1/cs6

111nc2/cs7
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Forwarding Class Queue Assignments

J Series and SRX Series devices have eight queues built into the hardware. By default,
four queues are assigned to four forwarding classes. Table 186 on page 806 shows
the four default forwarding classes and queues that Juniper Networks classifiers assign
to packets based on the CoS values in arriving packet headers. Queues 4 through 7
have no default assignments to forwarding classes. To use queues 4 through 7, you
must create custom forwarding class names and assign them to the queues. For
more information about how to assign queues to forwarding classes, see “Configuring
Class of Service” on page 815.

By default, all incoming packets, except the IP protocol control packets, are assigned
to the forwarding class associated with queue 0. All IP protocol control packets are
assigned to the forwarding class associated with queue 3.

Table 186 on page 806 displays the default assignments of forwarding classes to
queues.

Table 186: Default Forwarding Class Queue Assignments

Forwarding Class DescriptionForwarding ClassForwarding Queue

The Juniper Networks device does not apply any special CoS
handling to packets with 000000 in the DiffServ field, a
backward compatibility feature. These packets are usually
dropped under congested network conditions.

best-effort (BE)Queue 0

The Juniper Networks device delivers assured bandwidth, low
loss, low delay, and low delay variation (jitter) end-to-end for
packets in this service class.

Devices accept excess traffic in this class, but in contrast to
assured forwarding, out-of-profile expedited-forwarding
packets can be forwarded out of sequence or dropped.

expedited-forwarding (EF)Queue 1

The Juniper Networks device offers a high level of assurance
that the packets are delivered as long as the packet flow from
the customer stays within a certain service profile that you
define.

The device accepts excess traffic, but applies a random early
detection (RED) drop profile to determine whether the excess
packets are dropped and not forwarded.

Three drop probabilities (low, medium, and high) are defined
for this service class.

assured-forwarding (AF)Queue 2

The Juniper Networks device delivers packets in this service
class with a low priority. (These packets are not delay
sensitive.)

Typically, these packets represent routing protocol hello or
keepalive messages. Because loss of these packets jeopardizes
proper network operation, delay is preferable to discard.

network-control (NC)Queue 3

806 ■ Default CoS Settings

JUNOS Software Interfaces and Routing Configuration Guide



Scheduler Settings

Each forwarding class has an associated scheduler priority. Only two forwarding
classes, best-effort and network-control (queue 0 and queue 3), are used in the JUNOS
default scheduler configuration.

By default, the best-effort forwarding class (queue 0) receives 95 percent, and the
network-control (queue 3) receives 5 percent of the bandwidth and buffer space for
the output link. The default drop profile causes the buffer to fill and then discard all
packets until it again has space.

The expedited-forwarding and assured-forwarding classes have no schedulers, because
by default no resources are assigned to queue 1 and queue 2. However, you can
manually configure resources for expedited-forwarding and assured-forwarding.

By default, each queue can exceed the assigned bandwidth if additional bandwidth
is available from other queues. When a forwarding class does not fully use the
allocated transmission bandwidth, the remaining bandwidth can be used by other
forwarding classes if they receive a larger amount of offered load than the bandwidth
allocated. If you do not want a queue to use any leftover bandwidth, you must
configure it for strict allocation. For more information, see “Configuring Strict High
Priority for Queuing with a Configuration Editor” on page 893.

The device uses the following default scheduler settings. You can modify these settings
through configuration. For instructions, see “Configuring Class of Service” on page 815.

[edit class-of-service]
schedulers {

network-control {
transmit-rate percent 5;
buffer-size percent 5;
priority low;
drop-profile-map loss-priority any protocol any drop-profile terminal;

}
best-effort {

transmit-rate percent 95;
buffer-size percent 95;
priority low;
drop-profile-map loss-priority any protocol any drop-profile terminal;

}
}
drop-profiles {

terminal {
fill-level 100 drop-probability 100;

}
}

Default Behavior Aggregate Classifiers

Table 187 on page 808 shows the forwarding class and packet loss priority (PLP) that
are assigned by default to each well-known DSCP. Although several DSCPs map to
the expedited-forwarding (ef) and assured-forwarding (af) classes, by default no resources
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are assigned to these forwarding classes. All af classes other than af1x are mapped
to best-effort, because RFC 2597, Assured Forwarding PHB Group, prohibits a node
from aggregating classes. Assignment to best-effort implies that the node does not
support that class.

You can modify the default settings through configuration. For instructions, see
“Configuring Class of Service” on page 815.

Table 187: Default Behavior Aggregate Classification

Packet Loss Priority (PLP)Forwarding ClassDSCP and DSCP IPv6 Alias

lowexpedited-forwardingef

lowassured-forwardingaf11

highassured-forwardingaf12

highassured-forwardingaf13

lowbest-effortaf21

lowbest-effortaf22

lowbest-effortaf23

lowbest-effortaf31

lowbest-effortaf32

lowbest-effortaf33

lowbest-effortaf41

lowbest-effortaf42

lowbest-effortaf43

lowbest-effortbe

lowbest-effortcs1

lowbest-effortcs2

lowbest-effortcs3

lowbest-effortcs4

lowbest-effortcs5

lownetwork-controlnc1/cs6

lownetwork-controlnc2/cs7

lowbest-effortother
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Defining BA Classifiers

You can override the default IP precedence classifier by defining a classifier and
applying it to a logical interface. To define new classifiers for all code point types,
include the classifiers statement at the [edit class-of-service] hierarchy level:

[edit class-of-service]
classifiers {

(dscp | dscp-ipv6 | exp | ieee-802.1 | inet-precedence) classifier-name {
import [classifier-name | default];
forwarding-class class-name {

loss-priority level {
code-points [ aliases ] [ 6-bit-patterns ];

}
}

}
}

The map sets the forwarding class and PLP for a specific set of code-point aliases
and bit patterns. The inputs of the map are code-point aliases and bit patterns. The
outputs of the map are the forwarding class and the PLP.

The classifiers work as follows:

■ dscp—Handles incoming IPv4 packets.

■ dscp-ipv6—Handles incoming IPv6 packets.

■ exp—Handles MPLS packets using Layer 2 headers.

■ ieee-802.1—Handles Layer 2 CoS.

■ inet-precedence—Handles incoming IPv4 packets. IP precedence mapping requires
only the upper three bits of the DSCP field.

A classifier takes a specified bit pattern as either the literal pattern or as a defined
alias and attempts to match it to the type of packet arriving on the interface. If the
information in the packet’s header matches the specified pattern, the packet is sent
to the appropriate queue, defined by the forwarding class associated with the classifier.

The code-point aliases and bit patterns are the input for the map. The loss priority
and forwarding class are outputs of the map. In other words, the map sets the PLP
and forwarding class for a given set of code-point aliases and bit patterns.

Applying a BA Classifier to a Logical Interface

You can apply the classification map to a logical interface by including the classifiers
statement at the [edit class-of-service interfaces interface-name unit logical-unit-number]
hierarchy level:

[edit class-of-service interfaces interface-name interface-name unit logical-unit-number]
classifiers (dscp | dscp-ipv6 | exp | ieee-802.1 | inet-precedence) (classifier-name |

default);
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You can use interface wildcards for interface-name and logical-unit-number.

CoS Value Rewrites

Typically, a device rewrites CoS values in outgoing packets on the outbound interfaces
of an edge device, to meet the policies of the targeted peer. After reading the current
forwarding class and loss priority information associated with the packet, the
transmitting device locates the chosen CoS value from a table, and writes this CoS
value into the packet header.

For instructions for configuring rewrite rules, see “Configuring and Applying Rewrite
Rules” on page 845.

Sample Behavior Aggregate Classification

Table 188 on page 810 shows the device forwarding classes associated with each
well-known DSCP code point and the resources assigned to their output queues for
a sample DiffServ CoS implementation. This example assigns expedited forwarding
to queue 1 and a subset of the assured forwarding classes (af1x) to queue 2, and
distributes resources among all four forwarding classes.

Other DiffServ-based implementations are possible. For configuration information,
see “Configuring Class of Service” on page 815.

Table 188: Sample Behavior Aggregate Classification Forwarding Classes and Queues

QueuePLPForwarding ClassDSCP and DSCP IPv6 Bits
DSCP and DSCP IPv6
Alias

1lowexpedited-forwarding101110ef

2lowassured-forwarding001010af11

2highassured-forwarding001100af12

2highassured-forwarding001110af13

0lowbest-effort010010af21

0lowbest-effort010100af22

0lowbest-effort010110af23

0lowbest-effort011010af31

0lowbest-effort011100af32

0lowbest-effort011110af33

0lowbest-effort100010af41

0lowbest-effort100100af42

0lowbest-effort100110af43
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Table 188: Sample Behavior Aggregate Classification Forwarding Classes and Queues (continued)

QueuePLPForwarding ClassDSCP and DSCP IPv6 Bits
DSCP and DSCP IPv6
Alias

0lowbest-effort000000be

0lowbest-effort0010000cs1

0lowbest-effort010000cs2

0lowbest-effort011000cs3

0lowbest-effort100000cs4

0lowbest-effort101000cs5

3lownetwork-control110000nc1/cs6

3lownetwork-control111000nc2/cs7

0lowbest-effort—other

Transmission Scheduling

The packets in a queue are transmitted based on their transmission priority, transmit
rate, and the available bandwidth.

By default, each queue can exceed the assigned bandwidth if additional bandwidth
is available from other queues. When a forwarding class does not fully use the
allocated transmission bandwidth, the remaining bandwidth can be used by other
forwarding classes if they receive a larger amount of offered load than the bandwidth
allocated. A queue receiving traffic within its bandwidth configuration is considered
to have positive bandwidth credit, and a queue receiving traffic in excess of its
bandwidth allocation is considered to have negative bandwidth credit.

A queue with positive credit does not need to use leftover bandwidth, because it can
use its own allocation. For such queues, packets are transmitted based on the priority
of the queue, with packets from higher-priority queues transmitting first. The transmit
rate is not considered during transmission. In contrast, a queue with negative credit
needs a share of the available leftover bandwidth.

The leftover bandwidth is allocated to queues with negative credit in proportion to
the configured transmit rate of the queues within a given priority set. The queues
for an interface are divided into sets based on their priority. For more information,
see “Scheduling Priority” on page 799. If no transmit rate is configured, each queue
in the set receives an equal percentage of the leftover bandwidth. However, if a
transmit rate is configured, each queue in the set receives the configured percentage
of the leftover bandwidth.

Table 189 on page 812 shows a sample configuration of priority and transmit rate on
six queues. The total available bandwidth on the interface is 100 Mbps.
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Table 189: Sample Transmission Scheduling

Incoming TrafficTransmit RateScheduling PriorityQueue

20 Mbps10%Low0

20 Mbps20%High1

20 Mbps30%High2

20 Mbps30%Low3

10 MbpsNo transmit rate configuredMedium-high4

20 MbpsNo transmit rate configuredMedium-high5

In this example, queues are divided into three sets based on their priority:

■ High priority set—Consists of queue 1 and queue 2. Packets use 40 Mbps (20+20)
of the available bandwidth (100 Mbps) and are transmitted first. Because of
positive credit, the configured transmit rate is not considered.

■ Medium-high priority set—Consists of queue 4 and queue 5. Packets use 30 Mbps
(10+20) of the remaining 60 Mbps bandwidth. Because of positive credit, the
transmit rate is not considered. If the queues had negative credit, they would
receive an equal share of the leftover bandwidth because no transmit rate is
configured.

■ Low priority set—Consists of queue 0 and queue 3. Packets share the 20 Mbps
of leftover bandwidth based on the configured transmit rate. The distribution of
bandwidth is in proportion to the assigned percentages. Because the total assigned
percentage is 40 (10 + 30), each queue receives a share of bandwidth
accordingly. Thus queue 0 receives 5 Mbps (10/40 x 20), and queue 3 receives
15 Mbps (30/40 x 20).

CoS Queuing for Tunnels

A tunnel interface in a J Series device running JUNOS Software supports many of the
same CoS features as a physical interface. A tunnel interface is a virtual or logical
interface on a J Series device. It creates a virtual point-to-point link between two J
Series devices at remote points over an IP network.

For example, you can configure CoS features for generic routing encapsulation (GRE)
and IP-IP tunnel interfaces. Tunneling protocols encapsulate packets inside a transport
protocol.

GRE or IP-IP tunnels are used with services like IPsec and NAT to set up point-to-point
VPNs. JUNOS Software allows you to enable CoS queuing, scheduling, and shaping
for traffic exiting through these tunnel interfaces. For an example of configuring CoS
Queuing for GRE tunnels, see “Example: Configuring CoS for GRE/IPIP tunnels” on
page 888.
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Benefits of CoS Queuing on Tunnel Interfaces

On a J Series device, CoS queuing enabled for tunnel interfaces allows you to

■ Segregate tunnel traffic.

Each tunnel can be shaped so that a tunnel with low-priority traffic cannot swamp
other tunnels that carry high-priority traffic.

Traffic for one tunnel does not impact traffic on other tunnels.

■ Control tunnel bandwidth.

Traffic through various tunnels is limited to not exceed a certain bandwidth.

For example, suppose you have three tunnels to three remote sites through a
single WAN interface. You can select CoS parameters for each tunnel such that
traffic to some sites gets more bandwidth than traffic to other sites.

■ Customize CoS policies.

You can apply different queuing, scheduling, and shaping policies to different
tunnels based on user requirements. Each tunnel can be configured with different
scheduler maps, different queue depths, and so on. Customization allows you
to configure granular CoS policy providing for better control over tunnel traffic.

■ Prioritize traffic before it enters a tunnel.

For example, CoS queuing avoids having low-priority packets scheduled ahead
of high-priority packets when the interface speed is higher than the tunnel traffic
speed. This feature is most useful when combined with IPsec. Typically, IPsec
processes packets in a FIFO manner. However, with CoS queuing each tunnel
can prioritize high-priority packets over low-priority packets. Also, each tunnel
can be shaped, so that a tunnel with low-priority traffic does not swamp tunnels
carrying high-priority traffic.

How CoS Queuing Works

Figure 93 on page 814 shows CoS-related processing that occurs for traffic entering
and exiting a tunnel. For information on flow-based packet processing, see the Junos
OS Security Configuration Guide
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Figure 93: CoS Processing for Tunnel Traffic

Limitations on CoS Shapers for Tunnel Interfaces

On a J Series device, when defining a CoS shaping rate on a tunnel interface, be
aware of the following restrictions:

■ The shaping rate on the tunnel interface must be less than that of the physical
egress interface.

■ The shaping rate only measures the packet size that includes the Layer 3 packet
with GRE or IP-IP encapsulation. The Layer 2 encapsulation added by the physical
interface is not factored into the shaping rate measurement.

■ The CoS behavior works as expected only when the physical interface carries
the shaped GRE or IP-IP tunnel traffic alone. If physical interface carries other
traffic, thereby lowering the available bandwidth for tunnel interface traffic, the
CoS features do not work as expected.

■ You cannot configure a logical interface shaper and a virtual circuit shaper
simultaneously on the router. If virtual circuit shaping is desired, do not define
a logical interface shaper. Instead, define a shaping rate for all the virtual circuits.
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Chapter 33

Configuring Class of Service

You configure class of service (CoS) when you need to override the default packet
forwarding behavior of a J Series or SRX Series device—especially in the three areas
identified in Table 190 on page 815.

Table 190: Reasons to Configure Class of Service (Cos)

CoS Configuration AreaDefault Behavior to Override with CoS

ClassifiersPacket classification—By default, the J Series or SRX Series
device does not use behavior aggregate (BA) classifiers to
classify packets. Packet classification applies to incoming
traffic.

SchedulersScheduling queues—By default, the J Series or SRX Series
device has only two queues enabled. Scheduling queues apply
to outgoing traffic.

Rewrite rulesPacket headers—By default, the J Series or SRX Series device
does not rewrite CoS bits in packet headers. Rewriting packet
headers applies to outgoing traffic.

You can use either J-Web Quick Configuration or a configuration editor to configure
CoS. This chapter contains the following topics. For more information about CoS,
see the Junos Class of Service Configuration Guide.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Before You Begin on page 816

■ Configuring CoS (J-Web Procedure) on page 816

■ Configuring CoS Components with a Configuration Editor on page 833

■ Configuring Virtual Channels on page 869

■ Configuring Adaptive Shaping for Frame Relay on page 875

■ Classifying Frame Relay Traffic on page 876

■ Rewriting Frame Relay Headers on page 878

■ Configuring Strict-High Priority on page 879
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■ Configuring CoS for Tunnels on page 884

■ Configuring Strict High Priority for Queuing with a Configuration
Editor on page 893

■ Configuring Large Delay Buffers with a Configuration Editor on page 900

■ Applying an Ingress Interface Policer on page 906

■ Configuring Simple Filters and Policers on page 907

■ Configuring CoS Hierarchical Schedulers on page 910

■ Verifying a CoS Configuration on page 941

■ Configuring Class of Service for IPv6 Traffic on page 947

Before You Begin

Before you begin configuring a J Series or SRX Series device for CoS, complete the
following tasks:

■ If you do not already have a basic understanding of CoS, read “Class of Service
Overview” on page 789.

■ Determine whether the device needs to support different traffic streams, such
as voice or video. If so, CoS helps to make sure this traffic receives more than
basic best-effort packet delivery service.

■ Determine whether the device is directly attached to any applications that send
CoS-classified packets. If no sources are enabled for CoS, you must configure
and apply rewrite rules on the interfaces facing the sources.

■ Determine whether the device must support assured forwarding (AF) classes.
Assured forwarding usually requires random early detection (RED) drop profiles
to be configured and applied.

■ Determine whether the device must support expedited forwarding (EF) classes
with a policer. Policers require you to apply a burst size and bandwidth limit to
the traffic flow, and set a consequence for packets that exceed these
limits—usually a high loss priority, so that packets exceeding the policer limits
are discarded first.

Configuring CoS (J-Web Procedure)

The Class of Service menu allows you to configure most of the JUNOS CoS components
for the IPv4 and MPLS traffic on a J Series or an SRX Series device. You can configure
forwarding classes for transmitting packets, define which packets are placed into
each output queue, schedule the transmission service level for each queue, and
manage congestion using a random early detection (RED) algorithm. After defining
the CoS components, you must assign classifiers to the required physical and logical
interfaces.

This section contains the following topics:

■ Defining CoS Value Aliases on page 817

■ Defining Forwarding Classes on page 819
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■ Defining Classifiers on page 820

■ Defining Rewrite Rules on page 822

■ Defining Schedulers on page 824

■ Defining Scheduler Maps on page 827

■ Defining Drop Profiles on page 828

■ Defining Virtual Channel Groups on page 829

■ Assigning CoS Components to Interfaces on page 831

Defining CoS Value Aliases

A code-point alias assigns a name to a pattern of code-point bits. You can use this
name, instead of the bit pattern, when you configure other CoS components such
as classifiers, drop-profile maps, and rewrite rules. For more information about code
point aliases, see “Code-Point Aliases” on page 793.

To define CoS value aliases using the J-Web configuration editor:

1. Select Configure>Class of Service>Value Aliases. The Code Point Alias
Configuration summary page appears.

2. Fill in the options as shown in Table 191 on page 817.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 191: CoS Value Aliases Configuration Options

ActionFunctionField

Code Point Alias Summary

NoneDisplays the name given to CoS values—for
example, af11 or be.

Alias name
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Table 191: CoS Value Aliases Configuration Options (continued)

ActionFunctionField

NoneDisplays the code point type. The following type
of code points are supported:

■ DSCP—Defines aliases for DiffServ code
point (DSCP) IPv4 values.

You can refer to these aliases when you
configure classes and define classifiers.

■ DSCP-IPv6—Defines aliases for DSCP IPv6
values.

You can refer to these aliases when you
configure classes and define classifiers.

■ EXP—Defines aliases for MPLS experimental
(EXP) bits.

You can map MPLS EXP bits to the device
forwarding classes.

■ inet-precedence—Defines aliases for IPv4
precedence values.

Precedence values are modified in the IPv4
type-of-service (TOS) field and mapped to
values that correspond to levels of service.

Alias type

NoneDisplays the CoS value for which an alias is
defined.

Changing this value alters the behavior of all
classifiers that refer to this alias.

CoS value bits

Click Add to create a new code point alias.Opens a page that allows you to create a new
code point alias.

Add

To edit an existing code point alias, select the
alias in the summary page, and click Edit.

Opens a page that allows you to edit a selected
code point alias.

Edit

To delete an existing code point alias, select the
alias and click Delete.

Deletes a specified code point alias.Delete

Add Code Point Alias/Edit Code Point Alias

Specify a name for the CoS point alias.

NOTE: If you create a new alias with the same
name that is available in the default list, then the
default alias name is overwritten with the
user-configured name.

Name given to CoS values—for example, af11 or
be.

Code point name

Select the alias value you want to configure:
DSCP, DSCP-IPv6, EXP, or inet-precedence.

Code point type: DSCP, DSCP-IPv6, EXP, or
inet-precedence

Code point type
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Table 191: CoS Value Aliases Configuration Options (continued)

ActionFunctionField

To specify a CoS value, type it in an appropriate
format:

■ For DSCP and DSCP IPv6 CoS values, use
the format xxxxxx, where x is 1 or 0—for
example, 101110.

■ For MPLS EXP and IP precedence CoS
values, use the format xxx, where x is 1 or
0—for example, 111.

Specifies a CoS value for which an alias is
defined.

Code point value bits

Defining Forwarding Classes

By assigning a forwarding class to a queue number, you affect the scheduling and
marking of a packet as it transits a J Series or an SRX Series device. For more
information about forwarding classes and queues, see the “Forwarding Classes” on
page 796 and “Transmission Queues” on page 797.

To define forwarding classes using the J-Web configuration editor:

1. Select Configure>Class of Service>Forwarding Classes.

The Forwarding Class Configuration summary page appears.

2. Fill in the options as shown in Table 192 on page 819.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 192: Forwarding Classes Configuration Options

ActionFunctionField

Forwarding Classes Summary

NoneDisplays the forwarding class name assigned to
the internal queue number.

By default, four forwarding classes are assigned
to queue numbers 0 (best-effort), 1
(assured-forwarding), 5 (expedited-forwarding),
and 7 (network-connect).

Forwarding class name
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Table 192: Forwarding Classes Configuration Options (continued)

ActionFunctionField

NoneDisplays internal queue numbers to which
forwarding classes are assigned. By assigning a
forwarding class to a queue number, you affect
the scheduling and marking of a packet as it
transits a J Series or an SRX Series device.

By default, if a packet is not classified, it is
assigned to the class associated with queue 0.
You can have more than one forwarding class to
a queue number.

Queue number

NoneDisplays the queue characteristics, for example,
video or voice.

Queue characteristics

Click Add to create a new forwarding class.Opens a page that allows you to create a new
forwarding class.

Add

To edit a forwarding class, select a forwarding
class in the summary page, and click Edit.

Opens a page that allows you to edit a selected
forwarding class.

Edit

To delete a forwarding class, select the
forwarding class and click Delete.

Deletes a specified forwarding class.Delete

Add Forwarding Class/Edit Forwarding Class

To specify an internal queue number, type an
integer from 0 through 7, as supported by your
device.

NOTE: If you create a new forwarding class that
overrides the default queue number, the default
forwarding class is deleted after a commit.

Specifies the internal queue number to which a
forwarding class is assigned.

Queue number

To assign a forwarding class name to a queue,
type the name—for example, be-class.

Specifies the forwarding class name assigned to
the internal queue number.

Forwarding class name

Defining Classifiers

Classifiers examine the CoS value or alias of an incoming packet and assign it a level
of service by setting its forwarding class and loss priority. For more information
about classifiers, see the “Classifiers” on page 793.

To define classifiers using the J-Web configuration editor:

1. Select Configure>Class of Service>Classifiers.

The Classifier Configuration summary page appears.

2. Fill in the options as shown in Table 193 on page 821.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.
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■ To cancel your entries and return to the main page, click Cancel.

Table 193: Classifiers Configuration Options

ActionFunctionField

Classifier Configuration Summary

NoneDisplays the names of classifiers.Classifier name

NoneDisplays the classifier type. The following type of
classifiers are supported:

■ J Series (J6350), SRX650:

■ dscp-default

■ dscp-ipv6-default

■ dscp-ipv6-compatibility

■ exp-default

■ ieee8021p-default

■ ipprec-default

■ ipprec-compatibility

■ ieee8021ad-default

■ SRX210, SRX240:

■ dscp-default

■ dscp-ipv6-default

■ dscp-ipv6-compatibility

■ exp-default

■ ieee8021p-default

■ ipprec-default

■ ipprec-compatibility

■ ieee8021ad-default

■ ieee8021p-compatibility

Classifier type

Details of Classifiers

NoneDisplays CoS values and aliases to which forwarding class
and loss priority are mapped.

Incoming code point

NoneDisplays forwarding class names that are assigned to
specific CoS values and aliases of a classifier.

Forwarding class name

NoneDisplays loss priorities that are assigned to specific CoS
values and aliases of a classifier.

Loss priority

To add a classifier, click Add.Opens a page that allows you to define classifiers.Add

To edit a classifier, select a classifier in
the summary page and click Edit.

Opens a page that allows you to edit a selected classifier.Edit

To delete a classifier, select the classifier
and click Delete.

Deletes a specified classifier.Delete

Add Classifier
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Table 193: Classifiers Configuration Options (continued)

ActionFunctionField

To name a classifier, type the name—for
example, ba-classifier.

Specifies the name for a classifier.Classifier name

Select a classifier type from the
drop-down list, for example, dscp,
ieee-802.1, or inet-precedence.

Specify a classifier type.Classifier type

To assign a code point, forwarding class,
and loss priority to a specific CoS
classifier, click Add.

Opens a page that allows you to assign a forwarding class
and loss priority to the specified CoS value and alias.

A classifier examines the incoming packet's header for
the specified CoS value and alias and assigns it the
forwarding class and loss priority that you have defined.

Add

Add Code Point Mapping/Edit Code Point Mapping

To specify a CoS value and alias, either
select preconfigured ones from the list
or type new ones.

Specifies the CoS value in bits and the alias of a classifier.Code point

To assign a forwarding class, select either
one of the following default forwarding
classes or one that you have configured:

■ expedited-forwarding—Provides
low loss, low delay, low jitter,
assured bandwidth, and end-to-end
service. Packets can be forwarded
out of sequence or dropped.

■ best-effort—Provides no special CoS
handling of packets. Typically, RED
drop profile is aggressive and no
loss priority is defined.

■ assured-forwarding—Provides high
assurance for packets within the
specified service profile. Excess
packets are dropped.

■ network-control—Packets can be
delayed but not dropped.

Assigns the forwarding class to the specified CoS value
and alias.

Forwarding class

To assign a loss priority, select one:

■ high—Packet has a high loss
priority.

■ low—Packet has a low loss priority.

Assigns a loss priority to the specified CoS value and alias.Loss priority

Defining Rewrite Rules

Use the rewrite rules to alter the CoS values in outgoing packets to meet the
requirements of the targeted peer. A rewrite rule examines the forwarding class and
loss priority of a packet and sets its bits to a corresponding value specified in the
rule. For more information about rewrite rules, see the “Rewrite Rules” on page 801.
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To define rewrite rules using the J-Web configuration editor:

1. Select Configure>Class of Service>Rewrite Rules.

The Configure Rewrite Rule summary page appears.

2. Fill in the options as shown in Table 194 on page 823.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 194: Rewrite Rules Configuration Options

ActionFunctionField

Configure Rewrite Rule Summary

NoneDisplays names of defined rewrite rules.Rewrite rule name

NoneDisplays the rewrite rule type. The following types
are supported for J6350,SRX210, SRX240, and
SRX650 devices:

■ dscp—Defines the differentiated services
code point rewrite rule.

■ dscp-ipv6—Defines the differentiated
services code point rewrite rule IPv6.

■ exp—Defines the MPLS EXP rewrite rule.

■ frame-relay-de—Defines the frame relay
discard eligible bit rewrite rule.

■ ieee-802.1—Defines the IEEE-802.1 rewrite
rule.

■ inet-precedence—Defines the IPv4
precedence rewrite rule.

Rewrite rule type

Code Point Details

NoneDisplays the CoS values and aliases that a specific
rewrite rule has set for a specific forwarding class
and loss priority.

Incoming code point

NoneDisplays forwarding classes associated with a
specific rewrite rule.

Forwarding class name

NoneDisplays loss priority values associated with a
specific rewrite rule.

Loss priority

To add a rewrite rule, click Add.Opens a page that allows you to define a new
rewrite rule.

Add

To edit a rewrite rule, select a rewrite rule in the
summary page and click Edit.

Opens a page that allows you to edit a selected
rewrite rule.

Edit

To remove a rule, select the rewrite rule and click
Delete.

Removes selected rewrite rules.Delete
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Table 194: Rewrite Rules Configuration Options (continued)

ActionFunctionField

Add Rewrite Rule/Edit Rewrite Rule

To name a rule, type the name—for example,
rewrite-dscps.

Specifies a rewrite rule name.Rewrite rule name

Select a rewrite rule type from the drop-down
list, for example, dscp, ieee-802.1, or
inet-precedence.

Specify a rewrite rule type.Rewrite rule type

To assign a code point, forwarding class, and loss
priority to the rewrite rule, click Add.

Opens a page that allows you to rewrite outgoing
CoS values of a packet based on the forwarding
class and loss priority.

Add

Add Code Point Mapping

To specify a CoS value and alias, select one from
the drop-down list.

Specifies the CoS value in bits and the alias of a
classifier.

Code point

To assign a forwarding class, select one from the
drop-down list:

■ expedited-forwarding—Provides low loss,
low delay, low jitter, assured bandwidth,
and end-to-end service. Packets can be
forwarded out of sequence or dropped.

■ best-effort—Provides no special CoS
handling of packets. Typically, RED drop
profile is aggressive and no loss priority is
defined.

■ assured-forwarding—Provides high
assurance for packets within the specified
service profile. Excess packets are dropped.

■ network-control—Packets can be delayed
but not dropped.

Assigns the forwarding class to the rewrite rule.Forwarding class

To assign a loss priority, select one:

■ high—Packet has a high loss priority.

■ low—Packet has a low loss priority.

Assigns a loss priority to the specified rewrite
rule.

Loss priority

Defining Schedulers

An individual device interface has multiple queues assigned to store packets
temporarily before transmission. To determine the order in which to service the
queues, the device uses a round-robin scheduling method based on priority and the
queue's weighted round-robin (WRR) credits. JUNOS schedulers allow you to define
the priority, bandwidth, delay buffer size, rate control status, and RED drop profiles
to be applied to a particular queue for packet transmission. For more information
on schedulers, see the “Schedulers” on page 797.

To configure schedulers using the J-Web configuration editor:

1. Select Configure>Class of Service>Schedulers.
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The Configure Schedulers summary page appears.

2. Fill in the options as shown in Table 195 on page 825.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 195: Schedulers Configuration Options

ActionFunctionField

Configure Schedulers Summary

NoneDisplays the names of defined schedulers.Scheduler name

NoneDisplays the transmission priority of the
scheduler, which determines the order in which
an output interface transmits traffic from the
queues.

Scheduler priority

Details of Scheduler

NoneDisplays the scheduler name.Name

NoneDisplays the CoS value.Value

To add a scheduler, click Add.Opens a page that allows you to add a scheduler.Add

To edit a scheduler, select an existing scheduler
in the summary page and click Edit.

Opens a page that allows you to edit a selected
scheduler.

Edit

To remove an existing scheduler, select the
scheduler and click Delete.

Removes selected schedulers.Delete

Add Scheduler/Edit Scheduler

To name a scheduler, type the name—for
example, be-scheduler.

Specifies the name for a scheduler.Scheduler name

To specify a priority, select one:

■ high—Packets in this queue have high
priority.

■ low—Packets in this queue are transmitted
last.

■ medium—low—Packets in this queue have
medium-low priority.

■ medium—high—Packets in this queue have
medium-high priority.

■ strict—high—Packets in this queue are
transmitted first.

Sets the transmission priority of the scheduler,
which determines the order in which an output
interface transmits traffic from the queues.

You can set scheduling priority at different levels
in an order of increasing priority from low to
high.

A high-priority queue with a high transmission
rate might lock out lower-priority traffic.

Scheduler priority
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Table 195: Schedulers Configuration Options (continued)

ActionFunctionField

To define a delay buffer size for a scheduler,
select the appropriate option:

■ To enforce exact buffer size, select Exact.

■ To specify a buffer size as a temporal value
(microseconds), select Temporal.

■ To specify buffer size as a percentage of the
total buffer, select Percent and type an
integer from 1 through 100.

■ To specify buffer size as the remaining
available buffer, select Remainder.

Defines the size of the delay buffer.

By default, queues 0 through 7 have the following
percentage of the total available buffer space:

■ Queue 0—95 percent

■ Queue 1—0 percent

■ Queue 2—0 percent

■ Queue 3—0 percent

■ Queue 4—0 percent

■ Queue 5—0 percent

■ Queue 6—0 percent

■ Queue 7—5 percent

NOTE: A large buffer size value correlates with
a greater possibility of packet delays. This might
not be practical for sensitive traffic such as voice
or video.

Buffer size

To define a shaping rate, select the appropriate
option:

■ To specify shaping rate as an absolute
number of bits per second, select rate and
type an integer from 3200 to
160,000,000,000 bits per second.

■ To specify shaping rate as a percentage,
select percent and type an integer from 0
through 100.

Defines the minimum bandwidth allocated to a
queue.

The default shaping rate is 100 percent, which is
the same as no shaping at all.

Shaping rate

To define a transmit rate, select the appropriate
option:

■ To specify a transmit rate, select rate and
type an integer from 3200 to
160,000,000,000 bits per second.

■ To enforce an exact transmit rate, select
rate.

■ To specify the remaining transmission
capacity, select remainder.

■ To specify a percentage of transmission
capacity, select percent and type an integer
from 1 through 100.

Defines the transmission rate of a scheduler.

The transmit rate determines the traffic
bandwidth from each forwarding class you
configure.

By default, queues 0 through 7 have the following
percentage of transmission capacity:

■ Queue 0—95 percent

■ Queue 1—0 percent

■ Queue 2—0 percent

■ Queue 3—5 percent

■ Queue 4—0 percent

■ Queue 6—0 percent

■ Queue 7—5 percent

Transmit rate
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Defining Scheduler Maps

After defining schedulers you associate them with forwarding classes by means of
scheduler maps. For more information on scheduler maps, see “CoS Process on
Outgoing Packets” on page 803.

To configure scheduler maps using the J-Web configuration editor:

1. Select Configure>Class of Service>Scheduler Maps.

The Configure Scheduler Maps summary page appears.

2. Fill in the options as shown in Table 196 on page 827.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 196: Scheduler Maps Configuration Options

ActionFunctionField

Configure Scheduler Maps

NoneDisplays the names of defined scheduler maps.
Scheduler maps link schedulers to forwarding
classes.

Scheduler map name

NoneFor each map, displays the schedulers assigned
to it.

Schedulers

NoneFor each map, displays the forwarding classes
assigned to it.

Forwarding Class

Details of Scheduler

NoneDisplays the scheduler assigned to the selected
scheduler map

Name

NoneDisplays the CoS values.Value

To add a scheduler map, click Add.Opens a page that allows you to add a scheduler
map.

Add

To edit an existing scheduler map, select the
scheduler map in the summary page and click
Edit.

Opens a page that allows you to edit a selected
scheduler map.

Edit

To remove an existing scheduler map, select the
scheduler map and click Delete.

Removes selected scheduler maps.Delete

Add Scheduler Map/Edit Scheduler Map

To name a map, type the name—for example,
be-scheduler-map.

Specifies the name for a scheduler map.Scheduler map name
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Table 196: Scheduler Maps Configuration Options (continued)

ActionFunctionField

To associate a scheduler with a forwarding class,
locate the forwarding class and select the
scheduler in the box next to it.

Allows you to associate a preconfigured scheduler
with a forwarding class.

Once applied to an interface, the scheduler maps
affect the hardware queues, packet schedulers,
and RED drop profiles.

Scheduler mapping

Defining Drop Profiles

A drop profile is a feature of the random early detection (RED) process that allows
packets to be dropped before queues are full. Drop profiles are composed of two
main values—the queue fullness and the drop probability. For more information on
drop profiles, see “RED Drop Profiles” on page 799.

To configure drop profiles using the J-Web configuration editor:

1. Select Configure>Class of Service>Drop Profile.

The RED drop profiles summary page appears.

2. Fill in the options as shown in Table 197 on page 828.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 197: RED Drop Profile Configuration Options

ActionFunctionField

Red Drop Profiles

NoneDisplays the configured random early detection
(RED) drop profile names.

Drop profile name

NoneDisplays whether a RED drop profile type is
interpolated or segmented.

Profile type

NoneDisplays information about the data point types.Data points

To create a new RED drop profile, click Add.Opens a page that allows you to add a RED drop
profile.

Add

To edit an existing profile, select the profile in
the summary page and click Edit.

Opens a page that allows you to edit a RED drop
profile.

Edit

To remove an existing profile, select the profile
and click Delete.

Removes selected RED drop profiles.Delete

Add RED Drop Profile/Edit RED Drop Profile
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Table 197: RED Drop Profile Configuration Options (continued)

ActionFunctionField

To name a drop profile, type the name—for
example, be-normal.

Specifies a name for a drop profile.

A drop profile consists of pairs of values between
0 and 100, one for queue buffer fill level and one
for drop probability, that determine the
relationship between a buffer's fullness and the
likelihood it will drop packets. The values you
assign to each pair must increase relative to the
previous pair of values. With a few value pairs,
the system automatically constructs a drop
profile.

Drop profile name

Select Segmented or Interpolated.Specifies whether a RED drop profile type is
segmented or interpolated.

■ Segmented—The value pairs are represented
by line fragments, which connect each data
point on the graph to produce a segmented
profile.

■ Interpolated—The value pairs are
interpolated to produce a smooth profile.

RED drop profile type

To add fill level and drop probability, click Add.Opens a page that allows you to add the specified
queue buffer fill level and drop probability as a
data point for the graph.

Add

To specify x and y coordinates for data points,
type a number between 0 and 100 in the
following boxes:

■ Fill level—Type the percentage value of
queue buffer fullness for the x
coordinate—for example, 95.

■ Drop profile—Type the percentage value of
drop probability for the y coordinate—for
example, 85.

Specifies the points for generating the RED drop
profile graph. Each data point is defined by a pair
of x and y coordinates and represents the
relationship between them.

The x axis represents the queue buffer fill level,
which is a percentage value of how full the queue
is. A value of 100 means the queue is full.

The y axis represents the drop probability, which
is a percentage value of the chances of a packet
being dropped. A value of 0 means that a packet
is never dropped, and a value of 100 means that
all packets are dropped.

Data point

Defining Virtual Channel Groups

NOTE: SRX3400, SRX3600, SRX5600, and SRX5800 devices do not support virtual
channels.

Use virtual channels to avoid oversubscription of links by limiting traffic from a higher
aggregated bandwidth to a lower one—for example, to limit traffic from a main office
to branch offices. You channelize this traffic by applying queuing, packet scheduling,
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and accounting rules to logical interfaces. For more information on virtual channels,
see “Virtual Channels” on page 800.

To configure virtual channel groups using the J-Web configuration editor:

1. Select Configure>Class of Service>Virtual Channel Groups.

The configure class of service page appears.

2. Fill in the options as shown in Table 197 on page 828.

3. Click one of the following buttons:

■ To apply the configuration and return to the main configuration page, click
OK.

■ To cancel your entries and return to the main page, click Cancel.

Table 198: Virtual Channel Group Quick Configuration Page Summary

Your ActionFunctionField

Virtual Channel Groups Summary

NoneDisplays names of defined virtual channel groups.

Allows you to edit a virtual channel group.

Virtual Channel Group
Name

NoneDisplays names of defined virtual channels.

Allows you to edit a virtual channel.

Virtual Channel Name

NoneMarks the default virtual channel of a group.

One of the virtual channels in a group must be
configured as the default channel. Any traffic not
explicitly directed to a particular channel is
transmitted by this channel.

Default

NoneDisplays the scheduler map assigned to a
particular virtual channel.

Scheduler Map

NoneDisplays the shaping rate configured for a virtual
channel.

Shaping Rate

To add a virtual channel group, click Add.Opens a page that allows you to add a virtual
channel group.

Add

To remove a specific virtual channel group,
select it from the summary page, and click
Delete.

Removes a specific virtual channel group.Delete

Add a Virtual Channel Group/Edit a Virtual Channel Group

To name a group, type the name—for example,
wan-vc-group.

Specifies a name for a virtual channel group.Virtual Channel Group
Name
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Table 198: Virtual Channel Group Quick Configuration Page Summary (continued)

Your ActionFunctionField

To create a virtual channel group, click Add.Creates a virtual channel group.

Opens a page that allows you to add a virtual
channel to the specified group.

Add

Add a Virtual Channel/Edit Virtual Channel

To name a virtual channel, either select a
predefined name from the list or type a new
name—for example, branch1–vc.

Specifies the name of a virtual channel to be
assigned to a virtual channel group.

Virtual Channel Name

To specify a scheduler map, select it from the
Scheduler Map list.

Specifies a predefined scheduler map to assign
to a virtual channel.

Scheduler maps associate schedulers with
forwarding classes. For information about how to
define scheduler maps, see Table 196 on page 827.

Scheduler Map

To specify a shaping rate, select one of the
following options:

■ To specify no shaping rate, select
Unconfigured.

■ To configure a shaping rate as an absolute
number of bits per second, select Absolute
Rate and type a value between 3200 and
32,000,000,000.

■ To configure a shaping rate as a
percentage, select Percent and type a value
between 0 and 100.

Specifies the shaping rate for a virtual channel.

The shaper limits the maximum bandwidth
transmitted by a virtual channel.

Configuring a shaping rate is optional. If no
shaping rate is configured, a virtual channel
without a shaper can use the full logical interface
bandwidth.

Shaping Rate

Assigning CoS Components to Interfaces

NOTE: SRX Series devices do not support WAN interfaces (including T1/E1 and
channelized T1/E1).

After you have defined CoS components, you must assign them to logical or physical
interfaces. The Assign to Interface option allows you to assign scheduler maps to
physical or logical interfaces and to assign forwarding classes, classifiers, rewrite
rules, or virtual channel groups to logical interfaces.

To assign interfaces using the J-Web configuration editor:

1. Select Configure>Class of Service>Assign to Interface.

The Configure Interface Association summary page appears. The summary page
displays the interfaces available for CoS component assignment and the status
of existing CoS components.

2. Fill in the options as shown in Table 199 on page 832.
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3. To apply the configuration and return to the main configuration page, click OK.

4. To cancel your entries and return to the main page, click Cancel.

Table 199: Assigning CoS Components to Interfaces

ActionFunctionField

Configure Interface Association

NoneDisplays the port and interface name.Port

NoneDisplays predefined scheduler maps for the
physical interface.

A scheduler map enables the physical interface
to have more than one set of output queues.

NOTE: For 4-port Fast Ethernet ePIMs, if you
apply a CoS scheduler map on outgoing (egress)
traffic, the device does not divide the bandwidth
appropriately among the CoS queues. As a
workaround, configure enforced CoS shaping on
the ports.

Scheduler Map

To change a map for an interface, select it from
the Scheduler Map list and click Edit.

Opens an edit page that allows you to associate
the system default scheduler map or a
preconfigured map to the selected interface.

Edit

Details of Logical Interfaces

NoneUnit

NoneDisplays the forwarding classes assigned to a
particular interface.

Forwarding class

NoneDisplays the scheduler maps assigned to a
particular interface.

Scheduler map

NoneDisplays the virtual channel groups assigned to
a particular interface.

Virtual channel group

NoneDisplays the classifiers assigned to a particular
interface—for example, information about DSCP,
DSCPv6, EXP, and inet classifiers.

Classifier

NoneDisplays the rewrite rules assigned to a particular
interface—for example, information about DSCP,
DSCPv6, EXP and inet rewrite rules.

Rewrite rule

To add a CoS service to a physical interface, click
Add.

Opens a page that allows you to add a CoS service
to a physical interface.

Add

To edit an existing service, select the service in
the summary page and click Edit.

Opens a page that allows you to edit a CoS
services assigned to an interface.

Edit

To remove CoS services assigned to a specific
interface, locate the interface name, click the
check box next to it, and click Delete.

Removes CoS services assigned to a specific
interface.

Delete

832 ■ Configuring CoS (J-Web Procedure)

JUNOS Software Interfaces and Routing Configuration Guide



Table 199: Assigning CoS Components to Interfaces (continued)

ActionFunctionField

Add Logical Interface/Edit Logical Interface

To specify an interface for CoS assignment, type
its name in the Unit box.

To assign CoS services to all logical interfaces
configured on this physical interface, type the
wildcard character (*).

Specifies the name of a logical interface.

Allows you to assign CoS components to all
logical interfaces configured on a physical
interface at the same time.

Unit

To assign a scheduler map to the interface, select
it from the list.

Specifies a predefined scheduler map for this
interface.

NOTE: You can configure either a scheduler map
or a virtual channel group on a logical interface,
not both.

Scheduler Map

To assign a forwarding class to the interface,
select it from the list.

Assigns a predefined forwarding class to
incoming packets on a logical interface.

Forwarding Class

To specify a virtual channel group for the
interface, select it from the list.

Applies a virtual channel group to a logical
interface.

Applying a virtual channel group creates a set of
eight queues for each virtual channel in the group.

NOTE: You can configure either a scheduler map
or a virtual channel group on a logical interface,
not both.

Virtual Channel Group

To assign a classification map to the interface,
select an appropriate classifier for each CoS value
type used on the interface.

Allows you to apply classification maps to a
logical interface.

Classifiers assign a forwarding class and loss
priority to an incoming packet based on its CoS
value.

Classifiers

To apply a rewrite rule configuration to the
interface, select a rule for each CoS value type
used on the interface.

Allows you to apply rewrite rule configurations
to a logical interface.

Rewrite rules rewrite the CoS values in an
outgoing packet based on forwarding class and
loss priority.

You can choose to apply your own rewrite rule
or a default one. The default rewrite assignments
are based on the default bit definitions of DSCP,
DSCP IPv6, MPLS EXP, and IP precedence.

Rewrite Rules

Configuring CoS Components with a Configuration Editor

To configure the device as a node in a network supporting CoS, read the section
“Before You Begin” on page 816, determine your needs, and select the tasks you need
to perform from the following list. For information about using the J-Web and CLI
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configuration editors, see the the J-Web Interface User Guide and the Junos CLI User
Guide.

■ Configuring a Policer for a Firewall Filter on page 834

■ Configuring and Applying a Firewall Filter for a Multifield Classifier on page 835

■ Assigning Forwarding Classes to Output Queues on page 838

■ Example: Configuring Up to Eight Forwarding Classes on page 841

■ Configuring and Applying Rewrite Rules on page 845

■ Configuring and Applying Behavior Aggregate Classifiers on page 848

■ Configuring RED Drop Profiles for Congestion Control on page 854

■ Configuring Schedulers on page 857

■ Configuring and Applying Scheduler Maps on page 860

■ Scheduler Maps: Sample Configuration on page 863

■ Schedulers: Sample Configuration on page 863

■ Configuring and Applying Virtual Channels on page 864

■ Configuring and Applying an Adaptive Shaper on page 868

Configuring a Policer for a Firewall Filter

You configure a policer to detect packets that exceed the limits established for
expedited forwarding. The packets that exceed these limits are given a higher loss
priority than packets within the bandwidth and burst size limits.

The following example shows how to configure a policer called ef-policer that identifies
for likely discard expedited forwarding packets with a burst size greater than
2000 bytes and a bandwidth greater than 10 percent.

For more information about firewall filters, see the Junos OS Routing Protocols and
Policies Configuration Guide for Security Devices and the JUNOS Policy Framework
Configuration Guide.

To configure an expedited forwarding policer for a firewall filter for the Services
Router:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 200 on page 835.

3. Go on to “Configuring and Applying a Firewall Filter for a Multifield Classifier”
on page 835.
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Table 200: Configuring a Policer for a Firewall Filter

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit firewall

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Firewall, click Configure or Edit.

Navigate to the Firewall level in the
configuration hierarchy.

Enter

edit policer ef-policer

1. Click Add new entry next to Policer.

2. In the Policer name box, type ef-policer.

Create the policer for expedited forwarding,
and give the policer a name—for example,
ef-policer.

Enter

set if-exceeding
burst-limit-size 2k

set if-exceeding
bandwidth-percent 10

1. Click Configure next to If exceeding.

2. In the Burst size limit box, type a limit for
the burst size allowed—for example, 2k.

3. From the Bandwidth list, select
bandwidth-percent.

4. In the Bandwidth percent box, type 10.

5. Click OK.

Set the burst limit for the policer—for
example, 2k.

Set the bandwidth limit or percentage for
the bandwidth allowed for this type of
traffic—for example, use a bandwidth
percent of 10.

Enter

set then loss-priority high

1. Click Configure next to Then.

2. From the Loss priority list, select high.

3. Click OK.

Enter the loss priority for packets exceeding
the limits established by the policer—for
example, high.

Configuring and Applying a Firewall Filter for a Multifield Classifier

You configure a multifield (MF) classifier to detect packets of interest to CoS and
assign the packet to the proper forwarding class independently of the DiffServ code
point (DSCP). To configure a multifield classifier on a customer-facing or host-facing
link, configure a firewall filter to classify traffic. Packets are classified as they arrive
on an interface.

One common way to detect packets of CoS interest is by source or destination
address. The destination address is used in this example, but many other matching
criteria for packet detection are available to firewall filters.

This example shows how to configure the firewall filter mf-classifier and apply it to
the Services Router's Gigabit Ethernet interface ge-0/0/0. The firewall filter consists
of the rules (terms) listed in Table 201 on page 836.
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Table 201: Sample mf-classifier Firewall Filter Terms

ContentsPurposeRule (Term)

Match condition: destination address
192.168.44.55

Forwarding class: af-class

Loss priority: low

Detects packets destined for 192.168.44.55, assigns them
to an assured forwarding class, and gives them a low
likelihood of being dropped.

assured forwarding

Match condition: destination address
192.168.66.77

Forwarding class: ef-class

Policer: ef-policer

Detects packets destined for 192.168.66.77, assigns them
to an expedited forwarding class, and subjects them to the
EF policer configured in “Configuring a Policer for a
Firewall Filter” on page 834.

expedited-forwarding

Match condition: precedence net-control

Forwarding class: nc-class

Detects packets with a network control precedence and
forwards them to the network control class.

network control

Forwarding class: be-classDetects all other packets and assigns them to the best effort
class.

best-effort-data

For more information about firewalls filters see Junos OS Routing Protocols and Policies
Configuration Guide for Security Devices and the JUNOS Policy Framework Configuration
Guide.

To configure a firewall filter for a multifield classifier for the Services Router:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 202 on page 836.

3. Go on to “Assigning Forwarding Classes to Output Queues” on page 838.

Table 202: Configuring and Applying a Firewall Filter for a Multifield Classifier

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit firewall

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Firewall, click Configure or
Edit.

Navigate to the Firewall level in the
configuration hierarchy.

Enter

edit filter mf-classifier

set interface-specific

1. Click Add new entry next to Filter.

2. In the Filter name box, type
mf-classifier.

3. Select the check box next to
Interface specific.

Create the multifield classifier filter and
name it—for example, mf-classifier.
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Table 202: Configuring and Applying a Firewall Filter for a Multifield Classifier (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

edit term assured-forwarding

1. Click Add new entry next to Term.

2. In the Rule name box, type
assured-forwarding.

Create the term for the assured
forwarding traffic class, and give it a
name—for example, assured-forwarding.

Enter

set from destination-address
192.168.44.55

1. Click Configure next to From.

2. Click Add new entry next to
Destination address.

3. In the Address box, type
192.168.44.55.

4. Click OK twice.

Create the match condition for the
assured forwarding traffic class. Use the
destination address for assured
forwarding traffic—for example,
192.168.44.55.

Enter

set then forwarding-class af-class

set then loss-priority low

1. Click Configure next to Then.

2. In the Forwarding class box, type
af-class.

3. From the Loss priority list, select low.

4. Click OK twice.

Create the forwarding class for assured
forwarding DiffServ traffic—for example,
af-class.

Set the loss priority for the assured
forwarding traffic class—for example,
low.

From the [edit firewall filter mf-classifier]
hierarchy level, enter

edit term expedited-forwarding

1. Click Add new entry next to Term.

2. In the Rule name box, type
expedited-forwarding.

Create the term for the expedited
forwarding traffic class, and give it a
name—for example,
expedited-forwarding.

Enter

set from destination-address
192.168.66.77

1. Click Configure next to From.

2. Click Add new entry next to
Destination address.

3. In the Address box, type
192.168.66.77.

4. Click OK twice.

Create the match condition for the
expedited forwarding traffic class. Use
the destination address for expedited
forwarding traffic—for example,
192.168.66.77.

Enter

set then forwarding-class ef-class

set then policer ef-policer

1. Click Configure next to Then.

2. In the Forwarding class box, type
ef-class.

3. From the Policer choice list, select
Policer.

4. In the Policer box, type ef-policer.

5. Click OK twice.

Create the forwarding class for expedited
forwarding DiffServ traffic—for example,
ef-class.

Apply the policer for the expedited
forwarding traffic class. Use the EF
policer previously configured for
expedited forwarding DiffServ
traffic—ef-policer.

(See “Configuring a Policer for a Firewall
Filter” on page 834.)

From the [edit firewall filter mf-classifier]
hierarchy level, enter

edit term network-control

1. Click Add new entry next to Term.

2. In the Rule name box, type
network-control.

Create the term for the network control
traffic class, and give it a name—for
example, network-control.
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Table 202: Configuring and Applying a Firewall Filter for a Multifield Classifier (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set from precedence net-control

1. Click Configure next to From.

2. From the Precedence choice list,
select Precedence.

3. Click Add new entry next to
Precedence.

4. From the Value keyword list, select
net-control.

5. Click OK twice.

Create the match condition for the
network control traffic class.

Enter

set then forwarding-class nc-class

1. Click Configure next to Then.

2. In the Forwarding class box, type
nc-class.

3. Click OK twice.

Create the forwarding class for the
network control traffic class, and give it
a name—for example, nc-class.

From the [edit firewall filter mf-classifier]
hierarchy level, enter

edit term best-effort-data

1. Click Add new entry next to Term.

2. In the Rule name box, type
best-effort-data.

Create the term for the best-effort traffic
class, and give it a name—for example,
best-effort-data.

Enter

set then forwarding-class be-class

1. Click Configure next to Then.

2. In the Forwarding class box, type
be-class.

3. Click OK four times.

Create the forwarding class for the
best-effort traffic class, and give it a
name—for example, be-class. (Because
this is the last term in the filter, it has no
match condition.)

From the [edit] hierarchy level, enter

edit interfaces

On the main Configuration page next to
Interfaces, click Configure or Edit.

Navigate to the Interfaces level in the
configuration hierarchy.

Enter

set ge-0/0/0 unit 0 family inet filter
input mf-classifier

1. Click the Interface ge-0/0/0 and Unit
0.

2. Click Configure next to Inet.

3. Click Configure next to Filter.

4. From the Input choice list, select
Input.

5. In the Input box, type mf-classifier.

6. Click OK.

Apply the multifield classifier firewall
filter mf-classifier as an input filter on
each customer-facing or host-facing
interface that needs the filter—for
example, on ge-0/0/0, unit 0.

Assigning Forwarding Classes to Output Queues

You must assign the forwarding classes established by the mf-classifier multifield
classifier to output queues. This example assigns output queues as shown in Table
203 on page 839.
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Table 203:  Sample Output Queue Assignments for mf-classifier Forwarding Queues

Output QueueFor Traffic Typemf-classifier Forwarding Class

Queue 0Best-effort trafficbe-class

Queue 1Expedited forwarding trafficef-class

Queue 2Assured forwarding trafficaf-class

Queue 3Network control trafficnc-class

For multifield classifier details, see “Configuring and Applying a Firewall Filter for a
Multifield Classifier” on page 835.

To assign forwarding classes to output queues:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 204 on page 839.

3. Go on to “Configuring and Applying Rewrite Rules” on page 845.

Table 204: Assigning Forwarding Classes to Output Queues

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit class-of-service

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Class of service, click Configure or Edit.

Navigate to the Class of
service level in the
configuration hierarchy.

Enter

set forwarding-classes queue
0 be-class

1. Click Configure next to Forwarding classes.

2. Click Add new entry next to Queue.

3. In the Queue num box, type 0.

4. In the Class name box, type the previously configured
name of the best-effort class—be-class.

5. Click OK.

Assign best-effort traffic to
queue 0.

Enter

set forwarding-classes queue
1 ef-class

1. Click Add new entry next to Queue.

2. In the Queue num box, type 1.

3. In the Class name box, type the previously configured
name of the expedited forwarding class—ef-class.

4. Click OK.

Assign expedited forwarding
traffic to queue 1.
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Table 204: Assigning Forwarding Classes to Output Queues (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set forwarding-classes queue
2 af-class

1. Click Add new entry next to Queue.

2. In the Queue num box, type 2.

3. In the Class name box, type the previously configured
name of the assured forwarding class—af-class.

4. Click OK.

Assign assured forwarding
traffic to queue 2.

Enter

set forwarding-classes queue
3 nc-class

1. Click Add new entry next to Queue.

2. In the Queue num box, type 3.

3. In the Class name box, type the previously configured
name of the network control forwarding class—nc-class.

4. Click OK.

Assign network control traffic
to queue 3.

Configuring Forwarding Classes

To configure CoS forwarding classes on an SRX Series device, include the following
statements at the [edit class-of-service] hierarchy level of the configuration:

[edit class-of-service]
forwarding-classes {

class class-name queue-num queue-number priority (high | low);
queue queue-number class-name priority (high | low);

}
interfaces {

interface-name {
unit logical-unit-number {

forwarding-class class-name;
}

}
}
restricted-queues {

forwarding-class class-name queue-number;
}

You cannot commit a configuration that assigns the same forwarding class to two
different queues.

Assigning a Forwarding Class to an Interface

On an SRX Series device, you can configure fixed classification on a logical interface
by specifying a forwarding class to be applied to all packets received by the logical
interface, regardless of the packet contents.

To assign a forwarding class configuration to the input logical interface, include the
forwarding-class statement at the [edit class-of-service interfaces interface-name unit
logical-unit-number] hierarchy level:
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[edit class-of-service interfaces interface-name unit logical-unit-number]
forwarding-class class-name;

You can include interface wildcards for interface-name and logical-unit-number.

In the following example, all packets coming into the device from the ge-3/0/0.0
interface are assigned to the assured-forwarding forwarding class:

[edit class-of-service]
interfaces {

ge-3/0/0 {
unit 0 {

forwarding-class assured-forwarding;
}

}
}

Example: Configuring Up to Eight Forwarding Classes

By default on all platforms, four output queues are mapped to four forwarding classes
as shown in Table 186 on page 806. On J Series or SRX Series devices, you can
configure up to eight forwarding classes and eight queues.

To configure up to eight forwarding classes, include the queue statement at the [edit
class-of-service forwarding-classes] hierarchy level:

[edit class-of-service forwarding-classes]
queue queue-number class-name;

The output queue number can be from 0 through 7, and you must map the forwarding
classes one-to-one with the output queues. The default scheduler transmission rate
and buffer size percentages for queues 0 through 7 are 95, 0, 0, 5, 0, 0, 0, and 0
percent.

For example, to configure a one-to-one mapping between eight forwarding classes
and eight queues: you would use the following configuration:

[edit class-of-service]
forwarding-classes {

queue 0 be;
queue 1 ef;
queue 2 af;
queue 3 nc;
queue 4 ef1;
queue 5 ef2;
queue 6 af1;
queue 7 nc1;

}

Defining Eight
Classifiers

[edit class-of-service]
classifiers {

dscp dscp-table {
forwarding-class ef {

loss-priority low code-points [101000, 101001];
loss-priority high code-points [101010, 101011];
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}
forwarding-class af {

loss-priority low code-points [010000, 010001];
loss-priority high code-points [010010, 010011];

}
forwarding-class be {

loss-priority low code-points [000000];
}
forwarding-class nc {

loss-priority low code-points [111000];
}
forwarding-class ef1 {

loss-priority low code-points [101100, 101101];
loss-priority high code-points [101110];

}
forwarding-class af1 {

loss-priority high code-points [101110];
}
forwarding-class ef2 {

loss-priority low code-points [101111];
}
forwarding-class af2 {

loss-priority low code-points [010000];
}
forwarding-class nc1 {

loss-priority low code-points [111001];
}

}
}

Adding Eight Schedulers
to a Scheduler Map

Configure a custom scheduler map that applies globally to all interfaces, except those
that are restricted to four queues:

[edit class-of-service]
scheduler-maps {

sched {
forwarding-class be scheduler Q0;
forwarding-class ef scheduler Q1;
forwarding-class af scheduler Q2;
forwarding-class nc scheduler Q3;
forwarding-class ef1 scheduler Q4;
forwarding-class ef2 scheduler Q5;
forwarding-class af1 scheduler Q6;
forwarding-class nc1 scheduler Q7;

}
}
schedulers {

Q0 {
transmit-rate percent 25;
buffer-size percent 25;
priority low;
drop-profile-map loss-priority any protocol both drop-default;

}
Q1 {

buffer-size temporal 2000;
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priority strict-high;
drop-profile-map loss-priority any protocol both drop-ef;

}
Q2 {

transmit-rate percent 35;
buffer-size percent 35;
priority low;
drop-profile-map loss-priority any protocol both drop-default;

}
Q3 {

transmit-rate percent 5;
buffer-size percent 5;
drop-profile-map loss-priority any protocol both drop-default;

}
Q4 {

transmit-rate percent 5;
priority high;
drop-profile-map loss-priority any protocol both drop-ef;

}
Q5 {

transmit-rate percent 10;
priority high;
drop-profile-map loss-priority any protocol both drop-ef;

}
Q6 {

transmit-rate remainder;
priority low;
drop-profile-map loss-priority any protocol both drop-default;

}
Q7 {

transmit-rate percent 5;
priority high;
drop-profile-map loss-priority any protocol both drop-default;

}
}

Configuring an IP
Precedence Classifier

and Rewrite Tables

[edit class-of-service]
classifiers {

inet-precedence inet-classifier {
forwarding-class be {

loss-priority low code-points 000;
}
forwarding-class af11 {

loss-priority high code-points 001;
}
forwarding-class ef {

loss-priority low code-points 010;
}
forwarding-class nc1 {

loss-priority high code-points 011;
}
forwarding-class {

loss-priority low code-points 100;
}
forwarding-class af12 {
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loss-priority high code-points 101;
}
forwarding-class ef1 {

loss-priority low code-points 110;
}
forwarding-class nc2 {

loss-priority high code-points 111;
}

}
}
exp exp-rw-table {

forwarding-class be {
loss-priority low code-point 000;

}
forwarding-class af11 {

loss-priority high code-point 001;
}
forwarding-class ef {

loss-priority low code-point 010;
}
forwarding-class nc1 {

loss-priority high code-point 111;
}
forwarding-class be1 {

loss-priority low code-point 100;
}
forwarding-class af12 {

loss-priority high code-point 101;
}
forwarding-class ef1 {

loss-priority low code-point 110;
}
forwarding-class nc2 {

loss-priority low code-point 111;
}

}
inet-precedence inet-rw-table {

forwarding-class be {
loss-priority low code-point 000;

}
forwarding-class af11 {

loss-priority high code-point 001;
}
forwarding-class ef1 {

loss-priority low code-point 010;
}
forwarding-class nc1 {

loss-priority low code-point 111;
}
forwarding-class be1 {

loss-priority low code-point 100;
}
forwarding-class af12 {

loss-priority high code-point 101;
}
forwarding-class ef1 {
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loss-priority low code-point 111;
}
forwarding-class nc2 {

loss-priority low code-point 110;
}

}

Configuring and Applying Rewrite Rules

You can configure rewrite rules to replace DiffServ code points (DSCPs) on packets
received from the customer or host with the values expected by other devices. You
do not have to configure rewrite rules if the received packets already contain valid
DSCPs. Rewrite rules apply the forwarding class information and packet loss priority
used internally by the device to establish the DSCP on outbound packets. Once
configured, you must apply the rewrite rules to the correct interfaces.

The following example shows how to create the rewrite rules rewrite-dscps and apply
them to the device's Gibabit Ethernet interface ge-0/0/0. The rewrite rules replace
the DSCPs on packets in the four forwarding classes, as shown in Table 205 on
page 845.

Table 205: Sample rewrite-dscps Rewrite Rules to Replace DSCPs

rewrite-dscps Rewrite RulesFor CoS Traffic Type
mf-classifier Forwarding
Class

Low-priority code point: 000000

High-priority code point: 000001

Best-effort trafficbe-class

Low-priority code point: 101110

High-priority code point: 101111

Expedited forwarding trafficef-class

Low-priority code point: 001010

High-priority code point: 001100

Assured forwarding trafficaf-class

Low-priority code point: 110000

High-priority code point: 110001

Network control trafficnc-class

To configure and apply rewrite rules for the device:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 206 on page 846.

3. Go on to “Configuring and Applying Behavior Aggregate Classifiers” on page 848.
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Table 206: Configuring and Applying Rewrite Rules

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click
Configure or Edit.

Navigate to the Class of service level in
the configuration hierarchy.

Enter

edit rewrite-rules dscp rewrite-dscps

1. Click Configure next to Rewrite
rules.

2. Click Add new entry next to Dscp.

3. In the Name box, type the name
of the rewrite rules—for example,
rewrite-dscps.

Configure rewrite rules for DiffServ CoS.

Enter

set forwarding-class be-class loss-priority
low code-point 000000

set forwarding-class be-class loss-priority
high code-point 000001

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
best-effort forwarding
class—be-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select low.

5. In the Code point box, type the
value of the low-priority code point
for best-effort traffic—for example,
000000.

6. Click OK.

7. Click Add new entry next to Loss
priority.

8. From the Loss val list, select high.

9. In the Code point box, type the
value of the high-priority code
point for best-effort traffic—for
example, 000001.

10. Click OK twice.

Configure best-effort forwarding class
rewrite rules.
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Table 206: Configuring and Applying Rewrite Rules (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set forwarding-class ef-class loss-priority
low code-point 101110

set forwarding-class ef-class loss-priority
high code-point 101111

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
expedited forwarding
class—ef-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select low.

5. In the Code point box, type the
value of the low-priority code point
for expedited forwarding
traffic—for example, 101110.

6. Click OK.

7. Click Add new entry next to Loss
priority.

8. From the Loss val list, select high.

9. In the Code point box, type the
value of the high-priority code
point for expedited forwarding
traffic—for example, 101111.

10. Click OK twice.

Configure expedited forwarding class
rewrite rules.

Enter

set forwarding-class af-class loss-priority
low code-point 001010

set forwarding-class af-class loss-priority
high code-point 001100

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
assured forwarding class—af-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select low.

5. In the Code point box, type the
value of the low-priority code point
for assured forwarding traffic—for
example, 001010.

6. Click OK.

7. Click Add new entry next to Loss
priority.

8. From the Loss val list, select high.

9. In the Code point box, type the
value of the high-priority code
point for assured forwarding
traffic—for example, 001100.

10. Click OK twice.

Configure assured forwarding class
rewrite rules.
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Table 206: Configuring and Applying Rewrite Rules (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set forwarding-class nc-class loss-priority
low code-point 110000

set forwarding-class nc-class loss-priority
high code-point 110001

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
network control forwarding
class—nc-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select low.

5. In the Code point box, type the
value of the low-priority code point
for network control traffic—for
example, 110000.

6. Click OK.

7. Click Add new entry next to Loss
priority.

8. From the Loss val list, select high.

9. In the Code point box, type the
value of the high-priority code
point for network control
traffic—for example, 110001.

10. Click OK four times.

Configure network control class rewrite
rules.

From the [edit class of service] hierarchy
level, enter

set interfaces ge-0/0/0 unit 0 rewrite-rules
dscp rewrite-dscps

1. Click Add new entry next to
Interfaces

2. In the Interface name box, type the
name of the interface—for
example, ge-0/0/0.

3. Click Add new entry next to Unit.

4. In the Unit number box, type the
logical interface unit number—0.

5. Click Configure next to Rewrite
rules.

6. In the Rewrite rules name box,
under Dscp, type the name of the
previously configured rewrite
rules—rewrite-dscps.

7. Click OK.

Apply rewrite rules to an interface.

(See the interface naming conventions
in Junos OS Interfaces Configuration Guide
for Security Devices.)

Configuring and Applying Behavior Aggregate Classifiers

You configure behavior aggregate classifiers to classify packets that contain valid
DSCPs to appropriate queues. Once configured, you must apply the behavior aggregate
classifier to the correct interfaces.
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The following example shows how to configure the DSCP behavior aggregate classifier
ba-classifier as the default DSCP map, and apply it to the device's Gigabit Ethernet
interface ge-0/0/0. The behavior aggregate classifier assigns loss priorities, as shown
in Table 207 on page 849, to incoming packets in the four forwarding classes.

Table 207: Sample ba-classifier Loss Priority Assignments

ba-classifier AssignmentsFor CoS Traffic Type
mf-classifier Forwarding
Class

High-priority code point: 000001Best-effort trafficbe-class

High-priority code point: 101111Expedited forwarding trafficef-class

High-priority code point: 001100Assured forwarding trafficaf-class

High-priority code point: 110001Network control trafficnc-class

To configure and apply behavior aggregate classifiers for the device:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 208 on page 849.

3. Go on to “Configuring RED Drop Profiles for Congestion Control” on page 854.

Table 208: Configuring and Applying Behavior Aggregate Classifiers

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click
Configure or Edit.

Navigate to the Class of service level in
the configuration hierarchy.

Enter

edit classifiers dscp ba-classifier

set import default

1. Click Configure next to Classifiers.

2. Click Add new entry next to Dscp.

3. In the Name box, type the name
of the behavior aggregate
classifier—for example,
ba-classifier.

4. In the Import box, type the name
of the default DSCP map, default.

Configure behavior aggregate classifiers
for DiffServ CoS.
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Table 208: Configuring and Applying Behavior Aggregate Classifiers (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set forwarding-class be-class loss-priority
high code-points 000001

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
best-effort forwarding
class—be-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select high.

5. Click Add new entry next to Code
points.

6. In the Value box, type the value of
the high-priority code point for
best-effort traffic—for example,
00001.

7. Click OK three times.

Configure a best-effort forwarding class
classifier.

Enter

set forwarding-class ef-class loss-priority
high code-points 101111

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
expedited forwarding
class—ef-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select high.

5. Click Add new entry next to Code
points.

6. In the Value box, type the value of
the high-priority code point for
expedited forwarding traffic—for
example, 101111.

7. Click OK three times.

Configure an expedited forwarding class
classifier.
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Table 208: Configuring and Applying Behavior Aggregate Classifiers (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set forwarding-class af-class loss-priority
high code-points 001100

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
assured forwarding class—af-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select high.

5. Click Add new entry next to Code
points.

6. In the Value box, type the value of
the high-priority code point for
assured forwarding traffic—for
example, 001100.

7. Click OK three times.

Configure an assured forwarding class
classifier.

Enter

set forwarding-class nc-class loss-priority
high code-points 110001

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
network control forwarding
class—nc-class.

3. Click Add new entry next to Loss
priority.

4. From the Loss val list, select high.

5. Click Add new entry next to Code
points.

6. In the Value box, type the value of
the high-priority code point for
network control traffic—for
example, 110001.

7. Click OK five times.

Configure a network control class
classifier.
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Table 208: Configuring and Applying Behavior Aggregate Classifiers (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit class of service] hierarchy
level, enter

set interfaces ge-0/0/0 unit 0 classifiers
dscp ba-classifier

1. Click Add new entry next to
Interfaces.

2. In the Interface name box, type the
name of the interface—for
example, ge-0/0/0.

3. Click Add new entry next to Unit.

4. In the Unit number box, type the
logical interface unit number—0.

5. Click Configure next to Classifiers.

6. In the Classifiers box, under Dscp,
type the name of the previously
configured behavior aggregate
classifier—ba-classifier.

7. Click OK.

Apply the behavior aggregate classifier
to an interface.

(See the interface naming conventions
in Junos OS Interfaces Configuration Guide
for Security Devices.)

Example: Defining Aliases for Bits

When you configure classes and define classifiers, you can refer to the markers by
alias names. You can configure user-defined classifiers in terms of alias names. If
the value of an alias changes, it alters the behavior of any classifier that references
it.

To define a code-point alias on an SRX Series device, include the code-point-aliases
statement at the [edit class-of-service] hierarchy level:

[edit class-of-service]
code-point-aliases {

(dscp |exp | ieee-802.1 | inet-precedence) {
alias-name bits;
}

}

The CoS marker types are as follows:

■ dscp—Handles incoming IPv4 packets.

■ exp—Handles MPLS packets using Layer 2 headers.

■ ieee-802.1—Handles Layer 2 CoS.

■ inet-precedence—Handles incoming IPv4 packets. IP precedence mapping
requires only the upper three bits of the DSCP field.

For example, you can set up the following configuration:

[edit class-of-service]
code-point-aliases {

dscp {
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my1 110001;
my2 101110;
be 000001;
cs7 110000;

}
}

The sample configuration produces this mapping:

user@host>show class-of-service code-point-aliases dscp
Alias  Bit pattern
ef/my2  101110
af11   001010
af12   001100
af13   001110
af21   010010
af22   010100
af23   010110
af31   011010
af32   011100
af33   011110
af41   100010
af42   100100
af43   100110
be   000001
cs1   001000
cs2   010000
cs3   011000
cs4   100000
cs5   101000
nc1/cs6/cs7 110000
nc2   111000
my1   110001

The following notes explain certain results in the mapping:

■ my1 110001:

■ 110001 was not mapped to anything before, and my1 is a new alias.

■ Nothing in the default mapping table is changed by this statement.

■ my2 101110:

■ 101110 is now mapped to my2 as well as ef.

■ be 000001:

■ be is now mapped to 000001.

■ The old value of be, 000000, is not associated with any alias. Packets with
this DSCP value are now mapped to the default forwarding class.

■ cs7 110000:

■ cs7 is now mapped to 110000, as well as nc1 and cs6.

■ The old value of cs7, 111000, is still mapped to nc2.
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Configuring RED Drop Profiles for Congestion Control

If the device must support assured forwarding, you can control congestion by
configuring random early detection (RED) drop profiles. RED drop profiles use drop
probabilities for different levels of buffer fullness to determine which scheduling
queue on the device is likely to drop assured forwarding packets under congested
conditions. The device can drop packets when the queue buffer becomes filled to
the configured percentage.

Assured forwarding traffic with the PLP (packet loss priority) bit set is more likely to
be discarded than traffic without the PLP bit set. This example shows how to configure
a drop probability and a queue fill level for both PLP and non-PLP assured forwarding
traffic. It is only one example of how to use RED drop profiles.

The example shows how to configure the RED drop profiles listed in Table 209 on
page 854.

Table 209:  Sample RED Drop Profiles

Queue Fill LevelDrop ProbabilityDrop Profile

Between 95 and 100 percentBetween 0 (never dropped) and
100 percent (always dropped)

af-normal—For non-PLP (normal) assured
forwarding traffic

Between 80 and 95 percentBetween 95 and 100 percent (always
dropped)

af-with-plp—For PLP (aggressive packet
dropping) assured forwarding traffic

To configure RED drop profiles for assured forwarding congestion control on the
device:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 210 on page 855.

3. If you are finished configuring the device, commit the configuration.

4. Go on to one of the following tasks:

■ To assign resources, priorities, and profiles to output queues, see “Configuring
Schedulers” on page 857.

■ To apply rules to logical interfaces, see “Configuring and Applying Virtual
Channels” on page 864.

■ To use adaptive shapers to limit bandwidth for Frame Relay, see “Configuring
Adaptive Shaping for Frame Relay” on page 875.

■ To check the configuration, see “Verifying a CoS Configuration” on page 941.
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Table 210: Configuring RED Drop Profiles for Assured Forwarding Congestion Control

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit class-of-service

1. In the J-Web interface, select Configure>CLI Tools>Point
and Click CLI.

2. Next to Class of service, click Configure or Edit.

Navigate to the Class of
service level in the
configuration hierarchy.

Enter

edit drop-profiles af-normal
interpolate

set drop-probability 0

set drop-probability 100

1. Click Add new entry next to Drop profiles.

2. In the Profile name box, type the name of the drop
profile—for example, af-normal.

3. Click Configure next to Interpolate.

4. Click Add new entry next to Drop probability.

5. In the Value box, type a number for the first drop point—for
example, 0.

6. Click OK.

7. Click Add new entry next to Drop probability again.

8. In the Value box, type a number for the next drop point—for
example, 100.

9. Click OK.

Configure the lower drop
probability for normal,
non-PLP traffic.

Enter

set fill-level 95

set fill-level 100

1. Click Add new entry next to Fill level.

2. In the Value box, type a number for the first fill level—for
example, 95.

3. Click OK.

4. Click Add new entry next to Fill level.

5. In the Value box, type a number for the next fill level—for
example, 100.

6. Click OK three times.

Configure a queue fill level
for the lower non-PLP drop
probability.

From the [edit class of
service] hierarchy level,
enter

edit drop-profiles af-with-PLP
interpolate

set drop-probability 95

set drop-probability 100

1. Click Add new entry next to Drop profiles.

2. In the Profile name box, type the name of the drop
profile—for example, af-with-plp.

3. Click Configure next to Interpolate.

4. Click Add new entry next to Drop probability.

5. In the Value box, type a number for the first drop point—for
example, 95.

6. Click OK.

7. Click Add new entry next to Drop probability.

8. In the Value box, type a number for the next drop point—for
example, 100.

9. Click OK.

Configure the higher drop
probability for PLP traffic.

Configuring CoS Components with a Configuration Editor ■ 855

Chapter 33: Configuring Class of Service



Table 210: Configuring RED Drop Profiles for Assured Forwarding Congestion Control  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set fill-level 80

set fill-level 95

1. Click Add new entry next to Fill level.

2. In the Value box, type a number for the first fill level—for
example, 80.

3. Click OK.

4. Click Add new entry next to Fill level.

5. In the Value box, type a number for the next fill level—for
example, 95.

6. Click OK.

Configure a queue fill level
for the higher PLP drop
probability.

Example: Configuring RED Drop Profiles

Create a segmented configuration and an interpolated configuration that correspond
to the graphs in Figure 94 on page 856. The values defined in the configuration are
matched to represent the data points in the graph line. In this example, the drop
probability is 25 percent when the queue is 50 percent full. The drop probability
increases to 50 percent when the queue is 75 percent full.

Figure 94: Segmented and Interpolated Drop Profiles

Segmented class-of-service {
drop-profiles {

segmented-style-profile {
fill-level 25 drop-probability 25;
fill-level 50 drop-probability 50;
fill-level 75 drop-probability 75;
fill-level 95 drop-probability 100;

}
}

}
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To create the profile’s graph line, the software begins at the bottom-left corner,
representing a 0 percent fill level and a 0 percent drop probability. This configuration
draws a line directly to the right until it reaches the first defined fill level, 25 percent
for this configuration. The software then continues the line vertically until the first
drop probability is reached. This process is repeated for all of the defined levels and
probabilities until the top-right corner of the graph is reached.

Create a smoother graph line by configuring the profile with the interpolate statement.
This allows the software to automatically generate 64 data points on the graph
beginning at (0, 0) and ending at (100, 100). Along the way, the graph line intersects
specific data points, which you define as follows:

Interpolated class-of-service {
drop-profiles {

interpolated-style-profile {
interpolate {

fill-level [ 50 75 ];
drop-probability [ 25 50 ];

}
}

}
}

Configuring Schedulers

You configure schedulers to assign resources, priorities, and drop profiles to output
queues. By default, only queues 0 and 3 have resources assigned.

NOTE: SRX Series devices support hierarchical schedulers, including
per-unit-schedulers. For more information, see “Configuring CoS Hierarchical
Schedulers” on page 910.

This example creates the schedulers listed in Table 211 on page 857.

Table 211: Sample Schedulers

Assigned Bandwidth
(Transmit Rate)

Allocated Portion of
Queue Buffer

Assigned
PriorityFor CoS Traffic TypeScheduler

10 percent40 percentLowBest-effort trafficbe-scheduler

10 percent10 percentHighExpedited forwarding trafficef-scheduler

45 percent45 percentHighAssured forwarding trafficaf-scheduler

5 percent5 percentLowNetwork control trafficnc-scheduler

To configure schedulers for the device:
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1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 212 on page 858.

3. Go on to “Configuring and Applying Scheduler Maps” on page 860.

Table 212: Configuring Schedulers

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit class-of-service

1. In the J-Web interface, select Configure>CLI Tools>Point
and Click CLI.

2. Next to Class of service, click Configure or Edit.

Navigate to the Class of
service level in the
configuration hierarchy.

Enter

edit schedulers be-scheduler

1. Click Add new entry next to Schedulers.

2. In the Scheduler name box, type the name of the best-effort
scheduler—for example, be-scheduler.

Configure a best-effort
scheduler.

Enter

set priority low

set buffer-size percent 40

1. In the Priority box, type low.

2. Click Configure next to Buffer size.

3. From the Buffer size choice list, select the basis for the
buffer allocation method—for example, Percent.

4. In the Percent box, type the percentage of the buffer to be
used by the best-effort scheduler—for example, 40.

5. Click OK.

Configure a best-effort
scheduler priority and buffer
size.

Enter

set transmit-rate percent 10

1. Click Configure next to Transmit rate.

2. From the Transmit rate choice list, select the basis for the
transmit rate method—for example, Percent.

3. In the Percent box, type the percentage of the bandwidth
to be used by the best-effort scheduler—for example, 10.

4. Click OK twice.

Configure a best-effort
scheduler transmit rate.

From the [edit class of
service] hierarchy level,
enter

edit schedulers ef-scheduler

1. Click Add new entry next to Schedulers.

2. In the Scheduler name box, type the name of the expedited
forwarding scheduler—for example, ef-scheduler.

Configure an expedited
forwarding scheduler.

Enter

set priority high

set buffer-size percent 10

1. In the Priority box, type high.

2. Click Configure next to Buffer size.

3. From the Buffer size choice list, select the basis for the
buffer allocation method—for example, Percent.

4. In the Percent box, type the percentage of the buffer to be
used by the expedited forwarding scheduler—for example,
10.

5. Click OK.

Configure an expedited
forwarding scheduler priority
and buffer size.
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Table 212: Configuring Schedulers (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set transmit-rate percent 10

1. Click Configure next to Transmit rate.

2. From the Transmit rate choice list, select the basis for the
transmit rate method—for example, Percent.

3. In the Percent box, type the percentage of the bandwidth
to be used by the expedited forwarding scheduler—for
example, 10.

4. Click OK twice.

Configure an expedited
forwarding scheduler transmit
rate.

From the [edit class of
service] hierarchy level,
enter

edit schedulers af-scheduler

1. Click Add new entry next to Schedulers.

2. In the Scheduler name box, type the name of the assured
forwarding scheduler—for example, af-scheduler.

Configure an assured
forwarding scheduler.

Enter

set priority high

set buffer-size percent 45

1. In the Priority box, type high.

2. Click Configure next to Buffer size.

3. From the Buffer size choice list, select the basis for the
buffer allocation method—for example, Percent.

4. In the Percent box, type the percentage of the buffer to be
used by the assured forwarding scheduler—for example,
45.

5. Click OK.

Configure an assured
forwarding scheduler priority
and buffer size.

Enter

set transmit-rate percent 45

1. Click Configure next to Transmit rate.

2. From the Transmit rate choice list, select the basis for the
transmit rate method—for example, Percent.

3. In the Percent box, type the percentage of the bandwidth
to be used by the assured forwarding scheduler—for
example, 45.

4. Click OK.

Configure an assured
forwarding scheduler transmit
rate.

Enter

set drop-profile-map
loss-priority low protocol any
drop-profile af-normal

set drop-profile-map
loss-priority high protocol
any drop-profile af-with-PLP

1. Click Add new entry next to Drop profile map.

2. From the Loss priority box, select Low.

3. From the Protocol box, select Any.

4. In the Drop profile box, type the name of the drop
profile—for example, af-normal.

5. Click OK.

6. Click Add new entry next to Drop profile map.

7. From the Loss priority box, select High.

8. From the Protocol box, select Any.

9. In the Drop profile box, type the name of the drop
profile—for example, af-with-PLP.

10. Click OK twice.

(Optional) Configure a drop
profile map for assured
forwarding low and high
priority. (DiffServ can have a
RED drop profile associated
with assured forwarding.)
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Table 212: Configuring Schedulers (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit class of
service] hierarchy level,
enter

edit schedulers nc-scheduler

1. Click Add new entry next to Schedulers.

2. In the Scheduler name box, type the name of the network
control scheduler—for example, nc-scheduler.

Configure a network control
scheduler.

Enter

set priority low

set buffer-size percent 5

1. In the Priority box, type low.

2. Click Configure next to Buffer size.

3. From the Buffer size choice list, select the basis for the
buffer allocation method—for example, Percent.

4. In the Percent box, type the percentage of the buffer to be
used by the network control scheduler—for example, 5.

5. Click OK.

Configure a network control
scheduler priority and buffer
size.

Enter

set transmit-rate percent 5

1. Click Configure next to Transmit rate.

2. From the Transmit rate choice list, select the basis for the
transmit rate method—for example, Percent.

3. In the Percent box, type the percentage of the bandwidth
to be used by the network control scheduler—for example,
5.

4. Click OK.

Configure a network control
scheduler transmit rate.

Configuring and Applying Scheduler Maps

You configure a scheduler map to assign a forwarding class to a scheduler, then apply
the scheduler map to any interface that must enforce DiffServ CoS.

The following example shows how to create the scheduler map diffserv-cos-map and
apply it to the device's Ethernet interface ge-0/0/0. The map associates the
mf-classifier forwarding classes configured in “Configuring and Applying a Firewall
Filter for a Multifield Classifier” on page 835 to the schedulers configured in
“Configuring Schedulers” on page 857, as shown in Table 213 on page 860.

Table 213: Sample diffserv-cos-map Scheduler Mapping

diffserv-cos-map SchedulerFor CoS Traffic Typemf-classifier Forwarding Class

be-schedulerBest-effort trafficbe-class

ef-schedulerExpedited forwarding trafficef-class

af-schedulerAssured forwarding trafficaf-class

nc-schedulerNetwork control trafficnc-class

860 ■ Configuring CoS Components with a Configuration Editor

JUNOS Software Interfaces and Routing Configuration Guide



To configure and apply scheduler maps:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 214 on page 861.

3. If you are finished configuring the device, commit the configuration.

4. Go on to one of the following tasks:

■ To apply rules to logical interfaces, see “Configuring and Applying Virtual
Channels” on page 864.

■ To use adaptive shapers to limit bandwidth for Frame Relay, see “Configuring
Adaptive Shaping for Frame Relay” on page 875.

■ To check the configuration, see “Verifying a CoS Configuration” on page 941.

Table 214: Configuring Scheduler Maps

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click
Configure or Edit.

Navigate to the Class of service level in
the configuration hierarchy.

Enter

edit scheduler-maps diffserv-cos-map

1. Click Add new entry next to
Scheduler maps.

2. In the Map name box, type the
name of the scheduler map—for
example, diffserv-cos-map.

Configure a scheduler map for DiffServ
CoS.

Enter

set forwarding-class be-class scheduler
be-scheduler

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
best-effort forwarding
class—be-class.

3. In the Scheduler box, type the
name of the previously configured
best-effort scheduler—be-scheduler.

4. Click OK.

Configure a best-effort forwarding class
and scheduler.
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Table 214: Configuring Scheduler Maps (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set forwarding-class ef-class scheduler
ef-scheduler

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
expedited forwarding
class—ef-class.

3. In the Scheduler box, type the
name of the previously configured
expedited forwarding
scheduler—ef-scheduler.

4. Click OK.

Configure an expedited forwarding class
and scheduler.

Enter

set forwarding-class af-class scheduler
af-scheduler

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
assured forwarding class—af-class.

3. In the Scheduler box, type the
name of the previously configured
assured forwarding
scheduler—af-scheduler.

4. Click OK.

Configure an assured forwarding class
and scheduler.

Enter

set forwarding-class nc-class scheduler
nc-scheduler

1. Click Add new entry next to
Forwarding class.

2. In the Class name box, type the
name of the previously configured
network control class—nc-class.

3. In the Scheduler box, type the
name of the previously configured
network control
scheduler—nc-scheduler.

4. Click OK twice.

Configure a network control class and
scheduler.

From the [edit class of service] hierarchy
level, enter

set interfaces ge-0/0/0 scheduler-map
diffserv-cos-map

1. Click Add new entry next to
Interfaces.

2. In the Interface name box, type the
name of the interface—for
example, ge-0/0/0.

3. Click Add new entry next to Unit.

4. In the Unit number box, type the
logical interface unit number—0.

5. In the Scheduler map box, type the
name of the previously configured
scheduler map—diffserv-cos-map.

6. Click OK.

Apply the scheduler map to an interface.

(See the interface naming conventions
in Junos OS Interfaces Configuration Guide
for Security Devices.)
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Scheduler Maps: Sample Configuration

Once you define a scheduler, you can include it in a scheduler map, which maps a
specified forwarding class to a scheduler configuration. To do this, include the
scheduler-maps statement at the [edit class-of-service] hierarchy level:

[edit class-of-service]
scheduler-maps {

map-name {
forwarding-class class-name scheduler scheduler-name;

}
}

After you have defined the scheduler map, you can associate it with an output
interface. To do this, include the scheduler-map statement at the [edit class-of-service
interfaces interface-name] hierarchy level:

[edit class-of-service interfaces interface-name]
scheduler-map map-name;

Interface wildcards are supported.

Schedulers: Sample Configuration

You use schedulers to define the properties of output queues. These properties include
the amount of interface bandwidth assigned to the queue, the size of the memory
buffer allocated for storing packets, the priority of the queue, and the random early
detection (RED) drop profiles associated with the queue.

You associate the schedulers with forwarding classes by means of scheduler maps.
You can then associate each scheduler map with an interface, thereby configuring
the hardware queues, packet schedulers, and RED processes that operate according
to this mapping.

To configure class-of-service (CoS) schedulers, use the following sample configuration
at the [edit class-of-service] hierarchy level:

[edit class-of-service]
interfaces {

interface-name {
scheduler-map map-name;
scheduler-map-chassis map-name;
schedulers number;
shaping-rate rate;
unit {

output-traffic-control-profile profile-name;
scheduler-map map-name;
shaping-rate rate;

}
}

}
fabric {

scheduler-map {
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priority (high | low) scheduler scheduler-name;
}

}
scheduler-maps {

map-name {
forwarding-class class-name scheduler scheduler-name;

}
}
schedulers {

scheduler-name {
buffer-size (percent percentage | remainder | temporal microseconds );
drop-profile-map loss-priority (any | low | medium-low | medium-high | high) protocol

(any | non-tcp | tcp) drop-profile profile-name;
priority priority-level;
transmit-rate (rate  | percent percentage remainder) <exact | rate-limit>;

}
}
traffic-control-profiles profile-name {

delay-buffer-rate (percent percentage | rate);
guaranteed-rate (percent percentage | rate);
scheduler-map map-name;
shaping-rate (percent percentage | rate);

}

NOTE: For J Series devices and SRX210, SRX240, and SRX650 devices, when
configuring the “protocol parameter” in the drop-profile-map statement, tcp and
non-tcp values are not supported, only the value “any” is supported.

Configuring and Applying Virtual Channels

You configure a virtual channel to set up queuing, packet scheduling, and accounting
rules to be applied to one or more logical interfaces. You then must apply the virtual
channel to a particular logical interface. Virtual channels can be applied in different
ways. For more information on virtual channels, see “Configuring Virtual Channels”
on page 869. In the example here, an output firewall filter is used for directing traffic
to a particular virtual channel.

The following example shows how to create the virtual channels branch1–vc,
branch2–vc, and branch3–vc and apply them in the firewall filter choose-vc to the
Services Router's T3 interface t3-1/0/0.

To configure and apply virtual channels for the Services Router:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 215 on page 865.

3. If you are finished configuring the router, commit the configuration.

4. Go on to one of the following tasks:

■ To assign resources, priorities, and profiles to output queues, see “Configuring
Schedulers” on page 857.
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■ To use adaptive shapers to limit bandwidth for Frame Relay, see “Configuring
Adaptive Shaping for Frame Relay” on page 875.

■ To check the configuration, see “Verifying a CoS Configuration” on page 941.

Table 215: Configuring and Applying Virtual Channels

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click
Configure or Edit.

Navigate to the Class of service level in
the configuration hierarchy.

1. Enter

set virtual-channels branch1–vc

2. Repeat this statement for
branch2–vc, branch3–vc, and
default-vc.

1. Click Add new entry next to Virtual
channels.

2. In the Channel name box, type the
name of the virtual channel—for
example, branch1–vc.

3. Click OK.

4. Create additional virtual channels
for branch2–vc, branch3–vc, and
default-vc.

Define the virtual channels branch1–vc,
branch2–vc, branch3–vc, and the default
virtual channel. You must specify a
default virtual channel.

1. Enter

set virtual-channel-groups
wan-vc-group branch1–vc
scheduler-map bestscheduler

2. Repeat this statement for
branch2–vc, branch3–vc, and
default-vc.

3. Enter

set virtual-channel-groups
wan-vc-group default–vc default

1. Click Add new entry next to Virtual
channel groups.

2. In the Group name box, type the
name of the virtual channel
group—wan-vc-group.

3. Click Add new entry next to
Channel.

4. In the Channel name box, type the
name of the previously configured
virtual channels—branch1–vc.

5. In the Scheduler map box, type the
name of the previously configured
scheduler map—bestscheduler.

6. Click OK.

7. Add the virtual channels
branch2–vc, branch3–vc, and
default-vc. Select the Default box
when adding the virtual channel
default-vc.

Define the virtual channel group
wan-vc-group to include the four virtual
channels, and assign each virtual
channel the scheduler map
bestscheduler.
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Table 215: Configuring and Applying Virtual Channels (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. Enter

set virtual-channel-groups
wan-vc-group branch1–vc shaping-rate
2m

2. Repeat this statement for
branch2–vc and branch3–vc.

1. Click branch1–vc in the list of
virtual channels.

2. Select the Shaping rate box.

3. Click Configure.

4. Select Absolute rate from the Rate
choice box.

5. In the Absolute rate box, type the
shaping rate—2m.

6. Add the shaping rate for the
branch2–vc and branch3–vc virtual
channels.

7. Click OK three times.

Specify a shaping rate of 2 Mbps for
each virtual channel within the virtual
channel group.

From the [edit class of service] hierarchy
level, enter

set interfaces t3–1/0/0 unit 0
virtual-channel-group wan-vc-group

1. Click Add new entry next to
Interfaces.

2. In the Interface name box, type the
name of the interface—t3–1/0/0.

3. Click Add new entry next to Unit.

4. In the Unit number box, type the
logical interface unit number—0.

5. In the Virtual channel group box,
type the name of the previously
configured virtual channel
group—wan-vc-group.

6. Click OK.

Apply the virtual channel group to the
logical interface t3–1/0/0.0.

(See the interface naming conventions
in Junos OS Interfaces Configuration Guide
for Security Devices.)
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Table 215: Configuring and Applying Virtual Channels (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

1. From the [edit] hierarchy level, enter

edit firewall

2. Enter

set family inet filter choose-vc term
branch1 from destination
192.168.10.0/24

3. Enter

set family inet filter choose-vc term
branch1 then accept

4. Enter

set family inet filter choose-vc term
branch1 then virtual-channel
branch1–vc

5. Repeat these steps for virtual
channels branch2–vc and
branch3–vc.

1. On the main Configuration page
next to Firewall, click Configure or
Edit.

2. Click Add new entry next to Filter.

3. In the Filter name box, type the
name of the firewall
filter—choose-vc.

4. Click Add new entry next to Term.

5. In the Rule name box, type the
name of the firewall
term—branch1.

6. Click Configure next to From.

7. Click Add new entry next to
Destination address.

8. In the Address box, type the IP
address of the destination
host—192.168.10.0/24.

9. Click OK twice.

10. On the firewall term page, click
Configure next to Then.

11. Select Accept from the Designation
box.

12. In the Virtual channel box, type the
name of the previously configured
virtual channel—branch1–vc.

13. Click OK.

14. Repeat these steps for the virtual
channels branch2–vc and
branch3–vc.

Create the firewall filter choose-vc to
select the traffic that is transmitted on
a particular virtual channel.

1. From the [edit] hierarchy level, enter

edit interfaces

2. Enter

set t3–1/0/0 unit 0 family inet filter
output choose-vc

1. On the main Configuration page
next to Interfaces, click Configure
or Edit.

2. Click t3–1/0/0 in the list of
configured interfaces.

3. Click 0 in the list of configured
logical units for the interface.

4. Click Edit next to Inet.

5. Click Configure next to Filter.

6. In the Output box, type the name
of the previously configured firewall
filter—choose–vc.

7. Click OK.

Apply the firewall filter choose-vc to
output traffic on the t3–1/0/0.0
interface.
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Configuring and Applying an Adaptive Shaper

You can use adaptive shaping to limit the bandwidth of traffic flowing on a Frame
Relay logical interface. If you configure and apply adaptive shaping, the device checks
the backward explicit congestion notification (BECN) bit within the last inbound
(ingress) packet received on the interface. For more information on adaptive shaping,
see “Configuring Adaptive Shaping for Frame Relay” on page 875.

NOTE: Adaptive shaping is not available on SRX3400, SRX3600, SRX5600, and
SRX5800 devices.

The following example shows how to create an adaptive shaper fr-shaper and apply
it to the device's T1 interface t1-0/0/2. The adapter shaper limits the transmit
bandwidth on the interface to 64 Kbps.

To configure and apply an adaptive shaper for the device:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 216 on page 868.

3. If you are finished configuring the device, commit the configuration.

4. Go on to one of the following tasks:

■ To assign resources, priorities, and profiles to output queues, see “Configuring
Schedulers” on page 857.

■ To apply rules to logical interfaces, see “Configuring and Applying Virtual
Channels” on page 864.

■ To check the configuration, see “Verifying a CoS Configuration” on page 941.

Table 216: Configuring and Applying an Adaptive Shaper

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service

1. In the J-Web interface, select
Configure>CLI Tools>Point and
Click CLI.

2. Next to Class of service, click
Configure or Edit.

Navigate to the Class of service level in
the configuration hierarchy.
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Table 216: Configuring and Applying an Adaptive Shaper (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set adaptive-shapers fr-shaper trigger becn
shaping-rate 64k

1. Next to Adaptive Shapers, click Add
new entry.

2. In the Adaptive shaper name box,
type fr-shaper.

3. Next to Trigger, click Add new
entry.

4. Next to Becn, select the check box.

5. Next to Shaping rate, select the
check box and click Configure.

6. From the Rate choice list, select
Absolute rate.

7. In the Absolute rate box, type 64k.

8. Click OK three times.

Define the adaptive shaper name and
maximum transmit rate.

Enter

set interfaces t1-0/0/2 unit 0
adaptive-shaper fr-shaper

1. Next to Interfaces, click Add new
entry.

2. In the Interface name box, type the
name of the interface—t1-0/0/2.

3. Next to Unit, click Add new entry.

4. In the Unit number box, type the
logical interface unit number—0.

5. In the Adaptive shaper box, type
the name of the adaptive
shaper—fr-shaper.

6. Click OK.

Apply the adaptive shaper to the logical
interface t1-0/0/2.0.

(See the interface naming conventions
in Junos OS Interfaces Configuration Guide
for Security Devices.)

Configuring Virtual Channels

For J Series devices and SRX210, SRX240, and SRX650 devices, you can configure
virtual channels, which allow you to limit traffic sent from a corporate headquarters
to branch offices. Virtual channels might be required when the headquarters site has
an expected aggregate bandwidth higher than that of the individual branch offices.
The router at the headquarters site must limit the traffic sent to each of the branch
office routers to avoid oversubscribing their links. For instance, if branch 1 has a
1.5-megabits per second (Mbps) link and the headquarters router attempts to send
6 Mbps to branch 1, all of the traffic in excess of 1.5 Mbps is dropped in the ISP
network.

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.
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This chapter discusses the following topics:

■ Configuring CoS Virtual Channels on page 870

■ Creating a List of Virtual Channel Names on page 871

■ Defining a Virtual Channel Group on page 871

■ Applying a Virtual Channel Group to a Logical Interface on page 872

■ Selecting Traffic to Be Transmitted from a Particular Virtual Channel on page 873

■ Example: Configuring Virtual Channels on page 873

Configuring CoS Virtual Channels

To limit the traffic the headquarters router sends to each branch, you can configure
virtual channels on a logical interface. Each virtual channel has a set of eight queues
with a scheduler and an optional shaper. You can use an output firewall filter to direct
traffic to a particular virtual channel. For example, a filter can direct all traffic with
a destination address for branch office 1 to virtual channel 1, and all traffic with a
destination address for branch office 2 to virtual channel  2.

When you configure virtual channels on an interface, the virtual channel group uses
the same scheduler and shaper you configure at the [edit interfaces interface-name
unit logical-unit-number] hierarchy level. In this way, virtual channels are an extension
of regular scheduling and shaping and not an independent entity.

Although a virtual channel group is assigned to a logical interface, a virtual channel
is not the same as a logical interface. The only features supported on a virtual channel
are queuing, packet scheduling, and accounting. Rewrite rules and routing protocols
apply to the entire logical interface.

To configure virtual channels, you can include the following statements at the
[edit class-of-service], [edit firewall], and [edit interfaces] hierarchy levels of the
configuration:

[edit class-of-service]
virtual-channels {

virtual-channel-name;
}
virtual-channel-groups {

virtual-channel-group-name {
virtual-channel-name {

scheduler-map map-name;
shaping-rate (percent percentage | rate);
default;

}
}

}
interfaces {

interface-name {
unit logical-unit-number {

virtual-channel-group virtual-channel-group-name;
}

}
}
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[edit firewall]
family family-name {

filter filter-name {
term term-name {

then {
virtual-channel virtual-channel-name;

}
}

}
}

[edit interfaces]
interface-name {

per-unit-scheduler;
}

Creating a List of Virtual Channel Names

To create a list of virtual channels that you can assign to a virtual channel group,
include the virtual-channels statement at the [edit class-of-service] hierarchy level:

[edit class-of-service]
virtual-channels {

virtual-channel-name;
}

Defining a Virtual Channel Group

To define a virtual channel group that you can assign to a logical interface, include
the virtual-channel-groups statement at the [edit class-of-service] hierarchy level:

[edit class-of-service]
virtual-channel-groups {

virtual-channel-group-name {
virtual-channel-name {

scheduler-map map-name;
shaping-rate (percent percentage | rate);
default ;

}
}

}

virtual-channel-group-name can be any name that you want. virtual-channel-name must
be one of the names that you define at the [edit class-of-service virtual-channels]
hierarchy level. You can include multiple virtual channel names in a group.

The scheduler map is required. map-name must be one of the scheduler maps that
you configure at the [edit class-of-service scheduler-maps] hierarchy level. For more
information, see “Configuring Schedulers” on page 857.

The shaping rate is optional. If you configure the shaping rate as a percentage, when
the virtual channel is applied to a logical interface, the shaping rate is set to the
specified percentage of the interface bandwidth. If you configure a shaper on a virtual
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channel, the shaper limits the maximum bandwidth transmitted by that virtual
channel. Virtual channels without a shaper can use the full logical interface bandwidth.
If there are multiple unshaped virtual channels, they share the available logical
interface bandwidth equally.

When you apply the virtual channel group to a logical interface, a set of eight queues
is created for each of the virtual channels in the group. The scheduler-map statement
applies a scheduler to these queues. If you include the shaping-rate statement, a
shaper is applied to the entire virtual channel.

You must configure one of the virtual channels in the group to be the default channel.
Therefore, the default statement is required in the configuration of one virtual channel
per channel group. Any traffic not explicitly directed to a particular channel is
transmitted by this default virtual channel.

Applying a Virtual Channel Group to a Logical Interface

To apply a virtual channel group to a logical interface, include the virtual-channel-group
statement at the [edit class-of-service interfaces interface-name unit logical-unit-number]
hierarchy level:

[edit class-of-service interfaces interface-name unit logical-unit-number]
virtual-channel-group virtual-channel-group-name;

For the corresponding physical interface, you must also include the per-unit-scheduler
statement at the [edit interfaces interface-name] hierarchy level:

[edit interfaces interface-name]
per-unit-scheduler;

The per-unit-scheduler statement enables one set of output queues for each logical
interface configured under the physical interface.

When you apply a virtual channel group to a logical interface, the software creates
a set of eight queues for each of the virtual channels in the group.

If you apply a virtual channel group to multiple logical interfaces, the software creates
a set of eight queues on each logical interface. The virtual channel names listed in
the group are used on all the logical interfaces. We recommend specifying the
scheduler and shaping rates in the virtual channel configuration in terms of
percentages, rather than absolute rates. This allows you to apply the same virtual
channel group to logical interfaces that have different bandwidths.

When you apply a virtual channel group to a logical interface, you cannot include
the scheduler-map and shaping-rate statements at the [edit class-of-service interfaces
interface-name unit logical-unit-number] hierarchy level. In other words, you can
configure a scheduler map and a shaping rate on a logical interface, or you can
configure virtual channels on the logical interface, but not both.

If you configure multiple logical interfaces on a single physical interface, each logical
interface is guaranteed an equal fraction of the physical interface bandwidth:

logical-interface-bandwidth =
physical-interface-bandwidth / number-of-logical-interfaces
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If one or more logical interfaces do not completely use their allocation, the other
logical interfaces share the excess bandwidth equally.

If you configure multiple virtual channels on a logical interface, they are each
guaranteed an equal fraction of the logical interface bandwidth:

virtual-channel-bandwidth =
logical-interface-bandwidth / number-of-virtual-channels

If you configure a shaper on a virtual channel, the shaper limits the maximum
bandwidth transmitted by that virtual channel. Virtual channels without a shaper can
use the full logical interface bandwidth. If there are multiple unshaped virtual channels,
they share the available logical interface bandwidth equally.

Selecting Traffic to Be Transmitted from a Particular Virtual Channel

To select the traffic to be transmitted by a particular virtual channel, include the
virtual-channel statement at the [edit firewall family family-name filter filter-name term 
term-name then] hierarchy level:

[edit firewall family family-name filter filter-name term term-name then]
virtual-channel virtual-channel-name;

The virtual-channel statement is a firewall action modifier. For more information
about firewall action modifiers, see the Junos Policy Framework Configuration Guide.

Example: Configuring Virtual Channels

This configuration creates four virtual channels on the interface t3-1/0/0.0. Three
of them (branch1-vc, branch2-vc, and branch3-vc) are shaped to 1.5 Mbps. The fourth
virtual channel is the default (default-vc), and it is not shaped, so it can use the full
interface bandwidth. The output filter on the interface sends all traffic with a
destination address matching 192.168.10.0/24 to branch1-vc, and similar
configurations are set for branch2-vc and branch3-vc. Traffic not matching any of the
addresses goes to the default, unshaped virtual channel.

class-of-service {
interfaces {

t3-1/0/0 {
unit 0 {

virtual-channel-group wan-vc-group;
}

}
}
virtual-channels {

branch1-vc;
branch2-vc;
branch3-vc;
default-vc;

}
virtual-channel-groups {

wan-vc-group {
branch1-vc {

scheduler-map interface-global;
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shaping-rate 1.5m;
}
branch2-vc {

scheduler-map interface-global;
shaping-rate 1.5m;

}
branch3-vc {

scheduler-map interface-global;
shaping-rate 1.5m;

}
default-vc {

scheduler-map interface-global;
default;

}
}

}
}
firewall {

family inet {
filter choose-vc {

term branch1 {
from {

destination 192.168.10.0/24;
}
then {

accept;
virtual-channel branch1-vc;

}
}
term branch2 {

from {
destination 192.168.11.0/24;

}
then {

accept;
virtual-channel branch2-vc;

}
}
term branch3 {

from {
destination 192.168.12.0/24;

}
then {

accept;
virtual-channel branch3-vc;

}
}
term default {

then {
accept;

}
}

}
}

}
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interfaces {
t3-1/0/0 {

per-unit-scheduler;
unit 0 {

family inet {
filter output choose-vc;

}
}

}
}

Configuring Adaptive Shaping for Frame Relay

For J Series devices and SRX210, SRX240, and SRX650 devices, you can configure
adaptive shapers, which allow you to shape Frame Relay logical interfaces to a
maximum rate, based on congestion. Adaptive shaping is triggered by the backward
explicit congestion notification (BECN) bit in Frame Relay packet headers. Thus,
adaptive shaping allows you to use the information provided in Frame Relay packet
headers to detect possible congestion and to adjust your bandwidth limitation
accordingly.

Adaptive shaping is triggered when the last ingress packet on the logical interface
has its BECN bit set to 1. When adaptive shaping is triggered, the output queues on
the logical interface are shaped according to the adaptive shaper configuration.

Adaptive shaping is an alternative to regular logical interface shaping. If the last
ingress packet has its BECN bit set to 0, the logical interface queues are shaped
according to the shaping-rate statement at the [edit class-of-service interfaces
interface-name unit logical-unit-number] hierarchy level, which should be configured
at a higher rate than the rate you configure for the adaptive shaper. If you do not
include the shaping-rate statement in the configuration, the default logical interface
bandwidth is the average of unused bandwidth for the number of logical interfaces
that require default bandwidth treatment. For more information about shaping rates
and bandwidth sharing, see “Configuring Excess Bandwidth Sharing” on page 937.

To configure an adaptive shaper, you can include the following statements at the
[edit class-of-service] hierarchy level of the configuration:

[edit class-of-service]
adaptive-shapers {

adaptive-shaper-name {
trigger type shaping-rate (percent percentage | rate);

}
}
interfaces {

interface-name {
unit logical-unit-number {

adaptive-shaper adaptive-shaper-name;
}

}
}
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NOTE: For more information on configuring and applying an adaptive shaper using
the configuration editor, see “Configuring and Applying an Adaptive Shaper” on
page 868.

Configuring an Adaptive Shaper

To configure an adaptive shaper, include the adaptive-shapers statement at the
[edit class-of-service] hierarchy level:

[edit class-of-service]
adaptive-shapers {

adaptive-shaper-name {
trigger type shaping-rate (percent percentage | rate);

}
}

The trigger type can be becn only. If the last ingress packet on the logical interface
has its BECN bit set to 1, the output queues on the logical interface are shaped
according to the associated shaping rate.

The associated shaping rate can be a percentage of the available interface bandwidth
from 0 through 100 percent. Alternatively, you can configure the shaping rate to be
an absolute peak rate, in bits per second (bps) from 3200 through
32,000,000,000 bps. You can specify the value either as a complete decimal number
or as a decimal number followed by the abbreviation k (1000), m (1,000,000), or
g (1,000,000,000).

Applying an Adaptive Shaper to a Logical Interface

To apply an adaptive shaper to a logical interface, include the adaptive-shaper
statement at the [edit class-of-service interfaces interface-name unit logical-unit-number]
hierarchy level:

[edit class-of-service interfaces interface-name unit logical-unit-number]
adaptive-shaper adaptive-shaper-name;

Classifying Frame Relay Traffic

For J Series and SRX210, SRX240, and SRX650 device interfaces with Frame Relay
encapsulation, you can set the loss priority of Frame Relay traffic, based on the
discard eligibility (DE) bit. For each incoming frame with the DE bit containing the
CoS value 0 or 1, you can configure a Frame Relay loss priority value of low,
medium-low, medium-high, or high.

You can apply a classifier to the same interface on which you configure a Frame
Relay loss priority value. The Frame Relay loss priority map is applied first, followed
by the classifier. The classifier can change the loss priority to a higher value only (for
example, from low to high). If the classifier specifies a loss priority with a lower value
than the current loss priority of a particular packet, the classifier does not change
the loss priority of that packet.
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This section is organized as follows:

■ Assigning the Default Frame Relay Loss Priority Map to an Interface on page 877

■ Defining a Custom Frame Relay Loss Priority Map on page 877

■ Verifying Your Configuration on page 878

Assigning the Default Frame Relay Loss Priority Map to an Interface

The default Frame Relay loss priority map contains the following settings:

loss-priority low code-point 0;
loss-priority high code-point 1;

This default map sets the loss priority to low for each incoming frame with the DE
bit containing the 0 CoS value. The map sets the loss priority to high for each incoming
frame with the DE bit containing the 1 CoS value.

To assign the default map to an interface, include the frame-relay-de default statement
at the [edit class-of-service interfaces interface-name unit logical-unit-number
loss-priority-maps] hierarchy level:

[edit class-of-service interfaces interface-name unit logical-unit-number
loss-priority-maps]

frame-relay-de default;

Defining a Custom Frame Relay Loss Priority Map

To define a custom Frame Relay loss priority map, include the following statements
at the [edit class-of-service] hierarchy level:

[edit class-of-service]
loss-priority-maps {

frame-relay-de map-name {
loss-priority (low | medium-low | medium-high | high) code-point (0 | 1);

}
}

A custom loss priority map sets the loss priority to low, medium-low, medium-high, or
high for each incoming frame with the DE bit containing the specified 0 or 1 CoS
value.

Applying the Map to a Logical Interface

The map does not take effect until you apply it to a logical interface. To apply a map
to a logical interface, include the frame-relay-de map-name statement at the [edit
class-of-service interfaces interface-name unit logical-unit-number loss-priority-maps]
hierarchy level:

[edit class-of-service interfaces interface-name unit logical-unit-number
loss-priority-maps]

frame-relay-de map-name;
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Verifying Your Configuration

To verify your configuration, you can issue the following operational mode commands:

■ show class-of-service forwarding-table loss-priority-map

■ show class-of-service forwarding-table loss-priority-map mapping

■ show chassis forwarding

■ show pfe fwdd

NOTE: On J Series devices, show commands might still display a loss-priority-map
as applied to an interface even if the commit configuring it fails.

Rewriting Frame Relay Headers

For J Series device interfaces with Frame Relay encapsulation, you can rewrite the
discard eligibility (DE) bit based on the loss priority of Frame Relay traffic. For each
outgoing frame with the loss priority set to low, medium-low, medium-high, or high,
you can set the DE bit CoS value to 0 or 1.

You can combine a Frame Relay rewrite rule with other rewrite rules on the same
interface. For example, you can rewrite both the DE bit and MPLS EXP bit.

This section is organized as follows:

■ Assigning the Default Frame Relay Rewrite Rule to an Interface on page 878

■ Defining a Custom Frame Relay Rewrite Rule on page 879

Assigning the Default Frame Relay Rewrite Rule to an Interface

The default Frame Relay rewrite rule contains the following settings:

loss-priority low code-point 0;
loss-priority medium-low code-point 0;
loss-priority medium-high code-point 1;
loss-priority high code-point 1;

This default rule sets the DE CoS value to 0 for each outgoing frame with the loss
priority set to low or medium-low. This default rule sets the DE CoS value to 1 for each
outgoing frame with the loss priority set to medium-high or high.

To assign the default rule to an interface, include the frame-relay-de default statement
at the [edit class-of-service interfaces interface interface-name unit logical-unit-number
rewrite-rules] hierarchy level:

[edit class-of-service interfaces interface-name unit logical-unit-number rewrite-rules]
frame-relay-de default;
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Defining a Custom Frame Relay Rewrite Rule

To define a custom Frame Relay rewrite rule, include the following statements at the
[edit class-of-service] hierarchy level:

[edit class-of-service]
rewrite-rules {

frame-relay-de rewrite-name {
import (rewrite-name | default);
forwarding-class class-name {

loss-priority level code-point (0 | 1);
}

}
}

A custom rewrite rule sets the DE bit to the 0 or 1 CoS value based on the assigned
loss priority of low, medium-low, medium-high, or high for each outgoing frame.

Applying the Rule to a Logical Interface

The rule does not take effect until you apply it to a logical interface. To apply a rule
to a logical interface, include the frame-relay-de map-name statement at the
[edit class-of-service interfaces interface-name unit logical-unit-number rewrite-rules]
hierarchy level:

[edit class-of-service interfaces interface-name unit logical-unit-number rewrite-rules]
frame-relay-de map-name;

Configuring Strict-High Priority

NOTE: This section is applicable to only J Series device and SRX210, SRX240, and
SRX650 devices.

You can configure one queue per interface to have strict high priority, which causes
delay-sensitive traffic, such as voice traffic, to be removed and forwarded with
minimum delay. Packets that are queued in a strict-priority queue are removed before
packets in other queues, including high-priority queues.

The strict high-priority queuing feature allows you to configure traffic policing that
prevents lower-priority queues from being starved. The strict-priority queue does not
cause starvation of other queues because the configured policer allows the queue to
exceed the configured bandwidth only when other queues are not congested. If the
interface is congested, the software polices strict-priority queues to the configured
bandwidth.

To prevent queue starvation of other queues, you must configure an output (egress)
policer that defines a limit for the amount of traffic that the queue can service. The

Configuring Strict-High Priority ■ 879

Chapter 33: Configuring Class of Service



software services all traffic in the strict-priority queue that is under the defined limit.
When strict-priority traffic exceeds the limit, the policer marks the traffic in excess
of the limit as out-of-profile. If the output port is congested, the software drops
out-of-profile traffic.

You can also configure a second policer with an upper limit. When strict-priority
traffic exceeds the upper limit, the software drops the traffic in excess of the upper
limit, regardless of whether the output port is congested. This upper-limit policer is
not a requirement for preventing starvation of the lower-priority queues. The policer
for the lower limit, which marks the packets as out-of-profile, is sufficient to prevent
starvation of other queues.

The following steps describe how strict priority queuing and policing works:

1. Identify delay-sensitive traffic by configuring a behavior aggregate (BA) or
multifield (MF) classifier.

2. Minimize delay by assigning all delay-sensitive packets to the strict priority queue.

3. Prevent starvation on other queues by configuring a policer that checks the data
stream entering the strict priority queue. The policer defines a lower bound,
marks the packets that exceed the lower bound as out-of-profile, and drops the
out-of-profile packets if the physical interface is congested. If there is no
congestion, the software forwards all packets, including the out-of-profile packets.

4. Optionally, configure another policer that defines an upper bound and drops the
packets that exceed the upper bound, regardless of congestion on the physical
interface.

To configure strict priority queuing and prevent starvation of other queues, include
the priority strict-high statement at the [edit class-of-service schedulers scheduler-name]
hierarchy level and the if-exceeding and then out-of-profile statements at the [edit
firewall policer policer-name] hierarchy level:

[edit class-of-service schedulers scheduler-name]
priority strict-high;

[edit firewall policer policer-name]
if-exceeding {

bandwidth-limit bps;
bandwidth-percent number;
burst-size-limit bytes;

}
then out-of-profile;

To verify your configuration, you can issue the following operational mode commands:

■ show class-of-service scheduler-map map-name

■ show interfaces interface-name extensive

■ show interfaces queue interface-name
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Example: Configuring Strict High Priority Using the CLI

Use a BA classifier to classify traffic based on the IP precedence of the packet. The
classifier defines IP precedence value 101 as voice traffic and 000 as data traffic.

Configure two policers on the output interface that identify excess voice traffic
belonging to the voice-class forwarding class. If the traffic exceeds 1 Mbps, a policer
marks the traffic in excess of 1 Mbps as out-of-profile. If the traffic exceeds 2 Mbps,
the second policer discards the traffic in excess of 2 Mbps.

Configure a BA Classifier class-of-service {
classifiers {

inet-precedence corp-traffic {
forwarding-class voice-class {

loss-priority low code-points 101;
}
forwarding-class data-class {

loss-priority high code-points 000;
}

}
}

Configure the
Forwarding Classes

forwarding-classes {
queue 0 voice-class;
queue 1 data-class;

}

Configure the
Scheduler Map

scheduler-maps {
corp-map {

forwarding-class voice-class scheduler voice-sched;
forwarding-class data-class scheduler data-sched;

}
}

Configure the
Schedulers

schedulers {
voice-sched {

priority strict-high;
}
data-sched {

priority low;
}

}

Apply the BA Classifier
to an Input Interface

interfaces {
fe-0/0/0 {

unit 0 {
classifiers {

inet-precedence corp-traffic;
}

}
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}

Apply the Scheduler
Map to an Output

Interface

e1-1/0/1 {
scheduler-map corp-map;

}
}

}

Configure Two Policers firewall {
policer voice-excess {

if-exceeding {
bandwidth-limit 1m;
burst-size-limit 200k;

}
then out-of-profile;

}
policer voice-drop {

if-exceeding {
bandwidth-limit 2m;
burst-size-limit 200k;

}
then discard;

}
filter voice-term {

term 01 {
from {

forwarding-class voice-class;
}
then {

policer voice-drop;
next term;

}
}
term 02 {

from {
forwarding-class voice-class;

}
then policer voice-excess;

}
term 03 {

then accept;
}

}
}

Apply the Filter to the
Output Interface

interfaces {
e1-1/0/1 {

unit 0 {
family inet {

filter {
output voice-term;

}
address 11.1.1.1/24;

882 ■ Configuring Strict-High Priority

JUNOS Software Interfaces and Routing Configuration Guide



}
}

}
}

Example: Configuring Priority Scheduling

JUNOS Software supports multiple levels of transmission priority, which in order of
increasing priority are low, medium-low, medium-high, and high, and strict-high. This
allows the software to service higher-priority queues before lower-priority queues.

Priority scheduling determines the order in which an output interface transmits traffic
from the queues, thus ensuring that queues containing important traffic are provided
better access to the outgoing interface. This is accomplished through a procedure in
which the software examines the priority of the queue. In addition, the software
determines if the individual queue is within its defined bandwidth profile. This binary
decision, which is reevaluated on a regular time cycle, compares the amount of data
transmitted by the queue against the amount of bandwidth allocated to it by the
scheduler. When the transmitted amount is less than the allocated amount, the queue
is considered to be in profile. A queue is out-of-profile when its transmitted amount
is larger than its allocated amount.

The queues for a given output physical interface (or output logical interface if per-unit
scheduling is enabled on that interface) are divided into sets based on their priority.
Any such set contains queues of the same priority.

The software traverses the sets in descending order of priority. If at least one of the
queues in the set has a packet to transmit, the software selects that set. A queue
from the set is selected based on the weighted round-robin (WRR) algorithm, which
operates within the set.

You can configure priority scheduling, as shown in the following example:

1. Configure a scheduler, be-sched, with medium-low priority.

[edit class-of-service]
schedulers {

be-sched {
priority medium-low;

}
}

2. Configure a scheduler map, be-map, that associates be-sched with the best-effort
forwarding class.

[edit class-of-service]
scheduler-maps {

be-map {
forwarding-class best-effort scheduler be-sched;

}
}

3. Assign be-map to a Gigabit Ethernet interface, ge-0/0/0.
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[edit class-of-service]
interfaces {

ge-0/0/0 {
scheduler-map be-map;

}
}

Configuring CoS for Tunnels

CoS queuing, scheduling, and shaping allow you to control and improve the flow of
traffic through tunnel interfaces like GRE and IP-IP interfaces. The GRE and IP-IP
interfaces on a J Series device are internal, configurable interfaces named gr-0/0/0
and ip-0/0/0.

To configure CoS for a GRE or IP-IP tunnel, you must first enable tunnel queuing on
the router. If tunnel queuing is not enabled, the router continues to send traffic
through the tunnel but ignores any configured CoS schedulers and shapers.

NOTE: You cannot enable tunnel queuing on J Series interfaces other than tunnel
interfaces, although the router allows you to commit such a configuration.

You then define the GRE or IP-IP tunnel interface and its per-unit scheduler and set
a line rate for the tunnel with the CoS shaper.

To configure CoS for tunnels, include the following statements at the
[edit class-of-service] and [edit interfaces] hierarchy level:

[edit class-of-service]
interfaces {

tunnel-interface-name {
unit logical-unit-number {

scheduler-map scheduler-map-name;
shaping-rate, rate;
rewrite-rules {

dscp (rewrite-name | default);
dscp-ipv6 (rewrite-name | default);
exp (rewrite-name | default) protocol protocol-types;
exp-push-push-push default;
exp-swap-push-push default;
ieee-802.1 (rewrite-name | default);
inet-precedence (rewrite-name | default);

}
}

}
schedulers

gre_be {
transmit-rate transmit-rate-percent;
shaping-rate rate;
buffer-size buffer-size-percent;
priority low;
drop-profile-map loss-priority any protocol any drop-profile DP1;
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}
gre_ef {

transmit-rate transmit-rate-percent;
shaping-rate rate;
buffer-size buffer-size-percent;
priority low;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
}
scheduler-maps {

gre_sched_map {
forwarding-class fc_be scheduler gre_be;
forwarding-class fc_ef scheduler gre_ef;
forwarding-class fc_af scheduler gre_af;
forwarding-class fc_nc scheduler gre_nc;

}
ipip_sched_map {

forwarding-class fc_be scheduler ipip_be;
forwarding-class fc_ef scheduler ipip_ef;
forwarding-class fc_af scheduler ipip_af;
forwarding-class fc_nc scheduler ipip_nc;

}
}
rewrite-rules{

(dscp | dscp-ipv6 | exp | ieee-802.1 | inet-precedence) rewrite-name {
import (rewrite-name | default);
forwarding-class class-name {

loss-priority level code-point (alias | bits);
}

}
}
[edit interfaces]
tunnel-interface-name {

per-unit-scheduler;
unit logical-unit-number;
copy-tos-to-outer-ip-header;

}
}

For an example of configuring GRE tunnels, see “Example: Configuring CoS for
GRE/IPIP tunnels” on page 888.

Configuring CoS Queuing for Tunnels with a Configuration Editor

To configure COS queuing for GRE or IP-IP tunnels:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 217 on page 886 to configure
CoS queuing for tunnel interfaces.

a. Enable tunnel queuing on the router.

b. Define the GRE or IP-IP tunnel interface.
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c. Define the per-unit scheduler for the GRE or IP-IP tunnel interface.

d. Define the tunnel's line rate by using the shaper definition.

3. Configure forwarding classes and schedulers.

For information on configuring forwarding classes, see “Assigning Forwarding
Classes to Output Queues” on page 838. For information on configuring schedulers,
see “Configuring Schedulers” on page 857.

4. Configure a scheduler map and apply the scheduler map to the tunnel interface.
For information on configuring a scheduler map, see “Configuring and Applying
Scheduler Maps” on page 860.

5. Configure classifiers and apply them to the tunnel interface.

For information on configuring classifiers, see “Configuring and Applying Behavior
Aggregate Classifiers” on page 848.

6. Create rewrite rules and apply them to the tunnel interface.

For information on configuring rewrite rules, see “Configuring and Applying
Rewrite Rules” on page 845.

7. If you are finished configuring the router, commit the configuration.

8. Go on to one of the following tasks:

■ To configure other CoS components, see “Configuring CoS Components with
a Configuration Editor” on page 833.

■ To check the configuration, see “Verifying a CoS Configuration” on page 941.

Table 217: Configuring CoS for GRE Tunnels

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit chassis fpc 0 pic 0
tunnel-queuing

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Chassis, click Configure or Edit.

3. Next to Fpc, click Add new entry.

4. Next to Slot, type 0.

5. Next to Pic, click Add New Entry.

6. Next to Slot, type 0.

7. Select the check box next to Tunnel queuing.

8. Click OK until you return to the main Configuration
page.

Navigate to the Chassis  level in
the configuration hierarchy, and
enable tunnel queuing on the
router.

886 ■ Configuring CoS for Tunnels

JUNOS Software Interfaces and Routing Configuration Guide



Table 217: Configuring CoS for GRE Tunnels (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy
level, enter

edit interfaces gr-0/0/0 unit
0

1. On the main Configuration page, next to Interfaces
click Configure or Edit.

2. In the Interfaces name box, type gr-0/0/0.

3. Next to Unit, click Add new entry.

4. In the Interfaces unit number box, type 0.

5. Click OK.

Navigate to the Interfaces level in
the configuration hierarchy, and
define the GRE tunnel interface
gr-0/0/0.

From the [edit] hierarchy
level, enter

set interfaces gr-0/0/0
per-unit-scheduler

1. From the Scheduler type list, select Per unit
scheduler.

2. Click OK until you return to the main Configuration
page.

Define the per-unit scheduler for
the GRE tunnel interface.

From the [edit] hierarchy
level, enter

set class-of-service interfaces
gr-0/0/0 unit 0 shaping-rate
100m

1. On the main configuration page next to Class of
service, click Configure or Edit.

2. Next to Interfaces, click Add new entry.

3. In the Interface name box, type the name of the
interface gr-0/0/0.

4. Next to unit, click Add New Entry.

5. In the Interface unit number box, type the logical
interface unit number 0.

6. Select the Shaping rate check box, and click
Configure.

7. Next to Shaping Rate choice, select Rate.

8. In the Rate box, type 100m.

9. Click OK until you return to the main Class of Service
configuration page.

Navigate to the Class of service
level in the configuration
hierarchy, and define the GRE
tunnel's line rate (for example,
100 Mbps) by using the shaper
definition.

Preserving the ToS Value of a Tunneled Packet

To ensure that the tunneled packet continues to have the same CoS treatment even
in the physical interface, you must preserve the type-of-service (ToS) value from the
inner IP header to the outer IP header.

For transit traffic, JUNOS Software preserves the CoS value of the tunnel packet for
both GRE and IP-IP tunnel interfaces. The inner IPv4 or IPv6 ToS bits are copied to
the outer IPv4 ToS header for both types of tunnel interfaces.

For Routing Engine traffic, however, the router handles GRE tunnel interface traffic
differently from IP-IP tunnel interface traffic. Unlike for IP-IP tunnels, the IPv4 ToS
bits are not copied to the outer IPv4 header by default. You have a configuration
option to copy the ToS value from the packet's inner IPv4 header to the outer IPv4
header.
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To copy the inner ToS bits to the outer IP header (which is required for some tunneled
routing protocols) on packets sent by the Routing Engine, include the
copy-tos-to-outer-ip-header statement at the logical unit hierarchy level of a GRE
interface.

NOTE: For IPv6 traffic, the inner ToS value is not copied to the outer IPv4 header
for both GRE and IP-IP tunnel interfaces even if the copy-tos-to-outer-ip-header
statement is specified.

This example copies the inner ToS bits to the outer IP header on a GRE tunnel:

[edit interfaces]
gr-0/0/0 {

unit 0 {
copy-tos-to-outer-ip-header;
family inet;

}
}

Example: Configuring CoS for GRE/IPIP tunnels

In the network shown in Figure 95 on page 888, Router A has a GRE tunnel established
with Router B through interface ge-1/0/0. Router A also has an IPIP tunnel established
with Router C through interface ge-1/0/2. Router A is configured so that
tunnel-queuing is enabled. Routers B and Router C do not have tunnel-queuing
configured.

Figure 95: Configuring CoS Queuing for GRE Tunnels

Router A (has tunnel
queuing)

chassis {
fpc 0 {

pic 0 {
tunnel-queuing;

}
}

}
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interfaces
gr-0/0/0 {

per-unit-scheduler;
unit 0 {

tunnel {
source 192.12.12.1;
destination 192.12.12.2;
ttl 4;

}
family inet {

address 192.22.22.1/30;
}
copy-tos-to-outer-ip-header;

}
}
ip-0/0/0 {

per-unit-scheduler;
unit 0 {

tunnel {
source 192.13.13.1;
destination 192.13.13.2;
ttl 4;

}
family inet {

address 192.33.33.1/30;
}

}
}
ge-1/0/0 {

unit 0 {
family inet {

address 192.12.12.1/24;
}

}
}
ge-1/0/1 {

unit 0 {
family inet {

address 192.13.13.1/24;
}

}
}

class-of-service {
classifiers {

dscp gre-dscp {
forwarding-class fc_be {

loss-priority high code-points 000000;
}
forwarding-class fc_ef {

loss-priority high code-points 101110;
}
forwarding-class fc_af{

loss-priority low code-points 001010;
}
forwarding-class fc_nc {

loss-priority low code-points 111111;
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}
}
inet-precedence ipip-inet-prec {

forwarding-class fc_be {
loss-priority high code-points 000;

}
forwarding-class fc_ef {

loss-priority high code-points 001;
}
forwarding-class fc_af {

loss-priority low code-points 010;
}
forwarding-class fc_nc {

loss-priority low code-points 011;
}

}
}
drop-profiles {

DP1 {
fill-level 80 drop-probability 60;

}
DP2 {

fill-level 75 drop-probability 80;
}

}
forwarding-classes {

queue 0 fc_be;
queue 1 fc_ef;
queue 2 fc_af;
queue 3 fc_nc;

}
interfaces {

gr-0/0/0 {
unit 0 {

scheduler-map gre_sched_map;
shaping-rate 4m;
classifiers {

dscp gre-dscp;
}
rewrite-rules {

inet-precedence tnl_rw;
}

}
}
ip-0/0/0 {

unit 0 {
scheduler-map ipip_sched_map;
shaping-rate 7m;
classifiers {

inet-precedence ipip-inet-prec
}
rewrite-rules {

inet-precedence tnl_rw;
}

}
}
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}
rewrite-rules {

inet-precedence tnl_rw {
forwarding-class fc_be {

loss-priority high code-point 100;
}
forwarding-class fc_ef {

loss-priority low code-point 101;
}
forwarding-class fc_af {

loss-priority high code-point 110;
}
forwarding-class fc_nc {

loss-priority high code-point 111;
}

}
}
scheduler-maps {

gre_sched_map {
forwarding-class fc_be scheduler gre_be;
forwarding-class fc_ef scheduler gre_ef;
forwarding-class fc_af scheduler gre_af;
forwarding-class fc_nc scheduler gre_nc;

}
ipip_sched_map {

forwarding-class fc_be scheduler ipip_be;
forwarding-class fc_ef scheduler ipip_ef;
forwarding-class fc_af scheduler ipip_af;
forwarding-class fc_nc scheduler ipip_nc;

}
}
schedulers {

gre_be {
transmit-rate percent 30;
shaping-rate 2m;
buffer-size percent 30;
priority low;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
gre_ef {

transmit-rate percent 30;
shaping-rate 1m;
buffer-size percent 30;
priority low;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
gre_af {

transmit-rate percent 25;
buffer-size percent 25;
priority high;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
gre_nc {

transmit-rate percent 15;
buffer-size percent 15;
priority high;
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drop-profile-map loss-priority high protocol any drop-profile DP1;
}
ipip_be {

transmit-rate percent 40;
shaping-rate 3m;
buffer-size percent 40;
priority low
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
ipip_ef {

transmit-rate percent 20;
shaping-rate 1m;
buffer-size percent 20;
priority low;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
ipip_af {

transmit-rate percent 20;
buffer-size percent 20;
priority high;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
ipip_nc {

transmit-rate percent 20;
buffer-size percent 20;
priority high;
drop-profile-map loss-priority high protocol any drop-profile DP1;

}
}

Router B (has no tunnel
queuing)

interface
gr-0/0/0 {

per-unit-scheduler;
unit 0 {

tunnel {
source 192.12.12.2;
destination 192.12.12.1;
ttl 4;

}
family inet {

address 192.22.22.2/30;
}
copy-tos-to-outer-ip-header;

}
}
ge-1/0/3 {

unit 0 {
family inet {

address 192.12.12.2/24;
}

}
}
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Router C (has no tunnel
queuing)

interface
ip-0/0/0 {

per-unit-scheduler;
unit 0 {

tunnel {
source 192.13.13.2;
destination 192.13.13.1;
ttl 4;

}
family inet {

address 192.33.33.2/30;
}

}
}
ge-1/0/2 {

unit 0 {
family inet {

address 192.13.13.2/24;
}

}
}

Restrictions on CoS Shapers

On a J Series device, when defining a CoS shaping rate on a tunnel interface, be
aware of the following restrictions:

■ The shaping rate on the tunnel interface must be less than that of the physical
egress interface.

■ The shaping rate measures only the packet size that includes the Layer 3 packet
with GRE or IP-IP encapsulation. The Layer 2 encapsulation added by the physical
interface is not factored into the shaping rate measurement.

■ The CoS behavior works as expected only when the physical interface carries
the shaped GRE or IP-IP tunnel traffic alone. If the physical interface carries other
traffic, thereby lowering the available bandwidth for tunnel interface traffic, the
CoS features do not work as expected.

■ You cannot configure a logical interface shaper and a virtual circuit shaper
simultaneously on the device. If virtual circuit shaping is desired, do not define
a logical interface shaper. Instead, define a shaping rate for all the virtual circuits.

Configuring Strict High Priority for Queuing with a Configuration Editor

You can configure one queue per interface to have strict-high priority, which causes
delay-sensitive traffic, such as voice traffic, to be removed from the queue and
forwarded with minimum delay. Packets that are queued in a strict-priority queue
are removed from the queue before packets in other queues, including high-priority
queues. For more information on strict-high priority, see “Configuring Strict-High
Priority” on page 879.

To configure strict-priority queuing and prevent starvation of other queues:
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1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 218 on page 894.

3. If you are finished configuring the router, commit the configuration.

Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention

CLI Configuration EditorJ-Web Configuration EditorTask

Configuring a BA Classifier

From the [edit] hierarchy level, enter

edit Class of service classifiers inet-precedence
corp-traffic forwarding-class voice-class
loss-priority low

Enter set code-points 101

From the [edit] hierarchy level, enter

edit class-of-service classifiers inet-precedence
corp-traffic forwarding-class data-class loss-priority
high

Enter set code-points 000

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Class of service, click Configure
or Edit.

3. Next to Classifiers, click Configure or Edit.

4. Next to Inet precedence, click Add new
entry.

5. Enter corp-traffic in the Name box.

6. Next to Forwarding class, click Add new
entry.

7. Enter voice-class in the Class name box.

8. Next to Loss priority, click Add new entry.

9. Enter low in the Loss val box.

10. Next to Code points, click Add new entry.

11. Enter 101 in the Value box.

12. Click OK three times.

13. In the Inet precedence forwarding class
page, enter voice-class in the Class name
box.

14. Next to Loss priority, click Add new entry.

15. Enter high in the Loss val box.

16. Next to Code points, click Add new entry.

17. Enter 000 in the Value box.

18. Click OK five times.

Use a BA classifier to
classify traffic based on the
IP precedence of the
packet. The classifier
defines IP precedence
value 101 as voice traffic
and 000 as data traffic.

Configuring the Forwarding Classes
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Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service forwarding-classes queue 0
voice-class

enter

edit class-of-service forwarding-classes queue 1
data-class

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Class of service, click Configure
or Edit.

3. Next to Forwarding classes, click
Configure or Edit.

4. Next to Queue, click Add new entry.

5. Enter 0 in the Queue num box.

6. Enter voice-class in the Class name box.

7. Click OK to return to the Forwarding
Classes page.

8. Next to Queue, click Add new entry.

9. Enter 1 in the Queue num box.

10. Enter data-class in the Class name box.

11. Click OK three times.

Assign priority queuing to
voice and data traffic.

Configuring the Scheduler Map and Schedulers

From the [edit] hierarchy level, enter

edit class-of-service scheduler-maps corp-map
forwarding-class voice-class

Enter

set scheduler voice-sched

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Class of service, click Configure
or Edit.

3. Next to Scheduler maps, click Add new
entry.

4. In the Map name box, type corp-map.

5. Next to Forwarding class, click Add new
entry.

6. In the Class name box, type voice-class.

7. In the Scheduler name box, type
voice-sched.

8. Click OK three times.

Configure the scheduler
map and voice scheduler.
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Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit class-of-service schedulers voice-sched

Enter

set priority strict-high

From the [edit] hierarchy level, enter

edit class-of-service schedulers data-sched

Enter

set priority low

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Class of service, click Configure
or Edit.

3. Next to Schedulers, click Add new entry.

4. In the Scheduler name box, type
voice-sched.

5. In the Priority box, type strict-high.

6. Click OK.

7. Next to Schedulers, click Add new entry.

8. In the Scheduler name box, type
data-sched.

9. In the Priority box, type low.

10. Click OK twice.

Define the voice and data
traffic schedulers, and set
the priority.

Applying the BA Classifier to an Input Interface and Scheduler Map to an Output Interface
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Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces ge-0/0/0 unit 0

From the [edit] hierarchy level, enter

edit class of service classifiers inet-precedence
corp-traffic

From the [edit] hierarchy level, enter

edit interfaces e1-1/0/0 unit 0

From the [edit] hierarchy level, enter

edit class-of-service scheduler-maps corp-map

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Interfaces, click Configure or Edit.

3. Next to Interface, click Add new entry.

4. In the Interface name box, type ge-0/0/0.

5. Click OK three times.

6. In the Edit Configuration page, next to
Class of service, click Configure or Edit.

7. Next to Classifiers, click Edit.

8. Next to Inet precedence, click Add new
entry.

9. In the Name box, type corp-traffic.

10. Click OK three times.

11. In the Edit Configuration page, next to
Interfaces, click Configure or Edit.

12. Next to Interface name, type e1-1/0/1.

13. Click OK twice.

14. In the Edit Configuration page, next to
Class of service, click Configure or Edit.

15. Next to Scheduler maps, click Add new
entry.

16. In the Map name box, type corp-map.

17. Click OK twice.

Apply the BA classifier to
an input interface—for
example, ge-0/0/0.

Apply the scheduler map
to and output
interface—for example,
e1-1/0/0.

(See the interface naming
conventions in Junos OS
Interfaces Configuration
Guide for Security Devices.)

Configuring Two Policers
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Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit firewall policer voice-drop if-exceeding

Enter

set burst-size-limit 200000
bandwidth-limit 2000000

Enter

set then discard

From the [edit] hierarchy level, enter

edit firewall policer voice-excess if-exceeding

Enter

set burst-size-limit 200000
bandwidth-limit 1000000

Enter

set then out-of-profile

1. In the J-Web interface, select
Configure>CLI Tools>Point and Click
CLI.

2. Next to Firewall, click Configure or Edit.

3. Next to Policer, click Add new entry.

4. In the Policer name box, type voice-drop.

5. Next to If Exceeding, select the check box
and click Configure.

6. In the Burst size limit box, type 200000.

7. In the Bandwidth list, select
Bandwidth limit.

8. In the Bandwidth limit box, type 2000000.

9. Click OK.

10. On the Policer page, next to Then, click
Configure.

11. Next to Discard, select the check box.

12. Click Ok twice.

13. In the Firewall Configuration page next to
Policer, click Add new entry.

14. In the Policer name box, type voice-excess.

15. Next to If Exceeding, select the check box
and click Configure.

16. In the Burst size limit box, type 200000.

17. In the Bandwidth list, select
Bandwidth limit.

18. In the Bandwidth limit box, type 1000000.

19. Click OK.

20. On the Policer page, next to Then, click
Configure.

21. Next to Out of profile, select the check
box.

22. Click OK twice.

Configure two policers: one
as voice-drop and second as
voice-excess.
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Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit firewall filter voice-term term 01 from
forwarding-class voice-class then policer
voice-drop next term

1. In the Firewall Configuration page next to
Filter, click Add new entry.

2. In the Filter name box, type voice-term.

3. Next to Term click Add new entry.

4. In the Rule name box, type term 01.

5. Next to Term, click Add new entry.

6. Next to From, click Configure.

7. Next to Forwarding class choice, select
forwarding-class.

8. Next to Forwarding class, click Add new
entry.

9. In the String box, type voice-class.

10. Click OK twice.

11. In the Term Filter page, next to Then, click
Configure.

12. Next to Policer choice, select policer.

13. In the Policer box, type voice-drop.

14. Next to Designation, select Next.

15. In the Next box, select term.

16. Click OK twice.

Create a firewall filter
voice-term that includes the
new policers.

First, add the policer
voice-drop to the term.

Enter

edit firewall filter voice-term term 02 from
forwarding-class voice-class then policer
voice-excess accept

1. In the Firewall Filter page, next to Term,
click Add new entry.

2. In the Rule name box, type term 02.

3. Next to From, click Configure.

4. Next to Forwarding class choice, select
forwarding-class.

5. Next to Forwarding class, click Add new
entry.

6. In the String box, type voice-class.

7. Click OK twice.

8. In the Term Filter page, next to Then, click
Configure.

9. Next to Policer choice, select policer.

10. In the Policer box, type voice-excess.

11. Next to Designation, select Accept.

12. Click OK four times.

Then add the policer
voice-excess to the term.

Applying the Filter to the Output Interface
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Table 218: Configuring Strict-High Priority Queuing and Starvation Prevention  (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit interfaces e1-1/0/1 unit 0 family inet filter
output voice-term

Enter

set family inet address 11.1.1.1/24

Apply filter voice-term to
e1-1/0/0 using the CLI.

Configuring Large Delay Buffers with a Configuration Editor

Large bursts of traffic from faster interfaces can cause congestion and dropped
packets on slower interfaces that have small delay buffers. For example, a J Series
device operating at the edge of the network can drop a portion of the burst traffic it
receives on a channelized T1/ E1 interface from a Fast Ethernet or Gigabit Ethernet
interface on a router at the network core. On J Series devices, large delay buffers can
be configured for both channelized T1/E1 and non-channelized T1/E1 interfaces.

To ensure that traffic is queued and transmitted properly on slower interfaces, you
can configure a buffer size larger than the default maximum.

This section contains the following topics:

■ Maximum Delay Buffer Sizes Available to Channelized T1/E1
Interfaces on page 900

■ Delay Buffer Size Allocation Methods on page 901

■ Specifying Delay Buffer Sizes for Queues on page 902

■ Configuring a Large Delay Buffer on a non-Channelized Ti Interface on page 903

■ Configuring a Large Delay Buffer on a Channelized T1 Interface on page 904

Maximum Delay Buffer Sizes Available to Channelized T1/E1 Interfaces

When you enable the large delay buffer feature on interfaces, a larger buffer is
available for allocation to scheduler queues. The maximum delay buffer size that is
available for an interface depends on the maximum available delay buffer time and
the speed of the interface as shown in Table 219 on page 901.

. The default values are as follows:

■ Clear-channel interface—The default delay buffer time is 500,000 microseconds
(0.5 seconds).

■ NxDS0 interface—The default delay buffer time is 1,200,000 microseconds (1.2
seconds).
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Table 219: Maximum Available Delay Buffer Time by Channelized Interface and Rate

Maximum Available Delay Buffer TimeEffective Line Rate

4,000,000 microseconds (4 seconds)< 4xDS0

2,000,000 microseconds (2 seconds)< 8xDS0

1,000,000 microseconds (1 second)< 16xDS0

500,000 microseconds (0.5 second)<= 32xDS0

400,000 microseconds (0.4 seconds)<= 10mbps

300,000 microseconds (0.3 seconds)<= 20mbps

200,000 microseconds (0.2 seconds)<= 30mbps

150,000 microseconds (0.15 second)<= 40mbps

You can calculate the maximum delay buffer size available for an interface, with the
following formula:

interface speed x maximum delay buffer time = maximum available delay buffer size

For example, the following maximum delay buffer sizes are available to 1xDS0 and
2xDS0 interfaces:

1xDS0—64 kilobits per second x 4 seconds = 256 kilobits (32 kilobytes)

2xDS0—128 kilobits per second x 4 seconds = 512 kilobits (64 kilobytes)

If you configure a delay buffer size larger than the new maximum, the system allows
you to commit the configuration but displays a system log warning message and
uses the default buffer size setting instead of the configured maximum setting.

Delay Buffer Size Allocation Methods

You can specify delay buffer sizes for each queue using schedulers. The queue buffer
can be specified as a period of time (microseconds) or as a percentage of the total
buffer or as the remaining buffer. Table 220 on page 901 shows different methods
that you can specify for buffer allocation in queues.

Table 220: Delay Buffer Size Allocation Methods

DescriptionBuffer Size Allocation Method

A percentage of the total buffer.Percentage
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Table 220: Delay Buffer Size Allocation Methods (continued)

DescriptionBuffer Size Allocation Method

A period of time, value in microseconds. When you configure a temporal buffer,
you must also configure a transmit rate. The system calculates the queue buffer
size by multiplying the available bandwidth of the interface times the configured
temporal value and transmit rate.

When you specify a temporal method, the drop profile is assigned a static buffer
and the system starts dropping packets once the queue buffer size is full. By default,
the other buffer types are assigned dynamic buffers that use surplus transmission
bandwidth to absorb bursts of traffic.

Temporal

The remaining buffer available. The remainder is the percentage buffer that is not
assigned to other queues. For example, if you assign 40 percent of the delay buffer
to queue 0, allow queue 3 to keep the default allotment of 5 percent, and assign
the remainder to queue 7, then queue 7 uses approximately 55 percent of the delay
buffer.

Remainder

Specifying Delay Buffer Sizes for Queues

You specify delay buffer sizes for queues using schedulers. The system calculates
the buffer size of a queue based on the buffer allocation method you specify for it
in the scheduler. See Table 220 on page 901 for different buffer allocation methods
and Table 221 on page 902 for buffer size calculations.

Table 221: Delay Buffer Allocation Method and Queue Buffer

ExampleQueue Buffer Calculation
Buffer Size Allocation
Method

Suppose you configure a queue on a 1xDS0 interface
to use 30 percent of the available delay buffer size. The
system uses the maximum available delay buffer time
(4 seconds) and allocates the queue 9600 bytes of delay
buffer:

64 Kbps x 0.3 x 4 seconds=76800 bits=9600 bytes

available interface bandwidth x configured
buffer size percentage x maximum delay
buffer time = queue buffer

Percentage
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Table 221: Delay Buffer Allocation Method and Queue Buffer (continued)

ExampleQueue Buffer Calculation
Buffer Size Allocation
Method

Suppose you configure a queue on a 1xDS0 interface
to use 300,000 microseconds (3 seconds) of delay
buffer, and you configure the transmission rate to be
20 percent. The queue receives 4800 bytes of delay
buffer:

64 Kbps x 0.2 x 3 seconds=38400 bits=4800 bytes

When you configure a temporal value that is greater
than the maximum available delay buffer time, the
system allocates this queue the remaining buffer after
other queues are allocated buffer. Suppose you
configure a temporal value of 6,000,000 microseconds
on a 1xDS0 interface. Because this value is greater than
the maximum allowed value of
4,000,000 microseconds, the queue is allocated the
remaining delay buffer.

available interface bandwidth x configured
transmit rate percentage  x configured
temporal buffer size = queue buffer

Temporal

When you specify the buffer size as a percentage, the system ignores the transmit
rate and calculates the buffer size based only on the buffer size percentage.

Configuring a Large Delay Buffer on a non-Channelized Ti Interface

To configure large-delay buffers on non C-TI/E1 interfaces, you must first enable the
large buffer feature and then extend the q-pic-large-delay-buffer size on all interfaces.
The maximum delay buffer time varies by the interface speed as shown in Table
222 on page 903.

Table 222: Recommended Delay Buffer Sizes

Recommended Buffer Size in
microseconds (ms)

Effective Bandwidth in kilobytes per second
(kbps)

Interface Speed

4000ms< 256kbps

2000ms< 512kbps256kbps

1000ms< 024kbps512kbps

500ms<2048kbps1024kbps

100ms>2048kbps

For more information on using J-web or the CLI configuration editor to configure
large delay buffers, see “Configuring a Large Delay Buffer on a Channelized T1
Interface” on page 904.
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Configuring a Large Delay Buffer on a Channelized T1 Interface

On J Series devices, you can configure large delay buffers on channelized T1/E1
interfaces. To configure large-delay buffer sizes, you must first enable the large buffer
feature on the channelized T1/E1 PIM and then configure a buffer size for each queue
in the CoS scheduler.

Each channelized T1/E1 interface can be configured as a single clear channel, or for
channelized (NxDS0) operation, where N denotes channels 1 to 32 for an E1 interface
and channels 1 to 24 for a T1 interface.

In this configuration, you enable the large delay buffer option on a channelized T1
PIM with an interface speed of 1.5 Mbps and a maximum delay buffer time of 500,000
microseconds. Based on the interface speed and the maximum delay buffer time,
you can calculate the available delay buffer size for the interface. For more
information, see “Maximum Delay Buffer Sizes Available to Channelized T1/E1
Interfaces” on page 900.

Next, you specify a queue buffer of 30 percent in a scheduler be-scheduler and
associate the scheduler to a defined forwarding class be-class using a scheduler map
large-buf-sched-map. Finally, you apply the scheduler map to the channelized T1
interface t1-3/0/0. As a result, a buffer of 9600 bytes is assigned to the queue
associated with forwarding class be-class (see Table 221 on page 902). You can specify
a delay buffer size for other queues following the instructions in this example.

To configure large delay buffers for channelized T1/E1 interfaces:

1. Navigate to the top of the configuration hierarchy in either the J-Web or CLI
configuration editor.

2. Perform the configuration tasks described in Table 223 on page 904.

3. If you are finished configuring the router, commit the configuration.

4. Go on to one of the following tasks:

■ To configure other CoS components, see “Configuring CoS Components with
a Configuration Editor” on page 833.

■ From the CLI, enter the show class of service command, to check your
configuration.

Table 223: Configuring a Large Delay Buffer

CLI Configuration EditorJ-Web Configuration EditorTask

From the [edit] hierarchy level, enter

edit chassis

1. In the J-Web interface, select Configure>CLI
Tools>Point and Click CLI.

2. Next to Chassis, click Configure or Edit.

Navigate to the Chassis
level in the configuration
hierarchy.

904 ■ Configuring Large Delay Buffers with a Configuration Editor

JUNOS Software Interfaces and Routing Configuration Guide



Table 223: Configuring a Large Delay Buffer (continued)

CLI Configuration EditorJ-Web Configuration EditorTask

Enter

set fpc 3 pic 0 q-pic-large-buffer

1. Next to Fpc, click Add new entry.

2. In the Slot box, type the slot number 3.

3. Next to Pic, click Add new entry.

4. In the Slot box, type 0.

5. Next to Q pic large buffer, select the check box.

6. Click OK.

Enable the large buffer size
feature on the channelized
T1/E1 PIM in slot 3.

From the [edit] hierarchy level, enter

edit class-of-service

On the main Configuration page next to Class of
service, click Configure or Edit.

Navigate to the
Class-of-service level in
the configuration
hierarchy.

Enter

set schedulers be-scheduler buffer-size
percent 30

1. Next to Schedulers, click Add new entry.

2. In the Scheduler name box, type the name of
the scheduler—be-scheduler.

3. Next to Buffer size, click Configure.

4. From the Buffer size choice list, select percent.

5. In the Percent box, type 30.

6. Click OK.

Create be-scheduler and
specify a buffer size of 30
percent for it.

From the [edit class-of-service] hierarchy
level, enter

set scheduler-maps large-buf-sched-map
forwarding-class be-class scheduler
be-scheduler

1. On the Class of service page, next to Scheduler
maps, click Add new entry.

2. In the Map name box, type the name of the
scheduler map—large-buf-sched-map.

3. Next to Forwarding class, click Add new entry.

4. In the Class name box, type the name of the
forwarding class to be associated with the
scheduler—be-class.

5. In the Scheduler box, type the name of the
scheduler to be associated with the forwarding
class—be-scheduler.

6. Click OK.

Configure the scheduler
map large-buf-scheduler-map
to associate schedulers
with defined forwarding
classes.

For information about
configuring forwarding
classes, see “Assigning
Forwarding Classes to
Output Queues” on
page 838.

From the [edit class-of-service]  hierarchy
level, type

set interfaces t1-3/0/0 unit 0
scheduler-map large-buf-sched-map

1. On the Class of service page, next to Interfaces,
click Add new entry.

2. In the Interface name box, type the name of
the interface to which the scheduler map is to
be applied—t1-3/0/0.

3. Next to Unit, click Add new entry.

4. In the Unit number box, type 0.

5. In the Scheduler map box, type the name of
the scheduler map—large-buf-sched-map.

6. Click OK.

Apply the scheduler map
to the channelized T1
interface.

NOTE: For information
about configuring
channelized T1/E1
interfaces, see Junos OS
Interfaces Configuration
Guide for Security Devices.
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Applying an Ingress Interface Policer

Policers allow you to limit traffic of a certain class to a specified bandwidth and burst
size. You can use policers to limit the amount of traffic passing into or out of an
interface. SRX5600 and SRX5800 devices support two I/O cards (IOCs) (40x1 Gigabit
Ethernet IOC and 4x10 Gigabit Ethernet IOC) and allow only inbound (ingress)
interface policers.

NOTE: For applying a simple filter or policing actions to logical interfaces residing
in an SRX5000 line Flex IOC (FIOC) on SRX5600 and SRX5800 devices, see
“Configuring Simple Filters and Policers” on page 907.

Consider the following when applying a policer to an ingress interface:

■ You can configure a tricolor marker in the firewall; however, you cannot use the
marker in the input policer (the CLI will block it). For more information on
applying tricolor markers, see “Example: Applying a Two-Rate Tricolor Marking
Policer to a Firewall Filter” on page 909.

■ Only the following options are valid: logical-interface-policer, if-exceeding, and
then. For more information on applying a stateless firewall filter to an interface,
see Junos OS Routing Protocols and Policies Configuration Guide for Security Devices.

■ For the if-exceeding option, only bandwidth-limit and burst-size-limit are valid
options. The bandwidth-percent option is not supported.

■ For the then option, only discard is the valid option.

To filter packets transiting the device, apply the firewall filter to any nonrouting
device.

ge-0/1/0 {
unit 0 {

family inet {
policer {

input ingress-p;
}
address 200.4.1.1/24 {

arp 200.4.1.100 mac 00:00:de:ad:be:ee;
}

}
}

}

ge-0/3/0 {
unit 0 {

family inet {
address 200.4.3.1/24 {

arp 200.4.3.100 mac 00:00:de:ad:be:ef;
}

}
}
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}

To view the configuration of the firewall policer ingress-p, use the show configuration
firewall policer command. For example:

user@host# show configuration firewall policer ingress-p logical-interface-policer;
if-exceeding {

bandwidth-limit 8m;
burst-size-limit 1m

}
then-discard;

Configuring Simple Filters and Policers

To handle oversubscribed traffic in the SRX3400, SRX3600, SRX5600, and SRX5800
devices, you can configure simple filters and policing.

NOTE: For SRX5600 and SRX5800 devices, the simple filter or policing actions can
be applied only to logical interfaces residing in an SRX5000 line Flex IOC (FIOC),
because only an SRX5000 line FIOC supports the simple filter and policing features
on the SRX5600 and SRX5800 devices.

The simple filter functionality comprises of the following:

■ Classifying packets according to configured policies

■ Taking appropriate actions based on the results of classification

In JUNOS Software, ingress traffic policers can limit the rate of incoming traffic. There
are two main reasons to use traffic policing:

■ To enforce traffic rates to conform to the service-level agreement (SLA)

■ To protect next hops, for example, protecting the central point and the SPU from
being overwhelmed by excess traffic (example, DOS attacks)

Using the results of packet classification and traffic metering, a policer can take one
of the following actions for a packet: forward a conforming (green) packet or drop a
nonconforming (yellow) packet. Policers always discard a non conforming red packet.
The traffic metering supports the algorithm of the two-rate tricolor marker (TCM)
(RFC 2698). For more information on packet classification and traffic metering, see
“Configuring CoS Components with a Configuration Editor” on page 833

Configuring a Simple Filter

Simple filters, in contrast to other firewall filters, support only a subset of the full
firewall filter syntax. Unlike normal filters, simple filters are for IPv4 traffic only and
have the following restrictions:

■ The next term action is not supported.

■ Qualifiers, such as the except and protocol-except statements, are not supported.
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■ Noncontiguous masks are not supported.

■ Multiple source addresses and destination addresses in a single term are not
supported. If you configure multiple addresses, only the last one is used.

■ Ranges are not supported.

■ Output filters are not supported. You can apply a simple filter to inbound (ingress)
traffic only.

To configure a simple filter, include the following statement at the [edit firewall]
hierarchy level of the configuration:

Simple Filter firewall {
family inet {

simple-filter sf-1 {
term 1 {

source-address 172.16.0.0/16;
destination-address 20.16.0.0/16;
source-port 1024;

}
then { # Action with term-1
forwarding-class fc-be1;
loss-priority high;

}
term 2 {

source-address 173.16.0.0/16;
destination-address 21.16.0.0/16;

}
then { # Action with term-2
forwarding-class fc-ef1;
loss-priority low;

}
}
interfaces { # Apply the simple filter.
ge-1/2/3 {

unit 0 {
family inet {

simple-filter {
input sf-1;

}
}

}
}

Applying a Simple Filter

A simple filter can be applied to logical interfaces. Use the following CLI commands
to apply a simple filter:

edit interfaces interface-name unit logical-unit-number family family-name simple-filter
{
input filter-name;

}

908 ■ Configuring Simple Filters and Policers

JUNOS Software Interfaces and Routing Configuration Guide



NOTE: You can apply simple filters to the family inet only, and only in the input
direction. Because of hardware limitations on the SRX3400, SRX3600, SRX5600,
and SRX5800 devices, a maximum of 400 logical input interfaces (in one broadcom
packet processor) can be applied with simple filters. For more information on
limitations, see “SRX3400 and SRX3600 Device Hardware Capabilities and
Limitations” on page 913.

Configuring Policers

In JUNOS Software, policers can be configured as part of the firewall filter hierarchy.
For more information on configuring firewall policies, see the JUNOS Software Security
Configuration Guide.

You can configure a policer and then apply it as one of the actions of a term in a
simple filter. The policer can limit the rate of traffic that enters the logical interface
to which the simple filter is applied. Figure 96 on page 909 illustrates the application
of a policer.

Figure 96: Application of a Policer Through a Simple Filter

Use the following CLI commands to configure a policer:

policer policer-name {
filter-specific;
if-exceeding {

bandwidth-limit bps;
burst-size-limit bytes;

}
then {

policer-action;
}

}

Example: Applying a Two-Rate Tricolor Marking Policer to a Firewall Filter

To configure a trTCM policer to a firewall filter, use the following JUNOS CLI
commands:

firewall {
three-color-policer three-color-policer name{
two-rate {
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color-blind;
committed-information-rate bps;
committed-burst-size bytes;
peak-information-rate bps;
peak-burst-size bytes;

}
}

NOTE: The two-rate TCM policer supports only the color blind mode; color aware
mode is not supported.

Configuring CoS Hierarchical Schedulers

In metro Ethernet environments, a VLAN typically corresponds to a customer premises
equipment (CPE) device and the VLANs are identified by an inner VLAN tag on
Ethernet frames (called the customer VLAN, or C-VLAN, tag). A set of VLANs can be
grouped at the DSL access multiplexer (DSLAM) and identified by using the same
outer VLAN tag (called the service VLAN, or S-VLAN, tag). The service VLANs are
typically gathered at the Broadband Remote Access Server (BRAS) level, which can
be (among other devices) an SRX Series device. On SRX5600 and SRX5800 devices,
hierarchical schedulers let you provide shaping and scheduling at the service VLAN
level as well as other levels, such as the physical interface. In other words, you can
group a set of logical interfaces and then apply scheduling and shaping parameters
to the logical interface set as well as to other levels.

This basic architecture is shown in Figure 97 on page 911. You can apply
class-of-service (CoS) parameters at the premises on the CPE, on the customer or
service VLANs, at the BRAS level, or at all levels.
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Figure 97:  An SRX Series Device in a Hierarchical Scheduler Architecture

Bras (SRX Series devices)
CoS configured on physical ports

On SRX5600 and SRX5800 devices, you can apply CoS shaping and scheduling at
one of four different levels, including the VLAN set level.

The supported scheduler hierarchy is as follows:

■ The physical interface (level 1)

■ The service VLAN (level 2 is unique to SRX Series devices)

■ The logical interface or customer VLAN (level 3)

■ The queue (level 4)

You can specify a traffic control profile (output-traffic-control-profile) that can specify
a shaping rate, a guaranteed rate, and a scheduler map with transmit rate and buffer
delay. The scheduler map contains the mapping of queues (forwarding classes) to
their respective schedulers (schedulers define the properties for the queue). Queue
properties can specify a transmit rate and buffer management parameters such as
buffer size and drop profile. For more information, see “Defining Schedulers” on
page 824.

To configure CoS hierarchical schedulers, include the following statements at the
[edit class-of-service interfaces] and [edit interfaces] hierarchy levels:

[edit class-of-service interfaces]
interface-set interface-set-name {

excess-bandwidth-share (proportional value | equal);
internal-node;
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output-traffic-control-profile profile-name;
output-traffic-control-profile-remaining profile-name;

}

[edit interfaces]
hierarchical-scheduler;
interface-set interface-set-name {

ethernet-interface-name {
(interface-parameters);

}
}

Hierarchical Scheduler Terminology

Hierarchical schedulers introduce some new terms into a discussion of CoS
capabilities. They also use some familiar terms in different contexts. This section
presents a complete overview of the terms used with hierarchical schedulers.

The following terms are important for hierarchical schedulers:

■ Customer VLAN (C-VLAN)—A C-VLAN, defined by IEEE 802.1ad, . A stacked
VLAN contains an outer tag corresponding to the S-VLAN, and an inner tag
corresponding to the C-VLAN. A C-VLAN often corresponds to CPE. Scheduling
and shaping is often used on a C-VLAN to establish minimum and maximum
bandwidth limits for a customer. See also S-VLAN.

■ Interface set—A logical group of interfaces that describe the characteristics of
set of service VLANs, logical interfaces, or customer VLANs. Interface sets establish
the set and name the traffic control profiles. See also Service VLAN.

■ Scheduler— A scheduler defines the scheduling and queuing characteristics of
a queue. Transmit rate, scheduler priority, and buffer size can be specified. In
addition, a drop profile may be referenced to describe WRED congestion control
aspects of the queue. See also Scheduler map.

■ Scheduler map—A scheduler map is referenced by traffic control profiles to
define queues. The scheduler map establishes the queues that comprise a
scheduler node and associates a forwarding class with a scheduler. See also
Scheduler.

■ Stacked VLAN—An encapsulation on an S-VLAN with an outer tag corresponding
to the S-VLAN, and an inner tag corresponding to the C-VLAN. See also Service
VLAN and Customer VLAN.

■ Service VLAN (S-VLAN)—An S-VLAN, defined by IEEE 802.1ad, often corresponds
to a network aggregation device such as a DSLAM. Scheduling and shaping is
often established for an S-VLAN to provide CoS for downstream devices with
little buffering and simple schedulers. See also Customer VLAN.

■ Traffic control profile—Defines the characteristics of a scheduler node. Traffic
control profiles are used at several levels of the CLI, including the physical
interface, interface set, and logical interface levels. Scheduling and queuing
characteristics can be defined for the scheduler node using the shaping-rate,
guaranteed-rate, and delay-buffer-rate statements. Queues over these scheduler
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nodes are defined by referencing a scheduler map. See also Scheduler and
Scheduler map.

■ VLAN—Virtual LAN, defined on an Ethernet logical interface.

These terms are especially important when applied to a scheduler hierarchy. Scheduler
hierarchies are composed of nodes and queues. Queues terminate the CLI hierarchy.
Nodes can be either root nodes, leaf nodes, or internal (non-leaf) nodes. Internal
nodes are nodes that have other nodes as “children” in the hierarchy. For example,
if an interface-set statement is configured with a logical interface (such as unit 0) and
queue, then the interface-set is an internal node at level 2 of the hierarchy. However,
if there are no traffic control profiles configured on logical interfaces, then the interface
set is at level 3 of the hierarchy.

Table 224 on page 913 shows how the configuration of an interface set or logical
interface affects the terminology of hierarchical scheduler nodes.

Table 224: Hierarchical Scheduler Nodes

Queue (Level 4)Level 3Level 2Root Node (Level 1)

One or more queuesLogical interfacesInterface setPhysical interface

One or more queuesInterface setPhysical interface

One or more queuesLogical interfacesPhysical interface

SRX3400 and SRX3600 Device Hardware Capabilities and Limitations

The following list describes the hardware capabilities and limitations for the SRX3400
and SRX3600 devices:
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■ For SRX3400 and SRX3600 devices, each Input/Output Card (IOC) Flexible PIC
Concentrator (FPC) or IOC slot has only one Physical Interface Card (PIC), which
contains either two 10-Gigabit or sixteen 1-Gigabit Ethernet ports. Table 225 on
page 914 shows the maximum number of cards and ports allowed in an SRX3400
and SRX3600 device.

Table 225:  Available NPCs and IO Ports for SRX3400 and SRX3600 Devices

NPCsIO PortsIOCsSystem

3108 (16 x 6 + 12)7SRX3600

276 (16 x 4 + 12)5SRX3400

NOTE: The number of ports the Network Processing Unit (NPU) needs to handle may
be different than the fixed 10:1 port to NPU ratio for 1G IOC, or the 1:1 ratio for the
10G IOC that is needed on the SRX5600 and SRX5800 devices, leading to
oversubscription on the SRX3400 and SRX3600 devices.

■ SRX3400 and SRX3600 devices allow you to install up to three Network
Processing Cards (NPC). In a single-NPC configuration, the NPC has to process
all of the packets to and from each IOC. However, when there is more than one
NPC available, an IOC will only exchange packets with a pre-assigned NPC. You
can use the set chassis ioc-npc-connectivity CLI statement to configure the
IOC-to-NPC mapping. By default, the mapping is assigned so that the load is
shared equally among all NPCs. When the mapping is changed, for example, an
IOC or NPC is removed, or you have mapped a specific NPC to an IOC, then the
device has to be restarted. For more information, see the JUNOS Software
Administration Guide for Security Devices.

■ For SRX3400 and SRX3600 devices, the IOC supports the following hierarchical
scheduler characteristics:

Level 1- Shaping at the physical interface (ifd)

Level 2- Shaping and scheduling at the logical interface level (ifl)

Level 3- Scheduling at the queue level

NOTE: Interface set (iflset) is not supported for the SRX3400 and SRX3600 devices.

■ Shaping at the port level—In SRX5600 and SRX5800 devices, an NPC supports
32 port-level shaping profiles at level 1, such that each front port can have its
own shaping profile.

In SRX3400 and SRX3600 devices, an NPC supports only 16 port-level shaping
profiles in the hardware, including two profiles that are predefined for 10-Gbps
and 1-Gbps shaping rates. The user can configure up to 14 different levels of
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shaping rates. If more levels are configured, then the closest match found in the
16 profiles will be used instead.

For example, assume that a system is already configured with the following rates
for ifds:

10Mbps, 20Mbps, 40Mbps, 60Mbps, 80Mbps, 100Mbps, 200Mbps, 300Mbps,
400Mbps, 500Mbps, 600Mbps, 700Mbps, 800Mbps, 900Mbps, 1Gbps
(predefined), 10Gbps (predefined)

Each of these 16 rates is programmed into one of the 16 profiles in the hardware,
then consider the following two scenarios.

1. If the user changes one port’s shaping rate from 1Gbps to 100Mbps, which
is already programmed in one of the 16 profiles, the profile with 100Mbps
shaping rate will be used by the port.

2. If the user changes another port’s shaping rate from 1Gbps to 50Mbps, which
is not in the shaping profiles, the closest matching profile with 60Mbps
shaping rate will be used instead.

When scenario 2) happens, not all of the user-configured rates can be supported
by the hardware. If more than 14 different rates are specified, only 14 will be
programmed in the hardware. Which 14 rates are programmed in the hardware
depends on many factors. For this reason, we recommend that you plan carefully
and use no more than 14 levels of port-level shaping rates.

■ Weighed Random Early Discard (WRED) at the port level—Each NPU has 512
MB of frame memory. Also, 10-Gigabit Ethernet ports get more buffers than the
1-Gigabit Ethernet ports. Buffer availability depends on how much bandwidth
(number of NPCs, ports, 1-Gigabit or 10-Gigabit, and so forth) the device has to
support. The more the bandwidth that the device has to support, the less buffer
is available. When two NPCs are available, the amount of frame buffer available
is doubled.

Configuring an Interface Set

To configure an interface set, include the following statement at the [edit
class-of-service interfaces] hierarchy level of the configuration:

[edit class-of-service interfaces]
interface-set interface-set-name {

(interface-cos-parameters);
}

To apply the interface set to interfaces, include the following statements at the [edit
interfaces] hierarchy level of the configuration:

interface-set interface-set-name {
ethernet-interface-name {

(interface-cos-parameters);
}

}
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Interface sets can be defined as a list of logical interfaces (unit 100, unit 200, and so
on). Service providers can use these statements to group interfaces to apply scheduling
parameters such as guaranteed rate and shaping rate to the traffic in the groups.

All traffic heading downstream must be gathered into an interface set with the
interface-set statement at the [edit class-of-service interfaces] hierarchy level.

Interface sets are currently only used by CoS, but they are applied at the [edit
interfaces] hierarchy level so that they might be available to other services.

[edit interfaces]
interface-set interface-set-name {

ethernet-interface-name {
unit unit-number {

...
}

}
}

The logical interface naming option lists Ethernet interfaces:

[edit interfaces]
interface-set unitl-set-ge-0 {

ge-0/0/0 {
unit 0;
unit 1;
...

}
}

NOTE: Ranges are not supported; you must list each logical interface separately.

Applying an Interface Set

Although the interface set is applied at the [edit interfaces] hierarchy level, the CoS
parameters for the interface set are defined at the [edit class-of-service interfaces]
hierarchy level, usually with the output-traffic-control-profile profile-name statement.

This example applies a traffic control profile called tcp--set1 to an interface set called
set-ge-0:

[edit interfaces]
interface-set set-ge-0 {

output-traffic-control-profile tcp-set1;
}

Interface Set Caveats

You cannot specify an interface set mixing the logical interface, S-VLAN, or VLAN
outer tag list forms of the interface-set statement.
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A logical interface can only belong to one interface set. If you try to add the same
logical interface to different interface sets, the commit will fail.

This example will generate a commit error:

[edit interfaces]
interface-set set-one {

ge-2/0/0 {
unit 0;
unit 2;

}
}
interface-set set-two {

ge-2/0/0 {
unit 1;
unit 3;
unit 0; # COMMIT ERROR! Unit 0 already belongs to -set-one.

}
}

Members of an interface set cannot span multiple physical interfaces. Only one
physical interface is allowed to appear in an interface set.

This configuration is not supported:

[edit interfaces]
interface-set set-group {

ge-0/0/1 {
unit 0;
unit 1;

}
ge-0/0/2 { # This type of configuration is NOT supported in the same interface set!

unit 0;
unit 1;

}
}

Introduction to Hierarchical Schedulers

When used, the interface set level of the hierarchy falls between the physical interface
level (level 1) and the logical interface (level 3). Queues are always level 4 of the
hierarchy.

Hierarchical schedulers add CoS parameters to the new interface set level of the
configuration. They use traffic control profiles to set values for parameters such as
shaping rate (the peak information rate [PIR]), guaranteed rate (the committed
information rate [CIR] on these interfaces), scheduler maps (assigning queues and
resources to traffic), and so on.

The following CoS configuration places the following parameters in traffic control
profiles at various levels:

■ Traffic control profile at the port level (tcp-port-level1):

■ A shaping rate (PIR) of 100 Mbps

■ A delay buffer rate of 100 Mbps
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■ Traffic control profile at the interface set level (tcp-interface-level2):

■ A shaping rate (PIR) of 60 Mbps

■ A guaranteed rate (CIR) of 40 Mbps

■ Traffic control profile at the logical interface level (tcp-unit-level3):

■ A shaping rate (PIR) of 50 Mbps

■ A guaranteed rate (CIR) of 30 Mbps

■ A scheduler map called smap1 to hold various queue properties (level 4)

■ A delay buffer rate of 40 Mbps

In this case, the traffic control profiles look like this:

[edit class-of-service traffic-control-profiles]
tcp-port-level1 { # This is the physical port level

shaping-rate 100m;
delay-buffer-rate 100m;

}
tcp-interface-level2 { # This is the interface set level

shaping-rate 60m;
guaranteed-rate 40m;

}
tcp-unit-level3 { # This is the logical interface level

shaping-rate 50m;
guaranteed-rate 30m;
scheduler-map smap1;
delay-buffer-rate 40m;

}

Once configured, the traffic control profiles must be applied to the proper places in
the CoS interfaces hierarchy.

[edit class-of-service interfaces]
interface-set level-2 {

output-traffic-control-profile tcp-interface-level-2;
}
ge-0/1/0 {

output-traffic-control-profile tcp-port-level-1;
unit 0 {

output-traffic-control-profile tcp-unit-level-3;
}

}

In all cases, the properties for level 4 of the hierarchical schedulers are determined
by the scheduler map.

Scheduler Hierarchy Example

This section provides a more complete example of building a 4-level hierarchy of
schedulers. The configuration parameters are shown in Figure 98 on page 919. The
queues are shown at the top of the figure with the other three levels of the hierarchy
below.
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Figure 98: Building a Scheduler Hierarchy

The figure's PIR values will be configured as the shaping rates, and the CIRs will be
configured as the guaranteed rate on the Ethernet interface ge-1/0/0. The PIR can
be oversubscribed (that is, the sum of the children PIRs can exceed the parent's, as
in svlan 1, where 200 + 200 + 100 exceeds the parent rate of 400). However, the
sum of the children node level's CIRs must never exceed the parent node's CIR, as
shown in all the service VLANs (otherwise, the guaranteed rate could never be
provided in all cases).

This configuration example will present all details of the CoS configuration for the
interface in the figure (ge-1/0/0), including:

■ Interface Sets for the Hierarchical Example on page 919

■ Interfaces for the Hierarchical Example on page 920

■ Traffic Control Profiles for the Hierarchical Example on page 920

■ Schedulers for the Hierarchical Example on page 921

■ Drop Profiles for the Hierarchical Example on page 922

■ Scheduler Maps for the Hierarchical Example on page 922

■ Applying Traffic Control Profiles for the Hierarchical Example on page 922

Interface Sets for the Hierarchical Example

[edit interfaces]
interface-set svlan-0 {

interface ge-1/0/0 {
unit 0;
unit 1;

}
}
interface-set svlan-1 {

interface ge-1/0/0 {
unit 2;
unit 3;
unit 4;

}
}
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Interfaces for the Hierarchical Example

The keyword to configure hierarchical schedulers is at the physical interface level,
as are VLAN tagging and the VLAN IDs. In this example, the interface sets are defined
by logical interfaces (units) and not outer VLAN tags. All VLAN tags in this example
are customer VLAN tags.

[edit interface ge-1/0/0]
hierarchical-scheduler;
vlan-tagging;
unit 0 {

vlan-id 100;
}
unit 1 {

vlan-id 101;
}
unit 2 {

vlan-id 102;
}
unit 3 {

vlan-id 103;
}
unit 4 {

vlan-id 104;
}

Traffic Control Profiles for the Hierarchical Example

The traffic control profiles hold parameters for levels above the queue level of the
scheduler hierarchy. This section defines traffic control profiles for both the service
VLAN level (logical interfaces) and the customer VLAN (VLAN tag) level.

[edit class-of-service traffic-control-profiles]
tcp-500m-shaping-rate {

shaping-rate 500m;
}
tcp-svlan0 {

shaping-rate 200m;
guaranteed-rate 100m;
delay-buffer-rate 300m; # This parameter is not shown in the figure

}
tcp-svlan1 {

shaping-rate 400m;
guaranteed-rate 300m;
delay-buffer-rate 100m; # This parameter is not shown in the figure

}
tcp-cvlan0 {

shaping-rate 100m;
guaranteed-rate 60m;
scheduler-map tcp-map-cvlan0; # This example applies scheduler maps to customer

VLANs
}
tcp-cvlan1 {

shaping-rate 100m;
guaranteed-rate 40m;
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scheduler-map tcp-map-cvlan1; # This example applies scheduler maps to customer
VLANs

}
tcp-cvlan2 {

shaping-rate 200m;
guaranteed-rate 100m;
scheduler-map tcp-map-cvlanx; # This example applies scheduler maps to customer

VLANs
}
tcp-cvlan3 {

shaping-rate 200m;
guaranteed-rate 150m;
scheduler-map tcp-map-cvlanx; # This example applies scheduler maps to customer

VLANs
}
tcp-cvlan4 {

shaping-rate 100m;
guaranteed-rate 50m;
scheduler-map tcp-map-cvlanx; # This example applies scheduler maps to customer

VLANs
}

Schedulers for the Hierarchical Example

The schedulers hold the information about the queues, the last level of the hierarchy.
Note the consistent naming schemes applied to repetitive elements in all parts of
this example.

[edit class-of-service schedulers]
sched-cvlan0-qx {

priority low;
transmit-rate 20m;
buffer-size temporal 100ms;
drop-profile-map loss-priority low dp-low;
drop-profile-map loss-priority high dp-high;

}
sched-cvlan1-q0 {

priority high;
transmit-rate 20m;
buffer-size percent 40;
drop-profile-map loss-priority low dp-low;
drop-profile-map loss-priority high dp-high;

}
sched-cvlanx-qx {

transmit-rate percent 30;
buffer-size percent 30;
drop-profile-map loss-priority low dp-low;
drop-profile-map loss-priority high dp-high;

}
sched-cvlan1-qx {

transmit-rate 10m;
buffer-size temporal 100ms;
drop-profile-map loss-priority low dp-low;
drop-profile-map loss-priority high dp-high;

}
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Drop Profiles for the Hierarchical Example

This section configures the drop profiles for the example. For more information about
drop profiles, see “Configuring RED Drop Profiles for Congestion Control” on page 854.

[edit class-of-service drop-profiles]
dp-low {

interpolate fill-level 80 drop-probability 80;
interpolate fill-level 100 drop-probability 100;

}
dp-high {

interpolate fill-level 60 drop-probability 80;
interpolate fill-level 80 drop-probability 100;

}

Scheduler Maps for the Hierarchical Example

This section configures the scheduler maps for the example. Each one references a
scheduler configured in “Schedulers for the Hierarchical Example” on page 921.

[edit class-of-service scheduler-maps]
tcp-map-cvlan0 {

forwarding-class voice scheduler sched-cvlan0-qx;
forwarding-class video scheduler sched-cvlan0-qx;
forwarding-class data scheduler sched-cvlan0-qx;

}
tcp-map-cvlan1 {

forwarding-class voice scheduler sched-cvlan1-q0;
forwarding-class video scheduler sched-cvlan1-qx;
forwarding-class data scheduler sched-cvlan1-qx;

}
tcp-map-cvlanx {

forwarding-class voice scheduler sched-cvlanx-qx;
forwarding-class video scheduler sched-cvlanx-qx;
forwarding-class data scheduler sched-cvlanx-qx;

}

Applying Traffic Control Profiles for the Hierarchical Example

This section applies the traffic control profiles to the proper levels of the hierarchy.

NOTE: Although a shaping rate can be applied directly to the physical interface,
hierarchical schedulers must use a traffic control profile to hold this parameter, as
shown in “Controlling Remaining Traffic” on page 923.

[edit class-of-service interfaces]
ge-1/0/0 {

output-traffic-control-profile tcp-500m-shaping-rate;
unit 0 {

output-traffic-control-profile tcp-cvlan0;
}
unit 1 {
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output-traffic-control-profile tcp-cvlan1;
}
unit 2 {

output-traffic-control-profile tcp-cvlan2;
}
unit 3 {

output-traffic-control-profile tcp-cvlan3;
}
unit 4 {

output-traffic-control-profile tcp-cvlan4;
}

}
interface-set svlan0 {

output-traffic-control-profile tcp-svlan0;
}
interface-set svlan1 {

output-traffic-control-profile tcp-svlan1;
}

Controlling Remaining Traffic

You can configure many logical interfaces under an interface. However, only a subset
of them might have a traffic control profile attached. For example, you can configure
three logical interfaces (units) over the same service VLAN, but you can apply a traffic
control profile specifying best-effort and voice queues to only one of the logical
interface units. Traffic from the two remaining logical interfaces is considered
remaining traffic. To configure transmit rate guarantees for the remaining traffic, you
configure the output-traffic-control-profile-remaining statement specifying a guaranteed
rate for the remaining traffic. Without this statement, the remaining traffic gets a
default, minimal bandwidth. In the same way, the shaping-rate and delay-buffer-rate
statements can be specified in the traffic control profile referenced with the
output-traffic-control-profile-remaining statement in order to shape and provide buffering
for remaining traffic.

Consider the interface shown in Figure 99 on page 924. Customer VLANs 3 and 4
have no explicit traffic control profile. However, the service provider might want to
establish a shaping and guaranteed transmit rate for aggregate traffic heading for
those customer VLANs. The solution is to configure and apply a traffic control profile
for all remaining traffic on the interface.
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Figure 99: Handling Remaining Traffic

This example considers the case where customer VLANs 3 and 4 have no explicit
traffic control profile, yet need to establish a shaping and guaranteed transmit rate
for traffic heading for those customer VLANs. The solution is to add a traffic control
profile to the svlan1 interface set. This example builds on the example used in
“Scheduler Hierarchy Example” on page 918 and so this does not repeat all
configuration details, only those at the service VLAN level.

[edit class-of-service interfaces]
interface-set svlan0 {

output-traffic-control-profile tcp-svlan0;
}
interface-set svlan1 {

output-traffic-control-profile tcp-svlan1;
output-traffic-control-profile-remaining tcp-svlan1-remaining; # For all remaining traffic

}

[edit class-of-service traffic-control-profiles]
tcp-svlan1 {

shaping-rate 400m;
guaranteed-rate 300m;

}
tcp-svlan1-remaining {

shaping-rate 300m;
guaranteed-rate 200m;
scheduler-map smap-remainder; # this smap is not shown in detail

}

Next, consider the example shown in Figure 100 on page 925.
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Figure 100: Another Example of Handling Remaining Traffic

In this example, ge-1/0/0 has five logical interfaces (cvlan 0, 1, 2, 3 and 4), and
svlan0, which are covered by the interface set:

■ Scheduling for the interface set svlan0 is specified by referencing an
output-traffic-control-profile statement, which specifies the guaranteed-rate,
shaping-rate, and delay-buffer-rate statement values for the interface set. In this
example, the output traffic control profile called tcp-svlan0 guarantees 100 Mbps
and shapes the interface set svlan0 to 200 Mbps.

■ Scheduling and queuing for remaining traffic of svlan0 is specified by referencing
an output-traffic-control-profile-remaining statement, which references a
scheduler-map statement that establishes queues for the remaining traffic. The
specified traffic control profile can also configure guaranteed, shaping, and
delay-buffer rates for the remaining traffic. In this example,
output-traffic-control-profile-remaining tcp-svlan0-rem references scheduler-map
smap-svlan0-rem, which calls for a best-effort queue for remaining traffic (that
is, traffic on unit 3 and unit 4, which is not classified by the svlan0 interface set).
The example also specifies a guaranteed-rate of 200 Mbps and a shaping-rate of
300 Mbps for all remaining traffic.

■ Scheduling and queuing for logical interface ge-1/0/0 unit 1 is configured
“traditionally” and uses an output-traffic-control-profile specified for that unit. In
this example, output-traffic-control-profile tcp-ifl1 specifies scheduling and queuing
for ge-1/0/0 unit 1.

This example does not include the [edit interfaces] configuration.

[edit class-of-service interfaces]
interface-set {

svlan0 {
output-traffic-control-profile tcp-svlan0; # Guarantee & shaper for svlan0

}
}
ge-1/0/0 {

output-traffic-control-profile-remaining tcp-svlan0-rem
# Unit 3 and 4 are not explicitly configured, but captured by “remaining'
unit 1 {
output-traffic-control-profile tcp-ifl1; # Unit 1 be & ef queues
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}
}

Here is how the traffic control profiles for this example are configured:

[edit class-of-service traffic-control-profiles]
tcp-svlan0 {

shaping-rate 200m;
guaranteed-rate 100m;

}
tcp-svlan0-rem {

shaping-rate 300m;
guaranteed-rate 200m;
scheduler-map smap-svlan0-rem; # This specifies queues for remaining traffic

}
tcp-ifl1 {

scheduler-map smap-ifl1;
}

Finally, here are the scheduler maps and queues for the example:

[edit class-of-service scheduler-maps]
smap-svlan0-rem {

forwarding-class best-effort scheduler sched-foo;
}
smap-ifl1 {

forwarding-class best-effort scheduler sched-bar;
forwarding-class assured-forwarding scheduler sched-baz;

}

The configuration for the referenced schedulers is not given for this example.

Internal Scheduler Nodes

A node in the hierarchy is considered internal if either of the following conditions
apply:

■ Any one of its children nodes has a traffic control profile configured and applied.

■ You configure the internal-node statement.

Why would it be important to make a certain node internal? Generally, there are
more resources available at the logical interface (unit) level than at the interface set
level. Also, it might be desirable to configure all resources at a single level, rather
than spread over several levels. The internal-node statement provides this flexibility.
This can be a helpful configuration device when interface-set queuing without logical
interfaces is used exclusively on the interface.

The internal-node statement can be used to raise the interface set without children
to the same level as the other configured interface sets with children, allowing them
to compete for the same set of resources.

In summary, using the internal-node statement allows statements to all be scheduled
at the same level with or without children.
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The following example makes the interfaces sets if-set-1 and if-set-2 internal:

[edit class-of-service interfaces ]
interface-set {

if-set-1 {
internal-node;
output-traffic-control-profile tcp-200m-no-smap;

}
if-set-2 {

internal-node;
output-traffic-control-profile tcp-100m-no-smap;

}
}

If an interface set has logical interfaces configured with a traffic control profile, then
the use of the internal-node statement has no effect.

Internal nodes can specify a traffic-control-profile-remaining statement.

PIR-only and CIR Mode

The actual behavior of many CoS parameters, especially the shaping rate and
guaranteed rate, depend on whether the physical interface is operating in PIR-only
(peak information rate) or CIR (committed information rate) mode.

In PIR-only mode, one or more nodes perform shaping. The physical interface is in
the PIR-only mode if no child (or grandchild) node under the port has a guaranteed
rate configured.

The mode of the port is important because in PIR-only mode, the scheduling across
the child nodes is in proportion to their shaping rates (PIRs) and not the guaranteed
rates (CIRs). This can be important if the observed behavior is not what is anticipated.

In CIR mode, one or more nodes applies a guaranteed rate and might perform
shaping. A physical interface is in CIR mode if at least one child (or grandchild) node
has a guaranteed rate configured. In addition, any child or grandchild node under
the physical interface can have a shaping rate configured.

Only the guaranteed rate matters. In CIR mode, nodes that do not have a guaranteed
rate configured are assumed to have a very small guaranteed rate (queuing weight).

Priority Propagation

SRX5600 and SRX5800 devices with input/output cards (IOCs) perform priority
propagation. Priority propagation is useful for mixed traffic environments when, for
example, you want to make sure that the voice traffic of one customer does not
suffer due to the data traffic of another customer. Nodes and queues are always
serviced in the order of their priority. The priority of a queue is decided by
configuration (the default priority is low) in the scheduler. However, not all elements
of hierarchical schedulers have direct priorities configured. Internal nodes, for
example, must determine their priority in other ways.
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The priority of any internal node is decided by:

■ The highest priority of an active child (interface sets only take the highest priority
of their active children

■ Whether the node is above its configured guaranteed rate (CIR) or not (this is
relevant only if the physical interface is in CIR mode)

Each queue will have a configured priority and a hardware priority. The usual mapping
between the configured priority and the hardware priority as shown in Table 226 on
page 928.

Table 226: Queue Priority

Hardware PriorityConfigured Priority

0Strict-high

0High

1Medium-high

1Medium-low

2Low

In CIR mode, the priority for each internal node depends on whether the highest
active child node is above or below the guaranteed rate. The mapping between the
highest active child's priority and the hardware priority below and above the
guaranteed rate is shown in Table 227 on page 928.

Table 227: Internal Node Queue Priority for CIR Mode

Hardware Priority Above
Guaranteed Rate

Hardware Priority Below
Guaranteed Rate

Configured Priority of Highest
Active Child Node

00Strict-high

30High

31Medium-high

31Medium-low

32Low

In PIR-only mode, nodes cannot send if they are above the configured shaping rate.
The mapping between the configured priority and the hardware priority is for PIR-only
mode is shown in Table 228 on page 929.
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Table 228: Internal Node Queue Priority for PIR-Only Mode

Hardware PriorityConfigured Priority

0Strict-high

0High

1Medium-high

1Medium-low

2Low

A physical interface with hierarchical schedulers configured is shown in Figure 101
on page 929. The configured priorities are shown for each queue at the top of the
figure. The hardware priorities for each node are shown in parentheses. Each node
also shows any configured shaping rate (PIR) or guaranteed rate (CIR) and whether
or not the queues are above or below the CIR. The nodes are shown in one of three
states: above the CIR (clear), below the CIR (dark), or in a condition where the CIR
does not matter (gray).

Figure 101: Hierarchical Schedulers and Priorities

In the figure, the strict high queue for customer VLAN 0 (cvlan 0) receives service
first, even though the customer VLAN is above the configured CIR (see Table 227 on
page 928 for the reason: strict-high always has hardware priority 0 regardless of CIR
state). Once that queue has been drained, and the priority of the node has become
3 instead of 0 (due to the lack of strict-high traffic), the system moves on to the
medium queues next (cvlan 1 and cvlan 3), draining them in a round robin fashion
(empty queues lose their hardware priority). The low queue on cvlan 4 (priority 2)
will be sent next, because that mode is below the CIR. Then the high queues on cvlan
0 and cvlan2 (both now with priority 3) are drained in a round-robin fashion, and
finally the low queue on cvlan 0 is drained (because svlan 0 has a priority of 3).
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IOC Hardware Properties

On SRX5600 and SRX5800 devices, two IOCs (40x1GE IOC and 4x10GE IOC) are
supported on which you can configure schedulers and queues. You can configure 15
VLAN sets per Gigabit Ethernet (40x1GE IOC) port and 255 VLAN sets per 10 Gigabit
Ethernet (4x10GE IOC) port. The IOC performs priority propagation from one
hierarchy level to another, and drop statistics are available on the IOC per color per
queue instead of just per queue.

SRX5600 and SRX5800 devices with IOCs have Packet Forwarding Engines that can
support up to 512 MB of frame memory, and packets are stored in 512–byte frames.
Table 229 on page 930 compares the major properties of the the Packet Forwarding
Engine within the IOC.

Table 229: Forwarding Engine Properties within 40x1GE IOC and 4x10GE IOC

PFE Within 40x1GE IOC and 4x10GE IOCFeature

16,000Number of usable queues

2,000 with 8 queues each, or 4,000 with 4 queues each.Number of shaped logical interfaces

4Number of hardware priorities

YesPriority propagation

Yes: schedulers/port are not fixed.Dynamic mapping

Per queue per color (PLP high, low)Drop statistics

Additionally, the IOC features also support hierarchical weighted random early
detection (WRED).

The IOC supports the following hierarchical scheduler characteristics:

■ Shaping at the physical interface level

■ Shaping and scheduling at the service VLAN interface set level

■ Shaping and scheduling at the customer VLAN logical interface level

■ Scheduling at the queue level

The IOC supports the following features for scalability:

■ 16,000 queues per PFE

■ 4 Packet Forwarding Engines per IOC

■ 4000 schedulers at logical interface level (level 3) with 4 queues each

■ 2000 schedulers at logical interface level (level 3) with 8 queues each

■ 255 schedulers at the interface set level (level 2) per 1-port PFE on a 10-Gigabit
Ethernet IOC (4x10GE IOC )
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■ 15 schedulers at the interface set level (level 2) per 10-port PFE on a 1-Gigabit
Ethernet IOC (40x1GE IOC )

■ About 400 milliseconds of buffer delay (this varies by packet size and if large
buffers are enabled)

■ 4 levels of priority (strict-high, high, medium, and low)

NOTE: The exact option for a transmit-rate (transmit-rate rate exact) is not supported
on the IOCs on SRX Series devices.

The manner in which the IOC maps a queue to a scheduler depends on whether 8
queues or 4 queues are configured. By default, a scheduler at level 3 has 4 queues.
Level 3 scheduler X controls queue X*4 to X*4+3, so that scheduler 100 (for example)
controls queues 400 to 403. However, when 8 queues per scheduler are enabled,
the odd-numbered schedulers are disabled, allowing twice the number of queues per
subscriber as before. With 8 queues, level 3 scheduler X controls queue X*4 to
X*4+7, so that scheduler 100 (for example) now controls queues 400 to 407.

You configure the max-queues-per-interface statement to set the number of queues
at 4 or 8 at the FPC level of the hierarchy. Changing this statement will result in a
restart of the FPC. For more information about the max-queues-per-interface statement,
see “Example: Configuring Up to Eight Forwarding Classes” on page 841 and the
JUNOS Software CLI Reference.

The IOC maps level 3 (customer VLAN) schedulers in groups to level 2 (service VLAN)
schedulers. Sixteen contiguous level 3 schedulers are mapped to level 2 when 4
queues are enabled, and 8 contiguous level 3 schedulers are mapped to level 2 when
8 queues are enabled. All the schedulers in the group should use the same queue
priority mapping. For example, if the queue priorities of one scheduler are high,
medium, low, and low, all members of the group should have the same queue priority.

Groups at level 3 to level 2 can be mapped at any time. However, a group at level 3
can only be unmapped from a level 2 scheduler, and only if all the schedulers in the
group are free. Once unmapped, a level 3 group can be remapped to any level 2
scheduler. There is no restriction on the number of level 3 groups that can be mapped
to a particular level 2 scheduler. There can be 256 level 3 groups, but fragmentation
of the scheduler space can reduce the number of schedulers available. In other words,
there are scheduler allocation patterns that might fail even though there are free
schedulers.

In contrast to level 3 to level 2 mapping, the IOC maps level 2 (service VLAN)
schedulers in a fixed mode to level 1 (physical interface) schedulers. On 40-port
Gigabit Ethernet IOCs, there are 16 level 1 schedulers, and 10 of these are used for
the physical interfaces. There are 256 level 2 schedulers, or 16 per level 1 scheduler.
A level 1 scheduler uses level schedulers X*16 through X*16+15. Therefore level 1
scheduler 0 uses level 2 schedulers 0 through 15, level 1 scheduler 1 uses level 2
schedulers 16 through 31, and so on. On 4-port 10 Gigabit Ethernet PICs, there is
one level 1 scheduler for the physical interface, and 256 level 2 schedulers are mapped
to the single level 1 scheduler.
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The maximum number of level 3 (customer VLAN) schedulers that can be used is
4076 (4 queues) or 2028 (8 queues) for the 10-port Gigabit Ethernet Packet Forwarding
Engine and 4094 (4 queues) or 2046 (8 queues) for the 10 Gigabit Ethernet Packet
Forwarding Engine.

WRED on the IOC

Shaping to drop out-of-profile traffic is done on the IOC at all levels except the queue
level. However, weighed random early discard (WRED) is done at the queue level
with much the same result. With WRED, the decision to drop or send the packet is
made before the packet is placed in the queue.

WRED shaping on the IOC involves two levels. The probabilistic drop region
establishes a minimum and a maximum queue depth. Below the minimum queue
depth, the drop probability is 0 (send). Above the maximum level, the drop probability
is 100 (certainty).

There are four drop profiles associated with each queue. These correspond to each
of four loss priorities (low, medium-low, medium-high, and high). Sixty-four sets of
four drop profiles are available (32 for ingress and 32 for egress). In addition, there
are eight WRED scaling profiles in each direction.

An IOC drop profile for expedited forwarding traffic might look like this:

[edit class-of-service drop-profiles]
drop-ef {

fill-level 20 drop-probability 0; # Minimum Q depth
fill-level 100 drop-probability 100; # Maximum Q depth

}

Note that only two fill levels can be specified for the IOC. You can configure the
interpolate statement, but only two fill levels are used. The delay-buffer-rate statement
in the traffic control profile determines the maximum queue size. This delay buffer
rate is converted to a packet delay buffers, where one buffer is equal to 512 bytes.
For example, at 10 Mbps, the IOC will allocate 610 delay buffers when the delay
buffer rate is set to 250 milliseconds. The WRED threshold values are specified in
terms of absolute buffer values.

The WRED scaling factor multiples all WRED thresholds (both minimum and
maximum) by the value specified. There are eight values in all: 1, 2, 4, 8, 16, 32, 64,
and 128. The WRED scaling factor is chosen to best match the user-configured drop
profiles. This is done because the hardware supports only certain values of thresholds
(all values must be a multiple of 16). So if the configured value of a threshold is 500
(for example), the multiple of 16 is 256 and the scaling factor applied is 2, making
the value 512, which allows the value of 500 to be used. If the configured value of a
threshold is 1500, the multiple of 16 is 752 and the scaling factor applied is 2, making
the value 1504, which allows the value of 1500 to be used.

Hierarchical RED is used to support the oversubscription of the delay buffers (WRED
is configured only at the queue, physical interface, and PIC level). Hierarchical RED
works with WRED as follows:

■ If any level accepts the packet (the queue depth is less than the minimum buffer
level), this level accepts the packet.
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■ If any level probabilistically drops the packet, then this level drops the packet.

However, these rules might lead to the accepting of packets under loaded conditions
that might otherwise have been dropped. In other words, the logical interface will
accept packets if the physical interface is not congested.

Due to the limits placed on shaping thresholds used in the hierarchy, there is a
granularity associated with the IOCs. The shaper accuracies differ at various levels
of the hierarchy, with shapers at the logical interface level (level 3) being more
accurate than shapers at the interface set level (level 2) or the port level (level 1).
Table 230 on page 933 shows the accuracy of the logical interface shaper at various
speeds for Ethernet ports operating at 1 Gbps.

Table 230: Shaper Accuracy of 1-Gbps Ethernet at the Logical Interface Level

Step GranularityRange of Logical Interface Shaper

16 KbpsUp to 4.096 Mbps

32 Kbps4.096 to 8.192 Mbps

64 Kbps8.192 to 16.384 Mbps

128 Kbps16.384 to 32.768 Mbps

256 Kbps32.768 to 65.535 Mbps

512 Kbps65.535 to 131.072 Mbps

1024 Kbps131.072 to 262.144 Mbps

4096 Kbps262.144 to 1 Gbps

Table 231 on page 933 shows the accuracy of the logical interface shaper at various
speeds for Ethernet ports operating at 10 Gbps.

Table 231: Shaper Accuracy of 10-Gbps Ethernet at the Logical Interface Level

Step GranularityRange of Logical Interface Shaper

40 KbpsUp to 10.24 Mbps

80 Kbps10.24 to 20.48 Mbps

160 Kbps10.48 to 40.96 Mbps

320 Kbps40.96 to 81.92 Mbps

640 Kbps81.92 to 163.84 Mbps

1280 Kbps163.84 to 327.68 Mbps

2560 Kbps327.68 to 655.36 Mbps
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Table 231: Shaper Accuracy of 10-Gbps Ethernet at the Logical Interface
Level (continued)

Step GranularityRange of Logical Interface Shaper

10240 Kbps655.36 to 2611.2 Mbps

20480 Kbps2611.2 to 5222.4 Mbps

40960 Kbps5222.4 to 10 Gbps

Table 232 on page 934 shows the accuracy of the interface set shaper at various
speeds for Ethernet ports operating at 1 Gbps.

Table 232: Shaper Accuracy of 1-Gbps Ethernet at the Interface Set Level

Step GranularityRange of Interface Set Shaper

80 KbpsUp to 20.48 Mbps

320 Kbps20.48 Mbps to 81.92 Mbps

1.28 Mbps81.92 Mbps to 327.68 Mbps

20.48 Mbps327.68 Mbps to 1 Gbps

Table 233 on page 934 shows the accuracy of the interface set shaper at various
speeds for Ethernet ports operating at 10 Gbps.

Table 233: Shaper Accuracy of 10-Gbps Ethernet at the Interface Set Level

Step GranularityRange of Interface Set Shaper

500 KbpsUp to 128 Mbps

2 Mbps128 Mbps to 512 Mbps

8 Mbps512 Mbps to 2.048 Gbps

128 Mbps2.048 Gbps to 10 Gbps

Table 234 on page 934 shows the accuracy of the physical port shaper at various
speeds for Ethernet ports operating at 1 Gbps.

Table 234: Shaper Accuracy of 1-Gbps Ethernet at the Physical Port Level

Step GranularityRange of Physical Port Shaper

250 KbpsUp to 64 Mbps
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Table 234: Shaper Accuracy of 1-Gbps Ethernet at the Physical Port Level (continued)

Step GranularityRange of Physical Port Shaper

1 Mbps64 Mbps to 256 Mbps

4 Mbps256 Mbps to 1 Gbps

Table 235 on page 935 shows the accuracy of the physical port shaper at various
speeds for Ethernet ports operating at 10 Gbps.

Table 235: Shaper Accuracy of 10-Gbps Ethernet at the Physical Port Level

Step GranularityRange of Physical Port Shaper

2.5 MbpsUp to 640 Mbps

10 Mbps640 Mbps to 2.56 Gbps

40 Mbps2.56 Gbps to 10 Gbps

For more information about configuring RED drop profiles, see “Configuring RED
Drop Profiles for Congestion Control” on page 854.

MDRR on the IOC

The guaranteed rate (CIR) at the interface set level is implemented by using modified
deficit round-robin (MDRR). The IOC hardware provides four levels of strict priority.
There is no restriction on the number of queues for each priority. MDRR is used
among queues of the same priority. Each queue has one priority when it is under
the guaranteed rate and another priority when it is over the guaranteed rate but still
under the shaping rate (PIR). The IOC hardware implements the priorities with 256
service profiles. Each service profile assigns eight priorities for eight queues. One set
is for logical interfaces under the guaranteed rate and another set is for logical
interfaces over the guaranteed rate but under the shaping rate. Each service profile
is associated with a group of 16 level 3 schedulers, so there is a unique service profile
available for all 256 groups at level 3, giving 4,096 logical interfaces.

JUNOS Software provides three priorities for traffic under the guaranteed rate and
one reserved priority for traffic over the guaranteed rate that is not configurable.
JUNOS Software provides three priorities when there is no guaranteed rate configured
on any logical interface.

The relationship between JUNOS Software priorities and the IOC hardware priorities
below and above the guaranteed rate (CIR) is shown in Table 236 on page 936.
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Table 236: JUNOS Priorities Mapped to IOC Hardware Priorities

IOC Hardware Priority Above
Guaranteed Rate

IOC Hardware Priority Below Guaranteed
RateJUNOS Software Priority

HighHighStrict-high

LowHighHigh

LowMedium-highMedium-high

LowMedium-highMedium-low

LowMedium-lowLow

The JUNOS Software parameters are set in the scheduler map:

[edit class-of-service schedulers]
best-effort-scheduler {

transmit-rate percent 30; # if no shaping rate
buffer-size percent 30;
priority high;

}
expedited-forwarding-scheduler {

transmit-rate percent 40; # if no shaping rate
buffer-size percent 40;
priority strict-high;

}

NOTE: The use of both shaping rate and a guaranteed rate at the interface set level
(level 2) is not supported.

MDRR is provided at three levels of the scheduler hierarchy of the IOC with a
granularity of 1 through 255. There are 64 MDRR profiles at the queue level, 16 at
the interface set level, and 32 at the physical interface level.

Queue transmit rates are used for queue-level MDRR profile weight calculation. The
queue MDRR weight is calculated differently based on the mode set for sharing excess
bandwidth. If you configure the equal option for excess bandwidth, then the queue
MDRR weight is calculated as:

Queue weight = (255 * Transmit-rate-percentage) / 100

If you configure the proportional option for excess bandwidth, which is the default,
then the queue MDRR weight is calculated as:

Queue weight = Queue-transmit-rate / Queue-base-rate, where

Queue-transmit-rate = (Logical-interface-rate * Transmit-rate-percentage) / 100, and

Queue-base-rate = Excess-bandwidth-proportional-rate / 255
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To configure the way that the IOC should handle excess bandwidth, configure the
excess-bandwidth-share statement at the [edit interface-set interface-set-name] hierarchy
level. By default, the excess bandwidth is set to proportional with a default value of
32.64 Mbps. In this mode, the excess bandwidth is shared in the ratio of the logical
interface shaping rates. If set to equal, the excess bandwidth is shared equally among
the logical interfaces.

This example sets the excess bandwidth sharing to proportional at a rate of 100
Mbps with a shaping rate of 80 Mbps.

[edit interface-set example-interface-set]
excess-bandwidth-share proportional 100m;
output-traffic-control-profile PIR-80Mbps;

Shaping rates established at the logical interface level are used to calculate the MDRR
weights used at the interface set level. The 16 MDRR profiles are set to initial values,
and the closest profile with rounded values is chosen. By default, the physical port
MDRR weights are preset to the full bandwidth on the interface.

Configuring Excess Bandwidth Sharing

When using the IOC (40x1GE IOC or 4x10GE IOC) on an SRX Series device, there
are circumstances when you should configure excess bandwidth sharing and
minimum logical interface shaping. This section details some of the guidelines for
configuring excess bandwidth sharing.

■ Excess Bandwidth Sharing and Minimum Logical Interface Shaping on page 937

■ Selecting Excess Bandwidth Sharing Proportional Rates on page 938

■ Mapping Calculated Weights to Hardware Weights on page 938

■ Allocating Weight with Only Shaping Rates or Unshaped Logical
Interfaces on page 939

■ Sharing Bandwidth Among Logical Interfaces on page 940

Excess Bandwidth Sharing and Minimum Logical Interface Shaping

The default excess bandwidth sharing proportional rate is 32.65 Mbps (128 Kbps x
255). In order to have better weighed fair queuing (WFQ) accuracy among queues,
the shaping rate configured should be larger than the excess bandwidth sharing
proportional rate. Some examples are shown in Table 237 on page 937.

Table 237: Shaping Rates and WFQ Weights

Total WeightsWFQ WeightConfigured Queue Transmit RateShaping Rate

76(22, 30, 20, 4)(30, 40, 25, 5)10 Mbps

257(76, 104, 64, 13)(30, 40, 25, 5)33 Mbps

257(76, 104.64, 13)(30, 40, 25, 5)40 Mbps
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With a 10-Mbps shaping rate, the total weights are 76. This is divided among the
four queues according to the configured transmit rate. Note that when the shaping
rate is larger than the excess bandwidth sharing proportional rate of 32.65 Mbps,
the total weight on the logical interface is 257 and the WFQ accuracy will be the
same.

Selecting Excess Bandwidth Sharing Proportional Rates

To determine a good excess bandwidth-sharing proportional rate to configure, choose
the largest CIR (guaranteed rate) among all the logical interfaces (units). If the logical
units have PIRs (shaping rates) only, then choose the largest PIR rate. However, this
is not ideal if a single logical interface has a large WRR rate. This method can skew
the distribution of traffic across the queues of the other logical interfaces. To avoid
this issue, set the excess bandwidth-sharing proportional rate to a lower value on
the logical interfaces where the WRR rates are concentrated. This improves the
bandwidth sharing accuracy among the queues on the same logical interface.
However, the excess bandwidth sharing for the logical interface with the larger WRR
rate is no longer proportional.

As an example, consider five logical interfaces on the same physical port, each with
four queues, all with only PIRs configured and no CIRs. The WRR rate is the same
as the PIR for the logical interface. The excess bandwidth is shared proportionally
with a rate of 40 Mbps. The traffic control profiles for the logical interfaces are shown
in Table 238 on page 938.

Table 238: Example Shaping Rates and WFQ Weights

Total WeightsWFQ WeightConfigured Queue Transmit RateShaping Rate

63(60, 0, 0, 3)(95, 0, 0, 5)(Unit 0) 10 Mbps

128(32, 32, 32, 32)(25, 25, 25, 25)(Unit 1) 20 Mbps

255(102, 77, 51, 26)(40, 30, 20, 10)(Unit 2) 40 Mbps

255(179, 26, 26, 26)(70, 10, 10, 10)(Unit 3) 200 Mbps

20(5, 5, 5, 5)(25, 25, 25, 25)(Unit 4) 2 Mbps

Even though the maximum transmit rate for the queue on logical interface unit 3 is
200 Mbps, the excess bandwidth-sharing proportional rate is kept at a much lower
value. Within a logical interface, this method provides a more accurate distribution
of weights across queues. However, the excess bandwidth is now shared equally
between unit 2 and unit 3 (total weights = 255).

Mapping Calculated Weights to Hardware Weights

The calculated weight in a traffic control profile is mapped to hardware weight, but
the hardware only supports a limited WFQ profile. The weights are rounded to the
nearest hardware weight according to the values in Table 239 on page 939.
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Table 239: Rounding Configured Weights to Hardware Weights

Maximum ErrorWeights
Number of Traffic
Control Profiles

Traffic Control Profile
Number

50.00%1–16 (interval of 1)161–16

6.25%18–42 (interval of 2)1317–29

1.35%45–60 (interval of 3)630–35

2.25%64–92 (interval of 4)836–43

3.06%98–128 (interval of 6)644–49

3.13%136–184 (interval of 8)750–56

2.71%194–244 (interval of 10)657–62

2.05%255–255 (interval of 11)163–63

From the table, as an example, the calculated weight of 18.9 is mapped to a hardware
weight of 18, because 18 is closer to 18.9 than 20 (an interval of 2 applies in the
range 18–42).

Allocating Weight with Only Shaping Rates or Unshaped Logical Interfaces

Logical interfaces with only shaping rates (PIRs) or unshaped logical interfaces (units)
are given a weight of 10. A logical interface with a small guaranteed rate (CIR) might
get an overall weight less than 10. In order to allocate a higher share of the excess
bandwidth to logical interfaces with a small guaranteed rate in comparison to the
logical interfaces with only shaping rates configured, a minimum weight of 20 is
given to the logical interfaces with guaranteed rates configured.

For example, consider a logical interface configuration with five units, as shown in
Table 240 on page 939.

Table 240: Allocating Weights with PIR and CIR on Logical Interfaces

WeightsWRR PercentagesTraffic Control ProfileLogical Interface (Unit)

10, 1, 1, 195, 0, 0, 5PIR 100 MbpsUnit 1

64, 64, 64, 6425, 25, 25, 25CIR 20 MbpsUnit 2

128, 76, 38, 1350, 30, 15, 5PIR 40 Mbps, CIR 20 MbpsUnit 3

10, 1, 1, 195, 0, 0, 5UnshapedUnit 4

10, 1, 1, 195, 0, 0, 5CIR 1 MbpsUnit 5
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The weights for these units are calculated as follows:

■ Select the excess bandwidth-sharing proportional rate to be the maximum CIR
among all the logical interfaces: 20 Mbps (unit 2).

■ Unit 1 has a PIR and unit 4 is unshaped. The weight for these units is 10.

■ The weight for unit 1 queue 0 is 9.5 (10 x 95%), which translates to a hardware
weight of 10.

■ The weight for unit 1 queue 1 is 0 (0 x 0%), but although the weight is zero, a
weight of 1 is assigned to give minimal bandwidth to queues with zero WRR.

■ Unit 5 has a very small CIR (1 Mbps), and a weight of 20 is assigned to units with
a small CIR.

■ The weight for unit 5 queue 0 is 19 (20 x 95%), which translates to a hardware
weight of 18.

■ Unit 3 has a CIR of 20 Mbps, which is the same as the excess bandwidth-sharing
proportional rate, so it has a total weight of 255.

■ The weight of unit 3 queue 0 is 127.5 (255 x 50%), which translates to a hardware
weight of 128.

Sharing Bandwidth Among Logical Interfaces

As a simple example showing how bandwidth is shared among the logical interfaces,
assume that all traffic is sent on queue 0. Assume also that there is a 40-Mbps load
on all of the logical interfaces. Configuration details are shown in Table 241 on
page 940.

Table 241: Sharing Bandwidth Among Logical Interfaces

WeightsWRR PercentagesTraffic Control ProfileLogical Interface (Unit)

10, 1, 1, 195, 0, 0, 5PIR 100 MbpsUnit 1

64, 64, 64, 6425, 25, 25, 25CIR 20 MbpsUnit 2

128, 76, 38, 1350, 30, 15, 5PIR 40 Mbps, CIR 20 MbpsUnit 3

10, 1, 1, 195, 0, 0, 5UnshapedUnit 4

1. When the port is shaped at 40 Mbps, because units 2 and 3 have a guaranteed
rate (CIR) configured, both units 2 and 3 get 20 Mbps of shared bandwidth.

2. When the port is shaped at 100 Mbps, because units 2 and 3 have a guaranteed
rate (CIR) configured, each of them can transmit 20 Mbps. On units 1, 2, 3, and
4, the 60 Mbps of excess bandwidth is shaped according to the values shown in
Table 242 on page 941.
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Table 242: First Example of Bandwidth Sharing

BandwidthCalculationLogical Interface (Unit)

2.83 Mbps10 / (10+64+128+10) x 60 Mbps1

18.11 Mbps64 / (10+64+128+10) x 60 Mbps2

36.22 Mbps128 / (10+64+128+10) x 60 Mbps3

2.83 Mbps10 (10+64+128+10) x 60 Mbps4

However, unit 3 only has 20 Mbps extra (PIR and CIR) configured. This means that
the leftover bandwidth of 16.22 Mbps (36.22 Mbps – 20 Mbps) is shared among units
1, and 2, and 4. This is shown in Table 243 on page 941.

Table 243: Second Example of Bandwidth Sharing

BandwidthCalculationLogical Interface (Unit)

1.93 Mbps10 / (10+64+128+10) x 16.22 Mbps1

12.36 Mbps64 / (10+64+128+10) x 16.22 Mbps2

1.93 Mbps10 (10+64+128+10) x 16.22 Mbps4

Finally, Table 244 on page 941 shows the resulting allocation of bandwidth among
the logical interfaces when the port is configured with a 100-Mbps shaping rate.

Table 244: Final Example of Bandwidth Sharing

BandwidthCalculationLogical Interface (Unit)

4.76 Mbps2.83 Mbps + 1.93 Mbps1

50.47 Mbps20 Mbps + 18.11 Mbps + 12.36 Mbps2

40 Mbps20 Mbps + 20 Mbps3

4.76 Mbps2.83 Mbps + 1.93 Mbps4

Verifying a CoS Configuration

To verify a CoS configuration on a Services Router, perform the tasks relevant to
your CoS configuration from the following:

■ Verifying Multicast Session Announcements on page 942

■ Verifying a Virtual Channel Configuration on page 942
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■ Verifying a Virtual Channel Group Configuration on page 943

■ Verifying an Adaptive Shaper Configuration on page 943

■ Displaying CoS Tunnel Configurations on page 944

■ Verifying a CoS GRE Tunnel Queuing Configuration on page 944

■ Verifying a CoS IP-IP Tunnel Configuration on page 946

Verifying Multicast Session Announcements

Purpose Verify that the Services Router is listening to the appropriate groups for multicast
Session Announcement Protocol (SAP) session announcements.

Action From the CLI, enter the show sap listen command.

Sample Output user@host> show sap listen
Group Address   Port
224.2.127.254   9875

Meaning The output shows a list of the group addresses and ports that SAP and SDP listen on.
Verify the following information:

■ Each group address configured, especially the default 224.2.127.254, is listed.

■ Each port configured, especially the default 9875, is listed.

Related Topics For a complete description of the show sap listen command and output, see the Junos
Routing Protocols and Policies Command Reference.

Verifying a Virtual Channel Configuration

Purpose Verify the virtual channel configuration on a logical interface. Verify the class-of-service
(CoS) configuration associated with an interface on a Services Router.

Action From the CLI, enter the show class-of-service virtual-channel command.

Sample Output user@host> show class-of-service virtual-channel
Virtual channel: vc-1 Index: 1

Meaning Verify that the name of the configured virtual channel is displayed in the output.

Related Topics For a complete description of the show class-of-service virtual-channel command and
output, see the Junos System Basics and Services Command Reference.
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Verifying a Virtual Channel Group Configuration

Purpose Verify the virtual channel group configuration on a logical interface. Verify the
class-of-service (CoS) configuration associated with an interface on a Services Router.

Action From the CLI, enter the show class-of-service virtual-channel-group command.

Sample Output user@host> show class-of-service virtual-channel-group
Virtual channel group: vc-group, Index: 16321        Virtual channel: vc-1
   Scheduler map: sc-map

Meaning Verify that the name of the configured virtual channel group is displayed in the output.

Related Topics For a complete description of the show class-of-service virtual-channel-group command
and output, see the Junos System Basics and Services Command Reference.

Verifying an Adaptive Shaper Configuration

Purpose Verify the adaptive shaper trigger point and its associated transmit rate. Verify the
class-of-service (CoS) configuration associated with an interface on a Services Router.

Action From the CLI, enter the show class-of-service adaptive-shaper and show class-of-service
interface t1-0/0/2 commands.

Sample Output user@host> show class-of-service adaptive-shaper
Adaptive shaper: fr-shaper, Index: 35320
  Trigger type    Shaping rate
        BECN         64000 bps

user@host> show class-of-service interface t1-0/0/2
Physical interface: t1-0/0/2, Index: 137
Queues supported: 8, Queues in use: 4
  Scheduler map: <default>, Index: 2

  Logical interface: t1-0/0/2.0, Index: 69
    Object            Name                   Type                    Index
    Adaptive-shaper   fr-shaper                                      35320
    Classifier        ipprec-compatibility   ip                         11

Meaning Verify the following information:

■ The trigger type and shaping rate are consistent with the configured adaptive
shaper.

■ The adaptive shaper applied to the logical interface is displayed under Name.
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Related Topics For a complete description of the show class-of-service adaptive-shaper and show
class-of-service interface commands and output, see the Junos System Basics and
Services Command Reference.

Displaying CoS Tunnel Configurations

Purpose Verify the configuration of the CoS tunnel queuing on a Services Router. You can
analyze the flow of traffic by displaying the entire configuration. The following output
is specific to CoS queuing configuration.

Action From the CLI on Router A and B, enter the following show  commands.

Router B user@host# show interfaces gr-0/0/0
per-unit-scheduler

unit 0 {
tunnel
source 70.0.0.1;
destination 70.0.0.2;
family inet {

address 10.80.0.1/24;
}

}
}

user@host# show class-of-service interfaces gr-0/0/0
unit 0 {

scheduler-map SMAP;
shaping-rate 200m;

}

Router A user@host# show chassis
fpc 0 {

pic 0 {
tunnel-queuing

}
}
[edit]

Verifying a CoS GRE Tunnel Queuing Configuration

Purpose Verify that the Services Router is configured properly for tunnel configuration.

Action From the CLI, enter the show interfaces queue gr-0/0/0.0  command.

NOTE: If you enter gr-0/0/0 only, queue information for all tunnels is displayed. If
you enter gr-0/0/0 unit logical_unit_number queue information for the specific tunnel
is displayed.
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Sample Output user@host> show interfaces queue gr-0/0/0.0
Logical interface gr-0/0/0.0 (Index 68) (SNMP ifIndex 112) 
Forwarding classes: 8 supported, 4 in use 
Egress queues: 8 supported, 4 in use Burst size: 0
Queue: 0, Forwarding classes: VOICE
  Queued:
    Packets              :               7117734                  7998 pps
    Bytes                :             512476848               4606848 bps
  Transmitted:
    Packets              :               4548146                  3459 pps
    Bytes                :             327466512               1992912 bps
    Tail-dropped packets :                     0                     0 pps
    RED-dropped packets  :               2569421                  4537 pps
     Low                 :                     0                     0 pps
     Medium-low          :                     0                     0 pps
     Medium-high         :                     0                     0 pps
     High                :               2569421                  4537 pps
    RED-dropped bytes    :             184998312               2613640 bps
     Low                 :                     0                     0 bps
     Medium-low          :                     0                     0 bps
     Medium-high         :                     0                     0 bps
     High                :             184998312               2613640 bps
Queue: 1, Forwarding classes: GOLD
  Queued:
    Packets              :                117600                     0 pps
    Bytes                :               8467200                     0 bps
  Transmitted:
    Packets              :                102435                     0 pps
    Bytes                :               7375320                     0 bps
    Tail-dropped packets :                     0                     0 pps
    RED-dropped packets  :                 15165                     0 pps
     Low                 :                     0                     0 pps
     Medium-low          :                     0                     0 pps
     Medium-high         :                     0                     0 pps
     High                :                 15165                     0 pps
    RED-dropped bytes    :               1091880                     0 bps
     Low                 :                     0                     0 bps
     Medium-low          :                     0                     0 bps
     Medium-high         :                     0                     0 bps
     High                :               1091880                     0 bps
Queue: 2, Forwarding classes: SILVER
  Queued:
    Packets              :                     0                     0 pps
    Bytes                :                     0                     0 bps
  Transmitted:
    Packets              :                     0                     0 pps
    Bytes                :                     0                     0 bps
    Tail-dropped packets :                     0                     0 pps
    RED-dropped packets  :                     0                     0 pps
     Low                 :                     0                     0 pps
     Medium-low          :                     0                     0 pps
     Medium-high         :                     0                     0 pps
     High                :                     0                     0 pps
    RED-dropped bytes    :                     0                     0 bps
     Low                 :                     0                     0 bps
     Medium-low          :                     0                     0 bps
     Medium-high         :                     0                     0 bps
     High                :                     0                     0 bps
Queue: 3, Forwarding classes: BRONZE
  Queued:
    Packets              :                     0                     0 pps
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    Bytes                :                     0                     0 bps
  Transmitted:
    Packets              :                     0                     0 pps
    Bytes                :                     0                     0 bps
    Tail-dropped packets :                     0                     0 pps
    RED-dropped packets  :                     0                     0 pps
     Low                 :                     0                     0 pps
     Medium-low          :                     0                     0 pps
     Medium-high         :                     0                     0 pps
     High                :                     0                     0 pps
    RED-dropped bytes    :                     0                     0 bps
     Low                 :                     0                     0 bps
     Medium-low          :                     0                     0 bps
     Medium-high         :                     0                     0 bps
     High                :                     0                     0 bps

Meaning The output lists the egress queues and the corresponding forwarding classes. Assuming
that traffic is correctly classified using appropriate classifiers on the ingress port,
verify the traffic flow in various queues.

Related Topics For a complete description of the show interfaces queue  command and output, see
the Junos Interfaces Command Reference.

Verifying a CoS IP-IP Tunnel Configuration

Purpose Verify that the Services Router is configured properly for tunnel configuration.

Action From the CLI, enter the show interfaces queue ip-0/0/0.0  command.

NOTE: If you enter ip-0/0/0 only, queue information for all tunnels is displayed. If
you enter ip-0/0/0 unit logical_unit_number queue information for the specific tunnel
is displayed.

Sample Output user@host> show interfaces queue ip-0/0/0.0
Logical interface ip-0/0/0.0 (Index 70) (SNMP ifIndex 56
Forwarding classes: 8 supported, 4 in use
Egress queues: 8 supported, 4 in use
Burst size: 0
Queue: 0, Forwarding classes: q0
Queued:
  Packets: 38802710 22687 pps
  Bytes: 10942364220 51183344 bps

Meaning The output lists the egress queues and the corresponding forwarding classes. Assuming
that traffic is correctly classified using appropriate classifiers on the ingress port,
verify the traffic flow in various queues.
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Related Topics For a complete description of the show interfaces queue  command and output, see
the Junos Interfaces Command Reference.

Configuring Class of Service for IPv6 Traffic

The following topics describe class-of-service functions for IPv6 traffic and provide
examples on how to configure classifiers and rewrite rules that use IPv6 DiffServ
code points:

■ Overview of Class-of-Service Functions for IPv6 Traffic on page 947

■ Configuring and Applying a DSCP IPv6 BA Classifier on page 949

■ Configuring DSCP IPv6 Rewrite Rules on page 953

Overview of Class-of-Service Functions for IPv6 Traffic

Class-of-service (CoS) processing for IPv6 traffic uses the IPv6 DiffServ code point
(DSCP) value. The IPv6 DSCP value is the first six bits in the 8-bit Traffic Class field
of the IPv6 header. The DSCP value is used to determine the behavior aggregate (BA)
classification for the packet entering the network device. You use classifier rules to
map the DSCP code points to a forwarding class and packet loss priority. You use
rewrite rules to map the forwarding class and packet loss priority back to DSCP values
on packets exiting the device.

Figure 102 on page 947 shows the components of the CoS features for SRX Series
and J Series devices, illustrating the sequence in which they interact.

Figure 102: Packet Flow Through an SRX Series or J Series Device

NOTE: Not all features are supported on all SRX Series devices. For information on
the set of CoS features supported for your Juniper Networks device, see the Junos OS
Feature Support Reference for SRX Series and J Series Devices.
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CoS components perform the following operations:

1. BA classifier rules map DSCP code points to a forwarding class and loss priority.
The forwarding class and loss priority determine the per-hop behavior of the
packet throughout the system. The forwarding class associates a packet with an
outbound transmission queue. Loss priority affects the scheduling of a packet
without affecting the relative ordering of packets. BA classification is a simple
way that “downstream” nodes can honor the CoS objectives that were encoded
“upstream”.

See “Configuring and Applying a DSCP IPv6 BA Classifier” on page 949.

2. Multifield classifier rules overwrite the initial forwarding class and loss priority
determination read by the BA classifier rule. You typically use multifield classifier
rules on nodes close to the content origin, where a packet might not have been
encoded with the desired DSCP values in the headers. A multifield classifier rule
assigns packets to a forwarding class and assigns a packet loss priority based on
filters, such as source IP, destination IP, port, or application.

See “Configuring and Applying a Firewall Filter for a Multifield Classifier” on
page 835.

3. Input policers meter traffic to see if traffic flow exceeds its service level. Policers
might discard, change the forwarding class and loss priority, or set the packet
loss priority bit of a packet. A packet for which the packet loss priority bit is set
has an increased probability of being dropped during congestion.

See “Configuring a Policer for a Firewall Filter” on page 834.

4. Scheduler maps are applied to interfaces and associate the outgoing packets with
a scheduler and a forwarding class.

The scheduler manages the output transmission queue, including:

■ Buffer size—Defines the period for which a packet is stored during
congestion.

■ Scheduling priority and transmit rate—Determine the order in which a packet
is transmitted.

■ Drop profile—Defines how aggressively to drop a packet that is using a
particular scheduler.

See “Configuring Schedulers” on page 857.

5. Output policers meter traffic and might change the forwarding class and loss
priority of a packet if a traffic flow exceeds its service level.

See “Configuring a Policer for a Firewall Filter” on page 834.

6. Rewrite rules map forwarding class and packet loss priority to DSCP values. You
typically use rewrite rules in conjunction with multifield classifier rules close to
the content origin; or when the device is at the border of a network and must
alter the code points to meet the policies of the targeted peer.

See “Configuring DSCP IPv6 Rewrite Rules” on page 953.
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Only BA classification rules and rewrite rules require special consideration to support
CoS for IPv6 traffic. The program logic for the other CoS features is not sensitive to
differences between IPv4 and IPv6 traffic.

Configuring and Applying a DSCP IPv6 BA Classifier

A behavior aggregate (BA) classifier rule maps DSCP code points to a forwarding
class and loss priority. The forwarding class and loss priority determine the per-hop
behavior of the packet throughout the system. The forwarding class associates a
packet with an outbound transmission queue. Loss priority affects the scheduling of
a packet without affecting the relative ordering of packets.

BA classification can be applied within one DiffServ domain or between two domains,
where each domain honors the CoS results generated by the other domain. Table
245 on page 949 shows the mapping for the default DSCP IPv6 BA classifier.

Table 245:  Default IPv6 BA Classifier

Packet Loss PriorityForwarding ClassDSCP IPv6 AliasCode Points

lowexpedited-forwardingef101110

lowassured-forwardingaf11001010

highassured-forwardingaf12001100

highassured-forwardingaf13001110

lowbest-effortaf21010010

lowbest-effortaf22010100

lowbest-effortaf23010110

lowbest-effortaf31011010

lowbest-effortaf32011100

lowbest-effortaf33011110

lowbest-effortaf41100010

lowbest-effortaf42100100

lowbest-effortaf43100110

lowbest-effortbe000000

lowbest-effortcs1001000

lowbest-effortcs2010000

lowbest-effortcs3011000

lowbest-effortcs4100000
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Table 245:  Default IPv6 BA Classifier (continued)

Packet Loss PriorityForwarding ClassDSCP IPv6 AliasCode Points

lowbest-effortcs5101000

lownetwork-controlnc1/cs6110000

lownetwork-controlnc2/cs7111000

You can use the CLI show command to display the settings for the CoS classifiers.
The following command shows the settings for the default DSCP IPv6 classifier:

Displaying the settings
for the default DSCP

IPv6 classifier

user@host# show class-of-service classifier type dscp-ipv6
Classifier: dscp-ipv6-default, Code point type: dscp-ipv6, Index: 8
  Code point         Forwarding class                    Loss priority
  000000             best-effort                         low
  000001             best-effort                         low
  000010             best-effort                         low
  000011             best-effort                         low
  000100             best-effort                         low
  000101             best-effort                         low
  011011             best-effort                         low
...
Classifier: dscp-ipv6-compatibility, Code point type: dscp-ipv6, Index: 9
  Code point         Forwarding class                    Loss priority
  000000             best-effort                         low
  000001             best-effort                         low
  000010             best-effort                         low
  000011             best-effort                         low
  000100             best-effort                         low
  000101             best-effort                         low
  000110             best-effort                         low
  000111             best-effort                         low
 ...

NOTE: The predefined classifier named dscp-ipv6–compatibility maps all code points
loss priority to low. It maps 110000 and 111000 (typically seen in network control
packets) to the network-control class and all other code points to the best-effort class.
The dscp-ipv6–compatibility is an implicit classifier similar to the ipprec-compatibility
provided to map IP precedence bits in IPv4 traffic when no classifier has been
configured.

The following example CLI command associates the ge-0/0/0 interface with the
default DSCP IPv6 classifier:

Using the default DSCP
IPv6 BA classifier

user@host# set class-of-service interfaces ge-0/0/0 unit 0 classifiers dscp-ipv6
default
user@host# show class-of-service interfaces
ge-0/0/0 {
        unit 0 {
            classifiers {
                dscp-ipv6 default;
            }
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        }
    }

If necessary, you can create a user-defined DSCP IPv6 BA classifier with the CLI.

The following steps create a classifier named dscp-ipv6-example:

1. Navigate to the [class-of-service] hierarchy:

user@host# edit class-of-service

2. For this example, use the following commands to map queues to user-defined
forwarding classes:

[edit class-of-service]

user@host# set forwarding-classes queue 0 be-class

[edit class-of-service]

user@host# set forwarding-classes queue 1 ef-class

[edit class-of-service]

user@host# set forwarding-classes queue 2 af-class

[edit class-of-service]

user@host# set forwarding-classes queue 3 nc-class

3. Create a new behavior aggregate classifier for DiffServ CoS:

[edit class-of-service]

user@host# edit classifiers dscp-ipv6 dscp-ipv6-example

4. Import the default DSCP IPv6 classifier so that it can be used to classify the code
points you do not explicitly cover in your configuration:

[edit class-of-service classifiers dscp-ipv6 dscp-ipv6-example]

user@host# set import default

5. Specify a best-effort forwarding class classifier:

[edit class-of-service classifiers dscp-ipv6 dscp-ipv6-example]

user@host# set forwarding-class be-class loss-priority high code-points
000001

6. Specify an expedited forwarding class classifier:

[edit class-of-service classifiers dscp-ipv6 dscp-ipv6-example]

user@host# set forwarding-class ef-class loss-priority high code-points
101111

7. Specify an assured forwarding class classifier:

[edit class-of-service classifiers dscp-ipv6 dscp-ipv6-example]

user@host# set forwarding-class af-class loss-priority high code-points
001100
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8. Specify a network control class classifier:

[edit class-of-service classifiers dscp-ipv6 dscp-ipv6-example]

user@host# set forwarding-class nc-class loss-priority high code-points
110001

9. Go to the [class-of-service] level in the hierarchy and apply your user-defined
classifier to an interface:

[edit class-of-service classifiers dscp-ipv6 dscp-ipv6–example]
user@host# up
[edit class-of-service classifiers]
user@host# up
[edit class-of-service]
user@host# set interfaces ge-0/0/0 unit 0 classifiers dscp-ipv6
dscp-ipv6-example

10. Use the show command to review your configuration. If the output does not
display the intended configuration, repeat the configuration instructions in this
example to correct it.

[edit class-of-service]
user@host# show

classifiers {
    dscp-ipv6 dscp-ipv6–example {
        import default;
        forwarding-class be-class {
            loss-priority high code-points 000001;
        }
        forwarding-class ef-class {
            loss-priority high code-points 101111;
        }
        forwarding-class af-class {
            loss-priority high code-points 001100;
        }
        forwarding-class nc-class {
            loss-priority high code-points 110001;
        }
    }
}
forwarding-classes {
    queue 0 be-class;
    queue 1 ef-class;
    queue 2 af-class;
    queue 3 nc-class;
}

interfaces {
    ge-0/0/0 {
        unit 0 {
            classifiers {
                dscp-ipv6 dscp-ipv6–example;
            }
        }
    }
}

11. Check your changes to the configuration before committing.
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[edit class-of-service]
user@host# commit check

configuration check succeeds

12. Commit the configuration.

[edit class-of-service]
user@host# commit

commit complete

Configuring DSCP IPv6 Rewrite Rules

A rewrite rule maps the forwarding class and loss priority after JUNOS CoS processing
to a corresponding DSCP value specified in the rule. Typically, you use rewrite rules
to alter the CoS values in outgoing packets to meet the requirements of the targeted
peer.

You can use the CLI show command to display the configuration for the CoS classifiers.
The following command shows the configuration of the default DSCP IPv6 rewrite
rule:

Displaying the
configuration for the

user@host# show class-of-service rewrite-rule type dscp-ipv6
Rewrite rule: dscp-ipv6-default, Code point type: dscp-ipv6, Index: 32
  Forwarding class                    Loss priority       Code pointdefault DSCP IPv6

rewrite rule   best-effort                         low                 000000
  best-effort                         high                000000
  expedited-forwarding                low                 101110
  expedited-forwarding                high                101110
  assured-forwarding                  low                 001010
  assured-forwarding                  high                001100
  network-control                     low                 110000
  network-control                     high                111000

The following example configuration statement associates the ge-0/0/0 interface
with the default DSCP IPv6 rewrite rule:

Using the default DSCP
IPv6 rewrite rule

user@host# set class-of-service interfaces ge-0/0/0 unit 0 rewrite-rules dscp-ipv6
default
user@host# show class-of-service interfaces
ge-0/0/0 {
    unit 0 {
        classifiers {
            dscp-ipv6 default;
        }
        rewrite-rules {
            dscp-ipv6 default;
        }
    }
}

If necessary, you can use the CLI to create a user-defined rewrite rule.
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The following example configuration statements configure a rewrite rule named
rewrite-ipv6-dscps:

1. Navigate to the [class-of-service] hierarchy:

user@host# edit class-of-service

2. Create a user-defined rewrite rule:

user@host# edit rewrite-rules dscp-ipv6 rewrite-ipv6-dscps

3. Specify rewrite rules for the best-effort forwarding class:

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class be-class loss-priority low code-point
000000

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class be-class loss-priority high code-point
000001

4. Specify rewrite rules for the expedited-forwarding forwarding class:

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class ef-class loss-priority low code-point
101110

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class ef-class loss-priority high code-point
101111

5. Specify rewrite rules for the assured-forwarding forwarding class:

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class af-class loss-priority low code-point
001010

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class af-class loss-priority high code-point
001100

6. Specify rewrite rules for the network-control forwarding class:

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class nc-class loss-priority low code-point
110000

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]

user@host# set forwarding-class nc-class loss-priority high code-point
110001

7. Go to the [class-of-service] level in the hierarchy and associate an interface with
your user-defined rule:

[edit class-of-service rewrite-rules dscp-ipv6 rewrite-ipv6-dscps]
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user@host# up
[edit class-of-service rewrite-rules]
user@host# up
[edit class-of-service]
user@host# set interfaces ge-0/0/0 unit 0 rewrite-rules dscp rewrite-dscps

8. Use the show command to review your configuration. The following example
shows the classifier rules created in “Configuring and Applying a DSCP IPv6 BA
Classifier” on page 949 and the rewrite rules created in this procedure:

[edit class-of-service]
user@host# show

classifiers {
    dscp-ipv6 dscp-ipv6–example {
        import default;
        forwarding-class be-class {
            loss-priority high code-points 000001;
        }
        forwarding-class ef-class {
            loss-priority high code-points 101111;
        }
        forwarding-class af-class {
            loss-priority high code-points 001100;
        }
        forwarding-class nc-class {
            loss-priority high code-points 110001;
        }
    }
}
forwarding-classes {
    queue 0 be-class;
    queue 1 ef-class;
    queue 2 af-class;
    queue 3 nc-class;
}
interfaces {
    ge-0/0/0 {
        unit 0 {
            classifiers {
                dscp-ipv6 dscp-ipv6–example;
            }
            rewrite-rules {
                dscp-ipv6 rewrite-ipv6-dscps;
            }
        }
    }
}
rewrite-rules {
    dscp-ipv6 rewrite-ipv6-dscps {
        forwarding-class be-class {
            loss-priority low code-point 000000;
            loss-priority high code-point 000001;
        }
        forwarding-class ef-class {
            loss-priority low code-point 101110;
            loss-priority high code-point 101111;
        }
        forwarding-class af-class {
            loss-priority low code-point 001010;
            loss-priority high code-point 001100;
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        }
        forwarding-class nc-class {
            loss-priority low code-point 110000;
            loss-priority high code-point 110001;
        }
    }
}

9. Check your changes to the configuration before committing.

[edit class-of-service]
user@host# commit check

configuration check succeeds

10. Commit the configuration.

[edit class-of-service]
user@host# commit

commit complete
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Part 7

Power Over Ethernet

■ Power Over Ethernet Overview on page 959

■ Configuring Power Over Ethernet on page 961

■ Verifying PoE Settings Using the CLI on page 963
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Chapter 34

Power Over Ethernet Overview

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Introduction on page 959

■ SRX Series Services Gateway PoE Specifications on page 959

■ PoE Classes and Power Ratings on page 960

Introduction

Power over Ethernet (PoE) is the implementation of the IEEE 802.3 AF and IEEE
802.3 AT standards, that allows both data and electrical power to pass over a copper
Ethernet LAN cable.

The PoE is supported on SRX210 Services Gateway (PoE and voice models) and
SRX240 Services Gateway (PoE and voice models).

The SRX series devices support PoE on Ethernet ports. PoE ports transfer electrical
power and data to remote devices over standard twisted-pair cable in an Ethernet
network. PoE ports allow you to plug in devices that require both network connectivity
and electrical power, such as VOIP and IP phones and wireless LAN access points.

You can configure the SRX series device to act as a power sourcing equipment (PSE)
that supplies power to powered devices (PD) that are connected on designated ports.

SRX Series Services Gateway PoE Specifications

Table 246 on page 959 lists the SRX series devices PoE specifications.

Table 246: PoE Specifications on SRX Series Devices

Values on SRX240 DeviceValues on SRX210 DevicesSpecifications

■ IEEE 802.3 AF

■ IEEE 802.3 AT (PoE +)

■ Legacy (pre-standards)

■ IEEE 802.3 AF

■ Legacy (pre-standards)

Supported standards
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Table 246: PoE Specifications on SRX Series Devices (continued)

Values on SRX240 DeviceValues on SRX210 DevicesSpecifications

Supported on all sixteen Gigabit
Ethernet ports (ge-0/0/0 to
ge-0/0/15).

Supported on two Gigabit Ethernet
ports and two Fast Ethernet ports
(ge-0/0/0, ge-0/0/1, fe-0/0/2, and
fe-0/0/3).

Supported ports

150 watts50 wattsTotal PoE power
sourcing capacity

15.4 watts15.4 wattsDefault per port power
limit

30 watts30 wattsMaximum per port
power limit

■ Static: power allocated for
each interface can be
configured

■ Class: power allocation for
interfaces is decided based
on the class of powered
device connected

■ Static: power allocated for
each interface can be
configured

■ Class: power allocation for
interfaces is decided based
on the class of powered
device connected

Power management
modes

PoE Classes and Power Ratings

A powered device is classified based on the maximum power that it draws across
all input voltages and operational modes. When Class-based power management
mode is configured on the SRX series devices, power is allocated taking into account
the maximum power ratings defined for the different classes of devices.

Table 247 on page 960 lists the classes and their power ratings as specified by the
IEEE standards.

Table 247: SRX Series Devices PoE Specifications

Minimum Power Levels
Output from PoE PortUsageClass

15.4 wattsDefault0

4.0 wattsOptional1

7.0 wattsOptional2

15.4 wattsOptional3

Class 4 PDs are eligible for
receiving power up to 30
watts according to IEEE
standards.

Reserved4
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Chapter 35

Configuring Power Over Ethernet

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter includes the following topic:

■ Configuring PoE Settings on the SRX Series Services Gateway (CLI
Procedure) on page 961

Configuring PoE Settings on the SRX Series Services Gateway (CLI Procedure)

You can modify Power over Ethernet (PoE) settings on the SRX series devices using
the CLI configuration editor.

To configure PoE:

1. Navigate to the top of the configuration hierarchy in the CLI configuration editor.

2. Perform the configuration tasks described in Table 248 on page 961.

3. Commit the configuration when you have completed it.

Table 248: Configuring PoE Settings Using the CLI

MeaningCLI Configuration EditorTask

Enables a PoE interface. The PoE interface must
be enabled in order for the port to provide power
to a connected powered device.

From the [edit] hierarchy level:

■ For all PoE interfaces user@host> set poe
interface all

■ For specific PoE interfaces user@host>
set poe interface ge-0/0/0

Enable PoE

Disables a PoE interface.From the [edit] hierarchy level:

■ For all PoE interfaces user@host> set poe
interface all disable

■ For specific PoE interfaces user@host>
set poe interface ge-0/0/0 disable

Disable PoE
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Table 248: Configuring PoE Settings Using the CLI (continued)

MeaningCLI Configuration EditorTask

Sets the priority of individual ports. When it is not
possible to maintain power to all connected ports,
lower-priority ports are powered off before
higher-priority ports. When a new device is
connected on a higher-priority port, a lower-priority
port will be powered off automatically if available
power is insufficient to power on the higher-priority
port.

NOTE: For the ports with the same priority
configuration, ports on the left are given higher
priority than the ports on the right.

From the [edit] hierarchy level:

■ For all PoE interfaces user@host> set poe
interface all priority low

■ For specific PoE interfaces user@host>
set poe interface ge-0/0/0 priority high

Set the power port
priority

Sets the maximum amount of power that can be
supplied to the port.

From the [edit] hierarchy level:

■ For all PoE interfaces user@host> set poe
interface all maximum-power 14

■ For specific PoE interfaces user@host>
set poe interface ge-0/0/0 maximum power
12.8

NOTE: The default wattage per port is 15.4
watts.

Set the maximum PoE
wattage available power
for a port

Allows logging of per-port PoE power consumption.
The telemetries section must be explicitly specified
to enable logging. If left unspecified, telemetries is
disabled by default.

Default values for telemetries:

■ Duration: 1 hour

■ Interval: 5 minutes

From the [edit] hierarchy level:

■ For all PoE interfaces user@host> set poe
interface all telemetries

■ For specific PoE interfaces user@host>
set poe interface ge-0/0/0 telemetries

Enable logging of PoE
power consumption
with the default
telemetries settings

■ Class—When a powered device is connected
to a PoE port, the power allocated to it is equal
to the maximum power for the class as
defined by the IEEE standards.

■ Static—When a powered device is connected
to a PoE port, the power allocated to it is equal
to the maximum power configured for the
port.

From the [edit] hierarchy level:

■ set poe management classuser@host>
set poe management class

■ set poe management static user@host>
set poe management static

Set the PoE power
management mode

Reserves the specified amount of power for the
gateway in case of a spike in PoE consumption.

From the [edit] hierarchy level:

For all PoE interfaces user@host> set poe
guard-band 15

Reserve a specified
wattage of power for
the gateway in case of
a spike in PoE
consumption (default is
0)
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Chapter 36

Verifying PoE Settings Using the CLI

For information about which devices support the features documented in this chapter,
see the Junos OS Feature Support Reference for SRX Series and J Series Devices.

This chapter contains the following topics:

■ Verifying the Status of PoE Interfaces on page 963

■ Verifying Global Parameters on page 964

■ Telemetry Data (History) for the Specified Interface on page 964

Verifying the Status of PoE Interfaces

Purpose Verify that the PoE interfaces on the device are enabled and set to the desired priority
settings. (The device used here is SRX240 Services Gateway).

Action To display real-time status for all PoE interfaces, enter show poe interface from the
configuration mode in the CLI :

For all PoE interfaces:

user@host> show poe interface

Interface Admin status Oper status Max power Priority Power consumption Class
 ge-0/0/0 Enabled      Searching   15.4W     Low      0.0W                0
 ge-0/0/1 Enabled      Powered-up  15.4W     High     6.6W                0
 ge-0/0/2 Disabled     Disabled    15.4W     Low      0.0W                0
 ge-0/0/3 Disabled     Disabled    15.4W     Low      0.0W                0

For specific PoE interfaces:

user@host> show poe interface ge-0/0/1

PoE interface status:
PoE interface                :  ge-0/0/1
Administrative status        : Enabled
Operational status           : Powered-up
Power limit on the interface : 15.4 W
Priority                     : High
Power consumed               : 6.6 W
Class of power device        :   0
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Meaning The show poe interface command lists PoE interfaces configured on the SRX Series
device, with their status, priority, power consumption, and class. This output shows
that the device has four PoE interfaces of which two are enabled with default values.
One port has a device connected which is drawing power within expected limits.

Verifying Global Parameters

Purpose Verify global parameters such as guard band, power limit, and power consumption.

Action From the configuration mode in the CLI, enter the show poe controller command
from the top level.

user@host > show poe controller

Controller  Maximum   Power          Guard band  Management
   index       power     consumption
       0        150.0 W    0.0 W         0 W         Static

Meaning The show poe controller command lists the global parameters configured on the SRX
series device such as controller index, maximum power, power consumption, guard
band, and management mode along with their status

Telemetry Data (History) for the Specified Interface

Purpose To display the PoE interface's power consumption over a specified period.

Action Enable telemetries for the interface with the telemetries configuration statement.
When telemetries is enabled, you can display the log of the interface's power
consumption by using the CLI command show poe telemetries interface.

For all records:

root@xyz-power1> show poe telemetries interface ge-0/0/1 all

Sl No Timestamp Power Voltage
1 Fri Jan 04 11:41:15 2009 5.1 W 47.3 V
2 Fri Jan 04 11:40:15 2009 5.1 W 47.3 V
3 Fri Jan 04 11:39:15 2009 5.1 W 47.3 V
4 Fri Jan 04 11:38:15 2009 0.0 W 0.0 V
5 Fri Jan 04 11:37:15 2009 0.0 W 0.0 V
6 Fri Jan 04 11:36:15 2009 6.6 W 47.2 V
7 Fri Jan 04 11:35:15 2009 6.6 W 47.2 V

For a specific number of records:

root@xyz-power1> show poe telemetries interface ge-0/0/1 5

Sl No Timestamp Power Voltage
1 Fri Jan 04 11:31:15 2009 6.6 W 47.2 V
2 Fri Jan 04 11:30:15 2009 6.6 W 47.2 V
3 Fri Jan 04 11:29:15 2009 6.6 W 47.2 V
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4 Fri Jan 04 11:28:15 2009 6.6 W 47.2 V
5 Fri Jan 04 11:27:15 2009 6.6 W 47.2 V

Meaning The telemetry status displays the power consumption history for the specified
interface, provided telemetry has been configured for that interface.

Related Topics ■ Power Over Ethernet Overview on page 959

■ Configuring Power Over Ethernet on page 961

Telemetry Data (History) for the Specified Interface ■ 965
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